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1 Getting Started

Overview

InFocus is a dynamic solution that bridges form and function to create a powerful user experience.
Understanding InFocus is paramount to running a successful system. The InFocus User Manual is simply a
reflection of these concepts and acts as a guide to the end user. Browse the manual by chapter/topic
(descriptions below) or by clicking the "Search" link displayed above. If questions arise beyond the reach of
this manual, please feel free to contact us directly via Clearview Support. Enjoy!

Getting Started

Includes an overview on InFocus core functionality, navigation and technical specs.

InFocus Foundations

Provides a walk-through of the InFocus User Interface (UI) and discusses key InFocus concepts and

Terminology.

InFocus Setup

Walks through the setup of InFocus from the ground up.

InFocus Modules and Applets

Provides a comprehensive, detailed description of each area within InFocus.

InFocus System Reports

Provides a description of each report that comes shipped with InFocus.

InFocus Tutorials

Provides a step-by-step guide to standard processes used in InFocus.

InFocus Advanced

Provides a guide to advanced processes used in InFocus.

http://support.clearviewsoftware.net
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1.1 InFocus Overview

InFocus Core Features

InFocus is a dynamically deployed, A&E geared solution that focuses on the following features

Navigation

InFocus utilizes a Module>Applet approach where the Module represents the area of core functionality and
the Applet represents the child activities. InFocus navigates from left to right: When selecting a
Module>Applet, InFocus displays the interactive contents (Tabs, Buttons, Grids, etc) of the selected applet. 

Getting Started Tutorials

The following brief video tutorials will be foundational to your understanding of InFocus.



InFocus Foundations 23

© 2020 Clearview Software, Inc.

2 InFocus Foundations

2.1 InFocus User Interface

2.1.1 InFocus UI Basics

Overview

The InFocus User Interface (UI) is designed to be a user-friendly work environment. Below are the major
features of the UI.

General Navigation

InFocus utilizes a Module>Applet approach where the Module represents the area of core functionality and
the Applet the on-screen activities. For purposes of this manual, InFocus locations are referenced as follows
(for example): Project Management>Project Central. InFocus navigates from left to right: When selecting a
Module>Applet, InFocus displays the interactive contents (Tabs, Buttons, Grids, etc) of the selected applet.
The InFocus main screen additionally supports Split Tab making it easy for users to cross reference work or
view applet information side by side. Additionally, many InFocus screens contain hyperlinks which allow you
to quickly navigate to a specific record.

Favorites

Favorites allow you to pin applets and key reports to the main menu. Favorited applets also support Open
on Login. More on working with Favorites

2.1.2 Standard Toolbar Options

Overview

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. That being said,
the following menu options are always available.

Toolbar Options

File - Give the following options:
o Dashboard - Brings up the Dashboard. More on Dashboards.
o New - Creates a new record.
o Save - Saves current changes to the record.
o Delete - Deletes the currently loaded record.
o Logout - Logs the user out of InFocus.
o Exit - Closes out of InFocus completely.

Help - Gives the following options:
o Change Password - Allows the currently logged in user to change their password.
o About - Displays current InFocus application information
o Manual - Opens a web version of the InFocus User Manual.
o Support - Opens the following options:

https://support.clearviewsoftware.net/articles/6057
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Clearview Support - Launches Clearview Support.
Personal Support Key - Launches Clearview Support, bypassing login with a generated user
support key
Webex - Launches Clearview Support remote assistance via WebEx

New -  Creates a new record.

Copy - Copies the currently loaded record, prompting for the information needed to create the new record
(e.g. New Code, New Name, etc.)
Save - Saves the currently loaded record.

Delete - Deletes the currently loaded record.

UDF Designer - Brings up the UDF Designer.  More on User Defined Fields.

Print All "Applet Name" - When clicked, the user is directed to the Applet List report. Each of the Master
File Applets have a "List Report" that gives you a quick printout of the data.

2.1.3 Searching and Lookups

Overview

The Lookup Control offers alternate ways to narrow down your choices within an Applet Screen throughout

the InFocus program. The Lookup Control is an important tool to use when you are searching through

hundreds and thousands of rows of data. The Lookup Control is usually found on the top right of your screen,

but may also appear in other areas of the InFocus interface. 

Object Lookup Control

Capabilities

Pressing "Enter" or "Tabbing Out" - Throughout InFocus, each lookup object has unique lookup

properties (i.e., code, path, etc.). If you type in the unique record identifier (e.g., employee code in

employee screen,  client code in Client screen) and then hit Enter (or Tab Out) it will bring up the

corresponding record.  Each lookup object has different lookup filters.  Use the different filters to narrow

down your search.

Pressing the magnifying glass - By pressing the magnifying glass, you will get a window showing all of

the unique record identifiers available in that section. You can narrow down your search by using the F3

and F4 buttons (illustrated below). 

Option:  Auto Fill Lookup Forms (located in Administration>Global Settings>General Tab) - When

checked, all active records for master field applets will display in the lookup list when the magnifying glass

is clicked. For journal screens it means all records since transactions are not marked active/inactive.

Using the F4 button - When in the Lookup box, type in at least two characters of what you are searching

for, then push F4. Any item that contains the characters in the code or name field will be returned.
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Journal Searching - InFocus Journals offer some great search options listed below. Quickly pull up

recent transactions or search on key information.

a. F3 - Pressing F3 from the lookup box brings back the 10 most recent transactions within the Journal.

b. Key Search fields - Start typing in the Journal lookup box and InFocus will return a filtered list of

results according to the key search fields below:

i. Sales - Sales Transaction ID and Invoice Number

ii. Receipts - Receipts Transaction ID, Check Number and Sales Invoice Number

iii. Purchases - Purchase Transaction ID and Invoice Number

iv. Disbursements - Disbursements Transaction ID, Check Number and Purchases Invoice Number

2.1.4 InFocus Navigator

Overview

This is an extremely powerful search (navigation) function. It affects the most commonly used screens and
makes finding transactions and/or records much easier. The selections available in the InFocus Navigator are
driven by data queries. Each of these system queries can be edited as needed. Additionally, custom queries
can be written to be utilized by the Navigator. Navigator queries (system and custom) are edited in 
Utilities>Navigator Queries. Below is a discussion of this applet. For a list of available queries, click here

*Keystroke Note: Utilize the InFocus Navigator by clicking Ctrl + Tab and selecting Navigator in the Tools
section of the pop up.

Navigator Queries

Utilities>Navigator Queries

Queries Drop-down - When you click on the drop-down, a list of both system and custom queries to select
show up here.  The queries in the list are specific to the applet that you are currently in (Fig. 1 is currently in
the Projects applet).

Query Return Window - The window displays the results of the query selected in the Drop-down.

Queue Window - This window displays all items selected from the Query Return Window.  To get items to
display here, Left-click and highlight the items.  Next, click the Add To Queue button.  Once items are here,
you are able to move through them using the arrows at the bottom of the window.

Note - You are able to export the queries to Excel for personal use.

References



InFocus User Manual - Current (v2020)26

© 2020 Clearview Software, Inc.

Navigator

2.1.5 Grids

Overview

InFocus leverages dynamic grids for maximum convenience and usability. Nearly all grids throughout InFocus

have been enhanced with the functionality described below. Reports are also enhanced with a View Data

option which presents the reported data in a grid view.

Arrow Key Navigation - Easily navigate through cells using your arrow keys

Type to Edit - To edit the cell of a grid, simply start typing in editable cells

Link Throughs - All Journal Grids and many other system grids display link throughs to corresponding

applets. For example: link directly to the Projects applet from the Sales Journal detail. The selected

project will load with the applet. This can be accessed by the hot key combination Ctrl+L

Column Order and Width persistence - User changes made to grids are dynamically recalled by the

system.

Custom Columns - Most grids give you the option to create custom columns. Custom Columns are

available when you see a second tab labeled "Custom Columns" when the Column Chooser is open.

Custom Columns are available to everyone and give you the ability to create private custom columns with

the data available in that grid. If you are granted the "Can Manage Public Custom Columns" right, located

in Employees / Employee Information, you have the ability to create "Public" custom columns that will

appear for all users.

Column Chooser - Allows the user to view additional columns relevant to the grid displayed.

Row Numbers 

Grid Export - All dynamic grids can be exported to multiple formats by using the hot key combination: Ctrl

+Shift+E.

Grid Functions

Description - Sorting and/or filtering grids offers alternate ways of narrowing down and ordering data for

easier viewing.

Sorting

You are able to sort any column in InFocus by clicking on the column header.  If you click on the same

column header again, it will reverse sort.

http://support.clearviewsoftware.net/articles/share/7C31537B
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Filtering

By clicking on the funnel located in the column header, you are able to narrow down your results.  

References

The following tutorial details grid functionality and customization.

Base Grids

2.1.6 Keyboard Shortcuts

Overview

Keyboard shortcuts offer alternate ways of invoking a command that would otherwise be accessible only

through different levels of the InFocus user interface. Keyboard shortcuts expedite common InFocus

operations.

Keyboard Shortcut Descriptions

Ctrl + Tab: Toggles between open Applets and Navigator options

Ctrl + L: Auto-clicks a cell’s drill through link when the cell is highlighted

Ctrl + Shift + E: Exports the content of a grid (multiple formats supported)

Ctrl + W: Exports the content of a grid to Microsoft Word

Ctrl + P: Exports the content of a grid to Print View

Ctrl + N, R, B, W or H: Sets the Bill Status of a highlighted row(s) respectively in the PA Bill Review

Applet. Note, you can highlight multiple rows by either holding your cursor down and dragging or using

Shift+Click. Below is each command with corresponding Bill Status.

o Ctrl + N = Never Bill

o Ctrl + R = Ready to Bill

o Ctrl + B = Billed

o Ctrl + W = Write Off

o Ctrl + H = Hold

Delete (Grids): Deletes a highlighted Grid row(s). Note, you can highlight multiple rows by either holding

your cursor down and dragging or using Shift+Click.

F2: Copy/Pastes grid rows. F2 will copy the content of a highlighted grid row and paste (insert) it into a

new row. Likewise, if a new row is highlighted, F2 will copy the previous row to the new row.

http://support.clearviewsoftware.net/articles/share/F64CCA1B
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F3: Displays the the 10 most recent transactions from a Journal Lookup box. From any Journal Lookup,

pressing F3 will bring back a list of the 10 most recent transactions

F4: Auto-searches from the Lookup based on the entered search text. For instance, from the Sales

Journal Lookup, typing “10” and pressing F4 will display Invoice Numbers and Transaction ID’s that

contain “10”.

2.2 Key Concepts and Terms

2.2.1 Glossary

Overview

The following is an alphabetized list of commonly used terms throughout InFocus and the InFocus Manual.

Key Terms

Applet - The subcategories seen when you click a tab on the sidebar (ie. Click - Personal, Applets -

Expense Sheets, My Work Orders, Time sheets) . Applets are a part of the InFocus application where

security can be established. Everything at the second level of the Main Menu is an applet. Applets can be

thought of as screens.

Bad Debt - The write off of open accounts receivable.

Base Code - The part of a general ledger account that describes the account but does not include an

organizational unit.

Bill Rate - The rate that is billed to the client.

Bill Terms Node (Project Level) - The node where most project attributes are assigned. This will usually be

the top node, but in the case of the presence of a roll-up node, it will be the second level node.

Billed Revenue - Revenue from actual invoicing.

Bottom nodes - (also known as terminal nodes) are nodes with no children.

Burdened Cost Rate - The burden rate is the allocation rate at which indirect costs are applied to the

direct costs of labor. You should add burden to the direct cost of labor when you want to present the total

absorbed cost.

Chart of Accounts (COA) - List of all general ledger accounts. InFocus categorizes project management

amounts through the Chart of Accounts.

Critical Path - InFocus calculates Critical Path by taking the longest path to the end of the project

Diluted Pay Rates - Diluted pay rates are a calculated pay rate for salaried employees for a given pay

period, based on the number of hours for the period. By default, when you establish a pay rate for a

salaried employee in InFocus, it is the average pay rate (typically the annual salary divided by 2080

hours). Alternatively, you can run a utility after timesheets have been approved to recalculate rates for

non-overtime time entries for salaried employees. The employee salary per period amount is divided by

the number of hours worked, excluding overtime, and the resultant rate is then applied to the timesheets.

For instance, an employee earning $1,000/week would have an average pay rate of $25/hr based on a 40

hour work week. If in a given work week the employee worked 50 hours, the diluted pay rate would be

$1000/50 or $20/hr. 

Delimiter - A single character that separates the node codes with a path. Delimiters used in InFocus are
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period, hyphen, and colon. 

Effort - Effort includes all cost charges against a project at the prevailing billable rate. For labor, that

would be the established bill rate typically defined on a rate schedule. For non-labor transactions, that

would be the cost plus the expense markup. All transactions are part of effort, regardless of their billing

status.

ICC - In-Contract Consultants. All project-related consultants' expenses that are built into a fixed fee.

Job Cost Rate - A job cost rate is a user-definable rate for analyzing project labor charges. Basically, its

the cost of the job to the company. Typically, companies use it to look at a burdened cost rate on

projects. This would be done by setting the job cost rate to the pay rate, times a calculated or predicted

overhead multiplier for the company. This would best be accomplished by defining a singular job cost

schedule and then setting it as the default schedule in Global Settings. The schedule could then be

modified on a periodic basis (typically annually).

Labor -  Employee and sub-contractor time. Sub-contractors are defined as workers who enter time

sheets and are billed out like employees. However, they receive 1099's rather than W2's.

Late Charge - Late charges for unpaid invoices.

Main Menu - After you login into InFocus you receive the main screen with a Two-level menu system

anchored to the left hand side of the screen. That is the main menu.

Module - A group of applets organized by the area of a business that they address. Modules are the items

at the first level of the Main Menu.

Node - A node is an individual record or point in a tree structure (hierarchy), such as a phase or task.

OBS - Organizational Breakdown Structure. In InFocus, we refer to the organization as the organization

break down structure.

OCC - Out-of-Contract Consultants. All project-related consultants expenses that are not built into a fixed

fee.

ODC - Other Direct Charges. All project-related expense other than labor and consultants.

Path - A path is the code sequence that uniquely identifies a node. It is formed by concatenating all

parent (project) codes together separated by a delimiter.

Pay Rate - The Rate that you pay the employee to complete a job.

PM Comments - PM comments stand for project management comments. These comments can be made

on any cost (labor or non-labor) transaction and can optionally appear in Project Management reports and

invoices.

Post - The action of saving a transaction and making it available to general ledger reporting.

Premium Time - Synonymous with overtime. 

Project Code - Also called a "node code," is the code given to a project.

Project Level - The relative position of a node to the beginning of the tree.

Retainage - Monies held back during invoicing until project completion.

Retainer - Monies received prior to project work.

Roll-up Node - Allows multiple projects to be subtotaled together in project management reports

RDL - RDL stands for Report Definition Language. An RDL file is the file containing the design of a report

(in XML format) used in InFocus

Subcontractor - A non-W2-employee who enters a time sheet.

Top nodes - (also known as root nodes) are level one nodes (nodes with no parent). 

Transaction - An entry that affects the general ledger or time and expense. Transactions in InFocus are

time sheet entries and adjustments, purchases, disbursements, employee reimbursements, expense

sheets,  sales, receipts, and general adjustments.

Tree - Data that is related in a hierarchy is called a tree. There are two trees in InFocus - Organizational

Units and Projects.
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Unbilled Revenue - Earned revenue.

WBS - Work Breakdown Structure, In InFocus we refer to a project structure as the work break down

structure.

WIP - Work In Progress, all transactions against a project that have a bill status of Ready to Bill or Hold.

2.2.2 Organizational Structure

Overview

InFocus uses a parent/child system to represent the levels of hierarchy within an Organization Unit. 

Key Concept

InFocus refers to these as Organizational Units (Org Units). Org Units, defined in General

Accounting>Organizational Units, are classified by Labels and can represent entities such as: Office,

Department, Division, etc. For example, an organization structured by location and department could be

represented as follows. More on Organizational Units

2.2.3 COA Metrics and PM Types

Overview
InFocus categorizes project management amounts through the Chart of Accounts. It accomplishes this by
using two major properties assigned at the account level. These two properties are Metrics and Project
Management Types (PM Types). More on Chart of Accounts

Metrics

In-Focus currently tracks the following metrics:

Cost - This covers both Labor and Non-Labor Expense. However, in the case of project management
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reporting, labor costs come from time sheets, not the general ledger. This is the only exception in metrics.
One reason for this exception is that labor costs posted to the general ledger are done at a project level, not
an employee level. The second reason is, that by using time sheets, multiple valuations (pay, job cost and bill
rates) can be used.

Billed Revenue - Revenue from actual invoicing.

Unbilled Revenue - Earned revenue.

WIP - Work in progress

Retainage - Monies held back during invoicing until project completion.

Retainer - Monies received up front prior to project work.

Bad Debt - Revenue write offs.

Late Charge - Late charges for unpaid invoices.

PM Types

The first four metrics listed (Cost,Billed Revenue,Unbilled Revenue and WIP) can be subdivided into four PM
types:

Labor -  Employee and sub-contractor time. Sub-contractors are defined as non-W2 employees who enter
time sheets and are billed out like employees.

Out-of-Contract Consultants (OCC) - Consultants whose invoices are passed to project billing, potentially
with a markup and for reimbursement.

In-Contract Consultants (ICC) - Consultants whose invoices are not passed to project for reimbursement.
Instead, their fee is buried inside the fixed fee for a project.

Other Direct Charges (ODC) - All non-consultant and non-labor charges to a project.           

2.2.4 Firms

Overview

In InFocus, firms are a generic term for companies and organizations with which you conduct business. They

can be prospects, vendors, clients or any combination thereof. When you first set up a firm, the screen you

use automatically assigns the firm type. So firms first added through Vendor Setup are vendors. Firms first

added through Client Setup are clients. Firms added through Firms Setup in Marketing default to prospect (if

not marked prospect, they are considered clients).

Once a firm exists as a client (prospect or otherwise) or a vendor, simply calling them up under the opposing
setup screen and saving them allows them to be both types.

Firms can also have parent firms. This allows for the association of firms (especially for roll-up purposes) and
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is exposed in areas of the program such as the A/R and A/P sub-ledgers and Client and Vendor Queries.

2.2.5 Project Nodes

Overview

This section discusses different types of nodes used in configuring Projects: Roll-up, Bill-Term, and Other

Roll-up

Exists only at level 1

No attributes other than a code and a name

Allows multiple projects to be subtotaled together in project management reports

A separate WBS delimiter can be used from the rest of the WBS delimiter. For instance , 9801.01-A-001
is a four-level structure where the roll-up is 9801; the project is 01; the first level beneath project is A; the
bottom level is 001.
More on Rollup Nodes

Bill Term (aka  Project)

If no roll-up node exists, it is defined at level 1, else at level 2

Project leaders (PIC, PM, Project Accountant) are defined here

Client is defined here.

Invoice design is defined here. An invoice design can have multiple labor and expense sections. In the
case where multiple contractual elements (i.e., fixed fee, lumps sum, T&M, not to exceed) need to appear
on one invoice, there are two methods. Method A involves establishing an invoice filter at the level below
the Project level. The filter is simply a code that will be assigned on each of the nodes below the project.
Then multiple invoice sections will be added to an invoice design that will limit the scope to the particular
nodes with the corresponding code. 
Method B is to assign multiple projects to the same Invoice Group. In this method each project that is part
of an invoice group can have its own invoice design. While the individual projects will print out as separate
invoices, the actual invoice number assigned to each will be the same. It will also post as one invoice in
the InFocus A/R sub-ledger.  A special invoice design section called a cover sheet can be added to the
invoice group that will provide a recap of the projects involved along with a grand total. The major
difference between the two methods is invoice format. The first method, in essence uses one invoice
report design, so in the case where there is a mixture of contract types (fixed fee, T&M), the report design
can accommodate whether or not a page break occurs between the types. In the second method, each
project is its own report, so a page break will always happened between the projects. 
Determines what level of the WBS is used for upsets and fixed fee amounts. Please note that if fixed fee
and upsets are established on the same project they need to exist at the same level. Contract amounts
can exist up to three levels below the bill term level.
Profit center ownership is defined here.

Determines at what level sharing profit centers will be defined.

https://support.clearviewsoftware.net/articles/5446
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Determines minimum level where non-labor transactions can be applied.

Can have expense groups defined

Overall ODC and consultant markups can be defined here

Other

Exist below the bill term node

If level is directly below the project then invoice filters can be defined

Only bottom nodes can have labor charged to them.

First three below the bill term node can appear on invoicing. They can all use upsets and fixed fee
amounts. The contractual level is established on a project-by-project basis for labor, expense and
consultant.
Time and expense can be activated and inactivated on data range

Can have rate schedules and multipliers defined. In this case the rate potentially overrides schedules at
higher levels.
Can have sharing profit centers defined

Can identify taxable items

All budgeting occurs on bottom nodes

Expense multipliers can be defined

2.2.6 Project WBS Structure

Overview

InFocus utilizes a parent/child structure to represent the relational hierarchy (tree) in a project structures.
Commonly, a given project will consist of child levels often referred to as phases and tasks. Consider the
following project tree.

InFocus utilizes a parent/child structure to represent the relational hierarchy (tree) in a project structures.
Commonly, a given project will consist of child levels often referred to as phases and tasks. Consider the
following project tree.

Nodes
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In the above diagram we have a project linked to three phases, each of which are linked to two or more
tasks. Each item on the tree is called a node. Therefore, Empire State Building, schematic design, and cad
work are all nodes. The numbers and letters in parenthesis are generically referred to as node codes. So
9801 (typically referred to as the project code) is a node code as is 10 for phase schematic design. Two other
terms used in this manual in regards to trees are top nodes and bottom nodes. Top nodes (also known as
root nodes) are level one nodes (nodes with no parent). Bottom nodes (also known as terminal nodes) are
nodes with no children. Nodes must be uniquely coded in respect to their immediate parent- level one nodes
must be unique to all other level one nodes.

Project Path

Since some nodes can have the same code (e.g., cad work and meetings) it is necessary to refer to nodes
not only by their code, but also by what branch of the tree they live on. The way InFocus accomplishes this is
to cite each code along the branch to the node in question. For purposes of clarity, a separating character
(also know as a delimiter) is used between each node code. This notation is called a path. An example of a
path would be 9801-10-A. In this example, the project is Empire State Building, the phase is Schematic
Design, and the task is  CAD work. A hyphen is used as the delimiter.

Parent-Child

Nodes can have parents and children. For instance, CAD Work has an immediate parent called Schematic
Design but no children. Schematic design has an immediate parent called Empire State Building and two
immediate children called Cad work and research. The use of the word immediate means adjacent to. In
other words Empire State building is a non-immediate parent to CAD work since it is related to CAD work
indirectly through Schematic Design.

Level

The relative position of a node to the beginning of the tree is called the level. In the above example, 9801 is
on level one, phases 10,20 and 30 are on level two. All other nodes are on level three. Levels can be labeled
so we can refer to them in real world terms such as project, phase and task.

2.2.7 Journal Transactions

Overview

The following tutorial will discuss transactions in InFocus. Transactions cover all G/L transactions plus labor
entries and personal transactions (timesheets and expense sheets). All the journals share some common
operations, such as voiding a transaction. These operations will be discussed in the Common Journal
Operations chapter. Account journals support both Batch and Real-Time entry.

Batch Entry

Batch entry can only be used for new entries and is only available if enabled in Global Settings. Batch entry
allows for a series of transactions to be entered under a batch number. Totals for the entries can be viewed
prior to posting the batch. Until an entry is marked posted, it does not appear in any accounting or project
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management reports and cannot be part of any accounting process. While it is saved, it is not part of the
system. More on Batch Entry

Real Time Entry

In Real-Time mode, entries are flagged as posted as soon as they are saved. This makes them available to
all reports and operations in the system. Once a transaction is posted all revisions to that entry are
automatically done as real-time entries.

Audit Trail

InFocus employs a unique auditing feature. Depending on settings in Global Settings>General Tab>Full
Audits Section, it automatically determines if a change to a transaction line item should alter the existing
data, or, instead, make a background reversing entry of the prior state of the line and insert a new line
containing the changes. This technique makes corrections far simpler than a pure batch entry system and
results in a more accurate audit trail. It also allows for adjustments to naturally been seen down to the line
level.

The audit trail options are full or not full. When in full mode any change to critical data (In general, project,
amounts, G/L accounts) causes an immediate reversing entry. When not in full audit mode, changes to
critical data only generate a reversing entry if they are also accompanied by a change to the G/L period.
Every time a transaction contains one or more auto-reversals, a new revision number is displayed in the
header of the transaction. You can scroll backwards to view prior revisions. Each line item will also have the
revision number on which they were created. In normal operation, revisions are virtually transparent to the
user. For instance, if an entry contained five lines and you modified each line and saved the changes, the
transaction would still show five lines with the new values.

Employee Reimbursables

Accounts Payable>Employee Reimbursables

The Employee Reimbursable Journal is where employee reimbursements are entered. Typically, they have
been imported from employee expense sheets, but they can also be directly entered here. This journal makes
assumptions on debits and credits. It assumes the header amount is a credit so when you enter a positive
amount it saves it behind the scenes as a negative (a credit). 

For more information about Employee Reimbursables, see the Employee Reimbursables section of this
manual.

Expense Sheets

Personal>Expense Sheets

Expense sheets are for employees entering job-related expenses. There is no period cycle for expense
sheets. 

For more information about Expense Sheets, see the Expense Sheets section of this manual.

Timesheets



InFocus User Manual - Current (v2020)36

© 2020 Clearview Software, Inc.

Personal>Time Sheets

Timesheets can be entered by employees or sub-contractors. Typically, these users enter their own
timesheets, but timesheet administrators (when given special rights) can enter them in their stead. 

For more information about Timesheets, see the Timesheets section of this manual.

Timesheet Adjustments

Human Resources>Timesheets Adjustments

The Timesheet Adjustments Journal is used to make adjustments against an already existing timesheet. You
cannot enter new timesheets here. Once you modify an existing timesheet it can no longer be sent back to
the manager or owner (timesheet rejection). Modifications to the timesheet, via timesheet adjustments, will
not effect the original version of the timesheet. 

For more information about Timesheet Adjustments, see the Timesheet Adjustments section of this manual.

Purchases (Vendor Invoices)

Accounts Payable>Purchase Journal

The Purchase Journal is where vendor invoices are entered. Transactions entered here must be offset
against an accounts payable account (this is the header or control side of the transaction). This journal
makes assumptions on debits and credits. It assumes the header amount is a credit, so when you enter a
positive amount it saves it behind the scenes as a negative (a credit). 

For more information about Purchases, see the Purchase Journal section of this manual.

Sales (Client Invoices)

Accounts Receivable>Sales Journal

The Sales Journal is where client invoices are entered. Transactions entered here must be offset against an
accounts receivable account (this is the header side of the transaction). Typically, most transactions in the
sales journal are entered automatically from automated invoicing. This journal makes assumptions on debits
and credits. It assumes the detail amount is a credit, so when you enter a positive amount it saves it behind
the scenes as a negative (a credit). 

For more information about Sales, see the  Sales Journal section of this manual.

Cash Disbursements

Accounts Payable>Disbursements Journal

The Cash Disbursements Journal is where all outgoing checks are entered. Typically entries here have been
entered automatically from A/P or E/R check writing but can also be entered here manually. This journal
makes assumptions on debits and credits. It assumes the header amount is a credit so when you enter a
positive amount is saves it behind the scenes as a negative (a credit). 

For more information about Cash Disbursements, see the  Disbursement Journal section of this manual.
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Cash Receipts

Accounts Receivable>Receipts Journal

The Receipts (Cash Receipts) Journal is where all incoming checks or payments are entered. This journal
makes assumptions on debits and credits. It assumes the detail amount is a credit so when you enter a
positive amount it saves it behind the scenes as a negative (a credit). 

For more information about Cash Receipts, see the Receipt  Journal section of this manual.

General Adjustments

General Accounting>General Journal

The General Journal holds both accounting adjustments and special transactions, such as labor distributions,
revenue recognition and end of year closings. While you can make transactions that affect project
management figures, these transactions cannot be part of invoicing, accounts receivable, or accounts
payable reporting. Project-related transactions can, however, appear on project management reports. This is
the only journal where there is no header control account or amount. Instead, the sum of all line items must
zero out. Unlike other journals, no assumption is made about debits and credits. Debits are positive values,
while credits are negative values. Entry rules, as far as type of account and organizational unit, are relaxed in
this journal. 

For more information about General Adjustments, see the General Journal section of this manual.

Common Journal Operations

For common journal operations, see the How to sections at the end of each journal chapter within this
manual. Also, you can go to the Tutorials chapter of this manual to see these as well.

2.2.8 InFocus Processes

Overview

The following discusses special processes available in InFocus.

Activities

Marketing>Activities

Activities are an appointment system. While listed under Marketing, they could be used by anyone in the
system with the required permissions. Activities can be entered directly into the calendar or can be entered
when recording Notes. The main activity navigation is a calendar. The type of calendar (daily, weekly,
monthly) can be toggled from the tool bar. You cannot only view your own activities but activities for other
employees. On  the left hand side of the screen there are check boxes to control whether to see all activities
or certain users' activities. If you check the Group by Owner option you will see a separate calendar for each
selected user.
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Work Orders

Project Management>Work Orders

Work orders are used by project leaders to communicate with team members. Work orders are normally an
assignment of work to be accomplished, but can also be requests to internal employees for quotes. There are
two work order applets: Work Orders and My Work Orders. For more information about Work orders, see
either the Work Orders or My Work Orders sections of this manual.

PM Bill Review

Project Management>PM Bill Review

The PM Bill Review (Project Manager Bill Review) applet is used by project managers to communicate billing
and charging instructions to the project accountant. Only project managers have access to this applet. For
more information about PM Bill Review, see the PM Bill Review section of this manual.

PA Bill Review

Accounts Receivable>PA Bill Review

This applet is used by project accountants to perform time and expense modifications on a project-by-project
basis prior to invoicing. Only project accountants can access this applet unless the logged-in user has the
special permission "Can Override Project Accountant Restriction". For more information about PA Bill Review,
see the PA Bill Review section of this manual. To make adjustments on PA Bill review, see the "How to Make
Adjustments to PA Bill Review" section of this manual.

Labor Distribution

Human Resources>Labor Distribution

The purpose of labor distribution is to post labor to the general ledger and mirror payroll. For more information
about Labor Distribution, see the Labor  Distribution section of this manual.

Revenue Recognition

Project Administration>Projects

This utility serves two purposes: (1) It posts earned revenue and (2) It performs profit sharing within projects.
For more information about Revenue Recognition, see the Understanding Revenue Recognition / Profit
Centers section of this manual.

https://support.clearviewsoftware.net/articles/5437
https://support.clearviewsoftware.net/articles/5437
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Project Planning

Project Management>Project Planning

The project planning applets allows project managers to plan, schedule and allocate resources to their
projects. For more information about Project Planning, see the Project Planning section of this manual.

Resource Projections

Human Resources>Resource Projections

The resource projection is used to aggregate and analyze schedule data from project planning. Scheduled
hours can be viewed by employee or job title and compared against available hours to show predicted
utilization.  For more information about Resource Projections, see the Resource Projections section of this
manual.

Accounts Payable Check Writing

Accounts Payable>A/P Check Writing

Checks processes from A/P check writing are generated from the vendor invoices entered into the purchase
journal. The checks themselves are posted into the disbursements journal. To understand more about writing
A/P Checks, see the A/P Check Writing section of this manual.

Employee Reimbursable Check Writing 

Accounts Payable>E/R Check Writing

Checks processed from E/R check writing are generated from the employee reimbursable entered into the
employee reimbursable journal. The checks themselves are posted into the disbursements journal. To
understand more about writing E/R Checks, see the E/R Check Writing section of this manual.

Automated Invoicing 

Accounts Receivable>Automated Invoicing

Automated Invoicing streamlines the billing process. Invoices are printed and posted into the Sales Journal
based on User-entered criteria. To understand more about Automated Invoicing, see the Automated Invoicing
section in this manual.

A/R Collections 
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Accounts Receivable>A/R Collections

The A/R Collections applet is used to facilitate the collection of outstanding invoices. To understand more
about collections, see the A/R Collections section of this manual.

Overhead Allocation 

Utilities>Overhead Allocation

There are two ways to view overhead on project management reports. The most common method is to use
the job cost rate to include any overhead burden, which allows the user to view figures down to the
transaction level (i.e., employee and work date). The second method, overhead allocation, can be used in the
event that you use the job cost rate for other purposes, or if rate calculations do not yield the desired effect.
Overhead allocation can be made only to the bottom nodes of the WBS and to an accounting period. You
cannot apply it to an employee or work date. When you use this method, you now can use the specific
overhead variables in Project Management Report Design. These are not used in the default shipped reports.
To understand more about Overhead Allocation, see the Overhead Allocation section of this manual.

Form 1099

Accounts Payable>Form 1099

Form 1099 can be sent to vendors and employees. The system will fill out the forms automatically by the user
and can override any information, including financial amounts. To understand more about using Form 1099,
see the Form 1099 section of this manual.

Recalculate Labor Rates 

Human Resources>Recalculate Rates

The Recalculate Rates Utility is used when you set up rates or rate schedule after you enter timesheets. This
is, of course, not the preferred method. The three different types of rates (pay, job cost, and bill) can all be
recalculated. To understand more about using the Recalculate Rates Utility, see the Recalculate Rates
section of this manual.

Convert to Cash Basis 

General Accounting>Chart of Accounts>Toolbar

Cash basis conversion is accomplished by the use of two screen-less journals: one for disbursements and
one for receipts. The utilities scan the Disbursements and Receipts Journals. Any transactions that are
applied against an accounts payable or accounts receivable account are researched in the Purchase and
Sales Journals, based on the invoice number of the transaction. The non-subledger accounts (income and
expense) found in the Sales Journal or Receipt Journal are then transferred to the Cash-based Journal for the
G/L period in the Disbursement or Receipt Journal. In the case of partial payments, the amount of the receipt
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or disbursements is proportionately spread against the income and expense accounts. This conversion is a
"point in time" conversion. If a Purchase or Sales Journal is revised, depending on the G/L periods involved,
you may need to re-run the utility. Automated cash base conversion cannot address all possible conversion
scenarios. Adjustments can be made by entering cash only adjustments in the General Journal. To use the
CCB utility see the "How to Run a Cash Based Conversion " section of this manual.

End of Year Closing

Utilities>End of Year Closing

End of year closing in InFocus is an automated journal entry. The purpose is to take the year-to-date
amounts in all income and expense accounts and reverse them into retained earnings. This effectively zeros
out the income and expense accounts for a fiscal year. To understand more about using the End of Year
Closing utility, see the End of Year Closing section of this manual.

Project History

Utilities>Project History

Project history is used to enter historical labor against a project. Metrics can be entered through the
accounting journal (General Journal). A special screen is needed for labor, since it would be difficult
(sometimes impossible) to enter this in timesheet adjustments without going down to the detail level. Entries
in this screen are transferred into the timesheet tables. They are flagged as historical entries so they will not
appear in timesheet adjustments; neither can they be invoiced or be part of labor distribution. They will
appear on project management reports. To understand more about using the Project History utility, see the 
Project History section of this manual.

2.2.9 SQL Data Views

Overview

Every SQL table in the InFocus database is also represented by a SQL view. A SQL view is a stored query
that appears to other applications as a table. A SQL view simplifies user queries by joining tables for you.
InFocus provides two classes of SQL views for end-users to use for queries: Standard Views (SV) and
Extended Views (EV)

Standard Views (SV)

Standard View names are the same as the table name, but with a prefix of "SV_". Standard Views contain all
the columns of their table and, in addition, all code and title fields from related tables. For instance, if you
query timesheet items (which holds timesheet line items) you would see columns such as projectid, jtid, etc.
These are keys fields relating the projects and job titles tables. In Standard Views, you would see the joined
in code and title fields from the related table. The Standard View would also contain projectcode,
projectname, projectpath,projectlongname, jtcode and jtname.
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Extended Views (EV)

Extended Views are the other view class. These have a name beginning with  "EV_". Extended Views are
useful views that were created by InFocus. EV examples include, but are not limited to

EV_ProjectTransactions - Gathers project related transactions. Field compliment is same as aggregate and
non-aggregate in project management report designer.

EV_Marketing - Marketing contact information

EV_Wip - Work in progress data.

2.2.10 InFocus Report Design

Overview

The following tutorial will discuss Report Design in InFocus. All reports in InFocus use the Microsoft Report
Designer that ships with all versions of SQL 2005.

Reports are broken down into five categories: Invoices, Project Management, Financial Statements, Standard
Reports, and Custom Reports. The first three employ unique wizards geared to the report styles to simplify
report creation. Report design for standard reports is limited to layout only. Custom reports are the only
reports where the user can define the interface.

Report Components

All reports have three components: Interface, Layout, Dataset.

Interface

The interface refers to the passing of print criteria at run time. The interface is fixed and cannot be changed
by the user (except for custom reports). The interface is different for each report type. The criterion is used for
two purposes: (1) to dynamically populate the data in the dataset, and (2) to provide the conditional
formatting employed by the layout.

Layout

Layout refers to the print layout that is controlled by the Microsoft Report designer. A vast array of format
issues can be controlled here. Examples are columns to print, subtotals, grouping of data, underlining totals,
and indentation.

Dataset

The dataset refers to the fields presented and controlled by the layout. In  the case of invoices and project
management, the fields are selected by the wizard and, therefore, vary from design to design. In all other
reports the field list is static. The data that populates the dataset is based on selections made in the
interface.

Microsoft has various web sites and forums providing information on the use of the Report Designer.



InFocus Foundations 43

© 2020 Clearview Software, Inc.

Report Categories

Invoices

Invoice design is segmented into sections. Each section controls a particular area of an invoice. An invoice
design can have an unlimited number of sections. All section types, except for the border, can appear
multiple times on an invoice. However, no section design can appear twice. Section designs can be reused
between invoice designs. 

For more information about Invoices, see the Invoice Design section of this manual.

Project Management Reports

Project management reports are project-based. Only data related to projects are available. 

For more information about PM Reports, see the PM Report Designer section of this manual.

Financial Statements

Financial statement designer provide for very flexible statement generation. Balance sheets, profit & loss
(consolidated and by profit center), and other statements can be created here. The basic premise is that and
group of G/L accounts can be combined to appear on a financial statement design. 

For more information about Financial Statements, see the Financial Statement Designer section of this
manual.

Standard Reports

All reports not covered under one of the three specific report designers are called standard reports. Examples
of standard reports are journal reports, general ledger reports, utilization reports, checks, etc. All standard
reports can be copied and modified using the Report Management applet. You cannot modify the original
report, but you can mark it inactive.

For more information about Standard Reports, see the Report Management section of this manual.

Custom Reports

This designer allows the end user to construct their custom reports that will be housed in the application and
will appear on InFocus menus. Knowledge of SQL is required. 

For more information about Custom Reports, see the Custom Reports section of this manual.

2.2.11 Common Tools/Processes

2.2.11.1 Batch Entries

Overview  

Batches allow the user to manually input transactions into the system and check them against the Batch
Amount (Total). Once all transactions are entered, the user can then post them in the Batch.
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Key Concepts & Settings

Batch entry must be enabled by checking Use Batch Entries in Journals in Administration>Global

Settings>General Tab.

When enabled, a Batch ID is visible in the top-right of supporting journals. There you can assign/edit the

batch associated with the transaction.

Batch entries are available in all journals except for the General Journal (General Accounting>General

Journal)

Batches can be created via Menu>Tools>Batches or by clicking Batches from the toolbar.

More on working with Batches

Field Descriptions 

Batches Header

Batch Count - Number of Transactions in the Batch that is being added.

Batch Amount - Dollar amount that is to be used in the Batch.

Add Batch - Adds Batch to the Batched Grid.

Batches Top Grid

Select - Select the batch for approval. By clicking "Close Selected Batches", you are Posting the entries.

Batch ID - When you click Save, the system will then add a batch to the list with a unique batch ID.

Note - When you add transactions, you can enter a Batch ID. All subsequent new entries will then default to

that Batch ID.

Transaction Count - The Batch Count that was entered before the Batch was added to the list.

Entered Count - The number of the transaction associated with the Batch. They are added by selecting

the Batch ID in the top-right of the journal and clicking Save.

Batch Amount - The Batch Amount that was entered before the Batch was added to the list.

Entered Amount - The Amount of the transaction associated with the Batch. They are added by selecting

the Batch ID in the top-right of the journal and clicking Save.

Batches Bottom Grid

Firm Code - The Code of the Firm associated with the transaction.

Firm Name - The Name of the Firm associated with the transaction.

https://support.clearviewsoftware.net/articles/5289
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Invoice No. - The Invoice/Check No. associated with the transaction.

Invoice Date - The Invoice/Check Date associated with the transaction.

Amount - The Amount associated with the transaction.

2.2.11.2 Bookmarks

Overview  
Bookmarking a transaction helps a user find a commonly used transaction quickly. It is useful in copying a

transaction as a new transaction.

Key Concepts

Bookmarks are available in all journals. 

There are two Bookmark icons in the toolbar of a journal. The one to the left is disabled until you have a

transaction on the screen.

o Bookmark Button - When selected, this button "Bookmarks" the transaction that is currently pulled up

in the journal.

o Bookmarked Button - When selected, this drop-down selects the "Bookmarked" transaction.

2.2.11.3 Passwords

Overview

Password management is key to securing InFocus. Each InFocus user has the ability to change their

password at any time via Help>Change Password from all screens. Additionally, InFocus admins can fully

manage user passwords by establishing company policies related to strength and expiration, setting user

passwords and pushing out required resets.

Best Practices

Our recommended best practice is to establish a global company policy for passwords. This will streamline

the general management of passwords and how often users must change them. 

Once established, the admin can then explicitly set passwords and force a reset for new users or as

otherwise needed.
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Password Management

Admins

From and administrative perspective, passwords are managed via the Administration Module.

Establish a password policy

1. Browse to AD>Global Settings>General Tab>Password Settings Section.

2. In the Password Settings area, configure the following options

o Min. Password Length - Sets the minimum character length for passwords

o Password Expire Days - When set, InFocus will prompt users to change their password according to

the configured value

o Require Number - When checked, user passwords must include a number

o Require Special Character - When checked, user passwords must include a special character

o Require Lower Case Letter - When checked, user passwords must include a lower case letter

o Require Upper Case Letter - When checked, user passwords must include an upper case letter

Managing User Passwords

1. Browse to AD>Permissions

2. Clicking the user lockbox

3. Complete the password dialogue

4. Click Save

Password Reset

1. Browse to AD>Permissions

2. Check the Require Reset box for the appropriate user(s)

Upon next login (whether through InFocus Desktop or Mobile) the user will be prompted to reset their

password.

Users

Description - InFocus users can change their password at anytime via the following methods.

InFocus Desktop

1. Browse to Help>Change Password

2. Complete the dialogue. If no password has been given, leave the current password field blank.
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3. Click Save

InFocus Mobile

1. Browse to your InFocus Launch URL

2. Click Login to InFocus Mobile below the InFocus Launch button

3. Login to InFocus Mobile

4. Click Reset Password

5. Complete the dialogue. If no password has been given, leave the current password field blank.

6. Click Save

2.2.11.3.1  How To

2.2.11.3.1.1  Change Passwords

InFocus users can change their password at anytime via the following methods.

InFocus Desktop

1. Browse to Help>Change Password
2. Complete the dialogue. If no password has been given, leave the current password field blank.
3. Click Save

InFocus Mobile

1. Browse to your InFocus Launch URL
2. Click Login to InFocus Mobile below the InFocus Launch button
3. Login to InFocus Mobile
4. Click Reset Password
5. Complete the dialogue. If no password has been given, leave the current password field blank.
6. Click Save

  Back to Starting up a new system

2.2.11.3.1.2  Reset a User Password

From and administrative perspective, passwords are managed via the Administration Module. To reset a
user's password, please complete the following:
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1. Browse to AD>Permissions
2. Clicking the user lockbox
3. Complete the password dialogue
4. Click Save

2.2.11.3.1.3  Reset the Admin Password

Overview

If the administrator’s password is lost, contact Clearview Software via support@clearviewsoftware.net or 804-
361-6300 for instructions on resetting the password.

2.2.11.4 Recurring Entries

Overview  

Recurring Entries allow you to create journal entries that occur multiple times over a time frame. 

Key Concepts

Recurring entries can be made for all journals except Employee Reimbursable, Receipts and Cash

Disbursements. Recurring entries are implemented by using a mass copy operation.

To make a recurring entry, you must first enter one transaction. After entering a transaction, click on the

"Recurring Entry" button located on the toolbar to copy a specified number of times, beginning with a

specified G/L period.

In the case of purchases and sales, the assigned invoice number is the same as the G/L period code.

The "Recurring Entry" button becomes activated when you recall an existing transaction to the screen.
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This will be the transaction it copies.

The user must have the required G/L periods established. They do not have to be open periods.

Field Descriptions 

Number of Transactions - Number of copies

G/L Period - The G/L Period is the first or starting period for the first copy. It will automatically increment

for each subsequent copy.

Transaction Date - The first transaction date for the first copy automatically adds thirty days for each

subsequent copy.

  

2.2.11.5 Queries Applets

Overview 

There are seven query applets in InFocus: Client, Contacts, Firms, Opportunities, Vendors, Projects, and

Employees. 

Key Concepts

The concept of the query tools is to allow the user to define lists of data based on a user query definition

without having to necessarily know how to write SQL code to get results. 

The list can then be used to navigate to the individual records within the list or can be exported to Excel.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

New Query - This brings up the Query Designer which allows you to create a reusable query. This action can also be

called by Right-Clicking in the Queries Window.

Edit Query - This brings up the Query Designer which allows you to edit the selected query. This action can also be

called by Right-Clicking in the Queries Window.

Delete Query - This brings up the Query Designer which allows you to delete the selected query. This action can also

be called by Right-Clicking in the Queries Window.

Field Descriptions 
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Queries Window

Queries Window - This window contains all of the queries that have been created within the Queries

Applet.

Parameters Window

Description - The Parameters window displays the Parameters selected on the Input Tab.  Here you are able

to filter the data using the selected Field, choosing an Operator (>,<,=, etc.)  and adding a Value 1 and/or

Value 2 value.  When you click Run, the data returned in the Results window will be filtered. 

File - The table name that the selected field is retrieved from.

Field - The Column Name of the field that is retrieved.

Operator - The comparison method that is used to compare the Field to the Returned Data. Examples are

>,<,=, etc. This is used to filter the Results list.

Value 1 - The first value that is used to compare the Field to the Returned Data.  It is used in conjunction

with the Operator to filter the Result list.  

Value 2 - The second value that is used to compare the Field to the Returned Data when using the

Between Operator. It is used in conjunction with the Operator to filter the Result list. This acts as the

second value in the range. 

Results Window

Description - The Results Grid gives you the results of the Parameters entered in the Parameters Grid and

the selections made on the Query Designer. The columns are dependent upon the selections made on the

Output tab in the Query Designer. More on the Query Designer

Running a Query

Click on the Run button to fill the Results tab based on the query definition. If the result sets contain any

key fields, they will appear in blue with an underline (like an internet hyperlink). By clicking on one of

these, the associated master file screen will launch, with the associated record filled in. The primary key

fields are vendor code, client code, project path, and employee code.

Dragging a Result column to the area above the Results grid will group the results in a hierarchical style.

Clicking on the Export button will prompt the user for a filename. This will be the Excel file to which the

result set is exported. Note:  If the results set was grouped, the grouping will be preserved in the export.

2.2.11.5.1  Query Designer

Overview 
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The Query Designer pop-up allows you to create named queries that allow you to bring back data specific to

the applet that it references.

Field Descriptions 

Definition Tab

Name -  Name of query as it will appear to user. Must be unique.

Type - Query type. There are three choices: personal, private and public. Personal queries are visible only

to the user who designs them. Private queries are only available to users who have permission to view

private queries. Public queries are viewable by everyone. The type of query a user is allowed to create

depends on permissions.

Use Manual Filter -  When checked, the user can enter a manual filter. This is an advanced option.

Manual filters are SQL 'Where Clauses'.

Input Tab

Description - The input tab is where you can specify input parameters and filters for your query. An input

parameter prompts a user for values of fields to filter or limit the query by. A filter is a predefined limit to the

returned data, for which the user is not prompted.  The Parameters selected here display in the Parameters

Window grid on the main queries screen.

Table - InFocus table name. See data dictionary for more information.

Column - InFocus column name. See data dictionary for more information.

Parameter - When checked, this column will appear as a prompt.

Filter - When checked, the result set will be filtered by this column using the following three fields to

define the filter.

Filter Operator - Choices are =, <>, >, <, >=, <=, between, and is not null. Is not null is synonymous with

a blank or empty field.

Filter 1 -  Used with all filter operators except is not null. This is the value that completes the filter

operation (except in the case of the between operator). In the case of the between this represents the

lower range.

Filter 2 - Used only with the between operator. This represents the upper range.

Output Tab

Description - The output tab defines what columns appear in the Results Window on the main queries

screen.

Table - InFocus table name. See data dictionary for more information.
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Column - InFocus column name. See data dictionary for more information.

Display Name - Column name that should be used in result set. If left blank, InFocus column name will be

used.

Show - When checked, column will appear in result set.

Column Order - Numerical order from left to right where column appears in result set.

Sort Order - Numerical sort precedent for sorting result set. For example, if you want to sort first by state

and then by city, put a 1 on the state row and a 2 on the city row.

Ascending - When checked, data is sorted in ascending order if a sort order is specified; otherwise,

descending order is used.
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3 InFocus Setup

3.1 Initial Setup

Overview

Once you have installed the InFocus application, you will need to initialize the system prior to set-up for

actual use. InFocus installs with an empty password on an Admin login account. You use this account to set

up and account for the employee who will act as system administrator. This employee will typically be granted

full access to all modules within InFocus. The best practice is to create a user group titled "Admin" within

InFocus and assign the administrator to this group. By using a group, you will be allowing for the potential

assignment of other employees as administrator in the future. 

Login

When you first launch InFocus you will be prompted to login. Type in "Admin" and then click Login. Note, the

Admin login exposes the following applets: Time Sheet Groups, Employees, Permissions

System Setup

Below is a step-by-step guide to initial system setup

1. Time Sheet Groups - Once you are logged in, the first thing you need to do is create a Time Sheet

Group. For detailed instructions, go to Creating Time Sheet Groups under the Setting up your Program

section of this manual. 

2. Create System Administrator  - Next you need to add the employee who will be the system

administrator. For detailed instructions go to Creating An Employee under the "Employees" section in the

Setting up your program section of this manual. this time, only minimum information can be entered:

Code, First Name, Last Name, User Name (which can be auto-generated) and Timesheet Group.

3. Create Admin Group - Once the employee has been added, use the permissions applet to first create an

admin group. To create an Admin group, refer to the Creating Groups and Users section  in the Security

and Permissions section of this manual. 

https://support.clearviewsoftware.net/articles/5341
https://support.clearviewsoftware.net/articles/5342
https://support.clearviewsoftware.net/articles/5582
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4. Create an Administrator - Once the Admin group is created, add the employees to the group. For

detailed instructions go to the Members Tab section  under the Setting up Your Programsection of this

manual.

5. Set Permissions - Finally, to assign permissions to the "Admin" user, refer to the User Permissions

section of this manual. Refer to the Group Permissions section of this manual if you are assigning

permissions to a group. Set the permissions for this group to have all rights for all applets in the system.

See the Security and Permissions section in this manual for further detail. Please note, it is a good idea

to establish a password for the Admin account. While logged in as Admin choose Change Password for

the Main Screen help tool menu. Here you will be prompted for the new password. Refer to the

Passwords section of this manual for details.

At this point you can log out of the system and re-login under the new user "Admin" account. Your menu

should contain the complete list of applets in the InFocus system.

3.2 Application Setup

Overview
The following tutorial explains the continuous setup of InFocus after you have followed the steps in the Initial
Setup section of this manual.

Order of Setup

The applets below are given to you in the order in which you would set them up to begin use. The one
notable exception is global settings. While many of the fields in global settings should be setup up initially,
some will require returning to global settings after other section setups are completed.

List Management

Administration>List Management

Lists are found in most drop-down boxes in InFocus, as well as in cases where there are more than two
selections. Lists can be of two types System and User. System lists cannot be added to, edited, or deleted.
System lists are viewable for reference purposes only. User lists are completely in control of the user. You
can add, edit, delete and reorder these lists. Please note, the use of the individual lists will be referenced
after the overview of the pertinent setup module. 

For more detailed information, see the List Management section of this manual.

Global Settings 
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Administration>Global Settings

Global settings contain all system-wide settings for InFocus. In general, settings are configuration switches
for the application. Typically, these are set during the initial installation of the application or when needed
modules are brought into use. While many of the settings can be set up immediately upon installation, some
settings must be configured after their corresponding module has been initialized. This is especially true for
settings that act as default values. 

For more detailed information, see the Global Settings section of this manual.

Organizational Units

General Accounting>Organizational Units

Organizational units represent the corporate structure. They can contain an infinite number of levels.
Examples of levels would be division, office, discipline or department. They can also be used for target
markets, though that may be handled better using the market sector feature in InFocus. Employees, projects
and G/L base accounts can be attached to org units in various scenarios. Employees can be assigned only
to the lowest level of the org structure. This ensures proper revenue recognition calculations. Projects can be
shared among org units at the specified level established in global settings. Projects can be owned at any
level equal to or above the share level. In the case of project charging, allowable org units include not only
the established owner or sharing org unit, but all its children. 

For more detailed information, see the Organizational Units section of this manual.

Chart of Accounts 

General Accounting>Chart of Accounts

Chart of Accounts represents the allowable G/L Accounts. An allowable G/L account is comprised of
potentially two parts: a base account and, optionally, an organization path. In other words, base accounts
can be attached to any org path In other words, base accounts can be attached to any org path, or to no org
path. Base accounts also contain properties that interact with project management and accounting
processes.  This is where the integration of accounting and project management is established.

For more detailed information, see the Chart  of Accounts section of this manual.

GL Budgets 

General Accounting>G/L Budgets

Budgets can be maintained for any and all general ledger accounts per accounting period. Budgets for both
accrual and cash balances can be entered. Budgets can appear and be part of calculations in financial
statements. 

Show Budgets For: Choices are Accrual, Cash or Both. 

Fiscal Year: Designates fiscal year for budgeting. 

All columns can be both pinned (column does not scroll) and filtered (only rows with designated column value
will show). The push pin in the column header controls pinning and the funnel in the column header controls
filtering. 
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For more detailed information, see the GL Budgets section of this manual.

Clients

Accounts Receivable>Clients

Clients, vendors and prospects are all considered Firms in InFocus. When you add a client it can later be
flagged to also act as a vendor or vice verse. Prospects are firms that you are hoping become clients. Once
they become clients they are no longer considered to be prospects. Clients are required for billable projects. 

For more detailed information, see the Clients section of this manual.

Expense Groups and Codes

Project Administration>Expense Codes
Project Administration>Expense Groups

Expense codes provide two primary functions. First, they allow for non-labor expenses to be grouped into
categories. This is beneficial because it allows for billing categories to be established without the need for
changing the chart of accounts. For instance, if a client demands that air travel is separated from local travel,
you would not have to set up a separate ODC travel G/L account. Secondly, Expense Groups and Codes
provide a mechanism for varied unit billing and markups. Once expense codes are established, they are then
placed in expense groups. An expense code can belong to many groups. In turn, groups are applied to
projects. Groups also can have effect dates allowing for the revision of markups/rates on perhaps an annual
basis. Basically, expense groups are the expense equivalent of labor rate schedules. 

For more detailed information, see the Expense  Groups and Codes section of this manual.

Vendors

Accounts Payable>Vendors

Like clients, vendors are also firms. If the vendor you want to set up already exists as a client or prospect,
simply recalling the firm to the screen and clicking on Save will establish it as a vendor. Vendors are a
requirement to maintain accounts payable sub-ledgers. 

For more detailed information, see the Vendors section of this manual.

Job Titles

Human Resources>Job Titles

Job Titles can be established for employees. Examples of a job title are Senior Mechanical Engineer,
Surveyor, Cad Operator etc. Employees can be assigned to one or more job titles. At the project level,
employees can be assigned an override set of job titles. Rate schedules can be set up based on job titles.
Job titles also can provide the G/L posting accounts for labor distribution. These posting accounts override
those in global settings. 

Code: Job title code 

Title: Job title name 

Active: Flag indicating if job title is active.  

For more detailed information, see the Job Titles section of this manual.



InFocus Setup 57

© 2020 Clearview Software, Inc.

Labor Codes

Project Administration>Labor Codes 

Labor Codes are used to group time together for items (such as site time, meetings, phone call, etc.) that are
not part of the WBS. Labor codes can be subtotals in project management reports. They are not exposed in
billing, nor do they have budgets. Labor codes, when set up, are global and can be used against any project.
 They can be restricted to direct or indirect projects. 

Active: Indicates if labor code is active.

Labor Code: Labor Code

Labor Name: Labor Name

Type: Designates what type of project the labor code can be used with (direct or indirect).
Note that Indirect refers to all non-direct project types.

For more detailed information, see the Labor Codes section of this manual.

Timesheet Groups

Human Resources>Employees

Timesheet Groups provide a mechanism for the preparation of time sheet coverage periods. Timesheet
coverage periods simply means the starting date and ending date for a time sheet. InFocus allows for
multiple time sheet coverage periods. For instance, you can have a group of employees putting in weekly
timesheets and another putting in biweekly timesheets. You can even have multiple groups putting in weekly
timesheets but each starting on a different day of the week. 

For more detailed information, see the Timesheet Groups section of this manual.

Employees

Human Resources>Employees 

Employees and sub-contractors are entered in employee setup. These are the only items that can have time
sheets entered against them. InFocus is licensed-based on active employee count (subcontractors count as
employees). 

For more detailed information, see the Employees section of this manual.

WBS Templates 

Project Administration>WBS Templates

Work Breakdown Structure Templates are tree fragments. They can represent multiple levels of nodes linked
together or simply one unlinked level. WBS templates are used for fast WBS setups. After creating a project
or WBS structure you can right click on a node and apply a WBS template to that node or all nodes of the
same level. Please note that WBS codes must be unique with respect to parent node within a template.
Since the top level has no parent nodes all top nodes must be unique among themselves within the template.

For more detailed information, see the WBS Template section of this manual.

Rate Schedules
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Project Administration>Rate Schedules

Rate schedules are used to control job cost and bill rate schedules in the application. Once rate schedules
are setup they can then be applied to projects. Rate schedules are date sensitive so as to all period changes
to schedules perhaps on an annual basis. When time sheets are entered or edited in the system they
immediately pick up rates and store them in the time sheet module so that they are available for reporting. If
you want to apply rates retroactively to time entries, this can be accomplished via the Recalculate Rates
Utility. 

For more detailed information, see the Rate Schedules section of this manual.

Projects

Project Administration>Projects

There are five types of projects in InFocus: billable, indirect, projection, opportunity, and plan. Billable
Projects can be invoiced and require a client. Indirect Projects are overhead projects that can be charged to
but never invoiced. Opportunities are similar to Indirect Projects but, are client-related, and charges can be
placed on hold. If an Opportunity becomes a Billable Project, the charges on hold can then be either billed or
written off. The final two, Projection and Plan, cannot receive charges. Plans exist only for the purpose of
project planning. Projections are used to record estimated revenue for future endeavors. Projects can always
change their type. All projects can have an unlimited breakdown, called the Work Breakdown Structure
(WBS). You can assign names to the levels of the WBS such as phase and task. An entire WBS can be
created from a template project, or portions of the WBS can be constructed from WBS templates. 

When a project is first created, the top level is known as the Bill Terms Node (Project). This is the node that
receives the bulk of the project information, such as who the client is, what type of project it is, etc. All
nodes beneath the Bill Terms Node (Project) can

have limited information entered such as contractual caps, allowable charging date ranges, budgets and rate
schedules. While the Bill Terms Node (Project) is typically the top node, it can also live at the second level.
This is accomplished by inserting a roll-up

node above the Bill Terms Node (Project). In this way multiple Bill Terms Nodes (Projects) can be grouped
together for project reporting purposes. Charge levels are important in the setup of projects. Charge Levels
need to be established for ODC, OCC and ICC

charges. The setting dictates to what level of the WBS that charges can be applied.  By default that level is
the bill terms level. Labor can only be charged to a bottom node (a node with no children). 

For more detailed information, see the Projects section of this manual.

Accounting Periods

General Accounting>Accounting Periods

Accounting periods (also referred to as G/L periods) need to be established before transactions (other than
time sheets) can be entered into the system. 

For more detailed information, see the Accounting Periods section of this manual.

Firms

Marketing>Firms

Firms are organizations that you have done business with or would like to do business with. They can be
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vendors, clients, or prospects. Any entry in firms is also accessible from the client and vendor applets. The
Firm navigation screen is laid out like a rolodex with alphabetic tabs representing the first letter of the firm
name. An All tab contains all firms. On each tab, one or more columns will show specific data about the firm,
such as firm name or main phone. These columns are customizable by the user. If you click on a firm inside
of a tab a detail form will come up for that firm where you can view or change the data, depending on your
permissions. The New Firm button on the tool bar allows you to enter a new firm. Note that only clients and
prospects can be added from this form. By default the system assumes prospect. There is also an export
button to export the contents of the grid on the currently selected tab. 

For more detailed information, see the Firms section of this manual.

Opportunities

Marketing>Opportunities 

Opportunities are a specific type of project, typically a marketing effort. Time and expense can be charged to
opportunities. Opportunities are treated as indirect projects. The opportunity applet is a streamlined view of
opportunity projects. Opportunities can also be accessed from the main Project Setup applet. The
Opportunity applet exposes certain columns of a project that are relevant to opportunity projects. For
instance, there is no billing/invoice information since it is not applicable. The navigation for the opportunity
applet is a grid. You can click on any column header to  either sort by that column or to filter by that column.
Clicking on a row in the grid will bring up the Opportunity Detail screen for that opportunity. There is also an
export button to export the contents of the grid.

For more detailed information, see the Opportunities section of this manual.

Contacts

Marketing>Contacts

Contacts, in general are people. They can be employees of your company or employees of a firm with which
you do business. Contacts can also be associated with project's but only contacts for that projects client. In
other words, contacts cannot exist for a project that does not already exist for that project's client. 

For more detailed information, see the Contacts section of this manual.

User Defined Fields

User definable fields can be created for the following applets in InFocus: Clients, Employees, Vendors,
Projects, Contacts. Whenever you are in one of these five setup screens, a "UDF Designer" button will
appear on the tool bar, assuming you have proper permissions. You can also access any of the UDF
designers from the UDF Designer applet located in the Administration module. 

For more detailed information, see the User Defined Fields section of this manual.

Addresses

Addresses can be set up for the following items in InFocus:

Company - Refers to the licensed operator of InFocus, and is accessible via global settings.

Firms - Is accessible in Firms, Vendors, and Client screens, as all are considered firms.

Projects - Can inherit client addresses.

Employees - Can have both a work and home address.
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Contacts - Refer to people, either employees or members of vendors and clients.

Addresses can be NAMED to categorize addresses for reuse. For instance, clients may have many office
addresses. You can set up an address for each office, and then associate client contacts with a particular
office address. If the information of the NAMED address changes, you can cascade those changes to all
associated (linked) addresses in entirety, or only for fields that have a value. Sometimes addresses have
specific uses, as in the case of Bill To, Pay To, and Remit To addresses. These can be unassociated
addresses or linked addresses. Most often they will be linked addresses, which means you will first want to
enter them as a named address prior to referencing them as a Bill To, or Remit To. 

For more detailed information, see the Addresses sections of this manual.

Notes

Notes can be recorded for firms, contacts and projects. There is no limit to the number of notes or the length
of any singular note. Notes are stored with a date and time stamp of when they are entered. While the
creator of the note is also recorded, all users allowed into a particular Notes applet can access all notes,
regardless of creator. Activities can also be associated and established with notes. Activities are calendar
events. Before you can enter a note you need to establish a least one activity type in List Management. Note
that types are used to categorize notes. Examples of note types might be marketing or customer support.
Before you can enter an activity, you need to establish a least one activity type in List Management. Activity
types are used to categorize activities. Examples of activity types might be call back or appointment. 

For more detailed information, see the Notes section of this manual.
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4 InFocus Modules and Applets

The following chapters are arranged in the order that they appear in the InFocus program, starting from the
top of the Modules and working downward. Within each Module you have the Applet sections that are
described. Within each Applet section, there is an explanation of each Tab and/or Toolbar that affects that
screen. At the end of each Applet section, there is a "How To" section that describes most of the functions
that you may need to use. To understand more about the InFocus Interface, see the InFocus UI Basics
section of this manual.  

4.1 Dashboard

Overview

The starting place in InFocus is your Dashboard- it is the first thing you see when logging in and can serve as
a launch pad for business analytics and streamlining your work in InFocus.

Dashboards in InFocus are sourced from one of two types: Classic and Analytic.

Classic Dashboards

Classic Dashboards allow you to augment InFocus and streamline common activities. For instance, receive
an alert when a project goes over budget or when Receivables go past due. Alternatively, many reports in
InFocus can be run, directly from Classic Dashboards and Gridgets, allow you to display- even update- data
through a dynamic grid.

Analytic Dashboards

Analytic Dashboards use rich data visualizations allowing you to perform business analysis and gain powerful
insights into your data. For instance, view Utilization across departments with running trend lines. Use 
Charts, Grids, Maps, etc. to dynamically filter and interact with your data - all in real-time.

More on Classic Dashboards
More on Analytic Dashboards

4.1.1 Dashboard Applet

Dashboard Applet

Classic and Analytic Dashboards are housed and consumed through the Dashboard applet which makes
accessible all dashboards a user has permission to consume.

Permissions to each dashboard is managed using Dashboard Groups (UT>Dashboard Groups).
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Field Descriptions

Menu Options

File

Dashboard - Quick link back to the Dashboard

Logout - Logs the current user out of InFocus

Exit - Exists the application

Dashboards

Displays a list of all available Dashboards for the logged in user. The user can easily switch between
Dashboards by selecting the Dashboard from the list or using Ctrl+Shift+Number where the number
represents the number assigned to the Dashboard in the list. Example: Ctrl+Shift+1 loads the 01 -
Dashboard.

Configure

Dashboards - Launches the Dashboard dialogue through which available Widgets and views can be
added and configured or removed. Analytic Dashboards can additionally be configured to show a
particular view as the default (Default Load). Available widgets and views are determined by the governing
Dashboard Group the user is assigned to.
o Widgets View - Use this option to hide and/or show Widgets available to the currently loaded

Dashboard
o Analytic Dashboard Container - Use this option to show/hide the Analytic Dashboard views. Optionally

set one of the views as the Default Load, which will automatically load the selected view when opening
the Analytic Dashboard.

Save Current Layout - This saves the current layout of the loaded dashboard. If administering the
"Default" dashboard for a Dashboard Group, this option saves the layout for that dashboard and affects
all user instances of it.
Reset Layout - This reverts the loaded dashboard back to the most recently saved layout of that
dashboard

Help (see InFocus UI Basics for descriptions)

Toolbar Options

Refresh All Widgets

Refreshes widgets on the currently loaded dashboard.

4.1.2 Classic Dashboard

Overview

Classic Dashboards allow you to augment InFocus and streamline common activities. For instance, receive
an alert when a project goes over budget or when Receivables go past due. Alternatively, many reports in
InFocus can be run, directly from Classic Dashboards and Gridgets, allow you to display- even update- data
through a dynamic grid.
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Classic Dashboards consist of Widgets that gives real-time access to the most important aspects of your
work in InFocus. The Widgets available to a user's Dashboard are governed by the Dashboard Group the
user is assigned to. Once available Widgets have been assigned to a Dashboard the user can then order
and size the Widgets to create a layout meaningful and helpful to them. 

Below are the applets involved in configuring Classic Dashboards. Each applet is available from the Utilities
Module

Dashboard Queries Manager

Dashboard Groups

Next: Classic Dashboards - Moving Parts

4.1.2.1 Moving Parts

Overview

Like any other report, Classic Dashboards rely on a dataset- we call this a Dashboard Query. Each query is
written for the widget it supports (e.g. Chart, Alert, Tile, etc.) and draws from a data source (typically
InFocus).
 
Each aspect of Classic Dashboards is governed by assigned User Permissions.

Moving Parts

Permissions - Govern user access to applets, models and dashboards

Data Source - The source of data used in the Dashboard Query. Defaults to InFocus, but third party data
sources are supported
Dashboard Widgets/Queries - Dashboard Widgets are populated through Dashboard Queries

Dashboard Groups - Used to distribute Dashboards

Next: Classic Dashboards - Permissions Setup

4.1.2.2 Permissions

Overview

Permissions for working with Classic Dashboards are assigned in AD>Permissions. 

Please complete the steps below to grant permissions as appropriate to the applets used by this tool.

Tutorial

1. Browse to Administration>Permissions
2. Select the Groups and/or Users you wish to grant permissions to
3. On the row next to the Group/User, click the lockbox. A dialogue will display.
4. From the Groups and/or Users Permissions tab, grant permissions as appropriate. Below is a list of

permissions and what they grant access to.
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5. Once the permissions have been selected, click Save.

Module Applet Special Rights Description

Utilities Dashboard Groups n/a Access to manage
Dashboard Groups.
Analytic Dashboards are
distributed via
UT>Dashboard Groups.

Dashboard Groups Can Save Default Layout Access to save a
dashboard design layout
as the default view

Dashboard Queries

Manager

n/a Access to manage
Analytic Models and other
Classic Dashboard queries

Marketplace Purchases n/a Access to download and
distribute Analytic Models
and Classic Dashboard
widgets from InFocus
Marketplace

Query Builder n/a Access to Query Builder
applet (optional -
advanced users only)

Next: Classic Dashboards - Data Source Setup

4.1.2.3 Data Source Setup

Overview

As discussed, each Dashboard Query relies on a data source for the data it contains. Classic Dashboards
support both native (InFocus) and third party data sources- selected when building the query. This means
that, in addition to your InFocus data, you can utilize outside data across other areas of business.

Third party data sources are considered either external (e.g. SQL Database, etc.) or custom. External Data
Sources can be configured globally in AD>Global Settings or when building the Dashboard Query using a
connection string.

Note

Most users will simply use the default InFocus data source. If InFocus will be your only data source, no
additional data source setup is required.

Tutorial

1. Browse to Administration>Global Settings
2. Click the External Data Sources tab
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3. Complete the grid as appropriate
o If checked, Use Integrated Security will use Windows Authentication

4. Click Save

Next: Classic Dashboards - Dashboard Widgets/Queries

4.1.2.4 Dashboard Widgets/Queries

Overview

Dashboard Widgets/Queries are at the core of building classic dashboards. Dashboard Widgets are
populated through Dashboard Queries and as such they are generally used synonymously throughout
documentation on Classic Dashboards.

While we’ve given you the tools to build your own queries/widgets, Clearview offers several pre-written
widgets- available through InFocus Marketplace.

Whether downloaded or custom built, Dashboard Widgets/Queries are managed in the Dashboard Queries
Manager applet.

Tutorials

Installing Widgets from InFocus Marketplace

As mentioned above, Clearview offers several InFocus-optimized widgets, available in the InFocus
Marketplace. Below are the steps for downloading and installing your first widget.

1. Browse to InFocus Marketplace
2. Select a Dashboard Widget
3. Download/Purchase the widget

Once downloaded, complete the following steps in InFocus:

1. Browse to UT>Marketplace Purchases. Note, if you don’t see this applet, ensure you have permissions
via AD>Permissions (listed under Utilities>Marketplace Purchases).
2. Select the Dashboard Widget
3. Click Install/Update from the toolbar
4. Click the Manage link (gear icon to the right of the model)

Your Widget is installed and ready to be managed via UT>Dashboard Queries Manager.

Next: Distributing Classic Dashboards

https://support.clearviewsoftware.net/marketplace
https://support.clearviewsoftware.net/marketplace
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4.1.2.5 Distributing Classic Dashboards

Overview

Classic Dashboards are configured and distributed through Dashboard Groups using the Widgets listed
there.

Click for more information on working with Dashboard Groups

Setup Complete 

Further details on managing/using Classic Dashboards is available by clicking the links below.

Dashboard Queries Manager 

Dashboard Groups

Configuring a Classic Dashboard

4.1.3 Analytic Dashboards

Overview

Analytic Dashboards use rich data visualizations allowing you to perform business analysis and gain powerful
insights into your data. Analytic Dashboards are built on two components: Data and Design. As such, we’ve
built dedicated applets for working with each. Each applet is available from the Utilities Module.

Dashboard Queries Manager 

Analytic Dashboard Designer

Analytic Dashboards Applet

Depending on your firm’s environment, you may have different staff managing the data and design separately
(e.g. someone who writes/manages the queries and someone else who designs the dashboards based on
those queries). Generally, documentation of this feature will follow this tone. However, if you fill both of these
roles- not to worry- both components can be easily managed by one user. Regarding data/queries, Clearview
offers several queries optimized for InFocus- available through InFocus Marketplace.

In the discussion that follows we’ll cover the moving parts of Analytic Dashboards, what’s involved with
setup for building and managing them, and how to distribute your new dashboards.

Note It’s worth pointing out that this discussion focuses heavily on the administration of this powerful tool.
Most users will simply interact with either the design tool (described below) or the finished dashboards
themselves.

Next: Analytic Dashboards - Moving Parts

https://support.clearviewsoftware.net/articles/4249
https://support.clearviewsoftware.net/marketplace
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4.1.3.1 Moving Parts

Overview

As previously mentioned, Analytic Dashboards are built on the components of data and design.

Like any other report, Analytic Dashboards rely on a dataset- we call this an Analytic Model. Each model
contains a query that draws from a data source.

Analytic Models provide the data for designing dashboards, which can be done with the Analytic Dashboard
Designer. Created dashboards are then managed in the Analytic Dashboards applet.
 
Each aspect of an Analytic Dashboard is governed by assigned User Permissions.

Moving Parts

Permissions - Govern user access to applets, models and dashboards

Data Source - The source of data used in Analytic Models. Defaults to InFocus, but third party data
sources are supported
Analytic Models - Datasets used to design dashboards. InFocus-optimized models are available in
InFocus Marketplace. Additionally, models can be built and managed with Dashboard Queries Manager
(UT>Dashboard Queries Manager).
Analytic Dashboard Designer - Design tool used to create your Analytic Dashboards. Available in
UT>Analytic Dashboard Designer
Analytic Dashboards - Applet used for managing Analytic Dashboards (UT>Analytic Dashboards)

Next: Analytic Dashboards - Permissions Setup

4.1.3.2 Permissions Setup

Overview

Permissions for working with Analytic Dashboards are assigned in AD>Permissions. 

Please complete the steps below to grant permissions as appropriate to the applets used by this tool.

Tutorial

1. Browse to Administration>Permissions
2. Select the Groups and/or Users you wish to grant permissions to
3. On the row next to the Group/User, click the lockbox. A dialogue will display.
4. From the Groups and/or Users Permissions tab, grant permissions as appropriate. Below is a list of

permissions and what they grant access to.
5. Once the permissions have been selected, click Save.

Module Applet Special Rights Description

Utilities Analytic Dashboard n/a Access to use the
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Module Applet Special Rights Description

Designer designer

Analytic Dashboards n/a Access to manage
Analytic Dashboard views

Dashboard Groups n/a Access to manage
Dashboard Groups.
Analytic Dashboards are
distributed via
UT>Dashboard Groups.

Dashboard Groups Can Save Default Layout Access to save a
dashboard design layout
as the default view

Dashboard Queries

Manager

n/a Access to manage
Analytic Models (and other
Classic Dashboard
queries)

Marketplace Purchases n/a Access to download and
distribute Analytic Models
(and other items) from
InFocus Marketplace

Query Builder n/a Access to Query Builder
applet (optional -
advanced users only)

Next: Analytic Dashboards - Data Source Setup

4.1.3.3 Data Source Setup

Overview

Each Analytic Model relies on a data source for the data it contains. Analytic Dashboards support both native
(InFocus) and third party data sources- selected when building the design. This means that, in addition to
your InFocus data, you can now visualize outside data across other areas of business- making InFocus a
central hub for business analysis.

Third party data sources are considered either External (e.g. SQL Database, etc.) or Custom (e.g. SQL,
OLAP, Microsoft Excel / CSV, etc.) and can be added when designing an Analytic Dashboard view. External
Data Sources can be configured globally in AD>Global Settings for use in other InFocus applets. Custom
Data Sources are added when designing with the Analytic Dashboard Designer.

Note

Most users will simply use the default InFocus data source. If InFocus will be your only data source, no
additional data source setup is required. You can skip to the Analytic Models Setup section below.
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Tutorial

1. Browse to Administration>Global Settings
2. Click the External Data Sources tab
3. Complete the grid as appropriate

o If checked, Use Integrated Security will use Windows Authentication
4. Click Save

Next: Analytic Dashboards - Analytic Model Setup

4.1.3.4 Analytic Models Setup

Overview

Analytic Models are at the core of building great dashboards. It is also worth noting that model is just
another term for query (e.g. "select * from ev_projecttransactions” or similar). While we’ve given you the
tools to build your own models, Clearview offers several InFocus-optimized models- available through 
InFocus Marketplace.

Whether downloaded or custom built, Analytic Models are managed in the Dashboard Queries Manager
applet.

Tutorials

Installing an Analytic Model from InFocus Marketplace

As mentioned above, Clearview offers several InFocus-optimized models, available in the InFocus
Marketplace. Below are the steps for downloading and installing your first model.

1. Browse to InFocus Marketplace
2. Select an Analytic Model
3. Download/Purchase the model

Once downloaded, complete the following steps in InFocus:

1. Browse to UT>Marketplace Purchases. Note, if you don’t see this applet, ensure you have permissions
via AD>Permissions (listed under Utilities>Marketplace Purchases).
2. Select the Analytic Model
3. Click Install/Update from the toolbar
4. Click the Manage link (gear icon to the right of the model)

Your Analytic Model is installed and ready to be managed via UT>Dashboard Queries Manager.

Managing Analytic Models

Below is a tutorial for managing Analytic Models and making them available to your designers.

https://support.clearviewsoftware.net/marketplace
https://support.clearviewsoftware.net/marketplace
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1. Browse to Utilities>Dashboard Queries Manager
2. Select Analytic Models from the drop-down

o Note, if Analytic Models have not been installed, download one from InFocus Marketplace to get
started.

3. Double-click the model you wish to manage
4. Edit the model as appropriate (click here for further details)

o Most users will simply work with distributing pre-written models (as discussed above)
o If writing your own model, as a best practice use Field Lists/Descriptions to describe the fields

contained in the model. This will be helpful when designing the dashboards.
5. Distribute the Model for use in the designer

o Click the Model Permissions tab
o Assign permissions as appropriate

6. Click Save

Click for more information on working with Analytic Models

Next: Analytic Dashboard Designer Setup

4.1.3.5 Analytic Dashboard Designer

Overview

Analytic Dashboard Designer applet features an intuitive, interactive design environment that displays your
dashboards in real-time as you build them. Each design uses a Data Source (defaults to InFocus) and an
Analytic Model. 

When clicking New, you’ll be prompted to select an Analytic Model- the data source will default to InFocus.
That said, you’ll note that the designer supports multiple data sources and multiple models per design
(advanced designs).

Once selected, you’re ready to begin using the design tools.

Tutorial

Let’s walk through this process together:

1. Browse to Utilities>Analytic Dashboard Designer
2. Click New
3. When prompted for an Analytic Model, click Yes.
4. Select a model from the list. Your model will load into the left hand pane.

o Note, if you don't see Analytic Models listed, it is likely because either you don't have permissions to
an Analytic Model, or there aren't any installed in your system. To fix, review Analytic Models Setup.

5. IMPORTANT - click the Refresh icon (circular arrows) above the Query list. This populates your analytic
model with data from the data source and makes it available to the design.

6. Design your Dashboard (watch a tutorial)
a. Insert an item (Pivot, Grid, Chart, etc.)
b. Drag-and-Drop your data fields into the Design Items pane as appropriate
c. Your dashboard will populate as you add fields and other items.

https://support.clearviewsoftware.net/marketplace
http://support.clearviewsoftware.net/articles/share/ea4851ef
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7. Click Save and complete the dialogue that appears
o Grouping is used to organize similar Analytic Dashboards together for display purposes.

Click for more information on using the Analytic Dashboard Designer

Next: Analytic Dashboards Applet Setup

4.1.3.6 Analytic Dashboards

Overview

Once an Analytic Dashboard is created, you’ll manage your new dashboard in the Analytic Dashboards
applet (UT>Analytic Dashboards). Similar to other reporting applets, Analytic Dashboards allow you to Edit,
Copy, Delete, Import and Export your dashboard. 

Additionally, designer permissions can be granted for others to work with the dashboard design. Other
management options include activate/deactivate, grouping, titles, etc. 

Note, Analytic Dashboards are actually distributed via Utilities>Dashboard Groups.

More information on the Analytic Dashboards applet

Next: Distributing Analytic Dashboards

4.1.3.7 Distributing Analytic Dashboards

Overview

Analytic Dashboards are distributed through Dashboard Groups using a new Widget type of Analytic
Container. An Analytic Container is simply used to list multiple Analytic Dashboard views in the Dashboards
applet.

Tutorial

To make your dashboard available to staff, complete the following steps:

1. Browse to UT>Dashboard Groups
2. Double-click a Dashboard Group
3. Select the Widgets tab
4. Check Allowed next to Analytics Container
5. Select the Analytic Dashboards tab
6. Check Allowed next to the appropriate Analytic Dashboards
7. Click Save
8. Click Configure Dashboard from the toolbar.
9. From the dialogue, click the green + located in the Dashboards drop-down (upper left)
10.  When prompted, enter a Name for the dashboard. This will be the name that shows on your dashboard

list.
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11.  Select the Analytic Dashboard radio button
12.  Click Create
13.  Double-click the Analytic Dashboard Container widget listed
14.  Check Show for the dashboard views you wish to display on the Dashboard
15.  Click Save

Note At next login those assigned to the Dashboard Group will see the newly created Analytic Dashboard.

Click for more information on working with Dashboard Groups

Setup Complete 

Further details on Analytic Dashboards are available by clicking the links below. You can also review this
setup in our Analytic Dashboard  - White Paper.

Dashboard Queries Manager 

Analytic Dashboard Designer

Analytic Dashboards Applet

4.2 Accounts Payable

4.2.1 A/P Check Writing

Overview 

Accounts Payable Checks are written from this applet. Checks processed from A/P check Writing are

generated from the Vendor Invoices that are entered manually into the Purchase Journal. More on the

Purchase Journal

Key Concepts

 The checks themselves are posted to the Disbursements Journal. More on the Disbursement Journal

Out of the box, InFocus checks use the Deluxe / Nebs DLM102 Check Stock Layout.  Other check stocks
are available in the InFocus Marketplace.

Custom Check stock can be developed for a fee. Please inquire through InFocus Support.

4.2.1.1 A/P Check Writing Toolbar

Overview

https://support.clearviewsoftware.net/articles/5609
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The A/P Check Writing toolbar gives the user (if given the appropriate permissions) numerous capabilities
within the A/P Check Writing applet. Below is a list of those capabilities.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Tools - Additional Tools options

o EFT Bank Info - This allows you to Add/Modify the EFT Bank information used when processing an

EFT.

o Save to Batch - This allows you to save your selections as a batch for future use.

o Load from Batch - This allows you to save your selections as a batch for future use.

o Clear Batch - This allows you to clear your selections from the batch.

Save to Batch - This allows you to save your selections as a batch for future use.

Load from Batch - This allows you to save your selections as a batch for future use.

Clear Batch - This allows you to clear your selections from the batch.

Clear Check Sessions - This is used when you receive and error message stating that another user is

currently writing checks against this bank account when no other users truly are.  This error can occur if a

user improperly exits InFocus in the middle of a check writing session.

4.2.1.2 Selections Tab

Overview

The Selection Tab displays the settings that determine which invoices are to be processed. Checks that are

processed from A/P Check Writing are generated from the vendor invoices that have been entered into the

Purchase Journal. The checks themselves are then posted into the Disbursement Journal.

Field Descriptions

Accounts

Bank Account - The bank account to which checks will be posted. More on Chart of Accounts

Void Check Account - G/L Account to use as offset for void checks. (All transactions in InFocus require at

least two sides).

A/P Account - A/P account to use for invoice selection. Leave blank for all.

Discount Account - G/L Account to use for net discounts.

Next Check Number - Next check number to use. Defaults from the next control number field of the bank

account record on the Account Associations tab in General Accounting>Chart of Accounts. The Edit

button next to the check number allows a user to directly change the next check number in this screen.
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Next EFT Number - Next check EFT number to use. Defaults from the next control number field of the

bank account record on the Account Associations tab (EFT column) in General Accounting>Chart of

Accounts. More on EFTs

Settings

G/L Period - The G/L period to which checks are posted. More on G/L Periods

Check Date - Date of checks

Default "Pay" to Selected - When checked, defaults to pay the selected invoices.

Date Range

No Range - When checked, no range will be used for invoice selection

Use Range - When checked, a date range will be used for invoice selection.

From - Starting date of invoice selection

To - Ending date of invoice selection

Apply to Due Date - When checked, invoices with a due date between the From and To Dates will be

selected.

Apply To Invoice Date - When checked, invoices with an invoice date between the From and To Dates

will be selected.

Vendors

All - When checked, open invoices for all vendors will be included.

Specific - When checked, open invoices for the specified vendors will be selected.

Printing

Print Check Number - When checked, the check number will print on the face of the check.

Check Report - Report design to be used to print the check. More on A/P Check Reports

Label Report - Report design  used to print check labels More on A/P Check Labels

Long Stub Report - Report design used to print long stubs. Long stubs are a separate report for checks

that cover more invoices than can be printed on one stub. More on A/P Long Stub Reports

EFT Report - Report design to be used to print the EFT check.More on A/P EFT Reports

Max. Number of Invs. on Check Stub - Maximum number of invoices that will fit on one check. The default

of 10 applies to the check report design that ships with InFocus.

4.2.1.3 Results Tab

Overview
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In the Results Tab, you will see a list of vendors (Firms) and respective invoices that were found based on

the settings from the selections step. The Results Tab is split into two grids: 1) the vendor grid and 2) the

invoice grid. Please note, selecting a row in the Vendor Grid will display the associated invoices in the Invoice

Grid. 

Field Descriptions

Vendor Grid

Pay/Unpay All - When selected, All items in the grid below are selected/unselected.

Pay - When selected, a check will be printed for his vendor.

Separate Check - When checked, a separate check will be printed for each invoice for this vendor.

Defaults to setting in Vendor Setup record.

Firm - Vendor 

Amount Due - Total amount due this vendor.

Amount Applied - Amount to pay vendor for this invoice. Defaults to the balance due of the invoice less

any discount. You can override this amount by changing the field value.

EFT - When selected, check will be processed as an EFT.

Invoice Grid

Pay/Unpay All - When selected, All items in the grid below are selected/unselected.

Pay - When selected, a check will be printed for this vendor.

A/P Account - Accounts Payable Account from the Purchase Journal.

Firm - Vendor name. Read only.

Invoice No. - Invoice number. Read only.

Invoice Date - Invoice Date. Read only.

Due Date - Due Date from the Purchase Journal.

Invoice Amount - Invoice amount. Read Only.

Amount Due - Amount due on invoice. Read Only.

Discount Amount - Amount of discount to take on invoice. Calculated based on Vendor Setup record

settings. You can override this amount here.

Amount Applied - Amount to pay vendor for this invoice.

4.2.1.4 Post Tab

Overview

In the Post tab, a user can print checks, post checks, and void checks. The grid on the top of the Post tab is
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the check queue. When you first enter this tab, the system will display a list of checks that have been

prepared to be printed. The normal operation is to first print the checks. Once you have printed the checks, a

flag will be marked next to the checks. You can now print labels and long stubs for all checks that are flagged

as printed. Finally, you post the checks to the Disbursement Journal. Checks will be posted for only those

checks that are flagged as printed (or voided). Once the checks have been posted, they are removed from

the queue.                                                                                          

Note -  In the case of printer jams you may need to void or reprint checks. The grid at the bottom of the

screen retains the list of voided checks.

Field Descriptions

Check Queue Columns

Printed - When checked, the check is considered printed. Once you have the printed the checks, the

'Printed" flag will be automatically checked next to the checks. 

Firm - Vendor. Read only.

Memo - Check memo to print on check face. Can be edited when check printed flag is not set. This Memo

can be pulled from the Check Memo box at Vendors>General Tab

Check Number - Check number. Read Only

Check Amount - Check amount. Read only

Check Queue Buttons

Void - When selected, a check range to have voided can be entered. All checks in the range will move

from the check queue to the void log and new check numbers will be assigned in their stead. Voids will

get posted along with regular checks. You cannot move a void back into the check queue without starting

over.

Print Test Check - Print test check should be done to plain paper and held over a check against a light

source to verify alignment. Test checks do not generate a void.

Print Long Stubs - When selected, a long stub will print for every check marked printed, where there

maximum number of invoices have been exceeded.

Print Labels - When selected, mailing labels will print for every check marked printed. This is optional and

used when windowed envelopes are not used.

Print Checks - Prints all checks not flagged as printed and then marks them as printed.

Print EFTs - Prints all EFT checks.

Post -  Posts all checks flagged as printed, as well as the voids, to the Disbursements journal. Removes
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posted items from the queue and the void log.

4.2.2 Credit Card Cash Posting

Overview 

This utility creates automated cash basis General Journal entry for credit card charges.

Key Concepts

Employees can enter Credit Card expenses into their Expense Sheets, which are then imported into the
Employee Reimbursables Journal.  Expense Checks are then cut to the employees which upon posting,
creates a Disbursement Journal entry.  Credit Card expenses do not get checks, therefore, do not end up
having a Disbursement Journal entry made for them.  The Disbursement Journal is used when performing
Cash and Accrual financial reporting.

To recognize Credit Card expenses in Cash and Accrual Reporting, the Credit Card Cash Posting utility
creates a General Journal entry (flagged as 'Both') that "posts" credit card entries.  General Journal
entries flagged as 'Both' will have no adverse effect in the system. 

The ability to mark the entry as 'Cash' is there because many companies run their books on both cash
and accrual. They may operate on an accrual basis, but report taxes on a cash basis. This is why the
General Journal gives you the choice to mark an entry as Cash, Accrual or Both. For instance, a bank
balance should be the same whether it is on cash basis or accrual basis. Therefore, General Journal
entries effecting the bank account should be marked both. Year end closings, however would be either
cash only or accrual only. That is why when running the system on both cash and accrual basis you close
the year twice; once for cash and once on accrual.

To use this utility, you need to enable the “Separate Credit Card Charges on Expense Sheet Import”
option located at Global Settings>A/P Tab>Credit Cards and Cash Basis Section. When this option is
enabled the import of an expense sheet can potentially result in two employee reimbursable transactions;
one for lines that are flagged as Credit Card and one that is not.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Post - When selected, all items marked as Post are included in the General Journal Entry that is created. More on the

General Journal

4.2.2.1 Credit Card Cash Posting Detail

Overview

This Credit Card Cash Posting Detail window is where you enter the selection criteria in preparation to create
the automated cash basis general journal entry for credit card charges.
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Field Descriptions

E/R Account

E/R Account - Employee Reimbursable Account that was used during the Import of Expenses to the E/R

Journal. More on Expense Sheet Import

Credit Card Clearing Account

Credit Card Clearing Account - G/L Account that is used to clear Credit Card transactions. More on G/L

Accounts

Header Section

Summarize to G/L on Post - When selected, similar G/L Accounts are combined in the General Journal

entry that is created.

Include Unreconciled Transactions - When selected, Items that are not marked as Reconciled during

Credit Card Reconciliation, are brought into the CCC Posting grid to be included in the posting. More on

Credit Card Reconciliation

Load Transactions - When selected, all transactions that can be included in the current CCC Posting

session fill into the grid.

G/L Period - G/L Period that the posting will be recognized in.

Select All - When selected, all of the items in the grid will be flagged to Post.

Select By Clearing ID - The look-up allows you to select a group of transactions by Credit Card

Reconciliation IN number. More on Credit Card Reconciliation

Show All Versions - When selected, all versions of the transactions will show in the grid.

Grid Section

Post - When selected, the item will be included in the posting.

CC Header ID - If the item was a part of a Credit Card Reconciliation, the Header ID number will show

here.

Employee Code - Code of the Employee that entered the expense.

Employee Name - Proper Name of the Employee that entered the expense.

Project Path - Path of the project that the expense was entered against.

Project Name - Name of the project that the expense was entered against.

Transaction Date - Date of the expense that was entered.

G/L Code - G/L Code of the Expense that was entered.

G/L Name - G/L Name of the Expense that was entered.
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Qty - Quantity of the Expense that was entered.

Unit Rate - Unit Rate of the Expense that was entered.

Amount - Amount of the Expense that was entered.

Cleared Amount -  If the item was a part of a Credit Card Reconciliation, the Amount that was cleared.

Original - If checked, the transaction is the original.

ER ID - The Employee Reimbursable Journal ID number. More on the Employee Reimbursable Journal

ER Line ID - The Line number that the transaction represents in the Employee Reimbursable Journal

transaction.

Exp. Line ID - The Line number that the transaction represents in the Expense Sheet transaction.

Internal Comments - Text from the G/L Comment on the line item in the Employee Reimbursable Journal

transaction.

ES ID - The Expense Sheet ID number. More on the Expense Sheet 

ES Create Date - The date that the Expense Sheet was created.

4.2.3 Credit Card Reconciliation

Overview 

The Credit Card Reconciliation applet is used to reconcile company credit card charges that have been
entered via Expense Sheets (and Imported to the E/R Journal) and have been marked as Credit Card. 

Key Concepts

Double-click on a contact inside the grid to bring up the "Contact Detail" pop-up. Data can be viewed or
changed, depending on the user’s permissions.
Within the "Contact Detail" pop-up, there are multiple tabs that show specific data about the contact,
such as name or main phone. 
Only contacts and employees can be added from this form.

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

Edit - Additional Edit options

o Clearing Account - Allows you to change the Credit Card Clearing G/L Account that is used.

Credit Card Reconciliation Report - Runs the Credit Card Reconciliation Report. More on the Credit Card

Reconciliation Report

References

Please browse to the following Video to see the Credit Card Reconciliation at work.  
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CC Reconciliation

4.2.3.1 Purchase Look-up Window

Overview

The Purchase Look-up window is where you pull up Vendors that may have Credit Card charges against

them. 

Key Concepts

Purchase Journal entries that go against the selected Firm shows up here. More on the Purchase Journal

Double-Click to load the invoice.

Field Descriptions

Firm

Look-up - The look-up gives you a list of Clients and Vendors that may have Credit Card charges against

them, for example, MasterCard.

Invoices

Invoice No. - The Purchase Journal Invoice Number. 

Date - Date of the Invoice.

Amount - Amount of the Invoice

Additional Field Descriptions

Column Chooser (Sprocket icon)

Firm Code - Code of Firm associated with the Invoice.

Firm Name - Name of Firm associated with the Invoice.

Transaction ID - Internal ID number of the Invoice.

Due Date - Due Date of the Invoice

4.2.3.2 Credit Card Rec Header/Footer

Overview

http://support.clearviewsoftware.net/articles/share/1251FA24
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The Credit Card Reconciliation Header / Footer of Credit Card Reconciliation contains important information

about the current session. 

Key Concepts

Purchase Journal entries that go against the selected Firm populate the header info. More on the

Purchase Journal

Field Descriptions

Header

Firm Name (no label) - The Firm Name is the top item that displays in the Header.

Invoice No. - Invoice Number of the selected Purchase Journal.

Purchase ID - Internal ID number of the selected Purchase Journal.

Clearing Date - Clearing Date of the Credit Card Reconciliation session.

Clearing Amount - Clearing Amount of the Credit Card Reconciliation session.

Comment - Internal Comments

Cut-Off - Cut-off date for transactions that show in the Charges grid.

Reconciled - When checked, the Credit Card Reconciliation session is considered to be Reconciled.

Footer

Cleared Charges - Total of charges flagged as Cleared in the current session. More on Charges

Missing Charges - Total of charges added to the Missing Charges Tab. More on Missing Charges

Total Charges - Cleared plus Missing Charges

Balance - Clearing Amount minus Total Charges

4.2.3.3 Charges Tab

Overview

The Charges Tab is where you clear charges that were entered by Employees against the Vendors that were

marked as Credit Card transactions. 

Key Concepts

The footer amounts will auto-calculate with the totals.
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Field Descriptions

Cleared - When selected, the item is considered to be cleared and is part of the current session.

Employee Code - Code of the Employee who entered the Expense.

Employee Name - Name of the Employee who entered the Expense.

Project Path - Project that the Expense was entered against.

Exp. Amount - Amount of the Expense.

CC Amount - Amount of the Expense to be used in the current session (Fills when the Cleared box is

selected).

4.2.3.4 Missing Charges Tab

Overview

The Missing Charges Tab is where you add missing charges that were made by Employees but were not

entered through an Expense Sheet.

Key Concepts

The Missing Charges footer amount will auto-calculate when saved.

Field Descriptions

Employee Code - Code of the Employee who entered the Expense.

Employee Name - Name of the Employee who entered the Expense.

Description - Description of the Missing Charge.

Amount - Amount of the Missing Charge.

4.2.3.5 Employee Totals

Overview

The Employee Totals section displays all charges that are part of the current Credit Card Reconciliation

session (Cleared & Missing charges)

Field Descriptions

Employee - Name of the Employee who entered the Expense.

Amount - Amount of the Charge.



InFocus Modules and Applets 83

© 2020 Clearview Software, Inc.

4.2.4 Disbursement Journal

Overview 

The Disbursements Journal is where all outgoing checks are entered. 

Key Concepts

Entries here, are generated in two ways:

o They are automatically generated though the Check Writing applets (A/P and E/R) 

o They are entered manually through the Disbursement Journal interface and Printed using the Manual
Check option on the Toolbar. 

The Disbursement Journal makes assumptions on debits and credits. It assumes the Header amount is a

credit, so when you enter a positive amount it saves it behind the scenes as a negative (a credit).

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Menu Bar

File - Additional options under the File button.

o Void - Voids the current Journal Transaction.

View - Additional options under the View button.

o Bookmarked - Allows you to select Bookmarked Transactions. More on Bookmarks

Tools - Additional options under the Tools button.

o Auto-balancing - Allows user to enable auto-balance for journal entry. Available types of Auto Balance

include:

Off - Disables this functionality

Top Down - Distributes the remaining Header Amount listed into each new line item.

Bottom Up - Enters the sum of the line items into the Journal Header Amount

o New Entry On Save - If On is selected, a new Journal Entry screen will load when saving another

Journal Entry. Otherwise the saved Journal Entry remains loaded on the screen.

o Change Period for Current Revision - This will change the G/L period for the current journal revision

o Change Bank Account -  Allows the user to change the Bank account for the current journal entry

o Show Unposted -  Shows unposted journal entries for a given G/L period

o Print Check - Prints a check for the currently loaded Journal Transaction. Report

Management>Manual Check
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o Bookmark - Bookmarks the journal entry for future retrieval. More on Bookmarks

o Batches - When clicked, a batches box will pop up. Batches are a way for a user to manually input

transactions into the system and check them against the batch total. Once all of the transactions are

entered, the user can then post all of the transaction within the batch. More on Batch Entries

Toolbar Options

New -  Creates a new journal transaction

Copy - Copies the current journal transaction to the journal

Save - Saves the current journal transaction

Void - Voids the current Journal Transaction

Delete - Deletes the current journal transaction

Batches -  When clicked, a batches box will pop up. Batches are a way for a user to manually input

transactions into the system and check them against the batch total. Once all of the transactions are

entered, the user can then post all of the transaction within the batch. More on Batch Entries

Bookmark - Bookmarks the current journal transaction. More on Bookmarks

Bookmarked - Displays a list of Bookmarked transactions for quick reference

Documents - Opens the Document Management pop-up.  There you are able to upload, view, modify and

delete archived documents.

Print - Prints the Journal Single Transaction Report

4.2.4.1 Disbursement Header

Overview 

The Disbursement Journal header section contains all common data for a disbursement transaction. It

contains the bank account and transaction amount and is referred to as the control side. 
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Key Concepts

The Disbursement Journal makes assumptions on debits and credits. It assumes the Header amount is a

credit, so when you enter a positive amount it saves it behind the scenes as a negative (a credit).

Field Descriptions 

** Indicates a required field

Transaction ID - The unique identification number of this transaction.  This displays in the header next to
"Disbursement Journal".

Printed - Signifies that a Manual Check has been printed for this transaction.

Batch ID - The Batch ID that the selected transaction is a part of.  More on Batch Entries

** Bank - Bank account

Payee Type - Can be a vendor, employee, or client. If allowed by Global Settings>General Tab>Misc.

Section>Allow Disbursements to Payees Not on File, then a payee not on file can be added here.

** Pay To - Check payee (any vendor, employee, client, or payee not on file).

Check Memo -  Text entered here will appear on face of check in memo area, conversely when text is

entered in the Check Memo line in A/P and E/R Check Writing will be displayed here.

Comments - Comments to appear in G/L report. Will show on control side and, if no G/L comment is

entered on the line item, will also print on those as well.

Amount -  Amount of check. Must match to the Amount total in the Detail section.

Check Number - Check number. Combination of bank account and check number must be unique. If left

blank, system will apply next check number upon save.

Check Date - Date of the check.

G/L Period - General ledger period for this transaction or revision to affect. Defaults to current period and

only open periods are allowed.  The Default Current Period is set at General Accounting>Accounting

Periods>Current Period

Batch ID - Number of the batch that you are working with. Batched are enabled at Global

Settings>General Tab>Misc. Section>Use Batch Entries in Journals

4.2.4.2 Disbursement Detail

Overview 

The Disbursement Journal Detail section displays the detail of how the checks were distributed. 
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Key Concepts

The Detail Section gives the detail of how the checks were distributed. 

If you are on a new row, F2 duplicates the row from above; otherwise, it copies the row you are on to a
new line.

Field Descriptions 

1 of ? - This shows the version of the journal entry that you are currently viewing.  This is enabled by

checking "Journals" at Global Settings>General Tab>Full Audits.

Current Version Period - The GL Period that the current version of the transaction falls in. A "Change

Period for Current Revision" option is located under Tools in the toolbar, allows you to change the current

period.

Show Audit Trail - When checked, all entries (including reversing entries) will display. It will also include a

line for the header section of the transaction. Auto-reversals and header lines will be grayed out and

cannot be altered.  This also displays the Create By, Create Date, Modify By and Modify Date of the

transaction.

Rev. No. - The number of the revision of the Journal entry. The original entry is 1. 

SJID - Sales Journal ID number if the Disbursement is linked to a Sales Journal (Client Invoice).

Sales Invoice No. - Sales Journal Invoice Number if the Disbursement is linked to a Sales Journal (Client

Invoice).

G/L Account - The G/L account allowed is determined by the payee type. For instance, when client is the

payee type, then an A/R account is allowed. More on Chart of Accounts

G/L Account Name - Displays the GL Account Name in the detail section. This is optionally shown

through the Column Chooser.

Invoice No. -  Used only when G/L account is either Accounts Payable or Accounts Receivable.

Project Path - WBS Path. Available only when payee type is Vendor and G/L account is metric type Cost.

Project Name - Displays the Project Name in the detail section. This is optionally shown through the

Column Chooser.

Exp. Code - Expense code. Available only when payee type is Vendor and G/L account is metric type

Cost.

GL Period - Displays the GL Period of the line item in the detail section. This is optionally shown through

the Column Chooser. More on Accounting Periods

Amount - Extended amount. Read only. Sum of qty X unit rate.

Bill Status - Billing status. Available only when payee type is Vendor and G/L account is metric type Cost.

G/L Comments - General ledger comments. Will print on G/L reports in place of comments on header of

transactions for this line item.

PM Comments - Project management comments. Appears on project management reports and invoices.
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Available only when payee type is Vendor and G/L account is metric type Cost.

4.2.5 E/R Check Writing

Overview  

Checks processed from E/R Check Writing are generated from the employee reimbursable entered into the

Employee Reimbursable Journal. The checks themselves are posted into the Disbursements Journal. Our

system checks use the Deluxe/Nebs DLM102 Check Stock layout.

Key Concepts

Invoices are synonymous with reimbursements. A reimbursement is a transaction in the employee

reimbursement journal.

4.2.5.1 E/R Check Writing Toolbar

Overview

The E/R Check Writing toolbar gives the user (if given the appropriate permissions) numerous capabilities
within the E/R Check Writing applet. Below is a list of those capabilities.

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

Tools - Additional Tools options

o EFT Bank Info - This allows you to Add/Modify the EFT Bank information used when processing an

EFT.

o Save to Batch - This allows you to save your selections as a batch for future use.

o Load from Batch - This allows you to save your selections as a batch for future use.

o Clear Batch - This allows you to clear your selections from the batch.

Save to Batch - This allows you to save your selections as a batch for future use.

Load from Batch - This allows you to save your selections as a batch for future use.

Clear Batch - This allows you to clear your selections from the batch.

Clear Check Sessions - This is used when you receive and error message stating that another user is

currently writing checks against this bank account when no other users truly are.  This error can occur if a

user improperly exits InFocus in the middle of a check writing session.
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4.2.5.2 Selections Tab

Overview

The Selection Tab displays the settings that determine which invoices are to be processed. Checks that are

processed from E/R Check Writing are generated from the Employee Reimbursables Journal that may have

been imported from Expense sheets. The checks themselves are then posted into the Disbursement Journal.

Field Descriptions

Accounts

Bank Account - The bank account to which checks will be posted. More on Chart of Accounts

Void Check Account - G/L Account to use as offset for void checks. (All transactions in InFocus require at

least two sides).

E/R Account - E/R account to use for invoice selection. Leave blank for all.

Next Check Number - Next check number to use. Defaults from the next control number field of the bank
account record on the Account Associations tab in General Accounting>Chart of Accounts. The Edit
button next to the check number allows a user to directly change the next check number in this screen.
Next EFT Number - Next check EFT number to use. Defaults from the next control number field of the

bank account record on the Account Associations tab (EFT column) in General Accounting>Chart of

Accounts. More on EFTs

Settings

G/L Period - The G/L period to which checks are posted. More on G/L Periods

Check Date - Date of checks

Default "Pay" to Selected - When checked, defaults to pay the selected reimbursement.

Date Range

No Range - When checked, no range will be used for reimbursement selection

Use Range - When checked, a date range will be used for reimbursement selection.

From - Starting date of reimbursement selection

To - Ending date of reimbursement selection

Employees

All - When checked, open reimbursement for all employees will be included.

Specific - When checked, open reimbursement for the specified employees will be selected.

EFT Type - When selected, open reimbursement for the specified EFT Type will be selected.
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Printing

Print Check Number - When checked, the check number will print on the face of the check.

Check Report - Report design to be used to print the check. More on E/R Check Reports

Label Report - Report design  used to print check labels. More on E/R Label Reports

Long Stub Report - Report design used to print long stubs. Long stubs are a separate report for checks

that cover more invoices than can be printed on one stub. More on E/R Label Reports

EFT Report - Report design to be used to print the EFT check. More on E/R EFT Reports

Max. Number of Invs. on Check Stub - Maximum number of invoices that will fit on one check. The default

of 10 applies to the check report design that ships with InFocus.

4.2.5.3 Results Tab

Overview

In the Results Tab, you will see a list of Employees and respective reimbursements that were found based on

the settings from the selections step. The Results Tab is split into two grids: 1) the Employee grid and 2) the

Reimbursements grid. Please note, selecting a row in the Employee Grid will display the associated invoices

in the Invoice Grid. 

Field Descriptions

Employees Grid

Pay - When checked, the selected check(s) will be processed for printing.

Separate Check -  When checked, a separate check will be printed for each reimbursement for this

Vendor.

Employee - Employee

Amount Due -  Total amount due this employee.

Amount Applied -  Total amount to pay this employee. Defaults to amount due. Shows running total of

selections from reimbursement grid.

EFT - When selected, check will be processed as an EFT.

Reimbursement Grid

Pay - When checked, the selected check(s) will be processed for printing.

E/R Account - Employee Reimbursable Account from the Employee Reimbursable Journal.

Employee - Employee name. Read only.
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Invoice No. - Reimbursement. Transaction ID from employee reimbursement journal. Read only.

Invoice Date - Invoice Date. Read only.

Invoice Amount - Invoice amount. Read Only.

Amount Due - Amount due on invoice. Read Only.

Amount Applied -  Amount to pay employee for this reimbursement.

  

4.2.5.4 Post Tab

Overview  

In the Post tab, a user can print, post, or void checks. The grid on the top of the Post tab is the check queue.

When you first enter this tab, the system will display a list of checks that have been prepared to be printed.

The normal operation is to first print the checks. Once you have the printed the check, a flag will appear next

to the check in the check queue. You can now print labels and long stubs for all checks that are flagged as

printed. Finally, you post the checks. Checks will be posted only for checks flagged as printed or voided.

Once the checks have been posted they are removed from the queue.

Key Concepts

In the case of printer jams you may need to void or reprint checks. The grid at the bottom of the screen

retains the list of voided checks.

Field Descriptions

Check Queue Columns

Printed - When selected, the check is considered printed.

Employee - Employee Name. Read only.

Memo - Check memo to print on check face. Can be edited when check printed flag is not set.

Check Number - Check number. Read Only

Check Amount - Check amount. Read only

Check Queue Buttons

Void - When selected, a check range can be entered to have voided. All checks in the range will move

from the check queue to the void log and new check numbers will be assigned in their stead. Voids will
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get posted along with regular checks. You cannot move a void back into the check queue without starting

over.

Print Test Check - Print test check should be done to plain paper and held over a check against a light

source to verify alignment. Test checks do not generate a void.

Print Long Stubs - When selected, a long stub will print for every check marked printed that has exceeded

a maximum number of reimbursements.

Print Labels - When selected, mailing labels will print for every check marked printed. This is optional and

used when windowed envelopes are not used.

Print Checks - Prints all checks not flagged as printed and then marks them printed.

Print EFTs - Prints all EFT checks.

Post -  Posts all checks flagged as printed.  It also enters the voids in the Disbursements Journal.

Removes posted items from the queue and the void log.

4.2.6 Employee Reimbursables

Overview 

The Employee Reimbursables Journal is where employee reimbursements are entered. 

Key Concepts

Entries here, are generated in two ways:

o They are automatically generated though the Import Expense Sheets Utility located in the Toolbar.

More on Importing Expenses

o They are entered manually through the Employee Reimbursables Journal interface. 

This journal makes assumptions on debits and credits. It assumes the Header amount is a credit, so

when you enter a positive amount it saves it behind the scenes as a negative (a credit).

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Menu Bar

File - Additional options under the File button.

o Void - Voids the current Journal Transaction.

View - Additional options under the View button.

o Bookmarked - Allows you to select Bookmarked Transactions. More on Bookmarks

Tools - Additional options under the Tools button.
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o Auto-balancing - Allows user to enable auto-balance for journal entry. Available types of Auto Balance

include:

Off - Disables this functionality

Top Down - Distributes the remaining Header Amount listed into each new line item.

Bottom Up - Enters the sum of the line items into the Journal Header Amount

o New Entry On Save - If On is selected, a new Journal Entry screen will load when saving another

Journal Entry. Otherwise the saved Journal Entry remains loaded on the screen.

o Change Period for Current Revision - This will change the G/L period for the current journal revision

o Show Unposted -  Shows unposted journal entries for a given G/L period

o Change E/R Account -  Allows the user to change the E/R account for the current journal entry

o Import Expense Sheets - Launches a dialogue to evaluate and post a range of Expense Sheets. More

on Importing Expense Sheets

o Clear All Pending Expense Sheet Transactions - Will clear out all of the pending expense sheet

transactions from the grid.

o Recurring Entry -  Allows the user to have an entry that is recurring for a given number of cycles

o Bookmark - Bookmarks the journal entry for future retrieval. More on Bookmarks

o Recurring Entry -  Allows the user to have an entry that is recurring for a given number of cycles. More

on Recurring Entries

o Batches - When clicked, a batches box will pop up. Batches are a way for a user to manually input

transactions into the system and check them against the batch total. Once all of the transactions are

entered, the user can then post all of the transaction within the batch. More on Batch Entries

Toolbar Options

New -  Creates a new journal transaction

Save - Saves the current journal transaction

Copy - Copies the current journal transaction to the journal

Void - Voids the current Journal Transaction

Delete - Deletes the current journal transaction.

Recurring Entry -  Allows the user to have an entry that is recurring for a given number of cycles. More on

Recurring Entries

Batches -  When clicked, a batches box will pop up. Batches are a way for a user to manually input

transactions into the system and check them against the batch total. Once all of the transactions are

entered, the user can then post all of the transaction within the batch. More on Batch Entries

Recurring Entry -  Allows the user to have an entry that is recurring for a given number of cycles

Bookmark - Bookmarks the current journal transaction. More on Bookmarks

Bookmarked - Displays a list of Bookmarked transactions for quick reference
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Documents - Opens the Document Management pop-up.  There you are able to upload, view, modify and

delete archived documents.

Print - Prints the Journal Single Transaction Report

4.2.6.1 Employee Reimbursables Header

Overview 

The header section contains all common data for an E/R transaction. It contains the employee reimbursable

account and transaction amount, and is referred to as the control side. 

Key Concepts

This journal makes assumptions on debits and credits. It assumes the Header amount is a credit, so

when you enter a positive amount it saves it behind the scenes as a negative (a credit).

Field Descriptions 

** Indicates a required field

Transaction ID - The unique identification number of this transaction.  This displays in the header next to
"Employee Reimbursables".

Batch ID - The Batch ID that the selected transaction is a part of.  More on Batch Entries

** E/R Account - Employee reimbursable sub-ledger account.

Employee - The employee for whom the transaction is intended.

E/R Comment - Internal E/R Comment.

G/L Comments - Comments to appear in G/L report. Will show on control side and, if no G/L comment is

entered on the line item, will also print on those as well.

Amount -  Amount of check. Must match to the Amount total in the Detail section.

Invoice Date - Date of the check.

G/L Period - General ledger period for this transaction or revision to affect. Defaults to current period and

only open periods are allowed.  The Default Current Period is set at General Accounting>Accounting

Periods>Current Period
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Batch ID - Number of the batch that you are working with. Batched are enabled at Global

Settings>General Tab>Misc. Section>Use Batch Entries in Journals

4.2.6.2 Employee Reimbursables Detail

Overview 

The Employee Reimbursables Detail section displays the detail of how the reimbursements were distributed. 

Key Concepts

If you are on a new row, F2 duplicates the row from above; otherwise, it copies the row you are on to a
new line.

Field Descriptions 

1 of ? - This shows the version of the journal entry that you are currently viewing.  This is enabled by

checking "Journals" at Global Settings>General Tab>Full Audits.

Current Version Period - The GL Period that the current version of the transaction falls in. A "Change

Period for Current Revision" option is located under Tools in the toolbar, allows you to change the current

period.

Show Audit Trail - When checked, all entries (including reversing entries) will display. It will also include a

line for the header section of the transaction. Auto-reversals and header lines will be grayed out and

cannot be altered.  This also displays the Create By, Create Date, Modify By and Modify Date of the

transaction.

Rev. No. - The number of the revision of the Journal entry. The original entry is 1. 

Project Path -  WBS path. Optional

SJID - Sales Journal ID number if the Disbursement is linked to a Sales Journal (Client Invoice).

Expense Code - Defaults in from vendor setup if also setup on project (Optional). More on Expense

Codes

G/L Account -  If expense code is entered, it defaults in either the direct or indirect cost G/L account from

the expense code setup, depending on type of project. When project is specified, you are limited to the

appropriate direct/indirect cost accounts. More on Chart of Accounts

GL Account Name - Displays the GL Account Name in the detail section. This is optionally shown through

the Column Chooser.

GL Period - Displays the GL Period in the detail section. This is optionally shown through the Column

Chooser. More on Accounting Periods

Transaction Date - Date of reimbursement line item
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Project Name - Displays the Project Name in the detail section. This is optionally shown through the

Column Chooser.

Sales Invoice No. - Sales Journal Invoice Number.

Qty - Quantity. This is optionally shown through the Column Chooser by selecting "Quantity and Rate". 

When selected, the "Amount" column becomes Read Only and calculates off of the Qty and Unite Rate

columns.

Unit rate - Unit cost rate. This is optionally shown through the Column Chooser by selecting "Quantity and

Rate".  When selected, the "Amount" column becomes Read Only and calculates off of the Qty and Unite

Rate columns.

Amount - Extended amount. Read only. Sum of qty X unit rate.

Ext. Bill Amount - Amount of Employee Reimbursable including the markup.

Bill Status - Name of the Transaction Status.

Bill Status Code - Code of the Transaction Status.

G/L Comments - General ledger comments. Will print on G/L reports in place of comments on header of

transactions for this line item.

PM Comments - Project management comments. Appears on project management reports and invoices.

4.2.6.3 Expense Sheet Import

Overview 

The Expense Sheet Import allows you to Approve/Reject Expense Sheets and import them into the Employee

Reimbursables Journal so that you can issue the checks to the employees. More on Expense Sheets

Field Descriptions 

Pop-up Buttons

Load Expense Sheets - When clicked, this takes you to the Expenses Tab.

Accept All - When on the Expenses Tab, this button will mark all of the items in the Gris as "Accepted".

Post Expense Sheets to E/R - When selected, all transactions in the Expenses grid will be Posted to the

Employee Reimbursables Journal. You will then be prompted for the G/L period and invoice date. 

Reset - Resets the selections.

Cancel - Cancels the Import process.

Search Criteria Tab
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Filters

Description - This tab allows the user to filter available expense sheets and establish posting accounts. 

Note - When deriving G/L accounts from base accounts the system will first attempt to use the Employee

Profit Center and if unsuccessful then the Project Profit Center.

All Employees - When selected, all employee expense sheets will be analyzed.

Single Employee - When selected, only the selected employee's expense sheets will be analyzed.

Transaction Cut-Off Date - When selected, only transactions As-of the selected date will appear in the

Expenses Grid.

Org. Unit Path - When filled out, only employees belong to this org unit, or one of its  child org units will

be analyzed.

Accounts

E/R - The Base Account must have a Subledger setting of "Employee Reimbursable". More on Chart of

Accounts

Direct ODC - The Base Account must have a Metric Type of "Cost, Cost Type of "Direct" and PM Type of

Other Direct Charges.

Direct OCC - The Base Account must have a Metric Type of "Cost, Cost Type of "Direct" and PM Type of

Out of Contract Consultants.

ICC - The Base Account must have a Metric Type of "Cost, Cost Type of "Direct" and PM Type of In

Contract Consultants.

Indirect Exp. - The Base Account must have a Metric Type of "Cost, Cost Type of "Indirect" and PM Type

of Other Direct Charges.

Indirect CNS. -The Base Account must have a Metric Type of "Cost, Cost Type of "Indirect" and PM Type

of Out of Contract Consultants.

Error Account - Error G/L account. Used when a G/L account cannot be derived.

Credit Card Clearing Account -  This is the offset account for credit card line items.

Employee Non-Reimbursements - This is the variance account for non-reimbursements.

Search Criteria Tab

Description - This Tab displays all unprocessed expense sheet line items. Here you flag which line items

should be processed. allows you to approve, reject and ignore expense sheets.  

Action - A drop-down list of possible actions for the respective row. The actions are as follows:

o Ignore - Do not process this line item. It will be available in future conversions.

o Accept - The line item is approved and will be part of the created transaction.

o Decline - The line item is rejected and will not be part of the created transaction. The employee will not

be reimbursed.
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Emp. Name - The name of the employee that submitted the expense.

Transaction Date - The Expense Sheet Transaction Date. 

Charge Amount - Amount of the Expense. This includes Company Credit Card Charges that are not paid

to the employee.

Reimbur. Amount - Amount to be reimbursed to the employee.

Credit Card - Company Credit Card Amount. This is indicated by checking the Credit Card check-box in

the expense sheet.

Exp. Code - Expense Code of the Expense. More on Expense Codes

4.2.7 Form 1099

Overview 

Form 1099 can be sent to vendors and employees. The system will fill out the forms automatically. 

Key Concepts

The user can override any information, including financial amounts. 

The main Applet screen shows the fields that can be entered on the 1099 form. 

An individual's 1099 form can be entered / changed here manually. 

You can also load vendor and employee 1099 forms by using the Load 1099 Recipients button located in

the toolbar.

4.2.7.1 Form 1099 Toolbar

Overview 

 The Form 1099 Toolbar gives the user (if given the appropriate permissions) numerous capabilities. Below is
a list of those capabilities.

Additional Toolbar Options

File - Additional File options

o Load 1099 Recipients - Launches the Form 1099 Loading Criteria Dialogue. More on 1099 Loading

Criteria

Load 1099 Recipients - Launches the Form 1099 Loading Criteria Dialogue. More on 1099 Loading
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Criteria

Print 1099's - Launches Print Criteria dialogue box for printing 1099's that subsequently runs the Form

1099 Report. More on the Form 1099 Report.

Print Labels - Launches report dialogue to print mailing labels to send 1099 forms

Save - Saves the current session. This session can be reloaded by clicking Load 1099 Recipients and

checking "Use Previously Saved Values" in that dialogue.

4.2.7.2 Form 1099 Loading Criteria

Overview

Complete this dialogue to load in Vendors and/or Employees for 1099 processing. More on Filling out the

1099

Field Descriptions

Options

Year - Calendar year that should be analyzed.

1099 Minimum - Minimum amount paid out before a 1099 should be generated for a given vendor or

employee.

Run Cash Conversion - When checked, the cash based conversion utility will be run prior to generating

1099's. Cash journals are used in 1099 calculations.

Use All Accounts - When checked, all G.L accounts are considered for 1099 pay amount; otherwise, only

accounts that are flagged in the chart of accounts as 1099 accounts will be used.

Vendors

No Vendors - When checked, no vendors are selected.

All Vendors - When checked, all vendors are selected.

Types of Vendors - When selected, vendors with a selected 1099 Type (Vendors>Settings Tab>Vendor

Types>1099). The 1099 list is managed under Administration>List Management>Vendor 1099 Types.

Selected Vendors - A user is able to select individual vendors here.

Employees

No Employees - When checked, no Employees are selected.

All Employees - When checked, all employees are selected.

Selected Employees - If All Employees is not checked, you can select individual employees here.

https://support.clearviewsoftware.net/articles/5315
https://support.clearviewsoftware.net/articles/5315
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Buttons/Check boxes

Use Previously Saved Values - When checked, values from the previously saved session will be loaded

Load - Loads the selections

Cancel - Cancels and closes the dialogue

4.2.7.3 Form 1099 Print

Overview  

 How to use the 1099 form.

Field Descriptions

Address

Address drop-down - Lists your company addresses set in Global Settings>Offices Tab

Payer Name - Typically your Company Name

Payer ID Number - Your Federal EIN. 

Note - If you are not using windowed envelopes, you can print labels by selecting 1099 labels from the
toolbar.

4.2.8 Purchase Journal

Overview 

The Purchase Journal is where vendor invoices are entered. This is often referred to as the Vendor Invoice
Journal. 

Transactions entered here must be offset against an Accounts Payable account (this is the header or control
side of the transaction). This journal makes assumptions on debits and credits. It assumes the header
amount is a credit, so when you enter a positive amount it saves it behind the scenes as a negative (a
credit). 

The journal reports provide a listing for transactions entered within the respective journal. Typically, these are
printed once a month.

Field Descriptions

In addition to standard menu and toolbar options, the Purchase Journal supports the following:

Menu
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File - Additional options under the File button.
o Void - Voids the current Journal Transaction.

View - Additional options under the View button.
o Bookmarked - Allows you to select Bookmarked Transactions. More on Bookmarks

Tools - Additional options under the Tools button.
o Auto-balancing - Allows user to enable auto-balance for journal entry. Available types of Auto Balance

include:
Off - Disables this functionality
Top Down - Distributes the remaining Header Amount listed into each new line item.
Bottom Up - Enters the sum of the line items into the Journal Header Amount

o New Entry On Save - If On is selected, a new Journal Entry screen will load when saving another
Journal Entry. Otherwise the saved Journal Entry remains loaded on the screen.

o Change A/P Account -  Allows the user to change the A/P account for the current journal entry.
o Change Period for Current Revision - This will change the G/L period for the current journal revision.
o Show Unposted -  Shows unposted journal entries for a given G/L period.
o Bookmark - Bookmarks the journal entry for future retrieval. More on Bookmarks
o Batches - When clicked, a batches box will pop up. Batches are a way for a user to manually input

transactions into the system and check them against the batch total. Once all of the transactions are
entered, the user can then post all of the transaction within the batch. More on Batch Entries

o Recurring Entry -  Allows the user to have an entry that is recurring for a given number of cycles. More
on Recurring Entries

Toolbar

New -  Creates a new journal transaction

Save - Saves the current journal transaction

Copy - Copies the current journal transaction to the journal

Void - Voids the current Journal Transaction

Delete - Deletes the current journal transaction

Batches -  When clicked, a batches box will pop up. Batches are a way for a user to manually input
transactions into the system and check them against the batch total. Once all of the transactions are
entered, the user can then post all of the transaction within the batch. More on Batch Entries
Bookmark - Bookmarks the current journal transaction. More on Bookmarks

Bookmarked - Displays a list of Bookmarked transactions for quick reference

Documents - Opens the Document Management pop-up.  There you are able to upload, view, modify and
delete archived documents.
Recurring Entry -  Allows the user to have an entry that is recurring for a given number of cycles. More on
Recurring Entries
Print - Prints the Journal Single Transaction Report

Purchase Order Toolbar Options

When Purchase Orders are enabled, the following toolbar options will be displayed in the Purchase Journal.

Link PO - Used to view and manage Purchase Order line-items linked to the highlighted Purchase Journal
line.
Convert to PJ - Converts a pre-billed Purchase Order to a formal Purchase Journal (e.g. Purchase Journal
crediting A/P and debiting Expense)
New from PO - Creates a new Purchase Journal from a specified Purchase Order

Add from PO - Adds line-items from an existing Purchase Order to the loaded Purchase Journal
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4.2.8.1 Purchase Header

Overview 

The header section contains the common data for a vendor invoice. It contains the Accounts Payable

account and amount. This section is referred to as the control side. 

Key Concepts

This journal makes assumptions on debits and credits. It assumes the header amount is a credit, so when

you enter a positive amount it saves it behind the scenes as a negative (a credit). 

There are three key fields that uniquely identify a vendor invoice:

o The Accounts Payable account

o The Vendor 

o The Invoice Number

If you have permissions, you can edit (on an already saved record) the vendor or invoice number. This

can be done by selecting the notes icon next to each field. No audit is retained on the change. 

Field Descriptions 

** Indicates a required field

Transaction ID - The unique identification number of this transaction.  This displays in the header next to
"Purchase Journal".

Batch ID - The Batch ID that the selected transaction is a part of.  More on Batch Entries

** A/P Account - Accounts Payable G/L account. This is the control account. It must have a sub-ledger

type of accounts payable. A/P sub-ledger reports can be printed for an individual or combined account

(account indifferent).

** Vendor - Vendor for this transaction. Once saved, you need special permission to change.

** Invoice Number - Vendor invoice number. Once saved, you need special permission to change.

A/P Comments - Appears on Accounts Payable report.

G/L Comments - Comments to appear in G/L report. Will show on control side and, if no G/L comment is

entered on the line item, will also print on those as well.

Amount -  Amount of check. Must match to the Amount total in the Detail section.

Amount Status - Status of the amount invoiced, statuses include: Paid, Unpaid or Partial. You can view

the associated transaction by clicking the status. The break out list contains additional links to the actual

disbursements.
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Invoice Date - Vendor invoice date.

Due Date - Automatically calculated by adding net days from the vendor setup to the invoice date. That is

set at Accounts Payable>Vendors>General Tab>Payment Terms. The Due Date can be overridden here.

G/L Period - General ledger period for this transaction or revision to affect. Defaults to current period and

only open periods are allowed.  The Default Current Period is set at General Accounting>Accounting

Periods>Current Period

Batch ID - Number of the batch that you are working with. Batched are enabled at Global

Settings>General Tab>Misc. Section>Use Batch Entries in Journals.

4.2.8.2 Purchase Detail

Overview 

The Purchase Detail section displays the detail of how the purchase is distributed to G/L accounts and WBS

paths. 

Key Concepts

If you are on a new row, F2 duplicates the row from above; otherwise, it copies the row you are on to a

new line.

Field Descriptions 

Standard Columns

1 of ? - This shows the version of the journal entry that you are currently viewing.  This is enabled by

checking "Journals" at Global Settings>General Tab>Full Audits.

Current Version Period - The GL Period that the current version of the transaction falls in. A "Change

Period for Current Revision" option is located under Tools in the toolbar, allows you to change the current

period.

Show Audit Trail - When checked, all entries (including reversing entries) will display. It will also include a

line for the header section of the transaction. Auto-reversals and header lines will be grayed out and

cannot be altered.  This also displays the Create By, Create Date, Modify By and Modify Date of the

transaction.

Rev. No. - The number of the revision of the Journal entry. The original entry is 1. 

Project Path - Project the transaction is being entered against (Optional).

Expense Code - Defaults in from vendor setup if it is also setup on the entered project (Optional). More on

Expense Codes

G/L Account -  If expense code is entered, it defaults in either the direct or indirect cost G/L account from



InFocus Modules and Applets 103

© 2020 Clearview Software, Inc.

the expense code setup depending on type of project. When project is specified, you are limited to the

appropriate direct/indirect cost accounts.

Amount - Extended cost amount. Must be the same amount as the "Amount" box in the Header.

Bill Status - Billing status

G/L Comments - General ledger comments. Will print on G/L reports in place of comments on header of

transactions for this line item.

PM Comments - Project management comments. Appears on project management reports and invoices.

Additional Columns

Description - The following are additional columns that can be displayed through the column chooser.

PJLineID - Internal ID of the line item.

Do Not Recalc - This flags the transaction to be excluded from Recalculation processes. More on

Recalculating Markups

Expense Markup (Markup) - Markup amount associated with the Expense Code. More on Expense Codes

Expense Markup Type - Type of markup associated with the Expense Code.

Exp. Code Name - Name of the Expense Code.

G/L Period -  Displays the G/L Period in the detail section. More on Accounting Periods

Period ID - G/L Period internal system ID

Qty - Quantity. Available when entering a transaction on a Vendor flagged as Unit Biller at Accounts

Payable>Vendors>General Tab

Unit rate - Unit cost rate. Available when entering a transaction on a Vendor flagged at Accounts

Payable>Vendors>General Tab

Account Name - Name of the G/L Account. More on Chart of Accounts

Bill Status Code - Billing status code

Create By - User that entered the transaction line item.

Create Date - Date the transaction line item was created

Modify By - Indicates the last user to modify the line item

Modify Date - Date the line item was modified

Ext Bill Amount - Billing extension of the line item.

Is G/L - Flag indicating if entry is to be considered as part of general ledger. Only set to zero by project

management opening entries.

Project ID - Internal ID of the project associated with the line item

Project Name - Project Name of the project associated with the line item

Sales Invoice No. - Sales Journal Invoice Number.

SJID - Internal ID of the associated Sales Journal ID
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4.2.9 Vendor Queries

Overview 

There are seven query applets in InFocus: Client, Contacts, Firms, Opportunities, Vendors, Projects, and
Employees. The concept of the query tools is to allow the user to define lists of data based on a user query
definition. The list can then be used to navigate to the individual records within the list or can be exported to
Excel. More on the Query Applets

4.2.10 Vendors

Overview 

A vendor is a person or business that supplies goods or services to a company. Generally, when the vendor

delivers the goods or services it will also send an invoice to the company.   

Key Concepts

Like Clients, Vendors are considered firms. If the Vendor you want to set up already exists (as a client, or
prospect) simply recall the firm to the screen and click Save.  This will establish it as a Vendor. 

Vendors are a requirement to maintain Accounts Payable sub-ledgers.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Print All Vendors - Runs the Vendors List Report. More on the Vendor List Report

4.2.10.1 Vendors Header

Overview 

Vendors are Firms that do work for you. You typically receive invoices from them. Like Clients, Vendors are
also firms. If the Vendor you want to set up already exists (as a client, or prospect) simply recall the firm to
the screen and clicking Save.  This will establish it as a Vendor. 



InFocus Modules and Applets 105

© 2020 Clearview Software, Inc.

Field Descriptions
Below are field descriptions for the Employee Header section. 

** Indicates a required field

** Code - Entered Vendor Identification Code; each vendor must have a unique code.

o Re-Code - The Re-Code link allows the user to change the code for an existing vendor firm. The link is
required in order to prevent the accidental changing of a vendor code. Clicking on this link will open up
the vendor code field, making it editable. To re-code, enter the new code to which you would like to
change the vendor's identification and click Save. This will change the vendor code here and on all
related entries, and transactions, throughout the system.

** Name - Vendor Name.

Active - When checked, designates this as an active vendor and available for transactions and
assignments

Web Site - Vendors Web Site

Parent Firm - Parent firm code. Firms can have parents. Only two levels are supported in the current
version.  This allows for the association of firms (especially for roll-up purposes) and is exposed in areas
of the program such as the A/R and A/P sub-ledgers and Vendor Queries.

Consultant - When checked, the vendor is flagged as a consultant. It is necessary when using pay when
paid reports and it can also be used to filter results in other reports like the Vendor Inquiry. This has no
effect on the Labor Distribution process.

  

4.2.10.2 General Tab

Overview  

The General Tabs holds key information for each Vendor.

Field Descriptions 

Below are field descriptions for the General tab. 

General 

EIN - Employer Identification Number

Default Exp Code - Default expense code when the Vendor is used in a Journal entry.

Check Memo - Memo to be written on the checks for this vendor.

Options 
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Unit Biller - When checked, a units (quantity) field will automatically show in the Purchase Journal for the

selected vendor.

Receives 1099 - When checked, designates that the vendor normally receives a 1099.

Separate Checks Per Invoice - When checked, the vendor will receive a separate check per invoice.

Payment Terms

Payment Term - Vendor payment terms. Informational only. A User Defined Field. The Type list is

managed under Administration>List Management>Payment Terms.

Net Days - Net days to add to vendor invoice to calculate due date.

Discounts

Days - Number of days past invoice date when a discount can be realized.

Percentage - Percentage to apply against invoice amount to calculate discount.

Default Base Code

Direct - Default G/L base account for direct charges

Indirect - Default G/L base account for indirect charges

Pay To

Attention - Pay To Attention.

Office - Drop-down list of Addresses that are located on the Addresses Tab

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

City - City

State - State

Zip - Zip Code

State - State

Country - Country

Phone - Telephone number

Fax - Fax number

4.2.10.3 Settings Tab

Overview  

The Settings Tabs holds key information for each Vendor.
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Field Descriptions 

Below are field descriptions for the Settings tab. 

Alternate 1099 Name

Alternate 1099 Name - If there is a value there, then that name will be used for 1099's.

Vendor Types

Standard - This is a user-definable list type you can populate in the List Management applet.  It can be
used to filter A/P reports and A/P Check Writing sessions. The Standard list is managed under
Administration>List Management>Vendor Types.

1099 -  This is a user-definable list type you can populate in the List Management applet.  It can be used

to filter 1099 print runs.The 1099 list is managed under Administration>List Management>Vendor 1099

Types.

EFT Setup

The following information is to be filled out if using EFT.

Enable EFT - When checked, the EFT Setup will allow you to enter Vendor EFT information.

Company ID - Typically Federal EIN #.

Company Name - "Doing Business As" Name

ABA/Routing # - Company Account Routing #.

Account # - Company Account #.

Savings - When checked, flags account as an Savings account.  Otherwise considered an Checking
account.

EFT Type (SEC) - Standard Entry Class (SEC) Code

Clear EFT Information - Click to explicitly clear EFT Setup information. Simply unchecking Enable EFT
(see above) does not clear the information.

4.2.10.4 Addresses Tab

Overview
The Addresses Tab contains the addresses of the selected firm. 

Field Descriptions
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Below are field descriptions for the Addresses Tab. 

Name - Named address. Not available for employee contacts.

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

City - City

State - State

Zip - Zip Code

State - State

Country - Country

Phone - Telephone number

Fax - Fax number

Latitude - Latitude of Address

Longitude - Longitude of Address

Copy to Clipboard - Copies address to the clipboard of the local workstation. (Only seen in Address

Editor)

Geocode - When clicked, the Latitude and Longitude are filled in with the location of the Main Address. 

This can be used in the Map Viewer applet. More on the Map Viewer. (Only seen in Address Editor)

Note 1: Clicking on a the pencil icon will bring up an Address Editor that will make data entry easier.

Note 2:  Addresses can be NAMED to categorize them for reuse. For instance, a client can have many

offices with an address for each office, as well as associate client contacts with a particular office address. If

the information of the NAMED address changes, you can cascade those changes to all associated (linked)

addresses in entirety, or only for fields that have a value.

Sometimes addresses have specific uses, as in the case of bill to, pay to, and remit to addresses. These can

be unassociated addresses or linked addresses. Typically, they will be linked addresses, which means they

must first be entered as a named address, prior to referencing them as a bill to, pay to, or remit to.

4.2.10.5 Contacts Tab

Overview 

The Contacts Tab associates a Contact with a particular Firm. 
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Field Descriptions
Below are field descriptions for the Contacts Tab. 

** Indicates a required field when adding to the list

Add New Contact - Brings up the Contact Detail page that allows you to create a New Contact.

** Contact - Name of the Contact associated with the Firm.

** Relationship - The contact’s relationship with the Project. A User Defined Field. The Relationship list is

managed under Administration>List Management>Firm Contact Types.

Title - Title of the Contact.

Work Phone

Cell Phone

Home Phone

4.2.10.6 Recent Tab

Overview 

The Recent tab shows transactions that go against the firm that is currently pulled up. Users can link over to
the specific journals if they are granted the appropriate permissions. More on Permissions

Field Descriptions
Below are field descriptions for the Recent Tab. 

Include 

Sales Journal - Displays all Sales Journal transactions that have an Invoice date that falls on or after the
Transaction Since Date.

Receipts - Displays all Receipt Journal transactions that have an Check date that falls on or after the
Transaction Since Date.

Purchase Journal - Displays all Purchase Journal transactions that have an Invoice date that falls on or
after the Transaction Since Date.

Disbursements - Displays all Disbursement Journal transactions that have an Check date that falls on or

after the Transaction Since Date.

Transactions Since

Date - The Transaction Since Date filters the Recent Transactions Grid.  It displays only transactions
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whose transaction date falls on or above the selected date.

Arrow Button - Loads the Recent Transaction window.

Export to Excel - Exports the items in the Recent Transaction window to an Excel file.

Note - The grid includes the Transaction ID, Transaction Date, Invoice Number, Check Number, Comments,
Transaction Type, and Amount.

4.2.10.7 AP History Tab

Overview 

The AP History Tab is used for quick look-up of accounts payable transactions (Field Descriptions Below).

Field Descriptions
Below are field descriptions for the A/P History Tab. 

Options 

Open Only - Shows only open items against the selected Vendor.

Combine Accounts - Removes the A/P Account from the grid to group together items.

Note - The grid includes the Transaction ID, Journal, A/P Account, Invoice No., Invoice Date, Due Date,
Check No., Check Date, Amount, Days Old, Invoice Balance and Comments.

4.2.10.8 Notes Tab

Overview  

Notes can be entered against a Contacts, Firms, and Projects (including Opportunities). More on Notes

Field Descriptions
Below are field descriptions for the Notes Tab. 

** Indicates a required field

Note Details 

Comment - Body of the Note

Note Type - Type of Note Posting (ex. Phone Call, Meeting, E-Mail, Appointment, Lunch, and Dinner are
the choices). A User Defined Field. The Note Type list is managed under Administration>List
Management>Note Types

Contact - Contact associated with the note.
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Project - Project associated with the note.

Add a follow-up Activity?

Add - Create a a follow-up activity that appears on the Activity Calendar. More on Activities

Require Complete - When checked, the follow-up activity shows up on the Activity calendar until it is
marked complete.

Type -  Type of Activity. A User Defined Field. The Activity Type list is managed under Administration>List
Management>Activity Types

Date - Date of follow-up Activity.

Time - Time of follow-up Activity.

Duration - Duration of follow-up Activity.

Existing Notes

Notes associated with the Contacts, Firms, or Projects that have been created.  Double-click on them to
bring into focus.

4.2.10.9 Custom Fields (UDF) Tab

Overview 

User-definable fields (UDFs) can be created for Clients, Employees, Vendors, Projects, Project Level2 and
Contacts. More on User Defined Fields.

4.2.10.10Documents Tab

Overview 

Documents tab allows you to upload, view, modify and delete archived documents in relation to the loaded
record. Uploaded documents and related information will be listed in the grid. More on Document
Management

4.2.10.11Warnings Comment Tab

Overview

Vendor warnings can be noted using the text box on this tab. When warnings are entered and saved, a 
Warning icon will appear in the upper-right-hand corner of the applet for the loaded vendor.

4.2.10.12Purchasing Tab

Overview
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Vendors Purchasing tab defines settings for the Purchasing module on a per-vendor basis.

While Global Settings establishes system-wide configurations, settings made here further define key points of
setup for each vendor used in the Purchasing module.

Unless noted, settings made here are considered additive (as apposed to overrides) to the configurations in
Global Settings.

So, for instance, when a Purchase Order is created for a specified vendor, the allowable Ship To addresses
are defined by the sum of address categories defined in Global Settings + Vendors.

Field Descriptions

Bill To
o Default Bill To - Bill To address to include on Purchase Orders. Overrides Global Settings>Purchasing

tab Default Bill To.
o Allow Override - When checked, Default Bill To can be overridden on the Purchase Order

Terms
o F.O.B. - Freight on Board terms. List is defined in AD>List Management
o Shipping - Shipping terms. List is defined in AD>List Management

Special Settings
o Purchases Require PO - When checked, PO's are a prerequisite for entering a Purchase Journal
o Single Project per PO - When checked, all lines on a single Purchase Order must charge the same

project
o Require Items on PO - When checked, all lines on a Purchase Order must be assigned an Item Code.

Overrides
o PO Approver Override - Designates a vendor-specific approver
o Allow Override on PO - When checked, the PO Approver can be overridden on the Purchase Order

PO Address - Default address for Purchase Orders created for the loaded vendor

Approval Requirement Conditions - Defines a set of criteria for determining if a Purchase Order line-item
requires approval. Rules can be further defined per Vendor and/or Purchase Item.
o Require All Conditions - When checked, all criteria must be met to require approvals

Allowable Ship To - Defines where a Purchase Order item can be shipped. Alternatively, a Specific
Address can also be listed.
o Overridable on PO - When checked the Ship To address can be overridden on the Purchase Order

4.3 Accounts Receivable

4.3.1 A/R Collections

Overview 

A/R Collections is used to facilitate the collection of outstanding invoices. The screen allows for the filter of
receivables by Date, Client, A/R Account, Project Leader and Currency (multi-currency only). Transaction
balances can be aged by invoice or due date.

Click Load Collections and the appropriate A/R transactions will appear in the grid. Like other grids in
InFocus, the collection grid can be filtered and sorted by each column. 

A/R Collections are managed per invoice. Click an invoice row in the grid to review the details in the right-
hand pane. Multiple invoice rows can be selected for Email Delivery from the toolbar. 
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Note Email Delivery is a feature of Invoice Delivery / Payments

How to load Invoices for Review

From A/R Collections, follow these steps to review invoices.

1 Set Filters as appropriate
2 Click Load Collections
3 Select an invoice row to review in the right-hand pane. Note, multiple invoice rows can be selected for

Email Delivery from the toolbar.
4 Collection efforts can now be managed

Managing Collections

Collections can be managed using the tabs in the right-hand pane when clicking an invoice row. Additionally,
multiple invoices can be selected if you wish to queue invoice emails or reminder emails using Email Delivery
(located on the toolbar). 
Below is a list of tools for managing collections.

Transactions
Review related transactions, clicking the pencil icon to browse to the transaction
record

Comments
Make ongoing comments regarding collection efforts, etc. Note, other users can
also interact with this comment thread which is helpful for collaboration

Notes Enter notes related to collection efforts, etc.

Documents Review and manage Documents related to the invoice

Delivery / Payment
Send and manage invoice and reminder emails or view the invoice online.
Optionally override Delivery / Payment settings per invoice. Note, this tab requires
Invoice Delivery / Payments setup via AR>Delivery / Payments.

Email History
Review detailed tracking on previously emailed invoices. Note, this tab requires
Invoice Delivery / Payments setup via AR>Delivery / Payments.

Email Delivery (toolbar)
Use to send invoice or reminder emails for multiple invoices by checking invoice
rows. Note, this tab requires Invoice Delivery / Payments setup via AR>Delivery /
Payments.

Invoice No. (Column
Hyperlink)

Click to view the invoice

Note For more information on using Invoice Delivery / Payments referred to throughout this section, please
refer to Invoice Delivery / Payments

Field Descriptions

Toolbar

View Previous Invoices - Click to view invoices for the selected invoice

Email Delivery -  Displays a list of feature options for invoice delivery and payments including sending
invoice and reminder emails. Note Delivery / Payment options are a feature of Invoice Delivery /
Payments.
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Header

Load Collections (upper right) - When selected, the grid will display all outstanding A/R that meet the

selected criteria.

Filters

Filters are listed in a collapsible left-hand pane and include the following options.

Dates

As Of Period - Period used to cut off the outstanding invoices.

Aging Date - Date used to determine the Age (Days Old) of an invoice.

Age By

Invoice Date - When selected, the Invoice Date is used in conjunction with the Aging Date to determine
the Age of an invoice.
Due Date - When selected, the Due Date is used in conjunction with the Aging Date to determine the Age
of an invoice.

Clients

All Clients - When selected, the A/R Collections grid will show all outstanding A/R.

Selected Client - When a client is selected, the A/R Collections grid will show only outstanding A/R for
that client.

A/R Accounts

All A/R Accounts - When selected, the A/R Collections grid will show all outstanding A/R.

Selected A/R Account - When an A/R Account is selected, the A/R Collections grid will show only
outstanding A/R for that A/R Account.

Project Leaders

Project Manager - When a Project Manager is selected, the A/R Collections grid will show only
outstanding A/R for projects that have the specified Employee as a Project Manager.
Project Accountant - When a Project Accountant is selected, the A/R Collections grid will show only
outstanding A/R for projects that have the specified Employee as a Project Accountant.
Principal In Charge - When a Principal In Charge is selected, the A/R Collections grid will show only
outstanding A/R for projects that have the specified Employee as a Principal In Charge.

Currency (Multi-Currency only)

Invoicing Currency for which to filter
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A/R Collections Grid

Check box - Check to select one or more invoices for Email Delivery. Note Delivery / Payment options are
a feature of Invoice Delivery / Payments.
Pencil Icon - Click to browse to the Sales Journal entry

Code - Firm code

Firm - Firm name

Invoice No. - Invoice number. Click to view invoice.

Age - Days old

Invoice Date - Invoice Date

Projects - Project that invoice is associated with

Contact - Name entered in Bill To Attention line in the Client file located at Clients>General Tab.

Phone - Client phone number

Invoice Amount - Amount of invoice

Balance - Amount due. Note, displays green if receipts exist for the invoice.

Comments - Invoice comments entered either in PA Bill Review or on the Billing Tab in the Project. When

invoice Comments are entered here, the date of the entry and the person who entered the comment is

also recorded.

Note - This is a note saved at the Client Level. Clicking on the firm note icon will bring up the A/R memo

screen. Here you can record collection notes.

InFocus Pay - Send status of emails sent via Delivery / Payments. Note Delivery / Payment options are a

feature of Invoice Delivery / Payments.

Email - Email for invoices to be sent. Email listed will either be an overriding email (as defined on the

Delivery / Payments tab, see below), Project Invoice Email listed on the PR>Projects>Billing tab or Client

email listed under Main Email on the AR>Clients>Billing tab.

A/R Collection Tabs

Collections can be managed using the tabs in the right-hand pane (collapsible) when clicking an invoice row.

Transactions - List of transactions made against the invoice

Comments - Invoice comments entered either in PA Bill Review or on the Billing Tab in the Project. When
invoice Comments are entered here, the date of the entry and the person who entered the comment is
also recorded.
Note - Note - This is a note saved at the Client Level. Clicking on the firm note icon will bring up the A/R
memo screen. Here you can record collection notes.
Documents - Review and manage documents related to the invoice

Delivery / Payments - Displays a list of feature options for invoice delivery and payments including
override settings per invoice, sending invoice and reminder emails, viewing invoices online, etc. Note
Delivery / Payment options are a feature of Invoice Delivery / Payments.
o Use Custom Settings - When checked, all overrides are used even blank values, etc.
o Click Save to retain override settings on the invoice
o Queue - Queues invoice email for delivery
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o Queue Reminder - Queues reminder email for delivery
o View Invoice Online - Click to view invoice online
o More details can be found under Invoice Delivery / Payments.

4.3.2 Automated Invoicing

Overview 

Automated invoices streamlines the billing process.

Invoices are printed and posted into the Sales Journal based on user-defined criteria. Once an invoice is
posted, all transactions in the system that comprised the invoice are flagged as Billed (Bill Status = Billed)
and are linked to the Sales Journal entry. Deleting or voiding the invoice reverts the bill statuses to Ready to
Bill and removes the link for posted invoices.

Additionally, Automated Invoicing makes invoice management more efficient by allowing the user to email
(InFocus 2.0+), print and archive posted invoices directly from InFocus.

Key Concepts

Only projects with assigned invoice designs can print. Invoice Designs are assigned to a project at

Projects>Billing Tab under Invoicing

Invoices are printed and posted into the Sales Journal based on user-entered criteria. More on the Sales

Journal

All transactions in the system that comprised an invoice are flagged as Billed (bill status equal to billed)

and are linked to the Sales Journal entry

The user can email invoices directly from Automated Invoicing (InFocus 2.0 +)

Deleting or Voiding an invoice in the Sales Journal reverts the bill status to Ready to Bill and removes

the link for posted invoices. Note: documents archived to the Sales Journal entry must be removed prior

to deleting the invoice.

Automated Invoicing supports simultaneous billings for multiple users through Invoice Sessions

Invoice Sessions

Automated Invoicing was designed to allow multiple users to bill simultaneously. However, in order to prevent
two users from billing the same project, user sessions are maintained. When the logged-in user runs
Automated Invoicing, a new session for that user is created, but only after deleting that user's previous
session. That user's session is closed (deleted) when the user exits Automated Invoicing.

If a user exits Automated Invoicing abnormally (e.g. power loss or shutting down the system without exiting
normally) the user's session will not be deleted. Projects maintained in that session would not be available for
invoicing until that user's session is properly cleared. In this event, you can run Clear All Invoice Sessions
(see below) to correct the situation. This occurrence can only occur when multiple users have been in this
applet.
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Field Descriptions

Below is a list of standard applet fields/buttons/elements used in the Automated Invoicing menu and toolbar.

Menu Options

File/Help - Lists standard InFocus File and Help options

Toolbar Options

The Automated Invoicing toolbar has one button: Clear All Invoices Sessions. Running this utility will clear
all current Automated Invoicing sessions (see below). Access to this feature is governed by the "Can Clear
Invoice Sessions" special right via Global Settings>Permissions.

Clear all Invoice Sessions - When selected, the utility will clear out all current user sessions.
Automated Invoicing was designed to allow multiple users to bill simultaneously. In order to prevent two
users from billing the same project, user sessions are maintained. 

4.3.2.1 Selection Criteria Tab

Overview 

The Selection Criteria tab filters the projects for which you wish to process invoices.

Note Only projects with an assigned Invoice Design can be processed.

Field Descriptions 

Projects

Single Project

Single Project -  When checked, the entered project is the only project that will be selected for invoicing.

Selection Based

The following criteria will be used to establish which projects get selected for invoicing.

Project Accountant - When entered, only projects assigned to this accountant will be selected.

Project Manager - When entered, only projects assigned to this manager will be selected.

Principal in Charge - When entered, only projects assigned to this principal will be selected.

Billing Group - When entered, only projects assigned to this billing group will be selected. Billing groups

are items that can be used for filtered runs or batches of automated invoices. Billing groups are commonly

used as a separate group for each week of a month. You could then assign projects to a group and that

way process invoices throughout the month. A User Defined Field. The Billing Group list is managed

under Administration>List Management>Billing Groups. 
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Invoice Group - When entered, only projects assigned to this invoice group will be selected. The Invoice

Group allows for Projects to be invoiced as one invoice. When used, cover sheets can be designed to

summarize individual project billings. More on Invoice Groups

Limit Results to Project Reviewed by a Project Manager - When checked, only projects that have been

reviewed in the supplied G/L period by a project manager will be selected.

Limit Results to Project Reviewed by a Project Accountant - When checked, only projects that have been

reviewed in the supplied G/L period by a project accountant will be selected.

Review Period - The G/L Period used by the PM or PA to Limit Results to Project Reviewed.

G/L Period Dates

G/L Period For Posting - G/L Period invoices will be posted to. This is defaulted in by the Invoicing Period

selected in General Accounting>Accounting Periods

As-of-Date - As-of-date for unbilled transaction selection. The As-of-date is either compared to the 

Transaction Date or the End Date of G/L period as determined by Global Settings>Invoicing Tab>Cutoff

Dates.

Invoice Date - Invoice Date to apply to invoices. This will be the Invoice Date in the Sales Journal. More

on Sales Journal

Invoice Styles

Invoice Styles looks at the Style of a custom invoice set at Utilities>Invoice Design>Invoice Designs

Tab>Style Section to determine what to invoice.

Labor/Combined - When selected, only invoice designs with a Style of with Labor Only or Combined will

be selected.

Expense Only - When selected, only invoice designs with a Style of with Expense Only or Combined will

be selected.

Invoice Labels Report

Use this to select a Mailing Label Report design to use.

Invoice Labels Report - Mailing label report design to use. These are printed from the top-right of the 

Automated Invoicing>Invoices Tab. Simply click on the Print Labels button when you are on that tab

during an invoicing session.

Sort By

Defines how loaded results are ordered. Two level sorting is supported (e.g. Order results by Project
Manager and, then, Client Code).
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1st - When selected, the Invoices grid will sort the returned invoices 1st by the selection. 

2nd - When selected, the Invoices grid will sort the returned invoices by the 1st selection, then by the 2nd

selection.

4.3.2.2 Posting Accounts Tab

Overview 

The Posting Accounts tab displays the default posting G/L Accounts for invoicing. Each account is used to
post to a specified type of revenue. As such, InFocus will only allow accounts that match the metric profile of
the type of account (e.g. Fixed Fee should utilize an account configured for Income - Billed Revenue - Labor -
Fixed Fee).

Note While these accounts can be overridden per user, default accounts can be established company-wide
in AD>Global Settings>Revenue Posting Accounts tab.

Field Descriptions 

Posting Accounts

A/R Account - A/R account to process. Required.

Direct Labor - Base account to which the base amount for hourly labor is posted.

Overhead - Base account to which the DPE plus OH amount for hourly labor is posted.

Labor Profit - Base account to which the profit portion for hourly labor is posted.

Fixed Fee - Base account to which the fixed fee is posted.

Direct ODC - Base account to which the non-marked up portion of OCC expenses is posted.

Profit ODC - Base account to which the marked-up portion of ODC expenses is posted to.

Direct OCC - Base account to post non-marked up portion of OCC expenses to.

Profit OCC - Base account to post marked-up portion of OCC expenses to. If not supplied, direct account

is used.

ICC - Base account to which ICC portion of fixed fee is posted.

Retainage - Base account to use for retainage.

Retainer - Base account to use for retainers.

Error G/L - G/L account to use when an account derivation cannot be achieved.  

4.3.2.3 Invoices Tab

Overview

After completing Selection Criteria, Posting Accounts and clicking Run, the Invoices tab will load with a grid of
all projects that meet the specified criteria. Some projects, while listed, will not be able to print an invoice due
to either: 1) No dollars calculated or 2) No Invoice Design. You can optionally show Printable or Unprintable
projects by clicking Show from the toolbar.
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Once loaded, invoices can be processed one at a time or en masse. Use the check boxes to select the
invoice(s) for processing and then leverage the listed Actions to process the invoice(s).

Field Descriptions

Toolbar Actions

Show - Show/Hide listed invoices based on printable status
o Printable - Project has billable dollars
o Unprintable - Project does not have billable dollars. Select this option to print zero dollar invoices.
o Both - Shows all invoices

Assign - Assigns an invoice number to checked invoices

Reset - Rolls back invoice assignment

Preview - Renders a .PDF preview of the selected invoices. Note, multiple invoices can be rendered to
create one .PDF containing multiple invoices. Once clicked, the Preview dialogue contains the following
options
o Open (+ button) - Opens the rendered .PDF file
o Save - Saves the rendered .PDF
o Print - Prints the rendered .PDF. Note, printing from this dialogue treats all invoices as a single

document. If you are using double-sided printing or collation, it is best to use the Print button listed on
the toolbar (see below).

o Arrows (Up & Down) - Scroll through the rendered .PDF
o Find - Use to search the rendered .PDF
o Magnifying Glasses - Use to adjust the zoom of the rendered .PDF

Print - Prints the selected invoices

Post & Archive - Launches the Invoice Post & Archive dialogue where invoices can be posted to the Sales
Journal and Archived to Document Management or a folder. Note, also supports Post only.
Email - Click to email posted invoices to designated recipients. Recipients are designated in
Clients>Billing Tab or Projects>Billing Tab (email override)
Print Labels - Print labels for the current invoicing session

View Cover Sheet - Click to view cover sheet if associated with listed invoices. More on Invoice Groups

Automated Invoicing Grid

Check/Uncheck All - Selects/Deselects all listed invoices

Selection box - Check to select invoice for processing

View - Renders a preview of a single invoice. Once clicked, the View dialogue contains the following
options
o Navigation Arrows - Used to browse through pages
o Refresh - Refreshes the preview
o Print - Prints the previewed invoice
o Print Layout - Displays the print layout of the invoice
o Page Setup - Used to adjust the page setup options for printing
o Save - Saves the previewed invoice with support for multiple formats (e.g. Excel, Word DOC, .PDF,

etc.)
o Drop Down - Adjusts the zoom level of the previewed invoice

Status - Invoice status (None, Assigned, Posted)

Firm - Client associated with the project being invoiced.

Project Path - Path of Project being invoiced.
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Project Name - Name of Project being invoiced.

Invoice No. - Invoice number. When an invoice number has not been assigned, this will display Draft.

Labor - The total amount of Labor transactions to be billed on the selected invoice.

ODC - The total amount of ODC (Other Direct Charge) transactions to be billed on the selected invoice.

OCC - The total amount of OCC (Out of Contract Consultant) transactions to be billed on the selected
invoice.
Fixed Fee - The total amount of Fixed Fees (or Lump Sums) to be billed on the selected invoice.

Retainer - The total Retainer amount being applied to the selected invoice.

Retainage - The total Retainage amount being applied to the selected invoice.

Taxes - The total amount of Taxes being applied to the selected invoice.

Total - Invoice total

SalesID - Once you Post, this fills in with the SJID (Sales Journal Identification number).

4.3.2.4 Invoice Printing & Exporting

Overview

Invoices can be printed and/or exported directly from the Invoices tab in Automated Invoicing.

Printing

Selected invoices can be printed by clicking the Print button from the toolbar of the Invoices tab.

Printing from Preview

Notably, invoices can be also printed from two other dialogues in Automated Invoicing: View and Preview.

View

Clicking the View button next to a single invoice renders a preview of that single invoice. From the View
dialogue, the invoice can be printed by clicking Print.

Preview

Clicking the Preview button from the toolbar renders a .PDF preview of all selected invoices. From the
Preview dialogue, selected invoices can be printed by clicking Print.

Note Printing from this dialogue treats all invoices as a single document. If you are using double-sided
printing or collation, it is best to use the Print button listed on the toolbar.

Exporting

Selected invoices can be exported as a single .PDF by clicking the Preview button from the toolbar of the
Invoices tab. 

Export to multiple formats (e.g. Excel, Word DOC, .PDF, etc.) is supported for single invoices by clicking
the View button listed in the invoice grid.
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4.3.2.5 Invoice Post & Archive

Overview 

Automated Invoicing makes invoice posting and archiving seamless with Post & Archive, available from the

Invoice tab toolbar. Clicking Post & Archive launches the dialogue through which you can Post (only) or

Post & Archive the selected invoice(s). 

Note Archiving to Document Management requires that Document Management be setup, which is managed

via AD>Global Settings>Document Management.

Field Descriptions 

Invoice Naming

Using a name pattern organizes your Invoice files with a naming convention that’s meaningful to your users.
The default naming convention is fixed to Invoice_xxx, where xxx represents the Sales Journal ID. We’ve
provided you with several variables that make the naming unique.

Naming Variables

@InvoiceNo@ - Invoice Number

@SJID@ - Sales Journal transaction ID

@ProjectPath@ - Project Path (e.g. 20140000–100)

@ProjectID@ - Internal Project ID

@ProjectName@ - Project name

For example, using the Name Pattern Invoice_@InvoiceNo@_SJID_@SJID@ would yield the following file
name: Invoice_49_SJID_2965.pdf.

Archive Destination

InFocus supports archival to Document Management, archival to a specified Folder or None (e.g. no archival)

Archive to Document Management - Each invoice is archived directly to InFocus and stored in the
applet(s) specified by the configuration in Utilities>Document Management. For example, each invoice
could be attached to the Sales Journal entry, Project record and Client record. If this option is unavailable,
please contact Clearview Support for assistance with enabling this feature.
Archive to a Folder - This option allows the user to select a local (or network) folder location for archival.
The file(s) are stored outside of InFocus in the specified location.
o Include Merged PDF - When checked, all rendered invoices will be archived in one .PDF file. For

instance, if running invoices for a single client you could archive and send them one single file.
None - No invoices are archived. The selected invoices will only be Posted to the Sales Journal.

Buttons

Post - Clicking will first post selected invoices to the Sales Journal. If successfully posted, InFocus will
then archive the rendered invoice(s) as specified under Archive Destination. If None is selected as the
Archive Destination, the invoice will only be Posted to the Sales Journal.
Cancel - Cancels the Post & Archive
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4.3.2.6 Queue Delivery

Once an invoice has been posted and archived it can be queued for email delivery. Emails will be sent to
either the Project Invoice Email(s), the Client's Main Email or as overridden (overrides can be set when using
Sales Journal and A/R Collections).

Queued invoices use the Delivery Email Template (see below) and are sent every 5 minutes.

Note Queue Delivery is a feature of Invoice Delivery / Payments

4.3.2.7 Emailing Invoices

Overview

Emailing invoices expedites A/R and lessens the impact on collections. Additionally, this serves your clients
by making it easy to receive and respond to your invoice. This effort can be centralized with InFocus
Automated Invoicing.

Automated Invoicing helps you process invoices in a batch which means you can also email invoices in a
batch. This greatly reducing the time you spend sending invoices.

If your system is validated for our advance invoice delivery feature set (see Invoice Delivery / Payments), you
can click Queue Delivery to email the invoice and corresponding backup documents.

When clicking Email from the Invoice Tab toolbar, you'll be prompted with the Email Invoices dialogue.

Field Descriptions

cc: - Add cc’d (carbon copy) recipients

bcc: - Add bcc’d (blind carbon copy) recipients

subject: - Subject of the email. While the default is configured in Global Settings, this can be edited here.

body - Body of the email. While the default is configured in Global Settings, this can be edited here.

recipients - Review recipient details.

Email addresses can be entered/edited here. Alternatively, you can setup a default email address for
each client in Accounts Receivable>Clients>Billing tab. This default address can be overridden per
project via Project Administration>Projects>Billing tab.  All recipients will be checked to receive an email,
however, uncheck the box next to the recipient should you wish to exclude. Note - this does not affect the
invoice posting process, only the email(s) to be sent. 
From: - From address for the email. If clients reply to your email, it will be delivered to this address.

Invoices, Recipients - Indicates the number of invoices and number of recipients

Send preview to: - Send a preview email to a specified email address. Enter the email address and click
Send Preview
Send button - Sends the email(s)

Close button - Closes the dialogue

Using Variables

Variables are used to personalize your emails. For instance, include the Invoice Number in the body of your
email and InFocus will tailor your email for each recipient accordingly. Variables are supported for use in the
subject line and body of emails.
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Example

"Please find the following invoice attached for project @PROJECTPATH@, Invoice Number
@INVOICENO@."
becomes
"Please find the following invoice attached for project 20140000-001, Invoice Number 51.

Supported Variables

Please note, use ALL CAPS when using variables.

@FIRMCODE@ - InFocus firm code. Available to both Subject and Body of email in Automated Invoicing.

@FIRMNAME@ - InFocus firm name. Available to both Subject and Body of email in Automated
Invoicing.
@INVOICEAMOUNT@ - Amount of the invoice. Available to both Subject and Body of email in Automated
Invoicing.
@INVOICENO@ - Invoice number. Available to both Subject and Body of email in Automated Invoicing.

@PROJECTPATH@ - Project path (e.g. 20140000-100). Available to both Subject and Body of email in
Automated Invoicing.
@PROJECTNAME@ - Project name. Available to both Subject and Body of email in Automated Invoicing.

4.3.3 Client Queries

Overview 

There are seven query applets in InFocus: Client, Contacts, Firms, Opportunities, Vendors, Projects, and
Employees. The concept of the query tools is to allow the user to define lists of data based on a user query
definition. The list can then be used to navigate to the individual records within the list or can be exported to
Excel. More on the Query Applets

4.3.4 Clients

Overview 

A client is a person or business that receives professional services from a company. Generally, when the
client receives goods and/or professional services it will also receive an invoice.   

Key Concepts

Like Vendors, Clients (and Prospects) are considered firms in InFocus. When a client is added, it can
later be flagged to act as a vendor. The opposite is also true. Prospects are firms that are prospective
clients. Once they become clients, they are no longer prospects. Clients are required for billable projects. 

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options



InFocus Modules and Applets 125

© 2020 Clearview Software, Inc.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Print All Clients - Runs the Client List Report. More on the Client List Report

4.3.4.1 Clients Header

Overview 

Clients are Firms that you are doing work for. Clients are required for billable projects. You typically will be
sending them an invoice (AR). 

Note: Like Vendors, Clients are also firms. If the Client you want to set up already exists (as a vendor, or
prospect) simply recall the firm to the screen and clicking Save.  This will establish it as a Client. 

Field Descriptions
Below are field descriptions for the Employee Header section. 

** Indicates a required field

** Code - User-entered Client Identification Code. Each Client must have a unique code. 

o Re-Code - The Re-Code link allows the user to change the code for an existing client firm. The link is

required in order to prevent the accidental changing of a client code. Clicking on this link will open up

the client code field, making it editable. To Re-Code, enter the new code to which you would like to

change the client's identification and click Save. This will change the client code here and on all

related entries and transactions throughout the system.

** Name - Client Name.

Active - When checked, designates that this is an active client and available for transactions and

assignments.

Web Site - Clients Web Site.

Parent Firm - Parent firm code. Firms can have parents. Only two levels are supported in the current

version.  This allows for the association of firms (especially for roll-up purposes) and is exposed in areas

of the program such as the A/R and A/P sub-ledgers and Client Queries.

Prospect - When checked, designates this is a prospect, rather than a billable client.

4.3.4.2 General Tab

Overview  
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The General Tabs holds key information for each Client.

Field Descriptions 

Below are field descriptions for the Employee Information tab. 

Bill To 

Note - This is the Bill-To Address. The Bill-To Address can print on invoices, statements, and Accounts

Receivable reports. It can be overridden on the project at Project Administration>Projects>Billing Tab>Bill-To

Address.

Attention - Bill-To Attention. Can be selected from a list of contacts or typed in manually.

Office - Drop-down list of Addresses that are located on the Addresses Tab

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

City - City

State - State

Zip - Zip Code

State - State

Country - Country

Phone - Telephone number

Fax - Fax number

Client Type / Specialty 

Type - Type of Client. A User Defined Field. The Type list is managed under Administration>List

Management>Client Types.

Specialty - The specialty area of the client. A User Defined Field. The Specialty list is managed under 
Administration>List Management>Client Specialties.

Internal Contacts 

Main Contact - Employee who acts as main contact for this client.

Comments - Note for main contact.

Sales Contact - Employee who acts as sales contact for this client.

Comments - Note for sales contact.
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Marketing Contact - Employee who acts as marketing contact for this client.

Comments - Note for marketing contact.

Other Contact - Employee who acts as a miscellaneous contact for this client.

Comments - Note for contact.

4.3.4.3 Addresses Tab

Overview
The Addresses Tab contains the addresses of the selected firm. 

Field Descriptions
Below are field descriptions for the Addresses Tab. 

Name - Named address. Not available for employee contacts.

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

City - City

State - State

Zip - Zip Code

State - State

Country - Country

Phone - Telephone number

Fax - Fax number

Latitude - Latitude of Address

Longitude - Longitude of Address

Copy to Clipboard - Copies address to the clipboard of the local workstation. (Only seen in Address

Editor)

Geocode - When clicked, the Latitude and Longitude are filled in with the location of the Main Address. 

This can be used in the Map Viewer applet. More on the Map Viewer. (Only seen in Address Editor)

Note 1: Clicking on a the pencil icon will bring up an Address Editor that will make data entry easier.

Note 2:  Addresses can be NAMED to categorize them for reuse. For instance, a client can have many

offices with an address for each office, as well as associate client contacts with a particular office address. If

the information of the NAMED address changes, you can cascade those changes to all associated (linked)
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addresses in entirety, or only for fields that have a value.

Sometimes addresses have specific uses, as in the case of bill to, pay to, and remit to addresses. These can

be unassociated addresses or linked addresses. Typically, they will be linked addresses, which means they

must first be entered as a named address, prior to referencing them as a bill to, pay to, or remit to.

4.3.4.4 Billing Tab

Overview
The Addresses Tab contains the addresses of the selected firm. 

Field Descriptions
Below are field descriptions for the Addresses Tab. 

Main Email 

Email Address - Main email address of the client. 

Payment Terms 

Type - Payment Type. A User Defined Field. The Type list is managed under Administration>List

Management>Billing Terms. This information can be overridden on the project.

Net Days - When a sales journal entry is made, this value is added to the invoice date to determine the

due date. This information can be overridden on the project.

Late Charges 

Type - Type of late charge. Choices are a one time add-on amount and a percentage of total invoice. Late

charges can be shown as a calculated amount on A/R reports, but are not automatically booked.

Amount - Late charge amount. Either a flat amount or percentage, depending on type.

Invoicing / PO 

Next Inv. Number - Next Invoice Number is active when invoice incrementing in Global Settings is set to

"By Client".  The Global Setting is located at Administration>Global Settings>Invoicing Tab>Invoice

Numbering.

Client PO Number - Client Purchase Order Number. Available in Invoice Design.
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4.3.4.5 Contacts Tab

Overview 

The Contacts Tab associates a Contact with a particular Firm. 

Field Descriptions
Below are field descriptions for the Contacts Tab. 

** Indicates a required field when adding to the list

Add New Contact - Brings up the Contact Detail page that allows you to create a New Contact.

** Contact - Name of the Contact associated with the Firm.

** Relationship - The contact’s relationship with the Project. A User Defined Field. The Relationship list is

managed under Administration>List Management>Firm Contact Types.

Title - Title of the Contact.

Work Phone

Cell Phone

Home Phone

4.3.4.6 Projects Tab

Overview 

The Projects Tab displays the association of the Client with Billable, Indirect and Plan Projects. 

Field Descriptions
Below are field descriptions for the General Tab. 

** Project Path - Unique Path of the Project associated with the Contact.

Name - Name of the Project associated with the Contact.

Charge Type - Charge Type of the Project. The charge type is configured in Project
Administration>Projects>General Tab.

4.3.4.7 Opportunities Tab

Overview 
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The Projects Tab displays the association of the Client with Opportunity Projects. 

Field Descriptions
Below are field descriptions for the General Tab. 

** Project Path - Unique Path of the Project associated with the Contact.

Name - Name of the Project associated with the Contact.

4.3.4.8 Recent Tab

Overview 

The Recent tab shows transactions that go against the firm that is currently pulled up. Users can link over to
the specific journals if they are granted the appropriate permissions. More on Permissions

Field Descriptions
Below are field descriptions for the Recent Tab. 

Include 

Sales Journal - Displays all Sales Journal transactions that have an Invoice date that falls on or after the
Transaction Since Date.

Receipts - Displays all Receipt Journal transactions that have an Check date that falls on or after the
Transaction Since Date.

Purchase Journal - Displays all Purchase Journal transactions that have an Invoice date that falls on or
after the Transaction Since Date.

Disbursements - Displays all Disbursement Journal transactions that have an Check date that falls on or

after the Transaction Since Date.

Transactions Since

Date - The Transaction Since Date filters the Recent Transactions Grid.  It displays only transactions

whose transaction date falls on or above the selected date.

Arrow Button - Loads the Recent Transaction window.

Export to Excel - Exports the items in the Recent Transaction window to an Excel file.

Note - The grid includes the Transaction ID, Transaction Date, Invoice Number, Check Number, Comments,
Transaction Type, and Amount.
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4.3.4.9 AR History Tab

Overview 

The AR History Tab is used for quick look-up of accounts receivable transactions.  

Field Descriptions
Below are field descriptions for the A/P History Tab. 

Options 

Open Only - Shows only invoices with a non-zero balance.

Combine Accounts - When checked, the system will show the A/R account and balances will be
calculated with respect to the A/R account.  If you do not have more than one A/R account this option has
no affect.

Note - The grid includes the Transaction ID, Journal, A/P Account, Invoice No., Invoice Date, Due Date,
Check No., Check Date, Amount, Days Old, Invoice Balance and Comments.

4.3.4.10 Notes Tab

Overview  

Notes can be entered against a Contacts, Firms, and Projects (including Opportunities). More on Notes

Field Descriptions
Below are field descriptions for the Notes Tab. 

** Indicates a required field

Note Details 

Comment - Body of the Note

Note Type - Type of Note Posting (ex. Phone Call, Meeting, E-Mail, Appointment, Lunch, and Dinner are
the choices). A User Defined Field. The Note Type list is managed under Administration>List
Management>Note Types

Contact - Contact associated with the note.

Project - Project associated with the note.

Add a follow-up Activity?

Add - Create a a follow-up activity that appears on the Activity Calendar. More on Activities

Require Complete - When checked, the follow-up activity shows up on the Activity calendar until it is
marked complete.
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Type -  Type of Activity. A User Defined Field. The Activity Type list is managed under Administration>List
Management>Activity Types

Date - Date of follow-up Activity.

Time - Time of follow-up Activity.

Duration - Duration of follow-up Activity.

Existing Notes

Notes associated with the Contacts, Firms, or Projects that have been created.  Double-click on them to
bring into focus.

4.3.4.11 Warnings Tab

Overview
The Warning Tab is used to record potential issues when dealing with a particular client. If any warning or
comment is recorded, a stop sign will appear here in the header of the client record.

Field Descriptions
Below are field descriptions for the Warnings Tab. 

Warning Type 

Hands Off - When checked, client should be avoided at all costs.

Credit Risk - When checked, client has a poor credit history.

Potential Conflict - When checked, a professional conflict may exist.

Warning Comments - Used to record other warnings not listed.

4.3.4.12 Documents Tab

Overview 

Documents tab allows you to upload, view, modify and delete archived documents in relation to the loaded
record. Uploaded documents and related information will be listed in the grid. More on Document
Management

4.3.4.13 Custom Fields (UDF) Tab

Overview 

User-definable fields (UDFs) can be created for Clients, Employees, Vendors, Projects, Project Level2 and
Contacts. More on User Defined Fields.
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4.3.4.14 Invoice Groups

Overview 

Invoice groups allow for billing more than one project on a single invoice. Each project still has its own invoice

design. A coversheet is used to summarize the invoices. 

Key Concepts

Invoice Groups are established on the client record. Tey are accessed from the toolbar Accounts

Receivable>Clients>Tools (Toolbar)>Invoice Groups.

They allow for multiple Projects (Bill Terms Node) from a common client to be invoiced under a single

invoice number.

Each project uses it own master invoice design. This means, while projects share the same invoice and

are generated in the same run, they do not appear on the same piece of paper.

A cover sheet invoice section can be assigned that will summarize the multiple projects' current billing

info.

Field Descriptions
Below are field descriptions for the Invoice Group pop-up. 

Name

Name - Name of Invoice Group. This appears in the "Name" grid on the left after you save.

Tracking No. - This is the "Next invoice number" for this billing group. Note: Only used when invoice

incrementing is set to "Project".

Description - User-entered description.

Remit To Address

Office - Company office as established in global settings

Attn. - Attention that shows on the Coversheet when invoicing.

Bill To Address

Use Client Bill-To Address - When checked, client Bill-to address is used.
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Use Other Address - Specifies an already established client address to use in place of the client Bill-to

address.

Bill-To Attention - Attention line.

Cover Sheet

System - System cover sheet design to use. 

Custom - User cover sheet design. Not applicable when Clearview is used.

  

4.3.5 Delivery / Payments

Overview 

Invoice Delivery / Payments facilitates invoicing with enhanced invoice email tracking tools, automatic
reminders for due dates and past-due invoices, and a new invoice attachment capability with support for
multiple attachments.
Additionally, with integration from Stripe, InFocus supports optional Payment Facilitation which will allow you
to receive payments faster. Payment Facilitation includes payment options for ACH and Credit Cards,
provides for a seamless invoicing experience for your clients, and includes financial reconciliation and
reporting.

Once configured, you'll have the ability to track emailed invoices and manage/automate reminders which can
all be managed centrally in A/R Collections or directly from the Sales Journal. If using Payments via Stripe,
Delivery / Payments supports the automated posting of receipts and related postings.

Getting Started with Delivery / Payments

While detailed instructions can be found through the Clearview Support FAQ listed below, here is a quick
reference for getting started with Invoice Delivery / Payments.

Set Permissions- Configured via AD>Permissions, you’ll give access as appropriate to Delivery /
Payments applet found under Accounts Receivable
Delivery / Payments Activation Code - Your activation code can be generated from Clearview Support
under Account & Admin>Billing, Licenses & Settings>Invoice Delivery / Payments. You’ll also be asked to
verify your API Base URL, which is your InFocus Launch URL + /api
Connect your Stripe Account - For firms wishing to receive payments, you’ll connect your Stripe account
from Clearview Support under Account & Admin>Billing, Licenses & Settings>Invoice Delivery /
Payments.
API Token - You’ll need to generate an API Token via AD>API Management

Feature Setup - Delivery / Payments can be setup through AR>Delivery / Payments.

Note for complete instructions, please refer to the following Clearview Support FAQ: InFocus
Delivery / Payments Configuration

https://support.clearviewsoftware.net/articles/8473
https://support.clearviewsoftware.net/articles/8473
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Feature Options

Once configured, the following options will appear throughout InFocus in Automated Invoicing (Queue
Delivery only), Sales Journal and A/R Collections. Delivery / Payment is featured as a toolbar drop down list
in the Sales Journal and as a tab in A/R Collections. A/R Collections also includes an Email Delivery toolbar
drop down.

Queue Delivery

Once an invoice has been posted and archived it can be queued for email delivery. Emails will be sent to
either the Project Invoice Email(s), the Client's Main Email or as overridden (overrides can be set when using
Sales Journal and A/R Collections).

Queued invoices use the Delivery Email Template (see below) and are sent every 5 minutes.

Queue Reminders

Once an invoice has been posted and archived it can be queued for reminder from the Sales Journal or
through A/R Collections. Emails will be sent to either the Project Invoice Email(s), the Client's Main Email or
as overridden (overrides can be set when using Sales Journal and A/R Collections).

Queued Reminders use the Reminder Email Template (see below) and are sent every 5 minutes.

View Invoice Online

Click to view the loaded invoice online.

Delivery / Pay Settings Overrides

When sending emails or reminders from Sales Journal or AR Collections, the follow settings can be
overridden per invoice. Note, when opting to Use Custom Settings, all settings listed will be applied to the
invoice - whether a value exists or not. Overrides include the following (see field definitions for setting details).

Use Custom Settings Check box - Check to apply all overrides

Allow Credit Card Payment

Allow Bank Payment

Separate Emails per Recipient

Email Recipients

Reminder Days

Additional Document Folders (Types)

Email History

Review detailed tracking on previously emailed invoices.

Field Definitions

Settings
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Activation Code

Activation Code - Activation Code generated from Clearview Support (Account & Admin>Billing, Licenses
& Settings>Invoice Delivery / Payments)
API Token - API Token generated via AD>API Management

Validate - Click to validate and enable Invoice Delivery / Payments feature

G/L Accounts

When leveraging Stripe, there are two entries to account for: the initial payment to Stripe and then the
distribution of that payment to your Bank. While you can perform the manual accounting entries to reconcile
to Stripe, InFocus can optionally be configured to automate those entries using predefined G/L Accounts.

Bank Account: Bank G/L Account that monies will be deposited into once payments are distributed.

Undeposited Funds Account: Bank G/L Account used when payment is made to Stripe but not yet
distributed. Once monies are distributed from Stripe, a G/L Adjustment is made crediting your
Undeposited Funds G/L Account and debiting the Bank G/L Account for the amount distributed.
Merchant Fees Account: Expense Account for recording merchant fees related to the Stripe payments
platform. More on Understanding Merchant Fees.
Create Receipt Entry - Check if you wish to have receipt entries automated from Stripe

Create Deposit Adjustment - Check if you wish to have adjusting entries automated for moving funds from
Undeposited to Bank once distributed.

Payment Rules

Payment rules can be set for payments via Stripe and include the following options.

Note Payment rules for payment will be subject to the terms and conditions of your Stripe account

Allow Credit Card Payments: if this box is checked invoices that are delivered will allow credit card
payments
Minimum/Maximum Credit Card: should an invoice fall outside of this range, credit card payments will not
be permitted
Allow ACH / Bank Payments: if this box is checked invoices that are delivered should allow ACH/Bank
payments
Minimum/Maximum ACH/Bank: should an invoice fall outside of this range, ACH/Bank payments will not
be permitted

Settings can be overridden per invoice via Sales Journal or A/R Collections

Delivery Settings

Send Reminders: if this box is checked, InFocus Pay will send out reminders on each day per the the
Reminder Schedule (unless overridden on the invoice directly via Sales Journal or A/R Collections) 
Reminder Schedule: set the days when you want reminders sent, using commas between days

Calculate Reminder Date: the age is calculated using the current date less the Invoice Date or the Due
Date on the sales journal when sending reminders

Email Addresses

When sending initial Invoices or Reminders via email, Delivery / Payments will leverage the following settings
for Email Addresses. Notably, you can include multiple CC and BCC addresses using a comma separated list
and attach multiple documents  by leveraging Include all Invoice Docs and Additional Document Types.

https://support.clearviewsoftware.net/articles/8486
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From Name: From Name to use in the email (e.g. Casco Wilson Billing)

Reply-To Address: Email address to which replies to invoice delivery emails should be sent (e.g.
billing@cw.com). Note that unless otherwise specified, the Reply-To address defaults to
noreply@infocuspay.com which is not monitored.
CC Addresses: enter any email addresses for which all invoice delivery emails should be CC'd. Use
commas to separate multiple email addresses.
BCC Addresses: enter any email address for which all invoice delivery emails should be BCC'd. Use
commas to separate multiple email addresses.
Separate Emails per Recipient: When checked, each recipient will receive their own email.

Include All Invoice Docs: When checked, all documents attached to the invoice in the Invoice Document
Type folder will be attached. Alternatively, if unchecked only the oldest attached document will be sent
(e.g. the originally attached invoice).
Additional Document Types: if a user has additional document types configured in the system (ie,
Receipts, Backups, etc) and they include that document type in this field, all documents that are attached
to the Sales Journal for the specified type will also be attached to the invoice and available for download

Email Templates

Emails for invoices and reminders will use templates which consist of a Subject and Body. Both Subject and
Body support the use of invoicing variables (as seen below). The Body can be written using HTML or plain
text. 

Variables list

Invoice Number: {INVOICENO}

Invoice Amount: {AMOUNT}

Invoice Age: {INVOICEAGE}

Invoice Date: {INVOICEDATE}

Payment Link: {PAYMENTLINK}

Delivery

Email template used for sending invoices via email with the Invoice Delivery/Payments feature. An example
template can be found in the following Clearview Support FAQ:InFocus Delivery / Payments Configuration.

Preview (link upper right) - Click to preview the email

Subject - Email subject line

HTML Body - Email body using HTML

Body - Email body using plain text

Reminder

Reminder template used for sending reminder emails with the Invoice Delivery/Payments feature. An example
template can be found in the following Clearview Support FAQ:InFocus Delivery / Payments Configuration.

Preview (link upper right) - Click to preview the email

Subject - Email subject line

HTML Body - Email body using HTML

Body - Email body using plain text

https://support.clearviewsoftware.net/articles/8473
https://support.clearviewsoftware.net/articles/8473
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4.3.6 PA Bill Review

Overview 

This applet is used by project accountants to perform time and expense modifications on a project-by-project

basis prior to invoicing.

Key Concepts

Only project accountants can access this applet, unless the logged-in user has the special permission 

Can Override Project Accountant Restriction. More on Permissions

The project accountant typically uses this applet after the project managers have reviewed their projects

through PM Bill Review. More on PM Bill Review. However, this is not a requirement. 

Project accountants have free reign to change any project transactions. They will, of course, be able to

view the manager’s changes.

Project accountants are not restricted to the projects they are assigned to. 

When all adjustments have been made, the project should be marked as Reviewed. This is done by

checking the box labeled Reviewed. This helps the Project Accountant know what has been completed.

Like the PM Bill R eview applet, there is a V iew Invoice option in the toolbar. Unlike the PM Bill R eview

applet, this does not immediately bring up a draft invoice. Instead, it brings up the Automating Invoice

applet for the currently selected project. The accountant can then make changes, view the draft invoice,

and then finalize and post the invoice on a project-by-project basis.

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

View - Additional View options

o Columns - Additional columns that can be displayed on the Transactions Tab.

Job Code - Job Title Code. More on Job Titles

Job Name - Job Title Name. 

Reports

o View Invoice - Takes the user to Automated Invoicing where they can view the invoice. More on Automated Invoicing

o Bill Review Report - When selected, the system Bill Review Report is rendered.  This report is managed at Global

Settings>A/R Tab.

o Pre-Bill Report - When selected, the system Pre-Bill Review Report is rendered.  

View Invoice - Takes the user to Automated Invoicing where they can view the invoice. More on Automated Invoicing
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Bill Review Report - When selected, the system Bill Review Report is rendered.  This report is managed at Global

Settings>A/R Tab. More on the Bill Review Report

Pre-Bill Report - When selected, the system Pre-Bill Review Report is rendered. More on the Prebill Report

Set Bill Status - Changes the Bill Status of the Transactions. To use, you must first select the transactions that you

would like to change the status of. Then click the button and select the status.

Move Project Tx - Moves Transactions from the current project to a new destination project.. To use, you must first

select the transactions that you would like to move. Then click the button and select the destination. More on Move

Project Transactions

4.3.6.1 PA Bill Review Header

Overview 

The Header section shows important Project and Billing information .

Field Descriptions 

Header

Current Invoicing period set in Accounting Periods. More on Accounting Periods

Project Name - Name of the Project. You are able to click on this to "link over" to the projects applet.

Note - If you hover over the (?) icon next to the name, you will see important project information.

Project Code - Code of the Project. 

Note - If you click on the (!) icon next to the code, you will get a Project Note Pop-up. This will save on the

General Note tab on the project located at Projects>General Note Tab.

Client - Client Name located in the top-right of the header.

Last Invoice Date - Date of the last invoice (Sales Journal) against the selected project.

Do Not Bill - Informational Only. Used to flag the project as Do Not Bill.

PM Reviewed - Marked by the PM. Used to inform the Project Accountant that the project has been

reviewed.

Reviewed - Used by the Project Accountant to mark project as reviewed.

Status Box

Ready - Displays the total amount of transactions As of the given date that have a status of Ready to Bill.

Hold - Displays the total amount of transactions As of the given date that have a status of Hold.
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Retainer Balance - Remaining balance of the retainer.  More on Retainers 

Current Retainer - The current retainer that will be applied in the next billing cycle. This can be added

here.

Never Bill - Displays the total amount of transactions As of the given date that have a status of Never Bill. 

Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

Write-off - Displays the total amount of transactions As of the given date that have a status of Write-off. 

Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

ICC WIP - Displays the total amount of transactions As of the given date that are considered ICC WIP. 

Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

Rate Schedule - Displays the Rate Schedule associated with the project. More on Rate Schedules

Invoice Comments - These are comments that will show up on the invoice header of the system invoice

designs. This can also be modified on the project at Projects>Billing Tab>Invoice Comments

Instructions to Biller - These are internal notes intended for the Project Accountant. As the invoicing

period is changed, the comments are saved, however, they are blank for the new period.

4.3.6.2 Filter Window

Overview 

The filter window is available to assist in narrowing down your search.

Field Descriptions 

Filter Window (Grid)

Path - Project Path

Name - Project Name

Filter Window (Bottom)

Quick Filter (Text Box) - A Quick Filter is at the top of the panel.  This will filter projects whose path begins

with the entered characters.

As of Date - Used as a cut-off date to limit the transactions that you are reviewing.

Project Leader - Depending on the selection in the Limit To drop-down, projects that have the selected
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leader as the Leader type will be returned.

Limit To - When checked (and the Project Leader drop-down is filled out), only projects, where the stated

Project Leader is a project manager, will be returned.

Show Only PM Reviewed - When checked, only projects that have the PM Reviewed check-box checked

will be returned.

Has Fixed Fee - When checked, only projects that have Fixed Fee values will be returned.

Has WIP - When checked, only projects that have WIP values will be returned.

Load - When selected, all projects that match the filter criteria will fill into the Filter Window.

Additional Field Descriptions (Column Chooser) 

Filter Window Grid

Client - Client associated with the Project.

WIP - Total WIP

PA Reviewed - Check-box that displays the PA Reviewed status.

PM Reviewed - Check-box that displays the PM Reviewed status.

Do Not Bill - Check-box that displays the Do Not Bill status.

Retainer - Retainer Amount

Last Invoice Date - Date of the last invoice (Sales Journal) against the selected project.

4.3.6.3 Transactions Tab

Overview 

The Transactions tab is used by project accountants to perform time and expense modifications on a project-

by-project basis prior to invoicing. 

Key Concepts

When all adjustments have been made, the project should be marked as reviewed. This helps the project
accountant know what has been completed.

To see Transactions for a specific project, click on the project in the Filter Window.

When selected, the Transactions Tab displays the transactions entered against the project. 

The PA can then make bill and journal adjustments. 
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Columns in the detail grid can be dragged to change order.

Field Descriptions 

Arrange By

Arrange By - The drop-down allows you to select different ways in which you would like to see the

Transaction detail grouped. The options are Journal, Project Path, Bill Status, Transaction Date and

None.

Transactions Grid

JN - Journal. By clicking on the pencil icon, you get the Invoice Billing Adjustment pop-up. This allows you

to modify individual transactions. More on the Invoice Billing Pop-up

Note - When changes are made here, no audit trail entry is made.

ID - Identification number of the transaction. By clicking on the pencil icon, you get redirected to the

location of the transaction (ie. Time sheet Adjustments or Journal).

S - Bill Status. This shows the Bill Status of the transaction.

Project Path - Project Path of the transaction.

Name - Name of the Project Manager assigned to the project.

Labor/Exp. Code - Displays the Labor Code for Labor and Expense Code for Expenses.  More on Labor

Codes  More on Expense Codes

Transaction Date - Date of the Transaction.

Bill Rate/MU - Displays the Bill Rate for Labor and the Marked Up rate for Expenses.

Units/Hrs - Displays the Hours for Labor and Units for Expenses.

Amount - Amount of the Transaction

Time/Expense Comments - Displays the PM Comments entered on the transaction.

Instructions To Biller - These are internal notes intended for the Project Accountant. As the invoicing

period is changed, the comments are saved, however, they are blank for the new period.

ICC Amount - ICC Effort Amount. Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

Never Bill - Never Bill Amount. Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

Writeoff - Writeoff Amount. Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

Additional Field Descriptions (Column Chooser) 

Transactions Grid

Project Name - Name of the Project
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Project Long Name - Name of the project including the concatenation of the lower nodes of the project.

Job Code - Job Title Code - More on Job Titles

Job Name - Job Title Name

Labor/Exp. Name - Displays the Labor Name for Labor and Expense Name for Expenses

OT - Overtime

4.3.6.4 Fixed Fee Tab

Overview 

The F ixed Fee tab is used by project accounts to perform fixed fee modifications on a project-by-project basis

prior to invoicing. 

Key Concepts

To see Fixed Fee items for a specific project, click on the project in the Filter Window.

Columns in the detail grid can be dragged to change order.

Field Descriptions 

PC Formula

Percent Complete Formula - The drop-down contains predefined formulas managed in Global Settings>A/
R Tab>Percent Complete Calculation Default Formula 

Calculate All - When selected, the Calculate All button will calculate the percent complete for all contract
WBS nodes. The Calculate  All button will calculate percent complete for the WBS node on the given line. 

Allow Percent Complete Below Previous Value - When Unchecked, the check box will prevent the
calculated percent complete from going below the previously recorded percent complete.

Fixed Fees Grid

Project Path - Project Path

Project Name - Project Name

Contract Amount - This is the amount entered in the Contract Levels / Caps  within the project being
viewed.

Effort - This is total effort to date.

Billed - This is Fixed Fee + ICC Billed Revenue. 

BTD% - Billed to Date Percentage

Current Amt. - This is the calculated revenue to bill based on contract X percent complete less previously
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billed.

Prior % Complete - The previous percent complete amount.  Note - When the Current % Complete
amount has been saved, it becomes the Previous % Complete number.

Current % Complete - The current percent complete amount that is being billed.

Current ICC to Apply - The current ICC amount to be applied to this billing transaction.

ICC Contract Amount - ICC Contract amount entered in the Contract Levels / Caps  within the project
being viewed

Lump Sum - Current Lump Sum amount to be billed.

Calc PC - Runs the PC Formula on the individual line item.

Fixed Fee Notes - Internal notes associated with the Fixed Fee.

Invoice Description - Invoice Description notes associated with the contract level of the project.

Additional Field Descriptions (Column Chooser) 

Fixed fees Grid

Project Long Name - Name of the project including the concatenation of the lower nodes of the project.

Labor Budget - Labor Budget amount entered through Project Planning. More on Project Planning

Budgets

ODC Budget - Other Direct Charges Budget amount entered through Project Planning.

ICC Budget - In Contract Consultants Budget amount entered through Project Planning.

OCC Budget - Out of Contract Consultants Budget amount entered through Project Planning.

Total Budget - All Budget amounts entered through Project Planning.

Labor Effort - Labor Effort against the contract level.

ODC Effort - Other Direct Charges Effort against the contract level.

ICC Effort - In Contract Consultants Effort against the contract level.

OCC Effort - Out of Contract Consultants Effort against the contract level.

Labor Contract - Labor Contact Cap.

ODC Contract - Other Direct Charges Contact Cap.

OCC Contract - Out of Contract Consultants Contact Cap.

Fixed Fee Billed - Fixed Fee Billed Revenue.

Labor Billed - Labor Billed Revenue.

ODC Billed - Other Direct Charges Billed Revenue.

ICC Billed - In Contract Consultants Billed Revenue.

OCC Billed - Out of Contract Consultants Billed Revenue.

Labor WIP - Labor Work in Progress.
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ODC WIP - Other Direct Charges Work in Progress.

ICC WIP - In Contract Consultants Work in Progress.

OCC WIP - Out of Contract Consultants Work in Progress.

Total WIP - Total Work in Progress.

4.3.6.5 Invoice Billing Adjustment pop-up

Overview 

The Invoice Billing Adjustment pop-up allows you to modify individual transactions in PA Bill Review.  There

are different options for labor and non-labor transactions.

Field Descriptions 

Labor Transactions

Bill Status - Bill Status of the Transaction

Job Title - Job Title of the Transaction. More on Job Titles

Bill Hrs - Bill Hours of the Transaction

Labor Code - Labor Code of the Transaction. More on Labor Codes

Location - Location of the Transaction. More on Locations

PM Comment - Comment

Base Regular Rate - Regular Pay rate

 Premium Multiplier - Overtime multiplier

Premium Rate - Overtime rate

Bill Rate - Bill (Effort) rate

Bill DPE Multiplier - Direct Personnel Expense Multiplier

Bill Overhead Multiplier - Overhead Multiplier

Bill Profit Multiplier - Profit Multiplier

Re-Calc Rates - When selected, the transaction will recalculate on Save to adjust rates. When un-

checked, you are able to specify the rates that you would like the transaction to reflect.



InFocus User Manual - Current (v2020)146

© 2020 Clearview Software, Inc.

Non-Labor Transactions

Bill Status - Bill Status of the Transaction

Markup Type - Markup Type of the Expense. Options are Markup, Flat Amount and Add-on. More on

Expense Types

Markup Amount - Markup Amount of the Expense

PM Comments - Comment

4.3.7 Receipt Journal

Overview 

The Cash Receipts Journal is where all incoming checks or payments are entered.

Key Concepts

The Cash Receipts Journal makes assumptions on debits and credits. It assumes the detail amount is a

credit. When you enter a positive amount, it is saved behind the scenes as a negative (a credit).

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Menu Bar

File - Additional options under the File button.

o Void - Voids the current Journal Transaction.

View - Additional options under the View button.

o Bookmarked - Allows you to select Bookmarked Transactions. More on Bookmarks

Tools - Additional options under the Tools button.

o Auto-balancing - Allows user to enable auto-balance for journal entry. Available types of Auto Balance

include:

Off - Disables this functionality

Top Down - Distributes the remaining Header Amount listed into each new line item.

Bottom Up - Enters the sum of the line items into the Journal Header Amount

o New Entry On Save - If On is selected, a new Journal Entry screen will load when saving another

Journal Entry. Otherwise the saved Journal Entry remains loaded on the screen.

o Retainer Wizard - When clicked, the retainer wizard pops-up and walks the user through allowing the

user to enter data that creates both the Sales and Receipt Journal entries.  More on the Retainer

Wizard
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o Change Period for Current Revision - This will change the G/L period for the current journal revision.

o Show Unposted -  Shows unposted journal entries for a given G/L period.

o Change Bank Account -  Allows the user to change the Bank account for the current journal entry.

o Bookmark - Bookmarks the journal entry for future retrieval. More on Bookmarks

o Batches - When clicked, a batches box will pop up. Batches are a way for a user to manually input

transactions into the system and check them against the batch total. Once all of the transactions are

entered, the user can then post all of the transaction within the batch. More on Batch Entries

o Find By Invoice No. - This feature allows you to look up sales entries, solely by invoice number.  It

returns a list of sales entries that match the invoice number.  Selecting an entry from the returned list

will fill out most of the required fields for the receipt.

Toolbar Options

New -  Creates a new journal transaction

Save - Saves the current journal transaction

Copy - Copies the current journal transaction to the journal

Void - Voids the current Journal Transaction

Delete - Deletes the current journal transaction

Batches -  When clicked, a batches box will pop up. Batches are a way for a user to manually input

transactions into the system and check them against the batch total. Once all of the transactions are

entered, the user can then post all of the transaction within the batch. More on Batch Entries

Bookmark - Bookmarks the current journal transaction. More on Bookmarks

Bookmarked - Displays a list of Bookmarked transactions for quick reference.

Find By Invoice No. - This feature allows you to look up sales entries, solely by invoice number.  It returns

a list of sales entries that match the invoice number.  Selecting an entry from the returned list will fill out

most of the required fields for the receipt.

Documents - Opens the Document Management pop-up.  There you are able to upload, view, modify and

delete archived documents.

Print - Prints the Journal Single Transaction Report

4.3.7.1 Receipt Header

Overview 

The Receipt Journal Header contains all common data for a receipt transaction. It contains the bank account
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and transaction amount, and is referred to as the control side.

Key Concepts

The Receipt Journal makes assumptions on debits and credits. It assumes the detail amount is a credit.
When you enter a positive amount, it is saved behind the scenes as a negative (a credit).

Field Descriptions 

Transaction ID - The unique identification number of this transaction.  This displays in the header next to
"Receipt Journal".

Batch ID - The Batch ID that the selected transaction is a part of.  More on Batch Entries

Bank - Bank G/L account

Payee Type - Can be a vendor, employee, or client. If allowed by Global Settings>General Tab>Misc.

Section>Allow Disbursements to Payees Not on File, then a payee not on file can be added here.

Payer - Check Payer. 

Deposit Number -  Bank deposit number.

Deposit Date - Date of deposit.

Comments - Comments to appear in G/L report. Will show on control side and, if no G/L comment is

entered on the line item, will also print on those as well.

Amount -  Amount of check or payment.

Check Number - Check number. If not a check, then some identifying  notation.

Check Date - Date of check

G/L Period - General ledger period for this transaction or revision to effect. Defaults to current period and

only open periods are allowed.

Show Audit Trail -  When checked, all entries including reversing entries will display. It will also include a

line for the header section of the transaction. Auto-reversals and header lines will be grayed out and

cannot be altered.

Wizard Icon - When checked, the you get the Client Invoice Wizard that allows you to distribute a

receipt. More on the Client Invoice Wizard

4.3.7.2 Receipt Detail

Overview 

The Receipt Journal Detail section displays the detail of how the receipt is distributed to G/L accounts and

WBS paths. 
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Key Concepts

If you are on a new row, F2 duplicates the row from above; otherwise, it copies the row you are on to a

new line.

Field Descriptions 

1 of ? - This shows the version of the journal entry that you are currently viewing.  This is enabled by

checking "Journals" at Global Settings>General Tab>Full Audits.

Current Version Period - The GL Period that the current version of the transaction falls in. A "Change

Period for Current Revision" option is located under Tools in the toolbar, allows you to change the current

period.

Show Audit Trail - When checked, all entries (including reversing entries) will display. It will also include a

line for the header section of the transaction. Auto-reversals and header lines will be grayed out and

cannot be altered.  This also displays the Create By, Create Date, Modify By and Modify Date of the

transaction.

Rev. No. - The number of the revision of the Journal entry. The original entry is 1. 

G/L Account - The G/L account allowed is determined by the payee type. For instance, when Client is the

payee type then an A/R account is allowed.

G/L Account Name - Displays the GL Account Name in the detail section. This is optionally shown

through the Column Chooser.

Invoice No. -  Only used when G/L account is either Accounts Payable or Accounts Receivable.

Project Path - WBS Path. Only available when payee type is Client and G/L account is Accounts

Receivable.  This is optionally shown through the Column Chooser.

Note: To enter cash receipts to any level of the WBS you must check the "Breakdown Receipts To WBS"

check-box in Global Settings>A/R Tab>Receipt Wizard Breakdown Section

Project Name - Displays the Project Name in the detail section.   This is optionally shown through the

Column Chooser.

G/L Period - Displays the GL Period in the detail section.   This is optionally shown through the Column

Chooser.

Amount - Must be the same amount as the "Amount" box in the Header.

RT (Revenue Type) - This allows you to earmark how much of a receipt should be considered a certain

revenue type.  This affects revenue allocation in the new Pay When Paid reports.

Note: To enter use Revenue Types in the Receipt Journal you must check the "Breakdown Receipts To

Revenue Type" check-box in Global Settings>A/R Tab>Receipt Wizard Breakdown Section

G/L Comments - General Ledger comments. This line item will print on G/L reports in place of comments

on transaction header.
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PM Comments - Project Management Comments. Appears on project management reports and invoices.

Available only when payee type is Client and G/L account is Accounts Receivable.

4.3.7.3 Retainer Wizard

Overview  
 The Retainer Wizard is a quick and easy way to enter and post an advanced payment.  

Key Concepts

When you use the Wizard, both a Sales and Receipt Journal entry are created.

When you finally want to apply the retainer, just add it to the "Current Retainer" box in PA Bill Review. 

More on PA Bill Review

You can view this video to see the Retainer Wizard in use - More on Retainer Wizard

Field Descriptions 

Bank - Bank Account used in the Header of the Receipt when creating the journal entry.

A/R Account - A/R Account used in the Header of the Sales Journal when creating the entry.

Retainer Account - The Retainer Account used in the Detail of the Sales Journal when creating the entry.

Client - Client used when creating both transactions.

Project - Project used when creating both transactions.

Invoice Number -  The invoice number populates the following areas:

o Receipt Journal - Invoice No. in the detail section.

o Sales Journal - Invoice Number in the Header section.

Comments - This comment populates the G/L Comments/Comments box in both transactions.

Check Number - The Check Number populates the "Check Number" box located in the Header of the

Receipt Journal.

Check/Invoice Date - The Check/Invoice Date populates the following: 

o Receipt Journal - "Check Date" located in the Header of the Receipt Journal.

o Sales Journal - "Invoice Date" located in the Header of the Sales Journal.

https://support.clearviewsoftware.net/articles/4050?groupid=18
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Deposit Date - The Deposit Date populates the  "Check Date" located in the Header of the Receipt

Journal.

Deposit Number - The Deposit Number populates the  "Check Number" located in the Header of the

Receipt Journal.

G/L Period - This G/L Period populates the G/L Period in both transactions.

Amount -   This Amount populates the Amount in both transactions.

4.3.7.4 Client Invoice Wizard

Overview  
 The Client Invoice Wizard is a quick and easy way to distribute a payment.  

Field Descriptions 

Header

Check Amount - Amount of the received check that is going to be applied. 

Distributed Amount - Running calculation of the Amounts entered in the Projects grid. Read Only.  

A/R Account - A/R Account in the Header of the invoices that will populate the window.

Include Closed Invoices - When checked, closed invoices using the same AR account for the same Payer

will display.

Spread - When selected, the wizard will attempt to spread the amount across the available invoices.

Pay off - When selected, the wizard will attempt to pay off the selected invoice.

Invoices

Invoice No. - Invoice Number of the Sales Journal.

Invoice Date -  Invoice Date of the Sales Journal.

Balance - Unpaid Balance of the Invoice.

Original Invoice Amount - The original invoice amount before any payments were applied.

Projects
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Project Path - Project that is to be paid on the Invoice.

Invoice Date -  Invoice Date of the Sales Journal.

Balance - Unpaid Balance of the Invoice.

Amount - Amount to be applied to the invoice.

Rev. Type - This allows you to earmark how much of a receipt should be considered a certain revenue

type.  This affects revenue allocation in the new Pay When Paid reports.

4.3.8 Sales Journal

Overview 

The Sales Journal is where client invoices are entered.

Key Concepts

Transactions entered here must be offset against an Accounts Receivable account. This is the header

side of the transaction.

Most transactions in the sales journal are entered automatically from automated invoicing. More on

Automated Invoicing

The Sales Journal makes assumptions on debits and credits. It assumes the detail amount is a credit, so

when you enter a positive amount, it is saved behind the scenes as a negative (credit).

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Menu Bar

File - Additional options under the File button.

o Void - Voids the current Journal Transaction.

View - Additional options under the View button.

o Bookmarked - Allows you to select Bookmarked Transactions. More on Bookmarks

Tools - Additional options under the Tools button.

o Auto-balancing - Allows user to enable auto-balance for journal entry. Available types of Auto Balance

include:

Off - Disables this functionality

Top Down - Distributes the remaining Header Amount listed into each new line item.

Bottom Up - Enters the sum of the line items into the Journal Header Amount
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o Change A/R Account -  Allows the user to change the Accounts Receivable account for the current

journal entry.

o New Entry On Save - If On is selected, a new Journal Entry screen will load when saving another

Journal Entry. Otherwise the saved Journal Entry remains loaded on the screen.

o Linked Transactions - When selected, a pop-up will display showing all of the transactions that are

linked to the Sales Journal that is selected. The bottom left of the pop-up has a Print icon. Report

Management> Linked Transaction Report

Print Icon runs the Linked Transactions Report. More on the Linked Transactions Report

o Batches -  When clicked, a batches box will pop up. Batches are a way for a user to manually input

transactions into the system and check them against the batch total. Once all of the transactions are

entered, the user can then post all of the transaction within the batch. More on Batch Entries

o Change Period for Current Revision - This will change the G/L period for the current journal revision.

o Show Unposted -  Shows unposted journal entries for a given G/L period.

o Bookmark - Bookmarks the journal entry for future retrieval. More on Bookmarks

o Recurring Entry -  Allows the user to have an entry that is recurring for a given number of cycles. More

on Recurring Entries

Toolbar Options

New -  Creates a new journal transaction

Save - Saves the current journal transaction

Copy - Copies the current journal transaction to the journal

Void - Voids the current Journal Transaction

Delete - Deletes the current journal transaction.

o Recurring Entry -  Allows the user to have an entry that is recurring for a given number of cycles. More

on Recurring Entries

Batches -  When clicked, a batches box will pop up. Batches are a way for a user to manually input

transactions into the system and check them against the batch total. Once all of the transactions are

entered, the user can then post all of the transaction within the batch. More on Batch Entries

Bookmark - Bookmarks the current journal transaction. More on Bookmarks

Bookmarked - Displays a list of Bookmarked transactions for quick reference.

Print - Prints the Journal Single Transaction Report.

Delivery / Payment - Displays a list of feature options for invoice delivery and payments including sending

invoice and reminder emails, viewing invoices online, etc. Note Delivery / Payment options are a feature

of Invoice Delivery / Payments.

o Queue Delivery - Queues invoice email for delivery
o Queue Reminder - Queues reminder email for delivery
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o View Invoice Online - Click to view invoice online
o Refresh Payments Link - Click to invalidate original payments link and replace with a new link.
o Settings - Delivery / Payment override settings

Use Custom Settings - When checked, all overrides are used even blank values, etc.
Click Save to retain override settings on the invoice
History tab - Review detailed tracking on previously emailed invoices

o More details can be found under Invoice Delivery / Payments.

  

4.3.8.1 Sales Header

Overview  

The Sales Journal Header section is referred to as the control side. It contains the common data for a client

invoice, A/R Account and Transaction Amount. 

Key Concepts

The Sales Journal makes assumptions on debits and credits. It assumes the detail amount is a credit, so

when you enter a positive amount, it is saved behind the scenes as a negative (credit).

There are three key fields that uniquely identify a client invoice. 

o The Accounts Receivable Account

o The Client

o The Invoice Number  

With proper permissions, the client or invoice number can be edited on a previously saved record. Select

the Notes icon next to each field. No audit is retained on the change.

Field Descriptions 

Transaction ID -  The unique identification number of this transaction.  This displays in the header next to

"Sales Journal".

Batch ID - The Batch ID that the selected transaction is a part of.  More on Batch Entries

** A/R Account - The Accounts Receivable G/L account is the control account. It must have a sub-ledger

type of Accounts Receivable. A/R sub-ledger reports can be printed for an individual or combined account

(account indifferent). More on Chart of Accounts

** Client - Client for this transaction. Once saved, you need special permission to change. More on
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Clients

** Invoice Number - Client invoice number. Once saved, you need special permission to change.

Bill To Address - Assigned bill-to address for this invoice. Clicking on it will generate a list of available

addresses, as well as the currently selected one. If button text is red, no address has been assigned.

G/L Comments - Comments to appear in G/L report. Will show on control side and, if no G/L comment is

entered on the line item, it will also print on those as well.

Amount - Amount of invoice. Must balance to the line entries in the detail section.

Amount Status - Status of the amount invoiced, statuses include: Paid, Unpaid or Partial. You can view

the associated transaction by clicking the status. The break out list contains additional links to the actual

receipts.

Invoice Date - Client invoice date.

Due Date - Automatically calculated by adding net days from the client setup to the invoice date. This is

set at Accounts Receivable>Clients>Billing Tab>Payment Terms Section. The Due Date can be

overridden here.

As Of Date - The As of Date that was use when running Automated Invoicing. More on Automated

Invoicing

4.3.8.2 Sales Detail

Overview 

The Sales Journal Detail section displays the detail of how the client invoice is distributed to G/L accounts

and WBS paths. 

Key Concepts

If you are on a new row, F2 duplicates the row from above; otherwise, it copies the row you are on to a

new line.

Field Descriptions 

1 of ? - This shows the version of the journal entry that you are currently viewing.  This is enabled by

checking "Journals" at Global Settings>General Tab>Full Audits.

Current Version Period - The GL Period that the current version of the transaction falls in. A "Change

Period for Current Revision" option is located under Tools in the toolbar, allows you to change the current

period.

Show Audit Trail - When checked, all entries (including reversing entries) will display. It will also include a

line for the header section of the transaction. Auto-reversals and header lines will be grayed out and

cannot be altered.  This also displays the Create By, Create Date, Modify By and Modify Date of the
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transaction.

Rev. No. - The number of the revision of the Journal entry. The original entry is 1. 

Project Path - Project the line item is being entered against. Optional. More on Projects

Expense Code - Displays the Expense Code of the transaction. Optional. More on Expense Codes

G/L Account -  Limited to billed and unbilled revenue, WIP, retainage, retainer, bad debt, and late charge

accounts. More on Chart of Accounts

Amount - Line item amount. The total must equal the Amount in the Header.

G/L Comments - General ledger comments. Will print on G/L reports in place of comments on header of

transactions for this line item.

PM Comments - Project management comments. Appears on project management reports and invoices.

Additional Columns

Account Name - Name of the G/L Account

Exp. Code Name - Name of the Expense Code

G/L Org Name - Name of the Organizational Unit associated with the G/L Account used on the line item

G/L Period - Period code

Is G/L - Flag indicating if entry is to be considered as part of general ledger. Only set to zero by project

management opening entries.

Project Code - Code of the project the line item is being entered against. While Project Path shows the

full WBS path (e.g. 2014000-001), Project Code displays only the code of the assigned WBS node (e.g.

001).

Project ID - Internal ID of the project associated with the line item

Project Name - Project Name of the project associated with the line item

SJID - Internal Sales Journal ID

SJLineID - Internal ID of the line item

4.3.9 Set Bill Status

Overview 

This Set Bill Status Utility allows the user to change the bill status for selected or multiple projects within a

date range.

Field Descriptions 

Projects

All Projects - When selected, the status of the transactions that match the given criteria will be changed
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for all projects.

Selected Projects - When selected, the status of the transactions that match the given criteria will be

changed for the selected projects.

Dates

Transaction Start Date - The date selected will be used as the beginning date to filter out transactions.

Transaction End Date - The date selected will be used as the ending date to filter out transactions.

Bill Status

From Status - The status selected will be used as the status to be changed from on transactions.

To Status - The status selected will be used as the status to change the transactions to.

Journals

Disbursements - When selected, transactions from the Disbursements Journal will be included when

determining which statuses to change.

Employee Reimbursables - When selected, transactions from the Employee Reimbursables Journal will

be included when determining which statuses to change.

Purchases - When selected, transactions from the Purchase Journal will be included when determining

which statuses to change.

Timesheets - When selected, transactions from the Timesheets will be included when determining which

statuses to change.

Additional Settings

Exclude Billed Transactions Already Associated with an Invoice - When selected, any transaction that has

a status of Billed and is linked to a Sales Journal will not be modified by the utility.

4.4 Project Administration

4.4.1 Expense Codes

Overview 

Expense Codes/Groups allow for the categorization of expenses for transaction entry, project reporting and
invoicing. Examples are Prints, Travel, Meals, etc. They allow for varied markup per category. 

Key Concepts
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There are three types of Expense Markup Type. Markups can be Multiplier, Add-on of flat Amount.

Can be assigned Direct Cost, Indirect Cost, and Revenue G/L Accounts. 

Can be restricted to PM types (ex., ODC,OCC,ICC)

Can default in billing status (ex., Ready to Bill, Never Bill, etc.)

Can be budgeted in Project Planning

Expense Groups allow for subsets and overrides of expense codes that can be assigned to a project.

Expense Groups allow for non-labor expenses to be grouped into categories. This allows for billing
categories to be established without the need for changing the chart of accounts. For example, if a client
demands that air travel be separated from local travel, it would not be necessary to set up a separate
ODC travel G/L account.

Expense Groups provide a mechanism for varied unit billing and markups.

Note 1 - Once expense codes are established, they are then placed in expense groups. An expense code
can belong to many groups. In turn, groups are applied to projects. Groups can also have effect dates,
allowing for the revision of markups/rates on perhaps an annual basis. Expense groups are the expense
equivalent of labor rate schedules.

Note 2 - Expense Codes need to be created before they can be added to Expense Groups. Adding Expense
Codes is as simple as filling out a new row in the grid and clicking Save.

Field Descriptions 

Expense Codes Grid

Show in Expense Sheet - When checked, the expense will be a selectable option in an employee expense

sheet during expense sheet entry.

Active - When checked, the expense code is active and can be added to an Expense Group.

Code - Expense code. The code that will be associated with this Expense.  The Code must be unique.

Name - Expense Name. The Name that will be associated with this Expense.

Currency - Enabled with Multi-Currency Setup. Represents the transactional currency in which the

expense code is utilized. For example, if entering a Purchase Journal using an AP Account (USD) only

Expense Codes of similar currency would be available to the transaction. For complete instructions on

setting up a Multi-Currency environment, go here: More on Multi-Currency

Exp. Code Type - Allowable PM types for the expense code are chosen here. They include O ther D irect

C harges, Out-of-C ontract C onsultants , In-C ontract C onsultants , C onsultants  (either OC C or ICC) and Any.

Expense Markup Type - There are three types of Expense Markup Types: (a) Markup, (b) Add-on,and (c)

Flat Amount (see Fig.1). Below shows how each Markup type is calculated. 

o Markup - Unit Rate X  Qty  X  Markup (Amount entered in Markup Column)

o Add-on - [Unit Rate  +  Markup (Amount entered in Markup Column)]  X  Qty

o Flat Amount - Qty X Markup (Amount entered in Markup Column))
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Markup - This changes depending on the Expense Markup Type selected. Note: The amount entered in

the Markup Column can be the Markup, Add-on, or the Flat Amount depending on what Markup Type you

select.

o Markup - Multiplier used to mark up the Unit Rate.

o Add-on - Amount you would like to add on to the unit rate.

o Flat Amount - Flat amount that you would like to charge per unit.

Unit Rate - Unit cost rate. The amount you pay, per unit, for the expense. This can be overridden in the

Expense Journal. Typically used for things like Gas, Printing, etc., when you have a set unit rate amount. 

Note - This will default in all Expense Sheets and Expense Journals.

Bill Status - Bill status that defaults into a transaction when this Expense Code is used.

Direct Cost - This is the default G/L base account for direct expense.

Overhead - This is the default G/L base account for indirect expense.

Direct Bill Revenue - This is the default G/L base account for expense billed revenue direct portion.

Markup Billed Revenue - This is the default G/L base account for expense billed revenue markup portion

Unbilled Revenue - This is the default G/L base account for expense unbilled revenue.

Comment Template -  This is where you assign a comment template to the expense code. The template

will display when the user clicks on the PM Comments box in the Expense Sheet. More on Comment

Templates

Comment Required - When checked, the expense code is requires that a  PM Comment be added when

this expense is added to an expense sheet.

Internal Comment Template -  This is where you assign a comment template to the expense code. The

template will display when the user clicks on the Notes (Internal) box in the Expense Sheet. This comment

is for internal purposes only. More on Comment Templates

Internal Comment Required - When checked, the expense code is requires that a Note be added when

this expense is added to an expense sheet.

Non-Reimbursable - When checked, the expense codes is flagged as non-reimbursable for expense

sheets.

  

4.4.2 Expense Groups

Overview 

Once Expense Codes are created, they can then be added to Expense Groups. An Expense Code can
belong to many groups. In turn groups are applied to projects. Groups also have effect dates (Periods)
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allowing for the revision of markups/rates on perhaps an annual basis. Basically.To apply an Expense Code
Group to a project, an Expense Code Group drop-down is available at Project
Administration>Projects>Expense & GL Tab.

Field Descriptions 

Periods

Start Date - This is the start date of the selected Expense Group.

End Date - This is the end date of the selected Expense Group.  If it is blank, there is no end date for the

Expense Group. This date fills in when a new period is added to the Expense Group.

Expense Codes

Expense Code - This is the expense code. It must already exist to be applied to a group. 

Note - Selecting a code will fill out the rest of the grid. You can, however, override these values here.

Name -  Expense Name

Currency - Enabled with Multi-Currency Setup. Represents the transactional currency in which the

expense code is utilized. For example, if entering a Purchase Journal using an AP Account (USD) only

Expense Codes of similar currency would be available to the transaction. For complete instructions on

setting up a Multi-Currency environment, go here: More on Multi-Currency

Exp. Code Type - Allowable PM types for the expense code are chosen here. They include O ther D irect

C harges, Out-of-C ontract C onsultants , In-C ontract C onsultants , C onsultants  (either OC C or ICC) and Any.

Expense Markup Type - There are three types of Expense Markup Types: (a) Markup, (b) Add-on,and (c)

Flat Amount. Below shows how each Markup type is calculated. 

o Markup - Unit Rate X  Qty  X  Markup (Amount entered in Markup Column)

o Add-on - [Unit Rate  +  Markup (Amount entered in Markup Column)]  X  Qty

o Flat Amount - Qty X Markup (Amount entered in Markup Column))

Markup - This changes depending on the Expense Markup Type selected. Note: The amount entered in

the Markup Column can be the Markup, Add-on, or the Flat Amount depending on what Markup Type you

select.

o Markup - Multiplier used to mark up the Unit Rate.

o Add-on - Amount you would like to add on to the unit rate.

o Flat Amount - Flat amount that you would like to charge per unit.

Unit Rate - Unit cost rate. The amount you pay, per unit, for the expense. This can be overridden in the

Expense Journal. Typically used for things like Gas, Printing, etc., when you have a set unit rate amount. 
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Note - This will default in all Expense Sheets and Expense Journals.

Bill Status - Bill status that defaults into a transaction when this Expense Code is used.

Direct Cost - This is the default G/L base account for direct expense.

Overhead - This is the default G/L base account for indirect expense.

Direct Bill Revenue - This is the default G/L base account for expense billed revenue direct portion.

Markup Billed Revenue - This is the default G/L base account for expense billed revenue markup portion

Unbilled Revenue - This is the default G/L base account for expense unbilled revenue.

Comment Template -  This is where you assign a comment template to the expense code. The template

will display when the user clicks on the PM Comments box in the Expense Sheet. More on Comment

Templates

Comment Required - When checked, the expense code is requires that a  PM Comment be added when

this expense is added to an expense sheet.

Internal Comment Template -  This is where you assign a comment template to the expense code. The

template will display when the user clicks on the Notes (Internal) box in the Expense Sheet. This comment

is for internal purposes only. More on Comment Templates

Internal Comment Required - When checked, the expense code is requires that a Note be added when

this expense is added to an expense sheet.

Non-Reimbursable - When checked, the expense codes is flagged as non-reimbursable for expense

sheets.

4.4.3 Labor Codes

Overview 

Labor Codes are used to designate the "work" that an employee is doing. Labor codes can be subtotals in 
Project Management reports. They are not exposed in billing, nor do they have budgets. Similar to Expense
Groups, they are put into groups that are used to classify the work done on a project.  An employee is able to
enter a Labor Code on the time Sheet.  Examples of Labor Codes include site time, meetings, phone calls,
etc.

Key Concepts

Users can be given the ability to use Labor Codes in their time sheets at Global Settings>Time and

Expense Tab>Misc>Use Labor Codes.

Labor Codes are not part of the WBS.

Labor Codes are entered in time sheets.

Labor Codes can be used to group or identify Labor on PM Reports.

Labor Codes can be used to group or identify labor on T&M type invoices.
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Labor Codes can be used to identify taxable items.

Labor Codes cannot vary rate schedules by labor code.

Labor Codes cannot budget labor codes.

Note: When Labor Codes are set up, they are global and can be used against any project. They can,

optionally, be restricted to direct or indirect projects.

Field Descriptions 

Labor Codes Grid

Active - When checked, indicates if labor code is active.

Labor Code - Labor code

Labor Name - Labor name

Type - Designates what type of project the labor code can be used with. Choices are Direct, Indirect, or

Both. Note that Indirect refers to all non-direct project types.

Comment Required - This requires that the employee enter a PM Comment on the time sheet when this

Labor Code is used.

4.4.4 Labor Code Groups

Overview 

Labor Code Groups work like Expense Groups in that they are assigned to a Project and can limit the Labor
Codes available for use in a project.  Labor Code Groups also have the ability to have Comment Templates
associated with them that can require the entry of specified information before a time sheet can be submitted.
To apply a Labor Code Group to a project, a Labor Code Group drop-down is available at Project
Administration>Projects>Expense & GL Tab.

Field Descriptions 

Labor Code Group

Labor Code Group - The name of the Labor Code Group.

Labor Codes Grid

Code - Labor code

Name - Labor name

Comment Template -  This is where you assign a comment template to the Labor Code. The template will
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display when the user clicks on the PM Comments box in the Time Sheet. More on Comment Templates

Comment Required - This requires that the employee enter a PM Comment on the time sheet when this

Labor Code is used.

4.4.5 Move Project Transactions

Overview 

The Move Project Transactions utility allows the mass movement of project transactions from one project

node to another project node.  

Key Concepts

Project Administration will allow the mass move of projects transactions from one project/node to another

project node. It is specific to the node selected.  This does not move all transactions throughout a whole

project at one time.  For example, If you select the Project level node of the source project and the task

level of the destination project, all of the transactions, in the source project, will be moved to the task

level, of the destination project.  All other transactions remain.

This utility will permit the movement of transactions regardless of contract level rules established in the

project.  For instance, this utility will allow you to move timesheets to non-bottom project nodes.

Field Descriptions 

Projects

Source Project - Project to which you are moving transactions from.

Include Children Nodes - When checked, all transaction of the source project children nodes will be

moved to the Destination Project node.

Destination Project - Project to which you are moving transactions to.

Transaction Date Range

Start -  Start date that will include all transactions that are to be moved.
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End -  End date that will include all transactions that are to be moved.

Audit Trail

Current Version Only - When checked, an audit trail will be documented showing the transfer of all time,

expense, etc.  

Note - If you are moving transactions for the purpose of deleting a project, leave this box unchecked.

New G/L Period - New G/L period for the transferred transactions to fall in.

Bill Status Filter - Filters out transactions with a specific bill status.  Leave blank for all.

Transaction Types 

Time Sheets - Filters out Time Sheet transactions

Expenses - Filters out Expense transactions

Sales - Filters out Sales Journal transactions

Adjustments - Filters out General Journal transactions

4.4.6 Post Earned Revenue

Overview 

The Post Earned Revenue (Revenue Recognition) utility is used to recognize Unbilled Revenue and WIP on

the General Ledger.

Key Concepts

Revenue Recognition is activated at Global Settings>Revenue Recognition by selecting "Use Revenue

Recognition"

When the utility is run, an entry is made to the General Journal posting revenue against Unbilled Revenue

and WIP accounts. More on the General Journal

The entry is recorded to the appropriate WBS level and Expense Code, if any. These entries are marked

as coming from revenue recognition. More on Expense Codes

This utility can be run at any interval (daily, monthly, hourly). 

There is an option in Global Settings to delete all revenue recognition entries in the current period prior to

posting. This is useful if a user wants to post revenue on a daily basis but does not want a cluttered

ledger. This is located at Global Settings>Revenue Recognition by selecting "Post Single Journal Entry
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Per Period"

A user can exclude projects from participating in revenue recognition by flagging them in the project setup

profit center section. More on Project Setup

A user can also make revenue adjustments in the General Journal and flag them to be excluded from

revenue calculations by selecting "Ignore In Rev. Rec.". More on the General Journal Header

Field Descriptions 

Period

Period - General ledger period. Used as cutoff for transactions and for posting. More on Accounting

Periods

Error Account

Error Account - General ledger account to use if an account cannot be derived. More on GL Accounts

Unbilled Revenue Base Codes

Labor - Unbilled labor revenue base account (non subcontractor)

Other Direct Charges (ODC) - Unbilled ODC revenue base account

Out-of-Contract Consultants (OCC) - Unbilled OCC revenue base account

In-Contract Consultants (ICC) - Unbilled ICC revenue

Labor Upset - Unbilled labor revenue upset base account

ODC Upset - Unbilled ODC revenue upset base account

OCC Upset - Unbilled OCC revenue upset base account

ICC Upset - Unbilled ICC revenue upset base account

Subcontractor - Unbilled labor revenue base account (subcontractor)

WIP Base Codes

Labor - Work-in-progress labor base account

Other Direct Charges (ODC) - Work-in-progress ODC base account

Out-of-Contract Consultants (OCC) - Work-in-progress OCC base account

In-Contract Consultants (ICC) - Work-in-progress ICC base account
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4.4.7 Profit Sharing

Overview  

This utility is primarily meant for companies with multiple profit centers (aka Organizational Units) that would

recognize revenue as billed. Typically, this utility would be run once a month after billing has been

completed. More on Profit Sharing

Field Descriptions 

Period

Period - General ledger period. Used as cutoff for transactions and for posting. More on Accounting

Periods

As of

As of - As of Date. Used as cutoff for transactions and for posting.

Error Account

Error Account - General ledger account to use if an account cannot be derived. More on GL Accounts

Billed Revenue Base Codes

Labor - Labor Billed revenue base account

Overhead - Overhead revenue base account

Labor Profit - Labor Profit revenue base account

Direct ODC - Direct ODC base account

Profit ODC - Profit ODC base account

Direct OCC - Direct OCC base account

Profit OCC - Profit OCC base account

ICC - ICC base account
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4.4.8 Projects

Overview   

Projects are used to manage jobs throughout InFocus. 

Key Concepts

All projects can have an unlimited breakdown (WBS). 

You can assign names, such as phase and task, to the levels of the WBS. 

An entire WBS can be created from a template project. 

Portions of the WBS can be constructed from system WBS templates. More on WBS Templates

4.4.8.1 Projects Toolbar

Overview   

The Projects Toolbar gives the user (if given the appropriate permissions) numerous capabilities within the
Projects applet. Below is a list of those capabilities.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options

View 

o Project Figures - Launches the Project Figures report for the currently loaded record.

Tools - Lists advanced options

o Project Members Wizard - Opens a pop-up that walks you through setting up your team members on a project.

More on the Project Team Members Wizard.

o Project Level Labels - Opens a pop-up containing an editable list of Project Level Labels.  More on Project Level

Labels

Project Level Labels - Opens a pop-up containing an editable list of Project Level Labels. More on Project Level Labels.

Project Plan - Opens up the Project Planning applet with the currently loaded project loaded. 

Print All Projects - Runs the Project List Report. More on the Project List Report
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4.4.8.2 General Tab

Overview 

The General Tab contains information that lays the groundwork for a new project. 

Field Descriptions
Below are field descriptions for the General Tab. 

** Indicates a required field

Project Info

Active -When checked, the project is active. Once a project is inactive it cannot receive charges.

** Code - Project (Node) Code. Must be unique (Unless you are using a Rollup Node. More on Rollup
Nodes)

** Name - Project (Node) Name.

** Charge Type - Determines the type of project . There are five types of projects in InFocus. The choice
affects the chargeable nature of the project. 

o Billable Projects  - Projects that can be invoiced and require a client. 

o Indirect Projects -  Projects that are overhead projects. They can be charged to but, never invoiced. 

o Projection -  A projection cannot receive charges. Projections are used to record estimated revenue
for future endeavors. Projects can always change their type.

o Opportunities -  Opportunities are similar to indirect projects. However, they are client-related, and
charges can be placed on hold. If an opportunity becomes a billable project, the charges on hold can
then be either billed or written off. 

o Plan - Plans cannot receive charges. Plans only exist for the purpose of project planning. 

** Client - Client for whom this project is for.

Template - When checked, the project is considered a template. Templates cannot receive charges and
are visible in the project setup. They are used to create new projects.

Project Types

Contract Type - Contract Types can appear on Project Management reports. Examples of contract types
are Fixed Fee, T&M, and Cost Plus. Contract types are used for filtering projects. A User Defined Field.
The Contract Type list is managed under Administration>List Management>Contract Types. 

Note - Contract Types do not limit the project to that contract type. 

Report Type - Report types are reporting groups that can act as filters when printing project management
reports. A User Defined Field. The Report Type list is managed under Administration>List
Management>Project Report Types. 
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Projections

Expected Revenue -  The expected revenue from this project. This can appear on project management
reports, but is otherwise informational only.

Win Probability -  Probability of winning the contract. This can appear on project management reports, but
is otherwise informational only.

Project Dates

Project Start -  The estimated project start date. Informational only. When a project has a plan, this field is
automatically filled out by Project Planning and is unavailable here.

Project End - Estimated project end date. Informational only. When a project has a plan, this field is
automatically filled out by Project Planning and is unavailable here.

Planning PM Level Lockout

Project Planning Level Lock out - Level in which all nodes at that level (and above) are locked from being
altered by project planning. You can choose a specific level, lock out all levels, or unlock all levels. 

Note - This feature allows for the division of WBS control between accountants and project managers.

Require

Labor Code -  When checked, employees will be required to provide a Labor Code. More on Labor Codes

Expense Comments -  When checked employees, will be required to provide an comment in the PM
Comments field when their expense sheets are saved.

Timesheet Comments -  When checked employees, will be required to provide an comment in the PM
Comments field when their time sheets sheets are saved.

Estimates-to-Complete -  When checked, employees will be required to provide an estimate-to-complete 
for all bottom nodes of the WBS to which they charged time during the current time sheet period (typically
a week long).

Chat Handle

Chat Handle - Handle for instant messaging applications like Slack, Skype, etc.

4.4.8.3 General Note Tab

Overview 

The General Note Tab is used to store general notes regarding the project.
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4.4.8.4 Market Sectors Tab

Overview 

The term Market Sector is typically used to describe a part of the economy. It can be a set of businesses that
are buying and selling similar goods and services that are in direct competition with one another. A project
can be assigned to one or more market sectors. A percentage can be placed next to each market sector to
designate the percentage of the project's cost and revenue that should be assigned to a particular market
sector. Financial statements can use these percentages. Also, project management reports can be printed by
market sector.

Field Descriptions
Below are field descriptions for the Market Sectors Tab. 

Apply - Selects the Market Sector(s) to be used on the current project.

Sector Name - Name of the Market Sector. A User Defined Field. The Market Sector list is managed
under Administration>List Management>Market Sectors. 

% - Designates the percentage of the project's cost and revenue that should be assigned to a particular
market sector.

4.4.8.5 Members Tab

Overview 

The Members Tab establishes Project Leaders, Team Members, and Organizational Charging of a project.

Field Descriptions
Below are field descriptions for the Members Tab. 

Project Leaders

Principal In Charge - The Principal that owns this project. Acts as a filter in Project Management reporting.
Also allows permission for the creation of work orders.

Project Accountant - The Project Accountant acts as a filter in Project Management reporting. It also
allows the user to make billing adjustments and invoice this project. It also allows permission for the
creation of work order.

Project Manager - The Project Manager acts as a filter in Project Management reporting. It also allows the
user to plan a project, review project billings, and generate work orders for that project.

Line-Item Approval

Time Sheets - When Time Line-Item Approval is enabled (Global Settings), these fields are used to
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govern whether the time against the Project needs to be approved by line or not.
Expense Sheets - When Time Line-Item Approval is enabled (Global Settings), these fields are used to
govern whether the time against the Project needs to be approved by line or not.

Note: There are 4 options:
1. Default - Looks at the Global setting of Required or Not Required
2. Required
3. Not Required
4. Required (Allow Approver) - Allows the Assigned Approvers (HR> Employees> Accounting

Rates Tab) to approve line items in addition to the Project Leaders.

Member Settings

Restrict Time and Employee Expense to Team Members - When checked, only employees who are team
members can charge to this project. Project leaders are implicitly considered team members and do not
need to be listed.

Organizational Charging

Owning Org Unit. -  The Owning Organizational Unit has the primary responsibility for a project. The level
of the org unit must be equal to or above the sharing profit center level as established in Global Settings.
If no owner is established, the project is considered open, and any organization can charge to it. More on
Organizational Units

 
Note - The Owning Org Unit is especially significant in revenue recognition and automated invoicing. 

Organizational Charging Settings

Allow All Cross Charging - When checked, all org units can charge to this project. Cross-charging in
InFocus means the organizations (not the owning organization or a sharing organization) that charge to
this project will have the cost of the charges transferred to the owning organization. Likewise, the owning
organization receives all revenue for those charges.

Always Allow Owning Organization -  When checked, the owning organization is always permitted to
charge to this WBS, regardless of sharing organization settings.

Team Members

Team Members - Team members are assigned for three reasons: 
a. To restrict charging to a project.
b. For informational purposes.
c. To alter or override their allowable job titles on a project. (To assign alternate job titles, add an

employee to a row in the grid. Click on the button at the right edge of the row to add job titles.)

Wizard Button - Clicking on this option will open up a screen listing all Employees and all Job Titles.  You
can select multiple employees and assign them a series of job titles.  This option is designed to add
multiple project members with the same job title(s).  It does not show what job tile members are currently
assigned to. The wizard merely facilitates adding new members and assignments.
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Below are field descriptions for the Team Members Grid

Employee Code - Code of the Employee associated with the Project.

Employee Name - Name of the Employee associated with the Project.

Default Job Title - Default Job Title given to the employee on this project by using the Icon (3 people)
described below. More on Job Titles

Role - Project Role of the Employee. A User Defined Field. The Project Role list is managed under
Administration>List Management>Project Roles. More on Project Roles 

Icon (3 people) - Allows a user to override the Employees default Job Title.  You can also establish a list
of Job Titles available to the employee when entering time.

4.4.8.6 Billing Tab

Overview 

The Billing Tab establishes Billing terms, Billing addresses(Remit to & Bill to), Late Charges, Retainer,
Retainage, and Billing groups/Invoicing. 

Field Descriptions
Below are field descriptions for the Billing Tab. 

Billing Terms

Term Type - Billing (Payment) terms of this project. Informational only. A User Defined Field. The Term

Type list is managed under Administration>List Management>Billing Terms. 

Net Days - Number of days added to the Invoice Date (Sales Journal) to calculate  the Due Date (Sales

Journal). 

Remit-To-Address

Office - Company office, set up at Administration>Global Settings>Offices Tab, where payments should

be sent. Appears on system invoice designs as the Remit to Address.

Attention - Attention line for remit to address. Appears on system invoice designs as the Attention item.

Retainage

Description - A portion of the agreed upon contract that is deliberately withheld until the work is

substantially complete to assure that the client will satisfy its obligations and complete a construction
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project.

Max - Maximum amount of retainage to be withheld.

Percentage - Percentage of labor revenue to withhold as retainage.

Retainage Inclusions

Hourly - Labor charged against this project is included in the retainage amount.

Fixed Fee - Fixed Fee Billings against this project are included in the retainage amount.

OCC - Out of Contract Consulting (Sub-consultant charges) against this project is included in the

retainage amount.

ODC - Other Direct Charges (Expense) charges against this project is included in the retainage amount.

Retainer

Apply Current Amount - Amount of retainer to be applied on next invoice. When invoiced, this amount is
automatically reduced by amount that was applied.

Billing Group

Billing Group - Billing groups are items that can be used for filtered runs or batches of automated

invoices. Billing groups are commonly used as a separate group for each week of a month. You could

then assign projects to a group and that way process invoices throughout the month. A User Defined

Field. The Billing Group list is managed under Administration>List Management>Billing Groups. 

Invoicing

Invoice Email - Billing email address associated with the Project. Will be the email used if the emailing

functionality in Automated Invoicing is enabled.   More on setting up emailing within InFocus

Main Invoice - Main invoice design assigned to the Project.

Note - When "Separate Expense Invoice" is checked, this label of this box changes to "Labor Invoice".  At

that point an Invoice design must have the Style attribute of "Labor Only" selected, on the Invoice Design,

for the invoice design to show in this drop-down. More on Invoice Designs

Separate Expense Invoice - When checked, the Expense Invoice cell will activate.  This will allow for a

project to run an invoice for expenses separately from invoices that include labor and Fixed Fees.

 Expense Invoice - Invoice designs must have the Style attribute of "Expense Only" selected, on the

Invoice Design, for the invoice design to show in this drop-down. More on Invoice Designs

Next Inv. Number - Next Invoice Number is active when invoice incrementing in Global Settings is set to

https://support.clearviewsoftware.net/articles/4081
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"By Project".  The Global Setting is located at Administration>Global Settings>Invoicing Tab>Invoice

Numbering.

Invoice Group - The Invoice Group allows for Projects to be invoiced as one invoice. When used, cover

sheets can be designed to summarize individual project billings. More on Invoice Groups

PO Number - When filled out this will override the client PO Number in invoicing.

Late Charge

Description - While late charges can be manually entered into the system and appear on A/R reports,

they are not automatically calculated and booked. The following two fields are part of A/R reports and can

be used to customize the reports by the user.

Type - Designates the type of Late charge to be calculated.  Choices are "Percentage of Balance Due"

and "Flat Amount".

Amount - The amount of late charge to be added or percentage to calculate.  Depends on the "Type"

selected.

Bill-To Address

Use Client's Bill-To - When checked, no address will appear here in the project set-up, but client's default

bill-to address will be used in invoicing. 

Use Custom Bill-To - When checked, an address that is different from the client's default bill-to address

can be entered here and used when generating invoices for this project. 

Use Custom Bill-To Drop-down - After selecting Use Custom Bill-To, select dropdown to fill in the client's

default bill-to address. You may then modify it, as needed, for this particular project. For example, you

could enter a different contact person while using the rest of the default address for this project’s

invoices. 

Custom Bill-To Address 

Attention - Bill-To Attention. You can type in a custom or use the look-up to select from Firm Contacts.

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

City - City

State - State

Zip / Postal - Zip Code
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Country - Country

Invoice Comments 

Invoice Comments - Text that can optionally appear on an invoice, typically on the first page invoice

header section.  This text will appear and can be edited in the "Invoice Comments" located in the header

of PA Bill Review. More on PA Bill Review  

4.4.8.7 Multi-Currency Tab

Overview 

In IMC, projects must be assigned designations for both Project and Invoicing Currency and can optionally

include Project specific currency and exchange rate overrides. This configuration is completed on the Multi-

Currency tab in Project Administration>Projects. These settings impact how the project and invoicing

amount currencies are determined on a given transaction. For instance, when a Purchase Journal (USD) is

entered against a project and a Currency override exists on the project for the specified Purchase Journal

evaluation date and transactional currency, the defined rate override(s) will be used for the project and/or

invoice currency amounts respectively. If this match is not found, these amounts will be determined using the

currency exchange relationship defined between the transactional currency (Purchase Journal) and main

project currency. For complete instructions go here: More on Multi-Currency

Field Descriptions

Settings

Description - This section holds the Project and Invoicing currency designations. Note the designated

currencies must be configured in General Accounting>Multi Currency.

Invoice Currency - The transactional, real world currency used in invoicing (Sales Journal) for the selected

project- used for project contracts and invoicing.

Project Currency - The currency used in project administration and project planning for the selected

project. Project Management reports can optionally print using this currency for the selected project. 

Project Equals Invoice Currency - Indicates that the Project currency will always equal the Invoice

currency and disables the ability to set Project currency and exchange rate overrides.

Separate Exchange Rates - Allows currency and exchange rate overrides for both Labor and Non-Labor
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Currencies

Description - This section defines the project specific currency and exchange rate overrides for the previously

designated Project and Invoicing currencies. The available overrides are derived from the defined exchange

relationships (General Accounting>Multi-Currency) and only affect project and invoicing currencies for the

selected project.

Use - Indicates the ability to utilize the specified currency

% Button - Sets the exchange rate override. 

Rate Tester

Description - This utility provides an evaluation of the rate exchange between the specified originating

currency and the destination Invoice and Project currencies accounting for configured overrides.

Currency - Originating currency to test.

Amount - Originating currency amount to test.

As of Date - Date by which to test the rate exchange.

Invoice Labor - Converted destination Invoice currency amount for Labor.

Invoice Non-Labor - Converted destination Invoice currency amount for Non-Labor.

Project Labor - Converted destination Project currency amount for Labor.

Project Non-Labor - Converted destination Project currency amount for Non-Labor.

4.4.8.8 Exp. | G/L Tab

Overview 

Defines expense and labor controls for the loaded project.

Field Descriptions
Below are field descriptions for the Billing Tab. 

Expense Group

Expense Group Drop-down - Predefined group of Expense Codes that are able to be used with this

project. More on Expense Groups

Labor Code Group

Labor Code Group Drop-down - Predefined group of Labor Codes that are able to be used with this

project. More on Labor Groups
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Pensoft Payroll Export Code

Pensoft Payroll Export Code Drop-down - Leave code for accrued leave time (Vacation, sick, etc.). More

on Payroll Export

Labor Distribution Base Codes

Note - Not used on billable projects. More on Labor Distribution

Hourly Cost - A direct labor cost G/L base account that is not flagged for sub-contractors.

Salaried Cost - A direct labor cost G/L base account that is not flagged for sub-contractors

Sub-Contractor - A direct labor cost G/L base account that is flagged for sub-contractors

Labor Markup CR - A direct labor cost G/L base account. Offset for Labor Markup DB.

Labor Markup DB - A direct labor cost G/L base account. Capture markup portion in labor distribution.

Setup: Back to Labor Distribution Setup

  

4.4.8.9 Taxes and Surcharges Tab

Overview 

The Taxes and Surcharges tab establishes taxes and/or Surcharges used for the project selected.  In order to
enforce the tax/surcharge, a Taxes section must be used in the Invoice Design for the invoice being used for
the selected project. Taxes and Surcharges are established in Administration>Global Settings>Taxes and
Surcharges Tab.

Field Descriptions
Below are field descriptions for the Taxes and Surcharges Tab.

Use -  When checked, the tax will be used in the selected project.

Tax Code - Code of the tax. 

Tax Name - Name of the tax.

Tax 1 % - Percentage of the first Tax/Surcharge applied to this project. Used in the first tax field in the
Invoice Design.

Inv. Text 1 - Text that shows up on the invoice next to the first tax/surcharge.

Tax 2 % - Percentage of the second Tax/Surcharge applied to this project. Used in the second tax field in
the Invoice Design.
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Inv. Text 2 - Text that shows up on the invoice next to the second tax/surcharge.

WBS level - The WBS level in which the Tax/Surcharge is enforced.

Exclusions - In the Exclus ions column, click the icon and a pop up will appear. You will see the 3 following
sections.  Checking the box next to the item will exclude if from the tax.

o Project Exclusions - Checking the box next to any Project Path that you want to exclude the tax from.

o Labor Code Exclusions - Checking the box next to any Labor Code that you want to exclude the tax
from.  In order for this to work, users must be entering Labor Codes on their time sheets. More on
Labor Codes 

o Expense Code Exclusions - Checking the box next to any Expense Code that you want to exclude the
tax from.  In order for this to work, users must be entering Expense Codes on Expenses, Purchases
and Disbursements that are passed to billing. More on Expense Codes 

4.4.8.10 Contacts Tab

Overview 

The Contacts Tab associates an Project with a particular Contact. 

Field Descriptions
Below are field descriptions for the Contacts Tab. 

** Indicates a required field when adding to the list.

** Contact - Name of the Contact associated with the Opportunity.

** Relationship - The Opportunities’s relationship with the Contact. A User Defined Field. The
Relationship list is managed under Administration>List Management>Project Contact Types

4.4.8.11 Addresses Tab

Overview
The Addresses Tab contains the addresses of the selected Project. 

Field Descriptions
Below are field descriptions for the Addresses Tab. 

Name - Named address. Not available for employee contacts.

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3
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Street 4 - Address line 4

City - City

State - State

Zip - Zip Code

State - State

Country - Country

Phone - Telephone number

Fax - Fax number

Latitude - Latitude of Address

Longitude - Longitude of Address

Copy to Clipboard - Copies address to the clipboard of the local workstation. (Only seen in Address

Editor)

Geocode - When clicked, the Latitude and Longitude are filled in with the location of the Main Address. 

This can be used in the Map Viewer applet. More on the Map Viewer. (Only seen in Address Editor)

Note 1: Clicking on a the pencil icon will bring up an Address Editor that will make data entry easier.

Note 2:  Addresses can be NAMED to categorize them for reuse. For instance, a client can have many

offices with an address for each office, as well as associate client contacts with a particular office address. If

the information of the NAMED address changes, you can cascade those changes to all associated (linked)

addresses in entirety, or only for fields that have a value.

Sometimes addresses have specific uses, as in the case of bill to, pay to, and remit to addresses. These can

be unassociated addresses or linked addresses. Typically, they will be linked addresses, which means they

must first be entered as a named address, prior to referencing them as a bill to, pay to, or remit to.

4.4.8.12 Documents Tab

Overview 

Documents tab allows you to upload, view, modify and delete archived documents in relation to the loaded
record. Uploaded documents and related information will be listed in the grid. More on Document
Management

4.4.8.13 Recent Tab

Overview 

The Recent tab shows transactions that go against the Project that is currently pulled up. Users can link over
to the specific journals if they are granted the appropriate permissions. More on Permissions
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Field Descriptions
Below are field descriptions for the Recent Tab. 

Include 

Sales Journal - Displays all Sales Journal transactions that have an Invoice date that falls on or after the
Transaction Since Date.

Purchase Journal - Displays all Purchase Journal transactions that have an Invoice date that falls on or
after the Transaction Since Date.

Employee Reimbursables - Displays all Purchase Journal transactions that have an Invoice date that falls
on or after the Transaction Since Date.

Receipts - Displays all Receipt Journal transactions that have an Check date that falls on or after the
Transaction Since Date.

Disbursements - Displays all Disbursement Journal transactions that have an Check date that falls on or
after the Transaction Since Date.

Adjustments - Displays all General Journal transactions that have an Transaction date that falls on or
after the Transaction Since Date.

Timesheets - Displays all Time sheet transactions that have an Work date that falls on or after the
Transaction Since Date.

Transactions Since

Date - The Transaction Since Date filters the Recent Transactions Grid.  It displays only transactions

whose transaction date falls on or above the selected date.

Arrow Button - Loads the Recent Transaction window.

Export to Excel - Exports the items in the Recent Transaction window to an Excel file.

Note - The grid includes the Transaction ID, Transaction Date, Invoice Number, Check Number, Comments,
Transaction Type, and Amount.

4.4.8.14 Notes Tab

Overview  

Notes can be entered against a Contacts, Firms, and Projects (including Opportunities). More on Notes

Field Descriptions
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Below are field descriptions for the Notes Tab. 

** Indicates a required field

Note Details 

Comment - Body of the Note

Note Type - Type of Note Posting (ex. Phone Call, Meeting, E-Mail, Appointment, Lunch, and Dinner are
the choices). A User Defined Field. The Note Type list is managed under Administration>List
Management>Note Types

Add a follow-up Activity?

Add - Create a a follow-up activity that appears on the Activity Calendar. More on Activities

Require Complete - When checked, the follow-up activity shows up on the Activity calendar until it is
marked complete.

Type -  Type of Activity. A User Defined Field. The Activity Type list is managed under Administration>List
Management>Activity Types

Date - Date of follow-up Activity.

Time - Time of follow-up Activity.

Duration - Duration of follow-up Activity.

Existing Notes

Notes associated with the Contacts, Firms, or Projects that have been created.  Double-click on them to
bring into focus.

4.4.8.15 Custom Fields (UDF) Tab

Overview 

User-definable fields (UDFs) can be created for Clients, Employees, Vendors, Projects, Project Level2 and
Contacts. More on User Defined Fields.

4.4.8.16 Right-Click on Project Top Level

Overview 

Right clicking on the Project Name (Top Level of WBS) in the Project Explorer Window gives you a number
of options.  This sections deals with the options that you get when the "Edit Project Structure" box at the
bottom left of the Project Explorer is UNCHECKED.

Options
Below are field descriptions for the pop-up. 
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Allowable Date Ranges

Description - Allowable Date Ranges are used to limit time and expense entry date ranges to a project.

Date ranges are allowed to have no Start Date or End Date to leave them open-ended. Date ranges can

also be controlled from project planning. 

Timesheet Entry - The Employee will not be able to enter a Time Sheet against this project if the time

sheet falls outside of the date range.

Expenses - The Employee will not be able to enter an Expense Sheet against this project if the time sheet

falls outside of the date range.

Charge Levels

Description - Charge levels control to what level ICC (In Contract Consultants), OCC (Out of Contract

Consultants), and ODC (Other Direct Charges) can be applied. No level needs to be established for time

charges since they always occur at the bottom node. Options are taken from the Project Level Labels.

More on Project Level Labels

ICC Charge Level - Level in which ICC (In Contract Consultants) charges can be applied.

OCC Charge Level - Level in which OCC (Out of Contract Consultants) charges can be applied.

ODC Charge Level - Level in which ODC (Other Direct Charges) charges can be applied.

Contract Levels / Caps

Description - This is where you establish Contract Caps (Labor, ODC and OCC), Fixed Fees, Lump

Sums, and ICC portions. 

Project Management Type Drop-down - The option are Labor, ODC and OCC.  This navigates you

through the different PM Types to establish contract amounts.

WBS Level - This establishes the level of the WBS (Work Breakdown Structure) that you want your

contracts amounts to reside.  

Note - Labor PM Type Contract amounts MUST reside at the same level of the WBS.  If you change

levels and click Save, all data on the previous level will be deleted.

Construction Fee - Total amount of the Construction Project

Fee % - Percent of the Construction Project that the Total Fees of this project represent.

Total Fee - Total Fees of this project represent

Set Contract Amounts Equal to Budgets - By clicking this button you are given the option to update the

Caps or Fees to match the Budgets set in Project Planning. More on Project Planning Budgets

PM Type Labor (Grid)

Path - Project Path
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Name - Project Name

CAP - Labor Cap to be applied.  Depending on the setup of the invoice design, the Labor Cap can

prevent the project from billing Labor over this amount (aka Hard Cap).

Fixed Fee - Fixed Fee amount. This amount is used in both Percent Complete and Lump Sum Billing. In

both cases, the total contract amount for the node should be put here.

% Complete - This is the Percent Complete of the node. This can also be set from Project Accountant Bill

Review.

Lump Sum - This is the Lump sum portion of the Fixed Fee that is to be billed until it reached the Fixed

Fee amount. It is also accessible in the PA/PM Bill Review screens. In order to use this feature, you must

use an invoice design whose labor section has been designated to use this field.  Two new invoice

formats that support lump sum billing have been added.  Lump Sum Level 1 works at the project level

while Lump Sum Level 2 works at the phase level (2nd level). 

ICC FF Portion - Dollar amount of fixed fee that should be attributed to ICC for the entire WBS node.

ICC Current FF - Dollar amount of fixed fee that should be applied to ICC on next invoice.

% of Fee - Looks at the "Total Fee" located in the "Percent of Construction" box and uses the % to come

up with the Fixed Fee amount for that node.

Fixed Fee Notes - General Notes about the node can be stored here. These are accessible in PA & PM

Bill Review.

PM Type Non-Labor (Grid)

Path - Project Path

Name - Project Name

CAP - ODC or OCC Cap to be applied.  Depending on the setup of the invoice design, the Cap can

prevent the project from billing non-labor transactions over this amount (aka Hard Cap).

Default Bill Status

Description - This allows you to set the default bill status for transactions that go against this project.

These features do not limit the statuses; they simply specify the default value on a new transaction.

Expense Markups/Codes

Description - Expense Multipliers and Expense overrides on a per-project basis are established here.

Project Override Expense for ODC (Other Direct Charges) and CNS (Consultant Expense), can be set at

any level of the WBS (Work Breakdown Structure). Setting the Markup at lower levels will override higher

levels (e.g. Task overrides Phase, Phase overrides Project). 
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Invoice Description

Description - Users can enter general invoice description comments here. 

Invoice Filters

Description - This feature allows for using mixed style billings on a single project without the need to

create a roll-up project or an invoice group. A filter is a user-definable code that can be placed on the

second level nodes (usually called phases) within a project WBS. More on Invoice Filters

Invoice Posting Groups

Description - This gives you an option to assign Invoice Posting Groups that override the default posing

groups set in Automated Invoicing. More on Invoice Posting Groups

Rate Schedules

Description - Rate Schedules drive the rates for labor entered against the project.  Rates Schedules can

be established here for Bill Rate, Job Cost Rates and/or Pay Rates.  Rate schedules can be applied to

any or all nodes of the WBS. Children nodes override parents nodes. More on Rate Schedules

Revenue Recognition/Profit Centers

Description - Revenue Recognition is used to meet the GAAP principles of recognizing revenue in the

same accounting period in which the expense was incurred. More on Revenue Recognition / Profit 

Centers

Time Sheet Comment Templates

Description - Comment Templates allow for the entry of specific data in the Comment box. Comment

Templates for time sheets can be added to all levels of the WBS. More on Comment Templates

Labor Code Groups

Description - Labor Codes are used to designate the "work" that an employee is doing. Labor Code

groups can be added to all levels of the WBS. More on Labor Codes

4.4.8.17 Right-Click on Project Sublevel

Overview 

Right clicking on a sublevel Project Name (Lower Level of WBS) in the Project Explorer Window gives you
a number of options.  This sections deals with the options that you get when the "Edit Project Structure" box
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at the bottom left of the Project Explorer is UNCHECKED.

Options
Below are field descriptions for the pop-up. 

Allowable Date Ranges

Description - Allowable Date Ranges are used to limit time and expense entry date ranges to a project.

Date ranges are allowed to have no Start Date or End Date to leave them open-ended. Date ranges can

also be controlled from project planning. 

Timesheet Entry - The Employee will not be able to enter a Time Sheet against this project if the time

sheet falls outside of the date range.

Expenses - The Employee will not be able to enter an Expense Sheet against this project if the time sheet

falls outside of the date range.

Default Bill Status

Description - This allows you to set the default bill status for transactions that go against this project.

These features do not limit the statuses; they simply specify the default value on a new transaction.

Invoice Description

Description - Users can enter general invoice description comments here. 

Sublevel UDFs

Description - User-definable fields (UDFs) that are associated with the lower nodes of a project can be

created here.  In addition, the data entry for those fields happens here as well. More on User Defined Fields.

Time Sheet Comment Templates

Description - Comment Templates allow for the entry of specific data in the Comment box. Comment

Templates for time sheets can be added to all levels of the WBS. More on Comment Templates

Labor Code Groups

Description - Labor Codes are used to designate the "work" that an employee is doing. Labor Code

groups can be added to all levels of the WBS. More on Labor Codes
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4.4.8.18 Right-Click on Project (In Edit Project Structure Mode)

Overview 

Right clicking on the Project Name in the Project Explorer Window gives you a number of options.  This
sections deals with the options that you get when the "Edit Project Structure" box at the bottom left of the 
Project Explorer IS CHECKED.

Field Descriptions
Below are field descriptions for the pop-up. 

Add - Here you may Add a section of the project structure. Note - This will add a child to the level of the

WBS that you have selected. For example, if you click on the project name, this will create a phase.

Copy - Here you may Copy a section of the project structure. 

Cut - Here you may Cut a section of the project structure. 

Paste - Once you have cut or copied a part of the project, you can paste it to another section of the

project. Note - This will past as a child to the level of the WBS that you have selected. For example, if

you click on the project name, this will create a phase.

Cancel - This will cancel the current action.

Delete - This will delete the section of the project that has been selected.

Rename - This will allow the user to rename the section of the project that has been selected.

Apply WBS Template - This allows you to apply a WBS template to the current project. More on WBS

Templates

Attach Existing Roll-up - Only when you right-click on top level. This allows you to apply an existing roll-up

to the current project. More on Rollup Nodes

Create Roll-up Node - Only when you right-click on top level. This allows you to create a new roll-up to

attach to the current project.

Detach Roll-up Node - Only when you right-click on top level. This allows you to remove the roll-up that is

attached to the current project.

4.4.8.19 Project Members Wizard

Overview   

The Project Team Members wizard helps you build your team for a selected group of projects. 
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Options
Below are field options for the Project Team Members Wizard pop-up. 

Employees Tab

Description - Allows you to select the employees that you would like to be on the team for the selected

projects.

Check All - Checks the Apply box for all employees in the grid.

Apply - When checked, the member will be added to the team.

Code - Employee Code.

Name - Employee Name.

Status - Employee Status

Action - Action to be taken when the wizard is run. Options are Add/Modify and Remove

Default Job Title - What the Default Job Title will be for the employee after the wizard is run. More on Job Titles

Project Role - What the Project Role will be for the employee after the wizard is run. More on Project Roles

Filters Tab

Description - Allows you to filter the list of projects that you are creating teams for.

Apply members to all projects - Selecting this option applies the Employees selected from the Employees Tab to all

Opportunity and Billable Projects

Apply members to projects by filter - Selecting this option applies the Employees selected from the Employees Tab to

the list of projects created from the filters.  Here is a list of the filters given:

o Client - Allows you to filter by a  specific Client.  More on Clients

o Status - Allows you to filter by Project Status. Options are Active and Inactive.

o Charge Type - Allows you to filter by Project Charge Type. Options are Billable and Opportunity.

o Rate Schedule - Allows you to filter by a specific Rate Schedule a Client.  More on Rate Schedules

o Project Manager - Allows you to filter by a  specific Project Manager.

o Report Type - Allows you to filter by a specific Report Type assigned to the project (Project

Administration>Projects>General Tab).

o Contract Type - Allows you to filter by a specific Contract Type assigned to the project (Project

Administration>Projects>General Tab).

4.4.8.20 Project Level Labels

Overview   

Project level labels are used to assign a familiar name to each level of the WBS. 
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Field Descriptions 

Below are field descriptions for the Project Level Labels pop-up. 

Level - Project Level. One is the first level.

Singular Name - Singular form of level name.

Plural Name - Plural form of level name.

4.4.8.21 Revenue Recognition / Profit Centers

Overview 

This section gives a description of the Revenue Recognition / Profit Centers option when you right click on

the project.  More on Revenue Recognition Profit Centers

Field Descriptions

Below are field descriptions for the Revenue Recognition pop-up that you get when you right-click on the

project.  More on Right-Clicking on the Project 

Header 

Exclude from Revenue Recognition and Profit Sharing check-box - When checked, the project will be

ignored in Profit Sharing adjustments.

Sharing Org. Units Tab

Project Management Type

Project Management Type drop-down -  Profit Center Sharing Levels are established for the four PM types

(Labor, OD C , OC C , and IC C). 

WBS Level 

WBS Level drop-down (selected with a PM Type) - These levels not only dictate the part of the WBS to

which org members can charge, but also represent where organizations can establish intra-profit center

caps and rules for revenue recognition.

Projects Grid

Path - Path of current project at the level of the selected WBS.

Name -  Name of current project at the level of the selected WBS.
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Overall Cap - Overall caps can be entered here. When the overall cap is non-zero, over-runs/under-runs

are absorbed by the primary Sharing Profit Center.

Org Units Grid

Share - When checked, this organization can share in the project.

Path - Path of Organizational Unit.

Name -  Name of Organizational Unit.

Is Primary - When checked, this is the primary org unit for this WBS node. Only one org unit can be the

primary. The primary absorbs any overruns/under-runs for the level when a cap is present in the projects

grid. 

Cross Charge - When checked, this org unit receives cross-charging for any org units not listed as a

share. Only one org unit can be specified for cross-charging. Setting a cross-charge org unit opens up

this WBS node and its children to all org units.

Cap - Cap (if any) to be used in revenue calculations for this org unit.

PC - Percent complete (if any) to be used for revenue calculations for an org unit.

Revenue Method - Revenue recognition methods. There are various calculations based on time and

material, caps, and percentage completions using various valuation rates. Below is a list of the Methods

that can be selected.

Owning Org. Units Tab

Description: The Owning Org. Unit tab in Revenue Recognition is an optional feature.  It can run a Revenue

Recognition method and the Owner would get/lose revenue based on what the owner method specifies less

all revenues earned by the sharing org units.  So basically the idea is you could have a Fixed Fee job where

the overall earned is based on percent complete, meanwhile the sharing Orgs earn at a T & M basis.

Project Management Type

Project Management Type drop-down -  Profit Center Sharing Levels are established for the four PM types

(Labor, OD C , OC C , and IC C). 

WBS Level 

WBS Level drop-down (selected with a PM Type) - These levels not only dictate the part of the WBS to

which org members can charge, but also represent where organizations can establish intra-profit center

caps and rules for revenue recognition.

Revenue Methods

Labor Methods

Pay rate with no cap - Transactions are analyzed at pay rate. There is no maximum
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Job cost rate with no cap - Transactions are analyzed at job cost rate. There is no maximum

Bill rate with no cap - Transactions are analyzed at bill rate. There is no maximum

Pay rate with cap - Transactions are analyzed at pay rate. They are capped if applicable.

Job cost rate with cap - Transactions are analyzed at job cost rate. They are capped if applicable.

Bill rate with cap - Transactions are analyzed at bill rate. They are capped if applicable.

Percent complete - Transactions are analyzed at a user enter percent complete versus cap.

Cap amount - Revenue is set equal to cap amount.

Expense Methods

Cost amount with no cap - Transactions are analyzed at cost. There is no maximum

Bill amount with no cap - Transactions are analyzed at marked up or billable value. There is no maximum

Cost amount with cap - Transactions are analyzed at cost. They are capped if applicable.

Bill amount with cap - Transactions are analyzed at marked up or billable value. They are capped if

applicable.

Percent complete - Transactions are analyzed at a user enter percent complete versus cap.

Cap amount - Revenue is set equal to cap amount.

4.4.8.22 Roll-up Node

Overview 

This section discusses the concept of a Roll-up Node. More on Project Nodes

Key Concepts

Roll-up Nodes exists only at level 1.

Roll-up nodes allow multiple Bill Terms Nodes (Projects) to be connected together for the purpose of

summarization in Project Management reports. 

Roll-up Nodes can contain no other attributes other than a code and a name

Roll-up Nodes allows multiple projects to be subtotaled together in project management reports A

separate WBS delimiter can be used from the rest of the WBS delimiter. For instance , 9801.01-A-001 is

a four-level structure where the roll-up is 9801; the project is 01; the first level beneath project is A; the
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bottom level is 001.  This is set at Global Settings>project Admin Tab>Delimeters Section.

When roll-up nodes are inserted above an existing WBS, the WBS path now begins with the roll-up node

and is separated by a delimiting character from the rest of the WBS path.

4.4.9 Rate Schedules

Overview 

Rate schedules can be used to control Pay Rate, Job Cost and Bill Rates on individual projects.  If Rate
Schedules are not used the rates are pulled from the Pay Histories Tab (Pay Rate) and the Accounting /
Rates Tab (Bill and Job Cost Rates) in the Employee file. More on Employees.  Once rate schedules are set
up, they can then be applied to Projects (Where to apply Project).   

Key Concepts

InFocus supports those firms that revise their rate schedules annually with date revisions of rate
schedules. Time sheet work dates are compared to the Schedule Period ranges of the Rate Schedules
when locking in on a rate.

When time sheets are entered or edited in the system, they automatically pick up rates and store them in
the time sheet module, where they are available for reporting. 

If the Rate schedule is changed after time sheet have been submitted, the time sheets DO NOT
recognize the new rate.  The Recalculate Rates  utility is used to retroactively apply rates to time entries.
More on Recalculate Rates
Rate schedules are date-sensitive to all period changes to schedules. 

If there is not a match when InFocus looks at the Rate Schedule, the rates are pulled from the Employee
File. More on Employees

Field Descriptions 

Name

Name - Name of the Rate Schedule.  Must be unique.

Schedule Type - Type of Rate the Schedule controls.
o Bill Rate Schedule - When selected, the current Rate Schedule is a Bill Rate Schedule.
o Job Cost Schedule - When selected, the current Rate Schedule is a Job Cost Schedule.
o Pay Rate Schedule - When selected, the current Rate Schedule is a Pay Rate Schedule, however,

Pay Rates cannot be multiplier based.
Description - Rate Schedule description

Schedule Period

Schedule Period - Date range where the selected Rate Schedule is active.  By clicking the look-up, you

can see all of the periods associated with the Rate Schedule.

Add Period - When you click on this, the user can create a new period to the current Rate Schedule.

Delete Period - When you click this button, the user can delete the current period from the current Rate
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Schedule.

Rate Schedules Grid

Description - The Rate Schedule Grid shows you all of the line items that make up the Rate Schedule. To

add a line item click "Add Rate". To Edit a line, double-click on the line that you wish to edit.

Job Code - Job Title Code.This line looks for the specific Job Title. if  left blank (* represents blank), any

employee is a match. More on Job Titles

Job Title - Job Title Name

Emp Code - Employee Code. This line looks for the specific Employee. if  left blank (* represents blank),

any employee is a match.

Emp Name - Employee Name.

Currency Name - Enabled with Multi-Currency Setup. Represents the transactional currency in which the

rate is utilized. For example, if entering a Time Sheet (U.S. Dollars) only Rates of similar currency would

be used in bill, cost or pay rate evaluation. For complete instructions on setting up a Multi-Currency

environment, go here: More on Multi-Currency

DPE X - The DPE (Direct Personnel Expense) Multiplier is applied to this row of the Rate Schedule.  The

Pay Rate from the Employee File (Unless the Pay Rate is overridden on the Rate Editor) is multiplied by

the DPE multiplier to get a rate when a number is placed here. More on the Rate Editor

OH X - The OH (Overhead) Multiplier is applied to this row of the Rate Schedule.  The Pay Rate from the

Employee File (Unless the Pay Rate is overridden on the Rate Editor) is multiplied by the DPE multiplier

then by the OH multiplier to get a rate when a number is placed here. More on the Rate Editor

Profit X - The Profit Multiplier is applied to this row of the Rate Schedule.  The Pay Rate from the

Employee File (Unless the Pay Rate is overridden on the Rate Editor) is multiplied by the DPE multiplier

then by the OH multiplier, then by the Profit multiplier to get a rate when a number is placed here. More

on the Rate Editor

Flat Reg. Rate - Displays the overriding Regular Rate when "Use Flat Rates" is checked in the Rate

Editor. More on the Rate Editor

Flat Prem. Rate - Displays the overriding Premium Rate when "Use Flat Rates" is checked in the Rate

Editor. More on the Rate Editor

Add Rate - When you click on this, you will get the Rate Editor pop-up that will allow you to add a new

line to the Rate Schedule.  More on the Rate Editor

4.4.9.1 Rate Editor

Overview 

The Rate Editor allows you to Edit and Add line items to a Rate Schedule.
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Key Concepts

By leaving Employee blank means that any employee will be a match on the row. 

By leaving Job Title blank means that any Job Title will be a match on the row. 

By leaving both Employee and Job Title blank means that all time entries will match if there are no other
matches.  Typically, a final row will be added with both blank that will catch all of the non-matching time
sheet entries.  If this row is not added, then the Employee file is used to get this number.

Field Descriptions 

Employee / Job Title

Employee - Employee to match; left blank, any employee is a match.

Job Title - Job Title to be matched; left blank, any job title is a match.

Use Flat Rates

Use Flats Rates - When checked, the rates in this section will be used as a Flat Rate ignoring the

multipliers. When unchecked, multipliers will be used.

Regular - Overriding Flat Rate for regular time.

Premium - Overriding Flat Rate for premium time (Overtime).

Multipliers

DPE - Multiplier that represents the Direct Personnel Expense when calculating the rate.

OH - Multiplier that represents the Overhead when calculating the rate.

Profit - Multiplier that represents the Profit when calculating the rate.

Apply Multipliers on Premium Portion - When checked, the premium portion of overtime is marked up. 

o For Example, An Employee gets paid $10/hr straight time and $15/hr OT. The billing multiplier is 3.0.

When apply MU on Premium is true formula on overtime item is $15*3=$45. When apply MU on

Premium is false formula on overtime item is ($10*3)+$5=$35

Base Rates (Regular and Premium)

Override Regular Rate - When checked, the entered in the "Pay Rate" field will be used as the Pay Rate.

Otherwise the employee regular Pay Rate is used from the Employee File.

Pay Rate - Pay Rate to be used when "Override Regular Rate" is checked.

Override Premium Multipliers - When selected, the OT Multipliers selected below the button are used. 

Override Premium Rates - When selected, the Employee Premium (Overtime) rates selected below the

button are used.

OT1, OT2, OT3 and OT4 - Overtime typed that are enabled in Global Settings at

Administration>Global Settings>Labels Tab
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4.4.10 Recalculate Markups

Overview 

The Recalculate Markups utility allows the user to recalculate the markups on non-labor project cost

transactions. The ability to recalculate markups is used when the markup is set on a project or expense code

after transactions have already been entered. To recalculate markups, the user must have permission (via

the Permissions applet in the Administration module). 

Key Concepts

Project Override Expense for ODC (Other Direct Charges) and CNS (Consultant Expense), can be set at

any level of the WBS (Work Breakdown Structure). 

Setting the Markup at lower levels will override higher levels (e.g., task overrides phase, phase overrides

project). 

Access the Markup Overrides by right-clicking on the Project Name in the Project Explorer (in the Projects

Applet). Accordingly, the Markup fields on the Exp/GL tab have been removed. More on Project Setup

Note: In order to access the Recalculate Markups Applet, you will need to have permission via the

Permissions applet, located in the Administration Module.

Field Descriptions 

Limit Transactions By (Dates)

Do Not Limit - Does not limit the recalculation by a date range

Transaction Date Range -  Allows for the user to select a transaction date range to filter the transactions

to be recalculated.

Period Range - Allows for the user to select a period range to filter the transactions to be recalculated.

Limit Transactions By (Expense Codes)

Do Not Limit - Does not limit the recalculation by a date range

Expense Codes -  Allows for the user to select an Expense Code to filter the transactions to be

recalculated.
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Expense Group - Allows for the user to select an Expense Group to filter the transactions to be

recalculated.

Statuses To Include

Ready - When checked, time line items with a bill status of Ready to Bill will be included.

Hold - When checked, time line items with a bill status of Hold will be included.

Never Billed - When checked, time line items with a bill status of Never Bill will be included.

Billed - When checked, time line items with a bill status of Billed will be included.

Write Off - When checked, time line items with a bill status of Write Off will be included.

Include PM Types

ODC - When checked, the recalculation includes expenses that are Other Direct Charges. 

OCC - When checked, the recalculation includes expenses that are Out of Contract Consultants. 

ICC - When checked, the recalculation includes expenses that are In Contract Consultants. 

Only This Project (leave blank for all)

Lookup - Here you can select a specific project for which to recalculate markup or leave blank for all projects.

4.4.11 WBS Templates

Overview  
WBS Templates allow you to create a project structure that is used often and apply it to multiple projects.

WBS Codes must be unique with respect to Parent node within a template. Since the top level has no parent

nodes, all top nodes must be unique among themselves within the template. 

Note - Work Breakdown Structure Templates are tree fragments. They can represent either multiple levels of

nodes linked together or only one unlinked level. WBS templates are used for fast WBS setups. 

Field Descriptions 

Template Window

Template - This column contains the name of the WBS Templates. To create a WBS Template, click

"New".  Once saved, the name will appear in this column.
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Template Grid

Template - Name of the WBS Template.

Toggle - Expands and collapses the WBS tree in the grid.

Code - Name of the WBS node. Top level nodes must be unique among themselves within the template. 

Name - Name of the WBS node.

  

4.5 Project Management

4.5.1 PM Bill Review

Overview 

The PM Bill Review (project manager bill review) applet is used by project managers to communicate billing
and charging instructions to the project accountant. 

Key Concepts

Only project managers have access to this applet. When the screen is first launched, all active projects

assigned to the logged-in project manager will load with their respective un-billed transactions through an 

As of Date. 

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

View - Additional View options

o Columns - Additional columns that can be displayed on the Transactions Tab. PM

Job Code - Job Title Code. More on Job Titles

Job Name - Job Title Name. 

Reports

o View Invoice - Takes the user to Automated Invoicing where they can view the invoice. More on Automated Invoicing

o Bill Review Report - When selected, the system Bill Review Report is rendered.  This report is managed at Global

Settings>A/R Tab.

o Pre-Bill Report - When selected, the system Pre-Bill Review Report is rendered.  

View Invoice - Renders the invoice to be reviewed.

Bill Review Report - When selected, the system Bill Review Report is rendered.  This report is managed at Global

Settings>A/R Tab.
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Pre-Bill Report - When selected, the system Pre-Bill Review Report is rendered.  

Set Bill Status - Changes the Bill Status of the Transactions. To use, you must first select the transactions that you

would like to change the status of. Then click the button and select the status.

Move Project Tx - Moves Transactions from the current project to a new destination project.. To use, you must first

select the transactions that you would like to move. Then click the button and select the destination. More on Move

Project Transactions

Overview  

Note: The As of Date defaults to the End Date of the current invoicing period but can be changed in Global
Settings.

An instructional video is available in the Blog section of the Clearview web site at www.clearviewsoftware.net

The purpose of PM Bill Review is for project managers to (1) review each of their projects and (2) make

comments and instructions for the project accountant. Once all transactions have been reviewed and

appropriate entries made, the project manager should mark the project as Reviewed. When a project is

marked Reviewed, the project manager can no longer make changes, unless the project accountant (in the

PA Bill Review applet) unflags the project as Manager Reviewed. When the project is marked Reviewed, it

will automatically flag all associated transactions as reviewed. Therefore, when time and expense transfers

from other projects are assigned to a reviewed project, they will appear as Unreviewed. This eliminates

transactions from bypassing a review process.

Comments can be made both at the project level and the transaction level.

Note:  Filters are available in the top panel of the applet to limit the displayed projects by manager and/or
accountant. 

A user can filter transactions by an As of Date

A user can limit the display of projects to those that have been reviewed by a manager.

Limit To PM Leader - When checked (and the Project Leader drop-down is filled out), only projects, where
the stated Project Leader is a project manager, will be returned.
A Has WIP check box will filter out projects with no WIP value.

A Has Fixed Fee check box will filter out projects with no Fixed Fee value.

A Quick Filter has been added.  This will filter projects whose path begins with the entered characters.

A project can be marked as Do Not Bill.

  

4.5.1.1 Header Section

Overview 

http://www.clearviewsoftware.net
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The Header section shows important Project and Billing information .

Field Descriptions 

Header

Current Invoicing period set in Accounting Periods. More on Accounting Periods

Project Name - Name of the Project. You are able to click on this to "link over" to the projects applet.

Note - If you hover over the (?) icon next to the name, you will see important project information.

Project Code - Code of the Project. 

Note - If you click on the (!) icon next to the code, you will get a Project Note Pop-up. This will save on the

General Note tab on the project located at Projects>General Note Tab.

Client - Client Name located in the top-right of the header.

Last Invoice Date - Date of the last invoice (Sales Journal) against the selected project.

Do Not Bill - Informational Only. Used to flag the project as Do Not Bill.

PM Reviewed - Marked by the PM. Used to inform the Project Accountant that the project has been

reviewed.

Status Box

Ready - Displays the total amount of transactions As of the given date that have a status of Ready to Bill.

Hold - Displays the total amount of transactions As of the given date that have a status of Hold.

Retainer Balance - Remaining balance of the retainer.  More on Retainers 

Current Retainer - The current retainer that will be applied in the next billing cycle. This can be added

here.

Never Bill - Displays the total amount of transactions As of the given date that have a status of Never Bill. 

Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

Write-off - Displays the total amount of transactions As of the given date that have a status of Write-off. 

Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

ICC WIP - Displays the total amount of transactions As of the given date that are considered ICC WIP. 

Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings
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Rate Schedule - Displays the Rate Schedule associated with the project. More on Rate Schedules

Invoice Comments - These are comments that will show up on the invoice header of the system invoice

designs. This can also be modified on the project at Projects>Billing Tab>Invoice Comments

Instructions to Biller - These are internal notes intended for the Project Accountant. As the invoicing

period is changed, the comments are saved, however, they are blank for the new period.

4.5.1.2 Filter Window

Overview 

The filter window is available to assist in narrowing down your search.

Field Descriptions 

Filter Window (Grid)

Path - Project Path

Name - Project Name

Filter Window (Bottom)

Quick Filter (Text Box) - A Quick Filter is at the top of the panel.  This will filter projects whose path begins

with the entered characters.

As of Date - Used as a cut-off date to limit the transactions that you are reviewing.

Project Leader - Depending on the selection in the Limit To drop-down, projects that have the selected

leader as the Leader type will be returned. The Project Manager will be auto-filled into this look-up upon

entry.

Limit To - When checked (and the Project Leader drop-down is filled out), only projects, where the stated

Project Leader is a project manager, will be returned.

Has Fixed Fee - When checked, only projects that have Fixed Fee values will be returned.

Has WIP - When checked, only projects that have WIP values will be returned.

Load - When selected, all projects that match the filter criteria will fill into the Filter Window.
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Additional Field Descriptions (Column Chooser) 

Filter Window Grid

Client - Client associated with the Project.

WIP - Total WIP

PA Reviewed - Check-box that displays the PA Reviewed status.

PM Reviewed - Check-box that displays the PM Reviewed status.

Do Not Bill - Check-box that displays the Do Not Bill status.

Retainer - Retainer Amount

Last Invoice Date - Date of the last invoice (Sales Journal) against the selected project.

4.5.1.3 Transaction Tab

Overview 

The Transactions tab is used by project managers to review time and expense on a project-by-project basis

prior to approving for invoicing. 

Key Concepts

When a project has Labor and Expenses associated with it, a Project Manager can review it here. Once
all transactions have been reviewed and appropriate entries made, the project manager should mark the
project as Reviewed. 

To see Transactions for a specific project, click on the project in the Filter Window.

When selected, the Transactions Tab displays the transactions entered against the project. 

Comments can be made both at the project level and the transaction level.

Columns in the detail grid can be dragged to change order.

Field Descriptions 

Arrange By

Arrange By - The drop-down allows you to select different ways in which you would like to see the

Transaction detail grouped. The options are Journal, Project Path, Bill Status, Transaction Date and

None.
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Transactions Grid

Journal - Journal of the transaction.

Name - Name of the Project Manager assigned to the project.

S - Bill Status. This shows the Bill Status of the transaction.

Labor/Exp. Code - Displays the Labor Code for Labor and Expense Code for Expenses.  More on Labor

Codes  More on Expense Codes

Project Path - Project Path of the transaction.

Transaction Date - Date of the Transaction.

Bill Rate/MU - Displays the Bill Rate for Labor and the Marked Up rate for Expenses.

Units/Hrs - Displays the Hours for Labor and Units for Expenses.

Amount - Amount of the Transaction

Time/Expense Comments - Displays the PM Comments entered on the transaction.

Instructions To Biller - These are internal notes intended for the Project Accountant. As the invoicing

period is changed, the comments are saved, however, they are blank for the new period.

ICC Amount - ICC Effort Amount. Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

Never Bill - Never Bill Amount. Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

Writeoff - Writeoff Amount. Enabled at Global Settings>A/R Tab>PA/PM Bill Review Settings

Additional Field Descriptions (Column Chooser) 

Transactions Grid

Project Name - Name of the Project

Project Long Name - Name of the project including the concatenation of the lower nodes of the project.

Job Code - Job Title Code - More on Job Titles

Job Name - Job Title Name

Labor/Exp. Name - Displays the Labor Name for Labor and Expense Name for Expenses

OT - Overtime

4.5.1.4 Fixed Fee Tab

Overview 

The F ixed Fee tab is used by project accounts to perform fixed fee modifications on a project-by-project basis

prior to invoicing. When a project has a contract level established, the fixed fee tab will contain all the nodes
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of the WBS at the contract level, as well as their respective contract amounts and prior percents complete.

The project manager can enter the new percent here.

Key Concepts

To see Fixed Fee items for a specific project, click on the project in the Filter Window.

Columns in the detail grid can be dragged to change order.

Field Descriptions 

PC Formula

Percent Complete Formula - The drop-down contains predefined formulas managed in Global Settings>A/
R Tab>Percent Complete Calculation Default Formula 

Calculate All - When selected, the Calculate All button will calculate the percent complete for all contract
WBS nodes. The Calculate  All button will calculate percent complete for the WBS node on the given line. 

Allow Percent Complete Below Previous Value - When Unchecked, the check box will prevent the
calculated percent complete from going below the previously recorded percent complete.

Fixed Fees Grid

Project Path - Project Path

Project Name - Project Name

Contract Amount - This is the amount entered in the Contract Levels / Caps  within the project being
viewed.

Effort - This is total effort to date.

Billed - This is Fixed Fee + ICC Billed Revenue. 

BTD% - Billed to Date Percentage

Current Amt. - This is the calculated revenue to bill based on contract X percent complete less previously
billed.

Prior % Complete - The previous percent complete amount.  Note - When the Current % Complete
amount has been saved, it becomes the Previous % Complete number.

Current % Complete - The current percent complete amount that is being billed.

Current ICC to Apply - The current ICC amount to be applied to this billing transaction.

ICC Contract Amount - ICC Contract amount entered in the Contract Levels / Caps  within the project
being viewed

Lump Sum - Current Lump Sum amount to be billed.
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Calc PC - Runs the PC Formula on the individual line item.

Fixed Fee Notes - Internal notes associated with the Fixed Fee.

Invoice Description - Invoice Description notes associated with the contract level of the project.

Additional Field Descriptions (Column Chooser) 

Fixed fees Grid

Project Long Name - Name of the project including the concatenation of the lower nodes of the project.

Labor Budget - Labor Budget amount entered through Project Planning. More on Project Planning

Budgets

ODC Budget - Other Direct Charges Budget amount entered through Project Planning.

ICC Budget - In Contract Consultants Budget amount entered through Project Planning.

OCC Budget - Out of Contract Consultants Budget amount entered through Project Planning.

Total Budget - All Budget amounts entered through Project Planning.

Labor Effort - Labor Effort against the contract level.

ODC Effort - Other Direct Charges Effort against the contract level.

ICC Effort - In Contract Consultants Effort against the contract level.

OCC Effort - Out of Contract Consultants Effort against the contract level.

Labor Contract - Labor Contact Cap.

ODC Contract - Other Direct Charges Contact Cap.

OCC Contract - Out of Contract Consultants Contact Cap.

Fixed Fee Billed - Fixed Fee Billed Revenue.

Labor Billed - Labor Billed Revenue.

ODC Billed - Other Direct Charges Billed Revenue.

ICC Billed - In Contract Consultants Billed Revenue.

OCC Billed - Out of Contract Consultants Billed Revenue.

Labor WIP - Labor Work in Progress.

ODC WIP - Other Direct Charges Work in Progress.

ICC WIP - In Contract Consultants Work in Progress.

OCC WIP - Out of Contract Consultants Work in Progress.

Total WIP - Total Work in Progress.

4.5.2 Process Templates

Overview
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Process Templates are used in conjunction with Work Orders.  Process Templates allow you to create a
process that a Work Order can progress through to eventual completion. A Process can have unlimited
stages as well as specified roles, Tags, Custom Fields and Permissions.

Toolbar Options

New - Creates a New Process

Save - Saves the progress of the current Process Template.  Note - Any changes pass through to

processes that are currently in use.

Copy - Copies the currently selected Process Template.

Delete - Deletes the currently selected Process Template.

Refresh - Refreshes the current screen.

Workspace Options

Name - Name of the Process Template

Active - Status of the selected Process Template

Template Name -  Name of the Process Template

Collection Singular Name - Singular Name that you want the Template to be referred to in the Work
Orders screen.  For example, the process template name may be Development Process, however, I
would like for it to be referred to as a "Sprint" in the Work Orders applet.
Collection Plural Name - Plural version of the above name.

Work Order Item Singular Name - Singular Name that you want the specific items to be referred to in the
Work Orders screen.  For example, the you may want a Work Order to be referred to as a "Work
Package" in the Work Orders applet.
Work Order Plural Name - Plural version of the above name.

4.5.2.1 Stages Tab

Overview

The Stages Tab is where you develop the stages of a process. Stages are custom processes that are
valuable to your company. They can range from a basic KanBan (ToDo-Doing-Done) to a complex SCRUM.
You are able to create unlimited stages with added features that make it easy to build a process that suits
your needs.

Name
Name - Name of the Stage. This will be displayed in the Work Order Grid and will be turned into a "Swim

Lane" on the Work Orders Card View. Note: The Order counts, so use the Up and Down arrows on the

left to reorder the stages as necessary.

Default Owner Type - The default owner of the Work Order when a Work Order Enters this stage. Options

are Creator, Currently Assigned, Team Member, Role, Prompt and Query.
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Rules
Can Skip - When selected, the Stage can be skipped over in the designated process.  If unselected, the

stage must be entered from the previous stage.

Enter Reverse - When selected, the Stage can be entered into from a stage in front of it.  If unselected,

the can only be entered from previous stages.

Colors
Back Color - Back Color that the Stage will be highlighted as in the Grid View in Work Orders.

Fore Color - Fore Color that the Stage will be highlighted as in the Grid View in Work Orders.

Auto-Complete
Auto-Complete - Work Orders have a Status of Complete vs. Incomplete.  The Grid and Card views can

filter out by the status.  The Completion status typically signifies whether the work was actually completed

or not. When selected, the Work Order is switched to a status of Complete. When On Enter is selected,

the Work Order switches to this status when it enters this specific stage. When On Exit is selected, the

Work Order switches to this status when it exits this stage.   

Auto-Incomplete
Auto-Incomplete - When selected, the Work Order is switched to a status of Incomplete. When On Enter

is selected, the Work Order switches to this status when it enters this specific stage. When On Exit is

selected, the Work Order switches to this status when it exits this stage.   

Auto-Open
Auto-Open - Work Orders have a Status of Open vs. Closed.  The Grid and Card views can filter out by

the status.  The Open/Closed status typically signifies whether the work order is active or not. When

selected, the Work Order is switched to a status of Open. When On Enter is selected, the Work Order

switches to this status when it enters this specific stage. When On Exit is selected, the Work Order

switches to this status when it exits this stage.   

Auto-Close
Auto-Close - When selected, the Work Order is switched to a status of Open. When On Enter is

selected, the Work Order switches to this status when it enters this specific stage. When On Exit is

selected, the Work Order switches to this status when it exits this stage. 

Exit Events  
Exit Events - Exit events are custom Queries or Messages that can be designed to fire off an event when

then Work Order Exits the specific Stage.
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Enter Events
Enter Events - Enter events are custom Queries or Messages that can be designed to fire off an event

when then Work Order Enters the specific Stage.

4.5.2.2 Roles Tab

Overview

The Roles Tab is where determine the roles of individuals that will be a part of your process.  Think of it like
"mini permissions".  You want certain users to be able to create Work Orders and you want others to be only
able to move work Orders through a process.  This allows you to create users with those specific abilities. 
Typically, you will create an "Admin" role and a "Standard User" role.  

Note: These are actually assigned to specific users when you are creating a Process from the Template in
the Work Orders screen.

Role
Default - When selected, the role will be the default role assigned to all users filled in.

Role Name - Name of the Role.

Items
View All - When selected, the users in this group can see all work orders within the Process.  When
unselected, they can only see items where they are assigned or a team member.
Create - When selected, the user can create new Work Orders in the process.

Delete - When selected, the user can delete new Work Orders in the process.

Close - When selected, the change the status of the Work Order to Closed in the process.

Complete - When selected, the change the status of the Work Order to Complete in the process.

View Closed
Instance - When selected, the user can view closed Instances that were created using this process. For
example, if you create sprints using a process. The User would be able to view closed sprints that were
worked in the past. 
Item - When selected, the user can view closed Work Orders associated with the process. 

Project
Assign Any - When selected, the user can assign any project to a specific Work Order.

ToDo's
Manage - When selected, the user can create ToDo's on a Work Order.

Complete - When selected, a user can mark ToDo's complete on a Work Order.

Time
Enter Time - When selected, users can enter time against Work Orders in this Process.

Modify
Key Fields - When selected, the User can modify Key fields located on the Info Tab of the Work Order.

Assignments - When selected, the user can modify the assignee of a Work Order in the process.
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Tags - When selected, the user can check the Tags associated with a Work Order in the process.

Docs - When selected, the user can add documents to Work Orders in the process. This still honors the
Original Permissions set up in Document Types.

Delete
When selected, the row is deleted.

4.5.2.3 Tags Tab

Overview

The Tags Tab allows you to create user definable items called "Tags" that can be used as filter items in the
Work Orders applet.

Tag
Tag - Name of the Tag

Back Color - Back Color that the Tag will display as in the Grid/Card Views.

Fore Color - Fore Color that the Tag will display as in the Grid/Card Views.

4.5.2.4 Custom Fields Tab

Overview

The Custom Fields Tab allows you to create custom Data items that you can associate with a Work Order.

Columns
Field Name - Name of the Custom Field

Caption - The Label or "Display Name" of the Field on the Work Order.

Hide Label - When selected, the Caption of the Custom Field is hidden.

Data Type - Data Type of the Custom Field. 

Action ID - If an Action is referenced, the ID number of the Action should be listed here.

Required - When selected, the Custom Field is a required field for the user to enter when saving.

Grouping - Groups the Custom Fields by the text that you enter. For Example: Custom Fields

Role - 

RegEx - 

Min Value - The Minimum Value of the field.

Max Value - The Maximum Value of the field.

Min Date - The Minimum Date Value of the field.

Max Date - The Maximum Date Value of the field.

List - You can create a comma delimited list to select from the drop-down. For Example, Option 1, Option
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2, Option 3

URL Text - Text that you want the URL Link to Show. For Example: Clearview Support

URL Template - URL To be launched when clicking on the link. For Example:  https://

support.clearviewsoftware.net/

Order - The Order that you would like the Custom Fields to appear in on the Work Order.

4.5.2.5 Create Permissions Tab

Overview

The Create Permissions Tab allows you to Assign Users/Groups the ability to Create Process Instances
using the selected Process Template.

User/Group
Assign User/Groups the ability to Create Process Instances using the selected Process Template. More

on Permissions

4.5.3 Project Central

Overview

Project Central a centralized work space for Project Managers. PMs can view multi-project metrics or work
with a single project to view project to date figures, set budgets and contracts, schedule resources and
perform bill review. Project Central is organized (left to right) by the Navigator and a primary screen with drill
in detail that consists of the following tabs: Overview (default tab), Bill Review, Contract, Budget, Schedule,
Team, Contacts, Documents, and Addresses. Please note that when selecting multiple projects, only the
Overview tab (with corresponding Charts and Detail) is available. The chapters that follow discuss each area
of functionality in this powerful new applet (InFocus 2.0 and greater).

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following option in the toolbar:

Menu Options

File>New

o Plan - Launches the Project Plan Settings dialogue used to develop a new plan

o Plan from Template - Launches template selection to be used to develop a new plan

Reports

o Project Figures - Launches the Project Figures report for the currently loaded project. Available only

when viewing single projects.

New 

https://support.clearviewsoftware.net/
https://support.clearviewsoftware.net/


InFocus Modules and Applets 209

© 2020 Clearview Software, Inc.

o Plan - Launches the Project Plan Settings dialogue used to develop a new plan

o Plan from Template - Launches template selection to be used to develop a new plan

Settings

o Launches the Project Plan Setting dialogue for the selected project. Note, only available via Can Edit

Project Details special rights.

Load Selected Projects

o Loads the selected projects from the Navigator. Primarily used when selecting multiple projects.

Refresh - Refreshes the data in the primary screen

Configure Charts - Launches the Configure Charts Dialogue. 

o Chart Packs

This dialogue can be used to Add Charts to the current screen, add Chart Packs to the current

screen or save the currently displayed Charts as a Chart Pack.

o Analytic Dashboard

Analytic dashboards allow you to use an analytic Dashboard in place of the standard Chart Pack

version of the dashboards. More on Configuring Project Central to use Analytic Dashboards

Fields and Formulas - Launches the Fields and Formulas Dialogue where the user can define Field

Permissions for the Overview Tab and Formula Fields for use on the Overview Tab.

4.5.3.1 Getting Started

Overview

Foundational to Project Central is taking care of a few setup items. Please refer to this white paper to get
your system ready.

Key Concepts

Loading Projects

By default, Project Central utilizes the InFocus Navigator. The Navigator displays user defined lists from
which a project (or multiple projects) can be selected and viewed. To work with a single project, simply
double click the project from the list. To view multiple projects, drag the mouse over the desired projects
and click Load Selected Projects. Please note, multiple projects can also be selected by pressing Ctrl
while making selections with  the mouse. 
In addition to using the Navigator, the user can load single projects at a time by using the dedicated
Project Lookup. Once selected, project information is displayed in the Primary screen. More on Lookups.

http://support.clearviewsoftware.net/articles/share/1cf7c9c0
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Dynamic Save

For ease of use Project Central does not display a Save button, but instead uses dynamic save to write
back changes made to a project plan once the change has been made. This approach streamlines the
planning process and creates a dynamic, interactive work space for the Project Manager.

Charts and Chart Packs 

Charts bring your Project information to life by giving a clean visual representation of the underlying data.
Charts are fully customizable and can be created/modified by clicking Configure Charts from the toolbar.
A Chart Pack, is simply a group of charts typically meaningful to multiple users.

4.5.3.2 Overview Tab

Overview

The Overview Tab displays project to date figures for the select project(s). These figures are displayed in
both grid and chart format.

Field Descriptions

The grids displayed reflect live project to date information. By double clicking any of the grid fields, details are
dynamically displayed in the Details screen. If you double-click on any blue figure and the Detail section will
populate with the detail that makes up the figure. The project to date information is broken into 3 time buckets
- Current, YTD and Total.  Here are the time frames that those buckets cover:

Current - All transactions that fall between the Start Date and End Date of the Current Invoicing GL
Period.  The current Invoicing Period is set in the Accounting Periods applet.
YTD - All transactions that fall between the Fiscal Year Start Date (GL Period starting with 01 for the year
that the current invoicing period falls in) and End Date of the Current Invoicing GL Period.  The current
Invoicing Period is set in the Accounting Periods applet.
Total - All transactions that go against that project for all time.

Profit & Loss Window (Section)

Contract - Total Labor Contract Cap + Other Direct Charges (ODC) Contract Cap + Out of Contract
Consulting (OCC) Contract Cap + Fixed Fee amounts. These are added in Project
Administration>Project>Contract Levels/Caps
Billed - Transactions that go against a "Billed Revenue" GL Account. Billed Revenue refers to the Metric
Type assigned to the GL Account in General Accounting>Chart of Accounts 
Other Billed - Transactions that go against a "Other Revenue" GL Account. Other Revenue refers to the
Metric Type assigned to the GL Account in General Accounting>Chart of Accounts 
Earned -  Transactions that go against either the "Billed Revenue" or "Other Revenue" GL Accounts.
Billed Revenue and Other Revenue refer to the Metric Type assigned to the GL Account in General
Accounting>Chart of Accounts 
Bad Debt - Transactions that go against a "Bad Debt" GL Account. Bad Debt refers to the Metric Type
assigned to the GL Account in General Accounting>Chart of Accounts 
Cost - Transactions that go against a "Cost" GL Account. Cost refers to the Metric Type assigned to the
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GL Account in General Accounting>Chart of Accounts 
Overhead - The number given depends on the Project Central Overhead Calculation Method selected in
Global Settings>Project Admin Tab. The options are as follows:
o Job Cost Less Pay - If Job Cost Less Pay is selected, the amount comes from the Time Sheet

transactions. It takes the Job Cost amount of each time sheet transaction and subtracts the Pay Cost
Amount to get the Overhead.  You must be using Job Cost Rates for this to work.

o Overhead Allocation - If Overhead Allocation is selected, the amount comes from an overhead
allocation script that was run from the Overhead Allocation applet.  More on Overhead Allocation

o None - Returns a blank as this value.

Profit - The Profit amount is determined by the following calculation [Earned + Other Billed + Late Fee] -
[Bad Debt] - [Cost] - [Overhead]
Net Billings - The Net Billings line subtracts any Retainage, Bad Debt or Other Revenue from Billed.

Effective Labor Multiplier - Labor Effort / Labor Cost

Labor Pay Cost - Labor cost at the Pay Rate

Labor Job Cost - Labor Cost at the Job Cost Rate

Profit & Loss (Section)

Hours - Work hours from Time Sheets

Budget - Total Labor Budget + Other Direct Charges (ODC) Budget + Out of Contract Consulting (OCC)
Budget + In Contract Consulting (OCC) Budget amounts. These are added in Project
Administration>Project Planning
Labor Scheduled - Labor hours scheduled. These are added in Project Administration>Project Planning

Effort - Labor and/or Cost charges at the Billing Rate

Consultant Effort - Consulting cost at the "Marked-Up" rate.

Change Orders - Total Labor Chang Order + Other Direct Charges (ODC) Chang Order + Out of Contract
Consulting (OCC) Chang Order + In Contract Consulting (OCC) Chang Order amounts. These are added
in Project Administration>Project Planning>Change Orders

Accounts Receivable (Section)

A/R - Transactions that go against GL Accounts with a Sub-ledger type of Accounts Receivable and that
do NOT have a Metric Type of Unbilled Revenue or Work in Progress.
Received - Amounts entered in the Receipt Journal

Unbilled - Transactions from Time sheets, Purchase Journals, Employee Reimbursable's and
Disbursements that have a status of Ready-to-Bill (R) or Hold (H)
Retainer - The current Balance of the Retainer on the project. Retainer is determined by transactions that
go against a "Retainer" GL Account. Retainer refers to the Metric Type assigned to the GL Account in 
General Accounting>Chart of Accounts 
Retainage - The current Balance of the Retainage on the project. Retainage is determined by
transactions that go against a "Retainage" GL Account. Retainer refers to the Metric Type assigned to
the GL Account in General Accounting>Chart of Accounts 
Write Off - Transactions from Time sheets, Purchase Journals, Employee Reimbursable's and
Disbursements that have a status of Write-Off (W)

Overview Charts

The fully customizable charts display relevant project to date information helpful to Project Planning and
Management. To see how to cuse Analytic Dashboards in place of your charts, CLICK HERE

Detail Grids

The Detail grid contains the detail that makes up figures displayed in the Overview grid.
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4.5.3.2.1  PC Analytic Dashboard Setup

Overview 

Project Central Supports using Analytic Dashboards in place of the standard Chart Pack Dashboard view.
This section walks through the setup process for Analytic Dashboards to be 

Permissions

To begin working with Analytic Dashboards in Project Central, you'll assign Project Central Permissions to the
appropriate groups and/or users.

Those Permissions can be added in the following location:

Analytic Dashboards

Tutorial

Please complete the steps below to grant access permissions as appropriate.

1. Browse to Utilities> Analytic Dashboards> Project Central Permissions Tab
2. Double click on the Analytic Dashboard that you want to give permissions to.
3. Select the Users and/or Groups you wish to grant permissions to.
4. Once the permissions have been selected, click Save.

Note: Check the "Supports Multiple Projects" Check-box, if you have developed an Analytic Dashboard using
a Model that supports Multi-Selecting projects. Technically speaking, the "Where Clause" on the SQL Query
must be able to process a comma delimited list of ProjectIDs. Otherwise, the dashboard will select one
project at a time.

Application

To switch your dashboard to an Analytic Dashboard in Project Central, follow these instructions.  

Note:  The permission steps above have to be done before these steps.

Please complete the steps below to grant access permissions as appropriate.

1. Browse to Project Management> Project Central
2. On the toolbar, click Configure Charts.
3. At the Top-Right of the pop-up, click the button labeled Analytic Dashboard and check Load next to the

AD you would like to view.
4. Click Apply and the Dashboard will be loaded.

4.5.3.3 Bill Review Tab

Overview
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The Bill Review Tab incorporates a full scale bill review including transaction level adjustments. In addition to

inheriting all of the functionality of PM Bill Review, this tab enables PMs to change line item Billing Statuses

and Move Project Transactions. These additional features are permission based. Each grid on the Bill Review

Tab is dynamic and stores preferred display settings per user.

The purpose of Bill Review is for Project Managers to (1) review and adjust each of their projects and (2)

make comments and instructions for the Project Accountant. Once all transactions have been reviewed and

appropriate entries made, the Project Manager should mark the project as Reviewed. When a project is

marked Reviewed, the project manager can no longer make changes, unless the Project Accountant (in the

PA Bill Review applet) unflags the project as Manager Reviewed. When the project is marked Reviewed, it

will automatically flag all associated transactions as reviewed. Therefore, when time and expense transfers

from other projects are assigned to a reviewed project, they will appear as Unreviewed. This eliminates

transactions from bypassing a review process.

Comments can be made both at the project level and the transaction level.

Field Descriptions

Bill Review Toolbar

As of - Defaults to the End Date of the current invoicing period but can be changed in

Administration>Global Settings.

Reset - Resets changes the As of date to the end date of the current Invoicing G/L Period

Set Bill Status - Alters the Bill Status of the highlighted transaction(s)

Invoicing - Launches Current or Previous Invoice reports for the selected project

Reports - Launches Pre-Bill or Bill Review reports for the select project

Move Project Transactions - Launches a Projects dialogue box from which the user can select a

destination project, moving the highlighted transactions.

Reviewed - Indicates the project has been reviewed

Do Not Bill - Indicates a Do not bill status for the selected project

Invoice Comments - Project level PM related comments for invoicing

Instructions To Biller - Project level PM instructions to Project Accountant
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Transactions Grid

Journal - Journal of the transaction.

Name - Name of the Project Manager assigned to the project.

S - Bill Status. This shows the Bill Status of the transaction.

Labor/Exp. Code - Displays the Labor Code for Labor and Expense Code for Expenses.  More on Labor

Codes  More on Expense Codes

Project Path - Project Path of the transaction.

Transaction Date - Date of the Transaction.

Amount - Amount of the Transaction

Instructions To Biller - These are internal notes intended for the Project Accountant. As the invoicing

period is changed, the comments are saved, however, they are blank for the new period.

4.5.3.4 Contract Tab

Overview

Contracts (and Budgets if equal to Contracts) are managed from the Contracts tab. Currently only Fixed Fee

projects are supported.

Field Descriptions

Contract Toolbar

Contract = Budget - Sets the budgets equal to the defined project contracts

Level - Selects the project level contracts are to be entered at

Amount - Allows the user to roll up the contract amounts from the defined project budgets

Percent Complete Formula - Applies user defined percent complete formulas to contract grid. This also

represents the percent complete formula for fixed fee invoicing.

Contract Grid

Path - Path of the Project

Name - Name of the Project

Project Long Name - Name of the project including the concatenation of the lower nodes of the project.

Cap - Labor Cap Amount.

Contract Amount - Fixed Fee Amount on Project

Percent Complete - Percent Complete that is adjusted for billing.
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% of Fee - Percentage the fee is of the total fee.

BTD % - Bill to Date percentage.

Contract Detail

This chart simply reflects a visual representation of the information in the Contract Grid. 

4.5.3.5 Budget Tab

Overview

Budgets are managed from the Budgets tab. PMs can allocate Labor, ODC, OCC and ICC budgets in one
dynamic grid for the selected project.

Field Descriptions

Budget Toolbar

Level - Selects the project level budgets are to be entered at

Save as Baseline - Saves the defined budget as the Baseline budget for the selected project.

Budget Grid

This dynamic grid enables the user to set Budgets for Labor (Hours, Amounts and Percentages), ODC,
OCC and ICC for the selected project. Many of the fields are displayed through the column chooser.

Contract Detail

This chart simply reflects a visual representation of the information in the Budget Grid. 

4.5.3.6 Schedule Tab

Overview

One of the most powerful sections of this applet, the Schedule tab give the Project Manager real time access

to Resource allocation and schedules for the selected project.

Field Descriptions

Schedule Toolbar

Add Resource - Launches the Schedule Labor dialogue
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Day/Week/Month - Groups the Schedule accordingly

WBS Filter - Filters the Schedule by WBS level

Schedule Interface

Reflects scheduled resources for the selected project. Resources can be reallocated dynamically by moving,

increasing or decreasing the allocated time. Clicking the listed employee will display the employee's

availability chart below.

Scheduled / Availability Detail

This chart reflects each employees scheduled time based on project allocation.

4.5.3.7 Team Tab

Overview

Project Team members, with associated Job Titles are added from the Team tab. 

Field Descriptions

Team Toolbar

Add Member - Launches an Employee lookup from which the user can select the employee to add. Once

an employee is selected, the user will have the option to assign an alternative job title for the selected

project.

Job Titles - Launches the alternative job titels dialogue for the highlighted team member in the Team grid

below.

Save as Baseline - Saves the defined budget as the Baseline budget for the selected project.

Team Grid

This dynamic grid displays team member settings for the selected project.

4.5.3.8 Contacts Tab

Overview

Project Contacts are added from the Team tab. More on Contacts
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Field Descriptions

Contacts Toolbar

Add Contact - Launches a Contact lookup from which the user can select the contact to add.

Contact Grid

This dynamic grid displays contacts added to the selected project.

4.5.3.9 Documents Tab

Overview

Project Documents are added via dialogue or Document Drop in the Documents Tab. More about Documents

Tab

Field Descriptions

Documents Toolbar Buttons

Add Document - Launches the Document Upload dialogue

Delete - Deletes select document

Search (Magnifying Glass) - Opens the selected document

Up Arrow - Launches the Document Upload dialogue

Down Arrow - Begins dialogue to download the selected document

Envelope - Emails the selected document. Please note, Document Email is configured in 

Administration>Global Settings>Document Management tab.

Refresh - Refreshes the document grid.

Documents Grid

This dynamic grid displays documents added to the selected project.

Document Drop

Documents can be uploaded via Document Drop by dragging a document from a Windows Explorer (or

desktop location) and hovering over the intended document types folder. Drag the document by clicking on
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the document, holding the mouse click (while dragging the mouse to the InFocus Document Drop) until the

intended document type folder is highlighted (a plus sign will display). Releasing the mouse click adds the

document to the selected project, categorized under the intended document type.

4.5.3.10 Addresses Tab

Overview

Project Addresses are added from the Addresses tab. Addresses added are dynamically mapped using
Google Maps.

Field Descriptions

Address Grid

This dynamic grid displays addresses added to the selected project. Clicking on the Edit icon launches the
Address Editor.

4.5.4 Project Planning

Overview 

Project plans are another project with a particular type. Unlike some systems, there is no disconnect between
planning and actual projects. The Project Planning applet, allows Project Managers to plan, schedule, and
allocate resources to their projects. Typically, projects begin as a "Plan" and then migrate to an "Opportunity"
or "Billable" (Projects>General Tab>Contract Type) state. When in the "Planning" and "Opportunity" stages,
the Project Manager has complete control of the project plan. WBS nodes can be added and removed, and
budgets can be revised. Once the project has been changed to a billable or indirect project, the project
manager can no longer alter budgets (unless they have special permission) or WBS nodes. The moment a
project is changed to "Billable" or "Indirect" the current budgets are saved as the baseline budget. These can
be used in project management reporting for performance analysis. Changes to the budgets at this point
must go through the Change Order process. More on Change Orders. Moreover, when the project is
changed to "Billable" or "Indirect", the Project Manager WBS Lockout can be set in the Projects applet. This
restricts the Project Managers ability to add / remove WBS nodes to below the level defined in the lockout.
The concept upon the lockout is to give the Project Manager the freedom to alter the WBS structure at a level
lower than any that would affect accounting.

Key Concepts

All Project Planning entries "Auto-save" once you leave the field.  This eliminates having to save individual
sections.

Project Planning is broken into three sections: Project, Allocations and Resource Schedule 

o Project - The Project section is where the Project Manager creates the WBS structure of the project,

Modify Budget Amounts, Create & Approve Change Orders, etc. While the Project Window displays
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all levels of the WBS, only the lowest level is available for budget amounts (only when the project

type,in the Projects applet, is Not Billable or Indirect). The WBS can be modified when the WBS

button is selected in this window. More on Modifying the WBS of a Project Plan.  The data can be

modified when the Data button is selected in this window. More on the Project section.

o Allocations -  The Allocations Window is where Project Managers make allocations to the WBS levels

of a project. Allocations must be defined at the lowest level of the project.  In the initial planning

stages of a project, allocations typically represent the initial budget. As the project progresses, the

allocations can be altered if desired. Additionally, Estimates to Complete can be entered against

allocations. In the planning stage, Estimate to Complete will default in from the allocations amount.

More on the Allocation Section.

o Resource Schedule - The Resource Schedule window is where a Project Manager schedule

resources against allocations. They may be scheduled against individual vendors or against no

particular vendor by using the General Vendor name. More on the Resource Schedule Section.

You are able to schedule in different modes:

o Labor Mode - The Labor Mode is used to schedule labor resources.  Resource Scheduling is always

made at the lowest level of the WBS. Clicking on the bottom node of the WBS, and the appropriate

Allocation Job Title activates the Labor Resource Scheduling Window and allows the user to enter

schedules for the selected WBS.

o Non-Labor (ICC, ODC, or OCC) Mode - Resource Scheduling is made at the expense code level. 

Resource Scheduling is always made at the lowest level of the WBS. Click on the bottom node of the

WBS, and the appropriate Allocation Job Title to activate the ICC, OCC, or ODC window, and then

enter allocations and schedules for the selected WBS.

4.5.4.1 Project Planning Toolbar

Overview

The Project Planning Toolbar gives the user (If given the appropriate permissions) numerous capabilities

within the Journals of InFocus. Below is a list of those Capabilities.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar

https://support.clearviewsoftware.net/articles/5489
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Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

File - Additional File options 

o New

New From Template - With appropriate permissions, you can create a new plan from template.

Edit - Additional Edit options

o Preferences - When selected, the Planning Preferences window appears. More on Planning

Preference

View - Additional View options

o Options - When selected, the header showing the Project Name and Rate Schedule show in the

header.

o Project Figures - Prints the Project Figures Report for the current project.

o Gantt - Prints the Gantt chart for the current project. More on the Gantt Chart

o Earned Value -  Gives you the Earned Value Pop-up. More on Earned Value

Tools - Additional Tools options

o Save as Baseline - Click this to save the budgeted amounts as the baseline for the project.

o Recalculate Rates - Allows you to recalculate rates for Allocations, Scheduled, and ETC.

New

o Plan - Creates a new Project Plan.

o New From Template - With appropriate permissions, you can create a new plan from template.

Print - Runs the Project Planning Report. More on the Project Planning Report

Gantt -  Prints the Gantt chart for the current project. More on the Gantt Chart

Earned Value -  Gives you the Earned Value Pop-up. More on Earned Value

Percent Complete History - Opens up the Percent Complete History pop-up. The percent complete is a

“best guess” value of completion of a particular phase at a specific moment in time. More on Percent

Complete History

Resource Groups - Brings up the Reosurce Groups Pop-up. More on Resource Groups

Planning Mode - Controls the PM Type of the information that is viewed in Planning. Options are Labor,

ODC, OCC and ICC

o Labor Mode - The Labor tab is used to allocate and schedule labor resources. Allocations are done at

the job title level. The Generic job title can be used to allocate hours and dollars on the WBS to no

particular job title. Allocations are always made at the lowest level of the WBS. Clicking on the bottom

node of the WBS activates the Labor Allocations Window and allows the user to enter allocations and

schedules for the selected WBS.
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o ICC, ODC, or OCC Mode - Allocations are made at the expense code level. A Generic expense is

used to allocate units and dollars on the WBS to no particular expense code. Allocations are always

made at the lowest level of the WBS. Click on the bottom node of the WBS to activate the ICC, OCC,

or ODC window, and then enter allocations and schedules for the selected WBS.

4.5.4.2 Project Window

Overview 

The Project Window is where project managers create the WBS structure of the project, make budget
changes, etc. While the window displays all levels of the WBS (Fig.1) , only the lowest level is available for
budget amounts (only when the project type,in the Projects applet, is Not Billable or Indirect). The WBS can
be modified when the WBS button is selected in this window. More on Modifying the WBS of a Plan.  Data
can be modified when the Data button is selected in this window.

Key Concepts

All Project Planning entries "Auto-save" once you leave the field.  This eliminates having to save individual
sections.

Field Descriptions 

Button Descriptions (Top of Grid)

Pencil icon (Project Plan Settings) button -  By clicking on this button, a window will appear that allows
you to edit the Project Plan Settings (ex., Code, Name, Client, etc.). Note, only available via Can Edit
Project Details special rights.

Green Arrow icon (Project Roll-ups) Button - By clicking on this button, a window will appear that allows
you to set roll-up options for the project.  More on Project Rollups

Change Orders Button - By clicking on this button, a drop-down  will appear that allows you to select
between Request Change Order  or View Change Orders. More on Change Orders

Show Button - The show button is a quick way to display any level of the WBS.

Refresh - Refreshes the currently loaded data.

Sprocket icon (Column Chooser) - By clicking on this button, a window will appear that allows you to
select the columns that you would like to see in your Project section. For a description os the available
columns follow this link: More on Column Chooser Columns

Button Descriptions (Bottom of Grid)

Data Button - By clicking on this button, you are able to modify the data in the Project Grid.

WBS Button - By clicking on this button, you are able to modify the WBS in the Project Grid.

Papers icon (Apply WBS Template) Button - This button allows you to apply a WBS Template to the

https://support.clearviewsoftware.net/articles/5489
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current project.

Greyscale Bars Button - This button changes the grid view to a colorless view.

Color Bars Button - This button changes the grid view to a view with color.

Project Grid

Code - Code of the Project Level

Name - Name of the Project Level

Start Date - Project Start Date for the Project Level.

End Date - Project End Date for the Project Level.

Labor Budget Hours - Budgeted Hours. Must be entered at the lowest node of the project.

Labor Budget Amount - Budgeted Dollars. Must be entered at the lowest node of the project.

For a description of the other available columns through the Column Chooser, follow this link: More on
Column Chooser Columns

4.5.4.3 Allocations Window

Overview 

The Allocations Window is where project managers make allocations to the WBS levels of a project. 
Allocations must be defined at the lowest level of the project.  In the initial planning stages of a project,
allocations typically represent the initial budget. As the project progresses, the allocations can be altered if
desired. Additionally, Estimates to Complete can be entered against allocations. In the planning stage,
Estimate to Complete will default in from the allocations amount.

Key Concepts

All Project Planning entries "Auto-save" once you leave the field.  This eliminates having to save individual
sections.

Field Descriptions 

Button Descriptions (Top of Grid)

Refresh - Refreshes the currently loaded data.

Sprocket icon (Column Chooser) - By clicking on this button, a window will appear that allows you to
select the columns that you would like to see in your Project section. For a description os the available
columns follow this link: More on Column Chooser Columns

Button Descriptions (Bottom of Grid)

Grid icon (Grid View) Button - By clicking on this button, the Allocations window will display in the grid
view.

Chart icon (Chart View) Button - By clicking on this button, the Allocations window will display in the chart
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view.

Allocations Grid

Code - Code of the Project Level

Name - Name of the Project Level

Alloc. Units - Allocated Units (Hours for labor / Units for non-labor).

Alloc. Amount - Allocated Dollars

ETC Units - Estimate to Complete Units  (Hours for labor / Units for non-labor).

ETC Amount - Estimate to Complete Dollars

Rate - Displays the Labor Rate for Labor and the Cost or Marked Up rate for Expenses. This is driven by
the "Budget By Rate" located in the Project Plan Settings. More on Project Plan Settings

% of Budget -  Percentage of Budget that the Allocation represents. When filled out, the allocation will
look at the Budget Amount from the Project grid to calculate the figures.

For a description of the other available columns through the Column Chooser, follow this link: More on
Column Chooser Columns

4.5.4.4 Resource Schedule Window

Overview 

Resource Schedules are entered against allocations. They may be scheduled against individual vendors or

against no particular vendor by using the General Vendor name.

Key Concepts

All Project Planning entries "Auto-save" once you leave the field.  This eliminates having to save individual

sections.

Timeline / Timeline Window  - The Timeline has an adjustable “Timeline Window” that allows you to move

and adjust the time frame of the data you are viewing in the schedule window.  It also shows you the

entire timeline of the project, start to finish.  

All resources represent a dot on the timeline letting you see if there are any resources scheduled

anywhere throughout the life of the project.  Both Actuals and Baselines can be shown on the timeline by

going to Planning Preferences and selecting Include Actuals and Include Baseline. More on Planning

Preferences  There, you can click “Include Actuals” and “Include Baseline”.  There is a legend on the right

of the timeline. The dots are color coded to allow you to differentiate between schedules, actuals and

baseline data. 
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An Auto Schedule utility is available on a "per row" basis. Simply hold down the Control key, Left-click on

the desired cells and release the control key.  The Auto Schedule utility will then pop-up. More on the

Auto Schedule Utility

Field Descriptions 

Button Descriptions (Top of Grid)

Refresh - Refreshes the currently loaded data.

Wand icon (Schedule By Percentage Wizard) - By clicking on this button, a window will appear that

allows you to schedule an employee by percentage. More on Scheduling By Percentage 

Clock icon (Timeline Button) - This button expands/collapses the Timeline.

Lock icon - When selected, the timeline is locked to the Start and End Dates.

Start Date - The start Date of the Timeline.

End Date - The End Date of the Timeline.

Day, Week, Month (Data View Mode) - Controls the "buckets" of units displayed in the Resource

Schedule grid. 

Note - The timeline displays up to 120 units of the selected Mode (i.e. 120 days). 

Window Range - Displays the date range of the adjustable timeline window.

Sprocket icon (Column Chooser) - By clicking on this button, a window will appear that allows you to

select the columns that you would like to see in your Project section. For a description os the available

columns follow this link: More on Column Chooser Columns

Button Descriptions (Bottom of Grid)

+/- - The expander button expands and collapses the items in the Resource Schedule grid.

u (Units / Hours) - By clicking on this button, you are viewing Units in the Resource Schedule window.

$ (Dollars) - By clicking on this button, you are viewing Dollars in the Resource Schedule window.

u/$ (Units & Dollars) - By clicking on this button, you are viewing both Units and Dollars in the Resource

Schedule window.

Resource Schedule Grid
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Resource Code - Code of the Resource. In Labor Mode, that is the Employee Code. In Non-Labor Mode,

that is the Vendor Code. More on Employees More on Vendors

Resource Name - Name of the Resource. In Labor Mode, that is the Employee Name. In Non-Labor

Mode, that is the Vendor Name.

Allocation Code - Code of the Allocation. In Labor Mode, that is the Job Title Code. In Non-Labor Mode,

that is the Expense Code. More on Job Titles More on Expense Codes

Allocation Name - Name of the Allocation. In Labor Mode, that is the Job Title Name. In Non-Labor Mode,

that is the Expense Name.

Date Columns - Number of hours the employee has been scheduled for the specified time frame.

Date Columns - Number of hours the employee has been scheduled for the specified time frame.

For a description of the other available columns through the Column Chooser, follow this link: More on

Column Chooser Columns

4.5.4.5 Column Chooser

Overview 

The Column Chooser contains any additional columns that may not be displayed in the default layout of a

grid.  In this section is a description of additional columns available in Project Planning.

Field Descriptions 

Project Grid

Labor

Labor Alloc Amount - Allocated dollars. Read only. Accumulated from resource allocations.

Labor Alloc Hours - Allocated hours. Read only. Accumulated from resource allocations.

Labor Bgt. Amount - Budget dollars. Manually entered or automatically populated from Roll-up.

Labor Bgt. Amount PCT - Percent total of the labor budget amount in relation to its parent node.

Labor Bgt. Hours - Budget hours. Manually entered or automatically populated from Roll-up.

Labor Bgt. Hours PCT - Percent total of the labor budget hours in relation to its parent node.

LaborContractCap - Labor Contract Cap. This amount updates from Budget Amounts when you click on

the Roll up Button and select Contract=Budget and choose Cap.

Labor Budget PC - Labor budget percent complete.

Labor ETC Amount - Estimate to complete dollars. Read only. Accumulated from resource allocations.
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Labor ETC Hours - Estimate to complete hours. Read only. Accumulated from resource allocations.

LaborFixedFee - Fixed Fee Amount. This amount updates from Budget Amounts when you click on the

Roll up Button and select Contract=Budget and choose Fixed Fee.

Labor Scheduled Amount - Labor scheduled amount.

Labor Scheduled Amount Forward - Labor scheduled amount from the As of Date forward.

Labor Scheduled Hrs - Labor scheduled hours.

Labor Scheduled Hrs Forward - Labor scheduled hours from the As of Date forward.

Labor Used Amount - Used dollars. Read only. Accumulated from project transactions. Calculations are

through the specified As Of Date. (Additional columns that end in R,H,B,W and N bring back only the

amounts with that bill status)

Labor Used Amount Prev- Labor scheduled amount from the As of Date backward. (Additional columns

that end in R,H,B,W and N bring back only the amounts with that bill status)

Labor Used Hours - Used hours are Read Only. Accumulated from project transactions. Calculations are

through the specified As Of Date. (Additional columns that end in R,H,B,W and N bring back only the

hours with that bill status)

Labor Used Hours Prev- Labor scheduled hours from the As of Date backward. (Additional columns that

end in R,H,B,W and N bring back only the hours with that bill status)

ODC (Other Direct Charges)

ODC Alloc Amount - Allocated dollars. Read only. Accumulated from resource allocations.

ODC Alloc Units - Allocated units. Read only. Accumulated from resource allocations.

ODC Bgt. Amount - Budget dollars. Manually entered or automatically populated from Roll-up.

ODC Bgt. Amount PCT- Percent total of the ODC budget Amount in relation to its parent node.

ODCContractCap - Other Direct Charges Cap.

ODC ETC Amount - Estimate to complete dollars. Read only. Accumulated from resource allocations.

ODC ETC Units - Estimate to complete units. Read only. Accumulated from resource allocations.

ODC Scheduled Amount - ODC scheduled amount .

ODC Scheduled Amount Fwd - ODC scheduled amount from the As of Date forward.

ODC Scheduled Units - ODC scheduled units.

ODC Scheduled Units Forward - ODC scheduled units from the As of Date forward.

ODC Used Amount - Used dollars. Read only. Accumulated from project transactions. Calculations are

through the specified As Of Date. (Additional columns that end in R,H,B,W and N bring back only the

amounts with that bill status)

ODC Used Amount Prev - ODC scheduled amount from the As of Date backward. (Additional columns

that end in R,H,B,W and N bring back only the amounts with that bill status)
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ODC Used Units - Used units. Read only. Accumulated from project transactions. Calculations are

through the specified As Of Date. (Additional columns that end in R,H,B,W and N bring back only the

units with that bill status)

ODC Used Units Prev - ODC scheduled units from the As of Date backward. (Additional columns that end

in R,H,B,W and N bring back only the units with that bill status)

OCC (Out of Contract Consultants)

OCC Alloc Amount - Allocated dollars. Read only. Accumulated from resource allocations.

OCC Alloc Units - Allocated units. Read only. Accumulated from resource allocations.

OCC Bgt. Amount - Budget dollars. Manually entered or automatically populated from Roll-up.

OCC Bgt. Amount PCT- Percent total of the OCC budget Amount in relation to its parent node.

OCCContractCap - Outside Consultant Charges Cap.

OCC ETC Amount - Estimate to complete dollars. Read only. Accumulated from resource allocations.

OCC ETC Units - Estimate to complete units. Read only. Accumulated from resource allocations.

OCC Scheduled Amount - OCC scheduled amount.

OCC Scheduled Amount Fwd - OCC scheduled amount from the As of Date forward.

OCC Scheduled Units - OCC scheduled units.

OCC Scheduled Units Forward - OCC scheduled units from the As of Date forward.

OCC Used Amount - Used dollars. Read only. Accumulated from project transactions. Calculations are

through the specified As Of Date. (Additional columns that end in R,H,B,W and N bring back only the

amounts with that bill status)

OCC Used Amount Prev - OCC scheduled amount from the As of Date backward. (Additional columns

that end in R,H,B,W and N bring back only the amounts with that bill status)

OCC Used Units - Used units. Read only. Accumulated from project transactions. Calculations are

through the specified As Of Date. (Additional columns that end in R,H,B,W and N bring back only the

units with that bill status)

OCC Used Units Prev - OCC scheduled units from the As of Date backward. (Additional columns that end

in R,H,B,W and N bring back only the units with that bill status)

ICC (In Contract Consultants)

ICC Alloc Amount - Allocated dollars. Read only. Accumulated from resource allocations.

ICC Alloc Units - Allocated units. Read only. Accumulated from resource allocations.

ICC Bgt. Amount - Budget dollars. Manually entered or automatically populated from Roll-up.

ICC Bgt. Amount PCT- Percent total of the ICC budget Amount in relation to its parent node.

ICCContractCap - Inside Consultant Charges Cap.
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ICC ETC Amount - Estimate to complete dollars. Read only. Accumulated from resource allocations.

ICC ETC Units - Estimate to complete units. Read only. Accumulated from resource allocations.

ICC Scheduled Amount - OCC scheduled amount.

ICC Scheduled Amount Fwd - ICC scheduled amount from the As of Date forward.

ICC Scheduled Units - ICC scheduled units.

ICC Scheduled Units Forward - ICC scheduled units from the As of Date forward.

ICC Used Amount - Used dollars. Read only. Accumulated from project transactions. Calculations are

through the specified As Of Date. (Additional columns that end in R,H,B,W and N bring back only the

amounts with that bill status)

ICC Used Amount Prev - ICC scheduled amount from the As of Date backward. (Additional columns that

end in R,H,B,W and N bring back only the amounts with that bill status)

ICC Used Units - Used units. Read only. Accumulated from project transactions. Calculations are through

the specified As Of Date. (Additional columns that end in R,H,B,W and N bring back only the units with

that bill status)

ICC Used Units Prev - ICC scheduled units from the As of Date backward. (Additional columns that end in

R,H,B,W and N bring back only the units with that bill status)

4.5.4.6 Project Rollups

Overview 

The Project Rollups pop-up allows the user to roll-up in figures throughout Project Planning.

Field Descriptions 

Rollups

ETC = Scheduled - Make Estimate to Complete equal to Schedules. This takes the existing schedule for

allocations looking forward, and updates the ETC amounts of the allocation.

Percent Complete = ETC - Makes Budgeted Percent equal to Estimate to Complete. This takes the

Estimate to Complete of the allocations, and compares it to the Used Amounts to record the Percent

Complete at the WBS level.

Allocated = Scheduled - This makes the Allocated Amounts at the WBS level equal to the Scheduled

Amounts from the associated schedules. 

Budget = Allocated - This makes the Budget Amounts at the WBS level equal to the Allocated Amounts

from the associated allocations. This is available only when the project type is Plan or Opportunity.
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Contract Amount = Budget  - Sets the Fixed Fee or Labor Cap and the Percent Complete on a project.

The level that the contract amounts are set to is done in Projects (Right-Click on Project - Contract Levels

and Caps). Here a PA must select the WBS level that the contract levels will be set at. 

Project Dates = Scheduled - This will set the Project Start and End dates to the first and last date that

there is labor scheduled.

o Include Non-Labor Scheduled - When checked, the update will include non-labor items as well.

Timesheet Allowable Dates = Project Dates - When checked, the start and end dates on the nodes of the

plan become the Allowable Date Ranges for Labor on the project. More on Project Setup

Expense Allowable Dates = Project Dates - When checked, the start and end dates on the nodes of the

plan become the Allowable Date Ranges for Expenses on the project. More on Project Setup

4.5.4.7 Change Orders

Overview 

The Change Order screen allows for the separation of entering and approving change orders. Project

Managers can then enter Change Order requests while giving the approval to someone else. 

Key Concepts

A special permission, Approve C hange Orders, controls the ability to commit change orders. The C hange

Order tab is active only on direct and indirect project types.

Unless the special permission Edit Budgets on A ll Project Types has been granted, Change Orders are

required to modify the budget once a project has advanced to the direct or indirect stage. 

Adding a Change Order - To create a change order click on Request Change Order, fill out the change

order detail, and click Save.

Deleting a Change Order - Change Orders can be deleted as long as they have not been approved. To

delete a Change Order, select View Change Orders. Existing Change Orders with be shown in the grid.

Double -click on the Change Order to be deleted. Click Delete. 

Assuming the user has permissions, a Change Order can be committed by clicking on the Unapproved

Change Order button in the Existing Change Orders grid, and then clicking the Approve Change Order

button.
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Field Descriptions 

New Change Order (Header)

Change Entry Date - Change order. Informational only.

Description - Description of change order

New Change Order (Grid)

Project Path - Path of the Project.

Project Name -  Name of the Project.

Labor Hrs - Labor hours to be added to or subtracted from the existing budget.

Labor Amt. - Labor dollars to be added to or subtracted from the existing budget.

ODC Amt. - ODC dollars to be added to or subtracted from the existing budget.

OCC Amt. - OCC dollars to be added to or subtracted from the existing budget.

ICC Amt. - ICC dollars to be added to or subtracted from the existing budget.

4.5.4.8 Project Plan Settings

Overview 

The Project Details Box is where the main project information is saved and can be changed.

Field Descriptions 

Project Info

Code - Project Code.

Name - Project Name.

Client - Client associated with the project.

Budget By Rate - Rate that you want the plan to budget by. Budget By Rate has three types: labor can

be at pay rate, job cost rate or bill rate. The name of this Rate Schedule is displayed on the header of the

Project Plan when it is loaded in Project Planning.

Start Date - Start date of the project.

End Date - End date of the project.

Resource Group Level - Level that the Resource Group will be applied at. More on Resource Groups
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Template - When checked, this Project is flagged a a template.  When you select New (Toolbar) > Plan

From Template, you will see this project in the Templates list. 

Restrict Time Entry to Members - When checked, time entry is limited to those members associated with

the Project > Members Tab.

Rate Method

Description - Rate Method (You can only select one) - Here you select the method in which your figures are

calculated in the plan.

Other - Rates default to the employee record to get the Job Cost Rate or the Bill Rate field located in 

Employees>Accounting/Rates Tab.

Rate Schedule - The rates calculated in the plan are derived from the Rate Schedule that you assign

here. More on Rate Schedules

Note - Rate schedules are date sensitive.  Make sure that your rate schedule encompasses all of the time

periods that you will be scheduling/allocating for.

Multipliers - Rates are calculated by taking the Pay Rate from the Employees>Pay History Tab and

multiplying it by the multipliers set in the Labor Multipliers box on the right. 

o Apply for Premium Time - When checked, the multipliers will be applied to Overtime transactions.

Labor Multipliers

Description - Labor Multipliers used when you select "Multipliers" in the Rate Method box.

DPE - Multiplier that represents the Direct Personnel Expense when calculating the rate.

OH - Multiplier that represents the Overhead when calculating the rate.

Profit - Multiplier that represents the Profit when calculating the rate.

Filter Labor Allocations & Resources By

Description -  (You can only select one) Here you select the availability of your resources in the look-ups

when entering data in Allocations and Resource Schedules. 

None - There is no restriction to the Resource and Allocation that you choose. You may also use them in

any combination. 

Note - If you are using Resource Group Assignments located on the Toolbar, you must have Other selected

here.
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Rate Schedule - You are limited to the resources and their assigned Job Title (Allocation) set in the rate

schedule.  If there is an * in the rate schedule, you will be able to enter any resource or allocation with the

corresponding item.  For example- in the rate schedule you create a line set to Employee - *, Job Title -

Architect.  In that scenario you could select any employee with a Job Type of Architect. 

Note - If the Rate schedule has a line that is Employee - * Job Title - *, then you would be able to schedule

any employee with any job title.

Project Team Leaders - You are limited to the "Team Members" on the Project (Members Tab).  

o If the "Restrict Time and Expenses to Team Members" check-box is checked, you are limited to only

employees assigned here and the associated Job Titles.  If no Job Title is assigned to the employees

on the members tab, InFocus will look at their employee file for job titles available.  

o If the "Restrict Time and Expenses to Team Members" check-box is unchecked, you get the

employees on the Members Tab as well as all other employees and their assigned Job titles in

Employees (Job Titles Tab).  Employees that do not have any assigned Job Titles will not show up in

the list.

Non-Labor

Expense Group -  - Expense Group associated with this project.  The expense group is used in calculating

the amounts.

o Use Effort for Actuals - When selected, non-labor transactions at the Marked-up rate will be used to

calculate actuals.

Note - Expense Groups are date sensitive.  Make sure that your expense group encompasses all of the time

periods that you will be scheduling/allocating for..

4.5.4.9 Gantt

Overview 

Project Planning's Gantt chart allows you to plan project tasks, order-of-work and gives you feedback on the
impact of scheduled items- including Critical Path. Launched from the toolbar in Project Planning, a project's
schedule is displayed in an interactive Gantt chart.

Use the Gantt to schedule each phase/task of the project based on start/finish dates or duration. Once set,
these dates control the time frames in which you can schedule resources through Project Planning. As you
build the schedule, use the Gantt bars to adjust schedules as appropriate. Clicking a phase/task in the WBS
Grid re-centers the Chart.

Tutorial

1. Browse to PM>Project Planning
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2. Load/Create the project you wish to work with

3. Click Gantt from the toolbar. The Gantt dialogue will launch.

4. Select a View Option

5. Schedule the WBS beginning with Start Dates

6. Add Finish Dates by increasing/decreasing Duration or adding a static Finish date

7. Use Predecessors (description below) to link WBS nodes together for ordered/hierarchical scheduling

8. Adjust schedules using the WBS Grid or by dragging the Gantt Bars displayed on the Gantt Chart

9. Click Save

Field Descriptions 

View Options

Days, Weeks, Months, Quarters, Years - The Gantt chart can be viewed in units of Days, Weeks,

Months, Quarters or Years. Change the view by clicking the corresponding button. When viewing in Days

or Weeks, the current date is highlighted on the chart.

Show Critical Path - Displays Critical Path by color-coding the Gantt. InFocus calculates Critical Path by

taking the longest path to the end of the project.

Customize Settings - Sets custom user settings for viewing Gantt information

o Bar Settings

Color - Default bar color

Date/Time Format - Format to use for display text

Height - Sets the height for bar rows

Inside Text - Text to display on the bar

Left Text - Text to display to the left of the bar

Right Text - Text to display to the right of the bar

Show Tooltip - When checked, hovering over the bar will display a tooltip

Text Color - Bar text color

o Critical Path

Critical Path Color - Color for displaying critical path

o Grid Settings

Row Height - Sets the height for grid rows

WBS Grid

Description - The WBS Grid displays the project structure and associated planning. Each node can be

scheduled and ordered using the fields contained in the grid.
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Index - Index of the project node, primarily used for assigning predecessors (see below).

WBS - Project Path (read only)

Name - Project Name (read only)

Duration - Increase or decrease the amount of time allotted to a project node in increments of days or

weeks (based on the selected view option). This updates associated Finish dates and Gantt Bars. Project

Level duration is summarized and reflected in the number of planned days- start to finish.

Start - Planned start date

Finish - Planned end date

Predecessors - Indicated by the Index number, predecessors allows you to control, for instance, the

schedules for a list of tasks underneath a project phase. Using a predecessor, you can effectively lock the

schedules of a WBS together- rescheduling the predecessor has a ripple effect on the schedules of the

linked nodes. The nature of the relationship between a predecessor task and a successor task

determines the type of task dependency to use. This relationship can be defined by typing the following

codes into the Predecessors column prefixed by the Index ID (e.g. 2FS):

o FS (Finish-to-Start): Task A must finish before Task B can start. This is very commonly used and the

default dependency created if only an Index ID is entered into the Predecessors column.

o SS (Start-to-Start): Task B can’t start until Task A starts. Task B can begin any time after Task A

begins. This method can be beneficial as it can help reduce the overall duration of the project as it

allows for task overlap.

o FF (Finish-to-Finish): Task B can’t finish until Task A is done. They don’t have to end at the same

time- Task B can end any time after Task A ends. Similar to SS, FF dependencies can also reduce

the overall duration of a project.

o SF (Start-to-Finish): Task B cannot finish until the start of Task A. This is a VERY RARE scenario of

Task in any type of Project.

Chart

The chart is reactive to the view options and the WBS Grid settings and displays two types of bars: Gantt

bars and a Summary bar.

Gantt Bars - Gantt bars (blue) reflect the settings of the associated project node listed in the WBS chart.

Gantt Bars can be moved by editing the WBS chart or by clicking and dragging the Gantt bar. This will

adjust any associated schedules. You can alter the duration (and subsequently start and end dates) of a

task by gripping the left or right edge of the Gantt bar and increasing or decreasing its length.

Summary Bar - The summary bar shows a running total of the time represented by all scheduled tasks.

While Gantt bars can be edited, the Summary bar is read only.

Other Options
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Print - Launches print preview for content of the Gantt Chart and WBS Grid

Automatically move Schedules with Start Date - When checked, Start Dates are impacted when sliding
Gantt Bars
Save - Saves Gantt information

Save & Close - Saves Gantt information and closes the Gantt window

Close - Closes the Gantt window without saving

4.5.4.10 Planning Preferences

Overview 

This is where the project preferences are set. These are set for all projects in project planning.

Field Descriptions 

General Tab

Include Unsubmitted Time - Includes unsubmitted time in actuals

Include Unapproved Time - Includes unapproved time in actuals

Project Tab

Show Labor Amount %

Show Labor Hours %

Show ODC Amount %

Show OCC Amount %

Show ICC Amount %

Allocations Tab

Use Allocations - When unchecked, the allocations window is hidden.

Schedules Tab

Options
Use Resources - When unchecked, the resources in the Resource Schedule window is hidden.

Scheduling

Auto Calculate Dollars from Hours (Labor) - When checked, Dollars will be calculated by comparing the
Hours to the rate in the rate schedule.

Allow Over Scheduling - When checked, you will be allowed to over-schedule resources.

Auto Fill From Rate Schedule - When "Filter Labor Allocations & Resources By" on the Project Plan
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Settings is set to Rate Schedule, Zero hour resources fill in to every node.  They stay there until this box
is unchecked.  This prevents you from having to enter the resource every time when creating a plan.

Include Actuals - When checked, Actual figures will be displayed in the Resource Schedule section on
the Project Planning screen.

Include Baseline - When checked, Baseline figures will be displayed in the Resource Schedule section on
the Project Planning screen. You must run the Save as Baseline feature located on the toolbar for these
figures to populate.

Hours Per day

Hours Per Day text-box- Number of hours to schedule per day on auto-scheduling.  If zero, hours will be
evenly distributed across date range.

Allowable Days

Allowable Days - Check off which days of the week can be included when scheduling.

4.5.4.11 Earned Value

Overview 

Earned Value is an approach where you monitor the project plan (budget), actual work, and percent

completed value to see if a project is on track. Earned Value shows how much of the budget and time should

have been spent, considering the amount of work done so far. 

Key Concepts

Budget – The budget is the sum of the budgeted dollars for the project over time. This is calculated from
the Resource Schedule (Project Planning applet) . Alternatively, if you do not want to build the schedule
to determine the budget, you can enter the start and end date with a respective budget amounts at the
lowest levels of the project and use the “Spread Budget by WBS Start/End date” option in the EVM pop
up window.

Actuals – The actuals come from the Timesheets. You can optionally include both unsubmitted and
unapproved time.

Field Descriptions 

Header

Spread Budgets by WBS Start / End Dates - When checked, the budgets are spread throughout the
chart using the start and end dates on the project WBS.

Period Type - Time increment that you would like the Earned Value chart to display in. Options are Day,
Week, Two Week, Four Week, Thirty Day, Month and Year.
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Name - Left window displays the Project Name for easy navigation.

Budgets (PV) - Planned Value

Include Labor - When checked, Labor Budgets will be included in the Planned Value (PV) figures.

Include ODC - When checked, ODC Budgets will be included in the Planned Value (PV) figures.

Include OCC - When checked, OCC Budgets will be included in the Planned Value (PV) figures.

Include ICC - When checked, ICC Budgets will be included in the Planned Value (PV) figures.

Actuals (AC) - Actual Cost

Include Unsubmitted - When checked, unsubmitted time will be included in the Actual Cost (AC) figures.

Include Unapproved - When checked, Unapproved time will be included in the Actual Cost (AC) figures.

Percent Complete (EV) - Earned Value

Use Only Labor - When checked, only labor will be used when calculating the Earned Value (EV) figures.

Show

Description - When checked, the following items will show in the Earned Value grid.

Budget (PV) 

Budget Current

Scheduled Variance (SV)

Scheduled Performance Index (SPI)

Earned Value (EV)

Earned Value Actual

Cost Variance (CV)

Cost Performance Index (CPI)

Actual Cost (AC)

4.5.4.12 Scheduling By Percentage

Overview 

The Schedule by Percentage utility gives you the ability to schedule an employee and/or Job Title (Allocation)

over a period of time.  You are able to see Potential Hours as well as choose a percentage of hours that you

would like to schedule.

Key Concepts
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Located in the top-left of the Resource Schedule window. The Schedule by Percentage tool is enabled

when you click on the lowest node of the project WBS. By clicking the wand icon, you will get the

Schedule by Percentage Pop-up.

Field Descriptions 

Pop-up

Project info - The Project Node selected is located at the top in bold.

Employee - The Employee lookup gives you a list of all Active Employees. If left blank, Generic Resource
will be used as a "place holder".
Job Title -Â The Job Title lookup gives you a list of all Active Job Titles. If left blank, Generic Job Title
(Allocation Code) will be used as a "place holder".
Start Date - The date in which you want the scheduling to start.

End Date - The date in which you want the scheduling to end.

Percentage - The Percentage of Potential Hours or Available Hours.

Potential Hours - Looks at the "Hours per day" and the "Allowable
Days" (Toolbar>Edit>Preferences>Schedules Tab) to come up with the potential hours within the start
and end dates.Â Â 
Available Hours - Looks at the time Scheduled for the selected Employee across ALL Projects and
subtracts the hours scheduled for the selected Employee on the current Project.Â  The Job Title will have
an effect. If the Employee is "over scheduled", you will see a negative.Â 
Hours to Schedule - The number of potential hours multiplied by the Percentage.

4.5.4.13 Percent Complete History

Overview 

The percent complete is a “best guess” value of completion of a particular phase at a specific moment in

time. While calculating this value has been the subject of many books, in InFocus, you simply enter the

determined result in the new “Percent Complete History” screen.

Key Concepts

If you enter the budget through the Resource Schedule, you will need to save the baseline to use the

values in the Earned Value Screen. Once you have entered both your budget and entered a percent

complete history, you can use the new menu option to bring up the EVM screen. More on the Earned

Value

Field Descriptions 

Header



InFocus Modules and Applets 239

© 2020 Clearview Software, Inc.

Project - The window displays the project path of the selected row in the Project window.

Values Tab

Date - Date the Percent Complete is recognized.

Percent Complete (Labor %, ODC %, OCC %, ICC %)  –  This percent complete is then multiplied by the

amount budgeted for the respective phase to the same moment in time. For example, if you had a 10

week project that was budgeted at $100,000.00 spread evenly at $10,000.00 per week, and you entered

60% complete at 6 weeks through, your Earned Value would be $60,000.00, and you would be

considered “on time”. 

Chart Tab

Description - The Chart is a visual representation of the Percent Complete History values. 

4.5.4.14 Resource Schedule Auto Schedule

Overview 

The Auto Schedule utility is an easy way to schedule a single resource over selected time slots.

Field Descriptions 

Resource - Name of the Resource. Generic is used if none is selected.

Allocation - Name of Allocation. Generic is used if none is selected.

Start Date - Start Date of the selected cells.

End Date - End Date of the selected cells.

Total Days - Total days that have been selected.

Schedulable Days within Weeks - Number of days within the weeks that can be scheduled on. This is
affected by the Allowable Days checked on the Planning Preferences. More on Planning Preferences

Calculator - Tool that assists in calculating the hours and amount.

Options

A - Automatic Assignment. Automatically assigns the Hours/Units and Amount to each schedulable day in

the range.

M - Manual Assignment. Manually assigns the Hours/Units and Amount to the days in the range. This is

affected by the Allowable Days checked on the Planning Preferences. More on Planning Preferences

%B - Percentage of Budget - Enter a percentage of the Budgeted amount to  assigns the Hours/Units and
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Amount to each schedulable days in the range. Enter 25 for 25%.

%A - Percentage of Allocation - Enter a percentage of the Allocated amount to  assigns the Hours/Units

and Amount to each schedulable days in the range. Enter 25 for 25%.

4.5.5 Project Queries

Overview 

There are seven query applets in InFocus: Client, Contacts, Firms, Opportunities, Vendors, Projects, and
Employees. The concept of the query tools is to allow the user to define lists of data based on a user query
definition. The list can then be used to navigate to the individual records within the list or can be exported to
Excel. More on the Query Applets

4.5.6 Resource Groups

Overview 

Resource Groups are named groups of employees used to make data entry in Project Planning easier.   

Key Concepts

The purpose of a resource groups is to limit the list of possible employees to schedule in Project Planning.

There's an "Auto-Fill" checkbox that allows for zero hour resources to fill in on the WBS so that you can enter time
without having to fill in the resources every time. Once you are done, uncheck auto-fill and the zero hour resources will
go away.  

"None" must be selected under "Fill Labor Allocations & Resources By" under Project Plan Settings for this
functionality to work. More on Project Plan Settings

Field Descriptions 

Resource Groups Grid

Name - This column contains the name of the Resource Group. To create a Resource Group, click "New".

 Once saved, the name will appear in this column.

Members Grid

Employee Code - Employee Code selected.

Employee - Employee Name.

Job Title - Job Title to be selected with the Employee.

Group Leader - Employee designated as the leader of the group. Informational Only
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4.5.7 Resource Scheduler

Overview 

The Resource Scheduler gives the Project Manager the ability to schedule employees' time on a project. 

Key Concepts

By using the filters, the PM Manager can schedule All or individual employees to certain projects for any

given time.

When viewing the Employees Tab, the grid displays in colors to give you a "Heat Map" to warn you about

over scheduling. A Legend is at the bottom of the applet. 

4.5.7.1 Resource Scheduler Detail

Overview 

The Resource Scheduler screen has 3 windows; a top (Employee & Project Tabs), a middle (WBS Tab) and

a bottom (Filters Tab). The top displays the summary of hours scheduled, the middle shows the detail and

the bottom displays the filter options.

Note - You can left-click and hold on the blue header strip on the WBS &  Filter sections of the window to

"un-dock" them. To return them to their original locations, simply double-click on the blue  header strip.

Field Descriptions 

Employees Grid (top grid)

Employee - Name of the employee.

Date Columns - Number of hours the employee has been scheduled for the specified time frame.
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Projects Grid (top grid)

Project - Name of the Project.

Project Code - Code of the Project.

Date Columns - Number of hours the project has been scheduled for the specified time frame.

Work Breakdown Grid (middle grid)

Description - When you click on a cell containing a number on either of the top grids, the Work Breakdown

grid will display the detail of that number.

Project - Path of the Project.

Project Name - Long Name of the Project.

Employee Code - Code of the Employee

Employee Name - Name of the Employee.

Job Title Code - Code of the Job Title. More on Job Titles

Job Title Name - Name of the Job Title.

Hours - Total of the hours for the line item.

Filters Grid

View Dates

Start Date - Starting date for schedules to evaluate.

For - Number of Date View units that the top grid will look forward.

Date View - Block of time that the top grid will look forward. Options are Days, Weeks Months Calendar

Weeks and Calendar Months.

Hours Per Day Between - Allows you to specify the number of hours that can be scheduled per day.

Group Detail - When checked, the Work Breakdown section groups the line items by removing the

Transaction Date.

Planning Preferences - When selected, the Project planning preferences screen will appear. More on

Planning Preferences  

Employee Info

Employee - When selected, only information for the specific Employee is displayed.

Job Title - When selected, only information for the specific Job Title is displayed.

Home Org - When selected, only information for the specific Home Org is displayed. This is set at 

Employees>Employee Information. More on Org Units

Code / Level - When entered / selected, only information for the specified Org Code / Level is displayed

Resource Group - When selected, only information for the specified Resource Group is displayed
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Always Show Generic - When selected, the Employees Grid will show all of the Generic hours at the top

of the grid.

Project Info

Charge Type - When selected, only project information for the specific Charge Type is displayed.

Status - When selected, only project information with the specific Status is displayed.

Client - When selected, only information for the specific Client is displayed.

Org. - When selected, only information for the specific Home Org is displayed. This is set at 

Projects>Members Tab. Organization unit and its children to include. If left blank, all org units are used.

More on Org Units

Project Leaders

Project Manager - When selected, only information for the specific Project Manager is displayed.

Project Accountant - When selected, only information for the specific Project Accountant is displayed.

Principal In Charge - When selected, only information for the specific Principal In Charge is displayed.

Project UDFs

UDF Field - Drop-down includes any Project UDFs. More on User Defined Fields

Operator - Choices are =, <>, >, <, >=, <=, between, and is not null. Is not null is synonymous with a

blank or empty field.

o Value 1 -  Used with all filter operators except is not null. This is the value that completes the filter

operation (except in the case of the between operator). In the case of the between this represents the

lower range.

o Value 2 - Used only with the between operator. This represents the upper range.

o And/Or - Gives you the option of filtering using an And statement or an Or statement.

Legend

Legend - Color-coded legend used to show the user if the schedule is properly structured (i.e., balanced,

over-scheduled, etc.).

4.5.8 Work Orders

Overview 

Work Orders are a tool that can be used by project leaders to communicate with team members what their

specifi. Work Orders are usually an assignment of work to be accomplished, but can also be requests to

internal employees for quotes.  Work Orders contain meta-data ranging from Projects, Employees and Job

Titles to Documents, Time Entry and Transition History.
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Key Concepts

Work Orders provide a number of benefits:

Work Orders allow for time collection without the knowledge of WBS paths. If used extensively,

employees do not need to know anything about WBS paths, labor codes, or job titles. This makes time

entry far simpler. 

Work Orders also allow project managers to construct project plans that fit the project rather than

conforming to some strict generic company-wide coding system. 

Work Orders are proactive when used in place of emails. They alleviate much of the time transfer work

that goes on after time collection.

Small units of work can be managed without changing the project plan. Work Orders can be set to

demand that Estimates to Complete be provided by the employee when citing the work order during time

sheet collection.

Budgets can be assigned to work orders so that the project manager can analyze performance when

maintaining the plan.

Work Orders Work in conjunction with Process Templates to create stages that a Work Order Must go

through to completion. More on Process Templates

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Process (Description)
o New [Process] -  When you have selected a Process Type in the Process Types Drop-down, you will be

able to create a New Process Type of that selection.

o Delete [Process] - When you have selected a Process Type in the Process Types Drop-down, you will

be able to delete the selected Process Type.

New - The New button on the toolbar creates a new Work Order.

Save - The Save button saves the current work order, but maintains focus on the new Work Order.

Save / New - The Save / New button saves the current work order, the blanks out the Work Order form to

start a new Work Order.

Delete - Deletes the selected Work Order.

Refresh - Refreshes the Grid View grid.
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Other Options

Work Orders has a couple other options that are used when filtering & searching Work Orders

Assigned to Me - When selected, Only Work Orders assigned to the Logged in user will show in the Grid/
Card Views.
Over Due - When selected, only Work Orders that are past the "Estimated Finish Date" on the Work
Order.
Include Complete - When selected, Work Orders that have a status of Complete will show in the Grid/
Card Views.
Include Closed - When selected, Work Orders that have a status of Closed will show in the Grid/Card
Views.
Search Box - Text Search that seaches the Text, Comments and IS's of all Work Orders.

4.5.8.1 Work Orders Filters (Left Pane)

Overview 

The Work Order Filters Pane contains important information to locate Work Orders that have been created. 

Note - You will only be able to see Process Templates that the logged in user has Permissions to.

Field Descriptions 

Top Filters

Process Types - The drop-down will display only Process Templates that the logged in user has access
to.  Additionally, you will see an option for Unattached Work Orders that displays all Work Orders that are
not associated with a Process Template.
Project WBS Filter - When a Project Path is selected, the list of Processes will filter down to those
processes associated with the WBS.  Note: You have to go down to the lowest level of the WBS when
using the filter.

[Process Type] Tab

Check All - When selected, the list of instances will be filtered to all Instances of that Process.

Include Closed Processes - When selected, All closed Instances of the selected Process will be
displayed.
Default Columns
o Show - When selected, the Work Orders associated with that instance will be displayed.
o Name - Name of the Process Instance
o Total Items - Total Items in that Process Instance

Other Columns (available through Column Chooser)
o WBS Path - Project Long Path
o WBS Name - Project Long Name
o Project Path - Project Path
o Project - Project Name
o Completed Items - Number of Items that have been completed in the Instance
o Items - Total Number of Items that have been completed in the Instance
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Filters Tab

Stages - Stages are populated from the stages associated with the selected Process Template
o Check Box - When selected, the Work Orders are filtered by the selected Stage.
o Stage - Stage Name

Tags - Tags are populated from the Tags associated with the selected Process Template
o Check Box - When selected, the Work Orders are filtered by the selected Tag.
o Tag - Tag Name

4.5.8.2 Work Orders Grid View

Overview 

The Work Orders Grid View is allows you to see your Work Orders in a Horizontal Grid View. You are able to

easily filter using Header Filters in addition to the Text Search and Filter Check-boxes. Additionally, you are

able to Bulk change as well as drag & drop work Orders to other Processes from this view.

Note - Anything that needs to be highlighted for the users

Field Descriptions 

Grid View Header

Backward - Moves the selected Work Order to the previous stage in the Process Instance.

Forward - Moves the selected Work Order to the next stage in the Process Instance.

Bulk Edit - Activated when you click the Check-boxes in the first column of the Grid.  Allows you to
change Key Fields in bulk.  Note:  Bulk Edit only works within One Process Instance at a time.

Drag and Drop - You are able to Drag and Drop Work Orders from One Process Instance to another.  To
Drag and Drop, left-click and drag on the numbers column on the left side of the Grid View (Fig.1) until all
of the Work Orders that you want moved are highlighted.  Release the mouse button, and left click and
hold on any of the numbers in the left column. Drag over to the destination Process Instance and release.
 You will be prompted with a confirmation prompt that gives you the number of items that are being
moved.

Fig.1
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Check All - When selected, All Work Orders in the grid will be selected/de-selected.

Grid View
Check-box - Allows you to select multiple Work Orders to "Move Forward". "Move Backward" or Bulk Edit.

ID - Work Order ID

Stage - The Stage that the Work Order is currently in.

Title - Title of the Work Order

Comments - Comments on the Chat Tab.  (Read / Total) 

ToDos - Todos on the To Do Tab. (Complete / Total)

Employee Code - Code of the Employee assigned to the Work Order.

Score - User Definable Difficulty Score.

4.5.8.3 Work Orders Card View

Overview 

The Work Orders Chart View is an interactive Board that allows you to see all of your Work Orders organized

into "Swim Lanes" that are made up of the Stages in the Process Template. To see the Work Order detail,

simply double-click on the Card.

Field Descriptions 

Card View info

Swim Lanes are made from the Stages in the Process Templates.

Left-click and drag a card to another lane to advance a card.

Swim Lane headers give a count of the visible Work Orders.

Card View Layout
Work Order Number (ID)

Work Order Summary

Tag (Left Center)

Chat (Right Center)

Owner Name

To Dos (Complete / Total)

4.5.8.4 Work Order Detail (Right Pane)

Overview  
The Work Order Detail Screen is where the detail for a work order is entered. It is accessed by clicking on

the N ew button in the Work Orders screen, or by double-clicking on a work order in the Navigator List.
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Info Tab 

Subject - A summary of what the Work Order is for.

Description - A detailed description of what the Work Order is for.

Stage
Stage - Stage of the Process Instance that the Work Order is in.

Dates/Hours
Estimated Start - Estimated start date of work order. (Calculator - If Estimated Hours and End Date are

filled in the Start Date can be Calculated) 

Estimated Finish - Estimated completion date of work order. (Calculator - If Estimated Hours and Start

Date are filled in the End Date can be Calculated) 

Estimated Hours - Estimate hours required for work order. (Calculator - If Estimated Start and End Date

are filled in the Estimated Hours can be Calculated. Using Hours Per Day) 

ETC Date - Estimated Completion Date

ETC Hours - Estimated to Complete as of the last time entry. Note: By default it starts as the same

number as the Estimated Hours

Hours Per Day - Work Hours per day

Assignment

Project - Project WBS for which the work order is intended. More on Projects

Employee - Assigned employee. More on Employees

Job Title - Default job title. Can be overridden at time sheet entry. More on Job Titles

Labor Code - Default labor code. Can be overridden at time sheet entry. More on Labor Codes

Bill Status - Default bill status. Can be overridden as time sheet entry.

Score - User Definable Difficulty Score.

Custom Fields
Custom Fields created on the Custom Fields Tab in Process Templates show up here. More on Process
Templates> Custom Fields Tab

Chat Tab 

The Chat tab is where anyone assigned to the Work Order can carry on a conversation

Right-Clicking on a comment gives you the ability to Copy, Mark Unread or Delete a comment

Chat supports Markdown

To Do Tab 

The To Do tab allows for the creation of a "punch-list" of To Dos associated with the Work Order.

Check the Complete box to "strike through" the To Do.
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Tags Tab 

The Tags tab you to Tag the Work Order with the predetermined list of Tags from the Process Templates
applet. More on Process Templates> Tags Tab

To add new To Dos, you must add them to the Process Template.

Time Tab 

The Time tab allows you to enter time against the Work Order.

Allows you to select the Date, Hours, Minutes and the Time Type (Regular & OT).

You can add Time Sheet comments.

Auto Reduce ETC Hours - When selected, the ETC Hours will be reduced by the hours entered on the
Time Sheet.

Show All Time - When selected, All Time entered against the specific Work Order will be shown in the
Time Grid.

Documents Tab 

The Documents tab allows you to associate Documents with the specific Work Orders.

Subscribers Tab 

The Subscribers Tab allows you to assign individuals to a Work Order who are not going to be assigned
to it. 

History Tab 

The History Tab shows the Historical movement from one stage to another within a Process.

Note: When you move a Work Order to a new Process Instance, the History Tab is blanked out.

  

4.6 Purchasing

4.6.1 Overview

Purchasing in InFocus is used to manage the purchasing and receipt of goods and services.

Once enabled, each component of the Purchasing module can be used in whole or in part based on the
requirements of each individual firm.

Purchase Order Management

Approvals

Receipt of Goods

Conversion to Purchase Journal

Purchase Order Management

Purchase Orders can be created and managed through the applets found in the Purchasing module.
Governed by permissions, PO's inherit controls and settings from Global Settings, Employees and Vendors
that define requirements for creation and management. Furthermore, created Purchase Orders can be
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subject to approval and/or receiving requirements as needed.

Approvals

If enabled, Purchase Orders will undergo an approval process prior to being issued. InFocus uses line-item
approvals where each line can be marked Approved or Rejected.

Approvals can be granted automatically (based on a set of approval rules) or by an assigned approver or
delegate.

Receipt of Goods

Purchase Order fulfillment can be tracked by enabling Receipt of Goods. 

When enabled, this provides the ability to mark a Purchase Order as received. Similar to approvals, InFocus
uses line-item receiving.

Conversion to Purchase Journal

Purchase Orders can be converted directly to the Purchase Journal and each applet in the Purchasing
module makes this tool available. Additionally, InFocus supports pre-billing where a Purchase Order can be
billed out prior to being issued.

4.6.2 Getting Started with Purchasing

4.6.2.1 Setup

4.6.2.1.1  Global Settings

Overview

Primary setup for the Purchasing module is completed in Global Settings. There, you'll enable features
related to Purchasing and define rules for Approvals, Pre-Billing, Shipping and Auto-Codes.

Configurations are made using the following tabs in Global Settings:

Purchasing Tab

Auto Codes Tab

Purchasing Tab

Using the Purchasing tab, you'll enable the following features and controls used by Purchasing.

Note Use Purchase Orders is the only requirement for getting started with Purchasing. Each additional
setting is used to further define settings and controls for working with Purchase Orders.

Use Purchase Orders - Enables the use of the Purchasing Module and related applets and fields

Enable Receipt of Goods - Enables the Receipt of Goods feature with the ability to mark ordered items as
received.
Enable Vendor Shipping Address - Enables the use of Vendor Allowable Ship To rules for defining
Shipping addresses available to Purchase Orders. Defined via AP>Vendors>Purchasing tab.
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Enable Employee Shipping Address - Enables the use of Employee Allowable Ship To rules for defining
Shipping addresses available to Purchase Orders. Defined via HR>Employees>Purchasing tab.
Custom Comment Box 1 Label - Defines the InFocus label text for the top custom comment box in the
PO>Purchase Order applet
Custom Comment Box 2 Label - Defines the InFocus label text for the bottom custom comment box in the
PO>Purchase Order applet
Use Purchase Order Approval - Enables approvals for Purchase Order items. Left unchecked, all
Purchase Orders are auto-approved.
o Employee PO Approver - Approvals are made by an employee-assigned approver. Defined via

HR>Employees>Purchasing.
o Employee Timesheet Approver - Approvals are made by an employee-assigned Timesheet

Approver(s). Defined via HR>Employees>Accounting/Rates.
o Project Responsible - Approvals are made by the project-assigned Project Leader (e.g. Project

Manager, Project Accountant, Principle-in-charge). Defined via PA>Projects>Members.
Allow Purchase orders to be included in Sales - Enables the ability to pre-bill Purchase Orders
o ICC - Allow for ICC expense. Default Bill Status is also defined.
o OCC - Allow for OCC expense. Default Bill Status is also defined.
o ODC - Allow for ODC expense. Default Bill Status is also defined.
o PO AP Account - Default AP Account to use in the Purchase Journal entry
o PO Liability Account - Default PO Liab. Account to use in the Purchase Journal entry

Default Bill To - Bill To address to include on Purchase Orders
o Overridable on Purchase Order - When checked, Default Bill To can be overridden on the Purchase

Order
Default Allow Shipping To - Defines where a Purchase Order item can be shipped to. Alternatively, a
Specific Address can also be listed. This can be further defined per Employee and/or Vendor.
o Overridable on Purchase Order - When checked, Default Bill To can be overridden on the Purchase

Order
Global Approval Rules - Defines a set of criteria for determining if a Purchase Order item requires
approval. Rules can be further defined per Employee and/or Purchase Item.
o Approval Require All - When checked, all criteria must be met to require approvals

Read more on the Purchasing Tab

Auto Codes Tab

Auto Codes can be used to auto-generate Purchase Order codes. Read More about the Auto Codes Tab.

4.6.2.1.2  Permissions

Overview

To begin working with Purchasing, you'll assign permissions to the appropriate groups and/or users.

Permissions are available for the following applets, defined in the tutorial below:

Items

My Purchase Orders

Purchase Order Management

Purchase Orders

Receipt of Goods
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Tutorial

Please complete the steps below to grant access permissions as appropriate.

1. Browse to Administration>Permissions
2. Select the Groups and/or Users you wish to grant permissions to
3. On the row next to the Group/User, click the lockbox. A dialogue will display.
4. From the Groups and/or Users Permissions tab, grant permissions as appropriate. Below is a list of

permissions and what they grant access to.
5. Once the permissions have been selected, click Save.

Note, click for more information on Purchasing Special Rights.

Module Applet Special Rights Description

Purchasing Items n/a Applet used to define
frequently ordered items
for quick reference when
creating Purchase
Orders

My Purchase Orders Can create Purchase

Journal

Can issue Purchase Order

Can set not received

Can set received

Management applet
geared for general users
to view their submitted
Purchase Orders and/or
manage Purchase
Orders for which they
are an Approver or
Delegate

Purchase Order

Management

Can create Purchase

Journal

Can issue Purchase Order

Can set not received

Can set received

Administrative applet
geared for Purchase
Order Managers to view
and manage all existing
Purchase Orders

Purchase Orders Can Cancel a Purchase

Order

Can create Purchase

Journal

Can edit after Issued

Can Override X-rates

Can set not received

Can set received

Change Key Fields

Edit Grid

Handles the creation
and management of
Purchase Orders
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Module Applet Special Rights Description

Receipt of Goods Can set not received Administrative applet for
managing the receipt of
issued Purchase Orders.
This applet is geared for
staff who work in
Receiving

4.6.2.1.3  List Management

List Management governs the drop down lists that appear throughout the Purchasing module and related
applets and includes both System and User definable lists.

User Lists can be defined in AD>List Management and include the following:

FOB Terms

PO Item Receipts Status

Shipping Terms

Unit Types

4.6.2.2 Key Concepts

4.6.2.2.1  Purchasing Workflow

Overview

Purchasing in InFocus uses the following workflow. Enabled in Global Settings, much of the workflow is
considered optional and based on the requirements of your firm.

Purchasing Workflow

1. Purchase Order Created
2. Purchase Order Approved (optional)
3. Purchase Order Issued

a. Purchase Order Pre-Billed (optional)
4. Purchase Order Received (optional)
5. Purchase Order Converted to a Purchase Journal

Purchase Order Management

Purchase Orders are managed throughout this workflow by completing one of the related tasks.

Approval

Issue

Receipt of Goods

Convert to Purchase Journal

These tasks can be performed across the following applets. The applet you use for management is a matter
of preference based on your role.

My Purchase Orders - Can be used by any user to view the status of their submitted Purchase Orders
and/or manage those Purchase Orders to which they are assigned as Approver or Delegate
Purchase Order Management - Administrative applet geared for Purchase Order Managers
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Receipt of Goods - Administrative applet geared for staff who work in Receiving

Purchasing Workflow Descriptions

Purchase Order Created

Purchase Orders are created via the Purchase Orders applet.

Creating a new Purchase Order consists of assigning a unique PO Number, PO Name, Requester, PO Date
and applicable line-items. All other fields are considered optional and are used as needed to support your
firm's requirements for Purchasing.

Once created, a Purchase Order can be submitted for approval (optional - if not using approvals, the PO is
auto-approved).

Purchase Order Approved (optional)

If enabled, Purchase Orders can undergo an approval process prior to being issued. InFocus uses line-item
approvals where each line can be marked Approved or Rejected. A Purchase Order's Approval Status is not
marked Approved until all lines have been approved.

Approvals can be granted automatically (based on a set of approval rules) or by an assigned approver or
delegate.

Approval options are available from the following applets for employees designated as an approver or 
delegate of an approver.

Purchase Orders

My Purchase Orders

Purchase Order Management

Once approved, a Purchase Order can be issued to the vendor for fulfillment.

Purchase Order Issued

Once approved, whether by approval process or auto-approval, a Purchase Order is issued to the vendor for
fulfillment.

Purchase Orders can be issued by clicking Issue from the toolbar of the following applets.

Purchase Orders

My Purchase Orders

Purchase Order Management

Purchase Order Pre-Billed (optional)

Purchase Orders can be optionally pre-billed at the time they are issued to the vendor, prior to receiving an
actual invoice.

This optional feature can help streamline the collection of reimbursable expense and be helpful for managing
pay-when-paid contracts.
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Once issued, the Purchase Order is marked Open and ready to be received.

Purchase Order Received (optional)

Purchase Order fulfillment can be tracked by enabling Receipt of Goods. 

When enabled, this provides the ability to mark a Purchase Order as received. Similar to approvals, InFocus
uses line-item receiving. A Purchase Order's Receipt Status is not marked Received until all lines have been
received.

Receiving options are available from the following applets:

My Purchase Orders

Purchase Order Management 

Receipt of Goods

Purchase Order Converted to Purchase Journal

Purchase Orders are used to manage the purchasing process. However, until posted, a Purchase Order has
no impact on Accounts Payable, Billing or the G/L.

Once a Purchase Order has been fulfilled, the associated invoice can be posted to the Purchase Journal,
making the purchase available to A/P, Billing, etc.

Note In the case of a pre-billed Purchase Order, the pre-bill is simply updated to a formal Purchase Journal.

4.6.2.2.2  Line Item Management

A key concept to highlight is that Purchase Orders in InFocus are managed at the line-item level.

When created, a Purchase Order will include one or multiple lines. For management purposes, each line is
managed separately and, as such, statuses are built from the sum of all lines.

So, for instance, if there are ten line-items on the Purchase Order and only nine have been approved, the
Purchase Order is considered unapproved until all ten lines have been approved.

Note InFocus provides tools to update all lines at once (e.g. click the Approve button to approve all
highlighted lines)

Line-Item Management extends to the following processes:

Approvals

Receipt of Goods

Conversion to Purchase Journal

4.6.2.2.3  Purchase Order Approvals

Overview

Purchase Orders can, optionally, undergo an approval process prior to being issued. 

Purchase Orders use line-item approval where each line-item can be marked Approved or Rejected. A
Purchase Order's approval status is not set to Approved until all line-items have been approved.
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If not enabled, all Purchase Orders will be auto-approved upon submission.

When enabled, approvals will be granted by an assigned employee approver, delegate or auto-approved
based on a set of approval rules.

Employee Approvers

When enabling Purchase Order Approvals (Global Settings), you'll choose one of the following approval
methods:

Employee PO Approver

Employee Timesheet Approver

Project Responsible

Once a Purchase Order is submitted, the assigned approver (based on the method) is responsible to approve
or reject each item listed on the Purchase Order.

Approvals can be made from the Purchase Orders, My Purchase Orders and Purchase Order Management
applets

Employee PO Approver

Similar to Time & Expense Sheets, Purchase Orders are approved by an employee-assigned PO approver.

Employee PO Approvers are assigned via HR>Employees>Purchasing tab.

Employee Timesheet Approver

Using this option, Purchase Orders are approved by an employee-assigned Timesheet approver(s).

Employee Timesheet Approvers are assigned via HR>Employees>Accounting & Rates tab.

Project Responsible

Purchase Orders are approved by the project-assigned Project Leader (e.g. Project Manager, Project
Accountant, Principle-in-charge). 

Project Leaders are assigned via PA>Projects>Members.

Delegates

Delegates can be assigned approve Purchase Orders on behalf of an approver.

Configured in the Employees applet (HR>Employees>Delegates tab), each employee can be assigned one
(or multiple) delegates to act on their behalf.

More on Delegates
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Approval Rules

Approval Rules define a set of criteria used in determining if an item requires approval. For instance, a rule
could be configured to enforce approvals on Purchase Order items exceeding $1,000.00.

Approval Rules can be established Globally, per Employee, Vendor and/or Purchase Item.

Global Settings - AD>Global Settings>Purchasing tab

Employee - HR>Employees>Purchasing tab

Vendors - AP>Vendors>Purchasing tab

Purchase Items - PO>Purchase Items>Approval Rules column

If a Purchase Item meets any defined criteria, approval is required. If no criteria is met, the item is auto-
approved.

4.6.2.2.4  Purchase Order Statuses

Throughout the Purchasing workflow, a Purchase Order will receive status updates for Completion, Approval,
Issuance and Receipt.

While each status is sourced from the sum of all line-item statuses on a Purchase Order, they can be viewed
in summary in the Purchase Orders applet.

Completion

Status of the PO in the fulfillment process

In Progress - Purchase Order has been created

Open - Purchase Order has been issued but not received in full

Closed - Purchase Order has been issued, received and invoiced

Approval

Status of the PO in the approval process

Unsubmitted - Purchase Order has been created but not submitted

Submitted - Purchase Order has been submitted for approval (or auto-approval)

Rejected - Purchase Order has been rejected by an approver

Approved - All lines on the Purchase Order have been approved

Issuance

Status of issuance

Not Issued - Purchase Order has not been issued

Date/Time Stamp - Date of issuance

Receipt

Status of Receipt of Goods. PO Item Receipt Statuses are user-defined via UT>List Management.
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4.6.2.2.5  Ship To Addresses

When working with Purchase Orders, defining where an item can be shipped to is a key control. For
example, you may not want to allow a new laptop to be shipped to an employee's home address.

For each Purchase Order issued, you'll select a Ship To address from a list of allowable addresses.
Addresses are categorized in InFocus across various applets (e.g. Employees, Clients, Projects, etc.).

Allowable addresses are defined by category through Global Settings and, optionally, Employees and/or
Vendors.

4.6.2.2.6  Vendors

Purchase Orders are assigned a vendor for fulfillment. This could be for the provision of goods and/or
services.

For instance, a Purchase Order might be used to manage an order of supplies from a distributor in which
case the vendor assigned would be the distributor. Likewise, the vendor could be a sub-consultant or sub-
consulting firm assigned to provide a contracted service.

Based on the assigned vendor, the Purchase Order will inherit certain attributes configured in the Vendor
record. While common vendor A/P settings will apply when converting the PO to a Purchase Journal,
additional attributes can govern the creation of the Purchase Order itself, notably:

Single Project per PO - When checked, all lines on a single Purchase Order must charge the same
project
Require Items on PO - As required, all line-items on a single Purchase Order may require the use of Item
Codes. Additionally, individual Item Codes can be restricted for use to a specified vendor.
PO Approver Override - Vendors can be configured to use a vendor-specific approver

Approval Requirements - Vendors can be configured to use vendor-specific approval rules

Allowable Ship-To - Vendors can be configured to use vendor-specific allowable ship-to address
categories

Additional settings are discussed under Vendors in the Purchasing tab.

4.6.2.2.7  Employees (Requested By)

Purchase Orders require an assigned Requester, which will either be you (the logged in employee) or an
employee to which you are assigned as a delegate.

Based on the assigned requester, the Purchase Order will inherit certain attributes from Employee record.
Notable attributes include:

Approval Requirements - Employees can be configured to use employee-specific approval rules

Allowable Ship-To - Employees can be configured to use employee-specific allowable ship-to address
categories

Additional settings are discussed under Employees in the Purchasing tab.

4.6.2.2.8  Delegates

Delegates allow one employee to enter and/or approve Purchase Orders on behalf of another employee.

Configured in the Employees applet (HR>Employees>Delegates tab), each employee can be assigned one
(or multiple) delegates to act on their behalf.
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Delegates assigned to an employee are able to perform the following tasks:

PO Entry - Create a Purchase Order on behalf of the employee. When creating a Purchase Order, the
delegate will select the employee as the Requester.
PO Approvals - Approve Purchase Orders on behalf of the employee. The delegate will have access to
approve any Purchase Order for which the employee is assigned as an approver. Approvals can be made
via PO>My Purchase Orders, PO>Purchase Orders and PO>Purchase Order Management

4.6.2.2.9  Pre-Billing

Overview

Purchase Orders can be pre-billed at the time they are issued to the vendor, prior to receiving an actual
invoice/voucher.

This optional feature expedites the collection of reimbursable expense and can be helpful for managing pay-
when-paid contracts.

When utilized, InFocus posts a single, zero-dollar Purchase Journal entry marked Is Purchase Order. This
entry, will not impact A/P reporting but will reflect when billing.

The entry will include a zero-dollar credit to Accounts Payable, a debit to Expense and a credit to a PO
Liability Account, offsetting the expense.

Once the invoice is received from your vendor, you'll convert the existing Purchase Journal to a formal entry
(e.g. Purchase Journal crediting A/P and debiting Expense) by clicking Convert to PO in the Purchase Journal
applet. Expense lines will be marked billed, if already billed, and the vendor invoice can be processed
normally using A/P Check Writing or other preferred method.

Setup 

Setup for this optional feature is completed via AD>Global Settings>Purchasing tab under Allow Purchase
Orders to be included in Sales.

Procurement End of Month

Depending on the accounting controls your firm has in place, you may be required to reverse pre-bills at
month-end. Typically this will be for firms who wish to keep non-invoiced expenses off of their Financial
Statements. This can be done using the Procurement End of Month applet where you'll manage the reversal
of PO Liability and Expense.

4.6.2.2.10  Purchase Journal

Overview

Purchase Orders are used to manage the purchasing process. However, until posted, a Purchase Order has
no impact on Accounts Payable, Billing or the G/L.

Once a Purchase Order has been fulfilled, the associated invoice can be posted to the Purchase Journal,
making the purchase available to A/P, Billing, etc.

Purchase Orders can be posted to the Purchase Journal by using Convert to Purchase Journal found in the
Purchasing applets or by using one of the following toolbar options found in the Purchase Journal: Convert to
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PJ (pre-billed Purchase Orders only), New from PO, Add From PO.

Alternatively, Purchase Journals can be created manually from the vendor invoice and then linked to the PO
line-items using Link PO found in the toolbar of the Purchase Journal. 

Each line in the Purchase Journal can be linked to one, or multiple, PO line-items and will inherit the
attributes of those line-items (e.g. Project, Qty, Unit Rate, Expense Code, etc.).

Once created and linked, the Purchase Order is considered closed and the Purchase Journal will be used to
track Project Cost, Billings and A/P Processing.

Field Descriptions

When Purchase Orders are enabled, the following toolbar options will be displayed in the Purchase Journal.

Link PO - Used to view and manage Purchase Order line-items linked to the highlighted Purchase Journal
line.
Convert to PJ - Converts a pre-billed Purchase Order to a formal Purchase Journal (e.g. Purchase Journal
crediting A/P and debiting Expense)
New from PO - Creates a new Purchase Journal from a specified Purchase Order

Add from PO - Adds line-items from an existing Purchase Order to the loaded Purchase Journal

4.6.3 Items

Overview

Items applet allows you to define frequently ordered items for quick reference when creating Purchase
Orders.

While optional, Items can be helpful in that they centralize the management of commonly ordered items and
pre-define the attributes used on the Purchase Order, including:

Vendor Restriction (e.g. item is purchased exclusively through a designated vendor)

Unit Cost - Items are attributed a Unit Cost which is used for cost calculation in conjunction with the
Quantity when added to the Purchase Order (e.g. Qty * Unit Cost)
Expense Code - Used when posting to the Purchase Journal

G/L Base Code for Direct and Overhead expense

Approval Rules - InFocus supports line-item approval. Approval Rules are used in determining if an item
requires approval.

Active Items are available to any user creating a Purchase Order. Though Items pre-define the line-item
attributes, these can be overwritten when being added to the Purchase Order.

Field Descriptions

Toolbar

Save - Saves all Items in the grid
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Refresh - Refreshes grid with recently added items

Items Grid

Active - When checked, the Item is available for use in creating Purchase Orders

Item Code - Unique item code

Description - Item description

Unit - Unit of measurement an Item represents (e.g. Each, Dozen, Box, Day, etc.)

Unit Cost - Item cost per unit

Vendor - Restricts an Item to a designated vendor

Expense Code - Expense Code to use in Purchase Journal Posting

Direct Base Code - Direct Base Code to use in Purchase Journal posting. Note, the Item's Direct Base
Code will override the Direct Base Code associated with an Item's Expense Code.
Overhead Base Code - Overhead Base Code to use in Purchase Journal posting. Note, the Item's
Overhead Base Code will override the Overhead Base Code associated with an Item's Expense Code.
Approval Rules - Used to add Approval Rules to an Item (e.g. Purchase Order Line Cost Amount >
$1,000.00)

Additional Fields

In addition to the displayed grid columns, Items makes additional columns available using the column
chooser (gear icon). Definitions are listed under the standard Purchasing Columns.

4.6.4 My Purchase Orders

Overview

My Purchase Orders is a management applet geared for general users to view their submitted Purchase
Orders and/or manage Purchase Orders for which they are an Approver or Delegate.

Using the filters in the header, Purchase Orders can be loaded and managed per line-item.

How to load Purchase Order lines

1. Set filters in the applet header
2. Click Run
3. Rows will load into the grid
4. Line-items can be managed individually from the grid or en masse by highlighting multiple rows

Field Descriptions

Toolbar

Approve - Mark highlighted line-items as Approved

Reject - Mark highlighted line-items as Rejected

Issue - Issue an approved Purchase Order to the Vendor. Launches the Issue Purchase Order dialogue.

Received - Mark highlighted line-items as Received

Convert to Purchase Journal - Converts a received Purchase Order to a Purchase Journal for standard A/
P Processing and Billing. Launches the Convert to Purchase Order dialogue.
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Filters and Grid Columns

# Purchase Order Items - Label showing the number of selected line-items

Toggle All - Checks/Unchecks all loaded rows in the grid

My Purchase Orders uses standard Purchasing Filters and Columns.

4.6.5 Purchase Order Management

Overview

Purchase Order Management is an administrative applet geared for Purchase Order Managers to view and
manage all existing Purchase Orders.

Using the filters in the header, Purchase Orders can be loaded and managed per line-item.

How to load Purchase Order lines

1. Set filters in the applet header
2. Click Run
3. Rows will load into the grid
4. Line-items can be managed individually from the grid or en masse by highlighting multiple rows

Field Descriptions

Toolbar

Approve - Mark highlighted line-items as Approved

Reject - Mark highlighted line-items as Rejected

Issue - Issue an approved Purchase Order to the Vendor. Launches the Issue Purchase Order dialogue.

Received - Mark highlighted line-items as Received

Convert to Purchase Journal - Converts a received Purchase Order to a Purchase Journal for standard A/
P Processing and Billing. Launches the Convert to Purchase Order dialogue.

Filters and Grid Columns

Toggle All - Checks/Unchecks all loaded rows in the grid

Purchase Order Management uses standard Purchasing Filters and Columns.

4.6.6 Purchase Orders

Overview

Purchase Orders applet handles the creation and management of Purchase Orders.

Purchase Orders are created to track the fulfillment of goods and services (e.g. Supplies, Sub-consultant
contracts, etc.).
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Creating a new Purchase Order consists of assigning a unique PO Number, PO Name, Requester, PO Date
and applicable line-items. All other fields are considered optional and are used as needed to support your
firm's requirements for Purchasing.

Purchase Orders are processed (Submitted, Approved, Issued, etc.) on a line-item basis. As such each
Purchase Order must include at least one line-item.

Each line-item should include all information necessary to support the requirements of the Purchase Order.
Additionally, if using Convert to Purchase Journal, each line-item should support your A/P and Billing
requirements for the Purchase Journal entry. This may include attributes such as: Project, Expense Code, G/
L Account, etc. Note, many attributes can be pre-defined using the Items applet.

While each Purchase Order may have varying levels of complexity, line-items can be added manually in the
grid, added by using a pre-defined Item or copied from an existing PO (Add from PO).

Field Definitions

Toolbar Buttons

Save - Saves the Purchase Order

New - Create a new Purchase Order

Copy - Creates a Copy of the loaded Purchase Order

Delete - Deletes the loaded Purchase Order. Note this deletes the entire Purchase Order. To delete
individual rows, highlight the row(s) and use the Delete key.

Documents - Loads the Documents dialogue from which documents can be uploaded, viewed, modified
and/or deleted.
Submit - Submits the Purchase Order for approval. InFocus supports line-item approval.

Recall - Recall a previously submitted Purchase Order

Reject - Reject all lines on a submitted Purchase Journal

Approve - Approve all lines on a Purchase Order

Issue - Issue an approved Purchase Order to the Vendor. Launches the Issue Purchase Order dialogue.

Cancel - Cancels an issued Purchase Order

Add from PO - Copies a line-item from an existing Purchase Order. Launches the Add from PO dialogue.

Convert to Purchase Journal - Converts a received Purchase Order to a Purchase Journal for standard A/
P Processing and Billing. Launches the Convert to Purchase Order dialogue.
Print - Print the loaded Purchase Order

PO Header

PO Lookup (upper right) - Search by PO Number or internal ID

Requester - Employee requesting the purchase order. Required. Each logged in employee can select
themselves or any employee to which they are assigned as a Delegate.
PO Number - Purchase Order number. Required and must be unique. Auto Codes are supported.

PO Name - Purchase Order name. Required.

PO Date - Purchase Order date. Required.

Required By - Date the Purchase Order should be fulfilled by. This field also supports plain text (e.g.
"ASAP").
Bill To - Bill to address. Default set in Global Settings.

Approver - Default approver for Purchase Order line-items. InFocus supports line-item approval.

Vendor - Vendor responsible for fulfilling the Purchase Order
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Vendor Address - Vendor address, typically a Pay To address

Terms - Vendor terms (e.g. 15 Days)

F.O.B. - Terms related Freight On Board

Shipping - Shipping terms

Ship To - Ship to address for shipped goods. Allowable Ship To addresses are sourced from Global
Settings (AD>Global Settings>Purchasing tab), Employees (HR>Employees>Purchasing tab) and/or
Vendor (AP>Vendors>Purchasing tab) settings.
Custom Comment Box 1 (top) - User definable text to display on the printed Purchase Order (e.g.
Reference #, etc.). Defined via AD>Global Settings>Purchasing tab.
Custom Comment Box 2 (bottom) - User definable text to display on the printed Purchase Order (e.g.
Reference #, etc.). Defined via AD>Global Settings>Purchasing tab.
Template - When checked, the Purchase Order is marked as a Template.

Approval Status - Status of the PO in the approval process. Based on the sum status of all line-items.

Completion Status - Status of the PO in the fulfillment process. Based on the sum status of all line-items.

Receipt Status - Status of receipt of goods. Based on the sum status of all line-items.

Issue Status - Status of issuance

PO Line Items

Purchase Orders uses standard Purchasing Columns.

Standard Columns

Current (button) - Displays the current version of the Purchase Order (default)

Original (button) - Displays the originally Issued version of the Purchase Order

Line Num - Row number in the grid

Item - Item Code. Optional. Click the lookup for a list of available Items. 

Quantity - Quantity, used to calculate Extended cost (e.g. Quantity * Unit Price). Required.

Unit - User definable Unit Type, configured in AD>List Management.

Unit Price - Price per Unit (e.g. $10.00 / Each, $100.00 / Dozen, $1500.00 / Day, etc.)

Extended - Cost extension (e.g. Quantity * Unit Price)

Description - Line-item description. Appears on Purchase Order report

Comments - Comments to appear on the Purchase Order report

Project Path - Project to be charged once Converted to Purchase Journal

Expense Code - Expense Code to govern line-item attributes when Converted to Purchase Journal (e.g.
Markup, Direct G/L Base Code, etc.)
G/L Account - G/L Account to charge when Converted to Purchase Journal

Approved - Line-item approval status

Received - Line-item receipt status

Additional Columns

Below are additional columns available by clicking the column chooser (gear icon).

Extended (Rounded) - Cost extension, rounded to the nearest hundredth.

Approved By - User who approved the line item

Approved Date - Date approved

Approver Emp ID - Employee ID (internal) of the user who approved the line item

Approver Empname - Employee Name of the user who approved the line item

Approver Emp Code - Employee Code of the user who approved the line item

Base Cost XRate - Cost Exchange Rate in Base System Currency (Multi-Currency only)

Base Ext Cost Amount - Cost extension in Base System Currency (Multi-Currency only)
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Base Ext Cost Amount Rnd - Cost extension, rounded to the nearest hundredth in Base System Currency
(Multi-Currency only)
Comp Cost XRate - Cost Exchange Rate in Company Currency (Multi-Currency only)

Comp Ext Cost Amount - Cost extension in Company Currency (Multi-Currency only)

Comp Ext Cost Amount Rnd - Cost extension, rounded to the nearest hundredth in Company Currency
(Multi-Currency only)
Create By - User who created the record

Create Date - Date created

Do Not Summarize - Used to indicate if matching line-items should not be summarized into one line.
Defaults to False (e.g. by default matching lines will be summarized).
ECID - Expense Code ID

ECname - Expense Code Name

GLID - G/L Account ID

GLname - G/L Account Name

Note - Internal notes

Item ID - Item ID

Last Reject Date - Date stamp of latest rejection

Last Rejection Reason - Reason for latest rejection

Modify By - User who last modified the record

Modify Date - Last date modified

PJLineID - Linked Purchase Journal Line ID. Established when processing Convert to Purchase Journal
or by manually linking via AP>Purchase Journal>Link PO.
POItem Approval Status ID - Approval Status internal ID associated with the line item

POItem Approval Status Code - Approval Status Code associated with the line item

POItem Receipt Status ID - Receipt Status internal ID associated with the line item

Project ID - Project ID associated with the line item

Projectname - Project Name

Project Code - Project Code

Line - Internal line ID

Project Long Name - Concatenated project name (e.g. Million Dollar Bridge-Schematic Design-Task 1)

Purchase Order ID - Purchase Order ID associated with the line item

Purchase Order Name - PO Name associated with the line item

Submit By - User who submitted the Purchase Order

Submit Date - Date the Purchase Order was submitted

Transmit By - User who Issued the Purchase Order

Transmit Date - Date the Purchase Order was Issued

Unit Typename - Unit Type Name

Received By - User who marked the line-item received

Received Date - Date the line-item was received

4.6.7 Receipt of Goods

Overview

Receipt of Goods is an administrative applet for managing the receipt of issued Purchase Orders. This applet
is geared for staff who work in Receiving.

Using the filters in the header, Purchase Orders can be loaded and marked as Received or Not Received.

Typically, a shipment's Purchase Order will be loaded based on the Vendor and evaluated for receipt.

How to load Purchase Order lines
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1. Set filters in the applet header
2. Click Run
3. Rows will load into the grid
4. Line-items can be managed individually from the grid or en masse by highlighting multiple rows

Field Descriptions

Toolbar

Not Received - Mark highlighted line-items as Not-Received

Received - Mark highlighted line-items as Received

Filters and Grid Columns

Receipt of Goods uses a subset of standard Purchasing Filters and Columns.

4.6.8 Purchasing Tools

Overview

Below you'll find a list of standard tools used by applets in, or associated with, the Purchasing Module. Made
available via Permissions, these tools are typically accessed from the toolbar.

4.6.8.1 Add From Purchase Order

Overview

Purchase Orders support the ability to copy a line-item from one Purchase Order to another.

Launched by clicking Add from PO in the Purchase Orders applet, this allows you to search existing
Purchase Orders and select one or multiple lines to copy.

Search existing Purchase Orders by using the filters in the applet header.

How to Add Lines from an Existing Purchase Order

1. Set filters as appropriate
2. Click Run
3. Optionally use the column filters (first row) to further refine results
4. Select the line-item(s) to include 
5. Click Add Selected Lines

Field Descriptions

Add From Purchase Order uses standard purchasing Filters plus these additional fields:

Add Selected Lines (button) - Adds the highlighted rows to the loaded Purchase Order

Cancel (button) - Cancels and closes the dialogue
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4.6.8.2 Add From Purchase Order (Purchase Journal)

Overview

Purchase Orders line-items can be added to an existing Purchase Journal directly from the Purchase Journal
applet.

Launched by clicking Add from PO in the Purchase Journal applet, this allows you to search existing
Purchase Orders and select one or multiple lines to add.

When added, the Purchase Journal will be versioned with added lines from the Purchase Order.

How to Add Lines from an Existing Purchase Order

1. Set filters as appropriate
2. Click Run
3. Optionally use the column filters (first row) to further refine results
4. Select the line-item(s) to include 
5. Click Add

Field Descriptions

Add from PO (Purchase Journal) uses standard Purchasing Filters and Columns along with the following
dialogue-specific fields:

Toggle All (check box) - Selects or Deselects all line-items in the grid

Valid (grid column) - Validates the selected line-item. Errors must be resolved prior to adding to the
Purchase Journal
Filter Search - Click to hide filters

Add (button) - Adds the selected rows to the loaded Purchase Journal

4.6.8.3 Issue Purchase Order

Overview

Once a Purchase Order is approved, it can be issued to the vendor for fulfillment.

The Purchase Order is issued using a selected PO Report that can be Printed and sent, or Emailed directly
to the vendor. The PO Report can optionally be archived to Document Manager (setup required).

Optionally, if enabled via Global Settings, Purchase Orders can be pre-billed. A pre-billed Purchase Order will
be posted as a zero-dollar Purchase Journal until the vendor invoice has been received.

Once Issued, the Purchase Order will be marked Open.

Field Descriptions

PO Report - Report to generate and send to the vendor

Send to Document Management - When checked, the generated PO Report will be archived to Document
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Manager.
Send Email? - When checked, the PO Report will be emailed to the recipient defined by the specified
SMTP Relay Account (defined in AD>Global Settings>SMTP Relay Servers tab). Email Subject and Body
are also defined here.
AP Account - Accounts Payable Account to use if issuing a pre-bill

PO Liability Account - Liability Account to use if issuing a pre-bill

GL Period - Accounting Period for posting if issuing a pre-bill

Invoice Number - Invoice number to use if issuing a pre-bill

Invoice Date - Invoice Date to use if issuing a pre-bill

Due Date - Due Date to use if issuing a pre-bill

Print - Print the selected PO Report

Refresh Button (upper right) - Refreshes any listed errors

Errors Box - Reports any errors to address prior to Issuing the Purchase Order. All errors must be
resolved prior to Issuing.
Issue and Prebill - Issues the Purchase Order and posts a zero-dollar Purchase Journal for pre-bill

Issue - Issues the Purchase Order

Cancel - Cancels the Issuance

4.6.8.4 Convert To Purchase Journal

Overview

Once an invoice has been received from the vendor, a Purchase Order can be converted to a Purchase
Journal.

When converted, InFocus will post a Purchase Journal, crediting Accounts Payable and debiting Expense.
Each line-item from the Purchase Order will be used to define the attributes of the Purchase Journal expense
lines (e.g. Project, Expense Code, G/L Account, etc.).

Once converted, the newly created Purchase Journal will be available for billings and payments.

Convert To Purchase Journal can be run from:

PO>My Purchase Orders

PO>Purchase Order Management

PO>Purchase Orders

Field Descriptions

AP Account - Accounts Payable to use in posting

PO Liability Account - PO Liability Account to use in posting as appropriate

GL Period - Accounting Period for posting

Invoice Number - Invoice Number received from the vendor (e.g. voucher number)

Invoice Date - Invoice Date for the Purchase Journal

Due Date - Due Date for the Purchase Journal

Post (button) - Posts the Purchase Order line-items to the Purchase Journal

Cancel (button) - Cancels the posting and closes the dialogue

4.6.8.5 Convert To Purchase Journal (Pre-Bills)

Overview
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For Purchase Orders that have been pre-billed, once the PO has been fulfilled, the associated invoice can
be posted using Convert to PO found on the Purchase Journal toolbar.

Note This tool is used for pre-billed Purchase Orders only

Field Descriptions

Convert to Purchase Journal will prompt for the following information. Once provided, click Convert to
complete the conversion.

Invoice Number - Invoice number provided by the Vendor

Invoice Date - Date of the invoice

Due Date - Date the invoice is due for payment

Convert - Converts a pre-billed Purchase Order to a formal Purchase Journal (e.g. Purchase Journal
crediting A/P and debiting Expense)
Cancel - Cancels the conversion

4.6.8.6 Link PO

Overview

The Linked Items dialogue is used to manage links between the Purchase Journal and an originating
Purchase Order.

Launched by the Link PO toolbar button in the Purchase Journal, Linked Items allows you to view, add or
remove linked PO line-items to/from the highlighted Purchase Journal line.

Each line in the Purchase Journal can be linked to one, or multiple, PO line-items.

Field Descriptions

Add links to PO Items - Launches the Add from PO dialogue to filter and select line-items to link to the
Purchase Journal line.
Unlink (button) - Removes the link between the Purchase Order line and the PO line-item.

Additional Fields

Link PO uses standard Purchasing Columns.

4.6.9 Reference

Overview

Below you'll find a list of standard Filters and Grid Column descriptions used by applets found in the
Purchasing Module.
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4.6.9.1 Filters Index

Overview

Throughout the Purchasing module, you'll find a similar set of filters used for searching and loading records.
Below is a list of definitions.

Field Descriptions

Clear (button) - Clears all filters

Run (button) - Performs a search of existing Purchase Order line-items based on the designated filters

Purchase Order Number - Filters by specified Purchase Order Number. Available to Purchase Order
Management applet only.
Dates
o PO Date - Filters results based on From/Through PO Dates
o Required By Date - Filters results based on From/Through Required By dates

Status - Shows all Purchase Order line-items with the designated statuses
o Open - Completion Status = Open
o Closed - Completion Status = Closed
o Unsubmitted - Approval Status = Unsubmitted
o Submitted - Approval Status = Submitted
o Approved - Approval Status = Approved
o Rejected - Approval Status = Rejected
o Received - Receipt Status = Received
o Received Partial - Receipt Status = Received Partial
o Not Received - Receipt Status = Not Received

Staff - Filters results based on staff assignments. Not available to My Purchase Orders applet.
o Mine - Purchase Orders for which the logged in user is the creator
o Where I'm Approver - Purchase Orders for which the logged in user is an approver
o Where I'm Delegate - Purchase Orders for which the logged in user is a delegate

Requester and Approver
o Requester - Filters results based on selected requester
o PO Approver - Filters results based on selected approver

Issue Status - Filters results based on a selected issue status

Vendor
o Vendor - Filters results based on a selected vendor
o Vendor Address - Filters results based on a selected vendor address

Ship To
o Address Type - Filters results based on a selected address type
o Address - Filters results based on selected ship to addresses (supports up to two)

By Item - Purchase Orders that include the selected Item
o Item Only - Returns only the lines that include the selected Item
o PO with items - Returns all lines from Purchase Orders that include a line for the selected Item

Projects
o Project Leader - Purchase Orders that include projects to which the selected Project Leader is

assigned
Item Only - Returns only the lines that include the selected Project Leader
PO with items - Returns all lines from Purchase Orders that include a line for the selected Project
Leader

o My Projects - Purchase Orders that include projects to which the logged in user is assigned as a
Project Leader
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o Include Templates - Include line-items from Purchase Orders marked as a Template

Required by Date - Filters results using a date range against Purchase Order Required By setting

PO Date - Filters results using a date range against Purchase Order Date setting

4.6.9.2 Columns Index

Overview

Throughout the Purchasing module, you'll find a similar set of columns available to the base grids used by the
related applets. Below is a list of definitions:

Field Descriptions

Standard Columns

Current (button) - Displays the current version of the Purchase Order (default)

Original (button) - Displays the originally Issued version of the Purchase Order

Line Num - Row number in the grid

Item - Item Code. Optional. Click the lookup for a list of available Items. 

Quantity - Quantity, used to calculate Extended cost (e.g. Quantity * Unit Price). Required.

Unit - User definable Unit Type, configured in AD>List Management.

Unit Price - Price per Unit (e.g. $10.00 / Each, $100.00 / Dozen, $1500.00 / Day, etc.)

Extended - Cost extension (e.g. Quantity * Unit Price)

Description - Line-item description. Appears on Purchase Order report

Comments - Comments to appear on the Purchase Order report

Project Path - Project to be charged once Converted to Purchase Journal

Expense Code - Expense Code to govern line-item attributes when Converted to Purchase Journal (e.g.
Markup, Direct G/L Base Code, etc.)
G/L Account - G/L Account to charge when Converted to Purchase Journal

Approved - Line-item approval status

Received - Line-item receipt status

Additional Columns

Below are additional columns available by clicking the column chooser (gear icon).

Extended (Rounded) - Cost extension, rounded to the nearest hundredth.

Approved By - User who approved the line item

Approved Date - Date approved

Approver Emp ID - Employee ID (internal) of the user who approved the line item

Approver Empname - Employee Name of the user who approved the line item

Approver Emp Code - Employee Code of the user who approved the line item

Base Cost XRate - Cost Exchange Rate in Base System Currency (Multi-Currency only)

Base Ext Cost Amount - Cost extension in Base System Currency (Multi-Currency only)

Base Ext Cost Amount Rnd - Cost extension, rounded to the nearest hundredth in Base System Currency
(Multi-Currency only)
Comp Cost XRate - Cost Exchange Rate in Company Currency (Multi-Currency only)

Comp Ext Cost Amount - Cost extension in Company Currency (Multi-Currency only)

Comp Ext Cost Amount Rnd - Cost extension, rounded to the nearest hundredth in Company Currency
(Multi-Currency only)
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Create By - User who created the record

Create Date - Date created

Do Not Summarize - Used to indicate if matching line-items should not be summarized into one line.
Defaults to False (e.g. by default matching lines will be summarized).
ECID - Expense Code ID

ECname - Expense Code Name

GLID - G/L Account ID

GLname - G/L Account Name

Note - Internal notes

Item ID - Item ID

Last Reject Date - Date stamp of latest rejection

Last Rejection Reason - Reason for latest rejection

Modify By - User who last modified the record

Modify Date - Last date modified

PJLineID - Linked Purchase Journal Line ID. Established when processing Convert to Purchase Journal
or by manually linking via AP>Purchase Journal>Link PO.
POItem Approval Status ID - Approval Status internal ID associated with the line item

POItem Approval Status Code - Approval Status Code associated with the line item

POItem Receipt Status ID - Receipt Status internal ID associated with the line item

Project ID - Project ID associated with the line item

Projectname - Project Name

Project Code - Project Code

Line - Internal line ID

Project Long Name - Concatenated project name (e.g. Million Dollar Bridge-Schematic Design-Task 1)

Purchase Order ID - Purchase Order ID associated with the line item

Purchase Order Name - PO Name associated with the line item

Submit By - User who submitted the Purchase Order

Submit Date - Date the Purchase Order was submitted

Transmit By - User who Issued the Purchase Order

Transmit Date - Date the Purchase Order was Issued

Unit Typename - Unit Type Name

Vendor Name - Vendor name

Expense Name - Expense Code Name

Direct Name - Direct Base Account Name

Overhead Name - Overhead Base Account Name

Require All Approval Rules - Indicates if an Item requires all approval rules to be met to enforce approvals

Ven ID - Vendor ID

Received By - User who marked the line-item received

Received Date - Date the line-item was received

4.7 Human Resources

4.7.1 Benefit Accrual

Overview 

The purpose of Benefit Accrual is to manage time-off benefits that accrue over time based on a pre-

determined accrual schedule.  This applet works in conjunction with the Time Sheets applet to keep track of

time earned and used in various Benefit Projects. Some examples of Benefit Projects include Vacation, Sick,
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Paid Time Off (PTO) and Comp/Banked Time. 

Key Concepts

InFocus can keep track of multiple accruals that work with a single Benefit project as well as handle 

multiple accruals for multiple Benefit Projects.

Once the initial set-up is completed, the accruals can be run on a regular basis and InFocus will generate

a Benefit balance that employees can readily access through the Time Sheets applet.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

File - Additional File Options

o New -  Creates a new Benefit Accrual. More on Benefefit Accrual Setup

o Edit - Allows the user to edit the initial setup of the current Benefit Accrual. More on Benefefit Accrual

Setup

o Save - Saves the current Benefit Accrual

o Delete - Deletes the current Benefit Accrual

Tools - Additional Tools Options

o Accrual Schedules - Brings up a list of Accrual Schedules. More on Accrual Schedules

New -  Creates a new Benefit Accrual. More on Benefefit Accrual Setup

Edit - Allows the user to edit the initial setup of the current Benefit Accrual. More on Benefefit Accrual

Setup

Save - Saves the current Benefit Accrual

Delete - Deletes the current Benefit Accrual

Accrual Schedules - Brings up a list of Accrual Schedules. More on Accrual Schedules

Run Accruals - When selected, you are able to run Accruals for a single or multiple Benefit Projects "As

of" a specified Date.

Print - Runs and prints the the Benefit Accrual Status report for the loaded Benefit Project including the

Accrual settings plus the Accrued YTD, Hours Taken and Balance per Member. The Benefit Accrual

Status report is also accessible from the Utilities>Custom Reports applet.

4.7.1.1 Getting Started with Benefit Accrual

Overview
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When setting up Benefit Accrual, it is imperative that you know your firm's Accrual Policy. 

Things to determine prior to the setup include:

Does your firm differentiate between Vacation and Sick time or do you lump it all under one Benefit
Project (Annual Leave, PTO, etc.)?  

When does your Accrual year start? 
o If January 1st, you will use the Calendar > Calendar type of benefit accrual.
o If it is different for each employee based on their Hire/Accrual Date then you will use the Calendar >

Anniversary type of Benefit Accrual.

Do new employees begin accruing immediately or have to wait for a period of time (30 days, 90 days,
etc.) before they are eligible?
o If they begin accruing immediately you will use the Hire Date that is in their Employee record (this is

the standard default).
o If you make employees wait to begin accruing time off you will need to make sure that there is an

Accrue Date of when they are eligible to begin accruing time in their Employee record in order for the
system to be able to calculate the Benefit Accrual. The “Use Accrue Date” box will need to be checked
in the Accrual set-up.

Know your standard Accrual levels (there may be exceptions, but you can deal with that after initial setup)
o Is Accrual based on length of time with the company? For example, during the first year of

employment 80 hours of Vacation time is accrued but in Year 2 employees are eligible to accrue 88
hours.

o What are those tiers and Accruals?

Does your firm allow carryover of unused hours? 
o If so, how many? 
o Is it the same for all employees or based on how many years they’ve been with the company?

Once you have determined the above you can move forward with setup of Benefit Accrual.

4.7.1.2 Benefit Accrual Setup

Overview 

The Benefit Accrual Setup window is where the initial options are selected when configuring a benefit project.

Key Concepts

Before you can create a Benefit Project, you must first create an Indirect Project that will represent the

Benefit it represents (ie. Vacation, Sick, etc.) More on Projects

Field Descriptions 



InFocus Modules and Applets 275

© 2020 Clearview Software, Inc.

Header
Active - Status of the Benefit Project

Use Accrue Date for Schedule Placement - Check this box if the accrual is based on an Accrue Date
rather than the default Hire Date in the Employee file.
Name - Benefit Accrual name. If there are multiple Benefit Accruals that are for a single Benefit Project,
this is how you differentiate them.
Project - Benefit Project

Accrual Type
Description -  When an employee is awarded benefit hours.  The Accrual Type looks at the Hire Date (Accrue
Date if the box is checked to use Accrue Date for Schedule Placement) to base the accrual on when
calculating. These dates are located in the Employees>Employee Information Tab.

Calendar - Accrues over the course of a year.  There will be a new Benefit Year every year.  
o Type - The calendar type is how the system calculates when the benefit year begins and is also used

for carryover hours (if allowed). Options are Anniversary (based on the Hire Date anniversary),
Calendar (January 1st), and Fiscal Year (beginning of the Fiscal Year). 

Hours Worked - Accrues after an employee works a specified number of hours.  Note: Carryover will not
work with this Accrual Type as a new Benefit Year never takes place.
o Project Exclusions - There are Projects for which the system should not use the hours to count toward

the Hours Worked calculation for Accrual such as Vacation, Sick, PTO, etc.  These are the Projects
that will be selected in the Project Exclusions section.

Maximums
Maximum Hours - When selected, you specify the maximum hours that are allowed to be accrued.
Entering a -1 tells the system that it is unlimited.
Maximum Carry Over - When selected, you specify the maximum number of hours that can be accrued
from one year to the next.  Entering a -2 tells the system that it is unlimited.

Benefit Year
Description - Where you configure the year associated with the accrual if there is no Accrual Schedule in
place.

Days in Year - Number of days in accrual year.

Periods Per Year - Number of periods in accrual year. 

Work Hours Per Year - Number of Work hours in accrual year. 

Accrue Hours Per Year - Number of accrue hours awarded in accrual year. 

Accrue Hours Per Period - Number of accrue hours awarded in period. Note: Click "Calculate" for the
system to run the calculation  (Calculation = Accrue Hours Per Year / Periods Per Year)  

Accrual Schedule
Accrual Schedule -  You can optionally associate an accrual schedule with the project. More on Accrual
Schedules

4.7.1.3 Benefit Accrual Detail

 Overview 

The Benefit Accrual detail is where you manage employees and their accruals.
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Field Descriptions 

Header

Project Name - Name of the Accrual Project.

Project Code - Code of the Accrual Project.

Active - Status of the Accrual Project.

Check All - Selects all of the items in the grid directly below it.

(+) Add Button

o  Left of Screen - Adds a New Employee to the Members Grid.

o Right of Screen - Adds a Manual Benefit Entry to the Transactions Grid. Requires a Transaction Date,

Transaction Amount and a Comment.

(x) - Delete Button

o  Left of Screen - Deletes the selected Employee.

o Right of Screen - Deletes the selected Benefit Transaction.

Import Button (arrow pointing to the left into a square) - When selected, all active employees are imported

into the Members grid.

Refresh Button (blue arrows in a circle) - Refreshes the grids.

Delete Last Accrual Run Button (red circle with white line) - Deletes the Last Accrual Run

Members grid

Check-box - When checked, the Employee is selected for the actions above.

Employee - Employee Proper Name.

Accrued YTD - Accrued hours for the year to date.

Used YTD - Used hours for the year to date. These are calculated from time sheets that go against the

accrual project.

Current Year Start - The start date for the accrual project for the current benefit year.

Balance - Accrued minus Used hours

Delete - When selected, the line will be deleted.

Note: The Column Choose (gear icon) in the Header can be accessed to add the Employee Code. This is an

easy way to hyper-link to the Employee file to check Hire/Accrue Date when setting up the Benefit Accrual.

Transactions grid

Check-box - When checked, the Employee is selected for the actions above.

Employee - Employee Proper Name.
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Amount - Number of hours for the line item.

Tx Date - Transaction Date.

Type - Transaction Type. Used is populated from an approved time sheet. Standard is calculated by

InFocus based on the Accrual. Manual is for a manual entry. Carry-Over is for hours carried over from a

previous benefit year.

Comment - Internal Comments. This is populated from the manual entry comment field or by InFocus for

carry-over entries.

Delete - When the red X is selected, the line will be deleted.  If there is a black lock icon this entry cannot

be deleted as it is system-generated from a time sheet entry.

Balance - Shows the amount of hours remaining from the Accrual less Used/Manual entries in the

Transactions grid.

4.7.1.4 Accrual Schedule

Overview 

Accrual Schedules allow you to create more detailed accrual schedules than the standard setup.  It also can

account for multiple tiers of accruals based on length of time of employment.  Accrual schedules can also be

used for overrides for those employees who are granted higher accruals than the standard accrual for the

company.

Key Concepts

The Accrual Schedule allows a user to create a schedule and use it on multiple projects without having to

enter the same information multiple times.  

Also, this allows for a user to establish "tiers".  Tiers allow for setting a time frame that includes a certain

number of Accrual Hours based on length of employment.  Once an employee reaches the next tier, they

begin to accrue that level of Accruable time.  

A Benefit Accrual Schedule is optional to use when using Benefit Accrual. More on Benefit Accrual Setup

Accrual Schedule Max Hours and Max Carryover take priority over those set in Benefit Accrual Setup

You can also apply a schedule for individual employees.  When on the main screen, pull up the indirect

projects (If you have imported the employees affected by this accrual, you will see a list of employees). 

Double-click on the Employee name and you will get the Employee Benefit Override pop-up. More on

Benefit Accrual Employee Benefit Override
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Field Descriptions 

Schedules Window

Name - Name of the Accrual Schedule.  To add a new Schedule, click the green (+) at the bottom of the

pop-up.

 Tiers Window

Start Month - From the initial accrual run, the number of months that pass for the accrual to start in the

specific tier.

End Month - From the initial accrual run, the number of months that pass for the accrual to end in the

specific tier.

Hours Per Year - Number of Work hours in accrual year. 

Total Accruable Hours - Total number of accruable hours for the tier per benefit year. 

Periods Per Year - Number of periods in the benefit year. 

Accrue Per Period - Number of accrue hours awarded in period. (This is a system-calculated field based

on Total Accruable Hours / Periods Per Year)  

Hours Per Period - Number of Work hours in Period. (This is a system-calculated field based on Hours

Per Year / Periods Per Year)

Max Hours - Maximum number of hours that can be accrued for the tier. Entering a -1 allows the max to

be accrued based on the tier.

Max Carryover - Maximum number of hours that can be carried over to another tier. Entering a -1 allows

unlimited carryover.

Footer

Green (+) - When clicked, you are able to create a new Accrual Schedule.

Red (x) - When clicked, you are able to delete the selected Accrual Schedule.

4.7.1.5 Benefit Accrual Employee Benefit Override

Overview 

The Benefit Accrual Employee Benefit Override gives you the ability to override accruals on an individual 

basis.  This is especially helpful when an employee is granted benefits outside of the standard accrual policy.
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Key Concepts

The override is accessed by double-clicking on the Employee name in the Benefit Accrual detail grid.

Field Descriptions 

Header

Override Project Settings - When selected, the pop-up will activate, allowing you to override the accrual

settings.

Name - Name of the Employee.

Accrual Type

 Calendar - Accrues over the course of a year.  

o Type - The calendar type used for the accrual. Options are Anniversary, Calendar, and Fiscal Year. 

Hours Worked - Accrues after an employee works a specified number of hours. 

Accrual Schedule (optional)

 Calendar - You can optionally associate an accrual schedule with the project. More on Accrual

Schedules

Maximums

Maximum Hours - When selected, you specify the maximum hours that are allowed to be accrued. 

Maximum Carry Over - When selected, you specify the maximum number of hours that can be accrued

from one year to the next.

4.7.2 Diluted Pay Rates

Overview   

Diluted pay rates are for salaried people whose salary amount is divided by the number of hours worked in a

given pay period. This option can be used in place of the standard average cost rate currently used for pay

rate in InFocus.

Key Concepts

To enable Diluted Pay Rates you must first go to Global Settings>Time and Expense Tab and select Use
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Diluted Pay Rates. This will give you access to the Diluted Pay Rates applet.

When labor is entered into time sheets, it first uses the average pay rate. After the time sheets for a given

period have been submitted and approved, the pay rates utility for that period of time would be run. It will

establish diluted pay rates for each day and person within that period. It will also go back and recalculate

pay amounts for time sheets for the specified date range. 

By default, when you establish a pay rate for a salaried employee (Human Resources / Employees / Job

Titles Tab), the average pay rate is used (typically the annual salary divided by 2080 hours). 

To recalculate rates for salaried employees with non-overtime time entry, the user can run the Diluted Pay

Rates utility after time sheets have been approved. When calculated, the employee salary per period

amount is divided by the number of hours worked (excluding overtime), and the resultant rate is then

applied to time sheets. 

For example,  an employee earning $1,000/week would have an average pay rate of $25/hr based on a 40

hour work week. If, in a given work week, the employee worked 50 hours, the diluted pay rate would be

$1000/50 or $20/hr. 

Additional Toolbar Options  

The Diluted Pay Rates toolbar gives the user (if given appropriate permissions) the capability to calculate

diluted pay rates. 

Calculate Diluted Rates -   By clicking the button, a pop-up will ask for information to calculate diluted pay

rates. More on the Calculate Diluted Pay Rates pop-up. Diluted pay rates are pay rates calculated for

salaried employees over a given pay period. These rates are based on the number of hours for the

period. 

4.7.2.1 Calculate Diluted Rates Pop-up

Overview

The Calculate Diluted Rates Pop-up utility is how you calculate diluted rates.

Field Descriptions

Employees

All - When selected, all employees that meet the filter criteria will be included in the calculation.

Selected - When selected, the specified employees that meet the filter criteria will be included in the
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calculation.

Miscellaneous

Pay Group - When selected, all employees assigned to a specific Pay Group (Employees>Employee

Information Tab) will be selected when running the Labor Distribution Utility. Payroll Groups are managed

through Administration>List Management>Payroll Groups

Start Date - The start date of the pay period to which diluted pay rates should be applied.

End Date - The end date of the pay period to which diluted pay rates should be applied.

Calculate button - Applies and displays the diluted pay rate for the date range selected. 

Steps to Calculating Diluted Rates   

How to Calculate Diluted Pay Rates.

Step 1 - To establish a pay rate for a salaried employee (Employees>Pay History Tab), the average pay rate

(usually the annual salary divided by 2080 hours) is used.

Step 2 - In the Diluted Pay Rates applet, click Calculate Diluted Rates (located on the toolbar). Choose All

Employees (or a specific employee) and a Date Range. Click Calculate. This will automatically calculate the

diluted pay rate for the time period.

Step 3 -  To see or override the rates for an individual employee, go to the Diluted Pay Rates applet. Select

the employee, choose the date range, and click Get Rates.

4.7.3 Employee Queries

Overview 

There are seven query applets in InFocus: Client, Contacts, Firms, Opportunities, Vendors, Projects, and
Employees. The concept of the query tools is to allow the user to define lists of data based on a user query
definition. The list can then be used to navigate to the individual records within the list or can be exported to
Excel. More on the Query Applets

4.7.4 Employees

Overview   
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The Employees applet is where all Employees and Subcontractors are managed.  

Key Concepts

Since time sheets are entered per employee, you'll need an employee record for each person in your firm
who enters time (this can include sub-contractors). 

Employees and Licensing

InFocus licensing is based on the number of active employees you may need to adjust your licenses as
you add new employees. Should your active employee count exceed your license count, you'll receive a
message at login.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Print All Employees - Runs the Employee List Report. More on the Employee List Report

4.7.4.1 Employees Header

Overview 

The Employees Applet is organized by header information and detailed tabs. The Employees header contains
many of the fundamental fields involved in employee setup.

Field Descriptions
Below are field descriptions for the Employee Header section. 

** Indicates a required field

** Code - Employee code- must be unique

Prefix - A title that can be added before the employees name. The Prefix list is managed under 
Administration>List Management>Name Prefixes.

** First - Employee first name

Middle - Employee middle name

** Last - Employee last name
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Suffix - A title that can be added to the end of the employees name. The Suffix list is managed under 
Administration>List Management>Name Suffixes.

Proper Name - The concatenation of the First, Middle and Last names entered.  This is generated when
you click the wand icon located in the text box.

InFocus User Name - This is the name that the user will use to login to InFocus.Clicking on Generate
User name will auto-construct the login name.

Active - Check this box to make this an active employee. This will make the employee available for
transactions and assignments.

4.7.4.2 Timesheet Groups

Overview   

Timesheet Groups provide a mechanism for the preparation of time sheet coverage periods. Time sheet

coverage periods refer to the starting and ending dates for a time sheet. InFocus allows for multiple time

sheet periods. For instance, one group of employees can put in weekly time sheets while another group puts

in biweekly time sheets. It’s also possible to have multiple groups putting in weekly time sheets, with each

starting on a different day of the week. Weekly, biweekly, and semi-monthly are supported. Any coverage

period can be chosen, regardless of the payroll cycle. The support for different cycles allows them to co-exist

with already established procedures in the firm. A weekly coverage period is probably the best choice for

most companies and is recommended by Clearview.

**Once you establish a time sheet group or groups you then assign employees to them.**

Each coverage period, a utility is run to initialize the coming period. This utility can override the group settings

to allow for daily submissions is desired. It is, however, usually unnecessary, as even non-submitted time can

be included in project management reports.

To access Timesheet Groups, on the toolbar click Tools>Timesheet Groups.  When you get the pop-up,

you are able to Add, Edit and Delete Timesheet Groups.  

Field Descriptions

Below are field descriptions for the Timesheet Groups pop-up. 

Name - Name of the Timesheet Group

Next Start - This should be the next coverage start date for the Timesheet Group. Every time the group is
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initialized for a new coverage period, this date will automatically update.

Next End - This should be the next coverage end date for the Timesheet Group. Every time the group is

initialized for a new coverage period, this date will automatically update.

Cycle Type - Coverage period. Choices are Weekly, Bi-weekly, Semi-Monthly and Daily.

o Semi- monthly is fixed to be 1st through the 15th for one period and 16th through end of month for the

second.

Holiday Calendar - The Holiday Calendar that is associated with the Timesheet Group.  The holiday

calendar highlights holidays on the time sheet in blue and optionally fills in the hours. More on the Holiday

Calendar

4.7.4.3 Locations

Overview  

Locations are used to classify time sheets.  They are typically used to identify where the actual work was
done.  The Location check-box must be selected in Global Settings>Time and Expense Tab in order to
use this feature.

Key Concepts

Users can be given the ability to use Locations in their time sheets at Global Settings>Time and Expense
Tab>Allow Users to Edit Timesheet section.

In many cases, Locations are used for Workers Compensation Insurance. For example, if an employee is
in the Field, they are more likely to get injured than when they are in the office.

Field Descriptions
Below are field descriptions for the Locations pop-up.

Code - The Location Code. This must be unique

Location - The Location Name. The name of the location (ex.Field, Office, etc.).

Active - When checked, the location is active and can be selected in time sheets.

4.7.4.4 Employee Information Tab

Overview  

The Employee Information Tabs holds key information for each employee.
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Field Descriptions 

Below are field descriptions for the Employee Information tab. 

** Indicates a required field

Contact Information 

Attention - Attention line

Work Email - Work email address

Home Email - Home email address

Chat Handle - Handle for instant messaging applications like Slack, Skype, etc.

Mobile Phone - Cell phone number

Work Phone - Work phone number

Work Extension - Work extension

Home Phone - Home phone number

Fax - Fax number

Personal Information 

Gender - Employee gender

Hire Date - Employee hire date. Informational only.  The Hire Date can have an affect on Benefit Accrual

(See Accrue Date).

Accrue Date - Anniversary date for benefit accrual. When running Benefit Accrual, the Accrual types look

at the Accrue Date (Hire date if no Accrue Date Entered) to base the accrual on when calculating.

Birthday - Employee date of birth. Informational only

Termination Date - Employee termination date. Informational only

SSN - Employee social security number. Prints as EIN on 1099 - Misc.

Years Experience - Informational only

Company Information

Location - Locations are used to classify time sheets.  They are typically used to identify where the actual

work was done. Locations are configured via the Locations button from the toolbar.

Job Type - There are three choices of job types: Principal-in-Charge, Project Manager, and Project

Accountant. These give special access rights in various areas of the application. Below is a breakdown of

special rights per job type for Project reporting and for working in applets like Projects and Project

Central:

o Project Accountants - Can see all projects
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o Principals-In-Charge - Can see projects where they are the Principal-In-Charge or Project Manager

o Project Managers - Can see only projects where they are the Project Manager

o Employees with no job type in their employee setup - Cannot see any projects

Pay Group - Denotes the Payroll Group to which this employee belongs. Payroll Groups are a user-

defined list that allows for multiple runs of the Labor Distribution posting procedure. More on Labor

Distribution This is used when a company has multiple payrolls. Payroll Groups are managed through

Administration>List Management>Payroll Groups. Once established, employees can be assigned to a

group. Pay Groups are an optional feature. If you were navigating from the setup page, click here to

return to Labor Distribution Setup

** Timesheet Group - The Time sheet Group in which the employee is a member.  The Timesheet Group

is used to create time sheets for a group of employees.  To learn more bout Timesheet Groups. More on

Timesheet Groups

Dashboard Group - The Dashboard Group in which the employee is a member.  The Dashboard Group

populates the main Dashboard that a user first sees when they login to InFocus.  To learn more about

Dashboard Groups. More on Dashboard Groups

Time & Expense Template - The Time and Expense template that will auto-fill the employees time sheet.

To learn more about Time & Expense Template. More on Time & Expense Templates

Org. Unit - The Organization Unit that the employee is a member of.  To learn more about Organizational

Units More on Org Units. In order to see this field, you must have the "Uses Organizational Units" check-

box checked in Administration>Global Settings>General Tab.  The assigned Org. Unit must be at the

bottom node.

Subcontractor - Flag indicating if this employee is a subcontractor.  The only effect that this check-box

has is when using Labor Distribution.  If an employee is checked as a Subcontractor, the utility will split

the Subcontractor labor from the direct labor.  

Firm - Firm with which the subcontractor is associated.  This field is activated when the Subcontractor box

is checked.

Custom Grid Columns

Can Manage Public Custom Columns - When checked, the employee can manage public custom
columns used in various dynamic grids throughout InFocus. Custom Columns are created by clicking the
gear icon in the upper left hand corner of dynamic grids.

4.7.4.5 General Note Tab

Overview

The General Note tab is used for internal notes that are specific to the employee.
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4.7.4.6 Pay History Tab

Overview  
The Pay History tab is a record of the pay rate and salary change history for employees. Their effective date
range governs pay rate calculation in time sheet entry. Only one entry can have no end date; i.e., the entry
for the most current pay change.

Field Descriptions
Below are field descriptions for the Employees Pay History tab. 

Start Date - Effective start date of the pay information for that row.

End Date - Effective end date of the pay information for that row. Leave blank for the current pay

information.

Currency - Enabled with Multi-Currency Setup. Designated currency utilized by the selected employee

pay history. This designation determines the transactional currency of the employee's time sheets and

(therefore) the evaluation of available Rate Schedule rates for time entered. For complete instructions on

setting up a Multi-Currency environment, go here: More on Multi-Currency

Hourly - When checked, indicates this is an hourly employee.

Salary Per Pay Period - Employee's salary per pay period is used for two things:

1. Used in Labor Distribution to post variance. More on Labor Distribution. If you were navigating from

the setup page, click here to return to Labor Distribution Setup

2. Used to calculate the Diluted Pay Rate.

Pay Rate - For hourly employees, it is the regular pay rate. For salaried employees, this is the average

rate based on standard hours.

OT Rate (Overtime 1) - Overtime or premium hourly rate.  To change the Label, go to 

Administration>Global Settings>Labels Tab.  When the Overtime 1 label is filled out an additional column

will appear on the Pay Histories tab for the OT Rate with the Label Name as a prefix to "Rate"

OT Markup (Overtime 1) - Overtime markup. Used only in certain job cost/bill rate calculations. When the

Overtime 1 label is filled out an additional column will appear on the Pay Histories tab for the OT Markup

with the Label Name as a prefix to "Markup".

Change % - Calculates the percent variation from the previous line entry (Read-only)

Note - Used for entering notes associated with the line entry (e.g. reason for change, etc.)

Additional Overtime Types - You are able to enable up to 4 overtime types.  To enable additional overtime

types, go to Administration>Global Settings>Labels Tab and type in a label name next to the Overtime

number.

Overtime 2

o OT Rate - When the Overtime 2 label is filled out an additional column will appear on the Pay Histories

tab for the OT Rate with the Label Name as a prefix to "Rate"

o OT Markup -When the Overtime 2 label is filled out an additional column will appear on the Pay

Histories tab for the OT Markup with the Label Name as a prefix to "Markup".

Overtime 3

o OT Rate - When the Overtime 3 label is filled out an additional column will appear on the Pay Histories

tab for the OT Rate with the Label Name as a prefix to "Rate"

o OT Markup -When the Overtime 3 label is filled out an additional column will appear on the Pay
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Histories tab for the OT Markup with the Label Name as a prefix to "Markup".

Overtime 4

o OT Rate - When the Overtime 4 label is filled out an additional column will appear on the Pay Histories

tab for the OT Rate with the Label Name as a prefix to "Rate"

o OT Markup -When the Overtime 4 label is filled out an additional column will appear on the Pay

Histories tab for the OT Markup with the Label Name as a prefix to "Markup".

Change % - This represents the calculated pay increase between rows in the pay history grid.  The

column uses the salary per pay period for its calculation so if you want to see the correct percentage you

will need that filled out even on hourly employees.  This will not affect any other operations within

InFocus.

4.7.4.7 Job Titles Tab

Overview 

A Job Title describes the position held (or Hat worn) by an employee. Depending on the job, a Job Title can
describe the job responsibilities, the level of the job, or both.  Job Titles can have Rates associated with them
and can be used in setting up Rate Schedules for specific Projects.  Examples of Job Titles are Architect,
Senior Mechanical Engineer, Surveyor, Cad Operator, etc.

Job Titles are assigned to employees via the Job Titles tab. Here, you can assign a single or multiple job
titles. Employee job titles are weighted by percentage based the amount of time that employee is expected to
work under the given title. The total percentage must equal 100%. Employee job titles can be overridden
during Project setup.

Job Titles are created and managed in the Job Titles applet.  To learn more about Job Titles More on Job
Titles.

How are they used?

Job Titles are primarily used by time sheets and can impact an employee's bill rate when used in conjunction
with a Rate Schedule. When entering time, the assigned job title with the highest percentage will default in.
That said, an employee can select any of their assigned job titles when entering time.

Resource Projections utilize assigned Job Titles and their percentages.  To learn more about Resource
Projections More on Resource Projections.

Field Descriptions
Below are field descriptions for the Employees Job Titles tab.

Available Job Titles - Job Titles are created and managed in the Job Titles applet.  To learn more about
Job Titles More on Job Titles.

Navigation Arrows - Moves a selected job title from the "Available Job Titles" column to the "Current Job
Titles" column (and vice verse).

Current Job Titles - List of Job Titles assigned to the employee.  

Note: The total percentage must equal 100%. 
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4.7.4.8 Account/Rates Tab

Overview 

The Accounting/Rates tab establishes the Bill Rates and Job Cost Rates for an employee.  If no Rate
Schedule is established on a project, this is where the Job Cost and Bill Rate numbers are captured.

Note: Bill Rates, Job Cost Rates and even Pay Rates can be overridden on a per project basis.  Multipliers
or Rate Schedules can be applied at any WBS level.  To learn more about applying rates on per project
basis. More on Applying Rate Schedules

Field Descriptions
Below are field descriptions for the Employees Accounting / Rates tab.

Time / Expense Approverscapabilities

Default Approver - Primary time sheet approver for this employee.

Alternate Approver - Alternate time sheet approver for this employee.

Additional Time Approvers

Lists employees who can also approve time for the loaded employee

Additional Expense Approvers

Lists employees who can also approve expense sheets for the loaded employee

Company Credit Card

Card Number - Company credit card number

Rates

Bill Rate - Default billing rate. Can be overridden by multipliers at the WBS level or by Rate Schedules.

Premium (Overtime) Bill Rate - Default premium/overtime bill rate. Can be overridden by multipliers at the

WBS level or by Rate Schedules.

Job Cost Rate - Default job cost rate. Can be overridden by multipliers at the WBS level or by Rate

Schedules.

https://support.clearviewsoftware.net/articles/5473
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Premium (Overtime) Job Cost Rate. - Default premium/overtime job cost rate. Can be overridden by

multipliers at the WBS level or by Rate Schedules.

Target PCT - Target utilization percentage. This is the anticipated percentage of time an employee is to

spend on billable work. Used in time utilization reports.

Rate Options

Pay and/or Job Cost Rate information is sensitive and while permissions govern the types of reports a user

can run, these employee-specific rate settings govern the kind of information employees can see when

running various reports in InFocus (e.g. PM Reports, Custom Reports- except Pay History, Standard Reports

and My Projects widget).

While defaulted to unchecked, employees can be given access to view each type of rate (Pay and Job Cost)

either in detail or in summary. In Summary check boxes allow for aggregated cost in reports that do not show

detail below the WBS level to be viewed. If left unchecked, reports will return a zero when labor cost is

involved.

Can View Pay Rate - When checked, employees can see labor cost in report details

Can View Pay Rates in Summary - When checked, employees can see labor cost in report summaries

Can View Job Cost Rate - When checked, employees can see labor cost in report details. This setting

defaults to unchecked. Note, this setting does not impact the Pay History report found in UT>Custom

Reports.

Can View Job Cost Rates (in Summary) -  When checked, employees can see labor cost in report

summaries. This setting defaults to unchecked. Note: this setting does not impact the Pay History report

found in UT>Custom Reports.

4.7.4.9 Addresses Tab

Overview 

Employees can have two addresses: a work address and a home address. The work address can be derived

from an office address. Either the work or the home address can be used for employee reimbursement

checks.  To select which address is used, click on the radio button labeled "Reimbursable Checks" located

above the address of your choice and click "Save".

General Address Notes
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Addresses can be NAMED to categorize the addresses for reuse. Clients with multiple offices can be set up

with a particular address for each office, as well as for associate client contacts. If the information of the

NAMED address changes, the changes can be cascaded to all associated (linked) addresses, either in

entirety, or for only those fields that have value.

All Master Files have Geocode buttons on their addresses that get the Latitude and Longitude of an

address.  These can be used in queries to develop your own custom map views. 

Sometimes addresses have specific uses, as in the case of Bill To, Pay To, and Remit To addresses. These

can be either unassociated addresses or linked addresses. They will usually be linked addresses, meaning

they must first be entered as a NAMED address prior to referencing them as a Bill To, Pay To, or Remit To.

Field Descriptions

The following fields are located in the Addresses tab of the Employees applet.

Work Address

Reimbursable Checks - If selected, this will be the default address for Employee Reimbursement checks

made out to this employee.

Office - A NAMED office address can be selected to pre-fill the employee work address. The named office

addresses are configured via Administration>Global Settings>Offices Tab

Street 1

Street 2

Street 3

Street 4

City

State - State has an optional drop-down list of states.. The States list is managed under

Administration>List Management>Postal States.

Zip / Postal

Country

Latitude - Generated by the Geocode button.

Longitude - Generated by the Geocode button.

Geocode - Click this button to fill in the Latitude and Longitude values

Home Address
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Reimbursable Checks - If selected, this will be the default address for Employee Reimbursement checks

made out to this employee.

Street 1

Street 2

Street 3

Street 4

City

State - State has an optional drop-down list of states.. The States list is managed under

Administration>List Management>Postal States.

Zip / Postal

Country

Latitude - Generated by the Geocode button.

Longitude - Generated by the Geocode button.

Geocode - Click this button to fill in the Latitude and Longitude values

 
  

4.7.4.10 Contacts Tab

Overview 

Each employee can have associated contacts. An example of using contacts related to an employee would
be using it for emergency contact information.  

Contacts are added to an employee by clicking the Add New Contact button. Once added, contact
information will be listed here.

Field Descriptions
Add New Contact button - Launches the Contact Detail pop-up, pre-configured with the employee
association.

o Required Fields

First - The First Name of the new contact.

Last - The Last Name of the new contact.

Firm/Employee - Employee associated with this contact (Auto-filled)

Relationship Type - A Relationship Type is required to specify the  relation to the employee (ex.
wife, husband,etc.) The Relationship Type list is managed under Administration>List
Management>Employee Contact Types.

For descriptions follow this link: More on Contacts

Contact Grid - Lists the details of associated contacts
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4.7.4.11 Recent Tab

Overview 

Recent Tab displays the hours worked by an employee for each project. This is a simple way for managers to

review employee hours worked. Simply set a "Since" date and click the arrow button to display hours.

The top grid is a summary section that displays a total of hours for the project selected.  When you click on

the project, you will see the detail of the hours worked in the bottom grid.  With the appropriate permissions,

you can click on the Project Path or Timesheet ID to navigate to those locations.

Field Descriptions

Summary

Project Path - Project

Name - Project Name

Hours Worked - Total hours worked since the selected "Since" date

Detail

Timesheet ID - Internal ID of the time sheet that holds the hours. Click to view the time sheet record.

Work Date - Date of the hours worked

Work Hours - Hours worked

Job Title - Job Title used on the time record

Comments - Timesheet comments

4.7.4.12 Documents Tab

Overview 

Documents tab allows you to upload, view, modify and delete archived documents in relation to the loaded
record. Uploaded documents and related information will be listed in the grid. More on Document
Management

4.7.4.13 EFT Setup Tab

Overview 

The EFT Tab holds the employee configurations for EFT (Electronic Funds Transfer).

About EFT with InFocus
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Electronic Funds Transfer or EFT is a method of transferring money from one bank account to another.

InFocus saves this EFT bank information from the sender and receiver into a file that has to be uploaded to

your bank separately. The bank then uses the EFT information to make the money transfer. InFocus

supports Automated Clearing House (ACH) transactions which are a common type of EFT.

Field Descriptions
The following information is to be filled out if using EFT.

Settings

Enable EFT - Check this box to enable EFT for this employee

Individual ID - Federal EIN of employee

Individual Name - Employee name

ABA / Routing - Employee's bank routing number

EFT Account # - Employees' bank account number

Savings Account - Check this box if it is a saving's account. Otherwise considered a checking account.

EFT Type (SEC) - Standard Entry Class code is how the EFT is classified to the bank. The supported

EFT types are PPD (Prearranged Payments and Deposit), CCD (Cash Concentration or Disbursement)

and CTX (Corporate Trade Exchange).  Typically the PPD (Prearranged Payments and Deposit) type is

used for company bank accounts.  

Clear EFT Information - Click to explicitly clear EFT Setup information. Simply unchecking Enable EFT
(see above) does not clear the information.

4.7.4.14 Purchasing Tab

Overview

Employees Purchasing tab defines settings for the Purchasing module on a per-employee basis.

While Global Settings establishes system-wide configurations, settings made here further define key points of
setup for each employee using the Purchasing module.

Unless noted, settings made here are additive (as apposed to overrides) to the configurations in Global
Settings. So, for instance, when an employee submits a Purchase Order, the allowable Ship To addresses
are defined by the sum of address categories defined in Global Settings + Employees.

Field Descriptions
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Bill To
o Default Bill To - Bill To address to include on Purchase Orders. Overrides Global Settings>Purchasing

tab Default Bill To.
o Allow Override - When checked, Default Bill To can be overridden on the Purchase Order

Allowable Ship To - Defines where a Purchase Order item can be shipped to. Alternatively, a Specific
Address can also be listed.
PO Approval
o PO Approver - Employee responsible for approving submitted Purchase Orders
o Also Approver Override - When checked, the PO Approver can be overridden on the Purchase Order

Approval Requirement Conditions - Defines a set of criteria for determining if a Purchase Order item
requires approval. Rules can be further defined per Employee and/or Purchase Item.
o Require All Conditions - When checked, all criteria must be met to require approvals

4.7.4.15 Delegates Tab

Overview

Employee Delegates tab is used to define employees who can act on behalf of the loaded employee with
respect to the Purchasing module.

Delegates are listed in the grid and configured for PO Entry, PO Approval or both.

Employees can be assigned one or multiple Delegates.

Field Descriptions

Employee Code - Employee Code assigned as a delegate, selected from the lookup.

Name - Employee Name assigned as a delegate

PO Entry - When checked, the delegate can enter Purchase Orders on behalf of the loaded employee

PO Approve - When checked, the delegate can approve Purchase Orders on behalf of the loaded
employee

4.7.4.16 Custom Fields (UDF) Tab

Overview 

User-definable fields (UDFs) can be created for Clients, Employees, Vendors, Projects, Project Level2 and
Contacts. More on User Defined Fields.

4.7.5 Holiday Calendar

Overview 

The Holiday Calendar allows you to create a list of holidays that can be “highlighted” on the time sheet.  

Key Concepts



InFocus User Manual - Current (v2020)296

© 2020 Clearview Software, Inc.

The Holiday Calendar does not limit time entry on days specified in the calendar.  

Holiday Calendars can be used to pre-fill time sheets with a specified holiday project and hours. 

This does not limit time entered on a particularly configured holiday, but simply indicates the holiday and
prefills (optionally) configured project and hours. 

When setting up Holiday Calendars, it's worth noting that they can span multiple years (by leaving the
year blank). This means that you can have one ongoing Holiday Calendar which can be assigned to one
(or multiple) Timesheet Groups. If you prefer to establish one Holiday Calendar per year, you can also
configure the system this way.

Field Descriptions 

Holiday Calendar Grid

Holiday Calendar Name - This column contains the name of the Holiday Calendar. To create a Holiday

Calendar, click "New".  Once saved, the name will appear in this column.

Holiday Dates Grid

Holiday Project - Project to which holiday time should be charged.

Hours - Pre-filled hours for the specified days.

Holiday Name - Name of the holiday.

Month - Number of the month (e.g. January = 1).

Day - Day of the month.

Year - Year. If no year is specified, the date will be applied to all years.

4.7.6 Job Titles

Overview 

A Job Title describes the position held (or Hat worn) by an employee. Depending on the job, a Job Title can

describe the job responsibilities, the level of the job, or both.  Job Titles can have Rates associated with them

and can be used in setting up Rate Schedules for specific Projects.  Examples of Job Titles are Architect,

Senior Mechanical Engineer, Surveyor, Cad Operator, etc.

Key Concepts

Users can be given the ability to use Job Titles in their timesheets at Global Settings>Time and Expense

Tab>Allow Users to Edit Timesheet section.

Employees can be assigned to one or more job titles.
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At the project level, employees can be assigned an override set of job titles. 

Rate Schedules can be set up based on job titles. 

Job titles also can provide the G/L posting accounts for labor distribution. These posting accounts

override those in Global Settings.

Field Descriptions 

Job Titles Window Grid

Job Titles Window - This window contains the Code and Name of all Job Titles in the system. To create a

Job Title, click "New" fill out the information and click "Save".  Once saved, the name will appear in this

window.

Show Inactive Check-box - When checked, the list of Job Titles includes those that have the Active box

unchecked.

Code - Job title Code. Must be unique.

re-code - Allows you to change the code of the Job Title.

Name - Job title Name.

Active - When checked, the Job Tile is flagged as Active and can be used in time sheets.

4.7.6.1 Properties tab

Overview  

The Properties Tab is where you manage the Default Base Codes and Rates associated with Job Titles.  

Field Descriptions 

Direct Base Codes

Hourly - Direct labor cost base account for non-exempt employees.

Salaried - Direct labor cost base account for salaried employees.

Markup Credit - Direct labor cost base account to offset for the markup portion of direct labor.

Markup Debit -  Direct labor cost base account to charge for the markup portion of direct labor.

Sub-Contractor - Direct labor cost base account for subcontractors.

Indirect Base Codes

Hourly - Indirect labor cost base account for non-exempt employees.

Salaried - Indirect labor cost base account for salaried employees.
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Sub-Contractor - Indirect labor cost base account for subcontractors.

Average Rates

Pay - Average pay rate for job title for use in project planning.  

Note - Average pay rate is used by project planning for job title budgets when planning budgets are based on

pay rate.

Job Cost - Average job cost rate for job title for use in project budgeting.

Bill - Average bill rate for job title for use in project budgeting.

4.7.6.2 Employees Tab

Overview  

The Employees Tab shows employees that are assigned to this job title.

Field Descriptions 

Employees Grid

Employee Code - Code of the Employee.

Employee - Proper Name of the Employee 

4.7.7 Labor Distribution

Overview 

The Labor Distribution Pop-up contains the settings that will be used when you run the utility. More on Labor
Distribution

Field Descriptions 

Header & Footer

Period - G/L period to which the transactions will be posted.

Error Account -  Error G/L account. Used if an account derivation cannot be achieved.

Post button - After clicking on Post, an entry will be made in the General Journal.

Settings Tab (Misc. & Employees)

Payroll Group - When selected, all employees assigned to a specific Pay Group (Employees>Employee
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Information Tab) will be selected when running the Labor Distribution Utility. Payroll Groups are managed

through Administration>List Management>Payroll Groups

Standard Day - Standard hours in a day.

Pay Multiplier - Multiplier used when method is Pay Rate x Multiplier; otherwise, irrelevant.

Work Start Date - Timesheet starting work date, (normally the start date of payroll period).

Work End Date - Timesheet ending work date, (normally the end date of payroll period).

Use Salary Amounts - When checked, employee salary amount are used to capture variance.

Use Compensatory Time - When checked, a compensatory time project, as specified in Global Settings,

is used to capture salary variance. More on Compensatory Time

Treat Salaried as Hourly - When checked, Salaried employees are treated in the same manner that

Hourly employees are. See Notes 1&2 below

Employees - Optional filter list of employees. Leave blank for all.

Note 1 - In most scenarios Use Salary Amounts is checked and Treat Salaried as hourly is unchecked. Un-

checking Use Salary Amounts is only done if you want to split a single labor distribution into two postings

because the payroll transcends two G/P periods. Rarely, does anyone want to do that. Checking Treat

Salaried as hourly is only done when 1) running diluted rates (More on Diluted Pay Rates) and 2) you prefer

to have zero variance rather than payroll clearing exactly equaling gross pay. Again rarely does anyone want

to do this.

Note 2 - If you do not have Use Salary Amounts checked then the system calculates salary variance on a

per day basis based on the standard hours entered in this screen. For instance, if the standard hours is 8

and a salaried employee works 9 hours then one hour goes to variance.

Accounts Tab

Base Codes

Direct Salary - Default Cost Base Account for direct salary labor.

Overhead Salary - Default indirect salary labor cost base account.

Direct Hourly - Default direct non-exempt labor cost base account.

Overhead Hourly - Default indirect non-exempt labor cost base account.

Direct Subcontractor - Default direct subcontractor labor cost base account.

Overhead Subcontractor - Default indirect subcontract labor cost base account.

Markup Debit - Default markup debit direct labor cost account.

Markup Credit -Default markup credit direct labor cost account.
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G/L Accounts

Description - The offset of the direct and indirect postings are divided amount clearing and variance

accounts. More on Clearing and Variance Accounts

Salary Variance - Salary variance G/L account.

Payroll Clearing - Payroll clearing G/L account.

Subcontractor Clearing - Subcontractor clearing G/L account.

Setup: Back to Labor Distribution Setup

4.7.8 Payroll Export

Overview   

The Payroll Export Applet allows a user to export payroll hours to a file that can be uploaded into the Pensoft

Payroll Program.

Field Descriptions 

Work Date Ranges

Start - Start Date for which the Payroll Export tool will pick up work hours.

End - End Date for which the Payroll Export tool will pick up work hours

Other Options

Includes Accruals (Vac, Sick, etc.) - When checked, the export includes leave times (accruals)

Use InFocus Rates - When checked, the InFocus pay rates override the Pensoft pay rates.

Use Original Timesheet - When checked, uses time sheets prior to making any adjustments. Typically not

checked.

Include Salary Hours - When checked, Salary hours will be included in the export file.

Export File

Export File - The location of the Export File to be exported.

Employees
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All - When selected, all employees will be selected when running the Labor Distribution Utility.

 Employees in the following Payroll Group - When selected, all employees assigned to a specific Pay

Group (Employees>Employee Information Tab) will be selected when running the Labor Distribution

Utility. Payroll Groups are managed through Administration>List Management>Payroll Groups

Selected Employees -  When selected, the specified employees will be selected when running the Labor

Distribution Utility.

4.7.9 Recalculate Rates

Overview 

The Recalculate Rates Utility is used when rates or a rate schedule is set up after entering time sheets. This
is not the preferred method. 

Key Concepts

When time sheets are entered, or edited, in the system, they immediately pick up rates and store them in

the time sheet module so that they are available for reporting. If you retroactively want to apply rates to

time entries this can be accomplished via the Recalculate Rates utility. 

All three types of rates (Pay Rate, Job Cost Rate, and Bill Rate) can be recalculated.

Field Descriptions 

Projects

All Projects - When checked, time sheet line items are not limited by project charged.

Specific Projects - When checked, time sheet line items are limited by the specific project(s) listed.

Rate Schedule

Rate Schedule - When selected, the rate schedule will be used to recalculate the rates when the utility is

run.  If left blank, the utility will use the rate schedule setup on the Project (preferred).  If not rate schedule

is set up on the project, the rates will be pulled from the employee file.

Employee

Employee - When an employee is selected, they will be the only person who's rates will be recalculated. 

 When left blank, all employees who fall into the selection criteria will be recalculated.
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Hourly/Salary/Both - When selected, only employees of that type will be recalculated.  

Statuses To Include

Ready - When checked, time line items with a bill status of Ready to Bill will be included.

Hold - When checked, time line items with a bill status of Hold will be included.

Never Bill - When checked, time line items with a bill status of Never Bill will be included.

Billed - When checked, time line items with a bill status of Billed will be included.

Write Off - When checked, time line items with a bill status of Write-off will be included.

Dates

Start Date - Starting date of work dates to be included.

End Date - Ending date of work dates to be included.

Options

Do Pay Rate - When checked, pay rate is recalculated.

Do Job Cost Rate - When checked, job cost rate is recalculated.

Do Bill Rate - When checked, bill rate is recalculated.

Note - The following options only display when "Allow Audit Trail Posting in Rate Recalculation" located at

Global Settings>Time and Expense Tab>Additional Settings is checked.

Audit Pay Rate - When checked, audit entries occur for a changed pay amount.

Audit Job Cost Rate - When checked, audit entries occur for a changed job cost amount.

Audit Bill Rate - When checked, audit entries occur for a changed billable amount.

4.7.10 Resource Projections

Overview 

The Resource Projections Utility is used to aggregate and analyze schedule data from project planning. 

Key Concepts

Scheduled hours can be viewed by employee or job title and compared against available hours to show

predicted utilization. Hours are scheduled through Project Planning. More on Project Planning
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Clicking on Used columns will cause a drill-down screen to pop up, displaying the distributions of the

hours among the scheduled projects.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

View - Additional View options

o Balance Column - When selected, a Balance column appears in the Resource Projections grid.

Export - The Export button gives the user the ability to export the projections to Excel.

4.7.10.1 Resource Projections Detail

Overview 

The Resource Projection screen has 2 windows; a top and a bottom. The top displays the detail and the
bottom displays the filter options.

Note - You can left-click and hold on the blue header strip on the Filter section of the window to "un-dock"
the filter section. To return it to its original location, simply double-click on the blue  header strip on the Filter
section.

Field Descriptions 

Resource Projections Grid (top grid)

Employee - Name of the employee.

Allowed - Number of hours employee or job title can work for a given period of time.

Used -  Number of hours employee or job title has been scheduled for a given period.

Balance - Allowed Minus Used. There is an option under View in the toolbar to hide this column.

Filters Grid

View Dates

Start Date - Starting date for schedules to evaluate.

For - Number of Date View units that the top grid will look forward.

Date View - Block of time that the top grid will look forward. Options are Days, Weeks Months Calendar

Weeks and Calendar Months.

Include Saturday - When selected, Saturdays are included when retrieving the numbers.
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Include Sunday - When selected, Sundays are included when retrieving the numbers.

By Employee - When checked, projections are by employee.

By Job Title - When checked, projects are by job title.  

Employee Info

Employee - When selected, only information for the specific Employee is displayed.

Job Title - When selected, only information for the specific Job Title is displayed.

Home Org - When selected, only information for the specific Home Org is displayed. This is set at 

Employees>Employee Information. More on Org Units

Project Info

Charge Type - When selected, only project information for the specific Charge Type is displayed.

Status - When selected, only project information with the specific Status is displayed.

Client - When selected, only information for the specific Client is displayed.

Org. - When selected, only information for the specific Home Org is displayed. This is set at 

Projects>Members Tab. Organization unit and its children to include. If left blank, all org units are used.

More on Org Units

Project Leaders

Project Manager - When selected, only information for the specific Project Manager is displayed.

Project Accountant - When selected, only information for the specific Project Accountant is displayed.

Principal In Charge - When selected, only information for the specific Principal In Charge is displayed.

Project UDFs

UDF Field - Drop-down includes any Project UDFs. More on User Defined Fields

Operator - Choices are =, <>, >, <, >=, <=, between, and is not null. Is not null is synonymous with a

blank or empty field.

Value 1 -  Used with all filter operators except is not null. This is the value that completes the filter

operation (except in the case of the between operator). In the case of the between this represents the

lower range.

Value 2 - Used only with the between operator. This represents the upper range.

And/Or - Gives you the option of filtering using an And statement or an Or statement.

4.7.11 Time & Expense Templates

Overview 

Time and Expense templates are used to auto fill time and expense sheets with commonly used projects,
such as Admin, Vacation, or Sick. If no hours are put against these projects, the projects from the template
will be removed upon submitting a Time or Expense sheet.  Time & Expense Templates template are
assigned in Human Resources>Employees>Employee Information Tab.



InFocus Modules and Applets 305

© 2020 Clearview Software, Inc.

Field Descriptions 

Template Name Grid

Template Name - This column contains the name of the Template Name. To create a Template Name,

click "New".  Once saved, the name will appear in this column.

Name - This text box contains the name of the selected Time & Expense Template. The name can be

edited here.

Time Utilization

Show Direct PCT(%) - When selected, Current Direct, Month Direct and Year Direct are displayed in the

"% Billable" pop-up located on the toolbar in time sheets. 

Show Billable PCT(%) - When selected, Current Billable, Month Billable and Year Billable are displayed in

the "% Billable" pop-up located on the toolbar in time sheets.

Show Target PCT(%) - When selected Target % is displayed in the "% Billable" pop-up located on the

toolbar in time sheets.  The Target % is established at Human Resources>Employees>Accounting Rates

Tab

Sort

Sort template projects to top of sheet - When checked, the projects specified in the Time & Expense

Template will be sorted to the top of the Time and/or Expense Sheet.

Time & Expense Templates Grid Grid

Path - Path of Project.

Use in Time - When checked, the Project will auto fill in the time sheet.

Use in Expense - When checked, the Project will auto fill in the expense sheet.

Labor Code - When a Labor Code is selected, the Labor Code will auto fill. More on Labor Codes

Expense Code - When an Expense Code is selected, the Expense Code will auto fill. More on Expense

Codes

4.7.12 Timesheet Adjustments

Overview 

The Time sheet Adjustments Journal is used to make adjustments against an already existing time sheet.
New time sheets cannot be entered here. 
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Key Concepts

Once a time sheet has been modified, it can no longer be sent back to the manager or owner (time sheet
rejection). 

Time sheet adjustments are most commonly used to move hours between projects. This is usually done
by someone in the Accounts Receivable department.

Note:  Modifications to the time sheet via time sheet adjustments will not effect the original version of the
time sheet.

Giving TA Permissions - While a user can be given rights to make time sheet adjustments, the sum of
the adjustments must not alter the original hours and cost worked figures. This can be prevented by not
giving the user the standard Edit or Delete rights in Time sheet Adjustments. Instead, grant only Edit Grid
permission.

Enabling Full Audit

o Enabled - If Full Audit is enabled in Global Settings>General Tab>Full Audits, any change to critical
data (Project, Home, or Charge Org Unit, Work Hours or the Dollar Amount that is used for
Distribution) will result in the system recording an automatic reversing entry and storing your changes
as a new item. 

o Disabled - If not enabled, the prior automatic adjustment will occur only if this line item has already
been processed by Labor Distribution.

The normal mode of operation in Time sheet Adjustments is for the user to record only hours when
entering time items. The system automatically calculates rates, multipliers, and extended amounts. Any
calculated stored information for a line item can be overridden. The system does not, however, make the
automatic calculations. The user must change the extended amount if a rate is changed manually.

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

Time sheet - Additional Time sheet options.

o  Send Back to Manager - When selected, the time sheet is marked as Unapproved so that the Time sheet Approver

can make additional changes in the Time sheets applet.

o Send Back to Owner - When selected, the time sheet is marked as Unapproved so that the Employee can make

additional changes in the Time sheets applet.

Note - If a time sheet is marked as Billed, these options will be deactivated.

View - Additional View Options

o Project Name - When selected, the Project Name will display in the Time sheet Adjustments grid.

o SJID -  When selected, the SJID (Sales Journal Unique Identifier) will display in the Time sheet Adjustments grid.

o Sales Invoice No. - When selected, the Sales Invoice No. will display in the Time sheet Adjustments grid.

Print Original - When clicked, the Time sheet Report will print displaying the original time sheet.
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4.7.12.1 Timesheet Adjustments Detail

Overview 

The Time sheet Adjustments Detail grid displays the detail of any Submitted & Approved Time sheet.  In Time

sheet Adjustment, a time sheet can be modified and have different versions. 

Field Descriptions 

Header

Employee - Employee of the time sheet that is being displayed.

Period Ending - Period Ending date of the time sheet that is being displayed.

1 of ? - This shows the version of the time sheet entry that you are currently viewing.  This is enabled by

checking "Journals" at Global Settings>General Tab>Full Audits.

Show Audit Trail - When checked, all entries (including reversing entries) will display. Auto-reversals and

header lines will be grayed out and cannot be altered.  This also displays the Create By, Create Date,

Modify By and Modify Date of the transaction.

Hours

Original Reg. & OT - The numbers displayed here show the regular and overtime hours of the original time

sheet.

Current Reg. & OT - The numbers displayed here show the regular and overtime hours of the current time

sheet if any additional versions exist.

Amounts

Original Reg. & OT - The numbers displayed here show the regular and overtime amounts of the original

time sheet.

Current Reg. & OT - The numbers displayed here show the regular and overtime amounts of the current

time sheet if any additional versions exist.

Time Sheet Adjustments Grid

Project - The Project Path of the allowable WBS path for this employee.

Project Name - The Project Name of the allowable WBS path for this employee.

Work Date - Must be within time sheet coverage period.

Labor Code - Labor Code associated with the time sheet. More on Labor Codes

Job Title - Allowable job title for this employee on this project. More on Job Titles

OT - When checked, hours are overtime or premium.

Hours Work - Hours worked.
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Bill Status - Billing status.

Comments - Comments that can appear on project management reports or invoices.

Location - Location associated with the time sheet. More on Locations

Overrides Tab

Description - Accessed for any line item by clicking on the Overrides button in the lower left hand portion of

the screen.

Billing

Base rate - Base rate used when calculating bill rates.

Base Prem. Mult. - Multiplier applied against base rate for premium time. If changed, it auto-calculates

billing base premium rate.

Base Prem. Rate - Base premium rate used for calculating premium bill rate. When changed, it auto-

calculates premium multiplier.

DPE Mult. - Direct personnel expense multiplier.

OH Mult. - Overhead multiplier.

Profit Mult. - Profit Multiplier.

Bill Rate - Billing Rate

Job Cost

Base rate - Base rate used when calculating job cost rates.

Base Prem. Mult. - Multiplier applied against base rate for premium time. If changed, it auto-calculates

billing base premium rate.

Base Prem. Rate - Base premium rate used for calculating premium job cost rate. When changed, it auto-

calculates premium multiplier.

DPE Mult. - Direct personnel expense multiplier.

OH Mult. - Overhead multiplier.

Profit Mult. - Profit Multiplier.

JC - Job Cost Rate.

Pay Rate

Pay Rate -  Pay rate.

OT Rate - Overtime rate.

OT Markup - Overtime multiplier.

Misc

Charge Org. - Org unit that receives the cost of this line item.

Home Org. - Org. Unit to which employee belonged on this work date.

Ext. Bill - Extended bill amount (usually bill hours x bill rate).
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Ext. Pay.- Extended pay amount (usually work hours x pay rate).

Ext JC - Extended job cost amount (usually work hours x job cost rate).

Is Hourly - When checked, indicates that employee was classified non-exempt on this work date.

4.8 Personal

4.8.1 Approver

4.8.1.1 Overview

Geared specifically for approving time and expense, the Approvers applet will put all your approval tasks in
one place and give you full control with support for line-item approval (optional).

The documentation that follows will walk you through the setup and concepts involved with Approvers and
give you a full applet tutorial.

4.8.1.2 Getting Started With Approvals

4.8.1.2.1  Setup

4.8.1.2.1.1  Permissions

Overview

To begin working with the Approvers applet, you'll assign permissions to the appropriate groups and/or users.

Permissions are available for the following applets, defined in the tutorial below:

Approvers

Tutorial

Please complete the steps below to grant access permissions as appropriate.

1. Browse to Administration>Permissions
2. Select the Groups and/or Users you wish to grant permissions to
3. On the row next to the Group/User, click the lockbox. A dialogue will display.
4. From the Groups and/or Users Permissions tab, grant permissions as appropriate. Below is a list of

permissions and what they grant access to.
5. Once the permissions have been selected, click Save.

Note, click for more information on Approvers Special Rights

Module Applet Special Rights Description

Personal Approvers Can Force Approve

Can Force Reject

Can Force Submit

Applet used to manage
Time and Expense
Sheet approvals. Special
rights are applicable
when using line-item
approvals only and allow
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Module Applet Special Rights Description

users to Approve, Reject
or Submit a time /
expense sheet even if
the lines have not all
been approved.

Time Sheets Time Sheet Administrator Users granted this
special right will be able
to approve employee
time sheets, if granted
access to the Approvers
applet.

Expense Sheets Expense Sheet

Administrator

Users granted this
special right will be able
to approve employee
expense sheets, if
granted access to the
Approvers applet.

4.8.1.2.1.2  Global Settings

Overview

The Approvers applet provides a single place for managing time and expense sheet approvals. Optionally,
InFocus can be configured to support line-item approval via AD>Global Settings.

Configurations are made using the following tab via AD>Global Settings. 

Note These setting will only be applicable to subsequently submitted Time / Expense Sheets. Currently
submitted Time / Expense will not be governed by these rules.

Time and Expense Tab

Using the Time and Expense Tab tab, you'll enable the following features and controls used by the Approvers
applet.

Time Line-Item Approval

Use Time Line Approval - Enables the use of line-item approval for time sheets.

Project Approval Default - Default line-item approval requirement setting for projects.

Allowed Line Approvers - When checked, Project Leaders have the ability to approve line-items
associated with their projects.

Expense Line-Item Approval

Use Expense Line Approval - Enables the use of line-item approval for expense sheets.

Project Approval Default - Default line-item approval requirement setting for projects.

Allowed Line Approvers - When checked, Project Leaders have the ability to approve line-items
associated with their projects.



InFocus Modules and Applets 311

© 2020 Clearview Software, Inc.

4.8.1.2.2  Key Concepts

4.8.1.2.2.1  Approvers Workflow

Overview

Time and Expense Sheet approval follows this basic workflow.

Standard Approval Workflow

1. Time/Expense is Submitted
2. Time/Expense is reviewed via PR>Approvers
3. Time/Expense is marked Approved or Rejected

a. If Rejected, the Time/Expense Sheet is sent back to the employee for edits.

Line-Item Approval Workflow

For firms who elect to deploy line-item approvals, the workflow would be expanded as follows.

1. Time/Expense is Submitted
2. Time/Expense is reviewed via PR>Approvers
3. Time/Expense lines are each Approved or Rejected

a. If Rejected, the Time/Expense Sheet is sent back to the employee for edits.
5. Once all lines have been approved, the Time/Expense sheet can be marked Approved or Rejected

a. If Rejected, the Time/Expense Sheet is sent back to the employee or edits.

4.8.1.2.2.2  Defining Approvers

Overview

For purposes of the Approvers applet, an approver is defined as any user eligible to approve an employee's
time / expense sheet based on one of the following criteria.

Employee Time / Expense Approver - User is designated as an employee's approver via HR>Employees
at one of the following tiers.
o Default Approver
o Alternate Approver
o Additional Approver

Project Leader (Line-Item Approval only) - User is designated as a project leader on a project governed
by line-item approval. Project Leaders are defined as:
o Project Manager
o Principle In Charge
o Project Accountant
o PM as designated by Project Roles

Time / Expense Sheet Administrator - User has been granted the special right of Time Sheet
Administrator or Expense Sheet Administrator via UT>Permissions.

4.8.1.2.2.3  Line-Item Approval

Overview

When approving Time / Expense Sheets in InFocus, by default all associated lines-items are also considered
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approved. Similarly, when rejected, all line-items are considered rejected.

For firms that wish to more tightly govern their Time and/or Expense Sheet approvals, InFocus optionally
supports line-item approval.

When enabled, all lines on a Time / Expense Sheet must be approved prior to approving the full Time
/ Expense Sheet.

So, for instance, if there were ten line-items on a Time Sheet and only nine had been approved, the Time
Sheet would not be eligible for approval until all ten lines had been approved.

Enabling Line Item Approval

To leverage line-item approval, the feature must be enabled and configured via AD>Global Settings. As
described below, certain Force Options can be granted to approvers via special rights.

Force Options

For scenarios where line-item approval requirements need to be overridden, InFocus makes force options
available via specials rights (AD>Permissions). Force options exist for Approve, Submit and Reject.

Approver Additional Tabs

Once enabled, InFocus exposes two additional tabs in the Approvers applet specifically used for managing
line-items.

Time Sheet Lines

Expense Sheet Lines

Approvers can leverage each tab to review and approve/reject line-items as appropriate.

Projects and Line-Item Approval

When using line-item approvals, InFocus exposes an additional project setting that governs whether a project
is subject to line-item approvals and (if so) how approvers are defined.

Projects can be configured with the following options via PA>Projects>Members tab.

Default - Inherits the Project Approval Default setting defined in AD>Global Settings.

Not Required - Project is not subject to line-item approval

Required - Project requires line-item approval. Only the Project Leader(s) defined in AD>Global Settings
can approve line-items associated with the project.
Required (Allow Approver) - Project requires line-item approval. Any approver can approve line-items
associated with the project.

4.8.1.3 Time Sheets Tab

Overview

The Time Sheets tab allows approvers to review and approve (or reject) submitted time sheets.



InFocus Modules and Applets 313

© 2020 Clearview Software, Inc.

How to Approve/Reject a Time Sheet

Using the filters in the left-hand pane, time sheets can be loaded into the Time Sheets grid for review and
approval/rejection as appropriate.

When loaded, each row listed displays the current status of the Time Sheet. Clicking a Time Sheet row will
load it's details into the Time Sheets Detail.

The steps below walk you through a basic approval process.

Note Firms using line-item approval must approve all lines via the Time Sheet Lines tab prior to approving the
Time Sheet.

1. Browse to PR>Approver>Time Sheet tab
2. Use the filters to load Time Sheets for review
2. Click a row in the Time Sheets grid to review the related lines
3. Approve/Reject the Time Sheet by checking the box in the Time Sheet grid and clicking Approve or
Reject as appropriate. Multiple Time Sheets can be marked for bulk approval.

a. If rejecting, you'll be prompted to provide a reason.

The approval process has been completed for the selected Time Sheets.

Field Descriptions

Toolbar

Refresh - Refreshes the applet

Buttons

Submit (visible only with special rights) - Submits the selected time / expense sheets governed by line-
item approval regardless of the approval status of all lines.
Reject - Rejects the selected time / expense sheets

Approve - Approves the selected time / expense sheets

Toggle Checked - When checked, all of the time / expense sheets in the grid will be selected or
deselected.

Time Sheets Grid

Employee - Employee associated with the loaded time sheet

Status - Approval status of the time sheet.
o Unsubmitted - Time Sheet has not been submitted
o Pending - Time Sheet lines are partially approved. Only available when using line-item approval.
o Ready for Approval - Time Sheet is submitted and ready for approval. When using line-item approval,

also denotes all line items have been approved.
o Approved - Time Sheet has been approved
o Rejected - Time Sheet has been rejected

Period End - Period End Date of the Time Sheet

Regular Hours - Regular Work Hours

Premium Hours - Overtime Hours
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Total Hours - Total hours for the time sheet 

Documents - Number of documents associated with the Time Sheet. Click to review documents.

Time Sheet Detail Grid

Time Sheet Detail Grid displays line items associated with the selected time sheet.

Work Date - Date the hours were worked

Hours - Number of hours worked

Is Premium - When checked, the hours are considered overtime

Path - Project Path associated with the record

Job Code - Job Title code associated with the record

Labor Code - Labor Code associated with the record

Location Code - Location associated with the record

Comment - Time Sheet line comment

Time Sheets tab uses standard Approvers applet Filters and Columns.

4.8.1.4 Time Sheet Lines Tab

Overview

Time Sheet Lines Tab is used when Line Item Approval is Enabled in Global Settings (Global Settings> Time
and Expense Tab> Time Line-Item Approval Section). This is where your Project Leaders, or Allowed
Approvers, can approve specific line items on specific Time sheets.  

Note A Time Sheet cannot pass through to billing until all line items on the Time Sheet have been approved. 
Special Rights are available to Force Approvals and Rejections in scenarios where time needs to be billed
and the approval process needs to be overridden.  More on Approvals Special Rights

Field Descriptions

Filters

Project Manager - When selected, the grid will filter the list of line items to projects where the logged in
user is the Project Manager (PA> Projects> Members Tab)
Principal-In-Charge - When selected, the grid will filter the list of line items to projects where the logged in
user is the Principal-In-Charge (PA> Projects> Members Tab)
Project Accountant - When selected, the grid will filter the list of line items to projects where the logged in
user is the Project Accountant (PA> Projects> Members Tab)
Any Leader - When selected, the grid will filter the list of line items to projects where the logged in user is
any of the above Project Leaders (or Allowed Approver assigned on Project)

Time Sheet Lines Summary Grid

Project - Project Name associated with the item

Code - Project Code associated with the item

Employee - Employee associated with the item
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Hours - Total Hours on Time Sheet

Time Sheet Lines Detail Grid

Reject (button) - Rejects the selected time / expense sheets

Approve (button) - Approves the selected time / expense sheets

Toggle Checked - When checked, all of the time / expense sheets in the grid will be selected or
deselected.
WBS Path - Project Path associated with the line item

Project - Project Name associated with the line item

Employee - Employee associated with the item

Period Start - Period Start Date of the Time Sheet

Period End - Period End Date of the Time Sheet

Total Hours - Total Hours for the line item to be approved

Time Sheets Lines tab uses standard Approvers applet Filters and Columns.

4.8.1.5 Expense Sheets Tab

Overview

The Expense Sheets tab allows an approver to review and approve (or reject) submitted expense sheets.

How to Approve/Reject an Expense Sheet

Using the filters in the left-hand pane, expense sheets can be loaded into the Expense Sheets grid for review
and approval/rejection as appropriate.

When loaded, each row listed displays the current status of the Expense Sheet. Clicking an Expense Sheet
row will load it's details into the Expense Sheets Detail.

The steps below walk you through a basic approval process.

Note Firms using line-item approval must approve all lines via the Expense Sheet Lines tab prior to approving
the Expense Sheet.

1. Browse to PR>Approver>Expense Sheet tab
2. Use the filters to load Expense Sheets for review
2. Click a row in the Expense Sheets grid to review the related lines
3. Approve/Reject the Expense Sheet by checking the box in the Expense Sheet grid and clicking
Approve or Reject as appropriate. Multiple Expense Sheets can be marked for bulk approval.

a. If rejecting, you'll be prompted to provide a reason.

The approval process has been completed for the selected Expense Sheets.

Field Descriptions

Toolbar

Refresh - Refreshes the applet
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Buttons

Submit (visible only with special rights) - Submits the selected time / expense sheets governed by line-
item approval regardless of the approval status of all lines.
Reject - Rejects the selected time / expense sheets

Approve - Approves the selected time / expense sheets

Toggle Checked - When checked, all of the time / expense sheets in the grid will be selected or
deselected.

Expense Sheets Grid

ESID - Internal Expense Sheet ID. Click to view the Expense Sheet in PR>Expense Sheets.

Status - Approval status of the record.
o Unsubmitted - Expense Sheet has not been submitted
o Pending - Expense Sheet lines are partially approved. Only available when using line-item approval.
o Ready for Approval - Expense Sheet is submitted and ready for approval. When using line-item

approval, also denotes all line items have been approved.
o Approved - Expense Sheet has been approved
o Rejected - Expense Sheet has been rejected

Employee - Employee associated with the loaded record

Title - Expense Sheet title

Amount - Total amount of the Expense Sheet

Reimbursable Amount - Total amount to be reimbursed to the Employee.

Documents - Number of documents associated with the Expense Sheet. Click to review documents.

Expense Sheet Detail Grid

Expense Sheet Detail Grid displays line items associated with the selected expense sheet.

Line Status - Approval status of the line item

WBS Path - Project path associated with the record

WBS Name - Project long name associated with the record

Tx Date - Date of the expense

Amount - Total amount of the expense line

Reimbursable - Total amount to be reimbursed to the employee for the expense line (e.g. reimbursable
portion of the expense line)
Expense Code - Expense Code associated with the expense line

Credit Card - When checked, the expense was made with a company credit card and is not reimbursable.

Client Code - Client code associated with the record

Client Name - Client name associated with the record

Documents - Number of documents associated with the Expense Sheet line. Click to review documents.

Expense Sheets tab uses standard Approvers applet Filters and Columns.

4.8.1.6 Expense Sheet Lines Tab

Overview

Expense Sheet Lines Tab is used when Line Item Approval is Enabled in Global Settings (Global Settings>
Time and Expense Tab> Expense Line-Item Approval Section). This is where your Project Leaders, or
Allowed Approvers, can approve specific line items on specific Expense sheets.  
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Note: A Expense Sheet cannot be imported to the E/R Journal until all line items on the Expense Sheet have
been approved. Special Rights are available to Force Approvals and Rejections in scenarios where time
needs to be billed and the approval process needs to be overridden.  More on Approvals Special Rights

Field Descriptions

Filters

Project Manager - When selected, the grid will filter the list of line items to projects where the logged in
user is the Project Manager (PA> Projects> Members Tab)
Principal-In-Charge - When selected, the grid will filter the list of line items to projects where the logged in
user is the Principal-In-Charge (PA> Projects> Members Tab)
Project Accountant - When selected, the grid will filter the list of line items to projects where the logged in
user is the Project Accountant (PA> Projects> Members Tab)
Any Leader - When selected, the grid will filter the list of line items to projects where the logged in user is
any of the above Project Leaders (or Allowed Approver assigned on Project)

Expense Sheet Lines Summary Grid

Project - Project Name associated with the item

Code - Project Code associated with the item

Employee - Employee associated with the item

Amount - Total amount of the Expense Sheet

Reimbursable Amount -  Total amount to be reimbursed to the Employee

Lead Type - Logged in user's role (PM, PIC, PA) designated on the project associated with the item

Expense Sheet Lines Detail Grid

Reject (button) - Rejects the selected time / expense sheets

Approve (button) - Approves the selected time / expense sheets

Toggle Checked - When checked, all of the time / expense sheets in the grid will be selected or
deselected
Title - Title of the Expense Sheet

Amount - Total amount of the line item

Reimbursable Amount -  Total amount to be reimbursed to the Employee for the line item

WBS Path - Project Path associated with the line item

WBS Name - Project Name associated with the line item

Employee - Employee associated with the item

Expense Sheet Lines tab uses standard Approvers applet Filters and Columns.

4.8.1.7 Reference

Overview

Below you'll find a list of standard Filters and Grid Column descriptions used by the Approvers applet.
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4.8.1.7.1  Filters Index

The following are used to filter the loaded Time / Expense Sheets for evaluation.

Note Approver filter buttons are used to load records associated with employees for which the logged in user
is defined as an approver.

Time / Expense Sheet Tabs

Approver - Filters records for any employee to which you are assigned as the Default Approver

Alternate Approver - Filters records for any employee to which you are assigned as the Alternate
Approver
Additional Approver - Filters records for any employee to which you are assigned as an Additional
Approver
Any Approver - Filters records for any employee to which you are assigned as any approver (Default,
Alternate or Additional).
Include Unsubmitted - When selected, Unsubmitted Time / Expense Sheets are included in the loaded
records.
Include Rejected - When selected, Rejected Time / Expense Sheets are included in the loaded records.

Include Submitted - When selected, Submitted Time / Expense Sheets are included in the loaded records.

Include Approved -  When selected, Approved Time / Expense Sheets are included in the loaded records.

Include Pending - When selected, Unapproved time / Expense Sheets that are awaiting line-item approval
are included in the loaded records.
Since Date (Time Sheets only) - Date used to filter all  time sheets that have a work date on or after the
selected date.

Time / Expense Sheet Line Tabs

Project Manager - Filters records for any items associated with projects to which the logged in user is
designated as the Project Manager (PA>Projects> Members Tab) 
Principal-In-Charge - Filters records for any items associated with projects to which the logged in user is
designated as the Principal-In-Charge (PA> Projects> Members Tab)
Project Accountant - Filters records for any items associated with projects to which the logged in user is
designated as the Project Accountant (PA> Projects> Members Tab)
Any Leader - Filters records for any items associated with projects to which the logged in user is
designated as any of the above Project Leaders (or Allowed Approver assigned on Project)

4.8.1.7.2  Column Index

Overview

Throughout the Approver applet, you'll find a similar set of columns available to the base grids used. Below is
a list of definitions:

Field Descriptions

Standard Columns

Time Sheets Grid

Employee - Employee associated with the loaded time sheet



InFocus Modules and Applets 319

© 2020 Clearview Software, Inc.

Status - Approval status of the time sheet.
o Unsubmitted - Time Sheet has not been submitted
o Pending - Time Sheet lines are partially approved. Only available when using **line-item approval**.
o Ready for Approval - Time Sheet is submitted and ready for approval. When using **line-item

approval**, also denotes all line items have been approved.
o Approved - Time Sheet has been approved
o Rejected - Time Sheet has been rejected

Period End - Period End Date of the Time Sheet

Regular Hours - Regular Work Hours

Premium Hours - Overtime Hours

Total Hours - Total hours for the time sheet 

Documents - Number of documents associated with the Time Sheet. Click to review documents.

Time Sheet Detail Grid

Time Sheet Detail Grid displays line items associated with the selected time sheet.

Work Date - Date the hours were worked

Hours - Number of hours worked

Is Premium - When checked, the hours are considered overtime

Path - Project Path associated with the record

Job Code - Job Title code associated with the record

Labor Code - Labor Code associated with the record

Location Code - Location associated with the record

Comment - Time Sheet line comment

Expense Sheets Grid

ESID - Internal Expense Sheet ID. Click to view the Expense Sheet in PR>Expense Sheets.

Status - Approval status of the record.
o Unsubmitted - Expense Sheet has not been submitted
o Pending - Expense Sheet lines are partially approved. Only available when using **line-item

approval**.
o Ready for Approval - Expense Sheet is submitted and ready for approval. When using **line-item

approval**, also denotes all line items have been approved.
o Approved - Expense Sheet has been approved
o Rejected - Expense Sheet has been rejected

Employee - Employee associated with the loaded record

Title - Expense Sheet title

Amount - Total amount of the Expense Sheet

Reimbursable Amount - Total amount to be reimbursed to the Employee.

Documents - Number of documents associated with the Expense Sheet. Click to review documents.

Expense Sheet Detail Grid

Expense Sheet Detail Grid displays line items associated with the selected expense sheet.

Line Status - Approval status of the line item

WBS Path - Project path associated with the record

WBS Name - Project long name associated with the record

Tx Date - Date of the expense

Amount - Total amount of the expense line

Reimbursable - Total amount to be reimbursed to the employee for the expense line (e.g. reimbursable
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portion of the expense line)
Expense Code - Expense Code associated with the expense line

Credit Card - When checked, the expense was made with a company credit card and is not reimbursable.

Client Code - Client code associated with the record

Client Name - Client name associated with the record

Documents - Number of documents associated with the Expense Sheet line. Click to review documents.

Time Sheet Lines Summary Grid

Project - Project Name associated with the item

Code - Project Code associated with the item

Employee - Employee associated with the item

Hours - Total Hours on Time Sheet

Time Sheet Lines Detail Grid

Reject (button) - Rejects the selected time / expense sheets

Approve (button) - Approves the selected time / expense sheets

Toggle Checked - When checked, all of the time / expense sheets in the grid will be selected or
deselected.
WBS Path - Project Path associated with the line item

Project - Project Name associated with the line item

Employee - Employee associated with the item

Period Start - Period Start Date of the Time Sheet

Period End - Period End Date of the Time Sheet

Total Hours - Total Hours for the line item to be approved

Additional Columns

Below are additional columns available by clicking the column chooser (gear icon).

Time / Expense Sheet Grid

Approved By - User who approved the line item

Approved Date - Date approved

Documents - Number of documents associated with the Time Sheet. Click to review documents.

Employee - Employee Name of the user who submitted the item

Employee Code - Employee Code of the user who submitted the item

ESID - Internal Expense Sheet ID

Last Rejection Date - Date of most recent rejection

Last Rejection Reason - Reason provided for most recent rejection

Lines Approved - Count of associated lines approved

Lines Rejected - Count of associated lines rejected

Lines Waiting - Count of lines awaiting approval/rejection

Non-Reimbursement Amount - Amount of non-reimbursable items

Reimbursable Amount - Amount of reimbursable items

Period Days - Number of days in the Time Sheet period

Period End - Period End Date of the Time Sheet

Period Start - Period Start Date of the Time Sheet

Premium Hours - Overtime Hours

Regular Hours - Regular Work Hours
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Status - Approval status of the time/expense sheet.
o Unsubmitted - Time/Expense Sheet has not been submitted
o Pending - Time/Expense Sheet lines are partially approved. Only available when using **line-item

approval**.
o Ready for Approval - Time/Expense Sheet is submitted and ready for approval. When using **line-item

approval**, also denotes all line items have been approved.
o Approved - Time/Expense Sheet has been approved
o Rejected - Time/Expense Sheet has been rejected

Submit By - User who submitted the item

Submit Date - Date submitted

Time ID - Internal Time Sheet ID

Title - Title of the Expense Sheet

Time/Expense Sheet Detail Grid

Amount - Amount of the expense line item

Charge Code - Charge Org Code associated with the item

Charge Name - Charge Org Name associated with the item

Client (Name) - Client Name associated with item

Client Code - Client Code associated with the item

Comment - Comments associated with the line item

Credit Card - Designation of whether the item as purchased with a Company Credit Card. 1=Yes/True.

Documents - Number of documents associated with the Time Sheet. Click to review documents.

Emp Code - Employee code associated with the item

Emp Name (Employee) - Employee name associated with the item

ESID - Internal Expense Sheet ID

ESName - Expense Sheet Name

Expense Code - Expense Code assosiated with the line item

Expense Name - Expense Code Name associated with the line item

Hours - Work hours

Internal Comment - Notes (internal) associated with the line item

Is Premium - Designation of overtime, 1=Yes/True

Job Code - Job Title code associated with the item

Job Title - Job Title name associated with the item

Labor Code - Labor Code associated with the item

Labor Name - Labor Code Name associated with the item

Location - Location associated with the item

Location Code - Location Code associated with the item

Non Reimbursable - Non-Reimbursable amount of the line item

Path - Project Path associated with the item

Project Code - Project Code associated with the line item

Project Name - Project Name associated with the line item

QTY - Quantity

Reimbursable - Reimbursable amount of the line item

Status - Approval Status of the entry

TxDate - Expense date of the line item

Unit Rate - Unit Rate associated with teh line item

WBS Path - Project Path associated with the item

WBS Name - Project Long Name associated with the item

Work Date - Date the hours were worked

Work ID - Work Order ID associated with the item

Work Order - Work Order Title associated with the item
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Time/Expense Sheet Lines Summary Grid

Emp ID - Internal ID of the employee associated with the item

My Role - Logged in user's role (PM, PIC, PA) designated on the project associated with the item

Project ID - Internal ID of the Project associated with the item

Time/Expense Sheet Lines Detail Grid

Comments - Comments associated with the line item

Emp ID - Internal ID of the employee associated with the line item

ESID - Internal ID of the Expense Sheet associated with the line item

Internal Comment - Notes (internal) associated with the line item

Leader Type - Logged in user's role (PM, PIC, PA) designated on the project associated with the item

Line - Line number of the row displayed in the grid

Project - Project associated with the item

Project ID - Internal ID of the Project associated with the item

Project Code - Project Code associated with the line item

Time ID - Internal ID of the Time Sheet

4.8.2 Expense Sheets

Overview   

Similar to time entry, Expense Sheets are core to capturing Expense with InFocus. Employees can quickly

enter project expenses and capture markups and reimbursable amounts as applicable. While timesheets are

entered for periods of time, Expense Sheets do not carry the same requirement. Multiple expense sheets

could be entered within a day, if desired.

Note - Expense sheet entry is also available for web/mobile via InFocus Mobile.

Expense Sheet Workflow

Expense Sheet Created

Description - Employees can create their own expense sheets via Personal>Expense Sheets by clicking New

from the toolbar or the Create New Expense Sheet link when opening the applet. Expense sheet

administrators can also create expense sheets on behalf of employees.

Expense Sheet Entered & Submitted

Description - Expense sheets, while typically entered by each employee, can optionally be entered on behalf

of an employee by an expense sheet administrator.

https://support.clearviewsoftware.net/articles/5409
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Best Practices

Enter expenses on a daily basis

Projects must be associated with each expense

Use Document Manager to attach receipts to the expense sheet

Utilize Expense Codes to govern/automate mark up and expense/revenue tracking. Expense Codes,

optionally required for entry, provide automated controls per expense line, including- but not limited to:

o Markup and/or Unit Rate

o Default comments via comment templates

o Reimbursable vs Non-Reimbursable settings

o G/L Account assignment at the point of import the Employee Reimbursable Journal

o Bill Status

Save your expense sheet while entering

Ensure your expense sheet is complete before submitting. Once submitted, you cannot make edits unless

enabled by your expense sheet approver.

Expense Review

Description - Submitting your expense, notifies your approver for review.  If approved, your expense sheet is

sent to Accounting for billing and/or reimbursement via Employee Reimbursables. If rejected, you’ll receive

your expense sheet back for edits. Once approved, expense sheets can be imported to Employee

Reimbursables and subsequently reimbursed and/or billed. Expenses do not appear on project management

reports until they have been imported into the Employee Reimbursable journal.

Expense Sheets Tutorials

Creating Expense Sheets

1. Browse to Personal>Expense Sheets

2. Click New from the toolbar or click the Create New Expense Sheet when opening the applet

Entering Expenses

1. Browse to Personal>Expense Sheets

2. Select the Expense Sheet for which you wish to enter your expenses. This can be accessed via the drop

down to the right of the Expense Sheet label or by navigating Expense Sheets with the arrows to the left.

3. Enter your expenses, considering the following:

Selecting a Project

Description - Projects are required for each expense item and are specified via the Project Path. Simply begin
typing the path (ex. 20140000-001) and InFocus will dynamically search for a match. You can also click the
magnifying glass to search and select a project.
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Expense Codes

Description - Utilize Expense Codes to govern automate mark up and expense/revenue tracking. Expense
Codes, optionally required for entry, provide automated controls per expense line, including- but not limited
to:

Markup and/or Unit Rate

Default comments via comment templates

Reimbursable vs Non-Reimbursable settings

G/L Account assignment at the point of import the Employee Reimbursable Journal

Bill Status

Credit Cards

Description - Each expense line has an option for Credit Card. Check only if using a company credit card and
no reimbursement is required. Checking this box forces a zero dollar Reimbursement amount. If you're
entering a line item that requires reimbursement, leave this check box unchecked.

Notes & Comments

Description - Comments can be added on a per-entry basis via Notes and PM Comments. While Notes are
internal, PM Comments are used in project reporting and appear on invoices. If you use boiler-plate
comments for certain types of time, you can create a Snippet for quick reference via the Snippets button on
the toolbar. Reuse your snippets by clicking the button and inserting the previously created snippet.

Receipts

Description - Receipts can be attached via the Documents button on the toolbar.
4. Save your expense sheet by clicking Save from the toolbar

5. If needed, you can delete rows by highlighting the row (click the far left number column) and click Delete.

6. Submit the expense sheet by clicking Submit. Expense sheets can also be submitted via the Expense

Sheet Menu option. Once submitted, the expense sheet status will reflect the submission. If approved,

the status will be updated to Approved. If rejected, the status will reflect Rejected and include a reason

for rejection.

Approving/Rejecting Time

1. Browse to Personal>Expense Sheets

2. Enter the employee's code in the lookup (upper right hand corner of the applet)

3. Select the Expense Sheet to review by using navigation arrows, the navigation drop down or the Open

Expense Sheets tab located at the bottom of the screen. Note: Open Expense Sheets tab can be filtered

to give you a pick list of unapproved expense sheets.

4. Click Approve or Reject as appropriate (this can also be done via Menu>Expense Sheet). If rejecting,

provide instructions for the employee as appropriate.



InFocus Modules and Applets 325

© 2020 Clearview Software, Inc.

Expense Sheet Field Descriptions

Description - Below is a discussion of Expense Sheet Field Descriptions.

Expense Sheet Toolbar

Description - The Expense Sheet toolbar gives the user (with appropriate permission) various capabilities

within the Expense Sheet applet of InFocus. Those capabilities are as follows:

Menu Options

Tools>Enable Arrow Key Navigation - Allows the grid to be navigated with arrow keys. This also disables

moving the cursor with the arrow keys when in a cell.

Tools>Reset Declined Lines - Resets expense lines with a declined status

Tools>Copy - Copies the loaded expense sheet to a new, specified expense sheet

Expense Sheet>Submit - Submits the loaded expense sheet

Timesheet>Approve - Approves the loaded expense sheet

Timesheet>Reject - Rejects the loaded expense sheet. You'll be prompted for a rejection reason if

required via Administration>Global Settings>Time and Expense tab.

Toolbar Options

New - Creates a new expense sheet. You'll be prompted for a name.

Edit - Edits the name of the loaded expense sheet

Copy - Copies the loaded expense sheet to a new, specified expense sheet

Save - Saves the state of the loaded expense sheet

Delete - Deletes the loaded expense sheet

Check Spelling - Checks the spelling of the comments being edited (Notes or PM Comments)

Snippets - Launches the snippets dialogue for entering/adding common comments to the highlighted cell

Print - Runs the Timesheet report for the loaded expense sheet

Documents - Use this to load documents to your expense sheet

Expense Sheet Navigation & Statuses

Expense Sheet ID label - Internal ID of the expense sheet record

Employee Lookup - Used by administrators to load a expense sheet for review or entry on behalf of an

employee

Left/Right Arrows - Use these arrows to browse expense sheet



InFocus User Manual - Current (v2020)326

© 2020 Clearview Software, Inc.

Down Arrow - Click to browse expense sheet via a drop down list. Load a expense sheet from the list by

double clicking.

Submit - Click to submit your expense sheet

Approve - Visible by expense sheet approvers once the expense sheet has been submitted, Click to

Approve the expense sheet.

Reject - Visible by expense sheet approvers once the expense sheet has been submitted, Click to Reject

the expense sheet.

Employee Label - Reflects the employee associated with the loaded expense sheet

Status Label - Reflects the current status of the expense sheet: Unsubmitted, Submitted, Approved,

Rejected

Rejection Reason - If a expense sheet has been rejected, the status will reflect accordingly and the

rejection reason will be displayed.

Expense Sheet Grid

Grid Fields

Description - The expense sheet entry grid displays fields available to enter as a part of your expense sheet.

Additional fields can be added/removed from the detail using the column chooser (gear icon) in the upper left

of the detail grid. All fields can be reordered in the grid.

Below is a list of available grid and standard fields listed alphabetically.

Amount - Expense amount

Expense Code** - Expense code to associate with the transaction. When selected, the expense code will

govern/automate mark up and expense/revenue tracking for the transaction.

Project - Project the transaction is being entered against. Only allowable projects can be used. An

allowable projects is determined by a Project Active Flag, Expense Allow Date Entry, Profit Center

Membership, and (potentially) a Project Team Membership list. The lookup for this field is split into two

sections. The top section is used to select a Bill Terms Node (project). Once selected, the bottom section

lists the allowable WBS nodes.

Reimbursable Amt. - Defaulting to the value entered in the Amount field, this is the amount to be

reimbursed to the employee.

Transaction Date - Date expense was incurred

Note - Some fields listed below are only available if allowed via Administration>Global Settings>Time &

Expense tab.
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Standard Column Fields

Description - Fields can be selected using the column chooser (gear icon) in the upper left of the detail grid.

Approved - Checked if approved (read only)

Check Number - Check Number of the Disbursement associated with the expense

Credit Card -  Check only if using a company credit card and no reimbursement is required. Checking this

box forces a zero dollar Reimbursement amount. If you're entering a line item that requires

reimbursement, leave this check box unchecked. 

Declined - Checked if declined (read only)

Project Name - Project Name of the project associated with the line item

Quantity and Rate

o QTY - Quantity

o Unit Rate - Rate to apply to the QTY (e.g. If QTY = 2 and Unit Rate = 5.00 then Amount = 10.00)

Notes (Internal) - Internal notes for communication with accounting

PM Comments - Comments that can appear on project management reports and invoices

ERID - Employee Reimbursable internal ID associated with the expense line

ER Line ID - Employee Reimbursable Line internal ID associated with the expense line

Bill Status** - Bill Status of the expense record

Work Order** - Work Order expense is being entered against. When a Work Order is used, the project

(WBS) path will fill out automatically. The project cannot be overridden.

Note - Some fields listed below are only available if allowed via Administration>Global Settings>Time &

Expense tab.

Expense Sheet Totals

Description - Expense Sheet Totals gives you at-a-glace information for the expense sheet, including a

summary column, details for the highlighted cell and an Open Expense Sheet dialogue.

Open Expense Sheets

Description - Launch this dialogue by clicking or hovering with your mouse over the tab. This pane can be

pinned to the bottom of the expense sheet applet by clicking the pin icon in the upper right hand corner of the

opened tab.

Display drop down - Select to display expense sheets with the following statuses: Unsubmitted,

Unapproved or Both

Display list - Reflects all expense sheets with the selected status.

Refresh Button - Refreshes the list

Load Selected Expense Sheet - Click to load the highlighted expense sheet in the Display list
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4.8.2.1 Expense Sheet Toolbar

Overview   

The Expense Sheets toolbar gives the user (if given appropriate permissions) various capabilities within the
Expense Sheets applet. Below is a list of those capabilities.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options
Expense Sheet - Lists advanced options

o Submit - Submits the Expense Sheet that is pulled up.

o Approve - Approves the Expense Sheet that is pulled up.

o Reject - Rejects the Expense Sheet that is pulled up.

Tools

o Enable Arrow Key Navigation - When selected, arrow key navigation is enabled.

o Reset Declined Lines - When selected, any lines that were rejected in the Expense Sheet Import are reset.

Check Spelling - When selected, the Spelling window pops up.

Snippets - When selected, the snippet editor comes up. More on Snippets

Print - Runs the Expense Sheet Report against the Expense Sheet that is loaded. More on the Expense

Sheet Report

4.8.2.2 Expense Sheet Header

Overview  

The Expense Sheet Header is where you can see and navigate Expense Sheets.  

Field Descriptions 

Expense Sheet ID label - Internal ID of the expense sheet record

Employee Lookup - Used by administrators to load a expense sheet for review or entry on behalf of an

employee

Left/Right Arrows - Use these arrows to browse expense sheet

Down Arrow - Click to browse expense sheet via a drop down list. Load a expense sheet from the list by

double clicking.

Submit - Click to submit your expense sheet

Approve - Visible by expense sheet approvers once the expense sheet has been submitted, Click to
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Approve the expense sheet.

Reject - Visible by expense sheet approvers once the expense sheet has been submitted, Click to Reject

the expense sheet.

Employee Label - Reflects the employee associated with the loaded expense sheet

Status Label - Reflects the current status of the expense sheet: Unsubmitted, Submitted, Approved,

Rejected

Rejection Reason - If a expense sheet has been rejected, the status will reflect accordingly and the

rejection reason will be displayed.

4.8.2.3 Expense Sheet Detail

Overview  

The expense sheet entry grid displays fields available to enter as a part of your expense sheet. Additional

fields can be added/removed from the detail using the column chooser (gear icon) in the upper left of the

detail grid. All fields can be reordered in the grid.  

Field Descriptions 

Transaction Date - Date expense was incurred

Project Path - Project the transaction is being entered against. Only allowable projects can be used. An

allowable projects is determined by a Project Active Flag, Expense Allow Date Entry, Profit Center. More

on Projects

Expense Code** - Expense code to associate with the transaction. When selected, the expense code will

govern/automate mark up and expense/revenue tracking for the transaction. More on Expense Codes

Amount - Expense amount

Reimbursable Amt. - Defaulting to the value entered in the Amount field, this is the amount to be

reimbursed to the employee.

Credit Card -  Check only if using a company credit card and no reimbursement is required. Checking this

box forces a zero dollar Reimbursement amount. If you're entering a line item that requires

reimbursement, leave this check box unchecked. 

Notes (Internal) - Internal notes for communication with accounting

PM Comments - Comments that can appear on project management reports and invoices

Approval Status - Status of the Line Item. This is enabled with Line Item Approval. More on Approvals
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Additional Columns

Description - Fields can be selected using the column chooser (gear icon) in the upper left of the detail grid.

Check Number - Check Number of the Disbursement associated with the expense

Project Name - Project Name of the project associated with the line item

Quantity and Rate

o QTY - Quantity

o Unit Rate - Rate to apply to the QTY (e.g. If QTY = 2 and Unit Rate = 5.00 then Amount = 10.00)

ER Line ID - Employee Reimbursable Line internal ID associated with the expense line

Bill Status** - Bill Status of the expense record

Work Order** - Work Order expense is being entered against. When a Work Order is used, the project

(WBS) path will fill out automatically. The project cannot be overridden.

Approved - Checked if approved (read only)

 Membership, and (potentially) a Project Team Membership list. The lookup for this field is split into two

sections. The top section is used to select a Bill Terms Node (project). Once selected, the bottom section

lists the allowable WBS nodes.

Declined - Checked if declined (read only)

ERID - Employee Reimbursable internal ID associated with the expense line. Expense Sheets must be

imported to the E/R Journal for this to have an ID associated with it.

Docs - Documents that have been associated with the line item of the expense sheet.

4.8.3 My Work Orders

Overview   

My Work Orders is used by individuals to keep track of work that has been assigned to them. They can
attribute time to work orders, mark work as completed, and carry on recorded communication with the project
leaders. More on Work Orders

Key Concepts

The My Work Orders screen contains all the work orders that have been assigned to the user. By default,

it shows the Open list. 

This is essentially an Inbox. Use this screen to monitor the list of open work orders, respond to quote

requests, reject work order assignments, close work orders, and enter time.

Clicking on an Open work order opens up to three options under the Quote text box (in the middle of the

right side of the screen). The options are Submit Quote, Reject, and Cancel.

When a request for a Quote type work order is selected, the Quote text box will become enabled, and a

Submit Quote button will appear. Fill in the Quote textbox with an estimation of work; then click on the
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Submit Quote button. The Quote response will be sent back to the project leaders and the work order will

be removed from the user’s list.

When a work order is selected that is not mandatory, a Reject link button will appear under the Quote

textbox. Clicking on this will remove the user’s assignment from the work order, and the work order will no

longer appear on the user’s list.

Whenever an open work order is selected, a Closed link button will appear under the Quote textbox.

Clicking on the link will flag the work order as closed and remove it from the user’s Open list. Closing a

work order is how an assigned employee informs the project leaders that they have completed the work

order.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Print Work Order(s) - This prints the Work Order Detail OR Work Order Report. More on the Work Order

Detail OR Work Order Reports

Field Descriptions 

Work Order Navigator (Left Window)

Description - The left part of the Work Order applet is the Work Order Navigator. It lists the work order for

projects of which the user is the project leader. At the top of the list are Incomplete/Completed buttons.

Clicking these alters the list between completed and incomplete work orders. Work orders are built into

the list and grouped by date periods, such as two weeks old, more than a month, today, etc. 

Open - When selected, the grid only shows Work Orders that are open.  

Closed - When selected, the grid only shows Work Orders that are closed.  

Speech Bubble -  The speech bubble indicates that communications exist for the work order. If the bubble

icon is grayed out, it indicates that all existing communications have been read.

Question Mark - The question mark icon indicates that the work order is actually a request for a quote.

This is activated by checking the "Quote Request" box in the Work Order Detail. More on Work Order

Detail

Red Flag - The red flag icon indicates that the work order has been marked as high priority. This is

activated by checking the "High Priority" box in the Work Order Detail. More on Work Order Detail



InFocus User Manual - Current (v2020)332

© 2020 Clearview Software, Inc.

ID - The Unique Identifier of the Work Order.

Project - Project Path of the Project that the Work Order is in reference to. More on Work Order Detail

Client - Client that the Work Order is in reference to. More on Work Order Detail

Subject -  This is pulled from the "Subject" box in the Work Order Detail. More on Work Order Detail

Due Date - Estimated Finish Date of the Work Order. More on Work Order Detail

Work Order Navigator (Left Window - Visual Indicators)

Red - Work orders in red indicate that the work order has not been assigned to an employee.

Green - Work orders in green indicate that the work order has been closed by employee. 

Bold - Work orders that appear in bold have time entered against them.  

Work Order Window (Right Window)

Description - The right hand portion of the screen serves two purposes. First, it shows a quote (if one

exists). Second, it provides a running dialogue between project leaders and the work order assigner.

Work ID - Work Order ID Number.

Due Date - Estimated Finish Date of the Work Order. More on Work Order Detail

Project - Project Path of the Project that the Work Order is in reference to. More on Work Order Detail

Client - Client that the Work Order is in reference to. More on Work Order Detail

Description/Quote - When "Quote Request" box is checked, the comment box is labeled "Quote" and a

quote can be added.  When "Quote Request" box is un-checked, the comment box is labeled

"Description" and a description can be added.  Both are stored so that you can go between the two.

Reject - Allows the employee to reject the Work Order. This un-assigns them from the Employee field in

the Work Order Detail. More on Work Order Detail

Close - Signals the Project Leader that the work have been closed.

Comments (Right Window)

Comments - Allows the Project Leaders to have conversations with the Employee assigned to the Work

Orders.

4.8.4 Snippet Manager

Overview 

Snippets are standard comments that can be saved for future use.  You are able to use system variables (ex.

@MYID@ brings back the EMPID of the user) to return dynamic text in a comment.  You will now see a blue

“Insert Snippet” link in the top right of the Comment box (Fig.1).  Click on the link and you will see a list of

available Snippets.  To manage Snippets, a Snippet Manager (Fig.2) Applet has been added to Personal>

Snippet Manager.  Click here and go to the 1 minute 24 second mark to learn more about Snippets.

https://cvsupport.azurewebsites.net/articles/4079
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Field Descriptions 

Snippets Grid

Name - This column contains the name of the Snippets. To create a Snippets, simply type in a new line

and click Save.  Once saved, the name will appear in this column.

Snippet Editor - This text box contains the text of the selected Snippet. The text can be edited here.

4.8.5 Time Sheets

Overview

Time entry is a core process in InFocus. Entered by each employee and/or consultant, timesheets have a

direct impact on project reporting and utilization. The Timesheets applet gives you the tools you need to

record time quickly and accurately.

Note - Time entry is also available for web/mobile via InFocus Mobile.

Timesheet Workflow

Timesheet Created

Description - Timesheets are created by your timesheet admin based on a Weekly, Bi-Weekly, Semi-Monthly

or Monthly time cycle. Timesheets are generally created for a Timesheet Group. Alternatively, you can create

a timesheet for a single employee (typically used when hiring a new employee mid-time cycle, for example).

Timesheet Entered & Submitted

Description - Once created, you’ll enter and submit time via Personal>Timesheets. Time, while typically

entered by each employee and/or consultant, can optionally be entered on behalf of an employee and/or

consultant by a timesheet administrator.

Best Practices

Enter your time on a daily basis. This will ensure your time impacts project reporting and planning as

close to real-time as possible.

Save your timesheet while entering

https://support.clearviewsoftware.net/articles/5409
https://support.clearviewsoftware.net/articles/5341
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Use helpful tools like Add Recent Projects, Add Scheduled Projects, Timer, etc

Ensure your timesheet is complete before submitting. Once submitted, you cannot make edits unless

enabled by your timesheet approver.

Other Considerations

Work Orders - When utilizing this feature, work orders can be assigned to an employee and include much

of the info (Project Path, Job Title, etc.) necessary to fill out the timesheet line, except for hours and date.

This frees employees from having to know Project Paths and contractual or billing information.

Estimate to Complete - When using this feature, employees must enter an estimate to complete before

submitting timesheets that contain hours against Projects or Work Orders flagged with this requirement.

Enable this feature via Administration>Global Settings>Time & Expense tab.

Timesheet Review

Description - Submitting your time, notifies your time approver for review.  If approved, your timesheet is sent

to Accounting for billing. If rejected, you’ll receive your timesheet back for edits. Once approved, timesheets

can be reviewed and adjusted for billing. Completed via Human Resources>Timesheet Adjustments,

Accounting has full control over the recorded time to adjust as needed for the final bill.

Administrative Note

Description - Upon timesheet approval, InFocus takes a snapshot of the original timesheet. This means that

when viewing the approved timesheet in the Timesheets applet, the originally approved time is displayed-

regardless of adjustments made for billing.

After the appropriate adjustments, time is billed.

Timesheet Tutorials

Creating Timesheets

Description - Timesheets can be created for a Timesheet Group or for an individual Employee.

Create a Timesheet for a Group

1. Browse to Personal>Timesheets

2. Select Admin>Timesheets>Create Timesheets for a Timesheet Group

3. From the dialogue that appears, select the Timesheet Group and set the Periods. Note: You can

optionally add pre-filled Holiday Hours to the timesheet based on a Holiday Calendar. Holiday calendars

are managed via Human Resources>Holiday Calendar and assigned to timesheet groups via
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Personal>Timesheets>Admin Menu>Timesheet Groups.

4. Click Preview affected Employees to ensure all intended employees will have a timesheet created

5. Click Create. A timesheet will be created for each employee listed in Preview list.

Create a Timesheet for an Employee

1. Browse to Personal>Timesheets

2. Load the Employee you wish to create a timesheet for via the Employee Lookup

3. Select Admin>Timesheets>Create Employee Timesheet

4. From the dialogue that appears, select the Start and End Dates for the timesheet.

5. Click Create. A timesheet will be created for the loaded employee.

Entering Time

1. Browse to Personal>Timesheets

2. Select the period for which you wish to enter time. This can be accessed via the drop down to the right of

the Period label or by navigating timesheets with the arrows to the left.

3. Enter your time. In short, your timesheet consists of the hours you worked on specified projects. Hours

can be further defined by Job Tile and Comments (and optionally by Labor Code, Location, Bill Status

and/or Work Order).

Selecting a Project

Description - Projects are specified via the Project Path. Simply begin typing the path (ex. 20140000-001) and

InFocus will dynamically search for a match. You can also click the magnifying glass to search or select a

recently used or scheduled project by clicking Add Recent Projects or Add Scheduled Projects.

Comments

Description - Comments are added on a per-entry basis via the Comments box beneath the timesheet grid or

by typing “c” while in the timesheet grid. Once entered, you can apply the comment to all entries for the

specified project for the timesheet by clicking Apply Hours to Weekdays, found below the timesheet grid or

via the Comments dialogue (launched by typing "c" from the timesheet grid). Entries with comments are

highlighted yellow in the timesheet grid. If you use boiler-plate comments for certain types of time, you can

create a snippet for quick reference via the snippets link below the comments box. Reuse your snippets by

clicking the link and inserting the previously created snippet. All comments for your timesheet can be viewed

by clicking Show Comments from the toolbar or by hovering over the cell in the timesheet grid.
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Overtime

Description - Overtime is designated as a part of the total time entered on a given project/day. For example, if

you worked 8 hours on a given project and 2 of the hours were considered Overtime, you would enter the 10

hours in the timesheet grid and then designate the break out via the Regular and Overtime boxes below the

timesheet grid or via the Overtime Entry dialogue, launched by typing “o” from the timesheet grid. Saving the

entry publishes the breakout: 8 hours on the day and 2 hours to the Overtime column for the week.

Apply Hours/Comments to Weekdays

Description - This link is found below the timesheet grid and in the Comments and Overtime Entry dialogues.

When checked, InFocus will apply your comment and/or hours to each day in the week for the entered

Project.

4. Save your timesheet as you enter by clicking Save from the toolbar

5. If needed, you can delete rows by highlighting the row (click the far left number column) and click Delete.

6. Submit the timesheet by clicking Submit. Timesheets can also be submitted via the Timesheet Menu

option. Once submitted, the timesheet status will reflect the submission. If approved, the status will be

updated to Approved. If rejected, the status will reflect Rejected and include a reason for rejection.

Note - If any Estimates to Complete are required, a list will appear where the user can enter an estimate of

remaining hours or, optionally, flag the item as complete

Approving/Rejecting Time

1. Browse to Personal>Timesheets

2. Click Open Employee Timesheets from the Toolbar and select the timesheet you wish to review

3. Click Approve or Reject as appropriate (this can also be done via the Timesheet Menu). If rejecting,

provide instructions for the employee as appropriate- the instructions will appear on the user's timesheet

for their review/correction.

Timesheet Field Descriptions

Description - Below is a discussion of Timesheet Field Descriptions.

Timesheet Toolbar

Description - The Timesheets toolbar gives the user (with appropriate permission) various capabilities within

the Timesheets applet of InFocus. Those capabilities are as follows:
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Menu Options

Timesheet>Submit - Submits the loaded timesheet

Timesheet>Approve - Approves the loaded timesheet

Timesheet>Reject - Rejects the loaded timesheet. You'll be prompted for a rejection reason if required via

Administration>Global Settings>Time and Expense tab.

Admin>Modify Current Timesheet Period - Launches a dialogue where the period can be altered by

shifting the entire time entry period based on an anchor date, or altering the Start Date or End Date only.

Admin>Timesheet Groups - Launches a dialogue for managing Timesheet Groups. To learn more about

Timesheet Groups click here.

Admin>Timesheets - Allows you to create a timesheet for an individual Employee of for a Timesheet

Group

Admin>Delete Current Timesheet - Deletes the loaded timesheet

View>Billable Percentage - Shows the billable percentage

View>Missing Timesheets - Shows employees who haven't submitted their time for a specified Period End

Date.

View>Benefits - Displays a summary of benefits for the loaded employee

Tools>Compress Timesheet Lines - Merges timesheet lines that contain like information (Projects+Labor

code+Bill Status+Job Titles+Work Date+Work Order+PM Comments+Location+Comment Templates

+Overtime Type)

Toolbar Options

Save - Saves the currently loaded timesheet record

Copy - Copies the currently loaded timesheet record and pastes to another timesheet specified via the

Timesheet Copy. Copies can optionally include Hours and Comments. You can only paste to previously

created Timesheets.

Show Comments - Shows a listing of all comments entered on the loaded timesheet. Once clicked, this

button will read Hide Comments (click to hide the comments pane).

Print - Runs the Timesheet report for the loaded timesheet

Documents - Use this to load documents to your timesheet

Timer - Adds a Timer column to the Timesheet Grid. Clicking the timer column for a specified project's row

starts the timer. Clicking the running timer again, stops the timer and fills in the time value for the day.

% Billable - See View>Billable Percentage above

Benefits - See View>Benefits above

Open Employee Timesheet - Provides you with a list of Employee timesheets to load for timesheet review

and/or entry
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Timesheet Navigation & Statuses

Timesheet ID label - Internal ID of the timesheet record

Employee Lookup - Used by administrators to load a timesheet for review or entry on behalf of an

employee

Left/Right Arrows - Use these arrows to browse timesheets

Timesheet Dates - Indicates the Start and End dates of the loaded timesheet. 

Down Arrow - Click to browse timesheets via a drop down list. Load a timesheet from the list by double

clicking.

Submit - Click to submit your timesheet

Approve - Visible by timesheet approvers once the Timesheet has been submitted, Click to Approve the

timesheet.

Reject - Visible by timesheet approvers once the Timesheet has been submitted, Click to Reject the

timesheet.

Add Recent Projects - Displays a list of projects on which the employee has recently worked. The

employee checks off which projects to apply to the current timesheets. Projects the employee has worked

on in the last 30 days are considered Recent Projects. By default, projects are sorted in descending order

by the last day on which they were worked.

Add Scheduled Projects - Displays a distinct list of scheduled projects based in the supplied date range.

The employee checks off which projects to apply to the current timesheets.

Employee Label - Reflects the employee associated with the loaded timesheet

Status Label - Reflects the current status of the timesheet: Unsubmitted, Submitted, Approved, Rejected

Rejection Reason - If a timesheet has been rejected, the status will reflect accordingly and the rejection

reason will be displayed.

Timesheet Grid

Grid Fields

Description - The timesheet entry grid displays fields available to enter as a part of your timesheet. Additional

fields can be added/removed from the detail using the column chooser (gear icon) in the upper left of the

detail grid. All fields can be reordered in the grid. The timesheet grid, specifically, allows you to pin a column

(much like freezing a column in Excel). To do so, click the Pin icon contained in the column header. Below is

a list of available grid and standard fields listed alphabetically.

Days of the Week Columns - Regular hours (non-overtime) worked for the Project on a given day

J (Job Title) - Job Title associated with the time record. List shows the allowable Job Titles for selection

based on associated Rate Schedules, Project Membership and/or Employee Job titles.
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L (Labor Code)** - Labor Code associated with the time record

LOC (Location)** - Location of the time record

OT - Total overtime hours for line item

Project Path - Project the transaction is being entered against. Only allowable projects can be used. An

allowable projects is determined by a Project Active Flag, Timesheet Allow Date Entry, Profit Center

Membership, and (potentially) a Project Team Membership list. The lookup for this field is split into two

sections. The top section is used to select a Bill Terms Node (project). Once selected, the bottom section

lists the allowable WBS nodes.

Reg - Total regular hours for line item

S (Bill Status)** - Bill Status of the time record

Total - Total hours for line item

Work Order** - Work Order time is being entered against. When a Work Order is used, the project

(WBS) path, the labor code, and the job title will fill out automatically. The project cannot be overridden.

Note - some fields listed below are only available if allowed via Administration>Global Settings>Time &

Expense tab.

Standard Column Fields

DescriptionFields can be selected using the column chooser (gear icon) in the upper left of the detail grid

Client Code - Client Code associated with the line items (via the Project)

Client Name - Client Name associated with the line items (via the Project)

Labor Name** - Labor Name associated with the line item (via the Labor Code)

Location Code** - Location Code associated with the line item (via the Location selection)

Location Name** - Location Name associated with the line item (via the Location selection)

OT Hours** - Adding this adds an OT entry column for each day in the timesheet

Project Name - Project Name of the project associated with the line item

Note - Please note, some fields listed below are only available if allowed via Administration>Global

Settings>Time & Expense tab.

Timesheet Totals

Description - Timesheet Totals gives you at-a-glace information for the timesheet, including a summarized

column, details for the highlighted cell and a timesheet summary.

Timesheet Details

Date Label - Reflects the date of the highlighted cell
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Project Path Label - Reflects the project path of the highlighted cell

Comments Box - View and/or Edits comments for the highlighted cell

Snippets - Launches the snippets dialogue for entering/adding common comments to the highlighted cell

Regular - View and/or Edit the Regular Hours associated with the highlighted cell

Overtime - View and/or Edit the Overtime Hours associated with the highlighted cell

Apply Hours to Weekdays - Copies the hours from the highlighted cell and pastes them into all weekdays

in that row

Timesheet Summary

Description - Timesheet Summary gives you at-a-glace summary for the loaded timesheet.

Submitted Label - Date of submission

Approved Label - Date of approval

Direct Hours - Hours entered against billable projects

Indirect Hours - Hours entered against non-billable projects

Total Hours - Total direct and indirect hours

4.8.5.1 Time Sheets Toolbar

Overview   

The Time Sheets toolbar gives the user (if given appropriate permissions) various capabilities within the Time
Sheets applet. Below is a list of those capabilities.

Additional Toolbar Options

Time Sheet - Lists advanced options
o Submit - Submits the Time Sheet that is pulled up.
o Approve - Approves the Time Sheet that is pulled up.
o Reject - Rejects the Time Sheet that is pulled up.

Tools
o Enable Arrow Key Navigation - When selected, arrow key navigation is enabled.
o Reset Declined Lines - When selected, any lines that were rejected in the Expense Sheet Import are

reset.
Admin - Contains Administrative options
o Modify Current Timesheet Period - When selected, you are able to modify the Timesheet period of the

time sheet that is pulled up.
o Timesheet Groups - Opens the Timesheet Groups pop-up. More on Timesheet Groups
o Timesheets

Create Employee Timesheet - Creates a timesheet for the Employee that is pulled up. Timesheet
period must be available.
Create Timesheets for a Timesheet Group - Creates timesheets for the all of the Employees in a
specified Timesheet Group. More on Timesheet Groups

View 
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o Billable Percentages - Shows the percentage of the billable hours for the employee.
Target % - Reflects the Target PCT from HR>Employees>Accounting / Rates tab
Direct vs Billable - Direct includes all time against a billable project regardless of transaction bill
status. Billable does not include time with a bill status of N (Never Bill) or W (Write off).
Current - Current Timesheet
Month - Beginning of the calendar month based on the time sheet PS Date thru the PE Date
Year - Beginning of the year (January 1) through the PE Date

o Missing Timesheets - Displays all Employees that have an active Pay Rate on the Pay HistoryTab
(Human Resources> Employees) and DO NOT have a time sheet created as of the Period End Date
selected.  Note: When you check "Show for all Employees", you may see Inacive employees if you
did not add an End Date to the Pay Rate in a terminated employees record.

o Benefits - Shows the available benefits for the employee.

Delete Current Timesheet - Deletes the timesheet that is pulled up.

Check Spelling - When selected, the Spelling window pops up.

Snippets - When selected, the snippet editor comes up. More on Snippets

Show Comments - Shows a listing of all comments entered on the loaded timesheet. Once clicked, this
button will read Hide Comments (click to hide the comments pane).
Print - Runs the Time Sheet Report against the Time Sheet that is loaded. More on the Time Sheet
Report
Timer - Adds a Timer column to the Timesheet Grid. Clicking the timer column for a specified project's row
starts the timer. Clicking the running timer again, stops the timer and fills in the time value for the day.
% Billable - Opens a pop-up window that displays the % of billable hours for the employee.  Whether this
displays or not is controlled by the Time and Expense Template being used on the employee.  More on
Time and Expense Templates.
Benefits - Shows the available benefits for the employee.

Open Employee Timesheet - Provides you with a list of Employee timesheets to load for timesheet review
and/or entry

4.8.5.2 Time Sheet Header

Overview  

The Time Sheet Header is where you can see and navigate Time Sheets.  

Field Descriptions 

Timesheet ID label - Internal ID of the timesheet record

Employee Lookup - Used by administrators to load a timesheet for review or entry on behalf of an

employee

Left/Right Arrows - Use these arrows to browse timesheets

Timesheet Dates - Indicates the Start and End dates of the loaded timesheet. 

Down Arrow - Click to browse timesheets via a drop down list. Load a timesheet from the list by double

clicking.

Submit - Click to submit your timesheet

Approve - Visible by timesheet approvers once the Timesheet has been submitted, Click to Approve the

timesheet.
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Reject - Visible by timesheet approvers once the Timesheet has been submitted, Click to Reject the

timesheet.

Add Recent Projects - Displays a list of projects on which the employee has recently worked. The

employee checks off which projects to apply to the current timesheets. Projects the employee has worked

on in the last 365 days are considered Recent Projects. By default, projects are sorted in descending

order by the last day on which they were worked.

Add Scheduled Projects - Displays a distinct list of scheduled projects based in the supplied date range.

The employee checks off which projects to apply to the current timesheets.

Employee Label - Reflects the employee associated with the loaded timesheet

Status Label - Reflects the current status of the timesheet: Unsubmitted, Submitted, Approved, Rejected

Rejection Reason - If a timesheet has been rejected, the status will reflect accordingly and the rejection

reason will be displayed.

4.8.5.3 Time Sheet Detail

Overview  

The time sheet entry grid displays fields available to enter as a part of your time sheet. Additional fields can

be added/removed from the detail using the column chooser (gear icon) in the upper left of the detail grid. All

fields can be reordered in the grid.

  

Field Descriptions 

Description - The timesheet entry grid displays fields available to enter as a part of your timesheet. Additional
fields can be added/removed from the detail using the column chooser (gear icon) in the upper left of the
detail grid. All fields can be reordered in the grid. The timesheet grid, specifically, allows you to pin a column
(much like freezing a column in Excel). To do so, click the Pin icon contained in the column header. Below is
a list of available grid and standard fields listed alphabetically.

Project Path - Project the transaction is being entered against. Only allowable projects can be used. An

allowable projects is determined by a Project Active Flag, Timesheet Allow Date Entry, Profit Center

Membership, and (potentially) a Project Team Membership list. The lookup for this field is split into two

sections. The top section is used to select a Bill Terms Node (project). Once selected, the bottom section

lists the allowable WBS nodes. More on Projects 

Project Name - Project Name of the project associated with the line item

J (Job Title) - Job Title associated with the time record. List shows the allowable Job Titles for selection

based on associated Rate Schedules, Project Membership and/or Employee Job titles. More on Job Titles

L (Labor Code)** - Labor Code associated with the time record. More on Labor Codes

LOC (Location)** - Location of the time record. More on Locations
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Approval Status - Status of the Line Item. This is enabled with Line Item Approval. More on Approvals

Days of the Week Columns - Regular hours (non-overtime) worked for the Project on a given day.

Reg - Total regular hours for line item. Negative entries are supported (e.g. -1).

OT - Total overtime hours for line item. Negative entries are supported (e.g. -1). Users can be given the

ability to use Overtime in their time sheets at Global Settings>Time and Expense Tab>Allow Users to Edit

Timesheet section.  Overtime Types are also available. More on Overtime Types

Note - The overtime pop-up is triggered by clicking "o" on the keyboard.

S (Bill Status) - Bill Status of the time record. Users can be given the ability to modify Status in their time

sheets at Global Settings>Time and Expense Tab>Misc>Allow Users to Edit Bill Status in Time and

Expense 

Total - Total hours for line item

Work Order** - Work Order time is being entered against. When a Work Order is used, the project

(WBS) path, the labor code, and the job title will fill out automatically. The project cannot be overridden. 

More on Work Orders

Additional Columns

Description - Fields can be selected using the column chooser (gear icon) in the upper left of the detail grid.

Client Code - Client Code associated with the line items (via the Project). More on Clients

Client Name - Client Name associated with the line items (via the Project)

Labor Name** - Labor Name associated with the line item (via the Labor Code).  More on Labor Codes

Location Code** - Location Code associated with the line item (via the Location selection).  More on

Locations

Location Name** - Location Name associated with the line item (via the Location selection)

OT Hours** - Adding this adds an OT entry column for each day in the timesheet.Users can be given the

ability to use Overtime in their time sheets at Global Settings>Time and Expense Tab>Allow Users to Edit

Timesheet section.

4.9 General Accounting

4.9.1 Accounting Periods

Overview 

Accounting Periods (G/L periods) need to be established before non-labor transactions can be entered into
the system.
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Key Concepts

Fiscal Years

G/L Periods represent each period in the Fiscal Year. Before adding G/L Periods, the Seed Start Year
(earliest Fiscal Year) and Seed Start Date must be established and should cover the oldest transaction to be
entered in the system. This is done through AD>Global Settings>General Tab  in the Fiscal Calendar section.

InFocus supports the following Fiscal Year Types. This is assigned through Global Settings>General Tab  in
the Fiscal Calendar section. 

Calendar 12 - Twelve periods. Start date of year is January 1st. End Date of year is December 31st. Each
month is a period.
Non-calendar 12 - Twelve periods. Start date of year is specified by user. Each period begins on the
same day of the month.
13 Periods - Each period is 28 days long, starting on a user-specified start date.

5 x 4 x 4 - Twelve periods. The first period of each quarter receives five weeks. All other periods receive
four weeks.
4 x 5 x 4 - Twelve periods. The second period of each quarter receives five weeks. All other periods
receive four weeks.
4 x 4 x 5 - Twelve periods. The third period of each quarter receives five weeks. All other periods receive
four weeks.

Format

A G/L period contains a start and end date with a period code in the following format: YYYY-MM (e.g. 2016-
10). In this format, YYYY = Fiscal Year and MM = the period- a number between 01 and 13 (12 for 12-period
Fiscal Years).

Open/Closing Accounting Periods

When a period is checked open, the accounting period is open for transactions. Conversely, when
unchecked, the accounting period is closed. Having a standard approach to opening and closing accounting
periods is a recommended accounting control to have in place for your firm.

Allow Adjustments

That said, there are scenarios where adjustments must be made to transactions post-close. As an alternative
to re-opening the period (and therefor increasing the margin of error), each period can be marked to Allow
Adjustments. When checked, users with access to journals- including the special right Allow Post Closing
Adjustments- can make adjustments even if the period is closed.

Tutorial - Allowing Adjustments Post Close

1. Browse to GA>Accounting Periods
2. Check Allow Adjustments as appropriate
3. Click Save
4. Browse to AD>Permissions
5. Click the lockbox next to the user and/or group you wish to edit
6. Enable the Special Right Allow Post Closing Adjustments on each of the following applets as

appropriate
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o Purchase Journal
o Disbursements Journal
o Employee Reimbursables Journal
o Sales Journal
o Receipts Journal
o General Journal

Field Descriptions 

Menu

File/Help - Lists standard InFocus File and Help options

Toolbar Options

Periods Menu

Create New Fiscal Year -  When selected, this will create a new Fiscal Year.  If it is your first time running
this, InFocus will use the Seed Start Year and Seed Start Date to create the first year. Those are set at 
Global Settings>General Tab  in the Fiscal Calendar section. 
Delete Most Recent Fiscal Year - When selected, this will delete the most recent fiscal year. 

Applet Fields

Current Period - This is the default G/L period. It must be an open period in the All Periods Grid. It acts as
the default on new transactions and other procedures where a G/L period is required.
Current Invoicing Period - The default "As of" period for client invoicing.

Open - When checked, this period is open for transactions.

Period Code - System-generated. Cannot be changed.

Start Date - System-initialized but can be changed by user. This is the start date of the period.

End Date - System-initialized but can be changed by user. This is the end date of the period.

Allow Adjustments - Click to allow post close adjustments in the period. Note, only users with special
journal permissions can make post close adjustments.

4.9.2 Bank Reconciliation

Overview 

The Bank Reconciliation applet is used to match a company’s Books with its Bank Account.  More on Bank

Reconciliation

Key Concepts

To initialize a bank account for first-time use in this module, enter a balance forward for a given account

that represents the total of all cleared transactions that have NOT been entered in the system. 

https://support.clearviewsoftware.net/articles/4068
https://support.clearviewsoftware.net/articles/4068
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The balance forward is entered in the chart of accounts in the new field adjacent to the Next Control

Number field. More on Chart of Account Associations

The Bank Rec. ending balance should match the Bank Statement’s ending balance.

Use the Bank Reconciliation applet to clear items as of the last statement.

For ease of use, you can hold down the shift key and select multiple rows and then click on Clear or

Unclear to flag multiple transactions. Also, clicking Control + A will clear/unclear all items.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Tools - Here are additional options under the "Tools" drop-down

o Show Adjustment Detail - When selected, any details in the Adjustments section will display.

o Change Statement Date - When selected, you are prompted to enter a new Statement Date for the

current Bank Reconciliation.

o Bank Balance Forward - Here a user enters the balance forward for a given account that represents

the total of all cleared transactions that have NOT been entered in the system.

o Find Checks in Bank Recs - When selected, a pop-up appears that will allow a user to search for

checks cleared on another bank rec.

o Find Deposits in Bank Recs - When selected, a pop-up appears that will allow a user to search for

deposits cleared on another bank rec.

Refresh - Refreshes the current Bank Rec. session.

Print - Runs the Bank Reconciliation Report on the current Bank Rec. session. More on the Bank

Reconciliation Report

4.9.2.1 Bank Reconciliation Header

Overview 

The Header of Bank Reconciliation contains important information that pertains to the Bank Rec session that

is pulled up.  
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Field Descriptions 

Bank

Bank - The bank account the user wants to reconcile. More on Chart of Accounts

Statement Date

Statement Date - The bank statement date.

Bank Rec ID - Current Bank Reconciliation with which the user is working.

Comments

Comments - Internal comments.

Balance Forward - Calculated from prior bank statements. This is the ending balance from the previous

bank statement.

Ending Balance -  The account’s balance forward, including all current cleared items. After a Bank

Reconciliation, this becomes the new balance forward for the next statement.

Transactions

Cleared - When selected, only items that have been flagged as Cleared will show in the grids.

Uncleared - When selected, only items that have NOT been flagged as Cleared will show in the grids.

Uncleared Transactions

Show All - When selected, all uncleared transaction will show in the grids, ignoring the dates.

Show As Of - When selected, all uncleared transaction will show in the grids, As Of the selected date.

None - When selected, no uncleared transaction will show in the grids.

Transaction Totals

Description -  The Transaction Totals, located on the right, give the user the running totals of Bank Rec.

Transactions
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Cleared - The running total of items that have been flagged as Cleared.

Uncleared - The running total of items that have NOT been flagged as Cleared.

Total - The total of both the Cleared and Uncleared items.

4.9.2.2 Disbursements Tab

Overview 

The Disbursements tab displays cleared and uncleared Disbursement items. A user can select Show All to

display all uncleared transactions, or use an As Of Date to limit them. By selecting None, uncleared

transactions will not be displayed. The Clear Disbursements button clears all items from the Display grid. 

More on Disbursements

Key Concepts

A Find feature to search for a check or receipt cleared on another bank rec. More on Bank Rec Toolbar

Options

You can hold down the shift key and select multiple rows and then click on Clear or Unclear to flag

multiple transactions.

Ctrl-A will clear/unclear all items.

Field Descriptions 

Clear - When selected, the item is marked as Cleared in the current Bank Rec session.

Check Date - Date of the check.

Payee - Check payee (any vendor, employee, client, or payee not on file).

Check Number - Check number.

Amount -  Amount of check. 

4.9.2.3 Receipts Tab

Overview 

The Receipts tab displays cleared and uncleared cash receipts. The user can select Show All to display all

receipts or use an As Of date to limit them. By selecting None, uncleared transactions will not be displayed.

The Clear Disbursements button clears all items from the Display grid. The Deposit date is shown for cash
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receipts. More on Cash Receipts

Key Concepts

A Find feature to search for a check or receipt cleared on another bank rec. More on Bank Rec Toolbar

Options

You can hold down the shift key and select multiple rows and then click on Clear or Unclear to flag

multiple transactions.

Ctrl-A will clear/unclear all items.

Field Descriptions 

Clear - When selected, the item is marked as Cleared in the current Bank Rec session.

Deposit Number - Deposit Number of the Receipt entry.

Deposit Date - Deposit Date of the Receipt entry.

Payer - Check payer of the Check.

Check Number - Check number.

Amount -  Amount of check. 

4.9.2.4 Adjustments Tab

Overview 

The Adjustments tab displays any General Journal entries. The user can select Show All to display all
receipts or use an As Of date to limit them. By selecting None, uncleared transactions will not be displayed.
The Clear Disbursements button clears all items from the Display grid. More on Adjustments

Key Concepts

A Find feature to search for a check or receipt cleared on another bank rec. More on Bank Rec Toolbar

Options

You can hold down the shift key and select multiple rows and then click on Clear or Unclear to flag

multiple transactions.
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Ctrl-A will clear/unclear all items.

Field Descriptions 

Clear - When selected, the item is marked as Cleared in the current Bank Rec session.

Transaction Date - Date of the Adjustment entry.

Comment - Comment of the Adjustment entry.

Transaction ID - ID Number of the Adjustment entry.

Amount -  Amount of check. 

4.9.3 Chart of Accounts

Overview 

The Chart of Accounts is a list of all financial accounts. It includes a unique number for each account that
makes it easy to locate a specific account in each ledger. The Chart of Accounts represents the allowable G/
L accounts. An allowable G/L account can be comprised of two parts - a base account and possibly an
organization path. Base accounts can be attached to any org path or to no org path.

Base accounts also contain properties that interact with project management and accounting processes.  

Note: This is where the integration of accounting and project management is established.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Print All Accounts - Runs the Chart of Accounts List Report. More on the Chart of Accounts Report

4.9.3.1 Chart of Accounts Header

Overview
   
The Chart of Accounts Header is the top part of the applet screen that is visible when first going to the Chart
of Accounts applet.

Field Descriptions 

Code - Account Base Code. A unique number for each account.
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Re-Code - The Re-Code link allows the user to change the code for an existing General Ledger account.
It prevents the accidental changing of an account code. Clicking on this link will open the account Code
field, making it editable. To re-code, enter the account’s new identification code and click Save. The
account code will then be changed here and on all related entries and transactions throughout the
system.
Name - Account Base Name

Description - Description for the loaded Base Account

Active - When checked, base account is active.

Can Be Used without Org. Units - When checked, the base account does not require an organizational
unit to form a valid General Ledger account.

4.9.3.2 Properties Tab

Overview   

The Properties Tab manages the Properties of the G/L Accounts.  InFocus categorizes project management
amounts through the Chart of Accounts. It accomplishes this by using two major properties assigned at the
account level. These two properties are Metrics and Project Management Types (PM Types).  To understand
more about the Metrics and PM Types listed below, please refer to the Metrics and PM Types section of this
manual.

Field Descriptions 

Financial Type

Drop-down - Choices of financial types include Asset, Liability Capital, Income, and Expense.

Note - Income and Expense accounts will be zeroed-out to Retained Earnings when the EOY (end of year)

posting  is run.

Account Type

Sub-ledger Account - Choices include Bank, Accounts Receivable, Accounts Payable, and Employee
Reimbursable.

Other - When selected, the account is not a sub-ledger account
o Metric Type - Determines what metric type the account represents for project related transactions.

Choices are Cost, Billed Revenue, Work in Progress, Bad Debt, Late Fee, Retainer, Retainage,

Unbilled Revenue, and Other Revenue.

o Cost Type - Cost type is available only when the metric type is cost. Choices include Direct and

Indirect.

o PM Type -  Project Management Type is available when the metric type is one of the following: Cost,

Billed, Unbilled, or WIP. Those four metric types are then subdivided into Labor, ODC, OCC, and ICC.

o Revenue Type - Only available when the metric type is Billed Revenue. The Revenue Type splits

revenue between its cost component and the marked-up component. Revenue Type is needed to
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calculate Billed-to-Date at some value, other than the marked-up amount, and compare to a capped

figure in a Not-to-Exceed type invoice. Otherwise, select the first option "Direct". In the case of Non-

Labor Revenue, there are two choices: Direct and Markup. In the case of Labor Revenue, there are

four choices: Direct, DPE, DPE + Overhead, and Profit.

Register Type

Register Type (radio button) - The choices are Debit and Credit and the default setting is based on the

financial type selected. The Register Type represents the normal balance state of the account. The default is

changed only in a few cases, such as a contra account. This Register Type affects only the sign in Financial

Statements. InFocus stores debits as positive (+) values and credits as negative (-) values. Setting the

Register Type to credit informs Financial Statements to reverse the sign. 

Settings

Can Consolidate - When checked, the All Org Units for this base account will be merged if Consolidate is

chosen when printing a G/L Report.

Print Detail In G/L - When checked, this account will print transaction detail when printing a detailed G/L

report.

Is 1099 - Flag indicating whether charges to this account are considered for Form 1099-Misc. This is an

optional feature as Form 1099 can be run to consider all payments to a vendor despite this flag.

Is Subcontractor - Indicates that this is a subcontractor cost account. Available only when the metric type

is Cost and the PM type is Labor. It is used for labor distributions. Subcontractors different from other

consultants because they enter time sheets like an employee.

4.9.3.3 Account Associations Tab

Overview   

The Account Associations Tab manages the associations are made between base accounts and org paths.
The grid shows every available org path that has been established, plus one row (the top row) to allow for
base codes that have no association to an org unit.

EFT can also be configured here. More on EFT Setup

Field Descriptions 

Account Associations Grid

Use - When check, the account is associated with the org. path. Multiple rows can be set at once by



InFocus Modules and Applets 353

© 2020 Clearview Software, Inc.

using the various options at the right of the grid. By default, the first row automatically is checked when a

new base account is added.

Active - When checked, the Org. Path is Active.

Level - Denotes the level in the Org. Unit tree. More on Organizational Units 

Code - Code of the Org. Unit

Name - Name of the Org. Unit

Org. Path - Path of the Org. Unit. More on the Org Structure

Currency -  Enabled with Multi-Currency Setup. The designated currency defines transactional currency

where the account is used. Designated currency utilized by the selected employee pay history. This

designation determines the transactional currency of the employee's time sheets and (therefore) the

evaluation of available Rate Schedule rates for time entered. For complete instructions on setting up a

Multi-Currency environment, go here: More on Multi-Currency

GL Name Override - This is used to vary the account name between org paths. It is usually left empty;

however, in cases such as a bank account where the user wants to use the same base code for the main

bank in two different offices, but display the official name of the bank (e.g., Chase or Chemical), the G/L

name override is used.

Next Control Number - A Next Control Number column will appear in the grid in the case of a bank

account or A/R account. The next check number or next invoice number (when invoicing by A/R account)

will be established here.  This will show when the Incrementing Method is set to "A/R Account" in Global

Settings at Administration>Global Settings>Invoicing Tab.

EFT - When the  Financial Type of the account is Bank, you will get this column and the Bank Info button.

 More on setting up EFT in the Chart of Accounts

Selection Options (At top right)

Show Row Filter - enables the column row filters.

Check Level - Checks all org paths with the Level specified at the right.

Uncheck Level - Unchecks all org paths with the Level specified at the right.

Check All - Checks all org paths.
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Clear All - Unchecks all org paths.

Check Visible - Checks only those org paths that are visible.

Uncheck Visible - Unchecks only those org paths that are visible.

4.9.3.4 Balances Tab

Overview   

The Balances Tab is a quick reference for finding account balances.

Field Descriptions 

Recalculated - G/L Balances are calculated when certain reports are run in InFocus. They can be

manually recalculated here. Balances that are shown are through whatever the last Calculate date on this

tab shows

Show all Org. Units - When un-checked, the G/L Budgets are consolidated.

Fiscal Year - Drop-down where you select the fiscal year of the G/L Budgets.

Cash / Accrual (radio button) - Balances are available in both cash and accrual depending on this

selection.

Refresh icon - Refreshes the G/L Budgets.

G/L Balances Grid

Prev. Bal. Fwd. - Shows the prior Balance Forward amount from the Previous Fiscal Year.

Period (# columns) - Show the Balances for the specified period within the selected Fiscal Year.

New Bal. Fwd. - Shows the ending Balance Forward amount for the Current Fiscal Year.

4.9.3.5 FS Groups Tab

Overview

FS Groups gives the user the ability to group G/L Accounts when designing Financial Statements. FS Groups
are defined in List Management, assigned to G/L Accounts here and leveraged when designing Financial
Statements that use a Filter Range.

4.9.3.6 Convert to Cash (Cash Based Conversion)

Overview 

When running reports on a "Cash Basis" you must first run the Convert to Cash Utility. To get to the utility,
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go to General Accounting> Chart of Accounts> Tools (toolbar)> Convert to Cash.   The Convert to

Cash utility populates the Cash Based Journals (Receipt & Disbursements) at the point of running it.

Key Concepts

Description - By running the Convert to Cash utility,you are able to do the following:

o Accounting information can be reported based on accrual and cash figures. 

o Accrual figures are automatically kept in real time and require no calculation. 

o Cash figures updates are based only on the last time the conversion process from accrual to cash
was executed.

Note: Accrual figures are maintained separately and are not impacted by this process. Cash reporting is
available for the General Ledger, Trial Balance, Financial Statements, and three journals (Receipts,
Disbursements, and General Journal).

4.9.3.7 EFT Setup

Overview   

This section displays EFT information on the Accounts Association Tab when the  Financial Type of the
account is Bank. More on EFTs

Key Concepts

When the  Financial Type of the account is Bank, you will get this column and the Bank Info button.

The EFT Column is where you configure the EFT Bank Account.

The letters appear green when the account is configured and black when it is not.

When you click on the Bank Info button you get the pop-up containing the fields below.

Field Descriptions 

General Tab

Name - Company Long Name.

Short Name - Company Short Name

Bank Info Tab

Name - Bank name.

ABA/Routing - Bank routing number
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Account # - Bank account number

Company ID - typically the company EIN number

Next Control # - EFT Number

Balanced Batches - Check this to ensure batch debit and credit amounts are equal

EFT Tab

A/P Description - What vendors see when they receive the EFT on their bank statement. 

A/P File Prefix - Starting characters of the file name when saved.

Extension - Extension of the A/P file.

A/P Directory - Location of the file on the local machine when saved.

E/R Description - What Employees see when they receive the EFT on their bank statement. 

E/R File Prefix - Starting characters of the file name when saved.

Extension - Extension of the E/R file.

E/R Directory - Location of the file on the local machine when saved.

Override Procedure - EFT Override

  

4.9.4 Financial Statements

Overview 

The Financial Statements applet allows you to run reports that have been created using the Financial

Statement Designer. More on the Financial Statement Designer

Key Concepts

Three sample financial statements are included in InFocus:  

o Classified Income & Expense 

o Itemized Income & Expense 

o Classified Balance Sheet. 

These designs are based on the Chart of Accounts established by Quick Start. Even if Quick Start was
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not run, the samples may be installed as a reference. 

To install them, follow these steps:

o Step 1 - Launch the SQL Query applet. This is located in the Utilities module. More on the SQL Query
applet

o Step 2 - In the query box, type fssample_sav. 

o Step 3 - Click on the Run Query button. In a few seconds the message Query Execution Complete will
appear in the upper right corner of the SQL Query screen. Once that is done, the above Financial
Statements will appear in the drop-down.

4.9.5 GL Budgets

Overview   

The G/L Budgets applet allows the user to set budgets for both cash and accrual accounts within the Chart of
Accounts for a fiscal year (see below). Budgets can be maintained for any and all General Ledger accounts
per accounting period. Budgets for both accrual and cash balances can be entered. Budgets can appear and
be part of calculations in financial statements.

Note - Budgets are put in per accounting period. If you want to distribute an annual budget evenly across a
year’s periods right-click on the first period cell of a G/L account and choose allocate. It will ask you for the
annual amount to allocate.

Field Descriptions 

Description - All columns can be both pinned (column does not scroll) and filtered (only rows with

designated column value will show). The push pin in the column header controls pinning and the funnel in

the column header controls filtering. 

Show Budgets For - Choices are Accrual, Cash, or Both

Fiscal Year - Designates fiscal year for budgeting.

4.9.6 General Journal

Overview 

The General Journal holds both accounting adjustments and special transactions such as Labor

Distributions, Revenue Recognition and End of Year (EOY) closings. 
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Key Concepts

While transactions that affect Project Management Figures can be made, these transactions cannot be

part of Invoicing, Accounts Receivable, or Accounts Payable reporting. Project-related transactions can,

however, appear on Project Management reports.

The General Journal is the only journal where there is no header control account or amount. Instead, the

sum of all line items must zero out. Unlike other journals, no assumption is made about debits and

credits. Debits are positive values, while credits are negative values.

Entry rules, as far as type of account and organizational unit, are relaxed in this journal.

4.9.6.1 General Journal Toolbar

Overview   

The General Journal toolbar gives the user (with appropriate permissions) a number of capabilities within the
journals of InFocus. A list of those capabilities follows.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

View

o Labor Posting Report - The option is enabled only when a Labor Distribution entry has been recalled

to the screen. The report displays detailed breakdown of what makes up the journal entry. When

selected the Labor Distribution Report is run. More on the Labor Distribution Report

4.9.6.2 General Journal Header

Overview
The General Journal header section contains all common data for an Adjustment transaction. 
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Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Field Descriptions 

Transaction ID - The unique identification number of this transaction.  This displays in the header next to
"General Journal".

Transaction Date -  The Transaction Date is relevant only for Project Management reports, Otherwise, it is
informational.

Cash Accrual Type - The three choices are Cash, Accrual, or Both.

G/L Comments - Comments to appear in G/L report. The comments will show on the control side and, if
no G/L comment is entered on the line item, will also print on those as well.

Closing Entry - When checked, this entry is considered a Closing Entry. Closing Entries can be excluded
on financial statements, if desired (usually done on P & L). More on End of Year Closing

Ignore In Rev. Rec. - Ignore in Revenue Recognition. When this entry is flagged, revenue    recognition
does not include this transaction in calculations. More on Revenue Recognition

Rev. Rec. Entry - When checked, this entry was posted by Revenue Recognition. Revenue Recognition
can delete any entries for the current period when run. This flag identifies the entry as a candidate for
deletion. This is a read-only field. More on Revenue Recognition

Labor Dist. Entry -  When checked, this entry was posted by Labor Distribution. Deleting or voiding this
transaction will cause all time sheets that were associated with it to an un-posted state. This is a read-
only flag. Click on the icon next to the check box to see a breakdown to the employee level of the
automated posting. More on Labor Distribution

G/L Period - General ledger period for this transaction or revision to effect. Defaults to current period and
only open periods are allowed.

  

4.9.6.3 General Journal Detail

Overview

The General Journal Detail section displays the detail of how the journal is distributed. 

Field Descriptions 

Default Columns
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1 of ? - This shows the version of the journal entry that you are currently viewing.  This is enabled by

checking "Journals" at Global Settings>General Tab>Full Audits.

Current GL Period - The GL Period that the current version of the transaction falls in. A "Change Period

for Current Revision" option is located under Tools in the toolbar, allows you to change the current period.

Show Audit Trail - When checked, all entries (including reversing entries) will display. It will also include a

line for the header section of the transaction. Auto-reversals and header lines will be grayed out and

cannot be altered.  This also displays the Create By, Create Date, Modify By and Modify Date of the

transaction.

GJLineID - Unique Line id of the General Journal entry.

Rev. No. - The number of the revision of the Journal entry. The original entry is 1. 

Project Path - WBS path (Optional).

Expense Code - Expense code (Optional). More on Expense Codes

G/L Account - General Ledger account. More on G/L Accounts

Amount - Line item amount.

G/L Comments - General ledger comments. Will print on G/L reports in place of comments on header of
transactions for this line item.

PM Comments - Project Management comments appear on Project Management reports and invoices.
Available only when the payee type is Client and the G/L account is Accounts Receivable.

Optional Columns

Project Name

Expense Code Name

G/L Period

Debits & Credits - When selected, the Amount column disappears and is replace with a Credit column

and a Debit column.

Create By

Create Date

Modify By

Modify Date

4.9.7 MC Revaluations

Overview   

A new journal has been added to host multi-currency revaluations. Transactions in this journal are marked as
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realized or unrealized gains and losses. Any revaluation transaction has only two G/L accounts: the sub-

ledger account that is being revalued; and the offsetting gains and losses account. Transactional lines

include the gain or loss, and can optionally identify the project. A positive value represents a gain while a

negative value a loss. For complete instructions go here: More on Multi-Currency

Key Concepts

This journal does not utilize a debits verses credits approach as a recorded positive value will act as a

debit against the sub-ledger (Balance Sheet) account while simultaneously acting as a credit to the gains

and losses (P&L) account. While this journal is used by automated system utilities with pre-posting

reports to generate realized and unrealized gains and losses, manual entry in this journal is also

supported.

Field Descriptions 

Manual - Marked if entering the transaction manually

Balance Sheet Account - Sub-ledger account being revalued

Profit / Loss Account - Offsetting Gains and Losses account

GL Period - G/L posting period for the revaluation

Evaluation Date - Date used in evaluating the exchange rate

Realized - Indicates a realized or unrealized (unchecked) gain and loss.

GL Comments (header) - General notes for the revaluation.

MC Revaluations Grid

Base Amount - Amount in Base System Currency

Company Amount - Amount in Company Currency

Project - Specifies the project (optional)

GL Comments (detail) - General notes for the line item

 

4.9.8 Multi-Currency

Overview   

The General Journal toolbar gives the user (with appropriate permissions) a number of capabilities within the
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journals of InFocus. A list of those capabilities follows. For complete instructions go here: More on Multi-

Currency

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar

Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

New Currency - When selected, the Currency pop-up comes up so that you can enter a currency. More

on the Currency Utility

Edit Currency - When selected, the Currency pop-up comes up with the selected currency so that you

can edit the currency. More on the Currency Utility

Save - Saves the current changes.

Delete Currency - Deletes the selected Currency.

Refresh - Refreshes the applet.

Rate Tester - Brings up the Rate Tester. More on the Rate Tester

4.9.8.1 Multi-Currency Detail

Overview   

Multi-Currency detail gives the Field description of the Multi-Currency Applet.

Field Descriptions

Currencies Tab

Description - The grid below holds the following general information for each currency defined. Double click

the line to launch the Currency utility as described below.

Active - Indicates that the currency is active
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Base - Indicates the system base currency

Currency Symbol - Assigns the associated currency symbol

Currency Code - Currency code used to drive the currency exchange rate

Currency Name - Indicates the associated currency name

Currency Pairs Tab

Description - This tab defines the exchange relationship between currencies and contains the Currency

Rates set up tool. Exchange rates can be altered on a daily basis. Both triangulation and inverse (reciprocal)

exchanges are supported.

From - The originating currency in the exchange.

To - The destination currency in the exchange.

Triangulating Currency - The interim currency in the exchange if required. A triangulation is used when no

direct exchange rate exists between currencies. For instance, if an exchange from Yens to Euros did not

exist but Yen to USD and USD to Euro exchanges did exist, the currency pair for Yens to Euros could be

defined, triangulated via USD. Please note to utilize a triangulating currency, there must be accompanying

currency pairs to define the exchange relationship between the From and Triangulating currency and the

Triangulating and To currencies.

Use Reciprocal - Indicates the defined exchanges relationship can be utilized inversely.

Rates - Launches the Currency Rates Utility set up tool (defined below).

Currency Utility (Toolbar)

Description - This utility is used to define or edit detailed system settings for new or existing currencies

respectively.

Base Currency - Checked if designated as the Base System Currency in Administration>Global

Settings>Currencies tab.

Active - Indicates system status of the selected currency

Culture - Configures the base culture the business is operating in and drives system report formats.

Symbol - Represents the system wide currency symbol.

Code - International three character monetary code. This important setting drives the import of system

exchange rates.

Name - Required Field containing the selected culture's currency name.

Precision - Defines columns to the right of the decimal place and drives system rounding. Example:

Precision 2 rounds to the nearest hundredth (5.248 = 5.25).

Unit - Represents the smallest unit in the selected currency. Example: For USD, 1 represents the Penny

(the system will round to the nearest penny).
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Major Denomination - Defines the singular and plural cases for check printing. For example, USD major

labels are "dollar" and "dollars".

Minor Denomination - Defines the singular and plural cases for check printing. For example, USD minor

labels are "cent" and "cents".

Rate Tester Utility (Toolbar)

Description - This utility is used to test currency conversion rates.

From Currency - Source currency to convert from.

To Currency - Destination currency to convert to.

Amount - Amount to convert.

As of - As of date to convert from.

Currency Rates Utility

This utility defines the rate to use for the selected currency pair- notice the selected pair is displayed at the

top of the utility. Current and Historical rates can be set manually or imported directly from

openexchangerates.org and can then be tested for a given Amount/As of Date. An exchange rate must be

defined for each exchange relationship in the Currency Pairs grid.

Amount - Originating currency amount to test. Test functionality only.

As of Date - Date by which to test the rate exchange. Test functionality only.

Start Date - Effective date of defined exchange rate

Rate - Exchange rate to be applied to the exchange relationship

Current Rate - When selected, imported rates will be based on currently designated rates

Historic Rate - When selected, imported rates will be based on the selected Historic Rate Date.

4.9.9 Organizational Units

Overview   

InFocus uses a Parent/Child system to represent the levels of hierarchy within an organization. They are

referred to as Organizational Units (aka Profit Centers).  Org Units are classified by Org Labels and can

represent entities such as: Office, Department, Division, etc. To learn more about Organizational Units follow

this link: More on Understanding Organizational Units

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar



InFocus Modules and Applets 365

© 2020 Clearview Software, Inc.

Options

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

Org Labels - When selected, the Org Labels pop-up is displayed. More on Org Labels

4.9.9.1 Organizational Units Detail

Overview   

The Org Units applet is where you manage Organizational Units. This sections gives the detail of the

Organization Units applet.

Field Descriptions 

Window - The Organizational Units window displays the Org. Tree.  Click on any level of the Org Tree to

populate the fields on the right.

Org. Unit

Active - When selected, the Org. Unit is active for use.

Code - Org. Unit Code.

Name - Org Unit Name.

Org Path - Org Unit Path. This is the concatenation of the parent and child.

Currency - Currency used by the Org. Unit.  Company currency can be defined on a Level One

Organizational Unit ONLY. This configuration is only necessary when operating in a Multi-Company

environment where an individual company currency differs from the Base System Currency. For complete

instructions on setting up a Multi-Currency environment, go here: More on Multi-Currency

4.9.9.2 Org Labels

Overview   

Organizational units represent the corporate structure.  Here you manage the Labels that classify that

structure. They can contain an infinite number of levels, such as Division, Office, Discipline, or Department.
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Field Descriptions 

Below are field descriptions for the Or. Labels pop-up. 

Level - Org Level. One is the first level.

Singular Name - Singular form of level name.

Plural Name - Plural form of level name.

4.9.10 Procurement End of Month

Overview

Procurement End of Month is a supporting applet to the Purchasing module. Depending on the accounting
controls your firm has in place, you may be required to reverse pre-bills at month-end. Typically this will be for
firms who wish to exclude non-invoiced expenses from their Financial Statements. This can be done using the
Procurement End of Month applet where you'll manage the reversal of PO Liability and Expense.

Based on a set of filters, described below, Procurement End of Month posts a General Journal entry that
debits Expense and credits PO Liability Accounts used in pre-billed Purchase Journals (e.g. Purchase
Journals marked Is Purchase Order) that fall within the specified filters.

Field Descriptions

As of Date - As of Date used for determining which pre-billings to include. This is compared against the
Purchase Journal Invoice Date.
GL Period - Accounting Period used for determining which pre-billings to include. This is compared
against the GL Period attributed in the detail of the Purchase Journal.
Reverse Period - Account Period to which the reversing entry is posted

Vendors - Used to filter the posting criteria
o All Vendors - Include Purchase Journals, marked Is Purchase Order, for all vendors
o Subconsultant Vendors - Include Purchase Journals, marked Is Purchase Order, for all vendors linked

to an Employee marked Subconsultant.
o Selected Vendors - Includes only selected vendor(s)

Add (button) - Adds the loaded vendor to the filter list below
Post (button) - Posts the filtered reversal to the General Journal. View the transaction by browsing to
GA>General Journal and hitting F3 from the transaction lookup (upper-right).

4.10 Marketing

4.10.1 Activities

Overview 
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Activities are an appointment system. While listed under Marketing, they can be used by anyone in the
system (with permissions). Activities can be entered directly into the calendar or when recording notes.

The main navigation for activities is a Calendar. The type of calendar (Today, Day, Work Week, Week, or
Monthly) can be toggled from the toolbar

Field Descriptions 

Toolbar Options

Aside from the standard toolbar options this applet has the following options:

File - Additional button(s) on the File drop-down
o New Activity - When clicked, the Activity pop-up displays, allowing you to create a new Activity.

View - Additional button(s) on the View drop-down
o Day - Switches the Activity screen to Day mode.
o Work Week - Switches the Activity screen to Work Week mode.
o Week - Switches the Activity screen to Week mode.
o Month - Switches the Activity screen to Month mode.

New Activity - When clicked, the Activity pop-up displays, allowing you to create a new Activity.

Refresh - Refreshes the Calendar to update screen.

Day - Switches the Activity screen to Day mode.

Work Week - Switches the Activity screen to Work Week mode.

Week - Switches the Activity screen to Week mode.

Month - Switches the Activity screen to Month mode.

Activities (Left Sidebar)

Small Calendars - Display the current month an the next month. You can click on a date to quickly
navigate to that time frame.
Show All Activities check-box - When checked, the calendar will show all activities, including those
marked complete.
Group By Owner - When checked, A different calendar for each selected owner will appear.

Activity Owners - When checked, you will see the activities of the selected users.

Calendar

Activity Calendar - Double click on the desired time frame to bring up the Activity Editor. More on the
Activity Editor

Activities (Right Sidebar)

Upcoming Activities - This window displays all upcoming Activities. If you check the box next to the
activity, the Activity will be marked complete.
Recently Expired - This window displays all Activities that have passed their Activity Date. If you check
the box next to the activity, the Activity will be marked complete.
Recently Completed - This window displays all Activities that recently been marked as complete. If you
un-check the box next to the activity, the Activity will be reactivated.
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4.10.1.1 Activity Editor

Overview 

The Activity Editor allows you to enter/edit Activities. 

Field Descriptions 

Subject - Activity subject line

Date - Date of the scheduled activity

Time - Time of the scheduled activity

Duration - Duration of the scheduled activity

Type -  Type of Activity. A User Defined Field. The Activity Type list is managed under Administration>List

Management>Activity Types

Show Until Marked Complete - When checked, the activity will appear in the Upcoming Events list until it

is marked complete. Otherwise, it will no longer show in the list once the date has expired.

Contact - Contact associated with activity

o Work Phone - Work Phone of selected Contact

o Cell Phone - Cell Phone of selected Contact

o Home Phone - Home Phone of selected Contact

o Fax - Fax of selected Contact

o Work Email - Work Email of selected Contact

o Home Email - Home Email of selected Contact

Employee - Employee to assign the activity to. Only enabled with Can Assign Other Employees special

right assigned via AD>Permissions. 

Firm - Firm associated with the scheduled activity

Project - Project associated with the scheduled activity.

Completed - Marks the Activity as Complete.  If "Show Until Marked Complete" flag is checked, the

Activity will no longer show on the calendar.

4.10.2 Contact Queries

Overview 

There are seven query applets in InFocus: Client, Contacts, Firms, Opportunities, Vendors, Projects, and
Employees. The concept of the query tools is to allow the user to define lists of data based on a user query
definition. The list can then be used to navigate to the individual records within the list or can be exported to
Excel. More on the Query Applets
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4.10.3 Contacts

Overview 

Contracts are located in the following Modules: Project Administration, Human Resources, Accounts
Payable, Accounts Receivable, Marketing.

Contacts, in general, are people. They can be either employees of the user’s company or employees of a firm
with which the user does business. Contacts can also be associated with projects, but only contacts for that
project’s client. Contacts cannot exist for a project that does not already exist for that project’s client.

The Marketing navigation screens are laid out like a Rolodex with alphabetic tabs representing the first letter
in the name of the marketing item. An All tab contains all of the marketing items.

Key Concepts

Double-click on a contact inside the grid to bring up the "Contact Detail" pop-up. Data can be viewed or
changed, depending on the user’s permissions.
Within the "Contact Detail" pop-up, there are multiple tabs that show specific data about the contact,
such as name or main phone. 
Only contacts and employees can be added from this form.

Field Descriptions 

Active Status

Active Status - Filters your Contacts by their status (Active, Inactive or Both).

Show

Contacts (check-box)  - When checked, the display grid will include all Contacts.

Employees (check-box) - When checked, the display grid will include all Employees.

Marketing Lists

Marketing Lists - A marketing list is a list of Contacts, Firms, or Opportunities that are created in 
Marketing>Marketing Lists. A Marketing List is used to filter the grid on the right. When a Marketing list is
selected, the grid will display only the Contacts that were imported into the Marketing list.  More on
Marketing Lists

Views

Views - Views allow you to filter your grid even further. Views allow you to save the current Filter settings
(Funnel icons at the top of each column) of the marketing screen. What that means is that you can use
the different column filters to display your data just right in the grid, and save it as a View. 

Note - Views are available only available in Contacts, Firms, and Opportunities.  
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Quick Filter

Quick Filter - A real time filter that reduces the list of Contacts as you type into the cell.

Clear - Clears out the contents of the Quick Filter

Buttons (top-right of grid)

Columns (paper icon) - Displays a "Column Selector" pop-up that allows the user to select only those
columns they wish to view.  In the pop-up, there is a check box labeled "Set As Global Default" (granted
by a Permission) that allows that user to set a default view for all users that use this Marketing List.
Email (envelope icon) - Displays an email pop-up that allow you to create an email to send to everyone
within the Marketing List. More on Marketing Emails
Export (arrow icon) - Allows the user to export the list to a file.

Refresh - Refreshes the data in the grid.

Contacts Grid

The grid displays all of the recorded information for each contact as a single row.

Double-Click on a row to bring up the Contact Detail.

The Column Selector allows users to select only those columns that they wish to view.

The header of each column gives the name of the data field.

A Funnel icon at the top of each column represents a filter.  By clicking on the filter, the user is able to
filter down the grid to only the information that they would like to view.  

4.10.3.1 Contacts Toolbar

Overview   

The Contacts toolbar gives the user (if given appropriate permissions) various capabilities within the Contacts
applet. Below is a list of those capabilities.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options
Tools - Lists advanced options

o Clear Cache Files - The Contacts cache is a used to store files temporarily to shorten data access time, reduce

latency and improve input/output.  The Clear Cache button clears empties out the cache.

o Send Email - When clicked, InFocus looks at the Personal Tab of the Contact to see if they have a Work Email or

Home Email.  If they do, then InFocus will prompt you to open up the default email service on the users

workstation.

o Merge Records - When clicked a Merge Email pop-up will open and allow for you to select 2 Contacts to merge.  

More on Merging Contacts
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Send Email -  Sends an email from the default email service on the workstation

Merge Records - Will bring up the Merge Contacts utility. More on the Merge Contacts Utility

UDF Designer - Brings up the UDF Designer. More on User Defined Fields.

4.10.3.2 General Tab

Overview 

The General Tab contains many of the fundamental fields involved in contact setup.

Field Descriptions
Below are field descriptions for the General Tab. 

** Indicates a required field

Name 

Active - Check this box to make this an active contact. 

Prefix - A title that can be added before the employees name. A User Defined Field. The Prefix list is
managed under Administration>List Management>Name Prefixes.

** First - Employee first name

Middle - Employee middle name

** Last - Employee last name

Suffix - A title that can be added to the end of the employees name. A User Defined Field. The Suffix list is
managed under Administration>List Management>Name Suffixes.

DOB - Date of Birth 

Title - Position held 

Preferred Name - The contact’s preferred name, possibly a nickname or middle name.

Proper Name - All of the above linked together (for example, Mr. John Doe, Sr.). Can be used as an
alternate on mailings.

Attention - Attention line for mailings.

Spouse - Name of Spouse.

Firm / Employee Association 

** Firm/Employee - Firm or Employee associated with this contact. 

** Relationship Type - A title that can be added before the employees name. A User Defined Field. The
Relationship Type list is managed under Administration>List Management>Firm Contact Types.
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Office Address 

Office Address - Named address. Not available for employee contacts.

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

Phone - Telephone number

City - City

State - State

Zip/Postal - Zip Code

Country - Country

Fax - Fax number

4.10.3.3 Personal Tab

Overview  

The Personal Tab contains personal information specific to the selected Contact.

Field Descriptions
Below are field descriptions for the Personal Tab. 

Email & Phone 

Work Phone - Work phone

Work Ext. - Work phone extension

Home Phone - Home telephone number

Mobile Phone - Mobile phone number

Fax - Fax number

Work Email - Work email address associated with the Firm.  The Marketing Email functionality uses this
email if configured correctly. More on Marketing Emails
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Home Email - Home email address associated with the Firm.  The Marketing Email functionality uses this
email if configured correctly. More on Marketing Emails

Home Address 

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

Phone - Telephone number

City - City

State - State

Zip/Postal - Zip code

Country - Country

Phone - Telephone number

Fax - Fax number

4.10.3.4 Marketing Tab

Overview  

The Marketing Tab contains marketing information specific to the selected Contact.

Field Descriptions
Below are field descriptions for the Marketing Tab. 

Email Subscriptions 

Gift - Receives a holiday gift

Email - Receives email marketing pieces

Mailing - Receives mailed marketing materialWork Phone - Work phone

Newsletter - Receives a newsletter

Holiday Card - Receives a holiday card

Lead Source 
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Lead Source - Name of the source who generated the lead. Lead sources are useful for marketing
purposes and, therefore, generally used with firm contacts. Lead sources refer to where this contact was
for (for example, a magazine, trade show, etc.). A User Defined Field. The Lead Source list is managed
under Administration>List Management>Lead Sources.

Interests 

Social Activity - The contact’s favorite social activity. A User Defined Field. The Social Activity list is
managed under Administration>List Management>Social Types
Sports Activity - The contact’s favorite sports activity. A User Defined Field. The Sport Activity list is
managed under Administration>List Management>Sport Types.
Gift - The type of gift the contact should receive. A User Defined Field. The Gift Type list is managed
under Administration>List Management>Gift Types.
Event - The type of event the contact should be invited to. A User Defined Field. The Event Type list is
managed under Administration>List Management>Event Types.

4.10.3.5 Project Associations Tab

Overview 

The Project Associations Tab associates a contact with a particular project. 

Field Descriptions
Below are field descriptions for the General Tab. 

** Indicates a required field when adding to the list

Name 

** Project Path - Unique Path of the Project associated with the Contact.

Name - Name of the Project associated with the Contact.

** Relationship - The contact’s relationship with the Project. A User Defined Field. The Relationship list is
managed under Administration>List Management>Project Contact Types

4.10.3.6 Employee Associations Tab

Overview 

The Employee Associations Tab associates a contact with a particular Employee. 

Field Descriptions
Below are field descriptions for the General Tab. 

** Indicates a required field when adding to the list

Name 
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** Employee - Name of the Employee associated with the Contact.

** Relationship - The contact’s relationship with the Employee. A User Defined Field. The Relationship list
is managed under Administration>List Management>Contact Employee Types

4.10.3.7 Notes Tab

Overview  

Notes can be entered against a Contacts, Firms, and Projects (including Opportunities). More on Notes

Field Descriptions
Below are field descriptions for the Notes Tab. 

** Indicates a required field

Note Details 

Comment - Body of the Note

Note Type - Type of Note Posting (ex. Phone Call, Meeting, E-Mail, Appointment, Lunch, and Dinner are
the choices). A User Defined Field. The Note Type list is managed under Administration>List
Management>Contact Note Types

Firm - Firm associated with the note.

Project - Project associated with the note.

Add a follow-up Activity?

Add - Create a a follow-up activity that appears on the Activity Calendar. More on Activities

Require Complete - When checked, the follow-up activity shows up on the Activity calendar until it is
marked complete.

Type -  Type of Activity. A User Defined Field. The Activity Type list is managed under
Administration>List Management>Activity Types

Date - Date of follow-up Activity.

Time - Time of follow-up Activity.

Duration - Duration of follow-up Activity.

Existing Notes

Notes associated with the Contacts, Firms, or Projects that have been created.  Double-click on them to
bring into focus.

4.10.3.8 System Info Tab

Overview  
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The System Info gives you useful read-only information about the selected Contact.

Field Descriptions
Below are field descriptions for the System Info Tab. 

Record Details 

Contact ID: Internal ID number of the selected Contact.

Created By - The creator of the selected Contact.

Create Date - The date that the selected Contact was created.

Modified By - The last person to modify data on the selected Contact.

Modify Date - The last date that the selected Contact was modified.

4.10.3.9 Custom Fields (UDF) Tab

Overview 

User-definable fields (UDFs) can be created for Clients, Employees, Vendors, Projects, Project Level2 and
Contacts. More on User Defined Fields.

4.10.3.10Merge Contacts

Overview 

The Merge Contacts utility is used to merge two contacts into one contact.    

Key Concepts

Two contacts are selected, a Master Contact and a Merge Contact.  Next, the different data items are
selected and the contact is then merged into one contact.

Note: Even though employees display in this applet, they cannot be merged.

Column Descriptions
Below are descriptions for the Items located on the Merge Contacts pop-up. 

Master Contact - The Primary contact that will become the only contact after the merge.

Merge Contact -  The Secondary contact that will be merged into the Master Contact.

<-> button - Switches the selected Master and Merge Contacts.

Grid Groups - The grid columns are grouped into the following classifications (Personal, Email, Firm



InFocus Modules and Applets 377

© 2020 Clearview Software, Inc.

Association, Office Address, Home Address, Lead Source, Marketing)

Field Column - Name of the Field

Checkbox (left) - Selected Master Contact fields. If checked, the data will be retained from the Master
Contact and the Merge Contact data will be deleted.

Checkbox (right) - Selected Merge Contact fields. If checked, the data will be retained from the Merge
Contact and the Master Contact data will be deleted.

"Select fields with data. If both have data, use Master record" link - Selects all fields that have data. In the
case of both Contacts having data, the Master Contacts data will be used.

Preview - Shows you which fields are going to be merged.

Merge - By pressing merge, the 2 records become one and any data not selected is deleted.

Cancel - Cancels the Merge

4.10.3.11Marketing Emails

Overview 

Marketing Emails a user to create an email within the Marketing applets and send them to everyone in the

Marketing List. More on Marketing Lists

Keys to Setup

A valid email addresses must be associated with any Employee, Contact, Firm or Opportunity that is

intended to receive the email.  The Valid email must be entered in the Main Email, Work Email or Home

Email associated field located in the "Detail" pop-up of the Marketing applet.

The SMTP needs to be setup correctly for this option to function.  More on setting up SMTP and emailing

within InFocus

SMTP should be configured by an internal IT person.  This is not handled by Clearview. 

Field Descriptions 

SMTP Relay Account - SMTP Accounts that are configured in Global Settings>SMTP Relay Servers.

Email Address Field - This is the email address that you would like to send the email to.  Typical

selections may be:

o Contact Home Email (Contacts)

o Contact Work Email (Contacts)

o Main Email (Firms & Opportunities)

https://support.clearviewsoftware.net/articles/4081
https://support.clearviewsoftware.net/articles/4081


InFocus User Manual - Current (v2020)378

© 2020 Clearview Software, Inc.

Message Tab

Subject - This will be the Subject of the email that is sent.

Body - This will be the Body of the email that is sent.

[...] button - This allows for a file to be attached to the email.

Preview button - Displays a preview of what the email will look like (Preview Tab)

Send button - Sends the email.

Cancel - Cancels the email 

Preview Tab

Displays a preview of what the email will look like

4.10.4 Firm Queries

Overview 

There are seven query applets in InFocus: Client, Contacts, Firms, Opportunities, Vendors, Projects, and
Employees. The concept of the query tools is to allow the user to define lists of data based on a user query
definition. The list can then be used to navigate to the individual records within the list or can be exported to
Excel. More on the Query Applets

4.10.5 Firms

Overview 

Firms are organizations the user has done or would like to have business with. They can be vendors, clients,

or prospects. Any entry in Firms is also accessible from the Client and Vendor applets. The Marketing

navigation screens are laid out like a Rolodex with alphabetic tabs representing the first letter in the name of

the marketing item. An All tab contains all of the marketing items.  

Key Concepts

Double-click on a firm inside the grid to bring up the "Firm Detail" pop-up. Data can be viewed or

changed, depending on the user’s permissions.
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Within the "Firm Detail" there are multiple tabs that show specific data about the firm, such as firm name

or main phone. 

Only clients and prospects can be added from this form. By default, the system assumes prospect.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Field Descriptions 

Active Status

Active Status - Filters your Firms by their status (Active, Inactive or Both).

Marketing Lists

Marketing Lists - A marketing list is a list of Contacts, Firms, or Opportunities that are created in 

Marketing>Marketing Lists. A Marketing List is used to filter the grid on the right. When a Marketing list is

selected, the grid will display only the Firms that were imported into the Marketing list.  More on

Marketing Lists

Views

Views - Views allow you to filter your grid even further. Views allow you to save the current Filter settings

(Funnel icons at the top of each column) of the marketing screen. What that means is that you can use

the different column filters to display your data just right in the grid, and save it as a View. 

Note - Views are available only available in Contacts, Firms, and Opportunities.  

Quick Filter

Quick Filter - A real time filter that reduces the list of Firms as you type into the cell.

Clear - Clears out the contents of the Quick Filter

Buttons (top-right of grid)

Columns (paper icon) - Displays a "Column Selector" pop-up that allows the user to select only those

columns they wish to view.  In the pop-up, there is a check box labeled "Set As Global Default" (granted

by a Permission) that allows that user to set a default view for all users that use this Marketing List.

Email (envelope icon) - Displays an email pop-up that allow you to create an email to send to everyone
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within the Marketing List. More on Marketing Emails

Export (arrow icon) - Allows the user to export the list to a file.

Refresh - Refreshes the data in the grid.

Firms Grid

The grid displays all of the recorded information for each firm as a single row.

The Column Selector allows users to select only those columns that they wish to view.

The header of each column gives the name of the data field.

A Funnel icon at the top of each column represents a filter.  By clicking on the filter, the user is able to

filter down the grid to only the information that they would like to view.  

4.10.5.1 General Tab

Overview 

The General Tab contains many of the fundamental fields involved in firm setup.

Field Descriptions
Below are field descriptions for the General Tab. 

** Indicates a required field

Name 

Active - Check this box to make this an active firm. 

Prospect - When checked, designates this is a prospect, rather than a billable client.

** Code - Unique Code of the Firm.

** Name - Name of the Firm.

Website - Website of the Firm.

Main Email - Main Email to be associated with the Firm.  The Marketing Email functionality uses this email
if configured correctly. More on Marketing Emails

Firm Type / Specialty 

** Type - Type of Firm. A User Defined Field. The Firm Type list is managed under Administration>List
Management>Client Types.

** Specialty - Specialty of Firm. A User Defined Field. The Specialty list is managed under 
Administration>List Management>Client Specialties.

General Note 

The General Note is used for internal notes that are specific to the Firm.
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Internal Contacts 

Internal Contacts are internal contacts that are associated with the Firm.

Main Contact - Contact that is classified as the Main Internal Contact.

Comments - Internal notes that are specific to Main Contact.

Sales Contact - Contact that is classified as the Sales Contact.

Comments - Internal notes that are specific to Sales Contact.

Marketing Contact - Contact that is classified as the Marketing Contact.

Comments - Internal notes that are specific to Marketing Contact.

Other Contact - Contact that is classified as an Other Contact.

Comments - Internal notes that are specific an Other Contact.

4.10.5.2 Addresses Tab

Overview
The Addresses Tab contains the addresses of the selected firm. Clicking on a field in a Firm row will expose
the Addresses Tab. 

Field Descriptions
Below are field descriptions for the Addresses Tab. 

Main Address 

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

Phone - Telephone number

Fax - Fax number

City - City

State - State

Zip/Postal - Zip Code

Country - Country

Geocode - When clicked, the Latitude and Longitude are filled in with the location of the Main Address. 

This can be used in the Map Viewer applet. More on the Map Viewer.

Latitude - Latitude of Address
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Longitude - Longitude of Address

Additional Addresses

Additional addresses that you would like to associate with the Firm can be entered here. The data

entered is the same as above.

Pencil icon - Opens up a pop-up box that asks for the same information above.

4.10.5.3 Contacts Tab

Overview 

The Contacts Tab associates a Firm with a particular Contact. 

Field Descriptions
Below are field descriptions for the Contacts Tab. 

** Indicates a required field when adding to the list

Create Contact - Brings up the Contact Detail page that allows you to create a New Contact.

** Contact - Name of the Contact associated with the Firm.

** Relationship - The contact’s relationship with the Firm. A User Defined Field. The Relationship list is

managed under Administration>List Management>Firm Contact Types

4.10.5.4 Projects Tab

Overview 

The Projects Tab displays associations of a Firm with a particular project. 

Field Descriptions
Below are field descriptions for the Projects Tab. 

Name 

Project Path - Unique Path of the Project associated with the Firm.

Name - Name of the Project associated with the Firm.

Project Type - Charge Type of the Project. The charge type is configured in Project
Administration>Projects>General Tab.
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Stage - Marketing Stage that the Opportunity is currently at. A User Defined Field. The Stage list is
managed under Administration>List Management>Lead Stages.

4.10.5.5 Marketing Lists Tab

Overview  

The Marketing Lists Tab shows you a list of Marketing Lists that are  that have a "List Type" of Opportunity.
You must also have the appropriate "Access Level" access.  More on Marketing Lists

Field Descriptions
Below are field descriptions for the Marketing Lists Tab. 

Quick Filter - A real time filter that reduces the list of Opportunities as you type into the cell.

Clear - Clears out the contents of the Quick Filter.

Check All - Selects all of the available Marketing Lists in the Grid.

Check-box - Checked if a member of the Marketing List.

Name - Name of the Marketing List.

Date Added - Date that the Opportunity Project was added to the Marketing List.

4.10.5.6 Notes Tab

Overview  

Notes can be entered against a Contacts, Firms, and Projects (including Opportunities). More on Notes

Field Descriptions
Below are field descriptions for the Notes Tab. 

** Indicates a required field

Note Details 

Comment - Body of the Note

Note Type - Type of Note Posting (ex. Phone Call, Meeting, E-Mail, Appointment, Lunch, and Dinner are
the choices). A User Defined Field. The Note Type list is managed under Administration>List
Management>Contact Note Types

Contact - Contact associated with the note.

Project - Project associated with the note.

Add a follow-up Activity?
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Add - Create a a follow-up activity that appears on the Activity Calendar. More on Activities

Require Complete - When checked, the follow-up activity shows up on the Activity calendar until it is
marked complete.

Type -  Type of Activity. A User Defined Field. The Activity Type list is managed under
Administration>List Management>Activity Types

Date - Date of follow-up Activity.

Time - Time of follow-up Activity.

Duration - Duration of follow-up Activity.

Existing Notes

Notes associated with the Contacts, Firms, or Projects that have been created.  Double-click on them to
bring into focus.

4.10.5.7 Documents Tab

Overview 

Documents tab allows you to upload, view, modify and delete archived documents in relation to the loaded
record. Uploaded documents and related information will be listed in the grid. More on Document
Management

4.10.5.8 System Info Tab

Overview  

The System Info gives you useful read-only information about the selected Firm.

Field Descriptions
Below are field descriptions for the System Info Tab. 

Record Details 

Firm ID: Internal ID number of the selected Firm.

Created By - The creator of the selected Firm.

Create Date - The date that the selected Firm was created.

Modified By - The last person to modify data on the selected Firm.

Modify Date - The last date that the selected Firm was modified.

4.10.5.9 Custom Fields (UDF) Tab

Overview 

User-definable fields (UDFs) can be created for Clients, Employees, Vendors, Projects, Project Level2 and
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Contacts. More on User Defined Fields.

4.10.6 Map Viewer

Overview

The Map Viewer is where you are able to view queried data using Bing Maps.

Key Concepts

The Map Viewer incorporates Bing Maps to display queried data.  

To gain full access to this applet, you need to set up a Bing Maps account.  The account information is
managed in Global Settings>Mapping Tab 

There are some standard queries that come with InFocus to demonstrate the Map Viewers capabilities. 
More on Map Queries

Field Descriptions 

Map Viewer Window

Queries Drop-down - Displays the current query in use. If you look in the drop-down, you will see a list of

all available Map Queries. More on Map Queries

Check/Uncheck All - Checks or Unchecks all of the items in the Results Grid.

Quick Filter - Filters the items in the Results Grid.

Results Window

Description - Displays the results of the query selected in the Queries Drop-down.

4.10.7 Marketing Lists

Overview

A marketing list is a named list of either Contacts, Firms, or Opportunities.  

Field Descriptions 

Header

Mine - Gives only the creator of the list access to the marketing list.

Shared - Gives selected users access to the marketing list.

Public - Gives all users access to the marketing list.



InFocus User Manual - Current (v2020)386

© 2020 Clearview Software, Inc.

Marketing List Grid

Icon - Icon that represents the access type of the Marketing List. Access types are Personal, Shared, or
Public.

Market List - Name of the Market List.

Type - .Applet that the Marketing list is accessible.

Owner - User that created the Marketing List.

Member Count - Number of members that are in the Marketing List.

4.10.7.1 Marketing Lists Editor

Overview 

The Marketing List Editor allows you to create/edit Marketing Lists. A marketing list is a named list of either
Contacts, Firms, or Opportunities.  It allows a user to filter their returned results in the Contacts, Firms, or
Opportunities applets. For example, you may have thousands of contacts, however, you may have 50 main
contacts that you need to gain access to quickly.  A marketing list allows you to create a filter to show only
that group of users.

Field Descriptions 

Header

Name - Name of the Marketing List

List Type - The applet that the Marketing List is used in.

Access Level - The access type of the Marketing List. Access types are Personal, Shared, or Public.

Active - When checked, the Marketing List is Active.

Members Tab

Description - The Members Tab is where you build the list of users who have access to the Marketing

List.

Arrow Button (Import) - The Marketing List Import Button allows you to create filtering options to import

contacts. The options are:

o Import All - All records (users) will be imported. If a record is already a part of a list, it will not be

imported a second time.

o Import from another List - By selecting an existing list, you can bring over the same list of records.

o Import by Query - By uing the selection options, you can build a query that will import the records.

Plus Sign Button - The plus button gives you a list of contacts that you can import to this Marketing List.
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Permissions Tab

Description - When the Access Level is "Shared", you are able to set permissions that grant access to

certain Users/Groups. More on Permissions

4.10.8 Notes

Overview  

Notes can be entered against a Contacts, Firms, and Projects (including Opportunities). 

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

Print - Prints the comments in the Notes window

Field Descriptions

Note Window (Top Window)

Description - The notes window contains the running notes conversation. 

Note - Hover over a comment to Edit, View or delete a specific item.

Note Window (Bottom)

Description - In this window you are able to compose or edit a note.

Regarding

Contact - Contact associated with the note. More on Contacts

Firm - Firm associated with the note. More on Firms 

Project - Project associated with the note. More on Projects 

Schedule Follow Up Activity

Type - Type of Note Posting (ex. Phone Call, Meeting, E-Mail, Appointment, Lunch, and Dinner are the

choices). A User Defined Field. The Type list is managed under Administration>List

Management>Activity Types

Date - Date of follow-up Activity.

Time - Time of follow-up Activity.

Duration - Duration of follow-up Activity.
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Show Until Marked Complete - When checked, the activity remains on the Upcoming Activities List until

marked complete. If not completed, it comes off the Upcoming Activities list once the date has expired. 

More on ActivitiesActivities

Drop-down - Type of Note Posting (ex. Phone Call, Meeting, E-Mail, Appointment, Lunch, and Dinner are

the choices). A User Defined Field. The Note Type list is managed under Administration>List

Management>Note Types

4.10.9 Opportunities

Overview 

Opportunities are a specific type of project. Opportunities are typically a marketing effort.

The Marketing navigation screens are laid out like a Rolodex with alphabetic tabs representing the first letter
in the name of the marketing item. An All tab contains all of the marketing items.

Key Concepts

Double-click on a opportunity inside the grid to bring up the "Opportunity Detail" pop-up. Data can be

viewed or changed, depending on the user’s permissions.

Within the "Opportunity Detail" pop-up, there are multiple tabs that show specific data about the

opportunity, such as name or main phone. 

Only Opportunities and employees can be added from this form.

Time and expense can be charged to Opportunities. 

Opportunities are treated as indirect projects.

The Opportunity applet is a streamlined view of Opportunity projects. Opportunities can also be accessed

from the main Project Setup Applet.

The Opportunity applet exposes certain columns of a project that are relevant to Opportunity projects. For

instance, billing/invoice information does not appear because it is not applicable.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Field Descriptions 

Active Status

Active Status - Filters your Opportunities by their status (Active, Inactive or Both).
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Marketing Lists

Marketing Lists - A marketing list is a list of Contacts, Firms, or Opportunities that are created in 

Marketing>Marketing Lists. A Marketing List is used to filter the grid on the right. When a Marketing list is

selected, the grid will display only the Opportunities that were imported into the Marketing list.  More on

Marketing Lists

Views

Views - Views allow you to filter your grid even further. Views allow you to save the current Filter settings

(Funnel icons at the top of each column) of the marketing screen. What that means is that you can use

the different column filters to display your data just right in the grid, and save it as a View. 

Note - Views are available only available in Contacts, Firms, and Opportunities.  

Quick Filter

Quick Filter - A real time filter that reduces the list of Opportunities as you type into the cell.

Clear - Clears out the contents of the Quick Filter

Buttons (top-right of grid)

Columns (paper icon) - Displays a "Column Selector" pop-up that allows the user to select only those

columns they wish to view.  In the pop-up, there is a check box labeled "Set As Global Default" (granted

by a Permission) that allows that user to set a default view for all users that use this Marketing List.

Email (envelope icon) - Displays an email pop-up that allow you to create an email to send to everyone

within the Marketing List. More on Marketing Emails

Export (arrow icon) - Allows the user to export the list to a file.

Refresh - Refreshes the data in the grid.

Opportunities Grid

The grid displays all of the recorded information for each Opportunity as a single row.

Double-Click on a row to bring up the Opportunity Detail.

The Column Selector allows users to select only those columns that they wish to view.

The header of each column gives the name of the data field.

A Funnel icon at the top of each column represents a filter.  By clicking on the filter, the user is able to

filter down the grid to only the information that they would like to view.  
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Card View

The Card View all Opportunities in "Swim Lanes" that are made up of the Lead Stages. The Stage list is

managed under Administration>List Management>Lead Stages.

Double-Click on an Opportunity "Card" to bring up the Opportunity Detail.

Active Status, Marketing lists and Views filter the Card View. 

4.10.9.1 General Tab

Overview 

The General Tab contains many of the fundamental fields involved in the setup of Opportunities.

Field Descriptions
Below are field descriptions for the General Tab. 

** Indicates a required field

Name 

Active - Check this box to make this an active firm. 

** Code - Unique Code of the Firm.

** Name - Name of the Firm.

** Firm - Firm assigned to this Opportunity.

Org. Unit - Organizational Unit assigned to project. More on Organizational Units

Opportunity Info 

Stage - Marketing Stage that the Opportunity is currently at. A User Defined Field. The Stage list is
managed under Administration>List Management>Lead Stages.

Lead Source - Lead Source of the Opportunity. A User Defined Field. The Lead Source list is managed
under Administration>List Management>Lead Sources.

Chat Handle

Chat Handle - User handle for instant messaging applications like Slack, Skype, etc.

Opportunity Dates 

Start - Anticipated Start Date of the Opportunity.

End - Anticipated End Date of the Opportunity.

Proposal Due - Estimated Due Date of the Proposal.

Expected Close - Estimated Close Date.
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Market Sectors 

Market Sectors associated with the Opportunity. More on Market Sectors

4.10.9.2 Internal Contacts Tab

Overview 

The Internal Contacts Tab contains internal contacts associated with the Firm.

Field Descriptions
Below are field descriptions for the Internal Contacts Tab. 

Internal Employee Contacts 

Internal Contacts are internal contacts that are associated with the Firm.

Principal - Contact that is classified as the Principal in Charge Contact.

Comments - Internal notes that are specific to Main Contact.

Project Manager - Contact that is classified as the Project Manager Contact.

Comments - Internal notes that are specific to Sales Contact.

Marketing Contact - Contact that is classified as the Marketing Contact.

Comments - Internal notes that are specific to Marketing Contact.

Other Contact - Contact that is classified as an Other Contact.

Comments - Internal notes that are specific an Other Contact.

4.10.9.3 Comment Tab

Overview

The Comment tab is used for internal comments that are specific to the Opportunies.

4.10.9.4 Addresses Tab

Overview
The Addresses Tab contains the addresses of the selected firm. Clicking on a field in a Firm row will expose
the Addresses Tab. 

Field Descriptions
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Below are field descriptions for the Addresses Tab. 

Main Address 

Name - Named address. Not available for employee contacts.

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

City - City

State - State

Zip - Zip Code

State - State

Country - Country

Phone - Telephone number

Fax - Fax number

Latitude - Latitude of Address

Longitude - Longitude of Address

Copy to Clipboard - Copies address to the clipboard of the local workstation.

Geocode - When clicked, the Latitude and Longitude are filled in with the location of the Main Address. 

This can be used in the Map Viewer applet. More on the Map Viewer.

4.10.9.5 Contacts Tab

Overview 

The Contacts Tab associates an Opportunity with a particular Contact. 

Field Descriptions
Below are field descriptions for the Contacts Tab. 

** Indicates a required field when adding to the list.

** Contact - Name of the Contact associated with the Opportunity.

** Relationship - The Opportunities’s relationship with the Contact. A User Defined Field. The
Relationship list is managed under Administration>List Management>Project Contact Types
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4.10.9.6 Marketing Lists Tab

Overview  

The Marketing Lists Tab shows you a list of Marketing Lists that are  that have a "List Type" of Opportunity.
You must also have the appropriate "Access Level" access.  More on Marketing Lists

Field Descriptions
Below are field descriptions for the Marketing Lists Tab. 

Quick Filter - A real time filter that reduces the list of Opportunities as you type into the cell.

Clear - Clears out the contents of the Quick Filter.

Check All - Selects all of the available Marketing Lists in the Grid.

Check-box - Checked if a member of the Marketing List.

Name - Name of the Marketing List.

Date Added - Date that the Opportunity Project was added to the Marketing List.

4.10.9.7 Notes Tabs

Overview  

Notes can be entered against a Contacts, Firms, and Projects (including Opportunities). More on Notes

Field Descriptions
Below are field descriptions for the Notes Tab. 

** Indicates a required field

Note Details 

Comment - Body of the Note

Note Type - Type of Note Posting (ex. Phone Call, Meeting, E-Mail, Appointment, Lunch, and Dinner are
the choices). A User Defined Field. The Note Type list is managed under Administration>List
Management>Contact Note Types

Firm - Firm associated with the note.

Contact - Contact associated with the note.

Add a follow-up Activity?

Add - Create a a follow-up activity that appears on the Activity Calendar. More on Activities

Require Complete - When checked, the follow-up activity shows up on the Activity calendar until it is
marked complete.
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Type -  Type of Activity. A User Defined Field. The Activity Type list is managed under
Administration>List Management>Activity Types

Date - Date of follow-up Activity.

Time - Time of follow-up Activity.

Duration - Duration of follow-up Activity.

Existing Notes

Notes associated with the Contacts, Firms, or Projects that have been created.  Double-click on them to
bring into focus.

4.10.9.8 System Info Tab

Overview  

The System Info gives you useful read-only information about the selected Opportunity Project.

Field Descriptions
Below are field descriptions for the System Info Tab. 

Record Details 

Record ID: Internal ID number of the selected Opportunity Project.

Created By - The creator of the selected Opportunity Project.

Create Date - The date that the selected Opportunity Project was created.

Modified By - The last person to modify data on the selected Opportunity Project.

Modify Date - The last date that the selected Opportunity Project was modified.

4.10.9.9 Custom Fields (UDF) Tab

Overview 

User-definable fields (UDFs) can be created for Clients, Employees, Vendors, Projects, Project Level2 and
Contacts. More on User Defined Fields.

4.10.10 Opportunity Queries

Overview 

There are seven query applets in InFocus: Client, Contacts, Firms, Opportunities, Vendors, Projects, and
Employees. The concept of the query tools is to allow the user to define lists of data based on a user query
definition. The list can then be used to navigate to the individual records within the list or can be exported to
Excel. More on the Query Applets
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4.11 Utilities

4.11.1 Analytic Dashboard Designer

Overview

Analytic Dashboard Designer applet features an intuitive, interactive design environment that displays your
dashboards in real time as you build them.

Each design uses a Data Source (defaults to InFocus) and a Query (typically an Analytic Model - managed
via UT>Dashboard Queries Manager). When clicking New, you’ll be prompted to select an Analytic Model-
the data source will default to InFocus. That said, you’ll note that the designer supports multiple data sources
and multiple models per design (advanced designs).

Once selected, you’re ready to being using the design tools.

Getting Started

Before jumping into your first designs, you'll want to begin by taking a moment to understand the moving
parts and setup for Analytic Dashboards if you haven’t already.

Analytic Dashboard Overview and Setup

4.11.1.1 Designer Layout

The designer itself is organized into three sections: Toolbar, Data browser/pane and the Dashboard
surface.

In short, you’ll use the toolbar options in conjunction with your data to build your dashboard view on the
surface.

4.11.1.1.1  Designer Toolbar

Overview

The Analytic Dashboard Designer toolbar offers powerful options for working with designs and is where
primary tools are made available. 

The toolbar contains both standard options (always visible) and item-specific options, visible when working
with the item. While item specific options will be discussed in context, below is a list of standard toolbar
options.

Field Descriptions

Below is a list of standard applet fields/buttons/elements used in the Analytic Dashboard Designer.

Menu Options

File/Help - Lists standard InFocus File and Help options
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Toolbar Options

Pinned Options

Save - Saves the loaded dashboard

Undo - Reverses edits made

Redo - Add back Undone changes

Update - Updates the dashboard with the latest modifications. This could be used if two users were
working on the same dashboard design.

Home Tab

New - Click to create a new dashboard

Open - Opens an existing dashboard

Save - Saves the loaded dashboard

Undo - Reverses edits made

Redo - Adds back Undone changes

Inserts Section - Dashboard Items used in designing an Analytic Dashboard. Supported items are as
follows:
o Pivot
o Grid
o Chart
o Scatter Chart
o Pies
o Gauges
o Cards
o Choropleth Map
o Geo Point Map
o Range Filter
o Filter Elements (e.g. Combo Box, List Box, Tree View)
o Images
o Text Box
o Groups

Item Section - Hidden until an Item (listed above) is inserted. Available options include
o Duplicate - Duplicates the highlighted item on the dashboard
o Delete - Deletes the highlighted item
o Convert To - Used for converting one item to another (e.g. convert a Grid to a Chart).
o Remove Data Items - Removes Data Items from the dashboard
o Edit Rules - Launches dialogue to work with conditional format rules added to the dashboard item

Dashboard Section - Settings global to the loaded dashboard
o Title - Click to configure dashboard title options
o Currency - Configure currency options
o Edit Colors - Edit global dashboard colors
o Parameters - Used to managed dashboard parameters
o Automatic Updates - Click to enable automatic updates for the dashboard
o Update - Use to manual update the dashboard. Disabled when using Automatic Updates.
o Add Variable Parameters - Add additional dashboard parameters

Data Source Tab

Add InFocus Data Source - Click to add an InFocus data source

Add External Data Source - Click to add an external data source- configured in Global Settings
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(AD>Global Settings>External Data Sources)
Add Custom Data Source - Click to add a custom data source (e.g. Excel, CSV, etc.)

Edit Connection - Use to edit the currently loaded data source connection information

Rename - Renames the loaded data source

Delete - Removes the loaded data source

Server Mode - Enables server mode. In short, when enabled, data related operations (e.g. grouping,
filtering, etc.) are performed on the server. Alternatively, when not enabled, processing is done client side
in-memory. Generally, Server Mode only supports SQL Data Sources and may or may not impact
performance.
Add Calculated Field - Launches the Expression editor for creating calculated fields.

Add Analytic Model - Click to add Analytic Models to the Query dropdown. Multiple data sources are
supported.
Add Query - Launches the Query Editor for developing queries from the designer

Edit - Edits the currently loaded query (Analytic Model)

Rename - Renames the currently loaded query

Filter - Edits the currently loaded query filter

Delete - Deletes the currently loaded query from the data source

Model Info - Displays Field/List Descriptions for the loaded Analytic Model. Note, descriptions for the
model are entered for each model via UT>Dashboard Queries Manager.

4.11.1.1.2  Data Browser/Pane

Overview

The Data Browser is where you’ll interact with your Data Source and Analytic Model. Once a model is
loaded to the dashboard (done by clicking refresh above the model field list), you can bind fields to
Dashboard Items by dragging and dropping fields into the Data Items Pane as appropriate for the Dashboard
Item (e.g. Grid, Chart, Pie, etc).

Field Descriptions

Data Browser

Data Source - Lists the currently loaded data source. Supports multiple data sources (advanced designs).

Query/Model - Lists the currently loaded Analytic Models. Supports multiple models (advanced designs).

Group Button - Groups field list by data type (e.g. datetime, nvarchar, int, etc.)

AZ Button - Sorts field list alphabetically

ZA Button - Sorts field list alphabetically (descending order)

Refresh - Refreshes the field list. Note, when starting a new design, you must first click refresh to perform
an initial data load. Otherwise your data will not display.
Change Binding - Currently not in use

Data Items Pane

As mentioned above, Dashboard Items (e.g. Grids, Charts, etc) are bound to data fields via the Data Items
pane.

While options will in the Data Items pane will vary based on the Dashboard Item, below is a list of available
options.
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Command Buttons - Listed in the upper-right of the Data Items pane, command buttons allow you to run
various operations like adding a new pane to a chart dashboard item.
Data Item Placeholders (e.g. Values, Columns, Rows, Arguments, Series, etc.) - Used to bind data fields
to the dashboard item. Available placeholders are determined by the selected dashboard item.
Hidden Data Items - Data items being used by the dashboard (e.g. filters, etc) that don’t appear in any
displayed dashboard item. For instance, you could use a Grid to display Employee Name and Hours and
then use a hidden field to filter out time against indirect projects based on the Charge Type. Fields can be
used as either Dimensions or Measures based on the intended use for the field. 
o Dimensions - Represent data items that can be added to the dashboard as they are- with no required

aggregation. Dimensions can further be sorted and/or grouped. (e.g. Project Code, Employee Name,
etc).

o Measures - Represent data items that are added to the dashboard only as summaries (e.g. Sum of
Hours, Max Work Date, etc).

4.11.1.1.3  Dashboard Surface

Overview

The Dashboard Surface is your primary design space and reflects added items. Dashboard Items can be
configured, re-sized and reorganized as needed. The “Dashboard” title can be renamed, removed, etc. by
clicking Title from the Home Toolbar.

In short, what you see on the surface (in terms of design), is what your end users will experience when
viewing the Analytic Dashboard.

Field Descriptions

Title - Defaults to “Dashboard”. Configure by clicking Title from the Home Toolbar.

Export To - Exports the design to Print Preview, PDF or Image. For example, this can be a great option if
publishing a dashboard for one-time analysis.
Dashboard Parameters Button - Reflects the available parameters available to the design and
subsequently the end user.

4.11.1.2 Data Shaping and Formatting

Overview

Data is automatically formatted when added to a dashboard item, based on the data type (e.g. Number,
Currency, etc.). That said, formats can be edited by hovering over the data item and clicking the data item
menu drop-down.

Each data item will list several options for data shaping including: Summarizing, Calculations, Formatting,
etc.
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4.11.1.2.1  Summarization

Apply various forms of summary to data items as necessary by selecting the appropriate summarization from
the list.

For instance if viewing a total number of Hours, you would choose Sum.

To change the Summarization method:

1. Hover over the field in the Data Items pane
2. Click the data item menu drop-down
3. Select the appropriate Summarization

4.11.1.2.2  Calculations

Calculations can be applied over the data item in use.

For instance, instead of an actual sum of Hours, you could display the Percent of Hours in relation to the
grand total (etc.)

To apply a Calculation:

1. Hover over the field in the Data Items pane
2. Click the data item menu drop-down
3. Select Calculation
4. Select the appropriate calculation. Custom calculations are also supported.

4.11.1.2.3  Formats

While defaulting to Auto, standard formatting for measures can be adjusted by selecting Format… from the
data item menu drop-down.

For instance, if using a percentage value, you would likely need to change the format to: Percent.

Numbers / Currency

To change the format for numbers or currency:

1. Hover over the field in the Data Items pane
2. Click the data item menu drop-down
3. Select Format…
4. Configure settings as appropriate (see below)
5. Click OK

Format Type - Defaults to Auto. Options include: General, Number, Currency, Scientific, Percent.

Unit - Unit to which values should be converted

Precision - Defines the decimals to display

Currency - Defaults to Dashboard global currency setting. Specific currency settings can be set here.

Culture - Defines the currency cultures for currencies with multiple cultures

Include group separator - Displays a comma between each numeric group (e.g. 1,000,000.00)

Date Values

Date Values have several display options, listed when clicking the Options button. To change display
settings:
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1. Hover over the field in the Data Items pane
2. Click data item menu drop-down
3. Select the Date type (e.g. Year, Quarter, etc)
4. Optionally set the Format

o Default
o Full (e.g. Month = October, etc.)
o Abbreviated (e.g. Month = Oct, etc.)
o Numeric (e.g. Month = 10, etc.)
o Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))
o Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))
o Time Only (e.g. Date-Hour = 10:57pm (en-US))

4.11.1.2.4  Conditional Formatting

Once data is added to the pivot, it can be formatted in a variety of ways to help visualize otherwise static data
points. For instance, you can highlight cells that meet certain defined criteria.

Formatting can be added, edited and cleared/deleted by clicking Edit Rules from the toolbar or by hovering
over the data item and clicking the data item menu drop-down.

Format Rules include:

Value - Add a formatting rule based on an evaluation of static value (e.g. >, <, <=, >=, etc.)

Top/Bottom - Add formatting based on the evaluation of the topmost or bottommost value

Average - Add formatting rule based on an evaluation of average (e.g. >, <, <=, >=, etc.)

Expression - Build an expression to apply formatting (advanced)

Icon Ranges - Apply icons to items based on an evaluation of a range

Color Ranges - Apply colors to items based on an evaluation of a range

Gradient - Apply a color gradient to items based on an evaluation of a range

Bar - Displays a visual representation of a value using a bar. Bars can be colored based on positive or
negative values.
Bar Color Ranges - Displays a visual representation of a value using a bar. Bars are colored with the
color set based on an evaluation of range
Bar Gradient Ranges - Displays a visual representation of a value using a bar. Bars are colored with the
gradient color set based on an evaluation of range

4.11.1.3 Dashboard Interactivity

Overview

Analytic Dashboards support interactivity between Dashboard Items. The following is a discussion of
supported options and settings related to

Master Filters

Drill Down

4.11.1.3.1  Master Filters

Overview
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Included in the Analytic Dashboard feature set is the ability to filter dashboard items by another when similar
values are used by each. For instance, a chart displaying information by employee name, could be used to
filter a grid displaying other employee information.

This is done by setting the dashboard item you wish to filter by as a Master Filter- of which there are two
types.

Master Filter Types

Single Master Filter

Single Master Filter sets the selected dashboard item as a filter for all other dashboard items governed by the
data source. Using a Single Master Filter you can filter by one value in the selected item (e.g. a single
Employee Name cell in the Grid)

Single Master Filters can be further defined by Target Dimensions (Argument, Series, Point).
 

Multiple Master Filter

Multiple Master Filters work similarly to Single Master Filters with the exception that by using a Multiple
Master Filter you can filter by one or more values in the selected item (e.g. multiple Employee Name cells
in the Grid)

Multiple Master Filters can be further defined by the Target Dimension (Argument, Series, Point).

Master Filter Settings

Cross Data-Source Filtering

As mentioned above, by default setting an item as a Master Filter applies filtering to other dashboard items
using the same data source. 

Enabling Cross Data-Source Filtering allows a Master Filter to affect data items displaying data from other
data sources. When using this setting, the full names of data fields must match between data sources (e.g.
"Employee_Code" field, for instance, must exist in both data sources)

Ignore Master Filter

Enable this setting on any dashboard item you wish to to exclude from Master Filtering

4.11.1.3.2  Drill Down

Overview

Analytic Dashboard Items can be configured for Drill Down which allows the user to click into greater details
for the values being displayed.

For example, if you designed a Chart to display Utilization by Year, configuring Drill Down would allow you to
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click into the details for each Quarter, Month (etc.) of each year.

Drill Down can be further defined by Target Dimensions.

Tutorial

Drill Down is configured by following these steps:

1. Select the Dashboard Item you wish to configure
2. Browse to the Data tab on the toolbar
3. Click Drill Down
4. Configure the Target Dimension as needed
5. Drag-and-Drop data items to the Data Items pane in order of detail- least to greatest (e.g. WorkDate
(Year), WorkDate (Quarter), WorkDate (Month), etc.) 

4.11.1.3.3  Target Dimensions

Overview

Master Filters and Drill Down can be further defined by a Target Dimension. Target Dimension (Argument,
Series, Points) determines the data items to be used as filters/drill down.

For example, if configuring a Chart as a Master Filter, setting the Target Dimension to Argument allows the
user to filter other Dashboard Items by Arguments displayed on the Chart. Likewise, if configuring a Chart
with Drill Down, setting the Target Dimension to Series would leverage the data items listed under Series
when drilling into further detail.

4.11.1.4 Dashboard Design Items

Overview

Analytic Dashboards are built using the dashboard items available from the toolbar. Items include:

Pivot

Grid

Chart

Scatter Chart

Pies

Gauges

Cards

Choropleth Map

Geo Point Map

Range Filter

Filter Elements (e.g. Combo Box, List Box, Tree View)

Images

Text Box

Groups

To work with an item, simply select it from the toolbar and the designer will add it to the Dashboard
Surface for further configuration.
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4.11.1.4.1  Pivots

Overview

Pivots offer data visualization in a hierarchical grid.

Data can be added to the pivot, nested into a hierarchy, formatted and configured to interact with other
Dashboard Items.

Adding Data

Data fields are bound to the Pivot by dragging them to the Data Items Pane as a Value, Column or Row. 

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field in the Pivot.

Working with Pivot Data

Each Dashboard Item has different requirements for the data you add to it. Pivots use Values, Columns and
Rows.

Values - Used to calculate data (e.g. the Sum of all Hours)

Columns - Used to label the grid columns

Rows - Used to label grid rows

For example, to view the total hours for each project by year, add:

Values Columns Rows

Hours (Sum) Work Date (Year) Project Name

Columns can be further broken out by adding additional fields to Values.

Values Columns Rows

Hours (Sum) Work Date (Year) Project Name

Bill_Dollars (Sum)

Hierarchy can be added to the pivot by binding additional fields to Columns or Rows. Once hierarchy is
added, the pivot will display expand/collapse icons which can be used to view or hide the added hierarchy.

Values Columns Rows

Hours (Sum) Work Date (Year) Project Name

Bill_Dollars (Sum) Work Date (Month) Employee Name

TIP: If you’ve added data to the Pivot but don’t see it reflected, click the Refresh button above the Field List
in the Data Browser (left-hand pane of the designer).

Conditional Formatting
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Once data is added to the pivot, it can be formatted in a variety of ways to help visualize otherwise static
data points, highlighting cells that meet certain defined criteria.

Pivots support conditional formatting on Values, Columns and Rows.

Formatting can be added by clicking Edit Rules from the toolbar or by clicking Options>Add Format Rule
from the data item (Options Button- down arrow - becomes visible when hovering over the data field in the
Data Items pane).

For example, to color a cell green if the sum of hours exceeds 100 hours on a given project:

1. Hover over the Hours field
2. Click the Options button (down arrow)
3. Select Add Format Rule>Value>Greater Than. The Greater Than dialogue will appear.
4. Enter 100 in the <enter a value> text box
5. Select green to set the appearance. Note, you could also choose to add an Icon to the cell by selecting

the Icon tab.
6. Use the Auto Intersection Mode.

Intersection Mode defines the level at which the condition should be applied. Auto will typically default
to the highest level of hierarchy. If selecting Specific level, you can then specify a level based on Row
or Column to apply the conditional formatting to.

7. Use Hours as the Apply to. While this defaults to the selected field, you can add the formatting to the
cell of your choosing.

8. Apply to Row/Column can be left unchecked. Checking either will apply the format to the entire column/
row in which the evaluated cell resides.

9. Click Apply to preview results
10. Click OK

Pivot Tools

Pivots feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the pivot).

Data

The Data Tab includes several options for shaping your data.

Edit Filter - Use to add filters to the pivot based on displayed or Hidden Data Items.

Ignore Master Filter - Pivot Grids can interact with other dashboard items marked as a Master Filter (e.g.
data displayed on the pivot is filtered by, for instance, a bar chart). Clicking Ignore Master Filter removes
interactivity.
Initial State - Sets the default state of grid hierarchy (expanded or not).

Totals - Shows/Hides row and/or column totals

Grand Totals - Shows/Hides grand totals

Font - Adjust font options for the data results in the pivot

Design

Pivots allow the following design options.

Show Caption - Shows/Hides the Pivot caption (e.g. “Pivot 1” displayed at the top left of the pivot).
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Edit Names - Used to configure display name for the Dashboard Item and Values

4.11.1.4.2  Grids

Overview

Grids are a flexible way to view data.

Data can be added to the grid in columns, configured based on column types, formatted and configured to
interact with other Dashboard Items.

Adding Data

Data fields are bound to the Grid by dragging them to the Data Items Pane as a Column or Sparkline. 

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field in the Grid.

Working with Grid Data

Each Dashboard Item has different requirements for the data you add to it. Grids use Columns and
Sparklines

Columns - Used to label and provide data to the grid columns. Grids support multiple column types which
can be edited by clicking the column type indicator (right-aligned icon in the New Column placeholder).
Below is a description of each column type: 
o Dimension - Represent data items that can be added to the dashboard as they are- with no required

aggregation. Dimensions can further be sorted and/or grouped. (e.g. Project Code, Employee Name,
etc).

o Measures - Represent data items that are added to the dashboard only as summaries (e.g. Sum of
Hours, Max Work Date, etc). Can be displayed as the value or as a Bar.

o Delta - Calculates the difference between the sum of two measures and can display a visual indicator
of the difference. Actual represents the first measure and Target represents the second. Deltas can be
displayed as a Value or a Bar. Values can be further configured to evaluate the following

Value Type - How the calculated result is represented
Result Indication - Condition that defines the visual indicator (e.g. Greater is good will display a
green up arrow if the Actual exceeds the Target)
Threshold Type -  Further rules can be applied to when a visual indicator will be displayed in the
result (e.g. display a green up arrow only if the Actual exceeds the target by 15% or $1500.00).
Threshold Type defines the type of threshold to apply- percent or absolute value.
Threshold Value - Sets the value for the threshold (e.g. 15%).

o Sparkline - Used to display the variation in summary values over time. The Sparkline column should
contain the summary value (e.g. Sum of Hours). Additional Sparkline options include

Show start/end values
Sparkline view type - Defines how the sparkline should be visually represented
Highlight min/max points - When checked, places a corresponding dot on the sparkline
Highlight start/end points - When checked, places a corresponding dot on the sparkline

Sparkline - Sparklines calculate and display the variation of summary values over time. While the
Sparkline Column represents the equation’s value, this Data Item represents the argument in the
equation. For example, to view an employee’s direct hours over time, set the Sparkline Argument to
WorkDate (Month, etc.) and add a Sparkline Column (discussed above) for Direct Hours (Sum)
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Consider the following example for viewing Employee Utilization.

Column Column Type Sparkline (Argument)

Employee Name Dimension

Direct Hours Pct (Avg) Measure

Direct Hours Pct (Avg) Delta - Actual

Target Pct Delta - Target

Direct Hours (Sum) Sparkline WorkDate (Month)

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Conditional Formatting

Once data is added to the grid, it can be formatted in a variety of ways to help visualize otherwise static data
points, highlighting cells that meet certain defined criteria.

Grids support conditional formatting on Columns and Sparkines.

Formatting can be added by clicking Edit Rules from the toolbar or by clicking Options>Add Format Rule
from the data item (Options Button- down arrow - becomes visible when hovering over the data field in the
Data Items pane).

For example, to color a cell green if the average percentage exceeds 25% for a given employee:

1. Hover over the field in the Data Items pane
2. Click the Options button (down arrow)
3. Select Add Format Rule>Value>Greater Than. The Greater Than dialogue will appear.
4. Enter .35 in the <enter a value> text box
5. Select green to set the appearance. Note, you could also choose to add an Icon to the cell by selecting

the Icon tab.
6. Use the selected field (default) as the Apply to. While this defaults to the selected field, you can add the

formatting to the cell of your choosing.
7. Apply to Row can be left unchecked. Checking either will apply the format to the entire row in which the

evaluated cell resides.
8. Click Apply to preview results
9. Click OK

Grid Tools

Grids feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the grid).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.
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Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Single Master Filter - This sets the selected Dashboard Item (e.g. Grid, etc) as a Master Filter for all other
dashboard items. Using a Single Master Filter you can only filter by one element in the selected item (e.g.
a single Employee Name cell in the Grid)
Multiple Master Filter - This sets the selected Dashboard Item (e.g. Grid, etc) as a Master Filter for all
other dashboard items. Using a Mulitple Master Filter you can filter by one or more elements in the
selected item (e.g. multiple Employee Name cells in the Grid)
Drill Down - Enables drill-in details for the Dashboard Item. For Grids, list dimension columns at the top of
the Data Items Pane in order of detail - least to most. When enabled the grid will reflect data for the top
dimension, allowing you to click through to each subsequent dimension, displaying measures (e.g.
summary columns) in relation to each dimension. 
Cross Data Filtering - Allows a Master Filter to affect data items displaying data from other data sources.

Ignore Master Filter - Dashboard Items can interact with other dashboard items marked as a Master
Filter. Clicking Ignore Master Filter removes interactivity

Design Tab

Grids allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item and Columns, Values, etc.

Horizontal Lines - Show/Hide horizontal grid lines

Vertical Lines - Show/Hide vertical grid lines

Banded Rows - Color alternating rows

Merge Cells - Merges adjacent cells with identical data

Column Headers - Show/Hide column headers

Word Wrap - Enable word wrapping which will display cell content on multiple lines in one cell.

Font - Configure font settings for the dashboard item

Padding - Configure cell padding for grid cells. Padding is the amount of space between the border of the
cell and the value displayed therein
AutoFit to Contents - Automatically adjusts the column width to display all cell contents- regardless of the
grid size
AutoFit to Grid - Automatically adjusts the column width to best fit the size of the grid- regardless of the
cell content
Manual - Gives you control over each column in the grid. Right-click the column header to define each
column as appropriate

Column Header Options

Grids feature additional per-column settings, available by right-clicking the column header.

Fit to Content - Automatically adjusts the column width to display all cell contents- regardless of the grid
size
Fixed Width - Select to fix the width of the column to the current width

Column Width - Define an exact column width

Add Format Rule - Apply conditional formatting to the column

Edit Rules - Edit existing conditional formatting for the column

Clear Rules - Clear conditional formatting added to the column

Add Totals - Adds the specified aggregation(s) to the footer of the grid for the column.
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4.11.1.4.3  Charts

Overview

Charts offer several options for rich data visualization.

Data can be added to the Chart in the form of Values, Arguments and Series. Charts can then be formatted
and configured to interact with other Dashboard Items.

Adding Data

Data fields are bound to the Chart by dragging them to the Data Items Pane as Values, Arguments or a
Series. 

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Working with Chart Data

Each Dashboard Item has different requirements for the data you add to it. Charts use Values, Arguments
and Series displayed, typically, on two axes: X-Axis and Y-Axis.

Each Data Item can be formatted by hovering over the item and clicking the options icon (right aligned down
arrow).

Values - Data items which are calculated and displayed against the Y-Axis. Multiple values are supported
and can be be visualized using different Series Types (e.g. Bar, Point/Line, Area, Range, Bubble,
Financial).
Arguments - Data items displayed along the X-Axis. A Value is displayed on the chart for each Argument.

Series - Data items used to create chart series, typically used for categorizing arguments. A Value is
displayed on the chart for each Series within each argument. How that Value is represented depends on
the Series Type.

Series Types

Series Types provide options for visualizing chart series. Additional functionality is also made available to the
chart through the Series Type (e.g. plotting on a secondary axis, labeling, etc.) 

Series Options are accessed by clicking the series icon located to the right of the Values Placeholder in the
Data Items pane.

Series Types include:

Bar

Bar - Displays a bar representing each Value

Stacked Bar - Displays the contribution of each Value in relation to the whole

Full-Stacked Bar - Shows the percentage of each Value’s contribution to the whole

Point/Line
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Point - Plots a point representing each Value

Line - Plots points, connected by a straight line for each series across each argument

Stacked Line - Shows the trend of the contribution for each value

Full-Stacked Line - Shows the trend of the percentage for each value

Step Line - Connects plotted point using horizontal and vertical lines only

Spline - Plots points, along a fitted curve

Area

Area - Displays a straight line connecting data points for each Value across each argument, shading the
area between the plotted line and the X Axis. Areas display a line and shading for each Series bound to
the Chart.
Stacked Area - Shows the trend of contribution for each Value, shading the area between the plotted line
and then next Series.
Full-Stacked Area - Shows the trend of percentage for each Value, shading the area between the plotted
line and then next Series.
Step Area - Displays a straight line connecting data points for each Value across each argument using
horizontal and vertical lines only, shading the area between the plotted line and the X Axis.
Spline Area - Displays a fitted curve connecting data points for each Value across each argument,
shading the area between the plotted line and the X Axis.
Stacked Spline - See Stacked Area

Full-Stacked Spline - See Full Stacked Area

Range

Range - Displays a bar representing each Value in relation to a specified range, typically timeframe.

Range Area - Displays a straight line connecting data points for each Value across each argument,
shading the area between a specified range, typically timeframe.

Bubble (Weighted Series)

Bubble - Similar to Points, Bubbles plot a point representing each Value. The difference, however, is that
bubbles evaluate a third dimension: Weight. Weight determines the size of of series points.

Financial

Typically used to show stock prices across time periods. 

High-Low Close - Displays a representation of three required measures: High, Low, Close

Candle Stick - Displays a representation of four required measures: Open, High, Low, Close

Open-High-Low-Close (Stock) - Displays a representation of four required measures: Open, High, Low,
Close

Financial Series Measure types

Open - Price at the begging of a specified timeframe

High - Maximum price during a specified timeframe

Low - Minimum price during a specified timeframe

Close - Price at the end of a specified timeframe

Chart Example
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Consider the following example for visualizing Employee Utilization with a Chart.

Values Arguments Series Series Type

Hours (Sum) Work Date (Month) Charge Type Stacked Bar

The chart will display a bar for each month that shows a breakdown of direct and indirect hours. Using the
Stacked Bar, displays each hours amounts in relation to the total hours for the given month.

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Chart Panes

Charts allow you to add multiple panes which gives you the ability to view different Values (Y-Axis) against
similar Arguments (X-Axis) and Series.

Panes have unique Y Axes but share the X-Axis and Series.

To add a pane:

1. Click the Add Pane Icon (upper-right of the Data Items Pane). An additional Values section will appear.
2. Drag and Drop values to the placeholder as appropriate. A new pane will display

Formatting

Data added to charts are automatically formatted based on their data type. That said, formats can be edited
by clicking Options from the data item (Options Button- down arrow - becomes visible when hovering over
the data field in the Data Items pane).

For instance, if using a currency value, you would likely need to change the format to: Currency.

Numbers / Currency

To change the format for numbers or currency:

1. Hover over the field in the Data Items pane
2. Click the Options button (down arrow)
3. Select Format…
3. Configure settings as appropriate (see below)
4. Click OK

Format Type - Defaults to Auto. Options include: General, Number, Currency, Scientific, Percent.

Unit - Defines how the currency value should be converted

Precision - Defines the decimals to display

Currency - Defaults to Dashboard global currency setting. Specific currency settings can be set here.

Culture - Defines the currency cultures for currencies with multiple cultures

Include group separator - Displays a comma between each numeric group (e.g. 1,000,000.00)

Date Values

Date Values have several display options, listed when clicking the Options button. To change display
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settings:

1. Hover over the field in the Data Items pane
2. Click the Options button (down arrow)
3. Select the Date type (e.g. Year, Quarter, etc)
4. Optionally set the Format

Default

Full (e.g. Month = October, etc.)

Abbreviated (e.g. Month = Oct, etc.)

Numeric (e.g. Month = 10, etc.)

Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))

Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))

Time Only (e.g. Date-Hour = 10:57pm (en-US))

Chart Tools

Charts feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Single Master Filter - This sets the selected Dashboard Item as a Master Filter for all other dashboard
items. Using a Single Master Filter you can only filter by one element in the selected item.
o Single Master Filter is further defined by the Target Dimension which determines which Data Items

can be used as filters. For example, setting the Target Dimension to Argument allows the user to filter
other Dashboard Items by Arguments displayed on the Chart.

Multiple Master Filter - This sets the selected Dashboard Item as a Master Filter for all other dashboard
items. Using a Multiple Master Filter you can filter by one or more elements in the selected item.
o Multiple Master Filter is further defined by the Target Dimension which determines which Data Items

can be used as filters. For example, setting the Target Dimension to Argument allows the user to filter
other Dashboard Items by Arguments displayed on the Chart.

Drill Down - Enables drill-in details for the Dashboard Item. For Charts, list multiple Arguments or Series
in order of detail - least to most. When enabled the chart will reflect data for the top argument or series,
allowing you to click through to each subsequent argument or series, displaying values in relation to each.
o Drill Down is further defined by the Target Dimension which determines which Data Items can contain

drill-in detail. For example, setting the Target Dimension to Argument allows the user to drill down to
additional arguments.

Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Dashboard Items can interact with other dashboard items marked as a Master
Filter. Clicking Ignore Master Filter removes interactivity.
Arguments - Sets the target dimension for filters and/or drill down to displayed Arguments

Series - Sets the target dimension for filters and/or drill down to displayed Series

Points - Sets the target dimension for filters (only) to displayed Points
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Design Tab

Charts allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Rotate - Rotates the X and Y Axes

X-Axis Settings
o Reverse - Reverses the order of the X-Axis arguments
o Enables Zooming - Enables zooming on the X-Axis
o Show X-Axis - Show/Hide the axis labeling
o Show Title - Configures the title by default or as Custom Text
o Limit visible points - Limits the number of arguments to display on the X Axis. If the total number

exceeds the visible points, a scroll bar appears and can be used to scroll through the arguments. This
is a great option if using multiple dashboard items in a design and extra space is needed.

Y-Axis Settings
o Pane Drop Down - Selects the Chart Pane (see below) to apply the settings to
o Always show zero level - Show/Hide the zero point on the Y-Axis.
o Reverse - Reverses the order of the Y-Axis Values
o Show Grid lines - Show/Hide grid lines
o Show Axis - Show/Hide the axis labeling
o Show Title - Configures the title by default or as Custom Text
o Logarithmic scale - Check to show numerical values using a logarithmic scale. Set the logarithmic

base with the drop down to the right.
Show Legend - Show/Hide the chart legend. Legend placement can additionally be defined using the
legend drop down for certain series types.
Series Type - Similar to the series icon, you can set the series type from the design tab

Global Colors - Use to set colors for identical data items across all dashboard items

Local Colors - Use to set colors for items on the selected dashboard item

Edit Colors - Edits the Global or Local Color Scheme

4.11.1.4.4  Scatter Charts

Overview

Scatter Charts allow you to see weighted points plotted along two axes. Each axis contains it’s own
measurement by which a specified argument is evaluated.

Data can be added to a Scatter Chart in the form of X-Axis measures, Y-Axis measures, Weight and
Arguments. Scatter Charts can then be formatted and configured to interact with other Dashboard Items.

Adding Data

Data fields are bound to the Chart by dragging them to the Data Items Pane as the X-Axis, Y-Axis, Weight
or Argument. 

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Working with Scatter Chart Data
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Each Dashboard Item has different requirements for the data you add to it. 

As mentioned above, Scatter Charts place a weighted point plotted along two axes- against which the
specified value is calculated.

Each Data Item can be formatted (e.g. Number, Currency, etc.) by hovering over the item and clicking the
options icon (right aligned down arrow).

X-Axis - Data Item to be used for evaluating the Argument along the X-Axis

Y-Axis - Data Item to be used for evaluating the Argument along the Y-Axis

Weight - Data Item to be used for evaluating the size of the plotted point

Argument - Data Item to be evaluated

Consider the following example for viewing an Employee’s total Direct Hours, their percent of Billable Time
and those, weighted by their actual direct billings.

X-Axis Y-Axis Weight Argument

Direct Hours (Sum) Direct Hours Percent
(Average)

Direct Billings (Sum) Employee Name

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Formatting Data

Data added to scatter charts is automatically formatted based on their data type. That said, formats can be
edited by clicking Options from the data item (Options Button- down arrow - becomes visible when hovering
over the data field in the Data Items pane).

For instance, if using a percentage, you would likely need to change the format to type: Percent. Likewise, if
using a date as your argument, you may want to see that broken out in to quarters or months (etc.).

Numbers / Currency

To change the format for numbers or currency:

1. Hover over the field in the Data Items pane
2. Click the Options button (down arrow)
3. Select Format…
3. Configure settings as appropriate (see below)
4. Click OK

Format Type - Defaults to Auto. Options include: General, Number, Currency, Scientific, Percent.

Unit - Defines how the currency value should be converted

Precision - Defines the decimals to display

Currency - Defaults to Dashboard global currency setting. Specific currency settings can be set here.

Culture - Defines the currency cultures for currencies with multiple cultures

Include group separator - Displays a comma between each numeric group (e.g. 1,000,000.00)

Date Values
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Date Values have several display options, listed when clicking the Options button. To change display
settings:

1. Hover over the field in the Data Items pane
2. Click the Options button (down arrow)
3. Select the Date type (e.g. Year, Quarter, etc)
4. Optionally set the Format

Default

Full (e.g. Month = October, etc.)

Abbreviated (e.g. Month = Oct, etc.)

Numeric (e.g. Month = 10, etc.)

Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))

Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))

Time Only (e.g. Date-Hour = 10:57pm (en-US))

Color By

Scatter Charts, by default, will display your argument using a single color. 

For some scenarios, this can cause confusion. For instance, using Employee Name as the argument will
result, by default, in a single-colored point and a legend option of: Employee Name.

This can be changed by hovering over your Argument and completing the following: 

1. Click the Options button
2. Select Color by>Hue

Plotted points will now be colored by employee as listed in the legend.

Scatter Chart Tools

Scatter Charts feature a specific set of design and data tools, available from the toolbar (some options are
also available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Single Master Filter - This sets the selected Dashboard Item (e.g. Scatter Chart, etc) as a Master Filter
for all other dashboard items. Using a Single Master Filter you can only filter by one element in the
selected item.
Multiple Master Filter - This sets the selected Dashboard Item (e.g. Scatter Chart, etc) as a Master Filter
for all other dashboard items. Using a Multiple Master Filter you can filter by one or more elements in the
selected item.
Drill Down - Enables drill-in details for the Dashboard Item. For Scatter Charts, list multiple Arguments in
order of detail - least to most. When enabled the chart will reflect data for the top argument or series,
allowing you to click through to each subsequent argument, displaying results in relation to each.
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Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Dashboard Items can interact with other dashboard items marked as a Master Filter
(e.g. data displayed on the pivot is filtered by, for instance, a bar chart). Clicking Ignore Master Filter
removes interactivity.

Design Tab

Scatter Charts allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Rotate - Rotates the X and Y Axes

X-Axis Settings
o Reverse - Reverses the order of the Y-Axis Values
o Show Grid lines - Show/Hide grid lines
o Show Axis - Show/Hide the axis labeling
o Show Title - Configures the title by default or as Custom Text
o Logarithmic scale - Check to show numerical values using a logarithmic scale. Set the logarithmic

base with the drop down to the right.
Y-Axis Settings
o Always show zero level - Show/Hide the zero point on the Y-Axis.
o Reverse - Reverses the order of the Y-Axis Values
o Show Grid lines - Show/Hide grid lines
o Show Axis - Show/Hide the axis labeling
o Show Title - Configures the title by default or as Custom Text

Logarithmic scale - Check to show numerical values using a logarithmic scale. Set the logarithmic base
with the drop down to the right.
Point Label Settings - Show/Hide Point labels which will display defined content in labels as configured for
plotted points.
Show Legend - Show/Hide the chart legend. Legend placement can additionally be defined using the
legend drop down for certain dashboard items.
Global Colors - A global color scheme colors identical data items similarly across all dashboard items

Local Colors - A local color scheme sets colors for the selected data item only

Edit Colors - Edits the Global or Local Color Schemes

4.11.1.4.5  Pies

Overview

Pies can be used to reflect segments of values and their contribution to a whole.

Adding Data

Data fields are bound to Pie Charts by dragging them to the Data Items Pane as Values, Arguments or a
Series. 

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Working with Pie Data
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Each Dashboard Item has different requirements for the data you add to it. Pie Charts use Values,
Arguments and Series.

Each Data Item can be formatted by hovering over the item and clicking the options icon (right aligned down
arrow).

Values - Represent the measure used in determining pie segments (e.g. how the pie is divided)

Argument - Data Item for which the value is calculated (e.g. how the pie is labeled)

Series - Data Item for which the pie chart is displayed. This allows you to see the contribution of value per
argument across multiple pies. 

Consider the following example for viewing Employee Utilization.

Value Argument Series

Hours (Sum) Charge Type Employee Name

This will reflect a pie chart showing each employee’s sum/percent of hours broken out by charge type.

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Formatting

Data added to pie charts is automatically formatted based on their data type. That said, formats can be
edited by clicking Options from the data item (Options Button- down arrow - becomes visible when hovering
over the data field in the Data Items pane).

For instance, if using a percentage, you would likely need to change the format to type: Percent. Likewise, if
using a date as your series, you may want to see that broken out in to quarters or months (etc.)

Numbers / Currency

To change the format for numbers or currency, hover over the data item in the Data Items pane and complete
the following:

1. Click the Options button (down arrow)
2. Select Format…
3. Configure settings as appropriate (see below)
4. Click OK

Format Type - Defaults to Auto. Options include: General, Number, Currency, Scientific, Percent.

Unit - Unit to which values should be converted

Precision - Defines the decimals to display

Currency - Defaults to Dashboard global currency setting. Specific currency settings can be set here.

Culture - Defines the currency cultures for currencies with multiple cultures

Include group separator - Displays a comma between each numeric group (e.g. 1,000,000.00)

Date Values

Date Values have several display options, listed when clicking the Options button. To change display
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settings, hover over the data item in the Data Items pane and complete the following:

1. Click the Options button (down arrow)
2. Select the Date type (e.g. Year, Quarter, etc)
3. Optionally set the Format

o Default
o Full (e.g. Month = October, etc.)
o Abbreviated (e.g. Month = Oct, etc.)
o Numeric (e.g. Month = 10, etc.)
o Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))
o Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))
o Time Only (e.g. Date-Hour = 10:57pm (en-US))

Transpose

Pie Charts support the ability to transpose arguments and series. This effectively swaps data items listed as
Arguments and Series (and vice versa).

To transpose, simply click the Transpose button located on the toolbar in the Items section of the Home Tab.

Pie Chart Tools

Charts feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Note, for Master Filters and Drill Down, Pie Charts support filtering and drill down by Argument or Series.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Single Master Filter - This sets the selected Dashboard Item (e.g. Pie Chart, etc) as a Master Filter for all
other dashboard items. Using a Single Master Filter you can only filter by one element in the selected
item (e.g. a pie segment)
o Single Master Filter is further defined by the Target Dimension which determines which Data Items

can be used as filters. For example, setting the Target Dimension to Argument allows the user to filter
other Dashboard Items by Arguments represented on the Pie Chart.

Multiple Master Filter - This sets the selected Dashboard Item (e.g. Pie Chart, etc) as a Master Filter for
all other dashboard items. Using a Multiple Master Filter you can filter by one or more elements in the
selected item (e.g. multiple segments in a pie chart)
o Multiple Master Filter is further defined by the Target Dimension which determines which Data Items

can be used as filters. For example, setting the Target Dimension to Argument allows the user to filter
other Dashboard Items by Arguments represented on the Pie Chart.

Drill Down - Enables drill-in details for the Dashboard Item. For Pie Charts, list multiple Arguments or
Series in order of detail - least to most. When enabled the pie will reflect data for the top argument or
series, allowing you to click through to each subsequent argument or series, displaying values in relation
to each. Whether to drill down using Argument or Series is determined by the Target Dimension.
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Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Dashboard Items can interact with other dashboard items marked as a Master
Filter. Clicking Ignore Master Filter removes interactivity.
Arguments - Sets the target dimension for filters and/or drill down to displayed Arguments

Series - Sets the target dimension for filters and/or drill down to displayed Series

Points - Sets the target dimension for filters (only) to displayed Points

Design Tab

Pie Charts allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Auto Arrange - Automatically arranges the pie series to fit the dimensions of the dashboard item.

Arrange in Columns - Arranges the pie charts in a defined number of columns- configured by the Count
ticker.
Arrange in Rows - Arranges the pie charts in a defined number of rows- configured by the Count ticker.

Data Labels - Defines if (and if so how) labels should display on the pie chart(s)

Tooltips - Defines if (and if so how) tooltips should display on the pie chart(s). Tooltips contain information
displayed only when hovering over a segment of the pie chart.
Show Pie Captions - Show/Hide the series label (e.g. label listed above the pie chart)

Pie & Donut - Defines if the Pie Chart should be displayed as a pie or a donut.

Global Colors - A global color scheme colors identical data items similarly across all dashboard items

Local Colors - A local color scheme sets colors for the selected data item only

Edit Colors - Edits the Global or Local Color Scheme

4.11.1.4.6  Gauges

Overview

Gauges can be used to reflect up to two values and can be used, for instance, to see the performance of a
measure compared to a target.

Adding Data

Data fields are bound to Gauges by dragging them to the Data Items Pane as an Actual, Target or a Series.
 

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Working with Gauge Data

Each Dashboard Item has different requirements for the data you add to it. 

As mentioned above, Gauges use Actuals, Targets (optional) and Series. 

The aggregated value is compared to the target, and when using a target, the Gauge can also reflect a
defined Delta.
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Each Data Item can be formatted by hovering over the item and clicking the options icon (right aligned down
arrow).

Actual - Actual data to display on the Gauge

Target - Target data to display on the Gauge

Series - Data Item for which the Gauge is displayed. Using a Series allows you to see multiple Gauges
across several data items- Years, Projects, Employees, etc).

Consider the following example for viewing Employee Performance (or Utilization).

Actual Target Series

Direct Hours PCT (Avg) Target field (Max) Employee Name

This would reflect a Gauge for each employee indicating their billable percentage in relation to the target.
You’ll also see an indicator representing the Delta - the difference between the actual and the target.

Multiple Gauges

Gauge Dashboard Items allow you to build multiple gauges per dashboard item. 

When filling the Actual and Target placeholders, you’ll notice a new set of empty placeholders appear. If
applicable, drag and drop a new set of comparisons and the gauge will create a Value icon (stack seen in the
upper-right hand corner of the dashboard item) which you can use to switch between gauges.

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Formatting

Data added to Gauges is automatically formatted based on the data type. That said, formats can be edited by
clicking Options from the data item (Options Button- down arrow - becomes visible when hovering over the
data field in the Data Items pane).

For instance, if using a percentage, you would likely need to change the format to type: Percent. Likewise, if
using a date as your series, you may want to see that broken out in to quarters or months (etc.)

Numbers / Currency

To change the format for numbers or currency, hover over the data item in the Data Items pane and complete
the following:

1. Click the Options button (down arrow)
2. Select Format…
3. Configure settings as appropriate (see below)
4. Click OK

Format Type - Defaults to Auto. Options include: General, Number, Currency, Scientific, Percent.

Unit - Unit to which values should be converted

Precision - Defines the decimals to display

Currency - Defaults to Dashboard global currency setting. Specific currency settings can be set here.

Culture - Defines the currency cultures for currencies with multiple cultures
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Include group separator - Displays a comma between each numeric group (e.g. 1,000,000.00)

Date Values

Date Values have several display options, listed when clicking the Options button. To change display
settings, hover over the data item in the Data Items pane and complete the following:

1. Click the Options button (down arrow)
2. Select the Date type (e.g. Year, Quarter, etc)
3. Optionally set the Format

o Default
o Full (e.g. Month = October, etc.)
o Abbreviated (e.g. Month = Oct, etc.)
o Numeric (e.g. Month = 10, etc.)
o Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))
o Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))
o Time Only (e.g. Date-Hour = 10:57pm (en-US))

Gauge Scale

Gauge data is represent based on a gauge scale which can be auto-assigned or customized.

This can be configured by clicking the Gauge Options icon (gear to the right of the Actual/Target
placeholders in the Data Items pane).

Scale Options include:

Minimum value - Min value for the gauge- typically zero (0).

Maximum value - Max value for the gauge

Auto - Automatically sets min and max based on the displayed values.

Delta

As mentioned above, Deltas represent the difference between the Actual and the Target used on the
Gauge.

Deltas will reflect in the form of an indicator (whether the actual exceeds the target or not) and a number.

Deltas can be configured by clicking the Gauge Options icon (gear to the right of the Actual/Target
placeholders in the Data Items pane).

Delta Options include:

Value Type - Specifies which value type should be displayed as the Delta on the Gauge

Result Indication - Sets the logic for the delta indicator. Indicators include a green up-arrow (positive
result), a red down-arrow (negative result) and a yellow warning circle.
o Greater is good - Displays positive if the actual exceeds the target
o Less is good - Displays positive if the actual doesn’t exceed the target
o Warning if greater - Displays a warning if the actual exceeds the target
o Warning if less - Displays a warning if the actual does not exceed the target
o No indication

Threshold Type -  Further rules can be applied to when a visual indicator will be displayed in the result
(e.g. display a green up-arrow only if the actual exceeds the target by 15% or $1500.00, etc.). Threshold
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Type defines the type of threshold to apply- percent or absolute value.
Threshold Value - Sets the value for the threshold (e.g. 15%, $1500, etc.).

Gauge Tools

Gauges feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Single Master Filter - This sets the selected Dashboard Item (e.g. Gauge, etc) as a Master Filter for all
other dashboard items. Using a Single Master Filter you can only filter by one element in the selected
item.
Multiple Master Filter - This sets the selected Dashboard Item (e.g. Gauge, etc) as a Master Filter for all
other dashboard items. Using a Multiple Master Filter you can filter by one or more elements in the
selected item. Multiple items can be selected by using Ctrl+Click.
Drill Down - Enables drill-in details for the Dashboard Item. For Gauges, list multiple Series in order of
detail - least to most. When enabled the gauge will reflect data for the top series, allowing you to click
(double-click if also using Master Filter) through to each subsequent series, displaying values in relation
to each.
Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Dashboard Items can interact with other dashboard items marked as a Master
Filter. Clicking Ignore Master Filter removes interactivity.

Design Tab

Gauges allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Auto Arrange - Automatically arranges the gauge to fit the dimensions of the dashboard item.

Arrange in Columns - Arranges the gauges in a defined number of columns- configured by the Count
ticker.
Arrange in Rows - Arranges the gauges in a defined number of rows- configured by the Count ticker.

Full Circular - Sets the Gauge style to full circle

Half Circular - Sets the Gauge style to half circle

Left/Right Quarter - Sets the Gauge style to quarter circle

Three Fourths Circular - Sets the Gauge style to 3/4 circle

Linear Horizontal - Displays the gauge on a horizontal line

Linear Vertical - Displays the gauge on a vertical line

Show Gauge Captions - Show/Hide the series label (e.g. label listed above the gauge)
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4.11.1.4.7  Cards

Overview

Cards are used to reflect data actuals and can be used in conjunction with additional comparative
visualizations.

Each card can display up to three values: The Actual Value and, if using a target, two Delta values. Cards
can additionally reflect a Sparkline.

Adding Data

Data fields are bound to Cards by dragging them to the Data Items Pane as an Actual, Target, Series or
Sparkline. 

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Working with Card Data

Each Dashboard Item has different requirements for the data you add to it. 

As mentioned above, Cards use Actuals, Targets (optional), Series and Sparklines.

When using a target, the aggregated value is compared to the target, displaying defined Delta values.

Each Data Item can be formatted by hovering over the item and clicking the options icon (right aligned down
arrow).

Actual - Actual data to display on the Card

Target - Target data to display on the Card

Series - Data Item for which the Card is displayed. Using a Series allows you to see multiple Cards
across several data items- Years, Projects, Employees, etc).
Sparkline - Sparklines calculate and display the variation of summarized values over time. For Cards, the
sparkline argument (date-time) will make this calculation based on the defined Actual (e.g. not the
Target).

Consider the following example:

Actual Target Series Sparkline

Direct Hours PCT (Avg) Target field (Max) Employee Name Work Date (Month)

This will reflect a Card for each employee indicating their billable percentage in relation to the target. You’ll
also see indicators representing the Delta - the difference between the actual and the target.

Multiple Cards

Card Dashboard Items allow you to build multiple cards per dashboard item. 

When filling the Actual and Target placeholders, you’ll notice a new set of empty placeholders appear. If
applicable, drag and drop a new set of comparisons and the card will create a Value icon (stack seen in the
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upper-right hand corner of the dashboard item) which you can use to switch between cards.

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Formatting

Data added to Cards is automatically formatted based on the data type. That said, formats can be edited by
clicking Options from the data item (Options Button- down arrow - becomes visible when hovering over the
data field in the Data Items pane).

For instance, if using a percentage, you would likely need to change the format to type: Percent. Likewise, if
using a date as your series, you may want to see that broken out in to quarters or months (etc.)

Numbers / Currency

To change the format for numbers or currency, hover over the data item in the Data Items pane and complete
the following:

1. Click the Options button (down arrow)
2. Select Format…
3. Configure settings as appropriate (see below)
4. Click OK

Format Type - Defaults to Auto. Options include: General, Number, Currency, Scientific, Percent.

Unit - Unit to which values should be converted

Precision - Defines the decimals to display

Currency - Defaults to Dashboard global currency setting. Specific currency settings can be set here.

Culture - Defines the currency cultures for currencies with multiple cultures

Include group separator - Displays a comma between each numeric group (e.g. 1,000,000.00)

Date Values

Date Values have several display options, listed when clicking the Options button. To change display
settings, hover over the data item in the Data Items pane and complete the following:

1. Click the Options button (down arrow)
2. Select the Date type (e.g. Year, Quarter, etc)
3. Optionally set the Format

o Default
o Full (e.g. Month = October, etc.)
o Abbreviated (e.g. Month = Oct, etc.)
o Numeric (e.g. Month = 10, etc.)
o Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))
o Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))
o Time Only (e.g. Date-Hour = 10:57pm (en-US))

Delta Options

As mentioned above, Deltas represent the difference between the Actual and the Target used on the
Card. 
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In addition to the Actual Value, each card consists of a primary and secondary delta value. The primary
delta includes an indicator (whether the actual exceeds the target or not) and a number. The secondary,
simply reflects a number.

Deltas can be configured by clicking the Gauge Options icon (gear to the right of the Actual/Target
placeholders in the Data Items pane).

Delta Options include:

Value Type - Specifies which value type should be displayed as the Delta. For Cards, this is the Primary
Delta. When setting the value type, the following secondary deltas are used:
o Actual Value - Absolute Variation, Percent Variation
o Absolute Variation - Absolute Value, Percent Variation
o Percent Variation - Absolute Value, Absolute Variation
o Percent of Target - Absolute Value, Absolute Variation

Result Indication - Sets the logic for the delta indicator. Indicators include a green up-arrow (positive
result), a red down-arrow (negative result) and a yellow warning circle.
o Greater is good - Displays positive if the actual exceeds the target
o Less is good - Displays positive if the actual doesn’t exceed the target
o Warning if greater - Displays a warning if the actual exceeds the target
o Warning if less - Displays a warning if the actual does not exceed the target
o No indication

Threshold Type -  Further rules can be applied to when a visual indicator will be displayed in the result
(e.g. display a green up-arrow only if the actual exceeds the target by 15% or $1500.00, etc.). Threshold
Type defines the type of threshold to apply- percent or absolute value.
Threshold Value - Sets the value for the threshold (e.g. 15%, $1500, etc.).

Sparkline Options

As mentioned above, Sparklines calculate and display the variation of summarized values over time. For
Cards, the sparkline argument (date-time) will make this calculation based on the defined Actual (e.g. not the
Target).

Sparklines can be configured by clicking the Gauge Options icon (gear to the right of the Actual/Target
placeholders in the Data Items pane).

Sparkline Options include:

Visible - Show/Hide the sparkline

Sparkline view type - Defines how the sparkline should be visually represented

Highlight min/max points - When checked, places a corresponding dot on the sparkline

Highlight start/end points - When checked, places a corresponding dot on the sparkline

Card Tools

Cards feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.
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Data Tab

The Data Tab includes several options for data shaping.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Single Master Filter - This sets the selected Dashboard Item (e.g. Cards, etc) as a Master Filter for all
other dashboard items. Using a Single Master Filter you can only filter by one element in the selected
item.
Multiple Master Filter - This sets the selected Dashboard Item (e.g. Card, etc) as a Master Filter for all
other dashboard items. Using a Multiple Master Filter you can filter by one or more elements in the
selected item. Multiple items can be selected by using Ctrl+Click.
Drill Down - Enables drill-in details for the Dashboard Item. For Cards, list multiple Series in order of detail
- least to most. When enabled the gauge will reflect data for the top series, allowing you to click (double-
click if also using Master Filter) through to each subsequent series, displaying values in relation to each.
Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Dashboard Items can interact with other dashboard items marked as a Master
Filter. Clicking Ignore Master Filter removes interactivity.

Design Tab

Cards allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Auto Arrange - Automatically arranges the cards to fit the dimensions of the dashboard item.

Arrange in Columns - Arranges the cards in a defined number of columns- configured by the Count ticker.

Arrange in Rows - Arranges the cards in a defined number of rows- configured by the Count ticker.

4.11.1.4.8  Cloropleth Maps

Overview

Maps allow you to visualize location-based data using colors to reflect proportional results. 

For instance, if viewing Project Revenue by State or Province on a color scale from Blue to Red, areas would
be colored as follows (areas falling in between would be a combined shade):

Low Revenue = Blue

Mid Revenue = Purple

High Revenue = Red

While Analytic Dashboard Designer uses a set of default maps, you can also load custom maps with a
Shapefile (typically contains an .shp and .dbf).

Adding Data

Data fields are bound to Maps by dragging them to the Data Items Pane as an Attribute, Value, Target, or
Measure. 
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Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Working with Data

Each Dashboard Item has different requirements for the data you add to it. 

As mentioned above, Maps use Attributes, Values, Targets (if using a Delta), and/or Measures

Each Data Item can be formatted by hovering over the item and clicking the down arrow.

Attribute - Used to associate map shapes with a data item (e.g. StateCode - ME = PostalCode - ME)

Value - Map Values can be added as singularly aggregated values or as Deltas. If formatted to use Value,
the map will color based on the calculation of value alone, if formatted as a Delta, the map will color
based on the difference between the value and the target.
Target - Target data to use in calculating a Delta

Measures - Maps allow for customized tooltips which displays when hovering over areas on the map.
When defined, tooltip information will include the added Measures.

Consider the following example:

Attribute Value Measure

State Code field bound to the map
attribute: POSTAL

Hours (Sum) Projects (Count)

This will result in color coded areas on the US Map (for example) based on the total number of hours per
state. Hovering over each state will reflect the sum of hours and the number of projects per state.

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Binding Map Attributes

As mentioned above, Attributes are used to bind map shapes to data items. For example, a data item with
state codes (e.g. ME, VA, etc.) can be bound to the POSTAL map attribute.

To do this:

1. Click the Attribute’s options icon (link icon next to the Attributes placeholder)
2. Select the Map Attribute that corresponds to the Data Item
3. Click Ok

Map Options

Map values can be calculated based on a Value (only) or a Delta.

This is set by clicking the options icon (to the right of the Value placeholders in the Data Items pane).

Value

When selecting Value, the map will calculate results based on the value alone. For example, Countries would
be colored based on their position on the scale of results.
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A Value’s Scale and Color settings include the following options:

Color Palette - Start and End Color used in associating color with points along the range (e.g. from dark
to light). Defaults to Auto, but can be customized.
Scale Settings - Defines whether to use a Percent or Absolute scale for defining colors. Number of levels,
which correlate to the number of colors used on the map, can also be customized.
Preview - Shows the proposed output of colors against the scale. To edit the Rage stop, check Allow Edit.
Edits also allow you to append, delete, end edit and cancel edit.

Click Apply to preview the selected options on the map.

Deltas

As mentioned above, Deltas represent the difference between the Actual and the Target.

When selected, Maps will color based on the Delta and will include the Value Type in the map’s tooltip.

Deltas can be configured by clicking the options icon (to the right of the Value placeholders in the Data
Items pane).

Delta Options include:

Value Type - Specifies which value type should be displayed as the Delta.

Result Indication - Sets the logic for the delta indicator. For Maps, the indicator is the color of the location
(e.g. State, County, etc.) and include green (positive result), red (negative result) and yellow (warning)
coloring.
o Greater is good - Displays positive if the actual exceeds the target
o Less is good - Displays positive if the actual doesn’t exceed the target
o Waring if greater - Displays a warning if the actual exceeds the target
o Warning if less - Displays a warning if the actual does not exceed the target
o No indication

Threshold Type -  Further rules can be applied to when a visual indicator will be displayed in the result
(e.g. display green if the actual exceeds the target by 15% or $1500.00, etc.). Threshold Type defines the
type of threshold to apply- percent or absolute value.
Threshold Value - Sets the value for the threshold (e.g. 15%, $1500, etc.).

Multiple Maps

Map Dashboard Items allow you to build multiple maps per dashboard item. 

When filling the Map Values, you’ll notice a new set of empty placeholders appear. If applicable, drag and
drop a new value or new set of comparisons (Delta) and the map will display a Value icon (stack seen in the
upper-right hand corner of the dashboard item) which you can use to switch between maps.

Formatting

Data added to Maps is automatically formatted based on the data type. That said, each Data Item can be 
formatted by hovering over the item and clicking the down arrow.

For instance, if using a percentage, you would likely need to change the format to type: Percent.
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Numbers / Currency

To change the format for numbers or currency, hover over the data item in the Data Items pane and complete
the following:

1. Click the down arrow
2. Select Format…
3. Configure settings as appropriate (see below)
4. Click OK

Format Type - Defaults to Auto. Options include: General, Number, Currency, Scientific, Percent.

Unit - Unit to which values should be converted

Precision - Defines the decimals to display

Currency - Defaults to Dashboard global currency setting. Specific currency settings can be set here.

Culture - Defines the currency cultures for currencies with multiple cultures

Include group separator - Displays a comma between each numeric group (e.g. 1,000,000.00)

Map Tools

Maps feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Single Master Filter - This sets the selected Dashboard Item (e.g. Maps, etc) as a Master Filter for all
other dashboard items. Using a Single Master Filter you can only filter by one element in the selected
item.
Multiple Master Filter - This sets the selected Dashboard Item (e.g. Maps, etc) as a Master Filter for all
other dashboard items. Using a Multiple Master Filter you can filter by one or more elements in the
selected item. Multiple items can be selected by using Ctrl+Click.
Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Dashboard Items can interact with other dashboard items marked as a Master
Filter. Clicking Ignore Master Filter removes interactivity.

Design Tab

Cards allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Load Map - Loads a map Shapefile. Using this option provides the Dashboard with a path to the
Shapefile. This means if other users try to view the map and don’t have access to the location of the
Shapefile, the map will not load.
Import Map - Imports a map Shapefile. Unlike the Load Map option, Import actually adds the map to the
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definition (XML) of the Dashboard.
Default Map - Sets the default map for the dashboard item

Lock Navigation - Locks the current scroll/zoom of the map in the viewer. Un-clicked, the map can be
navigated with scroll (click, hold and drag), zoom (double-click) and other navigational features.
Full Extent - Sets the map back to center

Shape Labels - Settings used to define map titles and tooltips

Show Color Legend - Shows/Hides the color scale

4.11.1.4.9  Geo Point Maps

Overview

Geo Point maps allow you to visualize location-based data based on latitude and longitude coordinates.

Select from one of the three map types:

Geo Point - Adds callouts to the map based on location

Bubble Map - Similar to a Scatter Chart, this map adds bubbles to the map, reflecting both weight (in size)
and color
Pie Map - Adds location-aware Pie Charts to the map

While Analytic Dashboard Designer uses a set of default maps, you can also load custom maps with a
Shapefile (typically contains an .shp and .dbf).

Adding Data

Data fields are bound to Geo Point Maps by dragging them to the Data Items Pane. While each map type
relies on different data items, they each utilize Latitude and Longitude. 

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Working with Data

Each Dashboard Item has different requirements for the data you add to it.

In addition to Latitude and Longitude coordinates, below is a list of each map type and the data they
accept.

Each Data Item can be formatted by hovering over the item and clicking the down arrow.

Geo Point - Utilize a Value field in relation to the geographic points. For instance, sum of revenue per
location.
Bubble Map - Use both Weight and Color to plot points on the map. Weight determine the size of the
bubble and Color determine the color based on a color scale.
Pie Map - Using Pie Charts, Pie Maps display a value’s contribution to the whole. This is done through
Values and Arguments. Values represent the measure used in determining pie segments (e.g. how the pie
is divided). Arguments represent the Data Item for which the value is calculated (e.g. how the pie is
labeled)

Consider the following examples:



InFocus User Manual - Current (v2020)430

© 2020 Clearview Software, Inc.

Geo Point Map

Map Type Latitude/Longitude Value

Geo Point Bound data items that contain
coordinates for lat/long

Hours (Sum)

Callouts are added to the designated map for each data point

Bubble Map

Map Type Latitude/Longitude Weight Color

Bubble Map Bound data items that
contain coordinates for lat/
long

Direct Hours (Sum) Employee Name

Bubble points are plotted on the map for each data point, colors are weighted based on the relative settings.

Pie Map

Map Type Latitude/Longitude Value Argument

Pie Map Bound data items that
contain coordinates for lat/
long

Hours (Sum) Project

Pies are added to the map for each location representing the breakout of hours spent on each project in the
area.

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Map Options

Bubble and Pie Maps allow for additional options for view each type.

Clustering

When displaying Geo Point Maps, there are instances where the number of plotted points (callouts, bubbles
or pies) are close together and make it difficult to distinguish the individual points. 

This can be avoided by grouping points near to each other using Enable Clustering, located on the Data
Tab of the toolbar.

When enabled Geo Point callouts will be grouped into a single bubble. Bubble and Pie Maps will display
grouped bubbles and pies respectively.

Bubble Maps

Bubble Maps allow you to configure the Color Palette and Scale (mentioned above). 

To edit, click the options button next to the Color placeholder and configure the following options from the 
Color Scale Options dialogue.
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Color Palette - Start and End Color used in associating color with points along the range (e.g. from dark
to light). Defaults to Auto, but can be customized.
Scale Settings - Defines whether to use a Percent or Absolute scale for defining colors. Number of levels,
which correlate to the number of colors used on the map, can also be customized.
Preview - Shows the proposed output of colors against the scale. To edit the Rage stop, check Allow Edit.
Edits also allow you to append, delete, end edit and cancel edit.

Click Apply to preview the selected options on the map.

Pie Maps

Pie Maps allow you to build multiple map layers per dashboard item. 

When filling the Map Values, you’ll notice a new set of empty placeholders appear. If applicable, drag and
drop a new value or new set of comparisons (Delta) and the map will display a Value icon (stack seen in the
upper-right hand corner of the dashboard item) which you can use to switch between maps.

Additionally, Pie Maps can be weighted to display in size relative to their summary values. To enable, click
Weighted Pies, located on the Design Tab of the toolbar.

Formatting

Data added to Maps is automatically formatted based on the data type. That said, each Data Item can be 
formatted by hovering over the item and clicking the down arrow.

For instance, if using a percentage, you would likely need to change the format to type: Percent.

Numbers / Currency

To change the format for numbers or currency, hover over the data item in the Data Items pane and complete
the following:

1. Click the Options button (down arrow)
2. Select Format…
3. Configure settings as appropriate (see below)
4. Click OK

Format Type - Defaults to Auto. Options include: General, Number, Currency, Scientific, Percent.

Unit - Unit to which values should be converted

Precision - Defines the decimals to display

Currency - Defaults to Dashboard global currency setting. Specific currency settings can be set here.

Culture - Defines the currency cultures for currencies with multiple cultures

Include group separator - Displays a comma between each numeric group (e.g. 1,000,000.00)

Date Values

Date Values have several display options, listed when clicking the Options button. To change display
settings, hover over the data item in the Data Items pane and complete the following:

1. Click the Options button (down arrow)
2. Select the Date type (e.g. Year, Quarter, etc)
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3. Optionally set the Format
o Default
o Full (e.g. Month = October, etc.)
o Abbreviated (e.g. Month = Oct, etc.)
o Numeric (e.g. Month = 10, etc.)
o Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))
o Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))
o Time Only (e.g. Date-Hour = 10:57pm (en-US))

Map Tools

Maps feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Single Master Filter - This sets the selected Dashboard Item (e.g. Maps, etc) as a Master Filter for all
other dashboard items. Using a Single Master Filter you can only filter by one element in the selected
item.
Multiple Master Filter - This sets the selected Dashboard Item (e.g. Maps, etc) as a Master Filter for all
other dashboard items. Using a Multiple Master Filter you can filter by one or more elements in the
selected item. Multiple items can be selected by using Ctrl+Click.

Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Dashboard Items can interact with other dashboard items marked as a Master
Filter. Clicking Ignore Master Filter removes interactivity.
Enable Clustering - Groups nearby objects together on the map. 

Design Tab

Cards allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Load Map - Loads a map Shapefile. Using this option provides the Dashboard with a path to the
Shapefile. This means if other users try to view the map and don’t have access to the location of the
Shapefile, the map will not load.
Import Map - Imports a map Shapefile. Unlike the Load Map option, Import actually adds the map to the
definition (XML) of the Dashboard.
Default Map - Sets the default map for the dashboard item

Lock Navigation - Locks the current scroll/zoom of the map in the viewer. Unclicked, the map can be
navigated with scroll (click, hold and drag), zoom (double-click) and other navigational features.
Full Extent - Sets the map back to center

Shape Title - Settings used to define map titles (e.g. titles displayed inside map shapes)

Show Color Legend - Shows/Hides a color legend, displaying the range of colors with associated values.
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Weighted Legend - Shows/Hides a weighted legend which displays bubble/pie sizes and associated
values.
Global Colors - A global color scheme colors identical data items similarly across all dashboard items

Local Colors - A local color scheme sets colors for the selected data item only

Edit Colors - Edits the Global or Local Color Scheme

4.11.1.4.10  Range Filters

Overview

Range Filters display chart information and allow you to integrate dynamic master filtering for other
dashboard items.

Chart Data, displayed on the Range Filter, can be added in the form of Values, Arguments and Series.

Adding Data

Data fields are bound to the Range Filter by dragging them to the Data Items Pane as Values, Arguments
or a Series. 

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Working with Range Filter Data

Each Dashboard Item has different requirements for the data you add to it. Similar to Charts, Range Filters
use Values, Arguments and Series displayed, typically, on two axes: X-Axis and Y-Axis.

Each Data Item can be formatted by hovering over the item and clicking the options icon (right aligned down
arrow).

Values - Data items which are calculated and displayed against the Y-Axis. Multiple values are supported
and can be be visualized using different Series Types (see below).
Arguments - Data items displayed along the X-Axis. A Value is displayed on the chart for each Argument.
Range Filters use this data for filtering.
Series - Data items used to create chart series. A Value is displayed on the chart for each Series within
each argument. How that Value is represented depends on the Series Type.

Series Types

Series Types provide options for visualizing chart series.

Series Options are accessed by clicking the series icon located to the right of the Values Placeholder in the
Data Items pane.

Range Filters support the following Series Types:

Bar

Bar - Displays a bar representing each Value

Stacked Bar - Displays the contribution of each Value in relation to the whole
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Full-Stacked Bar - Shows the percentage of each Value’s contribution to the whole

Point/Line

Line - Plots points, connected by a straight line for each series across each argument

Stacked Line - Shows the trend of the contribution for each value

Full-Stacked Line - Shows the trend of the percentage for each value

Area

Area - Displays a straight line connecting data points for each Value across each argument, shading the
area between the plotted line and the X Axis. Areas display a line and shading for each Series bound to
the Chart.
Stacked Area - Shows the trend of contribution for each Value, shading the area between the plotted line
and then next Series.
Full-Stacked Area - Shows the trend of percentage for each Value, shading the area between the plotted
line and then next Series.

Consider the following example for filtering other items that visualize Employee Utilization.

Values Arguments Series Series Type

Hours (Sum) Work Date (Month) Charge Type Stacked Bar

The Range Filter will display a bar for each month that shows a breakdown of direct and indirect hours. Using
the Stacked Bar, displays each hours amounts in relation to the total hours for the given month.

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Predefined Ranges

The Range Filter uses selection thumbs (window bar) to filter out data by adjusting the size and moving
across the X-Axis (timeline in most cases). The size of the selection thumb represents the range by which
data is filtered.

Predefined Ranges can be added to the Range Filter right-click options menu for quick selection.

To add a predefined range:

1. Click the Design Tab from the toolbar
o Optionally, right-click the Range Filter

2. Select Edit Periods
3. From the dialogue, double-click the periods listed in the left hand pane of the dialogue as appropriate.

Note, Custom Periods (see below) can be added/edited as needed.
o Add - Adds a custom period (see below)
o Edit - Edits the highlighted period (see below)
o Delete - Removes the highlighted period
o Default - Click to make this range the default range for the Range Filter.
o Caption - Caption to display when right-clicking the period. Editable by typing over the listed value.
o Period - Shows the effective timeframe
o Type - Shows the type of endpoints associated with the timeframe

<—> - Float. Endpoint date is relative to the current date.
|—| - Fixed. Endpoint date is Defined.
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The items listed will now reflect when right-clicking the Range Filter.

Custom Periods

Periods can be customized or created as needed from the Edit Periods dialogue by clicking Add/Edit as
appropriate. In either case, the Period dialogue will display where you can define a custom period as follows.
Note, the Period dialogue displays the resulting period below the options.

- Year - A period defined in years
o Previous Year - Entire previous year
o This Year - Entire current year. Note, this would include values beyond the current date for the current

year (e.g. through 12/31 of the current year)
o Next Year - Entire next year
o Last Years - Defined number of previous years
o Next Years - Defined number of subsequent years
o Include Current - Includes the current year in the definition of Last Years and Next Years.

Quarter - A period defined in quarters
o Previous Quarter - Entire previous quarter
o This Quarter - Entire current quarter. Note, this would include values beyond the current date for the

current quarter
o Next Quarter - Entire next quarter
o Last Quarters - Defined number of previous quarters
o Next Quarters - Defined number of subsequent quarters
o Include Current - Includes the current quarter in the definition of Last Quarters and Next Quarters.

Month - A period defined in months
o Previous Month - Entire previous year
o This Month - Entire current month. Note, this would include values beyond the current date for the

current month
o Next Month - Entire next month
o Last Months - Defined number of previous months
o Next Months - Defined number of subsequent months
o Include Current - Includes the current month in the definition of Last Months and Next Months.

Custom - A custom period
o None - Period spans the enter visible range
o Fixed - Defines a fixed start and end date (right to left respectively)
o Flow - Defines a relative start and end date (right to left respectively)

Interval - Defines the interval from the current date
Offset - Defines the offset from the current date
Example: Year (Interval), -1 (Offset) = 2015 assuming a current year of 2016.

Formatting

Data added to range filters is automatically formatted based on the data type. That said, formats can be
edited by clicking the Options button (down arrow) seen when hovering over the data item.

Date Values

Date Values have several display options. To change display settings, hover over the data item and complete
the following:
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1. Click the Options button (down arrow)
2. Select the Date type (e.g. Year, Quarter, etc)
3. Optionally set the Format

o Default
o Full (e.g. Month = October, etc.)
o Abbreviated (e.g. Month = Oct, etc.)
o Numeric (e.g. Month = 10, etc.)
o Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))
o Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))
o Time Only (e.g. Date-Hour = 10:57pm (en-US))

Range Tools

Range Filters feature a specific set of design and data tools, available from the toolbar (some options are
also available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Range Filters can interact with other dashboard items marked as a Master Filter
(e.g. data displayed on the pivot is filtered by, for instance, a bar chart). Clicking Ignore Master Filter
removes interactivity.

Design Tab

Range Filters allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Series Type - Similar to the series icon, you can set the series type from the design tab

Edit Periods - Used to add predefined ranges (discussed above)

Global Colors - A global color scheme colors identical data items similarly across all dashboard items

Local Colors - A local color scheme sets colors for the selected data item only

Edit Colors - Edits the Global or Local Color Scheme

4.11.1.4.11  Filter Elements

Overview

Filter Elements, like Range Filters, act as master filters for other items on the dashboard.

Use Filter Elements singularly or in conjunction with others to create filtering for the dashboard.

Filter Elements include:
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Combo Box - Drop-down that contains a pick list of items. Each item in the drop-down is made up of one
or many dimensions.
List Box - Presents a list of values

Tree View - Presents a list of values in a collapsible tree structure

Working with Filter Element Data

Each Dashboard Item has different requirements for the data you add to it. 

Filter Elements rely on Dimensions used for filtering other dashboard items by the corresponding values,
such as Employee Name, Project Path, etc.

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Grouping

Filter Elements can be used hierarchically by creating a Group (available from the toolbar) and then adding
the Filter Elements to it. This would allow you to filter, for instance, based on a hierarchy like
Project>Employee>Work Date. Note, Ignore Master Filters (see below) would have to be disabled for
subservient Filter Elements (the filter elements holding Employee and Work Date in the example listed here).

Formatting

Data added to range filters is automatically formatted based on the data type. That said, formats can be
edited by clicking the Options button (down arrow) seen when hovering over the data item.

Date Values

For instance, Date Values have several display options. To change display settings, hover over the data item
and complete the following:

1. Click the Options button (down arrow)
2. Select the Date type (e.g. Year, Quarter, etc)
3. Optionally set the Format

o Default
o Full (e.g. Month = October, etc.)
o Abbreviated (e.g. Month = Oct, etc.)
o Numeric (e.g. Month = 10, etc.)
o Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))
o Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))
o Time Only (e.g. Date-Hour = 10:57pm (en-US))

Filter Element Tools

Filter Elements feature a specific set of design and data tools, available from the toolbar (some options are
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also available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Filter Elements can interact with other dashboard items marked as a Master Filter.
Clicking Ignore Master Filter removes interactivity.

Design Tab

Filter Elements allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Standard - Configures pick lists with radio buttons. This limits the filter to a single value

Checked - Configures pick lists with check boxes. This allows multiple values per filter.

Show ‘All’ Value - Enables the “All” option in pick lists.

4.11.1.4.12  Images

Overview

Analytic Dashboard Designer supports the use of images when building dashboard views.

Images can be Static (image file) or Bound Images (e.g. images pulled in from a data source). Static
images are displayed on the dashboard. Bound Images must be bound to a data source, and can be used
like a normal data item with support for Master Filtering. 

That said, static images will be the most typically used image type.

Working with Images

To load a static Image, complete the following:

1. Select Images>Image from the toolbar
2. Click the Design Tab from the toolbar
3. Load or Import your image (see below)
4. Set the size mode. Options include: Clip, Stretch, Squeeze and Zoom
5. Set the image’s alignment in relation to the image data item container.
6. Click Save

For information on using Bound Images, please contact Clearview Support.

https://support.clearviewsoftware.net
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Image Tools

Images feature a specific set of design tools, available from the toolbar (some options are also available by
right-clicking the image).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Design Tab

Images allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Load Image - Loads an Image. Using this option provides the Dashboard with a path to the image file.
This means if other users try to view the image and don’t have access to the location of the image file, the
image will not load.
Import Image - Imports an Image. Unlike the Load Image option, Import actually saves the image file to
the Dashboard.
Size Modes - Determines how the image will be displayed if the image size falls outside the borders of the
data item container.
Alignment - Sets how the image should be aligned inside the data item container.

4.11.1.4.13  Text Boxes

Overview

Text Boxes can be used to display static text and/or text bound to a data item.

Static text is simply written, or loaded using the Text Box Editor (toolbar). Bound Text is loaded from a data
source.

Working with Text Box Data

Static Text can be written by clicking the Design Tab and selecting Edit. Use the Text Box Editor (rich-text
editor located next to the Design Tab in the toolbar) to format as appropriate.

For Bound Text, data fields are bound to the Text Box by dragging them to the Data Items Pane. While each
Dashboard Item has different requirements for the data you add to it, Text Boxes use Values only.

Formatting Text

Each Data Item can be formatted by hovering over the item and clicking the options icon (right aligned down
arrow). That said, while the designer will default to aggregating the field, this may not be appropriate (e.g. for
plain text fields). In this case, simply format the data item as a Min.

For instance, if adding a comments field to the text, you would hover over the field, click the options icon
and select Min.

Inserting a Field
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As mentioned above, data can be bound to text boxes. To display a bound field, complete the following:

1. Click the Design Tab (toolbar)
2. Click Edit
3. Select Insert Field. You’ll see a highlighted Select value placeholder in the text box
4. Click the Select value placeholder
5. Pick one of the bound data items from the drop-down
6. Click Save

TIP: If you’ve added data but don’t see it reflected, click the Refresh button above the Field List in the Data
Browser (left-hand pane of the designer).

Text Box Tools

Text Boxes feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Ignore Master Filter - Text Boxes can interact with other dashboard items marked as a Master Filter.
Clicking Ignore Master Filter removes interactivity.

Design Tab

Text Boxes allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

Edit - Edits the Text Box

Insert Field - Inserts a data item to the Text Box

4.11.1.4.14  Groups

Overview

Dashboard Items can be combined together into a group, allowing you to manage how they interact with
other dashboard items- both in and outside the group.

For instance, a group could be used to isolate it’s members from outside Master Filter. Likewise, items within
the group could be filtered by each other.

To create a group, complete the following:

1. Click Group from the toolbar
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2. Drag-and-drop dashboard items into the group

From the group, each dashboard item is managed by clicking the item and configuring as appropriate.

Group Tools

Groups feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the chart).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Master Filter - When enabled, items configured as Master Filters inside the group can filter items outside
the group
Ignore Master Filters - Ignore Master Filters from outside the group

Design Tab

Groups allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Grid 1” displayed at the top left of the dashboard item).

Edit Names - Used to configure display name for the Dashboard Item

4.11.1.4.15  Treemaps

Overview

Treemaps can be used to visualize data in individual slices or squares.

Adding Data

Data fields are bound to Treemaps by dragging them to the Data Items Pane as Values or Arguments.

Additionally, Hidden Data Items can be used for additional configurations, such as filtering, without
displaying the field on the Dashboard Item.

Working with Treemap Data

Each Dashboard Item has different requirements for the data you add to it. Treemaps use Values and
Arguments.

Each Data Item can be formatted by hovering over the item and clicking the options icon (right aligned down
arrow).

Values - Represent the measure for determining treemap tiles

Argument - Data Item by which the value is calculated (e.g. how the treemap is labeled)
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Consider the following example for viewing Employee Utilization.

Value Argument

Hours (Sum) Charge Type

This will reflect a treemap showing a breakdown of the amount of hours by charge type.

Multiple Values

Treemaps also support measuring multiple values per Argument by dragging additional Values into the Data
Items Pane. For example, a Treemap could measure Hours and Cost by Charge Type

Value Argument

Hours (Sum) Charge Type

Cost (Sum)

In this example, the Treemap will display a stacked icon in the caption of the treemap (upper right) which you
could use to toggle between the Hours (Sum) and Cost (Sum) values.

Grouping

Treemap data can be grouped by nested arguments. For example, a Treemap could reflect Hours by Charge
Type- grouped by Organizational Unit.

Value Argument

Hours (Sum) Organizational Unit

Charge Type

In this example, the Treemap would reflect a breakdown of hours by charge type grouped by Organizational
Unit. Grouping can be enabled by:

1. Drag multiple Arguments into the Data Items Pane in the order they should be grouped
2. Click the options icon
3. Select Group Tiles

TIP: If you’ve added data to the Treemap but don’t see it reflected, click the Refresh button above the Field
List in the Data Browser (left-hand pane of the designer).

Formatting

Data added to Treemaps is automatically formatted based on the data type. That said, formats can be edited
by clicking options icon from the data item (down arrow - becomes visible when hovering over the data field
in the Data Items pane).

For instance, if using a percentage, you would likely need to change the format to type: Percent. Likewise, if
using a date as your series, you may want to see that broken out in to quarters or months (etc.)

Numbers / Currency

To change the format for numbers or currency, hover over the data item in the Data Items pane and complete
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the following:

1. Click the Options button (down arrow)
2. Select Format…
3. Configure settings as appropriate (see below)
4. Click OK

Format Type - Defaults to Auto. Options include: General, Number, Currency, Scientific, Percent.

Unit - Unit to which values should be converted

Precision - Defines the decimals to display

Currency - Defaults to Dashboard global currency setting. Specific currency settings can be set here.

Culture - Defines the currency cultures for currencies with multiple cultures

Include group separator - Displays a comma between each numeric group (e.g. 1,000,000.00)

Date Values

Date Values have several display options, listed when clicking the Options button. To change display
settings, hover over the data item in the Data Items pane and complete the following:

1. Click the Options button (down arrow)
2. Select the Date type (e.g. Year, Quarter, etc)
3. Optionally set the Format

o Default
o Full (e.g. Month = October, etc.)
o Abbreviated (e.g. Month = Oct, etc.)
o Numeric (e.g. Month = 10, etc.)
o Long (e.g. Date-Hour = Saturday, October 15, 2016 10:57pm (en-US))
o Short (e.g. Date-Hour = 10/15/2016 10:57pm (en-US))
o Time Only (e.g. Date-Hour = 10:57pm (en-US))

Treemap Tools

Treemaps feature a specific set of design and data tools, available from the toolbar (some options are also
available by right-clicking the Treemap).

All toolbar items feature tool tips which explain (in short) the core functionality of the toolbar option.

Data Tab

The Data Tab includes several options for data shaping.

Note, for Master Filters and Drill Down, Treemaps support filtering and drill down by Argument.

Edit Filter - Use to add/edit filters on the grid based on displayed or Hidden Data Items.

Clear - Clears all filters

Single Master Filter - This sets the selected Dashboard Item (e.g. Treemap, etc) as a Master Filter for all
other dashboard items. Using a Single Master Filter you can only filter by one element in the selected
item (e.g. single segments in a treemap)
Multiple Master Filter - This sets the selected Dashboard Item (e.g. Treemap, etc) as a Master Filter for
all other dashboard items. Using a Multiple Master Filter you can filter by one or more elements in the
selected item (e.g. multiple segments in a treemap)
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Drill Down - Enables drill-in details for the Dashboard Item. For Treemaps, list multiple Arguments in
order of detail - least to most. When enabled the Treemap will reflect data for the top argument or series,
allowing you to click through to each subsequent argument, displaying values in relation to each.
Cross Data-Source Filtering - Allows a Master Filter to affect data items displaying data from other data
sources.
Ignore Master Filter - Dashboard Items can interact with other dashboard items marked as a Master
Filter. Clicking Ignore Master Filter removes interactivity.

Design Tab

Treemaps allow the following design options.

Show Caption - Shows/Hides the caption (e.g. “Treemap 1” displayed at the top left of the dashboard
item).
Edit Names - Used to configure display name for the Dashboard Item

Slice and Dice - Sets the layout to display in linear bars based on the value size

Squarified - Sets the layout to display in tiles

Striped - Similar to Squarified the layout is set to display in tiles, however the tiles are displayed by
columns or rows
Layout Direction - Specifies the order of layout for the Treemap

Labels - Defines if (and if so how) labels should display on the Treemap

Tooltips - Defines if (and if so how) tooltips should display when hovering your mouse over the Treemap.

Group Labels - Defines if (and if so how) group labels should display on the Treemap

Group Tooltips - Defines if (and if so how) group tooltips should display when hovering your mouse over a
Treemap Group.
Global Colors - A global color scheme colors identical data items similarly across all dashboard items

Local Colors - A local color scheme sets colors for the selected data item only

Edit Colors - Edits the Global or Local Color Scheme

4.11.1.5 Adding Data Sources (Advanced)

Overview

 Advanced Users 

Each Analytic Model relies on a data source for the data it contains. Analytic Dashboards support both native
(InFocus) and third party data sources- selected when building the design. This means that, in addition to
your InFocus data, you can now visualize outside data across other areas of business- making InFocus a
central hub for business analysis.

Third party data sources are considered either External (e.g. SQL Database, etc.) or Custom (e.g. SQL,
OLAP, Microsoft Excel / CSV, etc.). External Data Sources can be configured globally in AD>Global
Settings for use in the designer or the SQL Query applet. Custom Data Sources are only added when
designing with the Analytic Dashboard Designer.

Once a data source is added to a dashboard view and saved, that data source and it's connection info is
embedded in the dashboard definition. Until the data source is removed from the design, the connection will
be preserved. If a dashboard view is exported for use in another InFocus database, the connection info is
preserved in the new dashboard definition file (.dashboard) until otherwise removed from it.

Please Note: Most users will simply use the default InFocus data source.
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4.11.1.5.1  Using External Data Sources

Overview

External Data Sources allow you to reach outside of InFocus and draw from third-party data sources for
analysis.

External Data Sources and their connection settings are configured in AD>Global Settings and thereby made
available to applets such as SQL Query and Analytic Dashboard Designer

Tutorial

To add an external data source, complete the following from the Analytic Dashboard Designer (UT>Analytic
Dashboard Designer):

1. Click the Data Source tab from the toolbar
2. Click Add External Data Source. A list of data sources configured in Global Settings will appear.
3. Select the Data Source

Once loaded, you can add an Analytic Model for use in the design.

4.11.1.5.2  Using Custom Data Sources

Overview

Custom Data Sources allow you to reach outside of InFocus and draw from third-party data sources for
analysis.

Custom Data Sources differ from External Data Sources in that the connection to the data source is
established from within the Analytic Dashboard Designer. Custom Data Sources feature a wizard walk
through and a native Query Builder.

Supported data sources include:

Database - SQL Database connection

Olap - Connect to an OLAP cube in a MS Analysis Services database

Microsoft Excel workbook / CSV File - Excel or CSV connection

Data extract - Used to work with data extracts

Tutorial

To add a Custom Data Source, complete the following from the Analytic Dashboard Designer (UT>Analytic
Dashboard Designer):

1. Click the Data Source tab from the toolbar
2. Click Add Custom Data Source. The Data Source Wizard will launch.
3. Complete the steps in the wizard to establish connection to the data source.
4. Click Finish
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The data source will load with the related query outputs (e.g. SQL Query, Excel Sheet info, etc.).

4.11.1.5.3  Edit/Deleting Data Sources

Overview

Once added, Data Sources can be edited and/or deleted when working in the Analytic Dashboard Designer.

Tutorial

Edit a Data Source

1. Click the Data Source tab from the toolbar
2. Click Edit Connection
3. Complete the Connection Editor dialogue
4. Click Finish
5. Click Save

Delete a Data Source

1. Click the Data Source tab from the toolbar
2. Click Delete

Please note: This removes the Data Source from the dashboard view. Use Caution.

4.11.1.5.4  Multiple Data Sources

Overview

Data Sources can be used singularly or in conjunction with other data sources when building dashboard
views. Accessed from the Data Source tab on the toolbar, you can add additional InFocus (default), External
or Custom data sources.

When designing, it's important to note that Dashboard Items (Charts, Grids, Maps, etc.) can be bound to
only one data source. That said, interactivity can be established between dashboard items across multiple
data sources.

Master Filtering (optional)

When using multiple data sources in Dashboard View, Master Filters can be applied across all data sources
using the Cross Data-Source Filtering setting, listed under the Data Tab on the toolbar . This means, for
instance, a Chart sourced from InFocus could be used to filter a grid sourced from an Excel spreadsheet or
other third party data source.

For this to work, there must be a similarly named data item (field) in each data source by which the sources
can be joined for filtering purposes.

For example, the following would support Master Filtering across data sources:

Data Source 1 | Field: Employee_Code

Data Source 2 | Field: Employee_Code
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The following would not

Data Source 1 | Field: Employee_Code

Data Source 2 | Field: EmpCode

4.11.1.6 Creating an Analytic Dashboard

Overview

With a good understanding of how the Designer is laid out and the moving parts, you’re ready to walk
through the process of creating an Analytic Dashboard design.

Please note, dashboard designs use a Data Source (defaults to InFocus) and a Query (typically an Analytic
Model - managed via UT>Dashboard Queries Manager). When clicking New, you’ll be prompted to select an
Analytic Model- the data source will default to InFocus.

Tutorial

Please complete the following steps

1. Browse to UT>Analytic Dashboard Designer
2. Click New. For our purposes here, we’ll use the default InFocus dataset.
3. When prompted for an Analytic Model, click Yes.
4. Select a model from the list. Your model will load into the left hand pane.
5. Click the Refresh icon (circular arrows) above the Query list. This populates your analytic model with data
from the data source and makes it available to the design.
6. Design your Dashboard

o Insert an item (Pivot, Grid, Chart, etc.)
o Drag-and-Drop your data fields into the Design Items pane as appropriate
o Your dashboard will populate as you add fields and other items.
o Shape and format the data as appropriate

7. Click Save and complete the dialogue that appears
o Grouping is used to organize similar Analytic Dashboards together for display purposes.

4.11.2 Analytic Dashboards

Overview

Analytic Dashboards are designed with the Analytic Dashboard Designer (UT>Analytic Dashboard Designer).

Once created, Analytic Dashboards are managed here, in the Analytic Dashboards applet (UT>Analytic
Dashboards). Similar to other reporting applets, Analytic Dashboards allow you to Edit, Copy, Delete,
Import and Export your dashboard. Other management options include activate/deactivate, grouping, titles,
etc.

Additionally, designer permissions can be granted for others to work with the dashboard design.
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Key Concepts

Below is a discussion of key concepts to understand when managing Analytic Dashboards.

Permissions

Analytic Dashboards consist of data and design. Permissions granted here are for purposes of editing
designs.

That said, when given access to edit a design, that user will inherently have access to work with the data
source connection information and query contained in the design definition.

Import/Export

Analytic Dashboards are comprised by a dashboard definition, which, at a high-level, consists of the design
definition (XML), data source connection information and the query.

When exported, these attributes are packaged into a .dashboard file which can be then imported.

While this is a powerful feature for sharing dashboards, it should be used with caution as the .dashboard file
contains data source connection and query information. Granting permission to work with an imported
dashboard, effectively grants permission to view and work with the underlying query/data.

Use Case

This feature could be used, for instance, if you run InFocus across multiple databases and wish to share
dashboard designs between them.

Limitations

While imported dashboards expose the attribute definitions needed to design and consume the dashboard
view, it does not expose the data source or query to the applets used for managing them (e.g. Global
Settings and Dashboard Queries Manager respectively).

Grouping

Grouping helps in the organization of dashboard views for display purposes in the Dashboard applet. For
instance, it may be helpful to group different views by type of analysis (e.g. Financials, Utilization, Project
Analysis, etc.).

Grouping can be established while designing (via Analytic Dashboard Designer) and subsequently edited
here as needed. Changing the grouping, will directly impact how the dashboard view is displayed on the
Dashboard.

Field Descriptions

Menu

File/Help - Lists standard InFocus File and Help options
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Toolbar

Save - Saves changes made to loaded dashboard

Edit - Loads the dashboard in to the Analytic Dashboard Designer applet for editing

Copy - Copies the loaded dashboard. Similar to custom reports, this feature can be used for test-editing
or to begin building a new dashboards with similar dashboard items already created.
Delete - Deletes the loaded dashboard

Import - Imports a previously exported dashboard definition

Export - Exports the dashboard definition to a .dashboard file.

Refresh - Refreshes the applet

Dashboard Views List Pane

Located on the left hand side of the applet, the Dashboard Views List Pane lists all available dashboard
views. Saving a dashboard view when designing via the Analytic Dashboard Designer, adds the dashboard to
this list.

Group label - Grouping assigned during Save dialogue in Analytic Dashboard Designer

Active - Check if the Dashboard view should be available to other users

Name - Name of the dashboard view

Settings & Permissions Pane

Below is a list of ways dashboard views can be configured.

Active - Check if the Dashboard view should be available to other users

Run Synchronously - Defaults to True. When False, dashboard performance may suffer, but individual
components load and render asynchronously.
Allow Action Processing - Certain Dashboard Items can be configured to process Actions when
interacting with the item. For more information on using Actions with Analytic Dashboards, please contact
Clearview Support.
Grouping - Groups the dashboard view and is used when displaying Analytic Dashboards in the
Dashboards applet. This can be overwritten or left blank.
Auto Refresh - Sets how often the dashboard view should refresh

Dashboard Name - Internal name

Title - Title seen when presented in the Dashboard applet.

Designer Permissions - Grants permissions for groups and/or users to edit the dashboard view.

Project Central Permissions - Permissions Granted here grant access to Analytic dashboards in Project
Central to be used in place of the Chart Pack layout. More on Project Central Configuration with Analytic
Dashboards 
Description tab - Enter a description for the dashboard view

4.11.3 Comment Templates

Overview 

The Comment Templates applet allows you to create and manage commet templates that can be used on

time and expense sheets.  The Comment Template allow for the entry of specific data in the Comment box. 
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This can be required either through using Labor Code Groups, Expense Code Goups or associating a level of

the WBS of a project with a Comment Template.  More on Adding Comment Templates to Projects. 

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

Preview - This allows you to see the prompt that the user will see when they go to enter data for the selected Comment

Template. 

Field Descriptions 

Comment Templates Window

Name - This column contains the name of the Comment Templates. To create a Comment Template, click

"New".  Once saved, the name will appear in this column.

Template Name - Name of the Comment Template. Name can be edited here.

Active - When checked, the Comment Template is active for use.

Comment Template Grid

Field Name - User Defined Field Name.

Label that will show in the pop-up when the user is prompted to enter data.

Data Type - Data Type of the field that is to be entered by the user.

Required - When checked, this Comment Template will require an answer for the field.

Comment Layout

Comment Layout - The layout of the comment when it us displayed in the PM Comments box.

Generate - Generates the comment layout.

Note - A Comment Template must have a Comment Layout before you hit "Save", so click the Generate link

before saving.

4.11.4 Custom Reports

Overview 

The Custom Reports applet allows the end user to construct Custom Reports (Reports, Data Grids, Actions,

Warnings) that will be housed in the application and will appear on the InFocus menus. There are several

Custom Reports available out of the box and are designated as System (i.e. Standard custom reports created
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by Clearview). Please note: Access to this applet is permissions based and knowledge of SQL is required.

Key Concepts

You can find a description of system Custom Reports in the InFocus System Reports chapter of this

manual. More on InFocus System Custom Reports

Many of the project related custom reports are designed with project leader security.

o Project Accountants can see all projects.  

o Principals-In-Charge can see projects where they are the principal or project manager.  

o Project Managers can see only projects where they are the project manager.  

o Employees with no job type in their employee setup cannot see any projects.

Access to these reports are granted through the Permissions Tab in Custom Reports, they are granted on

the Permissions Tab. More on the Permissions Tab

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.

There is a Help Center article that talks about these reports. To view that, follow this link: More on

Custom Reports

Note - Knowledge of using the Microsoft BIDS tool is required.  All customizations NOT completed by a

Clearview technician are NOT supported by Clearview Support.

Customizing a Custom Report

To create a custom Custom Report, first select the report in the Custom Report applet using the list on

the left part of the form. These designs, or a previously made custom reports, can be copied. 

The Copy function is located in the toolbar menu, click Copy. 

When clicked, it will prompt for a report name that must be unique.  Add the name and click OK.

After copying a report, it can be downloaded (Download button located on the toolbar) to a local disk

folder and modified using Microsoft Report Designer. 

When done, use the Upload function in the Report Management applet to save your design. More on

Uploading a report

4.11.4.1 Custom Reports Toolbar

Overview

https://support.clearviewsoftware.net/articles/5350
https://support.clearviewsoftware.net/articles/5350
https://support.clearviewsoftware.net/articles/5385
https://support.clearviewsoftware.net/articles/5385
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Below is a description of toolbar functionality in Custom Reports.

Field Descriptions

Menu Options

File>New - Focus cursor to define the title of the new Report, Action, Data Grid or Warning.

Tool Bar Options

New - Focus cursor to define the title of the new Report, Action, Data Grid or Warning.

Save - Saves the current changes on the Report, Action, Data Grid or Warning

Copy - Copies the current Report, Action, Data Grid or Warning to a new item.

Delete - Deletes the current Report, Action, Data Grid or Warning

Preview Report - Launches the currently selected Report, Action, Data Grid or Warning

Script - Disabled. This functionality is available through the Item Scripter applet.

Manage Parameter - Manages the parameters in use for the currently selected Report, Action, Data Grid

or Warning

Generate RDL - Generates a report file (.rdl) for the currently selected Report, Action, Data Grid or

Warning

Upload - Launches the upload .rdl dialogue

Downloads - Downloads report files for the currently selected Report, Action, Data Grid or Warning

Configure Prompt Overrides - Launches the Additional options dialogue which allows the user to

customize prompt forms

Refresh - Refreshes the applet

Launch Report Builder - Launches InFocus Report Builder

Edit Section Images/Settings - Launches a dialogue where the user can edit images and settings used on

custom reports. More info

4.11.4.2 Settings Tab

Overview

This tab contains general information related to the selected Custom Report type (Custom Report, Action,

Data Grid or Warning).

https://support.clearviewsoftware.net/articles/4264
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Field Descriptions

Active - Defines whether the selected item is active (checked)

Stored Procedure - Indicates that the Query below is a stored procedure

Use in Project Roles - Displays the Custom Report, Action, Data Grid or Warning in 

Administration>Project Roles

Allowed in Widget - Allows use of Custom Report, Action, Data Grid or Warning in the Dashboard Report

Widget

Prompt Style - Sets the stye of prompt to be utilized

Prompt Layout - Sets the layout of the prompt parameters

Output Type - Defines the output of the selected item

Query - Contains the defined query to execute

View Variables - Displays a list of allowed InFocus Variables for query writing

Update RDL Dataset(s) & Parameters - Adds created Parameters to the RDL

Manage Parameters - Launches the Report Parameters dialogue

4.11.4.3 Sections/Steps Tab

Overview

This tab defines the each step to be displayed by the report prompt. For Single prompt style, only one

Section needs to be defined, Tabbed and Wizard styles my require additional sections.

Field Descriptions

Section / Step Title - Title to be displayed at the top of the prompt

Description - Description of the section/step

Validation Script - SQL Validation can be performed at load of each section.

4.11.4.4 Sub-Reports Tab

Overview

Sub reports are added in the Sub Reports tab. A subreport is a control embedded inside the body of a parent

report and is rendered inside the parent report that contains it. Both reports are processed and displayed

simultaneously. 
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Field Descriptions

Name - Title of sub-report

Dataset - Indicates the data set to utilize in the sub-report.

Upload RDL - Uploads a report file (.rdl) to be utilized as the sub-report

Generate RDL - Generates an RDL for the sub-report

4.11.4.5 Drill-Downs Tab

Overview

Drill-Downs define drill through reports housed in your custom Report.

Field Descriptions

Name - Title of drill-down

Query - Store procedure to run for the drill-down

Upload RDL - Uploads a report file (.rdl) to be utilized as the drill-down

Generate RDL - Generates and RDL for the drill-down

Rebuild - Refreshes changes made to the drill-down query

4.11.4.6 Permissions Tab

Overview

The Permissions Tab gives a list of Users/Groups that may be granted access to the selected Custom Report

type. The concept is similar to system Permissions. More on Permissions

4.11.4.7 Modules/Applets Tab

Overview

This tab defines from which Module(s) and/or Applet(s) the selected Custom Report type can be accessed.
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Field Descriptions

Module - Indicates the module from which the custom report type can be accessed

Applet - Indicates the applet from which the custom report type can be accessed

Type - Indicates where the custom report type is accessed from within the selected applet or upon what

action the report type is launched. This setting is required when selecting an applet.

o Toolbar - Adds a toolbar option for the custom report type

o On Create - Launches the custom report type on creation of an applet record

o On Save - Launches the custom report type upon saving an applet record

o On Delete - Launches the custom report type upon deletion of an applet record

o On Load - Launches the custom report type upon the successful load of the selected applet

o On Deactivate - Launches the custom report type upon the deactivation of the loaded record

o On Submit - Launches the custom report type upon submitting a Timesheet or Expense Sheet

o On Reject - Launches the custom report type upon the rejection of a Timesheet or Expense Sheet

o On Approve - Launches the custom report type upon approval of a Timesheet or Expense Sheet

Reload - Indicates an applet screen reload upon completion of the report type in the selected applet

4.11.5 Dashboard Groups

Overview 

Dashboards are distributed to Employees using Dashboard Groups.

Configured in Utilities>Dashboard Groups, each group defines the Widgets and Dashboards (Classic and
Analytic) available to the employees assigned to the group. Dashboards created here are available to each
employee assigned to the Dashboard Group via the Dashboards menu option within the Dashboard applet.

Key Concepts

Employees are assigned a Dashboard Group which thereby governs what they can view and customize
on their personal Dashboard.
Once the Dashboard Group has been given access to a specific set of Widgets, the group can be
configured with predefined Dashboards (Classic and Analytic). These Dashboards are made available to
users who are a part of the group. When such a user logs in they will see the "Default" Dashboard
defined by the Dashboard Group. 
When a user is viewing Widgets that are part of the "Default" Dashboard for a group, they cannot alter
the specific settings of the Widget; they can only organize them on the Dashboard and choose whether or
not to show them upon login. Alternatively, a user can customize/create other Dashboards by clicking
Configure>Dashboards from the Toolbar on the Dashboard applet. This will allow them to configure and
personalize their own Dashboards- using only the Widgets that are allowed to them by their respective
Dashboard Group. 

Note:  If there are queries or alerts that reveal sensitive information, make sure they are not allowed, except
to specific Dashboard Groups.
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Field Descriptions 

Dashboard Groups Pane

Dashboard Groups - This column contains the name of the Dashboard Groups. To create a Dashboard
Groups, click "New".  Once saved, the name will appear in this column.
Name - Name of the Dashboard Groups. Name can be edited here.

Description - Internal description that describes the Dashboard Group.

Allowable Items Grid

The Allowable Items grids allow you to select the widgets available to the Dashboard Group. Not all of the
items have to be displayed on a Dashboard. The following sections discuss the different Tabs within the
Allowable Items grid.

4.11.5.1 Dashboard Groups Toolbar

Overview   

Dashboard Groups toolbar offers several options for working with Dashboard Groups. Among them is the
ability to Manage certain widgets for Classic Dashboards.

Field Descriptions

Menu Options

File/Help - Lists standard InFocus File and Help options

Manage - This brings up a pop-up that allows you to manage the following items:
o Chart Queries - When selected, a pop-up will display all system and custom Chart Queries.  Here you

are able to manage query charts.
o Alerts - When selected, a pop-up will display all system and custom Alerts.  Here you are able to

manage Alerts.
o Tiles - When selected, a pop-up will display all system and custom Tiles.  Here you are able to

manage Tiles.
o Gridgets - When selected, a pop-up will display all system and custom Gridgets.  Here you are able to

manage Gridgets.

Note While the widgets listed above can be worked with from Dashboard Groups, you can manage all
Dashboard Widgets/Queries (including Analytic Models used in Analytic Dashboards) through the Dashboard
Queries Manager applet.

Toolbar Options

New - Creates a new Dashboard Group

Save - Saves the loaded dashboard group
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Delete - Deletes the loaded Dashboard Group

Configure Dashboards - Used to configure Dashboards for the Dashboard Group

4.11.5.2 Widgets Tab

Overview 

The Widgets tab grants access to all Widgets available to a Dashboard Group. 

To allow a Widget to a Dashboard Group, simply check the box listed under Allow. Once the widget type is
allowed, items available to that widget are then allowed in the corresponding tabs (e.g. Queries, Alerts, Tiles,
Gridgets, Analytic Dashboards, etc.). The information displayed on a user's Dashboard is ultimately governed
by the widgets they have access to.

Field Descriptions 

Check All - When selected, all of the Widgets in the grid will be set to "Allowed".

Icon Column - The icon column displays the icon that represents the item type.

Allowed - When checked, the item will be available for use when configuring a Dashboard for the

Dashboard Group

Widget - List of Widgets that are available for use in either Classic or Analytic Dashboards. Note the only

widget used by Analytic Dashboards is the Analytic Container widget.

o Activities - Provide the ability to load a user's (or another specified user's) Activities.

o Alerts - The Alerts widget provides a list of predefined notifications (aka Alerts).

o Analytic Container - Widget used to display Analytic Dashboards in the Dashboard applet. This is the

only widget used by Analytic Dashboards.

o Clients - Allows the user to look up and add existing clients to a list for quick reference. Double

clicking on the client name will bring up a Business Card View, while clicking on the Search button

next to the client code will bring up the specific client record.

o Contacts - The contacts widget allows a user to look up and add an existing contact to a list for quick

reference. Double clicking on first name will bring up a “business card” view, while clicking on the

search button will bring up the specific contact record. Note: If a user does not have permission to

view the client’s applet, he will not see the Search button.

o Expense Sheet - The Expense Sheet widget lists an employee’s expense sheets and color codes

them based on current status. Double clicking a particular expense sheet will transfer the user to the 

Expense Sheet applet, with that expense sheet already loaded.

o Gridget - Provides the ability to utilize Data Grid Charts. Gridgets allow users to interact with data in

an Excel-like, editable grid and enables interactive reporting with drill-through. Gridgets can be used to

drive other Dashboard charts, work flows and other processes.

o My Projects - The My Projects widget provides Project Managers, Project Accountants, and Principals

a high level view of their respective projects. The widget provides a split view with a data grid
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containing project values and a column chart for easy viewing. Some of the columns can be drilled-

down upon for further analysis.

o Query Chart - The Query Chart widget provides a generic chart interface for predefined queries.

Twelve different chart types are supported, including: Area, Bar, Column, Doughnut, Funnel, Line, Pie,

Point, Spline, Stacked Area, Stacked Bar, Stacked Column. Depending on the type of chart, the query

must return columns in a particular manor.

Area - Similar to a Line or Plot chart, the Area chart type is used to show cumulative totals over a

period of time. The area between the axis and the line is filled with color. This makes it especially

helpful to compare multiple sets of data and the relationships between them.

Bar Graph- Shows the changes in a data series over time or compares multiple items. Types of

items are arranged vertically, while data values are plotted horizontally to emphasize variation over

time. Each row is drawn separately as a group of vertical columns. These groups are called a

series. The first string column is used as the series label. Every numeric column is displayed in the

chart.

Column - Shows the changes in a data series over time or compares multiple items. Types of

items are arranged horizontally, while data values are plotted vertically to emphasize variation over

time. Each row is drawn separately as a group of vertical columns. These groups are called a

series. The first string column is used as the series label. Every numeric column will be displayed

in the chart.

Doughnut - Similar to the Pie Chat, this shows the size of items that make up a data series

proportional to the total of the items in the series.

Funnel - Shows the size of the percentage of a given series in comparison to the total value being

compared. Each series is stacked and ordered proportionally.

Line - Emphasizes the amount of change over a period of time or compares multiple items. Data

points are plotted in series, using evenly-spaced intervals and connected with a line to emphasize

the relationships between the points. Each row is drawn as a single line (or area) on the chart, with

a number of points in the line equal to the count of numeric columns in the data set. Every numeric

column is displayed in the chart. The first numeric column encountered in the data is used for the

value of the first point, the second column for the second point, and so on.

Pie - Shows the size of items that make up a data series proportional to the total of the items in the

series. A pie chart always shows a single data series, and is useful for determining which item or

items in the series is/are most significant. The first strong column in the resulting query will be

used as the label. The first numeric column in the resulting query will be used for the slice value.

Point - Similar to the Line Chart, the Point chart emphasizes the amount of change over a period of

time or compares multiple items. The main difference visually is that the Point chart only plots the

points of the numeric columns in the data set- with no lines connecting the points in the series.



InFocus Modules and Applets 459

© 2020 Clearview Software, Inc.

Spline - Similar to the Line Chart the Spline chart emphasizes the amount of change over a period

of time or compares multiple items. The main difference visually is that the Spline chart strikes a

curved line between each point in the series.

Stacked Area - This chart is identical to the Area chart (described above) except that the fill colors

do not intersect when comparing multiple series- they are stacked, one on top of the other. This

can be helpful in clearly seeing the variance when comparing multiple series.

Stacked Bar - This chart is identical to the Bar chart (described above) except that the series data

is combined into a single bar per vertical type. This can be helpful in seeing variance when

comparing multiple series.

Stacked Column - This chart is identical to the Column chart (described above) except that the

data series are combined into a single column per horizontal type. This can be helpful in seeing

variance when comparing multiple series.

o Reports - The reports widget allows you to launch reports from the Dashboard.

o RSS Feed - The RSS Feed widget is used to consume RSS 2.0 or Atom 1.0 feeds. The feeds can be

any valid RSS URL. Double clicking one of the items in the feed will navigate the default web browser

to the particular article.

o Tiles - The Tile widget provides a predefined list of numeric outputs. Examples include: Active

Employees, Bank Balance and Revenue this Period.

o Timesheet - The time sheet widget offers a summarized view of an employee’s most current time

sheet with the ability to “jump” to that time sheet for completion or submission.

4.11.5.3 Queries Tab

Overview 

Queries are utilized by the Query Chart Widget and come in two types- System or Custom. The system

queries cannot be changed, but may be copied in order to customize in some way.

Key Concepts

To Create New Queries click Manage>Chart Queries from the toolbar. The name of the query, the chart
type, and the query itself can be specified there.

Field Descriptions 

Check All - When selected, all of the Queries in the grid will be set to "Allowed".
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Allowed - When checked, the item will be available for use when configuring a Dashboard for the

Dashboard Group

Query - List of Queries that are available for use.

System - When checked, the item is a system item. When unchecked, it is a custom item.

4.11.5.4 Alerts Tab

Overview 

The Alerts widget provides a list of predefined notifications (aka Alerts). Alerts are utilized by the Alerts

Widget and come in two types- System or Custom. The system Alerts cannot be changed, but may be

copied in order to customize in some way. 

Key Concepts

To Create New Alerts click Manage>Alerts from the toolbar. The name of the Alert, and the query itself
can be specified there. The Alerts widget assumes the first column of the resulting set of data is a string
that is itself the alert.

Field Descriptions 

Check All - When selected, all of the Alert in the grid will be set to "Allowed".

Allowed - When checked, the item will be available for use when configuring a Dashboard for the

Dashboard Group

Alert - List of Alerts that are available for use.

System - When checked, the item is a system item. When unchecked, it is a custom item.

Alerts Descriptions

Below is a description of a sampling of Alerts system alerts:

Warn on Use of At Risk -  An Alert will be generated if a project is assigned to an At Risk client (any client

displaying a stop sign in the Warnings tab in client setup).

My Scheduled Projects for Today - This will alert the logged-in user of all projects he or she is scheduled

for on the current day.

Accounts Receivable Balances - This alert will display the as of the moment balance in all A/R general

ledger accounts.
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Accounts Payable Balances  - This alert will display the as of the moment balance in all A/P general

ledger accounts.

New Projects Without a Bill Rate Schedule at The top level - This alert will report projects that do not have

a bill rate schedule assigned at the project level.

New Receipts for My Projects - The alerts the PM or PIC of new receipts on their projects.

New Sale Invoices for My Projects -  The alerts the PM or PIC of new sales on their projects.

New Consultant Invoices for My Projects -  The alerts the PM or PIC of new consultant invoices on their

projects.

Recent Projects Where I Have Been Added as a Team Member -   This alerts the logged in user of

projects they have been recently added to as a team member.

Change Orders Waiting Approval - This Alert displays any Change Orders that are waiting for approval in

Project Planning.

My New Work Orders - This Alert displays new Work Orders created for the user.

My Processed Expense Sheets - This Alert shows the user when a payment has been made for their

expenses.

4.11.5.5 Tiles Tab

Overview 

The Tile widget provides a predefined list of numeric outputs. Examples include: Active Employees, Bank

Balance and Revenue this Period. Tiles are utilized by the Tiles Widget and come in two types- System or

Custom. The system Tiles cannot be changed, but may be copied in order to customize in some way.

Key Concepts

To Create New Alerts click Manage>Tiles from the toolbar. The name of the Tile, and the query itself can
be specified there.

Field Descriptions 

Check All - When selected, all of the Alert in the grid will be set to "Allowed".

Allowed - When checked, the item will be available for use when configuring a Dashboard for the

Dashboard Group

Tile - List of Tiles that are available for use.

System - When checked, the item is a system item. When unchecked, it is a custom item.
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4.11.5.6 Gridgets Tab

Overview 

Gridgets provide the ability to utilize Data Grid Charts on the Dashboard. 

Key Concepts

To Create New Gridgets click Manage>Gridgets from the toolbar. The name of the Gridget, and the query/

additional options can be specified there.

Gridgets allow users to interact with data in an Excel-like, editable grid and enables interactive reporting

with drill-through. 

Gridgets can be used to drive other Dashboard charts, work flows and other processes. More on Gridgets

 

Field Descriptions 

Check All - When selected, all of the Gridget in the grid will be set to "Allowed".

Allowed - When checked, the item will be available for use when configuring a Dashboard for the

Dashboard Group

Gridget - List of Gridget that are available for use.

System - When checked, the item is a system item. When unchecked, it is a custom item.

Gridget Descriptions

Below is a description of a sampling of system Gridgets:

Clients-Active - Displays a dynamic list of active Clients and can be filtered by Client Code or Name.

Double clicking in either the Code or Name fields launches the Client applet and loads the selected Client

record.

Employees-Active - Displays a dynamic list of active Employees and can be filtered by Employee Code or

Name. Double clicking in either the Code or Name fields launches the Employee applet and loads the

selected Employee record.

Expense Sheet-Approver - Displays a list of all submitted but unapproved Expense Sheets for employees

where the logged in user is the Time/Expense Approver- default or alternate. Double clicking the listed

Expense Sheet loads the detail in the Expense Sheet - Approver Detail Gridget. Other options include:

o Open - Opens the listed Expense Sheet in the Expense Sheets Applet

o Approve - Approves the selected Expense Sheet

o Reject - Prompts for a rejection reason and, if given, Rejects the selected Expense Sheet
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Expense Sheet-Approver Detail - This is a dynamic child of the Expense Sheet - Approver Gridget and

displays the detail for the currently selected row.

Projects-Recent - This displays Project information for projects added to InFocus within the past week.

Other options include:

o Edit - Launches a prompt which allows the user to quickly update project information from the

Dashboard.

o View - Launches the selected Project in the Projects applet

o Plan - Launches the selected Project in Project Planning

o Central - Launches the selected Project in Project Central

Time Sheet-Approver - Displays a list of all submitted but unapproved Time Sheets for employees where

the logged in user is the Time/Expense Approver- default or alternate. Double clicking the listed Time

Sheet loads the detail in the Time Sheet - Approver Detail Gridget. Other options include:

o Open - Opens the listed Time Sheet in the Timesheets Applet

o Approve - Approves the selected Time Sheet

o Reject - Prompts for a rejection reason and, if given, Rejects the selected Time Sheet

Time Sheet-Approver Detail - This is a dynamic child of the Time Sheet - Approver Gridget and displays

the detail for the currently selected row.

Trial Balance-Summary - Clicking the Refresh button on this Gridget launches a dialogue that allows the

user to run a Trial Balance summary for a specified date range. Filter options include:

o Org Unit

o Consolidated

o Accrual or Cash Basis

o Include End of Year entries

Trial Balance-Detail - This is a dynamic child of the Trial Balance - Summary Gridget and displays the

detail of the selected account. Additionally, this Gridget includes clickable links to the Journal line items

displayed on the grid.

Utilization by Org-Summary - Clicking the Refresh button on this Gridget launches a dialogue that returns

Utilization information grouped by Organizational Unit. Filter options include:

o Start Date - Starting work date as compared to time sheets

o End Date - Starting work date as compared to time sheets

o Method - Work hours or bill hours as store in time sheets

o Group By - Level of org structure

o Exclude Holidays - Exclude time entries on date in holiday calendar 

o Exclude Benefit Projects - Exclude time entries against projects set up in benefit accrual

Note -  Gridget results are based off of employee home org. stored in time sheet that is derived from
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employee setup at time of time sheet entry. Exclude options exclude those hours from both actual and goal

amounts

o Summary Grid Columns include:

o Org Path

o Org Name

o Goal %  - Target Pct from employee set up

o Actual % - Total hours against direct projects divided by total hours

o Direct - Total hours against projects with a charge type of billable

o Total - Total, hours regardless of project charge type

o Goal Amount - Weeks day (Monday thru Friday) multiplied by standard hours from Global Settings 

o multiplied by target PCT.  Only weekdays with hours entered are included

o Goal Variance - Direct less goal amount

Utilization by Org-Detail - This is a dynamic child of the Utilization by Org - Summary Gridget and displays

the detail of the selected row- by Employee.

4.11.5.7 My Project Columns Tab

Overview 

The My Project Columns Widget provides Project Managers, Project Accountants, and Principals a high level
view of their respective projects. The Widget provides a split view with a data grid containing project values
and a column chart for easy viewing. Some of the columns can be drilled down for further analysis. The
columns available to this Widget are defined here on the My Project Columns Tab.

Field Descriptions 

Check All - When selected, all of the Gridget in the grid will be set to "Allowed".

Allowed - When checked, the item will be available for use when configuring a Dashboard for the

Dashboard Group

Column - List of Columns that are available for use.

4.11.5.8 Analytic Dashboards Tab

Overview 

The Analytic Dashboards tab displays a list of Analytic Dashboard views available to the Dashboard Group.
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To use when configuring a Dashboard, simply check the box listed under Allow.

Field Descriptions 

Check All - When selected, all of the Analytic Dashboard views in the grid will be set to "Allowed"

Allowed - When checked, the item will be available for use when configuring a Dashboard for the
Dashboard Group
Grouping - Defines the grouping for the view when displayed on the Dashboard

Name - Name of the Analytic Dashboard view

4.11.5.9 Employees Tab

Overview 

The Employees tab displays those employees who are assigned to the Dashboard Group in their Employee
File (HR> Employees> Employee Information Tab> Company Information Section). 

Field Descriptions 

Emp Code - Employee Code

Emp Name - Employee Name

4.11.5.10Configure Dashboards

Overview

Once the Dashboard Group has been created and Widgets allowed, Dashboards can be configured for the
Dashboard Group. Dashboards created here are available to each employee assigned to the Dashboard
Group via the Dashboards menu option within the Dashboard applet. Each group can have multiple
dashboards configured as Classic or Analytic.

Dashboards can be configured by clicking Configure Dashboards from the Dashboard Groups toolbar.
From the dialogue that loads, you'll use the Dashboards pane (left-hand) pane to create, edit and/or remove
dashboards available to the group.

Once a dashboard has been selected from the drop-down, widgets can be added to it and configured as
appropriate.

Tutorials

Below are the basic steps for configuring Classic and Analytic Dashboards.

Classic Dashboards
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1. Click Configure Dashboards from the toolbar. The dialogue will load.
2. Create a new Dashboard by clicking + from the Dashboards drop-down
3. Select Classic Dashboard
4. Add Widgets to the Dashboard

o Click the + at the bottom left of the dialogue
o Select a Widget
o Click Ok

5. Double-click the newly added Widget. The Widget can be renamed by clicking the Rename button.
6. Configure the Widget as appropriate
7. Click Save

Additional Widgets can be added/removed as appropriate.

Analytic Dashboards

1. Click Configure Dashboards from the toolbar. The dialogue will load.
2. Create a new Dashboard by clicking + from the Dashboards drop-down
3. Select Analytic Dashboard
4. Click Show for each view you wish to include on the Analytic Dashboard.
5. Click Save

Field Descriptions

Dashboards Pane (left-hand)

- Drop-down - Lists already configured dashboards by name. Default is listed if no other dashboards have
been configured.
- Add a Dashboard (+) - Adds a new dashboard to display in the Dashboards applet
- Delete (X) - Deletes the currently loaded dashboard
- Edit (pencil) - Edits the name of the currently loaded dashboard
- Widgets pane - Lists the widgets displayed on the loaded dashboard. Double click the listed widget to
configure.
- Add a Widget (+ lower left) - Adds a new widget to the loaded dashboard
- Delete a Widget (X lower left) - Removes the widget from the currently loaded dashboard
- Rename - Edits the name of the currently loaded widget

Widget Configuration Pane (right-hand)

The right hand pane is used to configure selected widgets. Double-click the widget in the Dashboards pane
to configure.

Save - Saves widget configurations for the loaded dashboard

Close - Closes the dialogue

4.11.6 Dashboard Queries Manager

Overview 

Dashboard Widgets are fed by queries, which can be managed, centrally, in Dashboard Queries Manager.
Accessed via UT>Dashboard Queries Manager, queries are categorized by the type of widget they support.
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Alerts

Analytic Models

Chart Queries

Gridgets

Tiles

Queries can be managed and/or created by selecting the type from the primary dropdown. You’ll note, toolbar
options and available queries are listed based on the selected type and can be filtered as System, Custom or
Both.

Creating a Query

Advanced users only

1. Select a query type from the dropdown
2. Click + New (Query Type) from the toolbar
3. Enter the query
4. Configure type-specific settings (discussed in the articles that follow)
5. Preview the results if supported by the type
6. Click Save

Managing Queries

1. Select a query type from the dropdown
2. Double-click the query you wish to manage
3. Configure type-specific settings (discussed in the articles that follow)
4. Click Save

Field Descriptions

Below is a list of standard fields/buttons and their descriptions.

Menu

• File/Help - Lists standard InFocus File and Help options

Toolbar

New - Click to add a new query from the list of types
o New (Query Type) - Click to create a new query for the selected query type

Save - Saves work completed in the applet

Delete - Deletes the loaded query

View Variables List - Lists the set of InFocus Variables and associated descriptions

4.11.6.1 Alerts

Overview

Alert queries are used to feed Alerts build for Classic Dashboards and simply consist of a title and query.
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Field Descriptions

Title

Query - SQL query. Must include a return labeled retmsg which defines what displays in the alert widget.

4.11.6.2 Analytic Models

Overview

Analytic Models (or queries) are used to feed dashboards designed with the Analytic Dashboard Designer.
Generally, models are written for performing business analysis and should be written with the end user in
mind (e.g. using decipherable return names, etc.). In addition to the query, you can leverage Parameters,
Field/List Descriptions and Permissions.

Permissions to Analytic Models allow the designated users access to the model when using the Analytic
Dashboard Designer.

Note - Clearview has made several InFocus-optimized models available via InFocus Marketplace. For more
information on installing Analytic Models from the InFocus Marketplace, click here.

Tutorials

Managing Analytic Models

Below is a tutorial for managing Analytic Models and making them available to your designers.

1. Browse to Utilities>Dashboard Queries Manager
2. Select Analytic Models from the drop-down

o Note, if Analytic Models have not been installed, download one from InFocus Marketplace to get
started.

3. Double-click the model you wish to manage
4. Edit the model as appropriate (see descriptions below)

o Most users will simply work with distributing pre-written models (as discussed above)
o If writing your own model, as a best practice use Field Lists/Descriptions to describe the fields

contained in the model. This will be helpful when designing the dashboards.
5. Distribute the Model for use in the designer

o Click the Model Permissions tab
o Assign permissions as appropriate

6. Click Save

Creating Analytic Models

Advanced Users Only

If you’ve been tasked with creating Analytic Models for your firm, below is a step-by-step guide for building
them.

1. Browse to UT>Dashboard Queries Manager
2. Select Analytic Model from the query type drop-down
3. Click + New Analytic Model from the toolbar

https://support.clearviewsoftware.net/marketplace
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4. Enter the query
5. Configure settings (see descriptions below)
6. Assign Permissions
7. Click Save

Your Analytic Model will now be available for use in the Analytic Dashboard Designer.

Field Descriptions

Title

Description - Model description

Query - SQL Query

Parameters - Parameters can be mapped to and used to define undeclared query variables at runtime.
Default Values can be configured and will be used when processing the query (server-side). Parameters
can be defined by the user at runtime by checking Create Dashboard Param.
o Param Name - Parameter name as it appears in the query. Note, SQL syntax is not needed here (e.g.

@AsOf should be listed as AsOf).
o Data Type - Associated data type
o Default Value - Sets the default value to be used by the SQL variable
o Create Dashboard Param - When checked, the parameter will be automatically added to designs

using the model. Users will be able to set the parameter while designing dashboards using the model
and when viewing in the Dashboard applet.

Field List/Descriptions - Lists fields used in the query and their descriptions. This can be referenced when
using the model in the Analytic Dashboard Designer.
o Generate Field List - Generate a field list from the query. Once generated, you can then add

associated descriptions.
Model Permissions - When checked, users can access the model when designing dashboards with the
Analytic Dashboard Designer.

4.11.6.2.1  Variables List

InFocus supports custom variables for use in advanced query applets like SQL Query, Custom Reports and
Dashboard Queries Manager. Variables are referenced in queries using the following syntax @variable@

Variable Type Description Example

Accounting

@CURRENTPERI
ODCODE@

Current Period Code 2019-12

@CURRENTPERI
ODEND@

Current Period End Date 2019/12/31

@CURRENTPERI
ODMONTH@

Current Period Month 12

@CURRENTPERI
ODSTART@

Current Period Start Date 2019/12/01

@CURRENTPERI
ODYEAR@

Current Period Year 2019

@INVOICEPERIO
DCODE@

Invoicing Period Code 2019-12

@INVOICEPERIO
DEND@

Invoicing Period End Date 2019/12/31
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@INVOICEPERIO
DMONTH@

Invoicing Period Month 12

@INVOICEPERIO
DSTART@

Invoicing Period Start Date 2019/12/01

@INVOICEPERIO
DYEAR@

Invoicing Period Year 2019

@LASTPERIODC
ODE@

Last Period Code 2019-11

@LASTPERIODE
ND@

Last Period End Date 2019/11/30

@LASTPERIODM
ONTH@

Last Period Month 11

@LASTPERIODST
ART@

Last Period Start Date 2019/11/01

@LASTPERIODYE
AR@

Last Period Year 2019

Company

@COMPANYNAM
E@

Company Name Pulls the Company Name from Global Settings> General Tab>
Company Name & Log-in Type section> Name

Date/Time

@AMPM@ AM or PM PM
@DAY@ Current Day of the Month 27
@DAY2@ Current Day of the Month

(Padded)
27

@HOUR@ Current Hour 6
@HOUR2@ Current Hour (Two Digits) 06
@LASTMONTHEN
D@

End of the Month 2019/11/30

@LASTMONTHST
ART@

Start of the Month 2019/11/01

@MINUTE@ Current Minute 33
@MINUTE2@ Current Minute (Two

Digits)
33

@MONTH@ Current Month Number 12
@MONTH2@ Current Month Number

(Padded)
12

@MONTHEND@ End of the Month 2019/12/31
@MONTHSTART
@

Start of the Month 2019/12/1

@NEXTMONTHEN
D@

End of the Month 2020/01/31

@NEXTMONTHST
ART@

Start of the Month 2020/01/01

@NOW@ Current Date and Time on
the Server

Dec 27 2019  6:33PM

@SECOND@ Current Second 3
@SECOND2@ Current Second (Two

Digits)
03

@TIME@ Current Time  6:33 PM
@YEAR@ Current Year 2019
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@YEAR2@ Current Year (Two Digits) 19
@YEAREND@ End of the Year 2019/12/31
@YEARSTART@ First of the Year 2019/1/1

Global Variables

@EBBT@
@EBITDA@
@EmptyName@ -- Unspecified --
@ProjectAddressN
ame@

Project Location

User

@MYCODE@ Logged in user's
Employee Code

@MYEMPID@ Logged in user's
Employee ID

@MYID@ Logged in user's
Employee ID

@MYUSERID@ Logged in user's User ID
@MYUSERNAME
@

Logged in user's
Username

4.11.6.3 Chart Queries

Overview

Chart Queries feed charts built for Classic Dashboards. Charts can be designed and previewed, here in
Dashboard Queries Manager.

Field Descriptions

Title

Chart Type - Defines the type of chart used to display the query

Colors - Used to defines colors used in the chart. Pick from the color picker (Colors link) or simply enter
hex codes (e.g. F2F2F2, FF0080FF, etc).
Action Source - Used to bind the chart to an Action (e.g. UT>Custom Reports).

Show Chart Legend - When checked a legend will be displayed on the chart

Stored Procedure - Check if the query references a stored procedure

Preview Dataset - Click to preview the raw output of the query

Preview Chart - Click to preview the chart

Query Text Box - SQL Query or stored procedure reference

Additional Options - Used to define additional attribute for the Chart Query

4.11.6.4 Gridgets

Overview

Gridget queries feed Gridgets (grid-widgets) built for Classic Dashboards. Gridgets present queried data in
grid form, but can be highly customized using a variety of additional options.
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Field Descriptions

Title

Action Source - Used to bind the chart to an Action (e.g. UT>Custom Reports).

Stored Procedure - Check if the query references a stored procedure

Preview Gridget - Click to preview the Gridget

Query Text Box - SQL Query or stored procedure reference

Reset Additional Options - Resets selections made in the Additional Options dialogue to default values

Generate Column Settings - ???

Additional Options - Used to define additional attribute for the Gridget

4.11.6.5 Tiles

Overview

Tile queries feed Tiles built for Classic Dashboards.

Field Descriptions

Title

Tile Text - Default text for the tile

Tile Size - Tile Text size

Caption - Default caption to display on the tile

Caption Size - Caption text size

ForeColor - Text color

BackColor - Tile background color

Format - Formatting to apply to the tile text (e.g. c = currency)

Preview - Click to preview the tile

Stored Procedure - Check if the query references a stored procedure

Query - SQL query. Must include a return labeled tiletext and caption which defines/overrides the Tile
Text and Caption respectively.

4.11.7 Document Manager

Overview  

Document Manager makes it easy to upload relevant documents to InFocus. Use Automated Invoicing to
archive invoices directly to InFocus or attach receipts on the go with InFocus Mobile Expense Sheets.

Next: Document Manager - Moving Parts

4.11.7.1 Moving Parts

Document Manager uploads documents to the server where the documents are stored and made available to
InFocus. Based on the type of document you're uploading, InFocus makes your documents available
throughout the application right where you need them.
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Additionally, you can configure permissions to each document so the right staff as access.

Permissions - Governs user access to Document Manager applet and defines who can view your
documents
Server Setup - If you're self-hosting InFocus, you'll need to ensure InFocus can communicate with your
server. If you're on InFocus Cloud, you're all set- we take care of this for you.
Document Types - Define the types of documents you'll upload and where they're made available in
InFocus

Next: Permissions Setup

4.11.7.2 Permissions Setup

Overview

There are two types of permissions when working with Document Manager: Access permissions to the
Document Manager applet (discussed here) and View rights assigned to Document Types.

Access Permissions for working with Document Manager are assigned in AD>Permissions.

Tutorial

Please complete the steps below to grant access permissions as appropriate.

1. Browse to Administration>Permissions
2. Select the Groups and/or Users you wish to grant permissions to
3. On the row next to the Group/User, click the lockbox. A dialogue will display.
4. From the Groups and/or Users Permissions tab, grant permissions as appropriate. Below is a list of

permissions and what they grant access to.
5. Once the permissions have been selected, click Save.

Module Applet Special Rights Description

Utilities Document Manager n/a Used to manage 

Document Types and

user view rights

Next: Server Configuration (Self-Hosted)

4.11.7.3 Server Configuration (Self-Hosted)

Overview

If you're self-hosting InFocus, you'll need to complete server setup to ensure InFocus can communicate
with your server. This requires two points of configuration: Server and InFocus setup.

https://support.clearviewsoftware.net/articles/5427
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Note! This article is only for firms who self-host InFocus. If you're on InFocus Cloud, you're all set- we take
care of this for you.

Server Setup

From the server, you'll configure the document repository.

The document repository can be found in the InFocus installation directory commonly located at C:\Program
Files\Clearview Software\InFocus\Client\Documents.

Please ensure the following configuration from your InFocus Server:

1. Browse to the Documents folder within your InFocus installation directory (e.g. C:\Program Files
\Clearview Software\InFocus\Client\Documents)

2. Establish Modify permissions to the Documents folder for the IIS user. Typically this is Local
System, however this can be verified by checking the Log On As user for the World Wide Web Publishing
service (services.msc). Alternatively this requirement can be met by granting Modify access to the
Everyone user.

InFocus Setup

Document Manager is enabled for InFocus via Global Settings where you'll turn on the feature and establish
a connection to the document repository.

Heads up! If you're currently using Document Manager with the Use Legacy Document Management
(deprecated) option selected, please Upgrade Document Manager before moving forward.

1. Browse to AD>Global Settings>Document Management tab
2. Click the On button under Document Management Features
3. Select the Use HTTP Document Management (recommended)
4. Enter your InFocus Launch URL, replacing the Document Base URL with your InFocus Launch page

URL (e.g. http:// _server_name_/infocus)
5. Click verify
6. You should receive a Verification Succeeded message
7. If so, click Remove Legacy Document Repository Settings

Next: Configuring Document Types

4.11.7.4 Configuring Document Types

Introduction

Documents are uploaded to InFocus organized by type (e.g. Invoices, Receipts, Contracts, etc).

Types work like folders. Each folder (type) has permissions and applet settings to define who can view/
upload documents to it and from where those documents can be accessed/uploaded.

Document type permissions include the following options:

View - enables the user to upload and view documents

https://support.clearviewsoftware.net/articles/5427
https://support.clearviewsoftware.net/articles/4090
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Modify - inherits view access with the additional ability to overwrite existing documents

TIP! When uploading documents, you can set additional permissions per document

Note! If you're not on InFocus Cloud you'll need to enable Document Management if you haven't done so
already.

Configuring Document Types

InFocus comes out-of-the-box with the listed system types, but you can create additional custom types to
organize your documents.

System Types

Let's configure the system types.

1. Browse to Utilities>Document Manager
2. Click Permissions next to the Invoices system type
3. Set permissions as appropriate
4. Click Save to close the dialog
5. Click Applets
6. For this tutorial, review the preconfigured Applets where Invoices can be accessed (e.g. uploaded,

downloaded, etc.)
7. Make any changes as appropriate
8. Click Save
9. Click Save from the Document Manager toolbar

Custom Types

Next, let's configure a Custom Type.

For this tutorial, we'll configure a Document Type for Expense Receipts which can be used for attaching
receipts to Expense Sheets (etc.).

The same setup principles below can be applied when creating any Custom Type.

1. Browse to Utilities>Document Manager
2. Enter Receipts as the type name
3. Click Save from the toolbar
4. Back on the Receipts line, click Permissions
5. When prompted, set permissions as appropriate
6. Click Save to close the dialog
7. Click Applets
8. When prompted, select Expense Sheets. This will make document uploads available for this type via

InFocus Mobile Expense Sheets and Personal>Expense Sheets in InFocus Desktop.
9. Click Save to close the dialogue
10. Click Save from the Document Manager toolbar

Setup Complete

https://support.clearviewsoftware.net/articles/5427
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Read more tutorials on working with Documents in the Clearview Support Help Center (click and scroll down
to Document Manager section)

4.11.7.6 Document Manager - Applet

Overview 

Document Manager applet is used to manage Document Types. Below are key concepts and definitions
related to the options contained in this applet.

Key Concepts

Documents are uploaded to InFocus organized by type (e.g. Invoices, Receipts, Contracts, etc).

Types work like folders. Each folder (type) has permissions and applet settings to define who can view/
upload documents to it and from where those documents can be accessed/uploaded.

Document type permissions include the following options:

View - enables the user to upload and view documents

Modify - inherits view access with the additional ability to overwrite existing documents

InFocus comes out-of-the-box with a system type for Invoices, but you can create additional custom types to
organize your documents.

Field Descriptions 

Name - Name of the Document Type (e.g. Receipts, Contracts, etc.) Note that document type does not
refer to the document extension such as .pdf, .xlsx, etc.
Permissions - This is where permissions are assigned to this Document Type.

Applets - This is where you designate the applets that the selected Document Type can be accessed
through.

4.11.7.7 Documents Dialog

Overview 

Once Document Manager has been setup and Document Types have been configured, uploading a
document is straightforward.

When working in an applet that supports Document Manager you'll see a Documents button in the toolbar.
Clicking will load the Documents dialog through which you can manage documents attached to the open
applet.

Below are field definitions related to the Documents dialog.

Field Descriptions

https://support.clearviewsoftware.net/Articles/List?categoryid=1&moduleid=8


InFocus Modules and Applets 477

© 2020 Clearview Software, Inc.

Buttons

Add (+) - Launches document upload dialogue

Delete (x) - Deletes the selected document

Magnifying Glass - Displays information related to the selected document

Up Arrow - Launches document upload dialogue

Down Arrow - Launches document download dialogue

Email (envelope icon) - Launches document Email dialogue

Refresh - Refreshes the view

Document Drop

Allows you to drag and drop documents into InFocus

Document List

File Name - File name

Notes - Notes added during document upload

File Size - Size of the file (kb)

Owner - User name of the employee who uploaded the document

Date Added - Date the document was uploaded

4.11.8 EFT Files

Overview 

The EFT Files applet is where you are able to view/edit generated EFT files.  

Key Concepts

In order to see the files here, the EFT must have been generated using A/P or E/R Check writing in

InFocus.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Preview - This allows you to see the prompt that the user will see when they go to enter data for the selected Comment

Template. 

Field Descriptions 
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Dates

All EFT Creation Dates -  You will see all EFTs in the grid on the bottom half of the page.  

EFT Creation Date Range -You are to select a Date Range to filter the EFTs in the grid on the bottom half

of the page.  

Bank Accounts

All Bank Accounts -  You will see all EFTs in the grid on the bottom half of the page.  

EFT Creation Date Range -You are to select a Bank Account to filter the EFTs in the grid on the bottom

half of the page.  

Bottom Grid

Description - In this grid you will see the list of EFTs. When you expand the detail line you can view the Type,

Payee, Transaction, EFT #, and Amount of the EFT.  

Bank Account, 

Account Name

File Name

File Amount

File Date 

4.11.9 End of Year Closing

Overview 

End of Year Closing in InFocus is an automated journal entry. The purpose is to take the year-to-date

amounts in all income and expense accounts and reverse them into retained earnings. This effectively zeros

out the income and expense accounts for a fiscal year.

Key Concepts

The journal entry is made to the General Journal and is flagged as a closing entry. This allows the entry

to be ignored for profit and loss type financial statements. The entry is posted in the last period of the

fiscal year in question with a transaction date equal to that periods end date.

For cash base conversion, the utility must be run twice - once for cash and once for accrual. More on

Cash Basis Conversion

This utility can be run as many times as needed for a given year. If all amounts are zero, no entry will be
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posted.

For complete instructions on End of Year processes follow this link: More on End of Year Processes

Field Descriptions 

Fiscal Year - Fiscal year to close

Retained Earnings Account - Offset account for income and expense.

Cash Accrual - Option for closing books for cash or accrual.

Org. Unit - Organizational Unit that the EOY closing is being run for. More on Organizational Units

4.11.10 Exchange Synchronization

Overview 

Exchange Contact Synchronization

This utility is part of the setup for Microsoft Exchange Sync (MES). If you are interested in using MES, please
contact Clearview Support.

Important: Detailed Setup Requirements can be found here. 

Field Descriptions

Settings/Subscribers

Service Account: Exchange Service Account used for MES

Account Password: Service Account password

Exchange EWS URL (Specify): Exchange Web Service URL

Polling Interval: Interval the system is polled for changes

Enable (Employees): Flag to allow selected employees to subscribe to MES

4.11.11 Financial Statement Designer

Overview 

Financial Statement Designer provides for flexible statement generation. Balance Sheets, Profit & Loss
(consolidated and by profit center), and other statements can be created here. This allows a group of G/L
accounts to be combined to appear on a financial statement design. Any line item can contain up to fifteen
columns, so comparatives between periods and/or budgets can be achieved. Financial statements can use
accrual or cash figures.

Financial Statement Designer allows you to utilize Sample Financial Statements, or create custom
statements. When creating custom statements, you'll define Lines and Columns to hold the rows of G/L
Accounts and G/L Periods respectively.

https://support.clearviewsoftware.net/articles/4067
https://support.clearviewsoftware.net/articles/4203
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Sample Financial Statements

InFocus comes out of the box with a set of sample Financial Statements, described in under InFocus System
Reports. These designs are based on the Chart of Accounts established by QuickStart. Even if QuickStart
was not run, the samples may be installed by following the steps below.

Installing Sample Financial Statements

1. Browse to UT>SQL Query. More on the SQL Query applet
2. In the query box, enter: fssample_sav. 
3. Click Run Query from the toolbar. Please note: SQL Queries can directly affect the InFocus

database. Use caution.

Once the query has completed, Query Execution Complete will appear in the upper right corner of the SQL
Query screen. The installed Financial Statements will be available to Financial Statement Designer.

4.11.11.1Designer Layout

The designer itself is organized into three sections: Toolbar, Header, and the Design tabs- Lines and
Columns.

In short, you'll create new Financial Statements by clicking New from the toolbar, and then defining the
Header info, Lines (G/L Account rows) and Columns (G/L Periods) to display on the statement.

4.11.11.1.1  FS Designer Toolbar

Financial Statement Toolbar can be leveraged to create new, copy system, save changes, delete and edit
common settings for statements.

Field Descriptions

Below is a list of options available from the toolbar:

Menu Options

File/Help - Lists standard InFocus File and Help options

Toolbar Options

New - Click to create a new Financial Statement

Save - Save changes to the loaded FS

Copy - Copies the loaded FS

Delete - Deletes the loaded FS

Edit Images/Settings - Edits common report settings
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4.11.11.1.2  FS Designer Header

Overview  

The Header section contains the common data for a Financial Statement design.

Field Descriptions

Statement Name - Name of the financial statement

Divide By - Number to divide all figures by. Commonly used for reporting in the, for instance, millions of
dollars (e.g. $10,000,000 / 1,000,000 = $10) 
Include Closing Entries - When checked, closing entries from the General Journal are included.

Upload Button -  Allows the user to upload custom Financial Statement Designs.

Download Button - Allows the user to download custom Financial Statement Designs.

Rebuild - Rebuilds the Dataset of the Financial Statement.

Modify Sectors - Allows you to select Market Sectors for the line selected. A User Defined Field. The
Market Sector list is managed under Administration>List Management>Market Sectors. It is assigned on
the Project at Projects>Market Sectors. More on Modifying Sectors
Modify Ranges - When selected, the Line Ranges screen comes up that allows you to filter the lines. 
More on Modifying Ranges

4.11.11.1.3  Lines Tab

Overview 

The Lines tab defines the rows to be displayed on the Financial Statement. Lines (or rows) can be added by
tabbing though each cell in the grid (descriptions below) and entering information as appropriate.

Command Types

Each row will either display static text or a listing of G/L Accounts based on one of four command types:

Text - Prints plain text entered in the Line Label column (see below)

Summarize - Prints one summarized line based on G/L Account ranges established with the Modify
Ranges Button
Itemize - Prints one line for every G/L Account retrieved from the ranges established with the Modify
Ranges Button
Consolidate - Used to consolidate rows of G/L Accounts with multiple Org. Units, this type prints one
consolidated line for every G/L Account retrieved from the ranges established with the Modify Ranges
Button. Note, only G/L Accounts marked with Can Consolidate will be consolidated.

Field Descriptions 

Line Order - Numerical order to print lines. Does not have to be continuous but must be unique within the
design
Line Label - Text to print on line; used only on Text and Summarize types.

Command Type - Line type; choices are text, summarize, itemize, and consolidate. Descriptions above.

Indentation -  Number of units to indent the line text; size of unit is determined in the report layout.
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Subtotal -  Subtotal column to print figure. Choices are 1,2 or 3. Each column in the design can be
subdivided into three columns.
% of line - Percent of line to compare to (ratio); typically used to show percent, total revenue, or expense.
A line that references itself will be 100%.
Format Group -  User-definable value that can be used for conditional print operations in the design.

Bold -  Flag to indicate line should be bolded.

Top Border - Border to be used on top edge of figures. Typically only used on summarized lines.

Right Border - Border to be used on top right edge of figures. Typically only used on summarized lines.

Bottom Border -  Border to be used on bottom edge of figures. Typically only used on summarized lines.

Left Border - Border to be used on left edge of figures. Typically only used on summarized lines.  

4.11.11.1.4  Columns Tab

Overview 

The Columns tab defines the columns to be displayed on the Financial Statement. Each column consists of
a specified calculation type and period. Columns can be added by tabbing through the grid and entering
appropriate info. Financial Statement Designer supports up to fifteen columns. 

The Columns tab is also used to define which Organizational Units should be included on the Financial
Statement using the Modify Org Units button.

Key Concepts

Calculation Types

InFocus supports the following calculation types

Transactions - Figures represent account balance (actual)

Budgets - Figures represent account budgets

Variance - Budget less Actual

Percent Variance - (Budget less Actual / Budget ) x 100

Inverse Variance - Actual less Budget

Inverse Percent Variance - (Actual less Budget / Budget ) x 100

Period Types

Period Types define both the **G/L Periods** to include on the statement and the how those periods should
be calculated at run-time.

When running Financial Statements (via GA>Financial Statements) an as-of G/L Period is selected. This
period acts as the anchor point by which other period types are defined.

For instance, if selecting G/L Period = **2016-12** at run-time, a column defined by the period type
**Current Period Minus 1** would yield a column of **2016-11**.

Column Headers

Column Headers are defined for each column on the statement.



InFocus Modules and Applets 483

© 2020 Clearview Software, Inc.

Column Headers support either plain text or a formula.

Formulas

To trigger a formula, the header text must be wrapped in brackets (e.g. […]).

Within the brackets you can have two values. For example: [-1|yyyy-MM].

The first value, -1, calculates which period to use for the formula. In this case, the negative one calculates to
the period before the selected period.

The second value is an optional format string for the Start Date of the calculated period. If none is specified,
the period code will be returned.

Field Descriptions 

Column Order - Order of column, ranging from 1 through 15 (max).

Cash/Accrual - Specify if Cash or Accrual figures are used.

Calculation Type - Specifies the calculation type (described above)

Period Type - Specifies the G/L Period to include based on a singular period entered at run time. There
are over fifty period types, the naming of which, should make their use self evident.

4.11.11.1.5  Permissions Tab

Overview

Permissions for Financial Statements are assigned here. 

Permissions
Users - Assign Permissions to a specific User to see a specific Financial Statement here.

Groups - Assign Permissions to a specific Group to see a specific Financial Statement here.

4.11.11.2Modify Options (Buttons)

Overview

Financial Statement lines and columns can be further defined by Market Sectors, Filter Ranges and Org
Units.

4.11.11.2.1  Modify Sectors

Overview

All line types except for Text can have sector filters. Sector filters are used to weight a financial statement
(revenue and expense) by Market Sectors.

When projects are set up, they can be assigned to market sectors, each at a certain percentage totaling
100%. For instance, a project can be assigned 70% to Government and 30% to Commercial. 

By using a sector filter, figures in the financial statement are multiplied by the percentage on the project.
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One or more market sectors can be included in the filter.

4.11.11.2.2  Modify Filter Ranges

Overview

Modify Filter Ranges gives you the ability to define a group of accounts to be included on the line in question.
Included accounts can be Added or Subtracted from the grand total. Any line can have an unlimited number
of Filter Ranges.

For instance, using Filter Ranges, one line with the Command Type: Itemize, could return all accounts
between 4000 and 4999.

All line types, except Text, support Filter Ranges.

Tutorial

1. Select the Line you wish to add the Filter Range to
2. Click Modify Filter Ranges. The Line Filter Criteria dialogue will launch.
3. Add Line Filters as appropriate using the dialogue (descriptions below)
4. Click Save
5. Click Close to exit the dialogue
6. Click Save from the toolbar to save the Financial Statement Design

Field Descriptions

Below are field descriptions when defining Filter Ranges.

Filter Title

Filter Title - Names the filter

Math

Add Values -  When checked, account figures are added to this range as a positive

Subtract Values - When checked, accounts figures are added to this range as a negative

Codes/Orgs Tab

Base Codes

No Criteria - When selected, no base code ranges are established

Use Mask - When selected, a mask is used (e.g. 4???). A mask works by placing a question mark (wild
card) in one or more positions of the base code. For example, 4???, would include all base accounts
beginning with 4 (e.g. 4000, 4001, etc). Likewise, 4??5 would include all base codes beginning with a 4
and ending with a 5 (e.g. 4005, 4105, etc.). Question mark means any value can appear in that position.

Use Range - When checked, the range of base codes entered is used (e.g. 4000 to 4999).
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Org Units / Companies

All Orgs - When checked, all org units are included

Specific Org Unit - When checked, only the supplied org unit is included
o Use Child Orgs - Available only when specific org unit is checked. When checked, children of the

specified org unit are also included.
Custom Org Units - When checked, org units can be combined with a like code at a specified level.
o Org Level - Org level where the code is found; available only when Custom Org Unit is checked.
o Org Code - The code on which to combine; available only when Custom Org Unit is checked.

System Types Tab

System Types can be used to include G/L Accounts that meet a certain configuration. The following settings
can be used singularly or together.

Metric Types - When checked, the list of metric types selected are included

Financial Types - When checked, the list of financial types selected are included

Cost types - When checked, the list of Cost types selected are included

PM Types - When checked, the list of PM types selected are included

FS Groups

FS Groups include only those G/L Accounts assigned to the designated FS Group.

4.11.11.2.3  Modify Org Units

Overview  

The Columns tab is used to define which Organizational Units should be included on the Financial Statement
using the Modify Org Units button.

To define Organizational Units:

1. Click Modify Org Units
2. Check Use to include the Org Unit
3. Click Save
4. Click Save from the toolbar to save the Financial Statement Design

4.11.11.3Creating a new Financial Statement

Overview

With a good understanding of the Financial Statement Designer layout and options, let’s discuss creating a
new Financial Statement.

Financial Statements can be created by copying an existing or creating new statements.
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Tutorials

Copy an Existing Financial Statement

To copy an existing statement:

1. Load the Financial Statement using the Financial Statements drop-down.
o Don’t see any? Read about how to Install Sample Financial Statements.

2. Click Copy from the toolbar
3. Enter a name for the new template
4. Edit the Financial Statement as appropriate
5. Click Save

Creating a new Financial Statement

To create a new statement:

1. Click New from the toolbar. The New Financial Statement dialogue will launch.
2. Name the Financial Statement
3. Optionally Include Closing Entries
4. Optionally Divide By a denominator
5. Select a Financial Statement Template
6. Click Create. Your statement will load in the designer.
7. Edit the Financial Statement as appropriate
8. Click Save

Field Descriptions

New Financial Statement Dialogue

Financial Statement Name - Name of the financial statement

Include Closing Entries - When checked, closing entries from the General Journal are included.

Divide By - Number to divide all figures by. Commonly used for reporting in the, for instance, millions of
dollars (e.g. $10,000,000 / 1,000,000 = $10) 
Financial Statement Templates (see below)

Financial Statement Templates

InFocus features several Financial Statement templates that can be used for building custom Financial
Statements. Each template has been designed to meet ANSI printing standards and can range from 1-15
columns.

Two-Column System Default

ANSI A 8.5X11 Letter - (1 Column)

ANSI A 8.5X11 Letter - (2 Columns)

ANSI A 8.5X11 Letter - (3 Columns)

ANSI A 8.5X11 Letter - (4 Columns)

ANSI A 8.5X11 Letter - (5 Columns)

ANSI A 8.5X11 Letter - (6 Columns)
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ANSI B 11X17 (7 Columns)

ANSI B 11X17 (8 Columns)

ANSI B 11X17 (9 Columns)

ANSI B 11X17(10 Columns)

ANSI B 11X17(11 Columns)

ANSI B 11X17(12 Columns)

ANSI C 17X22 (13 Columns)

ANSI C 17X22 (14 Columns)

ANSI C 17X22 (15 Columns)

4.11.11.4FS Dataset (Advanced)

Overview

 Advanced Users

While most Financial Statement requirements can be met using the Financial Statement Designer, some
designs will require editing the underlying report definition, contained in a .RDL file. The RDL design affects
the data that will be output to the report layout. While the actual figures and lines that appear vary by design,
the columns or fields of the Dataset are always the same. 

If you are in need of such custom statements, typically this will involve Clearview Support. That said, the
following is a list of the Dataset available in the Financial Statement designs (RDL File).

Field Descriptions 

Line Type  - Command type

Line Text - Text to print on line. This has already been processed to be either the G/L account name or
the line text from the design depending on line type.
Line Order - Sort order.

Base Code - Base code. Only relevant on types itemize and consolidate.

Org Path - Org unit path. Only relevant on type itemize.

Org Name - Org Name. Only relevant on type itemize.

Indents - Number of units to indent line text.

Subcol - Subtotal column.

IsBold - True or False; indicates if line should be bolded.

Left Border - Left border style for figures.

Right Border - Right border style for figures.

Top Border - Top border style for figures.

Bottom Border - Bottom border style for figures.

Format Group - User definable codes to use for conditional formatting.

Col1 thru Col15 - Column one through fifteen calculated figures.

Col1Pct thru Col15Pct - Column one through fifteen calculated percent of lines or rations.

4.11.12 Import Tools

Overview 

Import Tools is a powerful applet that can be used to import data from external sources to InFocus. Please
note: This is considered a part of the Advanced User Toolkit and should be used carefully as it writes directly
to your InFocus database.

http://suppprt.clearviewsoftware.net
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Key Concepts

Best Practice - In that Import Tools writes directly to your InFocus database, it’s a best practice to run

test imports in a Sandbox prior to running on production.

Microsoft.ACE.OLEDB - Import Tools leverage Microsoft data access technologies. In short, the

architecture of the local workstation’s Microsoft Office products must match the architecture (32-bit vs 64-

bit) of the local instance of Windows. More on this…

Permissions - Permissions to Import Tools is granted via Administration>Permissions. Please note,

permissions to Import Tools circumvents permissions to the applets used for import. So, while a user may

not have access to the Clients applet, they could Add and/or Update Client records via Import Tools.

For a detailed description of import tools, follow this link:  More on Import Tools

Additional Toolbar Options
Aside from the standard toolbar options this applet has the following options:

File - Additional File options

o Reset Import - Resets the import settings.

Script - Scripts the selected import.

Test Import - Runs a test of the import and displays the results on a pop-up.

4.11.12.1Import Tools Header

Overview 

The Header section is where the name for  a new import is established and the Table to be used during the

import.

Field Descriptions 

Import Name - User definable name of the import.

InFocus Data Table - The drop-down contains a list of all applets that can be imported to.

Comments - Internal Comments.

https://support.clearviewsoftware.net/articles/5432
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4.11.12.2General Tab

Overview 

The General Tab is where the Data Table is chosen (available tables are displayed in the drop down), as well

as the File Type (Delimited, Excel XLS, Access MDB, or ODBC Datasource) that will be imported.

Field Descriptions 

File Type - Data Source that is being used for the import. there are 4 options:

o Delimited - VBScript

o Excel (xls & xlsx) - VBScript

o Access (MBD & AccDB) - Access SQL

o ODBC - Contingent upon the driver. (ex. MS SQL = T-SQL, Oracle = Oracle SQL)

Use Column Headers - Use with Delimited & Excel Data Sources. When selected, the header row of the

source data will be brought in as a record.

Delimiter - Use with Delimited Data Source. When using the Delimited import, this represents the

delimiter that is used on the source data to separate the records for import.

Import File - Used with Delimited, Excel and Access Data Sources. The location of the file to be imported.

Table - Used with Excel & Access Data Sources. The name of the table that is being used as the source

data.

Data Source - Used with ODBC Data Source. Source of the data.

User - Username to access the Data Source.

Password - Password to access the Data Source.

4.11.12.3Custom Query Tab

Overview 

Custom Query tab is used to shape source data being used in the import. 

Key Concepts
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By default, when reading the data from your source, Import Tools is effectively reading: select * from [your

data source]. Using Custom Query, you can customize the return set that gets pushed to Field Mappings.

In short, Import Tools passes your query to Microsoft.ACE.OLEDB.12.0 which then communicates to the

source. The syntax used in the query is dependent upon the File Type (Data Source) configured on the

General Tab. Typically

Delimited - VBScript

Excel - VBScript

Access - Access SQL

ODBC - Contingent upon the driver. (ex. MS SQL = T-SQL, Oracle = Oracle SQL)

Field Descriptions 

Query Window - Custom Query is entered here. Knowledge of SQL is required.

Test Query - Returns a test result of the SQL Query.

4.11.12.4Field Mapping Tab

Overview 

Field Mapping Tab. Used to map the fields of the source data to the appropriate InFocus Field. 

Key Concepts

Fields listed reflect the supported fields for import

Fields in red are required. Note, the InFocus Data Table may have additional requirements. (e.g. Sales

Journal requires a project on entries using Revenue accounts).

Default Values may be added in the absence of a source field.

Columns can be excluded from the import

Field Descriptions 

Source Field - Field from the source document that will be brought over to InFocus.
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InFocus Field - Destination InFocus field that the Source Field will be imported to.

InFocus Field Description - Description of the InFocus Field. This is used to assist when trying to

determine which field to use.

Default Value - Optional. Default value of field.

Exclude -  When checked, the item is excluded from the import.

4.11.12.5Review Tab

Overview  

Review Tab. Used to map the fields of the source data to the InFocus fields.

Field Descriptions 

Import Mode

Add - Adds new records to the database

Update - Only updates existing records

Add & Update - Adds new records or updates existing records

Custom - Custom mode allows you to edit the import grid and gives you the ability to skip records as

appropriate.

Import Grid

Skip - When selected, the item will be skipped when the import is executed.

4.11.12.6Summary Tab

Overview  

Summary Tab. Displays the number of records imported and Records skipped when the utility was run.  A

Skipped Record is a record that did not have a match or was designated to be skipped (Review Tab) when

the utility was run.
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Field Descriptions 

Records Imported - The number of records imported .

Skipped Records - The number of records skipped. 

4.11.13 Invoice Design

Overview 

The Invoice Design applet is where Invoice Designs are customized in InFocus.        

Key Concepts

An invoice is composed of 2 parts, the UI (InFocus) and the RDL (Microsoft Buisness Intelligence Studio).

 A typical customization request is to add a logo to an invoice design. Here is an article that walks you

through that process, introducing you to to the concept of the UI and RDL in a hands on way. More on

Adding a Logo to an Invoice 

InFocus comes with 13 system invoice designs that are available in the Main Invoice Dropdown located

at Projects>Billing Tab.  If you want to alter a system invoice design, you must use the System Invoice

Design Copy button located on the toolbar. This will bring a copy if the selected invoice design into the

Invoice Design section. More on the Invoice Design Tab

InFocus has a unique "snap together" format that makes it easy to tailor invoices to the invoicing needs of

your firm. An invoice design is segmented into sections. Each section controls a particular area of an

invoice. The sections are managed on the Section Designs Tab. More on the Section Design Tab

An invoice design can have an unlimited number of sections. All section types, except for the Border, can

appear multiple times on an invoice; however, no section design can appear twice. The number of

sections that are on an invoice and the order of those sections are managed on the Invoice Design Tab. 

More on the Invoice Design Tab

Section designs can be reused between multiple invoice designs. For example, one Header section can

be used throughout many invoice designs.

Invoices can be categorized as labor/combined or expense only. This allows for expenses to be invoiced

separately. The Style is controlled on the Invoice Designs Tab. More on the Invoice Design Tab

Invoice designs are assigned to projects on the Bill Terms node (Project Level) at Projects>Billing Tab.

https://support.clearviewsoftware.net/articles/4021
https://support.clearviewsoftware.net/articles/4021
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One section, the Coversheet, is used to create a summary of multiple projects on the same invoice. This

is accomplished by assigning multiple projects to an Invoice Group (Clients Applet). Coversheet designs

are in turn assigned to an Invoice Group. More on Invoice Groups 

Each section has both a Layout and Dataset component. Each section has a Dataset that exposes

database fields in one or more rows. Some sections, such as Labor, ODC, and OCC, vary the Dataset

based on user-selected options. 

Other sections, such as Header and Summary, have preset Datasets.

Can flag sections as Do Not Post to allow backup reports to be generated with the invoice.

Can restrict sections to use transactions based on the invoice filter. More on Invoice Filters

4.11.13.1Invoice Design Toolbar

Overview  

The Invoice toolbar gives the user (with permission) numerous capabilities within the Invoice Design applet.

Below is a list of those capabilities.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar

Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

System Invoice Copy - Located under the Tools button; allows the user to copy a standard invoice design

from the system so that it can be modified.

System Invoice Management -  Gives you the ability to deactivate system invoice designs so they do not

show in the list of possible invoices when you click the Main Invoice drop-down at Projects>Billing Tab

Section Copy Wizard -  Located under the Tools button; allows the user to copy a specific standard

invoice section (for example, Labor, ODC, etc.) from the system. For a description on what the sections

display follow this link: More on Invoice Descriptions

Rebuild All Invoices -  This is used when fields are added to an invoice and need to be added to the RDL

(Invoice Report). Typically this is done when user-definable fields are exposed to invoices. In this case,

when a user-definable field is added to clients or projects, all invoice designs must be rebuilt.  To allow
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Project and Client UDFs you must first enable them at Global Settings>Invoicing Tab. More on User Defined

Fields.

Edit Section Images / Settings - Reports and Invoice Designs installed from InFocus Marketplace or

written with ReportBuilder can be easily customized using the Edit Section Images / Settings option from

the toolbar in reporting and Invoice Design applets. The tutorials below will walk you through how to add a

company logo and how to make a simple edit to the settings of your invoice design/custom report. More

on Editing Section Images / Settings

Copy - Creates a copy of the currently loaded invoice design. Launches the Copy Invoice dialogue which

prompts for a name to use for the new invoice design.

4.11.13.2Invoice Designs Tab

Overview 

The Invoice Design Tab serves many functions within the Invoice Design Applet. Invoice designs are Deleted,

Saved, and Created here.

Key Concepts

The window on the left contains all the "Custom" invoice designs that are currently available.  Remember,

System Invoice Designs are not accessible. To modify one, you must use the System Invoice Copy

button located on the toolbar.

There are many System Sections that can be copied and added to an invoice design.  To access those

use the Section Copy Wizard button located on the toolbar. For descriptions on what each section

contains, follow this link: More on Invoice Section Descriptions

Invoice designs can be altered by using the "Snap Together" feature in the Design Sections grid

described below.

The Scripting out (Copying) of Invoice designs are done here by using the Script button located at the

bottom of the applet. Scripting is used when you want to copy or move the designs from one database to

another.

Field Descriptions 

Invoice Design Name

Text Box - This text box contains the name of the invoice design. The invoice name can be edited here. 

https://support.clearviewsoftware.net/articles/4264
https://support.clearviewsoftware.net/articles/4264
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Invoice Design Border

Drop-down - This drop-down contains the Border of the selected invoice design. Only one Border can be

a part of an invoice. The Border section controls invoice attributes like Margins and Header items that

repeat on every page (ie. Page Numbers).

Style

Combined - When selected, the invoice design is flagged as a Combined invoice.  An invoice design with

this selected will show up in the Main Invoice drop-down located at Projects>Billing Tab>Invoicing

Section.

Labor Only - When selected, the invoice design is flagged as a Labor invoice.  An invoice design with this

selected will show up in the Labor Invoice drop-down located at Projects>Billing Tab>Invoicing Section. In

order to see this option, the Separate Expense Invoice check-box must be checked.

Expense Only - When selected, the invoice design is flagged as a Expense invoice.  An invoice design

with this selected will show up in the Labor Invoice drop-down located at Projects>Billing Tab>Invoicing

Section. In order to see this option, the Separate Expense Invoice check-box must be checked.

Invoice Posting Action

Drop-down - An invoice posting action allows for an action to be called after the posting action in

Automate Invoicing.

Design Sections Header

Description - The Section Design grids is where you assemble your invoice design.  No customization is don

here, you simply select the sections that you would like to use and Add them to the design.  Once you have

added them, you can use the up and down arrows to put them in the right order.  After that, click save and

the design has been assembled.  Specific Customization is done in the Section Designs Tab. More on the

Section Designs Tab

Section Type - This drop-down displays the Section Type that you want to drop into the design. Options

are Header, Labor, ODC, OCC, Combined, SQL Query, Summary Statement and Taxes.

Section - This drop-down displays the available sections and are dependent on the selection from the 

Section Type drop-down.  In order for an item to show in the drop-down, it must exist in the Section

Designs Tab.  An item displays on the Section Design tab either by copying or creating a new section. 

More on the Section Designs Tab

Do Not Print - When checked, the section will not print on the rendered invoice.

Add - When clicked, the section selected from the Section drop-down will be added to the Design

Sections grid.
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Up button - Moves the highlighted section up in the Design Sections grid.

Down button - Moves the highlighted section down in the Design Sections grid.

Note - To Delete an item from this grid, click on the left side of the item and click the delete key on your

Keyboard. DO NOT click Delete at the bottom of the applet. This will delete the whole invoice design and

associated project links.

Design Sections Grid

Type - The type of section added. This is from the Section Type drop-down.

Name - The Name of section added. This is from the Section drop-down.

Do Not Print -  When checked, the section will not print on the rendered invoice.

Design Sections Buttons (bottom)

New - Click to start a new invoice design.

Save - Saves the current progress of the invoice.

Delete - This will delete the whole invoice design and associated project links. DO NOT click this button

to remove items from the Design Sections grid.

Script - Scripting is used when you want to copy or move the designs from one database to another.

4.11.13.3Section Designs Tab

Overview 

The Section Designs Tab is where you customize the properties of an invoice section. 

Key Concepts

By selecting the fields located in the Columns section, you can customize what data is brought back in

the invoice section's Dataset. Keep in mind, this still requires the user to download and customize the

report to see the newly selected fields.   

A typical customization request is to add a logo to an invoice design. Here is an article that walks you

through that process, introducing you to other customization concepts during the process. More on

Adding a Logo to an Invoice

https://support.clearviewsoftware.net/articles/4021
https://support.clearviewsoftware.net/articles/4021
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Field Descriptions 

Invoice Design Name

Drop-down - The drop-down displays the available custom invoice sections. The options are:  Header,

Labor, ODC, OCC,Combined, Summary, Statement, Border, Taxes, and Coversheet.

Design Box (Below the Drop-down) - Once a type has been selected, all available custom sections will

display here. In order for an item to show here, you either have to Copy a System Invoice, Copy a

Section Design or create from New.

Section Details - Depending on the section type selected on the drop-down, you will get different details. 

See the following Invoice Sections of this manual for details on those properties.

Design Sections Buttons (bottom)

New - Click to start a new invoice section.

Save - Saves the current progress of the invoice section.

Delete - This will delete the whole invoice section.

Script - Scripting is used when you want to copy or move the section from one database to another.

Upload - Uploads the RDL back into the system. 

Note - This overwrites the old design and cannot be undone.

Download - Downloads a copy of the RDL to a specified location.

4.11.13.3.1  Header Section

Overview 

The Header section is typically the first page of an invoice. Only project-level type data is exposed here. 

Key Concepts

An Invoice can have multiple Invoice Header sections, the section used for the beginning of the invoice to
hold textual type information, such as Bill-to Address, Project Description, Invoice Date, and Company
Logo.

The fixed Dataset for this section contains exactly one row.

The Dataset will have all fields from the Bill-Terms Project (project facts, print criteria, project UDF’s,
client UDF’s, and bill-to and remit-to addresses).

If all of a user’s invoices have the same first page header, he may have only one header section design in
his system.
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Field Descriptions 

Name

Textbox - The name of the Header section can be edited here. Must be unique.

4.11.13.3.2  Labor Section

Overview 

An invoice design can have multiple Labor sections, either hourly based or fixed fee (this includes percent

complete).

Key Concepts

Labor Sections control both hourly and fixed fee (or Lump Sum) sections of an invoice. 

There can be as many labor sections as desired. 

Labor sections usually are set to post values, but there are times when the user will not want to have a

section post data. For example, government contracts use a multi-schedule invoice. The agency

sometimes requires labor to be listed and summed by discipline (job title) and then listed and summed by

phase. This would require two labor sections, but since the designs cover the same timesheets, only one

would be posted.  If you want a section to NOT post, simply uncheck the boxes located in the Post

section of an Invoice Section.

Field Descriptions 

Name

Textbox - The name of the Labor section can be edited here. Must be unique.

Invoice Filter - The Invoice Filter variable is set here. More on Invoice Filters

Print When Zero - When checked, the section will print regardless if there are any current amounts to be

billed.

Mark Billed
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Mark Labor as Billed - Available only when Is Hourly Based is NOT checked. When checked, all labor

transactions for the project are flagged as billed.

Mark ICC as Billed - When checked, associated ready to bill ICC charges will be flagged as billed.  

Mark ODC as Billed - When checked, associated ready to bill ODC charges will be flagged as billed. 

This should be used when ODC are not being passed through to your client.  Please note that only

expense projects nodes with a non-zero fixed fee amount will be flagged.

Mark OCC as Billed - When checked, associated ready to bill OCC charges will be flagged as billed. 

This should be used when OCC are not being passed through to your client. Please note that only

expense projects nodes with a non-zero fixed fee amount will be flagged.

Options
Is Hourly Based - When checked, the labor section is an hourly section. When unchecked, the section is

either Fixed Fee of Lump sum (depending on the Use Lump Sum flag). 

Use Bill Rates - When checked, Bill Rates are used rather than multipliers. Note in the field descriptions

that some fields are shown/hidden depending on this check-box.

Process when Zero PC - When checked, the invoice will Process the Fixed Fee even when the Percent

Complete is zero. 

Lump Sum
Use Lump Sum – When checked, the system will look at the lump sum field value, rather than the percent

complete.  

Note - Lump sum is a way to bill a lump fee instead of a Percent Complete of fee. In order to use this feature,

you must use an invoice design whose labor section has been designated to use this field.  Two new invoice

formats that support lump sum billing have been added. Lump Sum Level 1 works at the project level while

Lump Sum Level 2 works at the phase level (e2nd level).

Ignore Previously Billed – When checked, the system will not look at previously billed amounts when

calculating the current amount.  In normal fixed fee billing, the calculated current amount plus the

previously billed is compared to the contract amount to determine the amount to be invoiced.  This can be

useful for cycle type billings, where a set amount is to be invoiced each month.

Reset Lump Sum to Zero on Post - When checked, the system will zero out the entered lump sum

amount, when the invoice is posted.

Use Hourly Labor For
Premium Time - When checked, premium time (Overtime) is included.

Non-Premium Time - When checked, regular time is included.

Principals - When checked, principals are included. This looks at the Job Type of Principal In Charge
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located at Employees>Employee Information Tab>Company Information>Job Type

Non-Principals - When checked, non-principals are included.  This looks at the Job Type of Principal In

Charge located at Employees>Employee Information Tab>Company Information>Job Type

Non-Exempt Employees - When checked, non-exempt employees are included. Employees are

considered exempt if the Hourly check-box IS selected in Employees>Pay History Tab.

Exempt Employees - When checked, exempt employees are included. Employees are not considered

exempt if the Hourly check-box IS NOT selected in Employees>Pay History Tab. 

Subcontractors - When checked, subcontractor are included. This looks at the Subcontractor flag located

at Employees>Employee Information Tab>Company Information>Subcontractor

Non-Subcontractors - When checked, subcontractor are included.

Labor Cap
Description - Available only for hourly sections. Specifies what portion of labor is compared to an upset.

Leave blank for No Upset.  

Drop-down - This is where the labor cap is enforced. The options are Bill Amount (When "Use Bill Rates"

flag is checked),  Direct Labor, Direct Labor + DPE + Overhead, and Direct Labor + DPE + Overhead +

Profit (When "Use Bill Rates" flag is unchecked).   You can cap the cost or the billable value.

WBS Levels
Show - Number of levels below project level of the WBS to include.

Note - This is the level of the WBS that the Labor will be posted in the Sales Journal Entry.  So in reporting, if

you are posting to the top level (0), your billings will be recognized at the top level.

Include Sublevels with No Billing - When checked, nodes with no billing info will be included in the

Dataset. Typically this is used on Fixed Fee and Not to Exceed invoice designs.

Post
Direct Labor -  Available for hourly sections. When checked, base portion of labor will be posted.

DPE + Overhead - Available for hourly sections. When checked, DPE and overhead of labor will be

posted.

Profit - Available for hourly sections. When checked, profit portion of labor will be posted.

Fixed Fee - Available for fixed fee sections. When checked, fixed fee will be posted.

Columns Grid
Description - The Columns grid is only available for hourly sections. A list of Fields that can be added to the

Dataset of the labor RDL file. Checking the box simply adds the field to the Dataset in the RDL file.  It does

not make the information show up on the section in the invoice.  To have the information show up on the
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invoice, you must download the section, tweak it, and then upload it back into the system. 

EmpCode - Employee code. More on Employees

EmpName - Employee name

JobTitleCode - Job Title Code. More on Job Titles

JobTitleName - Job Title Name

LaborCode - Labor Code. More on Labor Codes

Labor Name - Labor Name

WorkDate - Work Date

BillHrs - Bill Hours

BillRate - Bill Rate; Available only when Use Bill Rates is checked.

BillBaseRate - Base Rate. Available only when Use Bill Rates is not checked.

BillBasePremMU - Base Rate Premium Multiplier. Available only when Use Bill Rates is not checked.

BillDPEMult - DPE multiplier. Available only when Use Bill Rates is not checked.

BillOHMult - Overhead multiplier. Available only when Use Bill Rates is not checked.

BillPRMult - Profit multiplier. Available only when Use Bill Rates is not checked.

IsHourly - Flag indicating if time was recorded for an hourly employee.

IsPremium - Flag indicating if line item is premium (Overtime) time.  

PMComments - Project management comments from time collection.

Home Org Code - The Code of the Org. Unit that the Employee is assigned to at Employees>Employee

Information Tab>Company Information>Org. Unit. More on Org Units

Home Org Path - The Path of the Org. Unit that the Employee is assigned to.

Home Org Name - The Name of the Org. Unit that the Employee is assigned to.

Home Org Long Name - The Long Name of the Org. Unit that the Employee is assigned to. The Long

Name contains a concatenation of the Parent Org.

Charge Org Code - The Code of the Org. Unit that the Project that the employee is putting time against.

This is assigned at Projects>Members Tab>Organizational Charging

Charge Org Path - The Path of the Org. Unit that the Project that the employee is putting time against.

Charge Org Name - The Name of the Org. Unit that the Project that the employee is putting time against.

Charge Org Long Name - The Long Name of the Org. Unit that the Project that the employee is putting

time against. The Long Name contains a concatenation of the Parent Org.

Location Code - Location Code. More on Locations

Location Name - Location Name.

PEDate - .  This is the timesheet period end date.

LineID - .  This allows for line items transactions to not be grouped based on the non-aggregate field

chosen.  For example if you design was showing payee name and date and you had two line items in
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purchases with the same payee and date the invoice design would automatically summarize them as one

line.  By adding this field to the selected columns in the section design the system would then not

summarize these.

TransID - This is the transaction ID of the Journal that the transaction comes from. A prefix containing the

first letter of the journal is attached to the returned field.

4.11.13.3.3  ODC Section

Overview 

ODC sections control ODC transactions, but can also include OCC transactions when the Include OCC

Charges box is checked. An invoice design can have multiple ODC (reimbursable) sections.

Field Descriptions 

Name

Textbox - The name of the ODC section can be edited here. Must be unique.

Invoice Filter - The Invoice Filter variable is set here. More on Invoice Filters

Print When Zero - When checked, the section will print regardless if there are any current amounts to be

billed.

WBS Level

Show - Number of levels below project level of the WBS to include.

Note - This is the level of the WBS that the ODC will be posted in the Sales Journal Entry.  So in reporting, if

you are posting to the top level (0), your billings will be recognized at the top level.

Include Unworked Sub-Levels - When checked, nodes with no billing info will be included in the Dataset.

Typically this is used in Not to Exceed invoice designs.

Expense Cap
Drop-down -  This is where the expense cap is enforced. The options are Direct Expense and Markup. 

You can cap the cost or the billable value.

OCC Charges
Include OCC Charges - When checked, OCC charges are included in the section. This means that that
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the OCC will be posted in the Sales Journal Entry as ODCs.  If you want them separate in the Sales

Journal, this box should remain unchecked.

Post
Direct Expense - When checked, the non-marked up portion of expense will be posted. The cap can be

set on the Markup or the Direct Expense.

Markup - When checked, the marked-up portion of Expense will be posted.

Columns
Description -  Checking the box simply adds the field to the Dataset in the RDL file.  It does not make the

information show up on the section in the invoice.  To have the information show up on the invoice, you must

download the section, tweak it, and then upload it back into the system. 

ExpCode - Expense Code. More on Expense Codes

ExpName - Expense name

PayeeCode - Vendor or employee code. More on Vendors

PayeeName -  Vendor or employee name

TransDate - Transaction date

TrackNum - Vendor invoice number or employee reimbursable journal ID

Qty - Quantity

UnitRate - Unit Rate

MarkUp -Markup. Depending on type, this can be a multiplier, flat amount, or add-on.

MarkupType - Markup Type. Possibilities are markup (multiplier), flat amount or add on.

PMComments - Project management comments.  

Org Code - The Code of the Org. Unit of the Project that the Expense is Against. This is assigned at 

Projects>Members Tab>Organizational Charging

Org Path - The Path of the Org. Unit of the Project that the Expense is Against. 

Org Name - The Name of the Org. Unit of the Project that the Expense is Against. 

Org Long Name - The Long Name of the Org. Unit of the Project that the Expense is Against.  The Long

Name contains a concatenation of the Parent Org.

LineID - .  This allows for line items transactions to not be grouped based on the non-aggregate field

chosen.  For example if you design was showing payee name and date and you had two line items in

purchases with the same payee and date the invoice design would automatically summarize them as one

line.  By adding this field to the selected columns in the section design the system would then not

summarize these.

TransID - This is the internal transaction ID.

GLBaseCode - Code of the Base Code assigned to the Expense.
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GLBaseName - Name of the Base Code assigned to the Expense.

4.11.13.3.4  OCC Section

Overview 

OCC sections control OCC transactions that pass through to the invoice. An invoice design can have multiple

OCC (Out of Contract Consultant) sections.

Field Descriptions 

Name

Textbox - The name of the OCC section can be edited here. Must be unique.

Invoice Filter - The Invoice Filter variable is set here. More on Invoice Filters

Print When Zero - When checked, the section will print regardless if there are any current amounts to be

billed.

WBS Level

Show - Number of levels below project level of the WBS to include.

Note - This is the level of the WBS that the OCC will be posted in the Sales Journal Entry.  So in reporting, if

you are posting to the top level (0), your billings will be recognized at the top level.

Include Unworked Sub-Levels - When checked, nodes with no billing info will be included in the Dataset.

Typically this is used in Not to Exceed invoice designs.

Expense Cap

Drop-down -  This is where the expense cap is enforced. The options are Direct Expense and Markup. 

You can cap the cost or the billable value.

Post

Direct Expense - When checked, the non-marked up portion of expense will be posted. The cap can be

set on the Markup or the Direct Expense.

Markup - When checked, the marked-up portion of Expense will be posted.
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Columns

Description -  Checking the box simply adds the field to the Dataset in the RDL file.  It does not make the

information show up on the section in the invoice.  To have the information show up on the invoice, you must

download the section, tweak it, and then upload it back into the system. 

ExpCode - Expense Code. More on Expense Codes

ExpName - Expense name

PayeeCode - Vendor or employee code. More on Vendors

PayeeName -  Vendor or employee name

TransDate - Transaction date

TrackNum - Vendor invoice number or employee reimbursable journal ID

Qty - Quantity

UnitRate - Unit Rate

MarkUp -Markup. Depending on type, this can be a multiplier, flat amount, or add-on.

MarkupType - Markup Type. Possibilities are markup (multiplier), flat amount or add on.

PMComments - Project management comments.  

Org Code - The Code of the Org. Unit of the Project that the Expense is Against. This is assigned at 

Projects>Members Tab>Organizational Charging

Org Path - The Path of the Org. Unit of the Project that the Expense is Against. 

Org Name - The Name of the Org. Unit of the Project that the Expense is Against. 

Org Long Name - The Long Name of the Org. Unit of the Project that the Expense is Against.  The Long

Name contains a concatenation of the Parent Org.

LineID - .  This allows for line items transactions to not be grouped based on the non-aggregate field

chosen.  For example if you design was showing payee name and date and you had two line items in

purchases with the same payee and date the invoice design would automatically summarize them as one

line.  By adding this field to the selected columns in the section design the system would then not

summarize these.

TransID - This is the internal transaction ID.

GLBaseCode - Code of the Base Code assigned to the Expense.

GLBaseName - Name of the Base Code assigned to the Expense.

4.11.13.3.5  Combination Section

Overview 

The Combination section allows you to return data from multiple hourly, fixed fee, ODC, and OCC sections. 

This allows for the grouping of project charges by project level and then by type of expense.
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Key Concepts

The Sections dropped into the Design Sections grid populate the Dataset.  Even though you may see the

field in the Dataset of the RDL, that item will not be returned until you go to the respective section and

check that box.

If you want to use the data in a SQL Query section, the data populates the Temp_Invoice_Combined

table. 

Field Descriptions 

Name

Textbox - The name of the Combination section can be edited here. Must be unique.

Print When Zero - When checked, the section will print regardless if there is any current amount to be

billed.

Cap Level

Drop-down - The level that the Combined Cap is set at

Note - The Contract Levels must be set at this level on Labor, ODC and OCC to use this cap. More on

Contact Levels/ Caps.  Also, all of the underlying sections must have the WBS Level set to the same level as

this number.

Design Sections Header

Description - This grid works like the main Invoice Designs Tab. Select the Labor, ODC, and OCC sections

that contain the fields that you would like to include in the Combinations Dataset.  Add them to the grid (as

seen above), and hit Save.  Now you can download the combination section and alter the RDL as you would

with any other section.

Section Type - This drop-down displays the Section Type that you want to drop into the design. Options

are Header, Labor, ODC, OCC, Combined, SQL Query, Summary Statement and Taxes.

Section - This drop-down displays the available sections and are dependent on the selection from the 

Section Type drop-down.  In order for an item to show in the drop-down, it must exist in the Section

Designs Tab.  An item displays on the Section Design tab either by copying or creating a new section.

Add - When clicked, the section selected from the Section drop-down will be added to the Design

Sections grid.
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Up button - Moves the highlighted section up in the Design Sections grid.

Down button - Moves the highlighted section down in the Design Sections grid.

Design Sections Grid

Type - The type of section added. This is from the Section Type drop-down.

Name - The Name of section added. This is from the Section drop-down.

Cap Type - The combined caps allow for combining different pm types (Labor, ODC and OCC)  into a

single cap for not-to-exceed type invoicing.  The system will compared aggregate charged and previously

billed against the aggregate cap.  Please note that the caps must be setup at the same level for a given

project.

4.11.13.3.6  SQL Query Section

Overview 

The SQL Query section allows you to create custom invoice sections that can pull in data from any table that

is accessible in the InFocus Database. 

Key Concepts

Queries are pasted into the Query window and you must use the variable ^projectpath^ as the Parameter

Variable.  

InFocus comes with 2 system SQL Query sections Receipts and AllocateICCRevenueByPCT.  

o Receipts - This section allows for you to display an archived image that has been associated with a

transaction being billed (i.e. Scanned .jpg image of a receipt) in an invoice.  In order to use this

section, you must be using the new HTTP Document Management.  Currently the only supported

image formats are jpg, jpeg, png, bmp and gif.

o AllocateICCRevenueByPct - This query section will allocate ICC Revenue based on the same percent

completes used in a fixed fee invoice. For this new SQL section to work it needs to be added to your

fixed fee designs and placed anywhere after the fixed fee section with respect to the order of the

sections.

Field Descriptions 
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Name

Textbox - The name of the Combination section can be edited here. Must be unique.

Stored Procedure - When checked, a stored procedure is placed into the SQL Query Window.  When

unchecked, the query must be written in the Query window.

Query

Query Window - Custom SQL Code is added here. Knowledge of SQL is required.

4.11.13.3.7  Summary Section

Overview 

Summary sections are used as subtotaling areas. They are single-record datasets that contain billing-to-date

information, contractual amounts, and running totals.

Key Concepts

Invoice Designs can have multiple summary sections. 

Summary sections are typically used to aggregate previous sections together. For instance, a total

professional services plus reimbursable expense invoice line item would be an example of a summary

section.

Summary sections can be used with labor upsets. Sometimes it is preferable to perform an upset in a

Summary section rather than in the Labor section. An example is when multiple labor schedules are used.

When a cap is used in the Summary section, it overrides the current posting figures.

Field Descriptions 

Name

Textbox - The name of the Header section can be edited here. Must be unique.

Apply Cap

Description - Controls the Labor upset.   Remove any caps from Labor, ODC or OCC sections if you are

applying a cap here. All caps here are applied at the top level of the project.
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None - No Cap is applied.

Separate - Separate Caps are applied. Options are:

o Labor - The options are Bill Amount (When "Use Bill Rates" flag is checked),  Direct Labor, Direct

Labor + DPE + Overhead, and Direct Labor + DPE + Overhead + Profit (When "Use Bill Rates" flag is

unchecked).   You can cap the cost or the billable value.

o ODC - This is where the expense cap is enforced. The options are Direct Expense and Markup.  You

can cap the cost or the billable value.

o OCC - This is where the expense cap is enforced. The options are Direct Expense and Markup.  You

can cap the cost or the billable value.

Combined - A combination cap is applied here.

Post Retainer / Retainage

Post Retainage - When checked, retainage (if any) will be posted.

Post  Retainer - When checked, retainer (if any) will be posted.

Recalculate Amounts using Project Multipliers
DPE / OH - If a DPE/OH Multiplier is on the Project Rate Schedule Setup>Multipliers Section, the

transaction cost will be multiplied with that to determine effort.  More on Project Setup

Profit - If a DPE/OH Multiplier is on the Project Rate Schedule Setup>Multipliers Section, the transaction

cost will be multiplied with that to determine effort.  

ODC Markup - If an Overriding multiplier is on the Project Setup>Expense Markups / Codes, the

transaction cost will be multiplied with that to determine effort.  More on Project Setup

OCC Markup -  If an Overriding multiplier is on the Project Setup>Expense Markups / Codes, the

transaction cost will be multiplied with that to determine effort. 

Note - Used for resolving Rounding Issues when multipliers are being applied at the project level. 

Print If Non-Zero  
Description - Section will print if any of the following checked values are non-zero.

Hourly

Fixed Fee

ODC

OCC

Retainage

Retainer

Tax
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4.11.13.3.8  Statement Section

Overview 

Statements print A/R type statements. The statements are by client not project.

Key Concepts

An Invoice can have multiple Invoice Statement sections, the section used for the beginning of the invoice

to hold textual type information, such as Bill-to Address, Project Description, Invoice Date, and Company

Logo.

The fixed Dataset for this section contains exactly one row.

The Dataset will have all fields from the Bill-Terms Project (project facts, print criteria, project UDF’s,

client UDF’s, and bill-to and remit-to addresses).

Field Descriptions 

Name

Textbox - The name of the Header section can be edited here. Must be unique.

Aging Method
By Invoice Date - When checked the statement ages by invoice date

By Due Date - When checked the statement ages by due date

Show
Show Fully Paid Invoices check-box - When checked, even fully paid invoices will print.

4.11.13.3.9  Border Section

Overview 

An invoice design can have only one Border section. A border controls two things: the footer and the
subsequent page header (page headers other than the first page).
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Key Concepts

Only a limited amount of data can appear on a border. 

Invoice Margins are enforced here. 

Due to report layout issues these fields are passed as report parameters instead of a Dataset.

Like a header, there is nothing to define other than a border name.

Field Descriptions 

Name

Textbox - The name of the Border section can be edited here. Must be unique.

4.11.13.3.10  Taxes Section

Overview 

The Taxes section is used to pick up any Taxes/Surcharges when invoicing a project. 

Key Concepts

Taxes are created and managed in Global Settings under the Taxes/Surcharges Tab.

Taxes are enabled on the Project>Taxes & Surcharges Tab. 

Field Descriptions 

Name

Textbox - The name of the Border section can be edited here. Must be unique.

Show & Post Taxes

All - When checked, any tax selected on the project is used.

Custom - When selected, any combination of the taxes selected in the grid can be used in combination

with the tax selected on the project.

o Tax Code - Code of the Tax.

o Tax Name - Name of the Tax.

o Show - Show the tax only.



InFocus User Manual - Current (v2020)512

© 2020 Clearview Software, Inc.

o Post - Post the tax only.

4.11.13.3.11  Coversheet Section

Overview 

Coversheet sections are used to invoice multiple projects on one invoice. The fields exposed to the report
writer are predetermined so no options need to be filled out. In general, the fields represent the billing
information for the projects that are part of the invoice. 

Key Concepts

Coversheets are used by utilizing Invoice Groups. More on Invoice Groups  

Note:  All projects within an invoice group belong to the same client.

Field Descriptions 

Name

Textbox - The name of the Header section can be edited here. Must be unique.

4.11.13.3.12  Invoice Filters

Overview 

Invoice Filters give InFocus the ability to support mixed-style billings on a single project without the need of

creating a roll-up project or an invoice group. 

Key Concepts

A filter is a user-definable code that is used to denote which billing style will be used on a specific phase

of a project.  An example of their use might be a phased fixed fee plus additional services. In this example,

the letter F would be placed on all phases that are Fixed Fee, and the letter H for all phases that are

Hourly.

Invoice Filters can only be set at the second-level of a projects WBS. That means that in a Task (Level 3)

billing scenario, all of the children of the phase must bill in the same manner (ie. TandM, Fixed Fee, etc.)

Invoice section designs (Labor, ODC and OCC) can use a filter.

Invoice filters must be set in two places:
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o On the project Setup> Invoice Filters section. More on Invoice Filters

o In the Invoice Section Design (Labor, ODC or OCC section). More on Section Designs

How to use Invoice Filters: 

Go to Project Administration> Projects>Right click on the project name in Project Explorer (within the
Projects applet) and choose Invoice Filters.  Place the filters in the appropriate places and click Save.

Go to the Utilities module in the Invoice Designs applet. Once there, go to the Sections Design tab and
choose the invoice section to filter to pick up the appropriate information. Place the corresponding filter in
the Invoice Filter box, and click Save.

4.11.13.3.13  Invoice Sections Descriptions

Overview  

Here are the descriptions of each section when using the Section Copy Wizard. An "X" in the column means
that section includes that field.

Key Concepts

Use the list below to determine what System Sections are available.

Head
er
Heade
r01

w/ Firm
Name

Heade
r02

w/o Firm
Name

Labo
r

Fixed
Fee

ProjN
ame

Contr
act
Amt

Phase
Fee

PrevB
illed

%
Co
mpl
ete

Fee Earned Prior
Billi
ng

Curre
nt

Fee

Invoice
Amount

Notes

FF01 X X X X No Groupings

FF02 X X X X X No Groupings

FF03 X X X X X No Groupings

FF04 X X X X X X No Grouping /
Designed for PFF

FF05 X X X X X No Grouping / Fixed
Fee (Name) is Hard
coded in

All NE Invoice Designs are the same as the TM sections but Include a Footer section
that includes Previously Billed, Maximum Allowable Services, and Net Professional
Services.

Phase Emp
Name

Job
Title

Date Hou
rs

Bill
Rate

Bill
Base

DPE OH Profi
t

PM
Comme

Labor
Name

Amo
unt

Notes
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Rate nt
TM01 NE01 X X X X No Groupings

TM02 NE02 X X X X X No Groupings

TM03 NE03 X X X X No Groupings

TM04 NE04 X X X X X No Groupings

TM05 NE05 X X X X X X No Groupings

TM06 NE06 X X X X X X X No Groupings

TM07 NE07 X X X X X X X X No Groupings

TM08 NE08 X X X X X X X No Groupings

TM09 NE09 X X X X X X X X No Groupings

TM10 NE10 X X X X X X X X X No Groupings

TM11 NE11 X X X X X No Groupings

TM12 NE12 X X X X X X No Groupings

TM13 NE13 X X X X X No Groupings

TM14 NE14 X X X X X X No Groupings

TM15 NE15 X X X X X X X No Groupings

TM16 NE16 X X X X X Grouping by
PorjCode2 &
ProjName2 / Sort by
Project Code2 & Emp
Name

TM17 NE17 X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
Emp Name, Work
Date

TM18 NE18 X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
JobTitleName

TM19 NE19 X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
JobTitleName,
Workdate

TM20 NE20 X X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
EmpName, Workdate

TM21 NE21 X X X X X X X X Grouping by
PorjCode2 &
ProjName2 / Sort by
Phase & Emp Name

TM22 NE22 X X X X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
Emp Name, Work
Date

TM23 NE23 X X X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
Emp Name, Work
Date

TM24 NE24 X X X X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
JobTitleName,
Workdate

TM25 NE25 X X X X X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
EmpName, Workdate

TM26 NE26 X X X X X X Grouping by
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PorjCode2 &
ProjName2 / Sort by
Project Code2 & Emp
Name

TM27 NE27 X X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
Emp Name, Work
Date

TM28 NE28 X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
JobTitleName

TM29 NE29 X X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
JobTitleName,
Workdate

TM30 NE30 X X X X X X X X Grouping by Proj.
Code2 & PojName2 /
Sort by Proj Code 2,
Emp Name, Work
Date

TM31 NE31 X X X X X No Grouping

TM32 NE32 X X X X X Grouped by
JobTileName / Sorted
by JT Name , Emp
Name

TM33 NE33 X X X X X No Groupings

TM34 NE34 X X X X X Grouped by
LaborName / Sorted
by LaborName, Emp
Name

TM35 NE35 X X X X X X X X No Grouping

TM36 NE36 X X X X X X X X Grouped by
JobtTitleName /
Sorted by JTName,
Emp Name

TM37 NE37 X X X X X X X X No Groupings

TM38 NE38 X X X X X X X X Grouped by
LaborName / Sorted
by LaborName, Emp
Name

TM39 NE39 X X X X X X No Grouping

TM40 NE40 X X X X X X Grouped by
JobTileName / Sorted
by JT Name , Emp
Name

TM41 NE41 X X X X X X No Groupings

TM42 NE42 X X X X X X Grouped by
LaborName / Sorted
by LaborName, Emp
Name

TM43 NE43 X X X X X X Grouped by
PhaseCode2 / Sorted
by ProjCode2,
EmpName, JTName

TM44 NE44 X X X X X X 2 Groupings (Group1-
ProjCode2/Sort1-
ProjCode2)(Group2-
JTName/Sort2-
JTName,EmpName)

TM45 NE45 X X X X X X Grouped by
ProjCode2 / Sort by
ProjCode2,
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EmpName,
LaborName

TM46 NE46 X X X X X X 2 Groupings (Group1-
ProjCode2/Sort1-
ProjCode2)(Group2-
LaborName/Sort2-
LaborName,EmpNam
e)

TM47 NE47 X X X X X X X X X Grouped by
ProjCode2 / Sort by
ProjCode2,
EmpName, JTName

TM48 NE48 X X X X X X X X X 2 Groupings (Group1-
ProjCode2/Sort1-
ProjCode2)(Group2-
JTName/Sort2-
JTName,EmpName)

TM49 NE49 X X X X X X X X X Grouped by
PhaseCode2 / Sorted
by ProjCode2,
EmpName,
LaborName

TM50 NE50 X X X X X X X X X 2 Groupings (Group1-
ProjCode2/Sort1-
ProjCode2)(Group2-
LaborName/Sort2-
LaborName,EmpNam
e)

TM51 NE51 X X X X X X X Grouped by
ProjCode2 / Sort by
ProjCode2,
EmpName, JTName

TM52 NE52 X X X X X X X 2 Groupings (Group1-
ProjCode2/Sort1-
ProjCode2)(Group2-
JTName/Sort2-
JTName,EmpName)

TM53 NE53 X X X X X X X Grouped by
ProjCode2 / Sort by
ProjCode2,
EmpName,
LaborName

TM54 NE54 X X X X X X X 2 Groupings (Group1-
ProjCode2/Sort1-
ProjCode2)(Group2-
LaborName/Sort2-
LaborName,EmpNam
e)

ODC

Phase Invoic
e #

Unit
Rate

Qty Mark
up

Am
oun

t

Exp
Nam

e

Paye
eNa
me

Prev
Billed

Max
Allowable

Net
Reim

b
ODC0
1

X X X X X X - Detail
Line

No Groupings

ODC0
2

X X X X X X X - Detail
Line

Group by Expense
Name

ODC0
3

X X - Detail
Line

No Groupings

ODC0
4

X X X X X X X - Detail
Line

Group by Project
Code2, Project
Name2

ODC0
5

X X X X X X X X - Detail
Line

GROUP 1 - Group by
Project Code2,
Project Name2  
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GROUP 2 - Expense
Name

ODC0
6

X X X - Detail
Line

Group by Project
Code2, Project
Name2

ODCN
E01

X X X X X X -
Detai
l Line

X X X No Groupings

ODCN
E02

X X X X X X X -
Detai
l Line

X X X Group by Expense
Name

ODCN
E03

X - Detail
Line

X X X No Groupings

ODCN
E04

X X X X X X X -
Detai
l Line

X X X Group by Project
Code2, Project
Name2

ODCN
E05

X X X X X X X X -
Detai
l Line

X X X GROUP 1 - Group by
Project Code2,
Project Name2  
GROUP 2 - Expense
Name

ODCN
E06

X X X - Detail
Line

X X X Group by Project
Code2, Project
Name2

OCC

Phase Invoic
e #

Unit
Rate

Qty Mark
up

Am
oun

t

Exp
Nam

e

Payee
Name

Prev
Bille

d

Max
Allowable

Net
Reimb

OCC0
1

X X X X X X

OCC0
2

X X X X X X X

OCC0
3

X X X X X X X

OCC0
4

X X X X X X X

OCC0
5

X X X X X X X X

OCC0
6

X X X

OCCN
E01

X X X X X X X X

OCCN
E02

X X X X X X X X X X

OCCN
E03

X X X X X X X X X X

OCCN
E04

X X X X X X X X X X

OCCN
E05

X X X X X X X X X X X

OCCN
E06

X X X X X X

Summ
ary

Contract PrevB
illed

Curre
nt

Billed

Billed
to

Date

Rema
ining

Recap
01

X X X X X Includes all
Metric Types

Labor
Total0

X Current Direct Labor,
DPE,OH, & Profit
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1
Total0
1

X Typical summary including
retainage and retainer

State
ment

Project# 
/ Name

Invoic
e #

Invoi
ce

Date

Invoic
e

Amou
nt

Recei
ved

Bala
nce

0-
30,
31-
60

Invoice
Sectio
ns

AR01 X X X X X X Client - Project w/
current invoice
amount

AR02 X X X Client - 0-30 - grouped by
project then invoice no.

AR03 X X X X X Client - grouped by project,
invoice no., then trans type.

AR04 X X X Client - broken
down by metric
type.

AR05 X X X X X X Client -
project

AR06 X X X X X X same as
AR05

AR07 X X X X X X X **Project Only - 0-
30 format

AR08 X X X X X X **Project Only - broken
down by metric type

4.11.13.4Section Features Tab

Overview 

The Section Features Tab is a tool used in Invoice Design to determine which section to use in an invoice
design. By filtering each column a user can narrow down a section to copy.  The funnel at the top of the
columns can be used to filter the list.

Field Descriptions 

Section - The name of the Section that can be copied from the Section Copy Wizard. More on Invoice

Section Descriptions

Hourly Based - When checked, the section is an Hourly Section.  When unchecked, it is a Fixed Fee or

Lump Sum.

Use Bill Rate - Hourly Based Only.  When checked, the section uses Bill Rates for it's labor effort.  When

unchecked, it uses Cost numbers with multipliers.

Sublevels - Denotes the level of the WBS the section displays. 0=Project, 1=Phase, 2=Task
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Labor Cap Type - Denotes sections that enforce a labor cap.

4.11.14 Invoice Posting Groups

Overview 

The Invoice posting groups allow you to override the normal G/L posting accounts in automated invoicing

located at Accounts Receivable>Automated Invoicing>Posting Tab.

Key Concepts

The accounts found on the Posting Accounts tab in Automated Invoicing are the same ones you can set

up in an Invoice Posting Group.  

Once you have set one or more Groups you can then right click on any level of the WBS of the Project

(More on Editing Project Settings) and select Invoice Posting Groups to assign the group.  The system

will hunt up the WBS tree (lowest level to top level) to find a G/L account.  If none is found it uses the

account found in Automated Invoicing.  There are two exceptions.  

o The A/R account will only be looked at on the top level of the WBS.  In other words it has no effect on

phases and tasks.  

o If you are posting to the expense code and the expense code has either a billed revenue or markup

revenue account assigned in expense codes or expense groups then that will override any assignment

in the posting group.

Field Descriptions 

Invoice Posting Groups Window

Name - This column contains the name of Invoice Posting Groups that exist in the system.

Title

Title - This column contains the name of Invoice Posting Groups that is selected. You can edit the title

here.

Accounts

A/R Account - A/R account to process. Required.
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Direct Labor - Base account to which the base amount for hourly labor is posted.

Overhead - Base account to which the DPE plus OH amount for hourly labor is posted.

Labor Profit - Base account to which the profit portion for hourly labor is posted.

Fixed Fee - Base account to which the fixed fee is posted.

Direct ODC - Base account to which the non-marked up portion of OCC expenses is posted.

Profit ODC - Base account to which the marked-up portion of ODC expenses is posted to.

Direct OCC - Base account to post non-marked up portion of OCC expenses to.

Profit OCC - Base account to post marked-up portion of OCC expenses to. If not supplied, direct account

is used.

ICC - Base account to which ICC portion of fixed fee is posted.

Retainage - Base account to use for retainage.

Retainer - Base account to use for retainers.

4.11.15 Item Scripter

Overview

 Advanced Users 

Item Scripter allows you to generate SQL scripts for custom items in InFocus.

Generated scripts can be used to INSERT or UPDATE the item in another InFocus database and are listed
across tabs in the order of deployment (e.g. Script 1, Script 2, etc.).

Supported Item types include:

Action/Reports - Custom reports built in Custom Reports applet and with ReportBuilder

Analytic Dashboard - Analytic Dashboard views designed in Analytic Dashboard Designer

Analytic Model - Queries entered as Analytic Models in Dashboard Queries Manager

Chart - Chart widgets built in Dashboard Queries Manager

Gridget - Gridgets built in Dashboard Queries Manager

Invoice - Invoice designs

Tile - Tile widgets built in Dashboard Queries Manager

When would I use this?

Item Scripter is generally only used to generate scripts for installing (or updating) supported items in another
InFocus database.

Tutorial
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To generate scripts for an item:

1. Browse to UT>Item Scripter
2. Select an item type from the drop-down
3. Double-click an Item from the list
4. Select INSERT or UPDATE as appropriate
5. Click Generate Scripts

Generated scripts are listed across tabs in the order of deployment. Scripts can be copied or exported as
needed for deployment. Generally, scripts would be deployed in the destination InFocus database using SQL
Query applet. Please note: SQL Queries can directly affect the InFocus database. Use caution.

Field Descriptions

Item Type - Drop-down displaying supported item types

Item list - List of available items

INSERT - Check to generate insert scripts

UPDATE - Check to generate update scripts

Generate Scripts - Click to generate scripts for the selected item

Copy Tab to Clipboard - Copies the text of the selected tab to the Clipboard

Copy all Tabs to Clipboard - Copies the text of all tabs to the Clipboard

Export to a Single File - Exports a single .sql file through a Save As dialogue

Export to File per Tab - Exports a .sql file for each tab using the Export Directory and File Name Mask
(see below)
Export Directory - Sets the location for saving files when using Export to File per Tab

File Name Mask - Sets the variables for naming the files exported with Export to File per Tab.
o {name} - Name of item
o {type} - Chart, Tile, Report, etc.
o {state} - INSERT or UPDATE
o {index} - 1, 2,… order of script

4.11.16 Layout Manager

Overview 

The Layout Manager gives you the ability to customize the layout of all master file applets (Clients, Contacts,

Employees, Firms, Opportunities, Projects and Vendors). 

Key Concepts

With the Layout Manager, you have the ability to require that additional information be entered before you

save, change the order and appearance of any tab (i.e. font color & size, location of sections, etc.) and

incorporate UDF’s into any tab. 
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For more information on using the Layout Manager, follow this link: More on Working with the Layout

Manager.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Copy System Form - When selected, the Layout fills the selected Form with the default layout of the specified applet.

4.11.16.1Layout Manager Detail

Overview 

The Layout Manager detail gives you the ability to customize the layout of all master file applets (Clients,

Contacts, Employees, Firms, Opportunities, Projects and Vendors). 

Field Descriptions

Side Window

Forms - Drop-down contains the applets that can be modified through the Layout Manager. Options are 

Clients, Contacts, Employees, Firms, Opportunities, Projects and Vendors.

Custom Mode - When selected, the applet in the Forms drop-down is in a Custom Mode. That means

that you are not seeing the default layout in that applet.

System Fields - List of fields available in the specified applet. 

Tabs Window

Description - The items in this grid list the Tabs available in the applet. You can Add/Delete a Tab by clicking

on the green (+) or red (x). Double click on the row to change the any of the following fields.

Name - Name of the Tab.

Columns - Number of columns on the tab. 

Use Buffer Column - When checked, a space is added between multiple columns.

Sections Window

Description - The items in this grid list the sections within a Tab. You can Add/Delete a Section by clicking on

the green (+) or red (x). Double click on the row to change the any of the following fields.

Name - Section Name

https://support.clearviewsoftware.net/articles/5394
https://support.clearviewsoftware.net/articles/5394
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Columns - Number of columns in the section.

Tab Column - Number of columns within the Tab.

Additional Columns when you double click on the row

Hide Header - When selected, the header will not display.

Hide Label Column - When selected, the Label will not display.

Font Name - Font Family used in the Section.

Font Size - Font Size used in the Section.

Bold - When selected, the text is bold.

Forecolor - Forecolor of section.

Backcolor - Backcolor of section.

Column 1 & 2 Fields Window

Description - The Columns in this grid list the the items that will be in the section. These are the data entry

pieces. You can Add/Delete a Section by clicking on the green (+) or red (x). Double click on the row to

change the any of the following fields.

Label - Label of the item

Width - Width of the item

Height - Height of the item

Additional Columns when you double click on the row

Format String - Format of the data returned from the item

Required - When checked, the item must be filled out in order to Save.

Show Label - When checked, the label will display next to the item.

Fill - Check if you would like your field to expand to fit the content in the field. Fields can expand to fill the

space within the boundaries of their section.

Space Row - when checked, it adds space above the field in the section. This is similar to inserting a row

in Excel.

Section Column - Select the section column to display the field in

Size - Configure the size of the field (in pixels)

4.11.17 Map Queries

Overview 

Map Queries manages the queries used by the Map Viewer. Here you can create custom queries that can be viewed in the

Map Viewer.  Hover over the Tool tip  to see what variables are needed to create a custom map query.
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Key Concepts
All Master Files have Geocode buttons on their addresses that get the Latitude and Longitude of an
address.  These can be used in queries to develop your own custom map views. 

4.11.18 Marketplace Purchases

Overview

InFocus Marketplace makes it easy to extend the functionality of InFocus. Reports, Invoice Designs,
Dashboard Widgets, Actions and Analytic Models are all made readily available to download.

Purchases made from the Marketplace will automatically reflect in InFocus via Utilities>Marketplace
Purchases. From there you can install your items and manage them by linking through to their native
applets.

Marketplace Items - Native Applets

Reports (Custom, PM and Report Management Reports)
o Custom Reports - Utilities>Custom Reports
o PM Reports - Utilities>PM Report Designer
o Report Management Reports - Utilities>Report Management

Invoices - Utilities>Invoice Design

Widgets - Utilities>Dashboard Groups (Advanced users can edit/customize installed widgets via
Utilities>Dashboard Queries Manager)
Actions - Utilities>Custom Reports

Analytic Models - Utilities>Dashboard Queries Manager

Included in this Section

Applet Field Descriptions (below)

Marketplace Purchases Setup

Installing Marketplace Items

Managing Marketplace Items

Field Descriptions

Below is a list of standard applet fields/buttons/elements used in the Marketplace Purchases applet.

Menu Options

File/Help - Lists standard InFocus File and Help options

Toolbar Options
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Refresh - Clicking refreshes the applet. This also checks for new installs or updates from the
Marketplace.
Install / Update - Installs and Updates purchased items

Applet Options and Filters

InFocus Marketplace link - Launches a browser and directs to InFocus Marketplace

Filter Options (listed on the left) - Select to filter the purchased items displayed

Purchased Items Grid

Status - Instal/Update status

Name - Item Name

Extension Type - Types include Reports, Invoices, Widgets, Actions, Bundles

Category - Item category from the Marketplace

Versions - InFocus-Item Version associated with the item

Purchase Date - Date of original purchase

Manage - Opens the item for management in it’s native applet
o Reports (Custom, PM and Report Management Reports)

Custom Reports - Utilities>Custom Reports
PM Reports - Utilities>PM Report Designer
Report Management Reports - Utilities>Report Management

o Invoices - Utilities>Invoice Design
o Widgets - Utilities>Dashboard Groups
o Actions - Utilities>Custom Reports

4.11.18.1Marketplace Purchases Seup

Overview

By default, permissions to this applet are not allowed. Please ensure the following configurations to deploy
this applet.  

Permissions

Check the appropriate permissions via Administration>Permissions. As a best practice, these
administrative features should only be allowed
to those in an administrator group.

4.11.18.2Installing Marketplace Items

Overview

Once a Marketplace Item has been purchased, it can be installed via Marketplace Purchases applet by
completing the following steps. Installed items can be accessed and managed from their native InFocus
applet.

Tutorial

Once you’ve purchased the item
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1. Browse to Utilities>Marketplace Purchases. Your purchased items will be displayed.
2. Select the item(s) to install
3. Click Install/Update from the toolbar.
4. Once installed, you can manage the item by clicking it’s Manage link (gear icon)

4.11.18.3Managing Marketplace Items

Overview

Once a Marketplace Item has been purchased, it can be installed via Marketplace Purchases applet by
completing the following steps. Installed items can be accessed and managed from their native InFocus
applet.

Tutorials

Below is a brief discussion for managing each item.

Reports

Reports include Custom, PM and Standard Reports and can be managed as
follows:

How to manage Custom Reports

How to manage PM Reports

How to manage Report Management Reports

Invoices

Invoices are managed via Utilities>Invoice Design

Widgets

Widgets are managed by adding them to a Dashboard Group via Utilities>Dashboard Groups. Read more
via the article below.

Adding Widgets

Actions

Similar to Reports, Actions are managed via Utilities>Custom Reports.

How to manage Custom Reports

Analytic Models

Analytic Models are used when designing Analytic Dashboard views. They are managed via 
Utilities>Dashboard Queries Manager.

How to manage Analytic Models

https://support.clearviewsoftware.net/articles/5350
https://support.clearviewsoftware.net/articles/5413
https://support.clearviewsoftware.net/articles/5414
https://support.clearviewsoftware.net/articles/5618
https://support.clearviewsoftware.net/articles/5350
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Bundles

Bundles are made up of multiple items. Each item will install and can be managed in it's native applet.

4.11.19 Messages Manager

Overview

Messages Manager gives you the ability to communicate key information from InFocus. With support for on-
event emailing, you'll be able to keep your staff and clients more connected through InFocus.

Note Messages Manager is developer tool. If additional assistance is needed, please contact Clearview
Support.

Field Descriptions

Toolbar

New - Creates a new message under the selected message type

Save - Saves the selected message

Copy - Copies the selected message

Delete - Deletes the selected message

Send Test - Sends a test based on a provided KeyID

Messages Tab

 Selections Pane

Message Type (drop down) - Used to categorize messages (e.g Email, Webhook, etc.)

Name (selection pane) - List of messages to select from

 Messages Pane

Name - Name of the selected message

Message Type - Designates the message type for categorization

Content Wrapper - Specifies a content wrapper to define the design of the email

IsActive - When checked, message is active

 Content Tab

Defines the content to be sent in the message. While messages can be used for purposes other than email,
for context, the documentation below 

Subject - Message subject

SMTP Relay - SMPT Relay used to send the message. Available relays are defined via AD>Global
Settings>SMTP / Webhoook Relay Servers.

HTML Body - Body of the message, supports HTML markup.

Body - Body of the message, supports plain text. Only used if HTML Body is blank.

Preview - Click to render a preview of the message.



InFocus User Manual - Current (v2020)528

© 2020 Clearview Software, Inc.

 Queries Tab

Messages are dynamic in that they can be used to communicate a defined set of information to one or many
recipients. 

These parameters are defined on the Queries tab.

Render Variables - Used to return a result set for processing when rendering a message. The result set
must contain two columns.
o VariableName (nvarchar) - Name of the variable. Must be defined in the query and should be returned

as a string wrapped in braces (e.g. '{{Body}}'). The VariableName can be referenced in the content of
the message. For instance, the HTML Body could contain a reference to {{Body}} which, upon render,
would be replaced with the VariableValue.

o VariableValue (nvarchar) - Results returned in the variable. Must be declared in the query (e.g.
@Body)

o KeyID - Specifies the internal InFocus record ID to use in the query.

Recipient List - Query to define the recipients. The result set should return the following columns- one of
which should be null.
o EmpID (int) - Use to specify a single Employee
o Receipients (nvarchar) Use to supply a comma separated list of email addresses.

Attachments - Query to define documents to be sent with the message. The result set should return the
the following columns
o UniqueName (nvarchar)
o FileName (nvarchar)
o PdfFileName (nvarchar) - If supplied, all files with matching values will be merged into a single PDF

file. Optional.
o ZipFileName (nvarchar) - If supplied, all matching values will be added to a .zip file. Optional.

 Headers Tab

Optionally supply additional Headers. The header values will be processed by the Render Query as well as
the Standard Variable Replacement.

Name - Header name

Value - Header value

 Wrappers Tab

Name - Wrapper name

Content Variable - Variable Name, must be contained in braces (e.g. {{TEMPLATE-CONTENT}}

Wrapper Text - Style sheet to be used by the wrapper. 

4.11.20 Navigator Queries

Overview

This is an extremely powerful search (navigation) function. It affects the most commonly used screens and

makes finding transactions and/or records much easier. The selections available in the InFocus Navigator are

driven by data queries. Each of these system queries can be edited as needed. Additionally, custom queries

can be written to be utilized by the Navigator. 
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*Keystroke Note: Utilize the InFocus Navigator by clicking Ctrl + Tab and selecting Navigator in the Tools

section of the pop up.

Field Description

Queries Drop-down - When you click on the drop-down, a list of both system and custom queries to select

show up here.  The queries in the list are specific to the applet that you are currently in (Fig. 1 is currently in

the Projects applet).

Query Return Window - The window displays the results of the query selected in the Drop-down.

Queue Window - This window displays all items selected from the Query Return Window.  To get items to

display here, Left-click and highlight the items.  Next, click the Add To Queue button.  Once items are here,

you are able to move through them using the arrows at the bottom of the window.

Note - You are able to export the queries to Excel for personal use.

Queries

Chart Of Accounts
Active By Code

Active By Cost Type

Active By Financial Type

Active By FS Group

Active By Metric Type

Active By Name

Active By Org Unit

Active By PM Type

Active By Revenue Type

Active Others

By Code

By Name

By Register Type

By Subledger

Inactive By Code

Inactive By Financial Type

Inactive By FS Group

Inactive By Name

Inactive Others
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Clients
Active By Code

Active By Name

Active By Specialty

Active By type

By Code

By Main Contact

By Marketing Contact

By Name

By Sales Contact

Inactive By Code

Inactive By Name

Inactive By Specialty

Inactive By Type

Open A/R

Warnings

Disbursement Journal
Book Marks

By Bank Account, Check No

By Payee

By Payee Last 2 Weeks

By Payee Last 6 Periods

By Project

By Project Last 2 Weeks

By Project Last 6 Periods

By Sales Invoice

Cleared By Bank Rec Date

Cleared By Check Number

Error Suspense

Last 2 Weeks

Last 6 Periods

This Period

Unbilled By Payee, Check Number

Unbilled By Payee, Project

Unbilled By Project, Payee

Uncleared By Check Number

Zero Dollar Checks

Employee Reimbursables
Book Marks

By Employee

By Employee Last 2 Weeks

By Employee Last 6 Periods

By Project

By Project Last 2 Weeks

By Project Last 6 Periods

By Sales Invoice

Emp Reim Open By Invoice Date

Error Suspense

Last 2 Weeks
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Last 6 Periods

Open By Employee

This Period

Unbilled By Employee, Invoice Date

Unbilled By Employee, Project

Unbilled By Project, Employee

Employees
Active By Code

Active By Dashboard Group

Active By Job Title

Active By Job Type

Active By Manager

Active By Name

Active By Org Unit

Active By Payroll Group

Active By Timesheet Group

Birthdays

By Anniversary Month

By Code

By Name

Inactive By Code

Inactive By Job Type

Inactive By Manager

Inactive By Name

Inactive By Org Unit

Last Review

Open E/R

Expense Sheets
My Expensesheets By Check No.

My Expensesheets By Date

My Expensesheets By Project Code

My Expensesheets By Project Name

My Unpaid Expensesheets

Open By Approver

Open By Date

Open By Employee

Unapproved  Where I Am The Alt Approver

Unapproved  Where I Am The Approver

Unpaid By Employee

General Journal
Bank Adjustments

Book Marks

By Period

Credit Card Cash Basis

End of Year Closings

Error Suspense

Invalid Bank Transfers
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Labor Distributions

Last 2 Weeks

Last 6 Periods

Rev Rec/Profit Sharing

This Period

Project Central
Active Projects

Active Rollup Projects

All Billable Projects

By Client

By Contract Type

By Market

By Org Unit

By Principal

By Project Accountant

By Project Manager

By Rate Schedule

By Report Type

Consultant charged in last 5 days

Dormant Projects

Inactive Opportunities

Inactive Projects

Labor charged in last 5 days

Open A/R

Opportunities

Opportunities By Stage

Overbudget Projects

Overdue by 45 Days or More

Plan Templates

Project Plans

Projects Active This Year

Projects with Backlog

Projects with WIP

Scheduled in next 5 days

Unapproved Change Orders

Unapproved Expense Sheets

Unapproved Time

Project Planning
Active By Billing Group

Active By Client

Active By Code

Active By Contract Type

Active By Expense Group

Active By Invoice Design

Active By Invoice Group

Active By Market

Active By Name

Active By Org Unit

Active By PIC
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Active By Prj Acct

Active By Prj Mgr

Active By Rate Schdule

Active By Report Type

Active Fixed Fee Projects

Active Indirect

Active Opportunities By Code

Active Opportunities By Name

Active Plans

Active Projects With WIP

Active With No Bill Rate Schedule

By Code

By Name

Inactive  By Prj Mgr

Inactive By Client

Inactive By Code

Inactive By Contract Type

Inactive By Market

Inactive By Name

Inactive By Org Unit

Inactive By PIC

Inactive By Prj Acct

Inactive By Report type

Inactive Indirect

Inactive Opportunities By Code

Inactive Opportunities By Name

Inactive Plans

My Active Projects

My Inactive Projects

Open A/R

Plan Templates

Scheduled in next 5 days

Unapproved Change Orders

Unapproved Time

Projects
Active By Billing Group

Active By Client

Active By Code

Active By Contract Type

Active By Expense Group

Active By Invoice Design

Active By Invoice Group

Active By Market

Active By Name

Active By Org Unit

Active By PIC

Active By Prj Acct

Active By Prj Mgr

Active By Rate Schdule

Active By Report Type
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Active Fixed Fee Projects

Active Indirect

Active Opportunities By Code

Active Opportunities By Name

Active Plans

Active Projects With WIP

Active With No Bill Rate Schedule

By Code

By Name

Inactive  By Prj Mgr

Inactive By Client

Inactive By Code

Inactive By Contract Type

Inactive By Market

Inactive By Name

Inactive By Org Unit

Inactive By PIC

Inactive By Prj Acct

Inactive By Report type

Inactive Indirect

Inactive Opportunities By Code

Inactive Opportunities By Name

Inactive Plans

My Active Projects

My Inactive Projects

Open A/R

Projects Active This Year

Unapproved Change Orders

Unapproved Time

Purchase Journal
Book Marks

By Project

By Project Last 2 Week

By Project Last 6 Periods

By Sales Invoice

By Vendor

By Vendor Last 2 Weeks

By Vendor Last 6 Periods

Error Suspense

Last 2 Weeks

Last 6 Periods

Open By Due Date

Open By Vendor

This Period

Unbilled By Project, Vendor

Unbilled By Vendor, Invoice

Unbilled By Vendor, Project

Receipt Journal
Book Marks
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By Bank Account, Deposit Date

By Payer

By Payer Last 2 Weeks

By Payer Last 6 Periods

By Project

By Project Last 2 Weeks

By Project last 6 Weeks

Cleared By Bank Rec Date

Cleared By Deposit Date

Error Suspense

Last 2 Weeks

Last 6 Periods

This Period

Uncleared By Check Date

Sales Journal
Book Marks

By Client

By Client Last 2 Weeks

By Client Last 6 Periods

By Project

By Project Last 2 Weeks

By Project Last 6 Periods

Credit Memos

Error Suspense

Last 2 Weeks

Last 6 Periods

Open By Clients

Open By Due Date

This Invoicing Period

This Period

Zero Dollar Invoices

Time Sheet
My Timesheets By P/E Date

My Timesheets By Project Code

My Timesheets By Project Name

Open By Approver

Open By Employee

Open By P/E Date

Unapproved Where I Am The Alt Approver

Unapproved Where I Am The Approver

Timesheet Adjustments
By Employee

By Employee Last 12 Weeks

By P/E Date

By P/E Date Last 12 Weeks

By Project, Employee

By Project, P/E Date
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By Sales Invoice

Unbilled By Project, Employee

Unbilled By Project, P/E Date

Unprocessed Time

Vendors
Active By 1099 Type

Active By Code

Active By Name

Active By Type

By Code

By Name

Inactive By 1099 Type

Inactive By Code

Inactive By Name

Inactive By Type

Open A/P

4.11.21 OH Allocation Scripts

Overview 

The OH Scripts applet is where you can Optionally build the scripts that will be run when using the Overhead

Allocation utility.  More on Overhead Allocation

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar
Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Script - When selected, you get a are prompt to enter a New Script.

Print Script Results - Runs the OH Scripts Report. More on the OH Scripts Report

Field Descriptions 

Name

Name - Name of the Overhead Allocation Script.  Double-click on it to bring it into focus.

Header

Script Name - Name of the Overhead Allocation Script.  It can be edited here.
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Calculation Type - Calculation Type that will be used by the Allocation Script.  Options are Single Period,

Multi-Period and Balance Forward.

Variance Account - Account that the Variance will be posted to when the utility is run.

Settings

Calc. Labor From Timesheet - When checked, the Labor amounts will be calculated from Timesheet

transactions when the Allocation Script is run.

Clear Previous OH Allocation - When checked, the previous Overhead Allocation will be deleted when the

Allocation Script is run.

Is DPE - When checked, the script is used to calculate DPE.

Only Use timesheets processed by labor distribution - When checked, only timesheets processed by

Labor Distribution utility will be used by the script. More on Labor Distribution

Use Work Dates - When checked, the Work Dates will be used when the Allocation Script is run.

Script Steps

Description - Double click to bring into focus. Line items here are entered through the Step Properties

when you click Add Step at the bottom of the grid.  More on Step Properties

4.11.21.1Step Properties

Overview 

The Step Properties appears when you click Add Step at the bottom of the OH Allocation Scripts>Script

Steps grid.  More on OH Allocation Scripts

Field Descriptions 

Header

Step Number - Step Number that the script will be run in the Overhead Allocation Script.

Description - Description of the Script.

Method - Method to be calculated by the script. Options are Direct Labor and Total Labor.

From G/L Account - Source G/L Account

To Base Account - Destination G/L Account

Apply to Projects - When checked, the step will apply to the projects.
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Source Tab

Org Units

Org Units - When selected, the Org unit is used as a source Org Unit in the Script Step. More on Org

Units

Accounts

Accounts - When selected, the Accounts selected are used as a source Account in the Script Step. More

on GL Accounts

All Indirect - When selected, all indirect Accounts will be used as a source Account in the Script Step.

Lines - Lines to be called in the script

o Line No - Order that the line will be calculated when the Script Step is run.

o Org. Path - Org Path that the line will calculated when the Script Step is run.

Target Tab

Use - When selected, the Org Unit is considered a target for the Script Step

Include Children - When selected, the children of the Organizational Unit are included in the Script Step.

Org Path - Path of the Organizational Unit.

4.11.22 Overhead Allocation

Overview 

The Overhead Allocation applet manages how overhead is viewed. This is an Advanced feature offered by

InFocus. It is recommended that you contact support to schedule a consultation before you implement this

feature.

Toolbar

The InFocus Toolbar is dynamically built in accordance with the active applet on the screen. More on Toolbar

Options

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Automate Allocations - When clicked, the Overhead Allocation Editor appears. More on the Overhead

Allocation Pop-up
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Field Descriptions 

Display

DPE - Select this if the allocation is for DPE.

Overhead - Select this if the allocation is for overhead.

G/L Period

G/L Period - General ledger accounting period to use for posting and labor transaction evaluation.

Overhead Allocation Grid

Project Path - Path of Project to be included in Allocation when it is run.

Project Path - Path of Project to be included in Allocation when it is run.

Project Name - Name of Project to be included in Allocation when it is run.

4.11.22.1Overhead Allocation Pop-up

Overview 

The Overhead Allocations Editor is where you manage your Overhead Allocations. 

Note - Clicking Run will make a transaction for all WBS bottom nodes worked on in the period. These can

later be edited, deleted, or added to manually. 

Field Descriptions 

G/L Period

G/L Period - General Ledger accounting period to use for posting and labor transaction evaluation.

Specified Multipliers

Options

DPE - When checked, this allocation is for DPE (Direct Personal Expense).

Overhead - When checked, this allocation is for Overhead.

G/L Period or Work Date

Period - When checked, only labor transactions processed by labor distribution for the given period are to

be included.



InFocus User Manual - Current (v2020)540

© 2020 Clearview Software, Inc.

Work Date - When checked, all labor transactions whose work date falls within the given period are to be

included.

Multiplier - Multiplier used when the Overhead Allocation tool is run.

OH Allocation Script - When selected, an OH Allocation Script to run Overhead Allocation can be

selected. More on OH Allocation Scripts

4.11.23 PM Report Designer

Overview 

Project Management Reports are project-based reports.

Key Concepts

You can find a description of system PM Reports in the InFocus System Reports chapter of this manual. 

More on InFocus PM Reports

The Original PM report cannot be modified,however, if you would like to customize the report, you can do

so by copying the system version of the report make changes through the Microsoft Business Intelligence

Development Studio.  A link to the tool is located on the support site here.

To export the raw data of the report to Excel without including headers, footers, and grouping areas (i.e., a

two-dimensional listing), click on the View Data button. The report data will appear in a grid that can then

be exported.

Only data related to projects is available. The data are grouped into these five categories:

o Aggregates -  Aggregates are transaction data that CAN be accumulated (summed or totaled). An

example is Hours Worked. While all aggregates are numeric, not all numeric's are aggregate. Bill Rate

is not an aggregate because summing a bill rate is illogical. More on Aggregates

o Non-Aggregates -  Non-aggregates are a transaction data that CANNOT be accumulated. Examples

are Employee Name or Invoice Date. More on Non-Aggregates

o Project  Fact - All fields that come from the Bill Terms Node (Project) are found here. Client name

would be one example.

o Project - Fields that can be set at any level of the WBS are found here. Labor contract amount is one

example.

o Project UDF - Project user-definable fields.

Up to three periods or data ranges can appear on a report. For instance, Current Hours and Project-to-

Date Hours can be viewed. The periods affect the aggregate fields only. They create multiple copies of

those fields in the dataset by appending a _1, _2, or _3 to the field name.

There are two types of reports -  simple and intermediate. 

https://support.clearviewsoftware.net/articles/5349
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o Intermediate reports require downloading the report layout, modifying it in Microsoft Report Designer,

and then uploading the layout.

o Both Simple and Intermediate designs require selecting columns, configuring report parameter

defaults, and setting security.

The reports that come with InFocus are preserved in a separate table from those designed by the user.

Shipped reports can be copied into the user’s own custom designs.

Here is a video that takes a deeper look into running InFocus reports: More on Running InFocus Reports.

Customizing a Project Management Report

To create a custom PM report, first select the report in the PM Report Designer applet using the list on

the left part of the screen. 

The Copy function is located in the toolbar menu, click Copy. 

When clicked, it will prompt for a report name that must be unique.  Add the name and click OK.

After copying a report, it can be downloaded (Download button located on the toolbar) to a local disk

folder and modified using Microsoft Report Designer. 

Note - Knowledge of using the Microsoft BIDS tool is required.  All customizations NOT completed by a

Clearview technician are NOT supported by Clearview Support.

When done, use the Upload function in the Report Management applet to save your design. More on

Uploading a report

4.11.23.1PM Report Interface

Overview 

This PM Report Designer allows the end user to Use/Construct his own PM Reports that will be housed in

the application and appear on the Report List of the PM Reports. Knowledge of SQL is required.

Key Concepts

Included with the PM Reports applet are nineteen pre-designed reports. The nineteen reports can be

filtered by date range, project date, charge type, sector, report type, and status. Click the Edit Prompts

Default button on the toolbar to set defaults. The user must have access to this applet in the permissions

module to use this applet.

On the Applet window at the left is a list of reports. Double-click a report to bring it up in the edit mode on

the right. If it is a system report, it cannot be changed. The details will be grayed out.

https://support.clearviewsoftware.net/articles/5379
https://support.clearviewsoftware.net/articles/5385
https://support.clearviewsoftware.net/articles/5385
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Print Expanded -  Project management reports use drill-down and are shown in a collapsed mode. When

Print Expanded is checked, all drill-downs are expanded. To see the details in the drill-down in a printed

copy, check this option.

To export the raw data of the report to Excel without including headers, footers, and grouping areas (i.e., a

two-dimensional listing), click on the View Data button. The data that comprise the report will appear in a

grid, which can then be exported.

4.11.23.2Report Details Tab

Overview 

The Report Details Tab contains the main details of the PM Report. 

Field Descriptions 

Active - When checked, this is an active report.

Name & Title

Report Name - Name of report (No Spaces Allowed)

Report Title - Title to print on report

Is Summary - When checked, Employees with the "Is Summary" rate access (Employees>Accounting

Rates Tab) can see those rates on the report.

Report Type

Limit Project Leaders - When checked, project leaders will see only the projects they are assigned to.

This can be overridden for a project leader with the special permission Can Override Limit to Project

Leader.

Use Range For Period 1 - When checked, period 1 will prompt for a start and end date; otherwise, only an

end date is requested.

Periods - Number of periods on report. As you select a number, fields in the Period Prompts section are

activated.

Period Prompts

Period 1 Prompt - Prompt text for period 1.
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Period 2 - Type of Period. Choices are Calendar Year-to-Date, Fiscal Year-to-Date, Project-to-date, and

Custom. All but Custom use a Period 1 end date and require no prompt. Custom prompts for a data

range.

Period 2 Prompt - Prompt text for period 2.

Period 3 - Type of Period. Choices are Calendar Year-to-Date, Fiscal Year-to-Date, Project-to-date, and

Custom. All but Custom use a Period 1 end date and require no prompt. Custom prompts for a data

range.

Period 3 Prompt - Prompt text for period 3.

Where Clause - A SQL Where Clause can be added here. Knowledge of SQL is required.

Description - Description of report. Informational only.

Results Override - Additional SQL can be added here to extend the data returned. The PM Report

designer returns a table named #results.  The table can be joined against in this window. Knowledge of

SQL is required.

Show Advanced Options

Eliminate Tx with Zero Balances For  - When checked, the report will not return transactions containing

zero balance for the following types:

o Revenue

o Cost

o Budget

Group Data - When checked, data is group based on all columns (except aggregates). This is the normal

operation. Only uncheck it if you want to see individual records.

Denormalize WBS -  When checked, the fields that breakdown the WBS are broken into separate fields.

Ex. ProjectPath  becomes ProjectPath1 (Project Level), ProjectPath2 (Phase Level), ProjectPath3 (Task

Level), and ProjectPath4 (Subtask Level)

Use v1.5.0+ Date Format - If you are running a version of InFocus that is greater than version 1.5.0, this

box should be checked.

4.11.23.3Layout Tab

Overview 

The Layout Tab. This tab is available only for simple reports. Simple reports allow for a fixed number of
columns (based on a template) to be defined. The columns are limited to the aggregate columns.
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Key Concepts

Access simple reports in the toolbar by clicking New in the Toolbar and then choosing Simple Report.

Field Descriptions

Template - Drop-down list of predefined shipped templates.

Col # - Column number. Order column appears to the left of fixed columns in template.

Header Line 1 - 1st line of column header.

Header Line 2 - 2nd line of column header.

Period - Period version of aggregate column.

Column - Aggregate column.

Format - Print numeric format. Choices determine number of decimal places, whether to print zero figures,

and largest number allowed.

Leaving blank rows between the column definitions will leave blank spacing in the report.

4.11.23.4Columns Tab

Overview 

The Columns tab is visible for intermediate reports. The available fields in the report are specified here.

Key Concepts

Access Intermediate Reports in the toolbar by clicking New in the Toolbar and then choosing Intermediate

Report.

The screen has two lists:

o Available Columns

o Current Columns 

To include a column - To include a column, highlight it in the Available Columns list and click on the right

arrow button.

To remove a column - To remove a column, highlight it in the Current Columns list and click on the left

arrow button.

Lists can be filtered by the type of field by using the Available Columns and Current Columns dropdown

menus. The choices are aggregate, non-aggregate, project, project facts, and UDF (Project UDF’s).

Available Columns list can be additionally filtered by typing in the list filter (located at the top of the

Available Columns list
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The following sections will give a definition of the aggregate and non-aggregate fields. Definitions for the

other three types can be found in the online data dictionary.

4.11.23.5Aggregates

Overview 

The majority of aggregate fields follow a basic set of syntactical rules with a root word that can have multiple

prefixes and suffixes. Understanding the syntax of the fields is key. Review the Key Concept on how to find

what the fields represent.

Key Concepts

Root Words

o Cost - Labor and expense cost values from transactions. In the case of labor it can be at pay rate or

job cost rate depending on global settings.

o Billed - Billed Revenue

o UnBilled - Unbilled Revenue

o Earned - Earned Revenue. Billed revenue plus unbilled revenue.

o Wip - Work In Progress

o Budget - Budget dollars

o Alloc - Allocated Dollars

First Prefix - Only used with budget and alloc root words.

o BL - Base line. 

Second Prefix - Used with all root words

o Labor - Project management type is labor

o ODC - Project management type is other direct charges

o OCC - Project management type is out-of-contract consultants

o ICC - In-contract consultants

First Suffix - Used with cost root word.

o MU - Marked-up value. For labor, it means bill rate; for expenses, it is the billable value.

Second Suffix - Used with cost root word.

o Rnd - Rounded to two decimal places value.
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Third Suffix - Used with cost root word.

o A - Adjustments. All versions of a cost transaction except its most recent.

o N - Transactions with a bill status of Never Bill.

o B - Transactions with a bill status of Billed.

o R - Transactions with a bill status of Ready to Bill.

o H - Transactions with a bill status of Hold.

o W - Transactions with a bill status of Writeoff.

Examples -  Variations of the root word - cost.

o Cost - Cost of all labor and expense transactions. Unrounded

o CostRND - Cost of all labor and expense transactions. Rounded

o LaborCost - Cost of labor transactions unrounded.

o ODCCostMU - Marked up value of ODC transactions

o OCCCostMUH - Marked up value of OCC transactions that are on hold.

Field Descriptions

AllocAmount - Total allocated dollars

BadDebt - Bad debt

Billed - Total billed revenue

BLHoursBudget - Baseline budgeted hours

BLICCBudget - Baseline ICC budget dollars

BLICCBudgetPA - Baseline ICC budget percent allocated

BLLaborBudget - Baseline labor budget dollars

BLLaborBudgetPA -Baseline labor budget percent allocated

BLOCCBudget - Baseline OCC budget dollars

BLOCCBudgetPA - Baseline OCC budget percent allocated

BLODCBudget - Baseline ODC budget dollars

BLODCBudgetPA - Baseline ODC budget percent allocated

Budget - Total budget dollars

BudgetPA - Total budget percent allocated

Cost - Total cost

CostA - Total cost of Non-Current Transactions

CostB - Total cost of Billed Transactions

CostH - Total cost of Hold Transactions

CostMU - Total marked-up Value Cost Transactions



InFocus Modules and Applets 547

© 2020 Clearview Software, Inc.

CostMUA - Total marked-up Value of Non-Current Transactions

CostMUB - Total marked-up Value of Billed Transactions

CostMUH - Total marked up value Hold Transactions

CostMUN - Total marked-up value of Never Bill Transactions

CostMUR - Total marked-up value of Ready-to-Bill Transactions

CostMURnd - Total marked-up value of Cost Transactions; rounded

CostMURndA - Total marked-up value of Non-Current Transactions; rounded

CostMURndB - Total marked-up value of Billed Transactions; rounded

CostMURndH - Total marked-up value of Hold Transactions; rounded

CostMURndN -Total marked-up value of Never Bill Transactions; rounded

CostMURndR - Total marked-up value of Ready-to-Bill Transactions; rounded

CostMURndW - Total marked-up value of Write Off Transactions; rounded

CostMUW - Total marked-up value of Write Off Transactions

CostN - Total cost of Never Bill Transactions

CostR - Total cost of Ready to Bill Transactions

CostRnd - Total Cost; rounded

CostRndA - Total cost of Non-Current Transactions; rounded.

CostRndB - Total cost of Billed Transactions; rounded

CostRndH - Total cost of Hold Transactions; rounded

CostRndN - Total cost of Never Bill Transactions; rounded

CostRndR - Total cost of Ready to Bill Transactions; rounded

CostRndW - Total cost of Write-Off Transaction; rounded

CostW - Total cost of Write-Off Transactions

Earned - Total earned revenue (Billed revenue plus unbilled revenue)

ETCAmount - Estimate-to-complete dollars

HoursBudget - Budget hours

ICCAllocAmount - ICC allocated dollars

ICCAllocQty - ICC allocated units

ICCBilled - ICC billed revenue

ICCBudget - ICC budget dollars

ICCBudgetPA - ICC budget percent allocated

ICCBudgetPC - ICC budget percent complete

ICCCost - ICC total cost

ICCCostA - ICC cost of Non-Current transactions

ICCCostB - ICC cost of Billed Transactions
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ICCCostH - ICC cost of Hold Transactions

ICCCostMU - ICC marked up value of Cost Transactions

ICCCostMUA - ICC marked up value of Non-Current Cost Transactions

ICCCostMUB - ICC marked up value of Billed Cost Transactions

ICCCostMUH - ICC marked up value of Hold Transactions

ICCCostMUN - ICC marked up value of Never Bill Cost Transactions

ICCCostMUR - ICC marked up value of Ready to Bill Transactions

ICCCostMURnd - ICC marked up value of cost transactions. Rounded

ICCCostMURndA - ICC marked up value of Non-Current Cost Transactions. Rounded

ICCCostMURndB - ICC marked up value of Billed Cost Transactions. Rounded

ICCCostMURndH - ICC marked up value of Hold Transactions. Rounded

ICCCostMURndN - ICC marked up value of Never Bill Cost Transactions. Rounded

ICCCostMURndR - ICC marked up value of Ready to Bill Cost Transactions. Rounded

ICCCostMURndW - ICC marked up value of Write Off Cost Transactions. Rounded

ICCCostMUW - ICC marked up value of Write Off Cost Transactions

ICCCostN - ICC cost of Never Bill Transactions

ICCCostR - ICC cost of Ready to Bill Transactions

ICCCostRnd - ICC cost. Rounded

ICCCostRndA - ICC cost of Non-Current Cost Transactions. Rounded

ICCCostRndB - ICC cost of Billed Transactions. Rounded

ICCCostRndH - ICC cost of Hold Transactions. Rounded

ICCCostRndN - ICC cost of Never Bill Transactions. Rounded

ICCCostRndR - ICC cost of Ready to Bill Transactions. Rounded

ICCCostRndW - ICC cost of Write Off Transactions. Rounded

ICCCostW - ICC cost of Write Off Transactions.

ICCEarned - ICC earned revenue. Billed revenue plus unbilled revenue

ICCETCAmount - ICC estimate to complete dollars

ICCETCQty - ICC estimate to complete units

ICCQty - ICC units from cost transactions

ICCQtyA - ICC units from Non-Current Cost Transactions

ICCQtyB - ICC units from Billed Cost Transactions

ICCQtyH - ICC units from Hold Cost Transactions

ICCQtyN - ICC units from Never Bill Cost Transactions

ICCQtyR - ICC units from Ready to Bill Cost Transactions

ICCQtyW - ICC units from Write Off Cost Transactions
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ICCUnbilled - ICC unbilled revenue

ICCWip - ICC work in progress

LaborAllocAmount - Labor allocated dollars

LaborAllocHrs - Labor allocated hours

LaborBilled - Labor billed revenue

LaborBilledDirect - Labor billed revenue non-marked up portion

LaborBilledDPEOH - Labor billed revenue DPE plus overhead portion

LaborBilledFixedFee - Labor billed revenue for fixed fee

LaborBilledProfit -Labor billed revenue for profit

LaborBudget - Labor budget dollars

LaborBudgetPA -Labor budget percent allocated

LaborBudgetPC - Labor budget percent complete

LaborCostBR - Labor at the billing rate

LaborCostBRA - Labor at the billing rate for Non-Current Transactions

LaborCostBRB - Labor at the billing rate for Billed Cost Transactions

LaborCostBRH - Labor at the billing rate for Hold Transactions

LaborCostBRN - Labor at the billing rate for Never Bill Transactions

LaborCostBRR - Labor at the billing rate for Ready to Bill Transactions

LaborCostBRRnd - Labor at the billing rate. Rounded

LaborCostBRRndA - Labor at the billing rate for Non-Current Transactions. Rounded

LaborCostBRRndB - Labor at the billing rate for Billed Transactions. Rounded

LaborCostBRRndH - Labor at the billing rate for Hold Transactions. Rounded

LaborCostBRRndN - Labor at the billing rate for Never Bill Transactions. Rounded

LaborCostBRRndR - Labor at the billing rate for Ready to Bill Transactions. Rounded

LaborCostBRRndW - Labor at the billing rate for Write Off Transactions. Rounded

LaborCostBRW - Labor at the billing rate for Write Off Transactions 

LaborCostJC - Labor at the job cost rate for Non-Current Transactions 

LaborCostJCA - Labor at the job cost rate for Non-Current Transactions 

LaborCostJCB - Labor at the job cost rate for Billed Transactions

LaborCostJCH - Labor at the job cost rate for Hold Transactions

LaborCostJCN - Labor at the job cost rate for Never Bill Transactions

LaborCostJCR - Labor at the job cost rate for Ready to Bill Transactions

LaborCostJCRnd - Labor at the job cost rate. Rounded

LaborCostJCRndA - Labor at the job cost rate for Non-Current Transactions. Rounded

LaborCostJCRndB - Labor at the job cost rate for Billed Transactions. Rounded
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LaborCostJCRndH - Labor at the job cost rate for Hold Cost Transactions. Rounded

LaborCostJCRndN - Labor at the job cost rate for Never Bill Transactions. Rounded

LaborCostJCRndR - Labor at the job cost rate for Ready to Bill Transactions. Rounded

LaborCostJCRndW - Labor at the job cost rate for Write Off Transactions. Rounded

LaborCostJCW - Labor at the job cost rate for Write Off Transactions

LaborCostPay - Labor at the pay rate

LaborCostPayA - Labor at the pay rate for Non-Current Transactions

LaborCostPayB - Labor at the pay rate for Billed Transactions

LaborCostPayH - Labor at the pay rate for Hold Cost Transactions

LaborCostPayN - Labor at the pay rate for Never Bill Transactions

LaborCostPayR - Labor at the pay rate for Ready to Bill Transactions

LaborCostPayRnd - Labor at the pay rate. Rounded

LaborCostPayRndA - Labor at the pay rate for Non-Current Transactions. Rounded

LaborCostPayRndB - Labor at the pay rate for Billed Transactions. Rounded

LaborCostPayRndH - Labor at the pay rate for Hold Transactions. Rounded

LaborCostPayRndN - Labor at the pay rate for Never Bill Transactions. Rounded

LaborCostPayRndR - Labor at the pay rate for Ready to Bill Transactions. Rounded

LaborCostPayRndW - Labor at the pay rate for Write Off Transactions. Rounded

LaborCostPayW - Labor at the pay rate for Write Off Transactions

LaborEarned - Labor earned revenue. Billed plus unbilled revenue

LaborETCAmount - Labor estimate to complete dollars

LaborETCHrs - Labor estimate to complete hours

LaborOTHrsBill - Labor overtime hours. Wrote up or down

LaborOTHrsBillA - Labor overtime hours for Non-Current Transactions. Written up or down

LaborOTHrsBillB - Labor overtime hours for Billed Transactions. Written up or down

LaborOTHrsBillH - Labor overtime hours for Hold Cost Transactions. Written up or down

LaborOTHrsBillN - Labor overtime hours for Never Bill Transactions. Written up or down

LaborOTHrsBillR - Labor overtime hours for Ready to Bill Transactions. Written up or down

LaborOTHrsBillW - Labor overtime hours for Write Off Transactions. Written up or down

LaborOTHrsWork - Labor overtime hours actually worked

LaborOTHrsWorkA - Labor overtime hours actually worked for Non-Current Transactions

LaborOTHrsWorkB - Labor overtime hours actually worked for Billed Transactions

LaborOTHrsWorkH - Labor overtime hours actually worked for Hold Cost Transactions

LaborOTHrsWorkN - Labor overtime hours actually worked for Never Bill Transactions

LaborOTHrsWorkR - Labor overtime hours actually worked for Ready to Bill Transactions
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LaborOTHrsWorkW - Labor overtime hours actually worked for Write Off Transactions

LaborOverallCap - Overall cap amount as specified on the Project Profit Center Sharing screen. 

LaborOwnerCap - Cap amount as specified on the Project Profit Center Owner screen.

LaborOwnerLevel - Project Level where ownership is established.  Specified on Project Profit Center

Owner screen.

LaborOwnerMethodName - Labor revenue recognition method for project owner.

LaborOwnerPC - Labor revenue recognition percent complete for project owner.

LaborRegHrsBill - Labor non-overtime hours. Written up or down

LaborRegHrsBillA - Labor non-overtime hours for Non-Current Transactions. Written up or down

LaborRegHrsBillB - Labor non-overtime hours for Billed Transactions. Written up or down

LaborRegHrsBillH - Labor non-overtime hours for Hold Cost Transactions. Written up or down

LaborRegHrsBillN - Labor non-overtime hours for Never Bill Transactions. Written up or down

LaborRegHrsBillR - Labor non-overtime hours for Ready to Bill Transactions. Written up or down

LaborRegHrsBillW - Labor non-overtime hours for Write Off Transactions. Written up or down

LaborRegHrsWork - Labor non-overtime hours actually worked

LaborRegHrsWorkA - Labor non-overtime hours actually worked for Non-Current Transactions

LaborRegHrsWorkB - Labor non-overtime hours actually worked for Billed Transactions

LaborRegHrsWorkH - Labor non-overtime hours actually worked for Hold Cost Transactions

LaborRegHrsWorkN - Labor non-overtime hours actually worked for Never Bill Transactions

LaborRegHrsWorkR - Labor non-overtime hours actually worked for Ready to Bill Transactions

LaborRegHrsWorkW - Labor non-overtime hours actually worked for Write Off Transactions

LaborUnbilled - Labor unbilled revenue

LaborWip - Labor work in progress

LateFee - Late fee revenue

OCCAllocAmount - OCC allocated dollars

OCCAllocQty - OCC allocated units

OCCBilled - OCC billed revenue

OCCBilledDirect - OCC billed revenue not marked up portion

OCCBilledMarkup - OCC billed revenue marked up portion

OCCBudget - OCC budget dollars

OCCBudgetPA - OCC budget percent allocated

OCCBudgetPC - OCC budget percent complete

OCCCost - OCC total cost

OCCCostA - OCC cost of Non-Current Transactions

OCCCostB - OCC cost of Billed Transactions
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OCCCostH - OCC cost of Hold Cost Transactions

OCCCostMU - OCC marked up value of cost transactions

OCCCostMUA - OCC marked up value of Non-Current Cost Transactions

OCCCostMUB - OCC marked up value of Billed Cost Transactions

OCCCostMUH - OCC marked up value of Hold Transactions

OCCCostMUN - OCC marked up value of Never Bill Transactions

OCCCostMUR - OCC marked up value of Ready to Bill Transactions

OCCCostMURnd - OCC marked up value of cost transactions. Rounded

OCCCostMURndA - OCC marked up value of Non-Current Cost Transactions. Rounded

OCCCostMURndB - OCC marked up value of Billed Cost Transactions. Rounded

OCCCostMURndH - OCC marked up value of Hold Transactions. Rounded

OCCCostMURndN - OCC marked up value of never bill cost transactions. Rounded

OCCCostMURndR - OCC marked up value of Ready to Bill Transactions. Rounded

OCCCostMURndW - OCC marked up value of Write Off Transactions. Rounded

OCCCostMUW - OCC marked up value of Write Off Transactions.

OCCCostN - OCC cost of Never Bill Transactions

OCCCostR - OCC cost of Ready to Bill Transactions

OCCCostRnd - OCC cost. Rounded

OCCCostRndA - OCC cost of Non-Current Cost Transactions. Rounded

OCCCostRndB - OCC cost of Billed Transactions. Rounded

OCCCostRndH - OCC cost of Hold Transactions. Rounded

OCCCostRndN - OCC cost of Never Bill Transactions. Rounded

OCCCostRndR - OCC cost of Ready to Bill Transactions. Rounded

OCCCostRndW - OCC cost of Write Off Transactions. Rounded

OCCCostW - OCC cost of Write Off Transactions

OCCEarned - OCC earned revenue. Billed revenue plus unbilled revenue

OCCETCAmount - OCC estimate to complete dollars.

OCCETCQty - OCC estimate to complete units

OCCQty - OCC units from cost transactions

OCCQtyA - OCC units from Non-Current Cost Transactions

OCCQtyB - OCC units from Billed Cost Transactions

OCCQtyH - OCC units from Hold Cost Transactions

OCCQtyN - OCC units from Never Bill Cost Transactions

OCCQtyR - OCC units from Ready to Bill Cost Transactions

OCCQtyW - OCC units from Write Off Cost Transactions



InFocus Modules and Applets 553

© 2020 Clearview Software, Inc.

OCCUnbilled - OCC unbilled revenue

OCCWip - OCC work in progress

ODCAllocAmount - ODC allocated dollars

ODCAllocQty - ODC allocated units

ODCBilled - ODC billed revenue

ODCBilledDirect - ODC billed revenue not marked up portion

ODCBilledMarkup - ODC billed revenue marked up portion

ODCBudget - ODC budget dollars

ODCBudgetPA - ODC budget percent allocated

ODCBudgetPC - ODC budget percent complete

ODCCost - ODC total cost

ODCCostA - ODC cost of Non-Current Cost Transactions

ODCCostB - ODC cost of Billed Transactions

ODCCostH - ODC cost of Hold Transactions

ODCCostMU - ODC marked up value of cost transactions

ODCCostMUA - ODC marked up value of Non-Current Cost Transactions

ODCCostMUB - ODC marked up value of Billed Cost Transactions

ODCCostMUH - ODC marked up value of Hold Transactions

ODCCostMUN - ODC marked up value of Never Bill Cost Transactions

ODCCostMUR - ODC marked up value of Ready to Bill Transactions

ODCCostMURnd - ODC marked up value of cost transactions. Rounded

ODCCostMURndA - ODC marked up value of Non-Current Cost Transactions. Rounded

ODCCostMURndB - ODC marked up value of Billed Cost Transactions. Rounded

ODCCostMURndH - ODC marked up value of Hold Transactions. Rounded

ODCCostMURndN - ODC marked up value of Never Bill Cost Transactions. Rounded

ODCCostMURndR - ODC marked up value of Ready to Bill Cost Transactions. Rounded

ODCCostMURndW - ODC marked up value of Write Off Cost Transactions. Rounded

ODCCostMUW - ODC marked up value of Write Off Cost Transactions

ODCCostN - ODC cost of  Never Bill Transactions

ODCCostR - ODC cost of Ready to Bill Transactions

ODCCostRnd - ODC cost. Rounded

ODCCostRndA - ODC cost of Non-Current Cost Transactions. Rounded

ODCCostRndB - ODC cost of Billed Transactions. Rounded

ODCCostRndH - ODC cost of Hold Transactions. Rounded

ODCCostRndN - ODC cost of Never Bill Cost Transactions. Rounded
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ODCCostRndR - ODC cost of Ready to Bill Transactions. Rounded

ODCCostRndW - ODC cost of Write Off Transactions. Rounded

ODCCostW - ODC cost of Write Off Transactions

ODCEarned - ODC earned revenue. Billed revenue plus unbilled revenue

ODCETCAmount - ODC estimate to complete dollars.

ODCETCQty - ODC estimate to complete units

ODCQty - ODC units from cost transactions

ODCQtyA - ODC units from Non-Current Cost Transactions

ODCQtyB - ODC units from Billed Cost Transactions

ODCQtyH - ODC units from Hold Cost Transactions

ODCQtyN - ODC units from Never Bill Cost Transactions

ODCQtyR - ODC units from Ready to Bill Cost Transactions

ODCQtyW - ODC units from Write Off Transactions

ODCUnbilled - ODC unbilled revenue

ODCWip - ODC work in progress

ProjectDPE - DPE dollars applied

ProjectOH - Overhead dollars applied

Recvd - Received dollars

Retainage - Retainage revenue

Retainer - Retainer revenue

Unbilled - Unbilled revenue

Wip - Work in progress

4.11.23.6Non-Aggregates

Overview 

Non-aggregates are transaction data that cannot be accumulated. Employee name or invoice date are

examples of non-aggregates.

Field Descriptions

BillDPEMult - DPE multiplier used for bill rate from labor transactions

BillOHMult - Overhead multiplier used for bill rate from labor transactions
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BillPrMult - Profit multiplier used for bill rate from labor transactions

BillRate - Bill rate from labor transaction

BillStatus - Bill status from cost transactions. See List Management for possible values

ChargeOrgCode - Charged organization unit code from labor transaction

ChargeOrgLongName - Charged organization unit long name from labor transaction

ChargeOrgName -Charged organization unit name from labor transaction

ChargeOrgPath - Charged organization unit path from labor transaction

ClientCode - Client code assigned to project

ClientName - Client name assigned to project

CostRate - Cost rate from labor transactions. Is either the pay rate or job cost rate, depending on Global

Settings

ExpenseCode - Expense code from non-labor transactions

ExpenseName - Expense code name from non-labor transactions

GLCode - General ledger base account code

GLName - General ledger base account name

HomeOrgCode - Employee home organization unit code from labor transaction

HomeOrgLongName - Employee home organization unit long name from labor transaction

HomeOrgName - Employee home organization unit name from labor transaction

HomeOrgPath - Employee home organization unit path from labor transaction

JCDPEMult - DPE multiplier used for job cost rate from labor transactions

JCOHMult - Overhead multiplier used for job cost rate from labor transactions

JCPrMult - Profit multiplier used for job cost rate from labor transactions

JobCostRate - Job cost rate from labor transactions

JobTitleCode - Job title code from labor transactions

JobTitleName - Job title from labor transactions

LaborCode - Labor code from labor transactions

LaborName - Labor code name from labor transactions

LineID - Transaction line item ID. If selected, every line item, including prior versions and reversals, will

appear in dataset. This will prevent any grouping of data

MasterName - Master name. Can be employee, vendor, or client, depending on transaction type

MetricType - Metric type (see List Management for possible values)

OrgCode - Organization unit code assigned to project

OrgLongName - Organization unit long name assigned to project

OrgName - Organization unit name assigned to project

OrgPath - Organization path assigned to project
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Periodcode - General Ledger period code

PEDate - Period End Date

PMComments - Project Management comments from transactions

PMTypecode - Project Management type code (see List Management for possible values)

PMTypename - Project Management type name (see List Management for possible values)

PMTypeOrder - Project Management type sort order (see List Management for possible values)

Principal - Principal assigned to the project

PrjAcct - Project accountant assigned to the project

PrjMgr - Project Manager

Source - Source of transaction; typically, the journal name

TimePEDate - Time Period End Date

TimePSDate - Time Period Start Date

TransCode - Transaction code; key transaction ID that varies by journal. Can be invoice number, check

number, etc.

Transdate - Transaction Date; varies by journal. Can be invoice date, check date, work date, etc.

TransID - Transaction ID; system-generated ID that groups the transaction

UnitBill - Unit bill rate for non-labor transactions; cost rate with markup

UnitCost - Unit cost rate for non-labor transactions

UnitMarkup - Unit markup for non-labor transactions; markup can be multiplier, flat amount, or add-on.

4.11.23.7Permissions Tab

Overview 

The Permissions Tab gives a list of Users /Groups that may be granted access to the selected PM Reports.
The concept is the same as system Permissions. More on Permissions

4.11.23.8Multi-Currency Tab

Overview 

Reports designed in the PM Report Designer support Base, Project, and Invoicing currencies. The user can
filter PM reports by designated currency. For example, a report could be filtered to show results only for
projects where the Project currency is set to U.S. Dollars (see below). Please note, the underlying report
compiler has been modified to support multi-currency. 
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Field Descriptions

Currency Type - 

Currency - 

4.11.23.9Filters Tab

Overview 

The PM Reports Filters Tab - On this tab, general filters are selected.

Field Descriptions

Date Ranges -  Up to three date periods can be used for a report. Date ranges are controlled by the

definition of the report. The date periods can be an as-of date, or a predefined periods, such as project-to-

date. The date period labels are also based on the report definition.

Projects Dates
Start - Project start dates work in conjunction with project end dates. When filled out, only projects whose

start date is on or after the entered start date and whose end date is one or before the entered end date

are included.

End - Project start dates work in conjunction with project end dates. When filled out, only projects whose

start date is on or after the entered start date and whose end date is one or before the entered end date

are included.

Project Status
Active - When checked, active projects are included.

Inactive - When checked, inactive projects are included.

Charge Types 

Billable - When checked, billable projects are included.

Indirect - When checked, indirect projects are included.

Projection - When checked, projection projects are included.

Opportunity - When checked, opportunity projects are used.
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Plan - When checked, plan projects are used.

Sectors 

Market Sectors - If no items are selected, then a filter is not used. Otherwise, checked market sectors are

included.  Name of the Market Sector. A User Defined Field. The Market Sector list is managed under

Administration>List Management>Market Sectors. 

Report Types

Report Type - Report types are reporting groups that can act as filters when printing project management
reports. A User Defined Field. The Report Type list is managed under Administration>List
Management>Project Report Types. 

Sort & Group By
1st - First field to sort by. Choices are client code, client name, org path, principal, project manager,

project accountant, and org level.

2nd - Second field to sort by. Choices are client code, client name, org path, principal, project manager,

project accountant, and org level.

Footer

Print Expanded -  Project Management reports use drill down and are rendered in a collapsed mode.

However, when print expanded is checked, all drill downs are expanded. To view these details in a printed

hard copy, check this option.

View Data - To export the raw data of the report to Excel without including headers, footers, and grouping

areas (i.e., a two-dimensional listing), click on the View Data button. The data that comprises the report

will appear in a grid that can then be exported.

Print - Renders the PM Report.

Cancel - Cancels the action.

4.11.23.10Settings Tab

Overview 

The PM Reports Settings Tab - On this tab, additional filters are selected.

Field Descriptions

Includes
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Unsubmitted Time - When checked, unsubmitted time is included.

Unapproved Time - When checked, unapproved time is included.

Grand Total - When checked, report grand total will print.

Roll Up Nodes - When checked, project roll-up nodes will print.

Work Breakdown Structure - When checked, project WBS below the bill terms project will print.

Organizational Units
No Org - When checked projects owning org unit is not used as a filter. More on Org Units

Org Path -  When entered, projects owned by this org path are included.

Include Org Children - When checked, projects owned by children of the entered org path are included.

Org Code/Level -  When checked, projects with the same org code at the same level as that entered in

the next two fields are included.

Org Code - Org code to include

Org Level - Org level to include

Date Range Evaluation Methods Labor
Transaction Date - When checked the transaction date will be used for date range evaluation of labor

transactions.

G/L Period End Date - When checked the transaction period end date will be used for date range

evaluation of labor transactions.

Date Range Evaluation Methods Non-Labor
Transaction Date - When checked, the transaction date is used for date range evaluation of non-labor

transactions.

G/L Period End Date - When checked, the transaction period end date is used for date range evaluation

of labor transactions.

Footer

Print Expanded -  Project Management reports use drill down and are rendered in a collapsed mode.

However, when print expanded is checked, all drill downs are expanded. To view these details in a printed

hard copy, check this option.

View Data - To export the raw data of the report to Excel without including headers, footers, and grouping

areas (i.e., a two-dimensional listing), click on the View Data button. The data that comprises the report

will appear in a grid that can then be exported.

Print - Renders the PM Report.

Cancel - Cancels the action.
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4.11.23.11Team Leaders Tab

Overview 

The PM Reports Team Leaders Tab. On this tab, team leader filters are selected.

Field Descriptions

Project Accountants 

Description - Project accountants to include; if empty, filter is not used.

Project Managers 

Description - Project managers to include; if empty, filter is not used.

Principals 
Description - Project principals to include; if empty, filter is not used.

Projects 

Description - Projects to include; if empty, filter is not used. You can also select all projects based on a Roll-

up Node.

Clients 

Description - Project clients to include; if empty, filer is not used.

Footer

Print Expanded -  Project Management reports use drill down and are rendered in a collapsed mode.

However, when print expanded is checked, all drill downs are expanded. To view these details in a printed

hard copy, check this option.

View Data - To export the raw data of the report to Excel without including headers, footers, and grouping

areas (i.e., a two-dimensional listing), click on the View Data button. The data that comprises the report

will appear in a grid that can then be exported.

Print - Renders the PM Report.

Cancel - Cancels the action.
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4.11.23.12UDF Tab

Overview 

The PM Reports Team Leaders Tab. On this tab, team leader filters are selected.

Field Descriptions

UDF Field - Drop-down includes any Project UDFs. More on User Defined Fields

Operator - Choices are =, <>, >, <, >=, <=, between, and is not null. Is not null is synonymous with a

blank or empty field.

o Value 1 -  Used with all filter operators except is not null. This is the value that completes the filter

operation (except in the case of the between operator). In the case of the between this represents the

lower range.

o Value 2 - Used only with the between operator. This represents the upper range.

Footer

Print Expanded -  Project Management reports use drill down and are rendered in a collapsed mode.

However, when print expanded is checked, all drill downs are expanded. To view these details in a printed

hard copy, check this option.

View Data - To export the raw data of the report to Excel without including headers, footers, and grouping

areas (i.e., a two-dimensional listing), click on the View Data button. The data that comprises the report

will appear in a grid that can then be exported.

Print - Renders the PM Report.

Cancel - Cancels the action.

4.11.23.13Edit Prompt Defaults Button

Overview 

The Edit Prompt Defaults option allows you to modify the PM Report prompt.

Key Concepts

Edit Prompt Defaults has three purposes:
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o To set the initial value of a report prompt so when a user runs the report the most common value for a

prompt is preset. 

o To disable prompts, that, if changed, would result in an improper meaning to a report design. 

o To avoid confusion of a user changing the value when the prompt has no effect on the report.

How to access the default prompts:

o Step 1 - Select the Edit Prompt Defaults option from the main menu.

o Step 2 - Complete the Standard Project Management Report parameter form that appears.

o Step 3 - Next to most fields (or groups of fields) will be a check box. If the check is removed from a

box, it will disable the associated field from the report user while retaining the default value.

4.11.24 Project History

Overview 

Project history is used to enter historical labor against a project. All other metrics can be entered through the

accounting journal (typically using the general journal). A special screen is needed for labor since it would be

difficult (sometimes impossible) to enter this in timesheet adjustments without going down to the detail level.

Key Concepts

Entries in this screen are transferred into the time sheet tables. 

They are flagged as historical entries so that will not appear in time sheet adjustments, nor can they be

invoiced or be part of labor distribution. 

They will appear on Project Management reports.

Historical labor transactions can be entered, viewed, and deleted through this screen.

Additional Toolbar Options

Aside from the standard toolbar options this applet has the following options:

Add Entry - When selected, an entry is made if the correct fields are filled out.

4.11.24.1New Entry Tab

Overview 

New Entry Tab. New historical entries are made on this tab. The amount of detail I up to the user.

Key Concepts
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 Click on Add Entry in the toolbar to post the entry.

Field Descriptions 

Options

Project - WBS Path; required field.

Employee - Employee. Required. If you do not wish to record to the employee level, then add an inactive

employee and name it something like "History".

Job Title - Optional.

Home Org Unit - Optional

Charge Org Unit - Optional

Labor Code - Optional

Hours

Work - Hours worked

Bill - Hours to charge client. Typically same as work hours.

Bill Status - Bill Status of transaction. Options are Never Bill, Write-off and Billed. Required

Is Hourly Employee - When checked, the timesheet entry is flagged as being an hourly employee;

optional.

Is Overtime/Premium - When checked, timesheet is flagged as overtime.

Work Date

Work Date - Date of work. can be an As-of date.

Extended Dollar Amounts

Pay - Extended pay amount

Job Cost - Extended job cost amount.

Bill - Extended bill amount

Comments - Comments to appear in Project Management reports.  

4.11.24.2History Tab

Overview 

The History tab is used to find already existing historical entries. Entries can be filtered by date, employee, or
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no filter (all). A list of historical entries appears when a search is run.

Field Descriptions 

Find Entries

All - When selected, all historical entries will appear in the Entries grid.

Date - When selected, any transactions that match the specified date will appear in the Entries grid. 

Employee - When selected, any transactions that match the specified Employee will appear in the Entries

grid. 

Entries Grid

Employee - The Employee proper name.

Period End - Transaction date of the historical entry.

Transactions Grid

Project Path - Project Path of the entry.

Project Name - Project Name of the entry.

Work - Hours worked

Bill - Hours to charge client. Typically same as work hours.

4.11.25 Rate Tester

Overview 

The Rate Tester allows the user to test how a rate will be calculated. Enter a project, employee, date, etc.,
and it will calculate the rates.

Field Descriptions

Filters Window

Project Path -  Project Path that is being analyzed.

Employee - Employee that is being analyzed.

Job Title - Job Title that is being analyzed.

Work Date - Work Date that is being analyzed

Is Overtime - When selected, the OT Type box is enabled to change the Overtime type being analyzed.
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OT Type - The Overtime type being analyzed. More on Overtime Types

Get Rates button - Runs the Utility.

Results Window

Pay Rate -   Pay Rate

OT Multiplier - Overtime multiplier

OT Rate - Overtime rate

JC Base Rate - Base rate used when calculating job cost rates.

JC Base Prem. Mult. - Multiplier applied against base rate for premium time. If changed, it auto-calculates

Job Cost base premium rate.

JC Rate - Job Cost Rate

JC DPE Mult. - Direct personnel expense multiplier.

JC OH Mult. - Overhead multiplier.

JC Profit Mult. - Profit Multiplier.

JC Base Prem. Rate - Base premium rate used for calculating premium job cost rate. When changed, it

auto-calculates premium multiplier.

Bill Base rate - Base rate used when calculating bill rates.

Bill Base Prem. Mult. - Multiplier applied against base rate for premium time. If changed, it auto-calculates

billing base premium rate.

Bill Rate - Billing Rate

Bill DPE Mult. - Direct personnel expense multiplier.

Bill OH Mult. - Overhead multiplier.

Bill Profit Mult. - Profit Multiplier.

Bill Base Prem. Rate - Base premium rate used for calculating premium bill rate. When changed, it auto-

calculates premium multiplier.

Is Hourly - When checked, indicates that employee was classified non-exempt on this work date.

4.11.26 Report Builder

Overview
ReportBuilder is a stand alone report building application which launches from within Utilities>Custom
Reports or directly from Utilities>ReportBuilder (if permissions are granted). Like other custom reports,
reports created through ReportBuilder are housed and displayed in InFocus and governed by designated
permissions.

Reports designed in ReportBuilder inherit the same set of user/role based permissions that govern InFocus
reporting.
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Navigation

ReportBuilder is easily navigated and walks the user through each element in the report design process.
Generally speaking, the elements of report design include the compilation of Data and the organization of that
data by means of Design.

4.11.26.1Datasets

Overview

Datasets is the first step in selecting the information for the report being built. Each dataset represents a

range of related data. Descriptions are provided for each dataset.

4.11.26.2Fields

Overview

Select the fields to be used on the report. Fields available to the chosen dataset are listed on the left and can

be searched by scrolling or typing. Selecting a field displays it's definition at the bottom of the screen.

Field Descriptions

Fields

Lists available fields contained in the selected Dataset

Search by scrolling, opening/closing categories or typing

Select fields using one of the following methods

o Double-Click

o Single Click + Arrow Button

o Mouse Highlight + Arrow Button (multiple selections)

o Ctrl + Click + Arrow Button (multiple selections)

Field Descriptions are displayed below the container when the field is highlighted

Selected Fields

Lists the Fields selected for the report in the default order they will appear on the report.
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Buttons

Right Button: Moves fields to Selected Fields container

Left Button: Moves fields from Selected Fields container

Up and Down Arrows: Used to reorder fields in the Selected Fields Container

4.11.26.3Calculated Fields

Overview

Create calculated fields by naming, configuring and building the supporting expressions.

Field Descriptions

Header

Use Calculated Fields: Enables features of the screen when checked

Field Name: Label to be displayed on the report

Data Type: This governs the typing validation and initial formatting of the returned value from the Field

Expression

o Yes/No

o Date

o Whole Number

o Number

o Text

Auto-Sum: When checked, ReportBuilder will include the calculated field in group footers

Delete (icon): Removes the calculated field from the report

Field Expression

Container where the field expression can be entered

Operands available to the expression

Fields available for use in the expression

4.11.26.4Sorts

Overview

Determine the sorting rules (if any) to apply the report. Fields are selected from a drop down list and then

configured appropriately.
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Field Descriptions

Field Name: Field to be sorted on

Descending: When checked, the report will be sorted in Descending order. Report sorting defaults to

Ascending (1,2,3; A,B,C).

Sort Order: Defines the order in which fields will be sorted when multiple fields are in use. For example:

Sort by Project (Sort Order=1), then by Employee (Sort Order=2)

Delete (icon): Removes the sort from the report

4.11.26.5Filters & Prompts

Overview

ReportBuilder supports two methods of filtering data: Explicit Filters and User Prompts. Each method can be

applied here. Fields are selected from a drop down list and configured appropriately. Select the field and

operand by which to filter. Explicit filters will be applied when a Value is provided for evaluation. A User

Prompt is created in the absence of a Value.

Field Descriptions

Field: Field to be filtered. 

Label: Label to display on the report if creating a prompt

?: Operand to be used in the filter

Value: Value to apply for explicit filters. Leave blank to create a User Prompt

Require: When checked, a value will be required at run-time (User Prompts only)

Delete (icon): Removes the filter/prompt from the report

4.11.26.6Template

Overview

Choose a Template. Templates are the starting place of Report Design in ReportBuilder and are easy to

choose. Scroll through the list of available templates and choose the one that best meets the needs of the

report.
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Field Descriptions

Template Images: Reflect a preview of the template

Use This Template: Click to select the template

Load a custom template: Clicking this link opens a file upload dialogue. Select the .RDL you wish to

utilize and click Open.

4.11.26.7Settings

Overview

Configure the selected template by customizing the Template Options and uploading an Image for "With

Logo" templates.

Field Descriptions

Template Options

Report Title Settings

o Report Text: Text to display in the title of the report. This is the text displayed at the top of the report.

o Show Title: When unchecked, the report title will be hidden

o Title Forecolor: Defines the color of the title text Example

o Title Backcolor: Defines the color of the title text background Example

o Title Align: Sets the alignment of the title on the report

o Title Format: Sets the format of the title using standard .NET formatting Read More 

o Title Font Family: Sets the title font

o Title Font Size: Sets the title font size

o Bold Report Title: When checked, title text appears bold

Subtitle Settings

o Subtitle Name: Text to display in the subtitle of the report. This is the text displayed under the title.

o Show Subtitle: When unchecked, the report subtitle will be hidden

o Subtitle Forecolor: Defines the color of the subtitle text Example

o Subtitle Backcolor: Defines the color of the subtitle text background Example

o Subtitle Align: Sets the alignment of the subtitle on the report

o Subtitle Format: Sets the format of the subtitle

o Subtitle Font Family: Sets the subtitle font

o Subtitle Font Size: Sets the subtitle font size

https://msdn.microsoft.com/en-us/library/dwhawy9k(v=vs.110).aspx
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o Bold Subtitle: When checked, subtitle text appears bold

Header/Footer Settings

o Repeat Page Header: When checked, the report header will be displayed on each page of the report

o Page Number Top: When checked, the page number will be displayed at the top of each page in the

report

o Page Number Bottom: When checked, the page number will be displayed at the bottom of each page

in the report

o Page Number format: Sets the format of the page numbers

o Page Number Align: Sets the alignment of the page number on the report

o Execution Time Top: When checked, the run-time stamp of the report will be displayed at the top of

the report

o Execution Time Bottom: When checked, the run-time stamp of the report will be displayed at the

bottom of the report

o Execution Time Format: Sets the format of the execution run-time stamp

o Execution Time Align: Sets the alignment of the run-time stamp on the report

Line Settings

o Show Header Top Line: When checked, a horizontal line will be displayed in the report header above

the report title

o Show Header Middle Line: When checked, a horizontal line will be displayed in the report header

between the title and subtitle

o Show Header Bottom Line: When checked, a horizontal line will be displayed in the report header

beneath the subtitle

o Show Footer Line: When checked, a horizontal line will be displayed at the top of the report footer

o Line Width: Sets the width of the header and/or footer lines

o Line Color: Sets the color of the header and/or footer lines

Logo

o Use Rectangle Logo: When checked, the report will use the image uploaded as the rectangle logo

placeholder

o Use Square Logo: When checked, the report will use the image uploaded as the square logo

placeholder

o Logo Align: Sets the alignment of the logo on the report

Images

Logo Placeholder (Square): Upload a square logo by clicking the ellipsis (...), selecting a supported file

and clicking open
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Logo Placeholder (Rectangle): Upload a rectangular logo by clicking the ellipsis (...), selecting a

supported file and clicking open

4.11.26.8Groups

Overview

Report Groupings. Determine the grouping rules (if any) to apply the report. Fields are selected from a drop
down list and configured appropriately.

Field Descriptions

Field: Field to be grouped by

Sort Descending: When checked, the group will be sorted in Descending order. Group sorting defaults to
Ascending (1,2,3; A,B,C).
Show Header: When checked, the group header will be displayed. This typically reflects the value of the
field being grouped by.
Show Footer: When checked, the group footer will be displayed. This typically reflects the total value of
the items within the group.
Show Map: When checked, Group will have associated navigation when the report is rendered in
InFocus.
Delete (icon): Removes the group from the report

4.11.26.9Table Layout

Overview

Table Designer is used to define the attributes of the table displayed on the report. The table contains the

data reflected by the report and can be formatted to present that data in a meaningful way.

Field Descriptions

Table Designer

Section T: This is the Title section of the table and is defined by configurations made in Templates and

Settings

Section H: This is the Header section of the table and is defined by configurations made in Settings.

Header labels can be edited.

Section gh: This is the Group Header section of the table and is defined by configurations made in

Groups. The table will display one gh section per group in use (gh0, gh1, gh2, etc). Group Headers can

be edited.

Section D: This is the Detail section of the table and is defined by configurations made in Datasets, Fields
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and Calculated Fields. Detail fields can be edited.

Section gf: This is the Group Footer section of the table and is defined by configurations made in Groups.

The table will display one gf section per group in use (gf0, gf1, gf2, etc). Group Footers can be edited.

Section F: This is the Footer section of the table and is defined by configurations made in Settings. Footer

values can be edited.

Add:

o Row Below: Adds a new row below the selected row in the Table Designer

o Row Above: Adds a new row above the selected row in the Table Designer

o Column: Adds a new column to the table

Remove:

o Row: Removes the row of the selected row or field in the Table Designer

o Column: Removes the column of the selected field in the Table Designer

Preview Sample Report

Preview Sample Report: This button launches a report viewer that displays a mock-up of the report as

defined by all steps in ReportBuilder including the Table Designer. Data displayed on the preview is

generated sample data.

Cell Styling

Description - The following options are applied to the selected cell in the Table Designer.

Alignment: Sets the alignment of the value within the cell (Left, Center or Right)

Font Size: Sets the font size of the value within the cell

Font Family: Sets the font of the value within the cell

Font: When checked, sets the font weight and/or style of the value within the cell

Format Code: Sets the format of the value within the cell

Foreground: Sets the color of the text within the cell

Background: Sets the background color of the cell

Top Border: Sets the weight and color of the top border line of the cell. A weight of "0" denotes a

transparent (hidden) line.

Right Border: Sets the weight and color of the right border line of the cell. A weight of "0" denotes a

transparent (hidden) line.

Bottom Border: Sets the weight and color of the bottom border line of the cell. A weight of "0" denotes a

transparent (hidden) line.

Left Border: Sets the weight and color of the left border line of the cell. A weight of "0" denotes a

transparent (hidden) line.
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Apply Settings to All Cell on Row: Applies the configured setting for each cell in the row of the selected

cell in the Table Designer

Row Settings

Description - The following options are applied to the selected row in the Table Designer.

Merge all Cells on Row: Creates one cell from all the cells in a given row and clears all values contained

by the cells in that row. The merged cell can then be reassigned a value selection.

Row Height: Sets the row height of the selected row

Row Hidden Expression: Row visibility expression. Ex: =iif(fields!column.Value>0,True,False)

Table & Group Options

Table Sections

o Show Header: When unchecked, the header section (Section H) is hidden and values are cleared

o Show Detail Rows: When unchecked, the detail section (Section D) is hidden and values are cleared

o Show Footer: When unchecked, the footer section (Section F) is hidden and values are cleared

Table Repeating

o Repeat Header: When checked, the header section (Section H) is displayed on each page of the

report

o Repeat Footer: When checked, the footer section (Section F) is displayed on each page of the report

Column Sizing

o Auto Size: When checked, the columns will be automatically sized by the maximum length of the

value(s) it contains

Group Sections

o Show Header: When unchecked, the group header selection is hidden and values are cleared

o Show Footer: When unchecked, the group footer selection is hidden and values are cleared

Group Left Indentation: Sets the indentation of the selected group

Group Repeating

o Repeat Header: When checked, the selected group header is displayed on each page of the report

o Repeat Footer: When checked, the selected group footer is displayed on each page of the report

Page Breaking

o Page Break After Grouping: When checked, a page break is inserted on the report after the selected

group

Designer Actions

o Reset Table Layout: Clears all modifications made to the Table Designer. The user is prompted for

verification.



InFocus User Manual - Current (v2020)574

© 2020 Clearview Software, Inc.

o Copy Report Definition to Clipboard: This copies the report JSON and XML to the clipboard

o Copy Report RDL to Clipboard: This copies the report XML to the clipboard

4.11.26.10Finish

Overview

Finish Your Report. Name the report and install it to InFocus. Reports are imported to Custom Reports via an

InFocus Exchange Import Code. Import Codes are unique to the report being created. When Saving and

Installing a report to InFocus, please ensure InFocus is open and that the Custom Reports applet is

launched.

Field Descriptions

Report Name: Name of the Report to be displayed in the Custom Reports list

Save and Install in InFocus: Launches the InFocus Exchange Import dialogue and generates a unique

code for the report or iteration thereof

Generate a Separate Install Code: Note: This will not be used by the general user. This option should

only be used when sharing a created report outside of the user's deployment of InFocus. If using, this

option generates a separate install code which can be used to allow others to have their own copy of the

report. When clicked, the install code will be displayed below. This code can be copied to the clipboard

and shared.

o Make Installation Code Single Use: When checked, the install code will only be able to be used once,

by one party.

o Install Code Copy Button: Copies the install code to your clipboard

Show InFocus Exchange Install Code: When clicked, this link shows or hides the InFocus Exchange

Install Code, Install Code Copy Button and "Make Installation Code Single Use" checkbox

New Report: Creates a new report

Feedback: Launches a dialogue through which you can provide feedback to Clearview regarding

ReportBuilder

4.11.26.11Save & Install

Overview

ReportBuilder reports are imported into InFocus via the InFocus Exchange Item Import dialogue. This allows

the user to conduct one-click imports to InFocus. The dialogue displays the Import Code and Name/Type of

report. To complete the import, simply click Start Import. The report scripts will be downloaded to InFocus
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where the report can then be configured with Module/Applet availability and User/Group permissions.

4.11.27 Report Management

Overview 

All reports not covered under one of the three specific report designers are called standard reports. Examples

of standard reports are A/R, A/P, The Journal reports, General Ledger reports, Utilization reports, Checks,

etc.

Key Concepts

You can find a description of system Report Management Reports in the InFocus System Reports

chapter of this manual. More on InFocus Report Management Reports

The Original report cannot be modified,however, if you would like to customize the report, you can do so

by copying the system version of the report make changes through the Microsoft Business Intelligence

Development Studio.  A link to the tool is located on the support site here.

To export the raw data of the report to Excel without including headers, footers, and grouping areas (i.e., a

two-dimensional listing), click on the View Data button. The report data will appear in a grid that can then

be exported.

Here is a video that takes a deeper look into running InFocus reports: More on Running InFocus Reports.

Note - Knowledge of using the Microsoft BIDS tool is required.  All customizations NOT completed by a

Clearview technician are NOT supported by Clearview Support.

Customizing a Report Management Report

To create a custom standard report, first select the report in the Report Management applet using the

drop-down list on the upper left part of the form. Each report has at least one report design flagged as

System. These designs, or a previously made custom design, can be copied. 

The Copy function is located in the toolbar menu, click Copy. 

When clicked, it will prompt for a report name that must be unique.  Add the name and click OK.

After copying a report, it can be downloaded (Download button located on the toolbar) to a local disk

folder and modified using Microsoft Report Designer. 

https://support.clearviewsoftware.net/articles/5349
https://support.clearviewsoftware.net/articles/5379
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When done, use the Upload function in the Report Management applet to save your design. More on

Uploading a report

4.11.29 SQL Query

Overview

 Advanced Users Only 

SQL Query applet allows you to write, review and run SQL Queries against InFocus (default), or other 
external data source.

In summary, queries are written in the editor using additional tools available from the menu and toolbar.
Results are reviewed below the query editor.

SQL Queries can be written ad hoc or for use in other applets such as Dashboard Queries Manager, Custom
Reports, etc.

Query Builder makes building SQL Queries accessible to users who are unfamiliar with writing queries in SQL
syntax.

Data & View Rights

SQL Query applet does not inherit view rights to sensitive information (e.g. Can view Pay Rate set in
HR>Employees>Account & Rates tab), nor does it inherit Project viewing rights (e.g. Project filtering based
on Employee Job Types or Project Roles). Results displayed reflect the raw output of the query.

Please note: SQL Queries can directly affect the InFocus database. Use caution.

Tutorial

Below is a brief tutorial for working with SQL Query applet.

1. Browse to UT>SQL Query
2. Select a data source (defaults to- and is typically- InFocus)
3. Using the editor, write the query

o Optionally load the query from a .SQL File by clicking Open File from the toolbar.
4. Once the query is complete, click Run Query. Please note: SQL Queries directly affect the InFocus

database. Use caution.
5. Review the Results

Once satisfied with the Results, they can by exported to excel, word, .pdf, etc. The query itself can be copied
for use in other InFocus applets such as:

Dashboard Queries Manager - Used for building Classic Dashboard widgets and Analytic Models

Custom Reports - Used for building customized reports

Field Descriptions

https://support.clearviewsoftware.net/articles/5385
https://support.clearviewsoftware.net/articles/5385
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Menu

In addition to standard toolbar options, SQL Query makes the following available:

File

Open File - Launches browse dialogue for opening a file in the SQL Query editor

Open Stored Procedure - Launches a dialogue where a stored procedure can be loaded by name

Open New SQL Query Instance - Opens a new instance of the SQL Query applet. This can be helpful, for
instance, when working with queries against different data sources.

Tools 

Generate Create Table Statement - Generates a create (#temptable) statement from the last run query

Generate Insert Table Statement - Generates an insert (#temptable) statement from the last run query

Doc / Undock Window - Docs or Undocks the SQL Query applet from the primary InFocus window

More on SQL Query Developer Tools

Toolbar Buttons

Open File - Launches browse dialogue for opening a file in the SQL Query editor

Run Query - Executes the query entered in the editor

Clear Query - Clears the query entered in the editor

Editor and Results

Query Datasource - Sets the data source the query is to be run against. Defaults to InFocus but can
include external data sources defined in Global Settings.
Process Query as Action Result

Replace Variables before Execution - Check to indicate that the script uses InFocus Variables which
should be inserted at run-time.
Editor - Used for entering and editing SQL queries

Results tab - Displays the results of the query

Dataset Info tab - Generates an alphabetical fields list based on the result columns. More on the Dataset
Info tab.
o Common Statements - Used to generate template SQL commands against a temp table (e.g.

#TableName) for the columns included in the results set
o Copy to Clipboard - Copies the text of the generated common statement to the clipboard

Export Results - Click to export the results of the query to, for instance, excel (e.g. .xlsx, etc.)

4.11.29.1SQL Query Developer Tools

Overview

 Advanced Users Only 

SQL Query applet makes several developer tools available.



InFocus User Manual - Current (v2020)578

© 2020 Clearview Software, Inc.

Developer Tools

Dataset Info Tab

Located below the editor, the Dataset Info tab generates an alphabetical fields list based on the result
columns. In that results are not listed alphabetically, this can be very useful in locating fields in a large result
set.

Double-clicking the field in the fields list will jump to that field in the Results tab.

Additionally, the Common Statements drop-down can be used to generate template SQL commands
against a temp table (e.g. #TableName) for the columns included in the results set. Click Copy to Clipboard
to copy the contents of the generated common statement.

Tools Menu Options

Generate Create Table Statement

Available from the Tools Menu, this options generates a create (#temptable) statement from the last run
query. 

For example, if select * from firms was run, this option could be used to generate the following statement
(or similar)

CREATE TABLE #temptable
(
firmcode nvarchar(max)
)
CREATE TABLE #temptable
(
FirmID int,
FirmName nvarchar(max),
FirmCode nvarchar(max),
ParentFirmID int,
MainAddressID int,
ModifyDate datetime,
ModifyBy nvarchar(max),
CreateBy nvarchar(max),
CreateDate datetime,
WebSite nvarchar(max),
FirmNote nvarchar(max),
ARNote nvarchar(max)
)

Generate Insert Table Statement

Available from the Tools Menu, this options generates an insert (#temptable) statement from the last run
query. 

For example, if select * from firms was run, this option could be used to generate the following statement
(or similar)

INSERT INTO #temptable (
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FirmID,FirmName,FirmCode,ParentFirmID,MainAddressID,ModifyDate,ModifyBy,CreateBy,CreateDate,Web
Site,FirmNote,ARNote
)
select
@FirmID,
@FirmName,
@FirmCode,
@ParentFirmID,
@MainAddressID,
@ModifyDate,
@ModifyBy,
@CreateBy,
@CreateDate,
@WebSite,
@FirmNote,
@ARNote

Dock / Undock Window

Available from the Tools Menu, this option undocks the SQL Query applet from the primary InFocus window.
This allows the user to continue running InFocus procedures while working with SQL Query in a dedicated
window.

4.11.30 SQL Watcher

Overview 

SQL Watcher; used to monitor SQL transactions within the program.

4.11.31 Updates

Overview
The Update applet allows Clearview Software to release minor updates directly to InFocus without the need
for a formal release. Click Check for Updates on Login in Global Settings to allow InFocus to check for any
available updates. If updates are available, users who have been given access to the Updates applet will be
notified. It is also possible to go directly to the Updates applet in the Utilities module to check for updates or
rerun particular updates.

To apply these updates, click Apply Selected Updates (located at the bottom of the window).

4.11.32 Query Builder (Beta)

Beta

Please note, this applet is currently in Beta please use with the understanding that results should be closely
reviewed.
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Overview

Advanced applets in InFocus leverage the power and flexibility of SQL queries, where the user can directly
query their InFocus Data.

Query Builder visualizes query writing and dynamically builds InFocus-optimized queries for use in applets
like Dashboard Queries Manager, Custom Reports, etc.

Please note: SQL Queries directly affect the InFocus database. Use caution.

Key Concepts

Datasets

Queries written with Query Builder begin with a Dataset. As such, each query can only reference one
dataset.

Fields to be used in the query are selected from the Available Fields list based on the Dataset and can then
be leveraged as Selected field, Calculated Columns, and Filters.

SQL Statements

Simplified SQL statements are build on the following commands: SELECT, FROM and WHERE. Query
Builder compiles these as follows:

SELECT - Built from Selected Fields and Calculated Columns based on the dataset

FROM - Dynamically built from the selected Dataset

WHERE - Built from defined Filters

Additional keywords such as GROUP BY and ORDER BY are dynamically built from the dataset.

Generated SQL can be further customized as necessary in the editor.

Field Descriptions

Datasets/Fields

Datasets - Lists available data sets. Each data set contains a list of available fields that can be selected
for use in the query
Available Fields - Displays a list of fields per dataset. Fields can be filtered by typing in the search box
and selected for use in the query by checking the box next to each field. Field descriptions are displayed
at the bottom of the pane when clicking the field.
Clear Selected - Clears all sections made in the Datasets field list.

Toolbar

Build Query - Generates the query based on Dataset selections, calculated Columns and Filters. Clicking
this will overwrite previous builds.
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Build & Execute Query - Generates the query as described above and then runs the SQL Query as
displayed in the editor. Note, SQL Queries directly affect the InFocus database. Use caution.
Execute Query - Executes the query only. Note, SQL Queries directly affect the InFocus database. Use
caution.
Copy - Copies the text of the generated query

Clear - Clears the generated query

Export Query - Exports the text of the query to a .sql file.

Query Options

Selected Fields - Displays a running list of selected fields from the dataset

Calculated Columns - Adds calculated columns using selected fields from the dataset. Calculated
columns use standard SQL formatting.
Filters - Adds filters to the query using selected fields from the dataset

Results - Displays the results of an executed query

4.11.32.1Building a SQL Query

Tutorial

Below is a brief tutorial for building a query with Query Builder.

1. Browse to UT>Query Builder
2. Select a Dataset
3. Select fields for use in the query form the Available Fields list

a. Add Calculated Columns and/or Filters as appropriate
4. Click Build Query
5. Click Execute Query
6. Review the Results from the Results tab

Once satisfied with the Results, the query can be Copied or Exported (to a .sql file) for use in other InFocus
applets such as:

Dashboard Queries Manager - Used for building Classic Dashboard widgets and Analytic Models

Custom Reports - Used for building customized reports

SQL Query - Used to write and run queries against a data source (typically InFocus).

4.11.32.2Building an Analytic Model (Query Builder)

Overview

Analytic Models (or queries) are used to feed dashboards designed with the Analytic Dashboard Designer.
Generally, models are written for performing business analysis and should be written with the end user in
mind (e.g. using decipherable return names, etc.). In addition to the query, you can leverage Parameters,
Field/List Descriptions and Permissions.

Query Builder makes building Analytic Models accessible to users who are unfamiliar with writing SQL.

Tutorial
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1. Browse to UT>Query Builder
2. Select a Dataset
3. Select fields for use in the query form the Available Fields list

a. Add Calculated Columns and/or Filters as appropriate
4. Click Build Query
5. Click Execute Query
6. Review the Results from the Results tab
7. Once satisfied with the results, click Copy
8. Browse to UT>Dashboard Queries Manager
9. Select Analytic Model from the query type drop-down
10. Click + New Analytic Model from the toolbar
11. Paste in the copied query
12. Configure settings (see descriptions)
13. Assign Permissions
14. Click Save

Your Analytic Model will now be available for use in the Analytic Dashboard Designer.

4.12 Administration

4.12.1 API Management

4.12.1.1 Overview

API Management Applet is an administrative applet used by developers to create and/or manage consumable
API's for InFocus.

In addition to management, the API Management applet provides a framework for creating API's to support
the specific needs of your firm. With auto-generated documentation, developers can leverage the applet to
create secure and robust integrations.

What is an API?

By definition, an API is an Application Programming Interface where the application receives requests and
sends responses.

An API uses a set of protocols to deliver these requests and responses between an outside party and the
application server.

For InFocus this means you can create an interface between your system and other third parties. So,
for instance, you could create an API to integrate InFocus and an application like HubSpot.

How does an API Work?

Imagine, for a moment, you visit your favorite restaurant. You sit down and order from the menu. Your waiter
delivers your order to the kitchen which responds in kind with the requested dish.

In this example, your waiter is like an API. They provide a way for you (the customer) to communicate with
the kitchen, whom you would otherwise not have access to. 

Based on the request, delivered by your waiter, the kitchen serves back a response- in this case, your
Chicken Parmesan!

Similarly, the InFocus API delivers requests and responses between a third party and the InFocus server.
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Next Steps

In the topics that follow, we'll discuss how to get started with the InFocus API and the API Management
Applet.

4.12.1.2 Getting Started with the InFocus API

4.12.1.2.1  Database Requirements

InFocus' API leverages SQL JSON Functions with the following server prerequisites.

SQL Server 2016

Database Compatibility Level = 130

If you're on InFocus Cloud, you're all set. However, if you self-host InFocus, work with your IT to ensure
these requirements are met.

4.12.1.2.2  Setup and Permissions

Overview

To begin working with API Management, you'll assign permissions to the appropriate groups and/or users.

Permissions are available for the following applets, defined in the tutorial below:

API Management

Tutorial

Please complete the steps below to grant access permissions as appropriate.

1. Browse to Administration>Permissions
2. Select the Groups and/or Users you wish to grant permissions to
3. On the row next to the Group/User, click the lockbox. A dialogue will display.
4. From the Groups and/or Users Permissions tab, grant permissions as appropriate. Below is a list of

permissions and what they grant access to.
5. Once the permissions have been selected, click Save.

Module Applet Special Rights Description

Administration API Management n/a API Management is an
administrative applet used
to create and manage API
Endpoints and their
defined Methods

4.12.1.2.3  API Framework Reference

Overview

https://docs.microsoft.com/en-us/sql/t-sql/functions/json-query-transact-sql?view=sql-server-2016
https://support.clearviewsoftware.net/articles/5427
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While the InFocus API supports native endpoints (e.g. written by Clearview) it also provides a framework for
**building custom API's**. 

Using the API Management applet, developers can create custom endpoints to meet the specific
requirements of their firm's integrations.

The InFocus API is a REST API that uses standard HTTP to process requests. When creating a custom API,
you'll need to consider the following.

Resources

Resources are used to group endpoints together. For example, an Employees resource might be created to
organize all endpoints that handle requests for employee data.

Employees (Resource)
o /employees (Endpoint)
o /employees/{employee_code} (Endpoint)

API Documentation, which is self-generated by the API Management applet, is organized by Resource group.
As required, Resources and their endpoints can be hidden from documentation.

Endpoints

An Endpoint is a unique URL through which a request can be made for an object or set of objects.

Each Endpoint can be configured with a Secure and Public route, allowed request methods and full object
control.

For example /employees could be an endpoint that supports GET methods and returns an object that
includes Employee Code and Employee Name for all active employees (e.g. https://
cascowilson.infocusapp.com/employees)

Alternatively, /employees/{employee_code} could be an endpoint that supports GET, PUT and DELETE
methods for returning, updating or deleting an employee specified in the request (e.g. https://
cascowilson.infocusapp.com/employees/LJC01).

Endpoint requests and responses are sent in a JSON object (e.g. {"employee_code"="LJC01"}).

Routes

Routes define the URL used for submitting requests  to an Endpoint. Each Endpoint can support Secure and
Public (optional) routes.

Secure Route - Requests made on this URL require an API Key

Public Route - Requests made on this URL are public
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Request Methods (HTTP)

The InFocus API is a REST API that supports the following standard HTTP Request Methods:

GET - Retrieves data as specified by the request

POST - Creates data as specified by the request

PUT - Updates data as specified by the request

DELETE - Deletes data as specified by the request

Responses

Successful requests will return a JSON object. 

For instance, using the /employees example above, a GET request would return:

{
"employee_code": "LJC01",
"employee_name": "Lewis James Casco"

},
{

"employee_code": "EPF01",
"employee_name": "Erwin P. Fletcher"

}

Sample responses can be viewed when testing via the API Management application or in the self-generated
API documentation.

HTTP Status Codes

When making requests of the InFocus API, the following is an index of status codes returned.

200's Success - Indicates a successful request
o 200 OK

400's Client Error - Indicates an error in the request from the client making the request
o 400 Bad Request
o 403 Forbidden
o 409 Conflict
o 401 Unauthorized
o 404 Not Found

500's Server Error - Indicates an error from the server
o 500 Internal Sever Error
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Documentation

An API Reference is generated when installing or creating API's through the API Management applet.

The InFocus API is self-documenting in that it generates firm specific end-user documentation for each
Endpoint organized by Resource group unless explicitly hidden.

Your unique API Reference is published to the route path of your InFocus API (e.g. https://company_name/
infocusapp.com/api) and includes the following sections.

Introduction

Authentication

Errors

Resource/Endpoints - Each Resource and it's available Endpoints are described in detail with examples.

4.12.1.2.4  API Authentication and Security

Overview

In the context of REST, authentication is the means by which a requester is identified and given access.

The InFocus API uses Basic Authentication, where an API Key is passed in the Authorization Request
Header.

Authorization: Basic {authkey:}

API Keys

API Keys can be managed within InFocus using the API Management applet. Each key (32bit unique key)
created can be assigned access independently to the various resources of the API. 

As API Keys grant access to the various resources and endpoints, you should never share your secret API
Keys in publicly accessible areas.

Secure vs Public Routes

When working with API's in the API Management applet, each endpoint can be assigned a Secure and,
optionally, Public Route.

Secure Routes are secure in that they are governed by an API Key, as discussed above.

Public Routes are publicly accessible. As such, great caution should be used when enabling public routes.

All API requests should be made over HTTPS.

4.12.1.2.5  API Conventions

Overview

Under the principles of REST, here are some general conventions used by the InFocus API.
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Endpoint Best Practices

Naming Conventions

Endpoints are nouns (e.g. Employee, Project, etc.) and should be listed in order of plural to singular based on
specificity.

/employees

/employees/{employee_code}

Respones

Similarly, the data returned in an endpoint response should follow respectively from generic to detailed.

For example, a GET request to /employees would have a more generic response than the same request to /
employees/{employee_code}

GET /employees - Generic information for many records. (e.g. many rows, fewer columns).

GET /employees/{employee_code} - Detailed information for one record (e.g. single row, many columns).

HTTP Methods

HTTP Methods are verbs and should follow these general conventions when making endpoint requests.

GET - Retrieves records. Requests can be made to both plural and singular endpoints. As discussed
above, responses should be generic or detailed respectively.
POST - Creates records. Requests are made to plural endpoints only and must define the criteria for
INSERT in the body of the request.
PUT - Updates records. Requests are made to singular endpoints and must define the criteria for
UPDATE in the body of the request. While it is possible to make a PUT request to a plural endpoint, this
should be done with great caution.
DELETE - Deletes records. Requests are made to singular endpoints and must define the criteria for the
DELETE in the body of the request. While it is possible to make a DELETE request to a plural endpoint,
this should be done with great caution.

4.12.1.3 API Management Applet

Overview

API Management is an administrative applet used to create and manage API Endpoints and their defined
Request Methods.

For developers, API Management is a framework for creating API's to support the needs of your firm. With
auto-generated documentation, developers can leverage this applet to create secure integrations.

Non-developers who wish to leverage InFocus' API can request custom solutions via Clearview Support.

Field Descriptions

https://support.clearviewsoftware.net
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Toolbar

New Endpoint - Creates an API endpoint

Save - Saves the currently loaded record

Manage Resources - Launches the Resources dialogue where the following can be managed:
o Name - Name of the resource (e.g. Employees, Projects, etc.)
o Hide Documentation - Hides generated documentation for the selected endpoint

Manage Keys - Used to create and manage API Keys. Launches the API Keys dialogue.
o Active - Key is Active when checked
o Key - API Key. Click the refresh icon to generate.
o Issue Date - Date created
o Expire Date - Date to expire
o Description - Key description

Resources

The Resources pane allows you to select a resource and displays a list of endpoints that can be loaded and
managed.

Dropdown - Lists all available resources for management

Refresh (button) - Refreshes the list

Endpoint Settings

Endpoint Settings are used to configure how requests can be made to a given endpoint.

Active - Endpoint is active when checked

Hide Endpoint Documentation - Hides generated documentation for the selected endpoint

Endpoint Group - Resource group or category to which the endpoint belongs

Name - Endpoint name (e.g. Employees)

Secure Route - URL for requests governed by API Key permissions

Public Route - URL for public requests

Generate Private Link - Click to generate a Public Route

Allowed HTTP Methods - Defines the allowable request methods (e.g. GET, POST, PUT, DELETE).
Check to allow.
Description - Endpoint description and internal notes.

Methods/Query

Methods and Query tab is used to define each available request method and it's attributes.

Header

Method - List available request methods. Click to configure.

Query Arguments - Defines a list of available arguments to be passed into the call.
o Name - Argument name
o Parent - Used to group arguments
o Data Type - SQL Data type
o Default Value - Default value to use if NULL or blank is returned
o Sample Value - Sample Value for documentation
o Query Parameter - Enable as a parameter available to the query



InFocus Modules and Applets 589

© 2020 Clearview Software, Inc.

o Required - Required for resource requests using the selected method
o Description - Argument description for documentation

Query Tab

Defines the script that executes when requesting the selected request method.

Stored Procedure - Query is a stored procedure (e.g. z_my_storedproc).

Hide Query Documentation - Hides generated documentation for the selected query

Name - Name of the query

Query (text box) - Enter your query here

Data Source - Data Source for the query

Generate Query Parameters - Click to generate Query Arguments (Query Parameter = Checked) for
parameters found in the query.

Documentation Tab

The Documentation tab is used to generate and review documentation for the loaded Method (e.g. GET,
POST, etc.).

Documentation can be used by developers authorized to leverage the API.

Description - Query description for documentation. Markdown Formatting is supported.

JSON Request - Sample request for POST, PUT and DELETE methods.

Response - Sample response produced by the query

Permissions Tab

Permissions tab is used to manage API Keys available to the loaded Method.

Enable - Key is enabled when checked

Key - API Key

Description - Key description

Set Test Key (wizard) - Generates a temporary key for use in testing. Pre-fills the Auth. Key on the
Testing tab.

Testing Tab

Testing tab is used to validate API setup and view the results of your method.

Warning Queries executed will be processed on the database specified in the Route Base. Use caution for
POST, PUT and DELETE methods.

Route Base - Base URL to call for testing purposes. Database is specified here and can be set to run on
a [Sandbox](https://support.clearviewsoftware.net/articles/6118). (e.g. http://mycompany.infocusapp.com/
api/database_name)
Parameters - Query parameters defined above under Query Arguments. Parameter default can be
overridden for testing.
Secure Route - Pre-fills the Endpoint's Secure Route when checked

Public Route - Pre-fills the Endpoint's Public Route when checked

Auth. Key - API Key to use for test. Generated with the Set Test Key wizard on the Permissions tab. 

URL - Fully defined URL to call for testing. Route Base + Secure or Public Route

Request tab - Request attributes. Used for POST, PUT and DELETE methods.
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o Querystring - Query parameters to append to the request URL (e.g. ?emp_code=cw01)
o JSON Body - JSON formatted body of the request

Response tab - Displays the formatted JSON Response

Exec Querystring (button) - Executes the request Querystring

Exec Body (button) - Executes the body of the request

Executes Request (button) - Executes the loaded method using the settings defined here on the Testing
tab. Once executed, InFocus will display the HTTP response code and the API response in the tab above.
Copy Output - Copies the JSON object from the Response tab to the clipboard

4.12.2 Database Backups

Overview

Database Backups can be used to take on-demand backups of your self-hosted InFocus database from the
InFocus user interface. While convenient for one-time backups, this feature should not replace a company
controlled backup plan. 

Read more in this Help Center article and/or browse to the 2:52 mark in the video below.

4.12.3 Event Manager

Overview

Event Manager is an administrative applet used to track and optionally process WebHooks against InFocus
events.

InFocus events include items related to user actions (e.g. record created, saved, deleted, etc.) and/or
processes (e.g. login, recalculated, etc.).

Available events are listed, categorized by module, in the Event Manager applet.

Tracking Events

Each event listed can be selected for tracking. When tracking an event, InFocus will post the Event,
associated User, KeyID and Date to the Logs tab in the Event Manager applet.

Processing Webhooks

Additionally, listed events can call a Webhook for processing. Similar to event tracking, InFocus will post the 
Event, associated User, KeyID and Date to a specified WebHook URL (or multiple URL's).

Using Webhooks, you can notify third-party applications that an event has occurred and supply that
application with the associated event data.

Event data is passed to the Webhook URL in the body of the HTTP POST request. This content can be
overridden as required using the Content Override column in the Settings/Webhooks display grid.

InFocus supports an infinite number of Webhook URL's per event and will post to each URL in the order it is

http://support.clearviewsoftware.net/articles/share/72f551ee
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listed on the Settings/WebHooks tab.

Additionally, InFocus Jobs (AD>InFocus Jobs) can be triggered by events listed in Events Manager via
Webhook.

All Webhooks should be processed using HTTPS.

Setup

To begin working with Event Manager, you'll assign permissions to the appropriate groups and/or users.
Please complete the steps below to grant access permissions as appropriate.

1. Browse to Administration>Permissions
2. Select the Groups and/or Users you wish to grant permissions to
3. On the row next to the Group/User, click the lockbox. A dialogue will display.
4. From the Groups and/or Users Permissions tab, grant permissions as appropriate. Below is a list of

permissions and what they grant access to.
5. Once the permissions have been selected, click Save.

Module Applet Special Rights Description

Administration Event Manager n/a Event Manager is an
administrative applet used
to track and optionally
process WebHooks
against InFocus events

Field Descriptions

Toolbar

Save (button) - Saves the loaded record

Events Drop-down/Grid

Event Manager Drop-down - Lists available modules. Select to view and work with related events.

Refresh (button) - Click to refresh the events grid

Events Grid - InFocus events available for tracking and/or processing
o Tracking Events - When checked, InFocus will post the Event, associated User, KeyID and Date to

the Logs tab in the Event Manager applet.
o Processing Hooks - When checked, InFocus will post the Event, associated User, KeyID and Date to

a specified WebHook URL (or multiple URL's).

Settings/WebHooks tab

The Settings/WebHooks tab is used to manage settings and WebHook URL's for the selected event.

Track Event - Indicates if the selected event is being tracked

Process WebHooks - Indicates if the selected event is being processed by WebHooks
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WebHooks Grid
o Order - Defines the posting order for WebHook processing. So, Order # 1 is posted to first.
o WebHook URL - URL to which the event data is posted
o Content Override - The body of the HTTP POST can be overridden with content entered here.

Logs tab

The Logs tab reflects the events being tracked. Additionally, if an event is being processed by a WebHook,
the event will be marked as processed or not.

Processed - When checked, the posted event has been processed by an application listening on a
WebHook URL.
Username - User associated with the event

Key ID - Record ID associated with the event (e.g. Timesheet ID)

Date - Data/Time of the event

Clear History (link) - Clears the log history

4.12.4 Global Settings

Overview 

Global Settings contains all system-wide settings for InFocus. 

Key Concepts

Settings are configuration switches for the application and are typically set during the initial installation of
the application. 

Global Settings can also be set as needed modules are brought into use. Many of the settings can be set
up immediately upon installation; however, some settings must be configured after their corresponding
module has been initialized, in particular, those settings that act as default values. The following sections
of the manual take you through the different tabs within that section.

4.12.4.1 General Tab

Overview 

General Tab contains miscellaneous settings that do not fall under any major category.

Field Descriptions 

Company Name & Login Type

Company Name - The name of the company using InFocus.  This will show up on My system reports and

invoice designs.

Login Mode - InFocus supports 3 login modes. More on InFocus Login Modes

https://support.clearviewsoftware.net/articles/4073
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o InFocus Only – this is the default. Requires the user to login with just the InFocus user name and
password.

o Windows Only – this requires the Domain\Username be added to the user record. If present, when the
login screen comes up, it will look up the InFocus user based on the Windows user when logging in.

o Both – If both, you will be able to log in with either login button.

Delimeters

Description - A single character that separates the node codes with a path. Delimiters used in InFocus are

period, hyphen, and colon.

Organization Break Down Structure (OBS) - Character that delimits, or separates, the levels or the

organizational breakdown structure. The character chosen as the delimiter cannot be used in any OBS

Codes. For eexample - In a two-level OBS, where departments exist within offices, there may be an OBS

code of NY-AR (where NY is the code for the New York Office and AR is the code for the architectural

department, and the hyphen is the delimiter). This is called an OBS Path.

Organization Name - Character that delimits the concatenated OBS name (also known as the long name).

The delimiter can appear in the long name. For example. In a two-level OBS, where departments exist

within offices, there may be an OBS long name of New York-Architectural (where New York is the name of

the office, architectural is the name of the department, and a hyphen is the delimiter).

G/L Account Delimiter - The character that separates a G/L Base account from an OBS structure. This

character is not allowed in the base account code. A G/L base account and an optional OBS path form

the G/L Account. For example. A typical office A/R account may be 1200-NY (where 1200 is the base

account for Accounts Receivable, NY is the OBS path, and a hyphen is the delimiter). G/L accounts are

always listed with the base account first, followed by an optional OBS path.

Full Audits

Description - Full audits store a Version of journals and time sheets when enabled.  If unchecked, no audit

trail of transaction changes will be stored.  It is recommended that this be enabled.

Timesheets - When checked, full audits are used in time sheet adjustments. In full audit mode, any

change to critical information (project, work date, hours, or pay amount) will result in a background

system-generated reversing entry. When not checked, the reversing entry will be made only if the line

item in question has already been processed by Labor Distribution in addition to a change in critical

information.

Journals - When checked, full audits are used in all Accounting journals. In full audit mode, any change to

critical information (project, G/L Account, or amount) will result in a background system-generated

reversing entry. When not checked, the reversing entry will occur only if a change in account period has

occurred in addition to a change in critical information.
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Calculate Labor Cost Using

Pay Rate - When selected, the Pay Rate will be used when calculating cost in many different areas

throughout the system. Some examples are Project Figures Report, PM Reports and Project Central.

Job Cost - When selected, the Job Cost Rate will be used when calculating cost in many different areas

throughout the system. Some examples are Project Figures Report, PM Reports and Project Central.

Fiscal Calendars

Seed Start Date - Starting date of earliest fiscal year in system for which to maintain transactions. More

on Accounting Periods

Seed Start Year - Year of earliest fiscal year in system to maintain transactions for.

13th Period in Quarter - In the event that a 13-period fiscal year is used, this is the quarter in which the

13th period should appear. This affects only financial statements.

Fiscal Year Type - Type of Fiscal Year. There are various 12- and 13-period options allowed. See the

Accounting Periods section in this manual for further instructions.

Look up Settings

Max. Recent Results - This setting allows you to limit the number of returned results in the system look

ups.

G/L Accounts

Retained Earnings G/L Account - Account to be used for end-of-year automated posting. More on G/L

Accounts

Error G/L Account - Account to be used when an automated process cannot derive a G/L account. A

derived account is one where the process asks for a base account and uses relevant employee or project

OBS paths to derive a true G/L account. Some processes that include this method are revenue

recognition, labor distribution and automated invoicing.

Misc.

Enable Margin Skew - Certain print drivers render the margins on printed reports incorrectly. When

experiences these issues with margins, enable the Margin Skew to fix this.

Auto-Fill Look ups - Automatically populate look up forms with default list. When not checked, user

optionally enters search criteria first and then clicks on the SEARCH button.

Check for Updates on Login - When checked, InFocus will automatically check for updates as a user logs

in. If there are available updates, the user will be notified.
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Use Batch Entries In Journals - When checked, batch entry options are available in journal entry.

Use Deposit Dates for Reports - When checked, InFocus will use the deposit date instead of the check

date when running many system reports.

Disable Project Auto-Complete - When selected, the Auto-fill option in the Project Path entry cells will be

turned off in the journals and time sheets.

Mark New Entries As posted - New Entries can be flagged automatically as posted. When checked, the

post option is not available in journals.

Allow Disbursements to Payees not on File. - Disbursements can be made to employees, vendors and

clients. When this option is checked, disbursements can also be made to user entered payees.

Password Settings

Min password Length - Minimum number of characters required for a valid login password.

Password Expire Days - If a number is entered here, all passwords will expire if the specified number of

days have passed since the last time the password was changed by the user.

Require Number - Requires a number be in a password when it is created.

Require Special Character - Requires a special character (i.e. @,*,^ etc.) be in a password when it is

created.

Require Lower Case Letter - Requires a lower case letter be in a password when it is created.

Require Upper Case Letter - Requires an upper case letter be in a password when it is created.

Organizational Units

Uses Organizational Units - When checked, Org units can be used and all related fields will display

throughout the system. More on Org. Units

User Session Tracking

Enable Sessions - When checked, The User Sessions applet will be enabled. This tracks the user

sessions to see who is logged in.  More on User Sessions

Enable Session Detail - When checked, The detail portion of the User Sessions applet will be enabled. 

This tracks the number of times an applet opens and closes. 

Cycle - This is the session check-in frequency in seconds.  The default is 60seconds.

4.12.4.2 A/R Tab

Overview 

The A/R Tab. Settings on this tab relate mostly to the Accounts Receivable processes.
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Field Descriptions 

Overpayments

Type - Determines how over-payments are aged on Receivable reporting. Options are "Keep in Current",

"Last Check Date" and "Invoice Date".

Label - Label to print in Accounts Receivable reporting for over-payments.

Aging Periods

Number of Periods - Number of aging periods to appear on Accounts Receivable reporting. Up to five

periods can be specified. The system automatically adds a final period that is all transactions older than

the final period specified.

1st Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum is

automatically zero.

2nd Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum

is one day past 1st Period.

3rd Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum is

one day past 2nd Period.

4th Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum is

one day past 3rd Period.

5th Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum is

one day past 4th Period.

Receipt Wizard Breakdowns

Breakdown Receipts to WBS  - Controls whether or not the receipt wizard will break down receipts to

levels below the project (top node) level.

Breakdown Receipts to Revenue Type  - Controls whether or not the receipt wizard will break down
receipts to the revenue type.  Revenue Types include the following:
o F - Fixed Fee
o L - Labor
o O - Other Direct Charges
o C - Out of Contract Consultants
o I - In Contract Consultants
o R - Retainer
o G - Retainage
o B - Bad Debt

Default Bill Review Report

PM Bill Review -  Selects the default Bill Review Report that is accessed by clicking "Bill Review Report"

on the toolbar in PA Bill Review.
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PA Bill Review -  Selects the default Bill Review Report that is accessed by clicking "Bill Review Report"

on the toolbar in PM Bill Review.

Percent Complete Calculation Default Formula

Drop-down Box - Gives you a list of Percent Complete Formulas that have been created using the

"Manage Formulas" link.

Manage Formula - When clicked, you will get the "Percent Complete Formulas" pop-up. The Percent

Complete Calculation Formula box allows you to define formulas that can be used to calculate Percent

Complete numbers in PA Bill review.  The available columns are listed in the "Available Fields" column.  A

sample formula is provided in the pop-up , but note that column names need to be enclosed with [ ]. An

example of a formula for calculating the percent complete based on labor effort is:  [LaborEffort]/

[LaborFixedFee] 

PA/PM Bill Review Settings

Never Bill - When selected, Never Bill (N) charges will appear in PA/PM billing review.  They will also

show up in the system Bill Review reports.

Write Off - When selected, Write Off (W) charges will appear in PA/PM billing review.  They will also show

up in the system Bill Review reports.

ICC WIP - When selected, ICC WIP charges will appear in PA/PM billing review.  They will also show up

in the system Bill Review reports.

4.12.4.3 A/P Tab

Overview 

The A/P Tab. Settings on this tab relate mostly to the Accounts Payable processes.

Field Descriptions 

Aging Periods

Number of Periods - Number of aging periods to appear on payables reporting. Up to five periods can be

specified. The system automatically adds a final period that is all transactions older than the final period

specified. 

1st Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum is

automatically zero.

2nd Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum

is one day past 1st Period.
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3rd Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum is

one day past 2nd Period.

4th Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum is

one day past 3rd Period.

5th Period - Maximum number of days old for an invoice to fall into this period.  The calculated minimum is

one day past 4th Period.

Default Credit Card Clearing Account

Default Credit Card Clearing Account - The default account used when running credit card clearing utility.

Default AP Account

Default AP Account - Default AP account when none is specified.

Credit Cards and Cash Basis

Summarize Disbursements to Invoice Level for Cash Basis Conversion - When checked, the

Disbursement numbers will be summarized to the same level as the Invoice when the Cash Basis

Conversion tool is run. More on Cash Basis Conversions

Separate Credit Card Charges on Expense Sheet Import - When checked, credit card charges will appear

as separate line items on the ER Journal entry made after the Expense Sheet Import is used in the

Employee Reimbursables Journal. More on the ER Journal Toolbar options

  

4.12.4.4 Invoicing Tab

Overview 

The settings on this tab relate to the automated invoicing process. 

Field Descriptions 

Current Invoicing G/L Period

Drop down Box - Default G/L period used by automated invoicing.

Invoicing Design Options

Expose Client UDFs in Invoice Design -   When checked, client user-definable fields can be used in
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Invoice Design. More on User Defined Fields

Expose Project UDFs in Invoice Design -   When checked, project user-definable fields can be used in

Invoice Design.

Invoice Numbering

Incrementing Method - Determines how invoice numbers are incremented in the system. The choices are

by Company, A/R account, Client and Project.

Next Invoice Group Number - The next invoice number is used only when the incrementing method is set

to PROJECT, and then only when an invoice group is used. Invoice groups allow multiple projects to be

combined under one invoice.

Invoice Email

SMTP Relay Account - The SMTP Account that will be used to send emails using Automated Invoicing.  

More on SMTP Setup

Subject - The subject of the email that will be sent using Automated Invoicing. More on Emailing from

Automated Invoicing

Body -   The body of the email that will be sent using Automated Invoicing.

Cutoff Dates

Expenses - What date will be used as a cutoff when looking at expenses in invoicing.

o G/L Period End Date - When selected, all reimbursable transactions through the specified G/L will be

included.  

o Transactions Date - When selected, the transaction date will be compared with the specified as-of

date.

Billed and Received  - What date will be used as a cutoff when looking at billed and received numbers in

invoicing.

o G/L Period End Date - When selected, the billed-to-date and received-to-date calculations will include

all transactions through the specified G/L period. 

o Transaction Date - When selected, the transaction date will be compared with the specified As-of

date.

o No Cutoff - When selected, billed and received amounts will be calculated, regardless of any

transaction cut-off date.  This is the preferred method for most clients.

Disbursements Journal --> Check Date

E/R Journal --> Transaction Date

General Journal --> Transaction Date

Purchase Journal--> Invoice Date
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Receipts Journal--> Check Date

Sales Journal --> Invoice Date

Time sheets --> Work Date

Additional Settings

Convert "Holds" to "Ready to Bill" after invoicing post - When checked, all transactions flagged as Hold

will be changed to Ready-to-Bill after the invoice has been posted.

Allow PM to Edit Invoice Comments - When checked, the PM can edit the Invoice Comments on a

project.

Allow PM to Apply Fixed Fee - When checked, PM is able to make changes to the "Current % Complete"

and "Current ICC to Apply" fields in PM Bill Review without Project Accountant approval.

Mark All Fixed Fee Transactions as Billed Regardless of Current Bill Amount - This feature works in

conjunction with settings on the Fixed Fee design.  Specifically, Invoice Filters, Show Un-worked Levels,

and the Labor, ODC, OCC and ICC flag-as-billed check boxes.

Remit To Address

Office -Named address that comes from the Office tab in Global Settings. The remit-to address can

appear in invoices to clients.

Street 1 - First address line of Remit-to.

Street 2 - Second address line of Remit-to.

Street 3 - Third address line of Remit-to.

Street 4 - Fourth address line of Remit-to.

City - Remit-to City

State - Remit-to State

Zip - Remit-to Address

Attn - Remit-to attention.

4.12.4.5 Time and Expense Tab

Overview 

The the items on the Time and Expense Tab can affect personal time and expense entry. 

Field Descriptions 

Allow users to Edit Time sheets

Job Titles - When checked, users can change their job title to an allowable job title. More on Job Titles
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Overtime - When checked, true users can specify overtime on time sheets.

Location -   When checked, users can specify a location on time sheets. More on Locations

Misc.

Use Labor Codes - When checked, labor codes will be accessible in time entry. More on Labor Codes

Require Expense Codes In Expense - When checked, users must supply an expense code in expense

sheet entry. Checking this requires expense groups to be used on all projects. More on Expense Codes

Enable Estimate-to-Complete In Time sheets - When checked, estimate-to-complete requests can appear

when a user submits a timesheet. If not checked, no request will occur, whether one was requested via

project setup or through a work order.

Allow Users to Edit Bill Status In Time and Expense - When checked, bill status is accessible to users in

time and expense entry.

Allow Work Orders in Time and Expense - When checked, work orders are available in time and expense

entry. More on Work Orders

Default Separate Checks For Employees - When set, will cause a separate check to be issued for each

invoice (Employee Reimbursement) for an individual employee, rather than combining multiple invoices on

an e-check. Regardless of this setting, the behavior can be overridden when processing E/R checks.

Allow Labor Code Org. Override - Override allows individuals to use labor codes that are assigned to org

units other than their home org. More on Labor Codes

Auto Approve Timesheet on Submit - When this option is checked, the approval process is removed from

the system. Submitted time sheets will be flagged automatically as approved.

Auto Approve Time / Exp. Sheet When Owner Approver - When submitting a time or expense sheet,

where the employee was also listed as an approver, the time or expense sheet would auto-approve. This

check box allows you to optionally prevent auto-approval.

Show Zero Hours in  Time sheets - You have the ability to hide or show the zeros in the time sheet

window. This is controlled in Global Settings > Time and Expense Tab by selecting the “Show Zero Hours

in Time Sheets” check box.

Auto-Compress Mobile Time Sheet On Save - Checking this box will compress multiple entries with

similar attributes (e.g. Project, Labor Code, Job Title) into one entry line for time entries made via InFocus

Mobile.

Pay Rates

Used Diluted Pay Rates - Enables the diluted pay rates module for use.

Set Bill Base Rate To Diluted Rate - Causes the system to use the diluted rate as the base rate for

calculating the bill rate, rather than the average pay rate. Base rates are used in cost plus invoicing.
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Set Job Cost Base Rate To Diluted Rate - Causes the system to use the diluted rate as the base rate for

calculating the job cost rate, rather than the average pay rate.

Timesheet Timer Rounding

Round to the nearest ??minute(s) - This controls the time rounding in the time sheet Stopwatch. Here you

set the accuracy of the timer in minutes. 

Default Time & Expense Template

Default Time & Expense Template - When selected, this will be the default Time & Expense template

assigned to newly created employees. More on Time & Expense Templates

Required Comment Defaults For Project Types

Direct - When checked, a user entering a time sheet must enter a PM Comment before he can submit a

time sheet on Direct Projects.

Indirect - When checked, a user entering a time sheet must enter a PM Comment before he can submit a

time sheet on Indirect Projects.

Opportunity - When checked, a user entering a time sheet must enter a PM Comment before he can

submit a time sheet on Opportunity Projects.

Required Comment Prompts

Timesheets - The “Require Comments Prompts” determines when you are going to require that the Time
Sheet comment be entered.  Options include; On Save, On Submit, or On Line Create (when the user
leaves the line).

Expense Sheets - The “Require Comments Prompts” determines when you are going to require that the
Expense Sheet comment be entered.  Options include; On Save, On Submit, or On Line Create (when the
user leaves the line).

Additional Settings

Allow Audit Trail Posting in Rate Recalculation - When checked, You get the options to post an audit trail

for   Pay Rate, Job Cost Rate, and Bill Rate  when you run the Recalculate Rates Utility.

Default Timesheet Report

System Timesheet Report - Uses the Time Sheet report located under Report Management.

Custom Timesheet Report - Allows user to select a custom time sheet report.

Time Sheet Header Mask

Allows you to optionally set a Time Sheet Header Mask. This mask will allow you to customize the header
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format for the days of a timesheet period. For Example, with the mask "MM/dd/yyyy", the date will appear

as 01/05/2012.

Require Rejection Reason

Time Sheets - You can require a reason for a rejected Time Sheet.  An optional reason box has been

added for rejected Time Sheets. Upon rejecting a time sheet, the approver will get a pop-up requiring a

reason to be entered for the rejection.  When a Time sheet has been rejected, a red banner will show up

in the header of the Employee’s time sheet.  The banner goes away when the sheet is re-submitted.  

Expense Sheets - You can require a reason for a rejected Expense Sheet.  An optional reason box has

been added for rejected Expense Sheets. Upon rejecting a expense sheet, the approver will get a pop-up

requiring a reason to be entered for the rejection.  When a Expense sheet has been rejected, a red

banner will show up in the header of the Employee’s expense sheet.  The banner goes away when the

sheet is re-submitted.  

Time Sheet Adjustment Hours Precision

Drop-down - The drop-down sets the precision for hours Time Sheet Adjustments. More on Timesheet

Adjustments

Time Line Item Approval
Use Time Line Approval - When selected, the line item approval feature for Time Sheets will be enabled. 

More on Line Item Approval

Project Approval Default - The Default Line-Item Approval setting on projects.  If "Default" is selected on

the project, the selection will be honored.  Required, requires that all time entries against the project be

approved by line item. Not Required does not a require that each line item be approved for the time sheet

before the Time Sheet, as a whole, can be approved.

Allowed Line Approvers - Options are Principal In Charge, Project Manager and Project Accountant.

When selected, the Corresponding Button will appear on the Line Item Tab and the individual assigned to

that role on the project will see the Time sheet line item(s) for individuals that have entered time against

that project.

Expense Line Item Approval
Use Expense Line Approval - When selected, the line item approval feature for Expense Sheets will be

enabled. More on Line Item Approval

Project Approval Default - The Default Line-Item Approval setting on projects.  If "Default" is selected on

the project, the selection will be honored.  Required, requires that all expense entries against the project

be approved by line item. Not Required does not a require that each line item be approved for the
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expense sheet before the Expense Sheet, as a whole, can be approved.

Allowed Line Approvers - Options are Principal In Charge, Project Manager and Project Accountant.

When selected, the Corresponding Button will appear on the Line Item Tab and the individual assigned to

that role on the project will see the Expense sheet line item(s) for individuals that have entered time

against that project.

4.12.4.6 Global Settings Electronic Signature Tab

Overview 

The items on the Electronic Signature Tab enables a Customizable Prompt when submitting both Time and

Expense Sheets. 

Field Descriptions 

Time Sheet Electronic Signature 

Require Electronic Signature Confirmation - When selected, a prompt comes up after clicking submit that
displays the comment that is entered into the "Electronic Signature Text" textbox.

Expense Sheet Electronic Signature 

Require Electronic Signature Confirmation - When selected, a prompt comes up after clicking submit that
displays the comment that is entered into the "Electronic Signature Text" textbox.

4.12.4.7 Currency Tab

Overview 

The root setup of Multi-Currency is completed here. Here the Base System Currency and Multi-Currency

functionality is defined.

Key Concepts

Complete MultiCurrency Setup is located at this link: More on Multi-Currency

Field Descriptions 

Base System Currency
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Description - This defines the base currency InFocus operates from. All systems will have one base currency.

This is the currency that all companies within a single database will consolidate to. Although this setting

defaults to the U.S. Dollar (USD), it can be customized to reflect any given company's base operating

currency.

Culture - Configures the base culture the business is operating in and drives system report formats.

Symbol - Represents the system wide currency symbol.

Code - International three character monetary code. This important setting drives the import of system

exchange rates.

Name - Required Field containing the selected culture's currency name.

Precision - Defines columns to the right of the decimal place and drives system rounding. Example:

Precision 2 rounds to the nearest hundredth (5.248 = 5.25).

Unit - Represents the smallest unit in the selected currency. Example: For U.S. Dollars, 1 represents the

Penny (the system will round to the nearest penny).

Major Denomination

o Singular - Defines the singular cases for check printing. For example, USD major labels are "dollar".

o Plural - Defines the plural cases for check printing. For example, USD major labels are "dollars".

Minor Denomination - 

o Singular - Defines the singular cases for check printing. For example, USD minor labels are "cent" .

o Plural - Defines the plural cases for check printing. For example, USD minor labels are "cents".

Multi-Currency

Description - This section is only defined when the system should operate across multiple currencies. The

configurations herein define the dates that drive configured exchange rates for sub ledger journals.

Use Multi-Currency - When checked, this enables the system to operate across multiple currencies.

Default Evaluation Date Settings - Here you select which date will be used when evaluating currency in

the Purchase, Disbursement, E/R, Sales, Receipt and General Journals.

o Transaction Date - Journal based MC Effective date

o Period End Date - End date of the G/L Period of the transaction

o Period Start Date - Start date of the G/L Period of the transaction

o Today's Date - The system date of the transaction

4.12.4.8 Labels Tab

Overview 

The Labels Tab allows you to enable Overtime Types and customize selected column headers in the time
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sheet.  

Field Descriptions 

Overtime Labels

Description - You have the option of selecting up to 4 different overtime types.  When you add a name to the

Overtime label box, it is activated.  You can then go to the Employees>Pay History Tab and enter the

overtime rates.  When more than one Overtime Type is activated, the employees will be required to select an

Overtime Type when they enter overtime in a time sheet. If you delete the name from the box, the Overtime

type will be deactivated. 

Overtime 1 - When a label is entered in this box the Overtime 1 type is activated.

Overtime 2 - When a label is entered in this box the Overtime 2 type is activated.

Overtime 3 - When a label is entered in this box the Overtime 3 type is activated.

Overtime 4 - When a label is entered in this box the Overtime 4 type is activated.

Timesheet Labels

Description - In Time Sheets, you are able to customize the column name of the Work Order, Job Title, Bill

Status, Labor Code and Location Columns by just filling in the new name on this tab.  If you delete the name,

it defaults to the original. 

Work Order - When a label is entered here, the Work Orders column will display the label instead of the
default name. More on Work Orders

Job Title - When a label is entered here, the Job Title column will display the label instead of the default
name. More on Job Titles

Bill Status - When a label is entered here, the Bill Status column will display the label instead of the
default name.

Labor Code - When a label is entered here, the Labor Code column will display the label instead of the
default name. More on Labor Codes

Location - When a label is entered here, the Location column will display the label instead of the default
name. More on Locations

4.12.4.9 Project Admin Tab

Overview 

The Project Administration Tab is where you configure default settings that will assist with project setup. 

Field Descriptions 
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Default Labor Multipliers

Description - Multipliers that are entered here will be the default labor multipliers in the Rate Schedules

section on any projects that are created in the Projects applet.  More on where the Multipliers (in Rate

Schedules) is set on the Project

Direct Personnel Expense (DPE) - Default DPE multiplier for projects.

Overhead - Default overhead multiplier for projects. If only a combined multiplier is used, use this and set

DPE and Profit to 1.

Profit - Default profit multiplier for projects.

Direct Non-Labor Multipliers

Description - Multipliers that are entered here will be the default non-labor multipliers in the Expense

Markups/Codes section on any projects that are created in the Projects applet.  More on where the

Multipliers (in Expense Markups/Codes) is set on the Project

Other Direct Charges (ODC) - Default ODC multiplier for projects.

Out-Of-Contract-Consultants (OCC) - Default OCC multiplier for projects.

Default Rate Schedules

Description - The Rate Schedules entered here will be the default Rate Schedule in the Rate Schedules

section on any projects that are created in the Projects applet.  More on where the Multipliers (in Rate

Schedules) is set on the Project

Direct Job Cost - Default job cost rate schedule for Direct (Billable) projects.

Direct Bill - Default bill rate schedule for Direct (Billable) projects.

Indirect Job Cost - Default job cost rate schedule for Indirect projects.

Indirect Bill - Default bill rate schedule for Indirect projects.

Opportunity Job Cost - Default job cost rate schedule for Opportunity projects.

Opportunity Bill - Default bill rate schedule for Opportunity projects.

Default Project Figures Report

Drop-down - Selects the default Project Figures Report to run for Projects

Project Central Default Overhead Calculation Method

Drop-down - Defines the default calculation method in Project Central  for Overhead, according to one of

the following options. More on Project Central

o Job Cost less Pay - Calculates Overhead using Job Cost minus Pay

o Overhead Allocation - Utilizes per project Overhead Allocation amounts defined in Utilities>Overhead

Allocation
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o None

Delimiters

Description - Delimeters are character that delimit or separate the codes at different levels of the WBS. It

is used for separation between all codes except for the roll-up node of a project. This character cannot be

contained in any code. 

Work Breakdown Structure (WBS) - Delimiter that will be used to separate the Work Breakdown

Structure in the project.  

o For example. 9801-10-A would represent Project 9801 /  Phase 10  / Task A with a hyphen used as

the delimiter.  The hyphen between the 10 and the A is the WBS delimiter.

Project Name - Character that separates the project names at different levels of the WBS.  

o For example. 9801-10-A would represent Project 9801 /  Phase 10  / Task A with a hyphen used as

the delimiter.  The hyphen between the 9801 and the 10 is the Project Name delimiter.

Roll up Node - Character that delimits a roll up node from the project node. It can use the same delimiter

as the rest of the WBS. It cannot be contained in any code.  

o For example. RU:9801-10-A would represent Roll up node RU / Project 9801 /  Phase 10  / Task A

with a colon used as the delimiter.  The colon between the RU and the 9801 is the Roll up Node

delimiter.

Profit Centers

Project Sharing Profit Center Level - Organization level at which profit sharing can be assigned. Example -

Office, Department or Division. When you have the Project Sharing Profit Center set to the lowest node

this will enable you to set the Project's owning Org at any level. Please note that this will allow both

Billable and Indirect projects to carry an owning org at any level. More on Profit Sharing

Allow multiple profit centers per project - Enables profit sharing between profit centers within a project.

Default Expense Groups

Description - The Expense Groups entered here will be the default Expense Groups on the Expense & G/

L Tab on any projects that are created in the Projects applet.  More on Expense Groups  

Direct - Defines the default Expense Group for Direct Projects

Indirect - Defines the default Expense Group for Indirect Projects

Opportunity - Defines the default Expense Group for Opportunity Projects

Labor Codes

Required by Default Check Box - When checked, Labor Codes are required by default on Projects that

are created. More on Labor Codes
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Default Opportunity Bill Status

Drop-down - You are able to select the Default Bill Status for Opportunity projects.  These features do not

limit the statuses; they simply specify the default value on a new transaction.

4.12.4.10Taxes and Surcharges Tab

Overview 

The Taxes and Surcharges Tab control the settings that relate to applying taxes and surcharges to an

invoice.

Field Descriptions 

Taxes and Surcharges Grid

General Section

Active - When checked, the tax will appear on the "Taxes and Surcharges" tab in the Projects applet.

Tax Code - Tax code used to differentiate between tax codes.

Tax Name - Tax Name

Tax 1 %  - Percentage of 1st tax in the Tax Invoice Section.

Invoice Text1 - Name of 1st Tax as it appears on the invoice.

Tax 2 % - Percentage of 1st tax in the Tax Invoice Section (optional).

Invoice Text2 - Name of 1st Tax as it appears on the invoice (optional).

Base Account - Base account for this tax.

Base Account (Tax 2) - You can post tax amount 2 to a separate G/L account.

Use in Rev. Rec. - When checked, the tax will be used in the Rev. Rec. feature in InFocus.

"Apply Tax To" Section

Labor -  When checked, the tax will be applied to the Labor section of the invoice.

ODC - When checked, the tax will be applied to the Other Direct Charges (ODC) section of the invoice.

OCC - When checked, the tax will be applied to the Out of Contract Consultants (OCC) section of the

invoice.

4.12.4.11Auto Codes Tab

Overview 
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Auto-Coding allows InFocus to auto generate codes for Projects, Opportunities, Firms, Employees and
Purchase Orders. When enabled, an auto-code icon (blue wand) will appear in the Code field of the
respective applet.

Using Auto Codes, you'll designate a prefix for your code, seed number and length of the code. For instance,
using the following settings, InFocus would generate the code E0000 for your first entered employee.

Prefix - E

Seed - 0

Pad Length - 4

Click here and go to the 3 minute 57 seconds mark to learn more about the Auto Coding Tab in Global
Settings.

Field Descriptions

Auto Codes Header

Enable Project Auto Codes - When checked, the auto code feature will be available in the Projects
applet. More on Projects
Enable Opportunity Auto Codes - When checked, the auto code feature will be available in the
Opportunities applet. More on Opportunities
Enable Firm Auto Codes (Client and Vendor) - When checked, the auto code feature will be available in
both the Client and Vendor applets. More on Clients More on Vendors
Enable Employee Auto Codes - When checked, the auto code feature will be available in the Employees
applet. More on Employees
Enable Purchase order Auto Codes - When checked, the auto code feature will be available in the 
Purchase Orders applet.

Auto Codes Grid

Type - The applet where Code is being generated.

Name - Name of Code

Prefix - Text that will appear before any Auto-Generated code.  You can use Global Variables to generate
these. For example, @YEAR@ will append the current year to the code. More available Global Variables
Seed - The first code that will be used.

Pad Length - The length of the code. For example, with a pad of 4, if the code is 1, Auto-Coding will
generate 0001.
Custom - When checked, the Code will require a custom query.

Custom Query -  A custom query can be entered here to generate a custom code.

4.12.4.12Document Management Tab

Overview 

The Document Management Tab controls the settings that deal with the configuration of Document

Management. 

http://support.clearviewsoftware.net/articles/4078
https://support.clearviewsoftware.net/articles/5354
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Key Concepts

Document Management is HTTP.  What this means is that documents live in the same installation folder as InFocus

(<drive>:\program files\Clearview Software\InFocus\Client\Documents). When you upgrade to version 1.4.7 or greater,

a Documents folder is created.  This is where all documents will reside.  All previously archived documents will need to

be moved into this folder. Additionally, you will need to modify the permissions on the folder to allow Read/Write access

to the folder. (See this article  or a more detailed explanation.)

Field Descriptions 

Document Management Features

On/Off buttons - The On/Off buttons are used to enable and disable on Document Management.  

Disallow Document Updates - When checked, users are unable to upload changes to documents that

have been added.

Document Management Type

Use HTTP Document Management (recommended) 

Note - Once you select "Use HTTP Document Management", you are unable to go back to "Legacy

Document Management".

o Document Base URL - This URL is the URL that you use to launch InFocus (typically http://

server_name/infocus).

o "Verify" link - Verifies a connection with the Document Base URL.

o Max File Size (KB) - This limits the size of the documents to be uploaded.

o "Remove Legacy Document Repository Settings" link - Used after moving from the old Document

Management setup to the HTTP Document Management setup. This removes the old repository

settings.

Use Legacy Document Management (depricated).  **Clearview does not configure this way any more.  All

new Clients must use HTTP Document Management**

Deployment Server FTP Settings

Description - These settings are generated by the DTA Config utility when Document Management is

configured.

User - InFocus DTA is the default user.

Password - A default password is generated during setup.  To properly change the password, go to your

FTP provider and change it.  Then change the password here to the corresponding password.

Confirm Password - Password used to confirm the new password to be entered.

Port - The port being used by the FTP service to communicate with InFocus.

http://support.clearviewsoftware.net/articles/4090
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Email Relay Settings

Host - SMTP Email Host

User - Who the email will be delivered from (ex. noreply@clearviewsoftware.net)

Password - Email password

Confirm Password - Password used to confirm the new password to be entered.

Port - SMTP Port

Use SSL / TLS

"Send Test E-mail To" link - A test email will be sent when you enter a valid email address and click on

the link.

4.12.4.13Multi-Company_Tab

Overview 

Multi-Company (Inter Company Transfers aka. ICT) is used for advanced multi-company support. More on

Multi-Company Setup

Note - Additional setup and training is required to use this feature as well as an associated cost.  If you are

interested in using ICT, please contact support. 

Field Descriptions 

Settings

Use Multi-Company - When checked, the Multi-Company feature is enables and all related fields are

available.

Post Inter-Company Transfers Using Automated Invoicing - 

Methods

Labor - Method to be used when calculating Labor.

ODC (Other Direct Charges) - Method to be used when calculating Other Direct Charges.

OCC (Out of Contract Consultants) - Method to be used when calculating Out of Contract Consulting

charges.

ICC (In Contract Consultants) - Method to be used when calculating In Contract Consulting charges.

Cross-Company TX Settings by Journal

Description - For each journal you can specify how the system handles the attempt of a transaction to

reference two or more companies.  The Drop-down options are Allow, Disallow and Warn.
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General - Specifies how the system will handle this in the General Journal. 

Sales - Specifies how the system will handle this in the Sales Journal. 

Receipt - Specifies how the system will handle this in the Receipt Journal. 

Purchase -  Specifies how the system will handle this in the Purchase Journal. 

Employee Reimbursable - Specifies how the system will handle this in the Employee Reimbursable

Journal. 

Disbursement -  Specifies how the system will handle this in the Disbursement Journal. 

Enable Inter-company Transfers by Journal

Purchase - When checked, the inter-company transfer option is turned on in the Purchase Journal.

Employee Reimbursable - When checked, the inter-company transfer option is turned on in the Employee

Reimbursable Journal.

Disbursement - When checked, the inter-company transfer option is turned on in the Disbursement

Journal.

Receipt - When checked, the inter-company transfer option is turned on in the Receipt Journal.

Base Accounts

Revenue

Description - Here you select the Revenue Base Accounts to be used for Multi-Company

Labor - Select the Labor Revenue Base Account.

ODC (Other Direct Charges) - Select the ODC Revenue Base Account.

OCC (Out of Contract Consultants) - Select the OCC Revenue Base Account.

ICC (In Contract Consultants) - Select the ICC Revenue Base Account.

Expense

Description - Here you select the Expense Base Accounts to be used for Multi-Company

Labor - Select the Labor Expense Base Account.

ODC (Other Direct Charges) - Select the ODC Expense Base Account.

OCC (Out of Contract Consultants) - Select the OCC Expense Base Account.

ICC (In Contract Consultants) - Select the ICC Expense Base Account.

4.12.4.14Offices Tab

Overview 

The Office tab allow is where the address of the company using InFocus.
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Key Concepts

Office addresses can be used in employee setup and in invoicing for remit-to addresses. 

When entering an address, the user enters the addresses name (referred to as Address Name). Later,
this address can be applied to items such as an employee, by referencing the named address.

Addresses can be NAMED to categorize them for reuse. For instance, a client can have many offices with
an address for each office, as well as associate client contacts with a particular office address. If the
information of the NAMED address changes, you can cascade those changes to all associated (linked)
addresses in entirety, or only for fields that have a value.

Sometimes addresses have specific uses, as in the case of bill to, pay to, and remit to addresses. These
can be unassociated addresses or linked addresses. Typically, they will be linked addresses, which
means they must first be entered as a named address, prior to referencing them as a bill to, pay to, or
remit to.

Field Descriptions 

Offices Grid

Pencil icon - When clicked, the Address Editor pop-up appears for easy data entry. 

Name - Named address. Not available for employee contacts.

Street 1 - Address line 1

Street 2 - Address line 2

Street 3 - Address line 3

Street 4 - Address line 4

City - City

State - State

Zip - Zip Code

State - State

Country - Country

Phone - Telephone number

Fax - Fax number

Latitude - Latitude of Address

Longitude - Longitude of Address

Copy to Clipboard - Copies address to the clipboard of the local workstation. (Only seen in Address

Editor)

Geocode - When clicked, the Latitude and Longitude are filled in with the location of the Main Address. 

This can be used in the Map Viewer applet. More on the Map Viewer. (Only seen in Address Editor)
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4.12.4.15Revenue Posting Accounts Tab

Overview 

The Revenue Posting Accounts Tab controls the default Revenue Posting Accounts used in Automated
Invoicing.  These accounts can me overridden in Automated Invoicing>Posting Tab and when using Invoice
Posting Groups. More on Invoice Posting Groups

Field Descriptions 

A/R Account - A/R account to process. Required.

Direct Labor - The base account to which the base amount for hourly labor is posted.

Overhead - Base account to which the DPE plus OH amount for hourly labor is posted. If not supplied,

direct labor is used.

Labor Profit - Base account to which the profit portion for hourly labor is posted. If not supplied, direct

labor is used.

Fixed Fee - Base account to which fixed fee is posted. If not supplied, direct labor is used.

Direct ODC - Base account to which non-marked up portion of ODC expense is posted.

Profit ODC - Base account to which marked-up portion of ODC expense is posted. If not supplied, direct

account is used.

Direct OCC - Base account to which non-marked up portion of OCC expense is posted.

Profit OCC - Base account to which marked-up portion of OCC expense is posted. If not supplied, direct

account is used.

ICC - Base account to which ICC portion of fixed fee is posted.

Retainage - Base account to use for retainage.

Retainer - Base account to use for retainers.

4.12.4.16Labor Distribution Tab

Overview 

The Labor Distribution Tab manages the settings that control Labor Distribution postings. More on Labor

Distribution

Key Concepts

The purpose of labor distribution is to post labor to the General Ledger and mirror payroll. 
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Labor Distribution posts labor figures to the General Ledger based on time sheet entries. 

The process scans time sheets that have been approved, but not yet processed by this utility. In general,

labor is divided between direct and indirect labor cost accounts. 

To understand how Labor Distribution G/L Accounts are derived click here.

Field Descriptions 

Base Codes

Description - These are the default base codes that will automatically fill into the Labor Distribution utility

when launched. They can be overridden by base codes on the job title, and those can be overwritten by base

codes at the project level. More on Job Titles

Direct Salary -  Direct Labor base account for salaried employees. It is combined with the charged

organization to derive a valid G/L account. The metric type is cost; the cost type is direct; and the project

management type is labor. It cannot be flagged as a subcontractor base account.

Overhead Salary -  Indirect Labor base account for salaried employees. It is combined with the charged

organization to derive a valid G/L account. The metric type is cost; the cost type is indirect; and the

project management type is labor. It cannot be flagged as a subcontractor base account.

Direct Hourly -  Indirect Labor base account for non-exempt employees. It is combined with the charged

organization to derive a valid G/L account. The metric type is cost; the cost type is indirect; and the

project management type is labor. It cannot be flagged as a subcontractor base account.

Overhead Hourly -  Indirect Labor base account for non-exempt employees. It is combined with the

charged organization to derive a valid G/L account. The metric type is cost; the cost type is indirect; and

the project management type is labor. It cannot be flagged as a subcontractor base account.

Direct Subcontractor -  Direct Labor base account for subcontractors (timekeepers who are not

employees). It is combined with the charged organization to derive a valid G/L account. The metric type is

cost; the cost type is direct; and the project management type is labor. It must be flagged as a

subcontractor base account.

Overhead Subcontractor -  Direct Labor base account for markup portion. It is combined with the charged

organization to derive a valid G/L account. The metric type is cost; the cost type is direct; and the project

management type is labor. It is used only when a marked-up value (not pay rate) is used.

Markup Debit -  Direct Labor base account for markup portion. It is combined with the charged

organization to derive a valid G/L account. The metric type is cost; the cost type is direct; and the project

management type is labor. It is used only when a marked-up value (not pay rate) is used.

Markup Credit -  Direct Labor base account for the offset of the markup portion. It is combined with the

employee home organization to derive a valid G/L account. The metric type is cost; the cost type is direct;

and the project management type is labor. It cannot be flagged as a subcontractor base account and is
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used only when a marked-up value (not pay rate) is used.

Base Codes

Salary Variance - G/L account to post the difference between an exempt employees salary and their

distributed pay rate amount.

Payroll Clearing - Offset or suspense G/L account for direct and indirect labor (non- subcontractor).

Subcontractor Clearing - Offset or suspense G/L account for direct and indirect subcontractor labor.

Misc.

Posting Method - Rate method used for posting labor. There are four Posting Methods to use to calculate

the amount to post: 

o Pay Rate - Labor is calculated at the pay rate value in timesheets.

o Job Cost Rate - Labor is calculated at the job cost rate value in timesheets.

o Bill Rate - Labor is calculated at the bill rate value in timesheets.

o Pay Rate X Supplied Multiplier - Labor is calculated at the pay rate value in timesheets and then

multiplied by the supplied multiplier when this utility is run.

Note - When using any method except pay rate, you can split the difference between pay rate and the select
method into two debit and credit base accounts. This allows the user to transfer an overhead portion in cross-
charge scenarios from one organization to another, and maintain visibility of that overhead transfer in the
General Ledger.

Hours In A Work Day - Standard number of hours in a work day. In Labor Distribution, it is used salary

variance calculations, if compensatory time is not booked. It is also used in resource management

projections.

Compensatory Time Project

Look-up Box - Project to which compensatory time is posted. When posting compensatory time, salaried

variance is washed through a compensatory project.

Next: Back to the Labor Distribution Overview

4.12.4.17Revenue Recognition Tab

Overview 

The Revenue Recognition Tab controls the initial settings of automated Revenue Recognition postings. 
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Key Concepts

Revenue recognition is to used to meet the GAAP principle of recognizing revenue in the same

accounting period that the expense was incurred.  When this utility is run, labor and expense transactions

are calculated based on user-set rules to obtain an earned revenue value on a project-by-project basis.

The system then calculates the previous earned revenue. The difference is posted to Unbilled Revenue

and offset to WIP. When automated invoicing is used, whatever gets posted to Billed Revenue is relieved

from WIP and offset against Unbilled Revenue.

Rules can be established for each PM type (Labor, ODC, OCC, and ICC) on a project. Rules can analyze

expense transactions at cost or marked up (billable value), and analyze labor at any of the three rates

(pay, job cost, or bill). Values can then be compared to maximums of upsets to prevent over-valuing. The

rules can also earn revenue based on user-entered percent completion. More on Revenue Recognition

Project Setup

All billing statuses (except for Never Bill) are included. 

When upsets occur, the overage is posted against an upset G/L account. This allows for a separation

from the standard unbilled revenue account. You can make this the same as the standard. In other words,

you could use one unbilled labor revenue account for both the labor revenue and the upset labor revenue.

This technique is also useful regarding expenses. Expense revenue will post by expense code if available.

In the case of a cap, you can post the overage to a separate account without randomly penalizing any

expense code.

Field Descriptions 

Unbilled Revenue Base Codes

Labor - Account for Labor Gross Earned Revenue. Base account must have a metric type of unbilled

revenue and a project management type of Labor.

Other Direct Charges (ODC) - Account for ODC Gross Earned Revenue. Base account must have a

metric type of unbilled revenue and a project management type of ODC.

Out-Of-Contract Consultants (OCC) - Account for OCC Gross Earned Revenue. Base account must have

a metric type of unbilled revenue and a project management type of OCC.

In-Contract Consultants (ICC) - Account for ICC Gross Earned Revenue. Base account must have a

metric type of unbilled revenue and a project management type of ICC.

Labor Upset - Account for Labor Overrun Earned Revenue. Base account must have a metric type of

unbilled revenue and a project management type of Labor. When a cap is exceeded, this account will be

debited for the amount of the overrun.
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ODC Upset - Account for ODC Overrun Earned Revenue. Base account must have a metric type of

unbilled revenue and a project management type of ODC. When a cap is exceeded, this account will be

debited for the amount of the overrun.

OCC Upset - Account for OCC Overrun Earned Revenue. Base account must have a metric type of

unbilled revenue and a project management type of OCC. When a cap is exceeded, this account will be

debited for the amount of the overrun.

ICC Upset - Account for ICC Overrun Earned Revenue. Base account must have a metric type of unbilled

revenue and a project management type of ICC. When a cap is exceeded, this account will be debited for

the amount of the overrun.

Subcontractor - Account for Subcontractors.

WIP Base Codes

Labor - Base account for Labor work-in-progress.

Other Direct Charges (ODC)  - Base account for ODC work-in-progress.

Out-Of-Contract Consultants (OCC) - Base account for OCC work-in-progress.

In-Contract Consultants (ICC) - Base account for ICC work-in-progress.

Misc.

Use Revenue Recognition - Indicates whether Revenue Recognition screens will be available in the

system.

Post single journal entry per period - Flag indicating if only one entry should be used per period for

Revenue Recognition postings. When checked, any previous entry in the same accounting period as the

current processing period will first be deleted.

Effort Calculation

Include Never-Bill Transactions for Owning Profit Centers - Flag indicating if transactions with a never-bill

status should be included in the calculation of effort in Revenue Recognition formulas for owning profit

centers.

Include Never-Bill Transactions for Sharing Profit Centers - Flag indicating whether transactions with a

never-bill status should be included in the calculation of effort in Revenue Recognitions formulas for

owning profit centers.

Include Write-Off Transactions for Owning Profit Centers - Flag indicating if transactions with a write-off

status should be included in the calculation of effort in Revenue Recognition formulas for owning profit

centers.

Include Write-Off Transactions for Sharing Profit Centers - Flag indicating if transactions with a write-off
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status should be included in the calculation of effort in Revenue Recognition formulas for sharing profit

centers.

4.12.4.18SMTP / Webhook Relay Servers Tab

Overview 

The SMTP / Webhook Relay Servers is where most SMTP / Webhook relay information is stored for use in

emailing. The only exception is with Document Management Read more on Configuring InFocus for Emailing

Field Descriptions 

SMTP Relay Servers Grid

Active - When checked, the SMTP server is active and can be used in the emailing processes.

Is Public - When checked, the SMTP server is accessible in the application by users who have been
granted Permissions to those applets.  More on Permissions

Name - User defined name of the SMTP Server.

From Address - Email address that any email sent from this SMTP Server will be from.

From Name - Name in the email that any email sent from this SMTP Server will be from.

SMTP Server - Email Server information.

User ID - User ID used to access the SMTP Server

Password - Password used to access the SMTP Server

Port - Port that the SMTP Server is using.

SSL/TLS - Is SSL or TL are required by the email service provider, check this box.

Webhook Relays Grid

Name - Webhook Name

Method - HTTP Method with which the webhook is being sent (POST, PUT, DELETE, etc.)

URL - Webhook URL

Use Basic Auth - Check to use basic authentication

Username - User name to be passed (optional)

Password - Password to be passed (optional)

Headers - Headers to be passed (optional)

All Webhooks should be processed using HTTPS.

https://support.clearviewsoftware.net/articles/4081
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4.12.4.19External Data Sources Tab

Overview

InFocus supports the use of External Data Sources when using advanced query applets such as: SQL Query
and Analytic Dashboard Designer.

Global Settings provides one, central place for managing external data sources and their connection
information.

Generally, connections entered here are configured for connecting to SQL databases. That said, use the
Custom CX option for connecting to other third party data source (e.g. Access, Oracle, etc.)

Field Descriptions

Name - Name to appear throughout InFocus in data source drop-downs

Server Name - SQL server name

Database - SQL Database

Use Integrated Security - Check to use Windows Authentication

User Id - SQL Server user id to use in the connection string

Password - SQL Server password to use in the connection string

Use Encryption - Check to encrypt communication to/from the SQL Server. Defaults to checked.

Connect Timeout - Defines the number of seconds InFocus will attempt to connect to the data source
before dropping the connection
Custom CX - Used for writing your own connections to SQL, Access, Oracle, etc.

4.12.4.20Mapping Tab

Overview 

The Mapping Tab holds the Bing Maps API Key that is required to use the Map Viewer. It also contains the
default settings for the Map Viewer applet. 

Note - The Map Viewer incorporates Bing Maps to display queried data.  To gain full access to this applet,
you need to set up a Bing Maps account. There are some standard queries that come with InFocus to
demonstrate the Map Viewers capabilities.

Field Descriptions 

Map Settings
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Bing Maps Key - Bing Maps API Key. This is obtained by setting up a Bing Maps account. 

Bing Maps URL - The Bing Maps URL if you would like to override the default. Default is used if left blank.

Default Latitude - The Latitude that the map will default to when the Map Viewer is launched.

Default Longitude - The Longitude that the map will default to when the Map Viewer is launched.

4.12.4.21Global Variables Tab

Overview

In addition to system scripting variables, InFocus supports custom variables for use in advanced query
applets like SQL Query, Custom Reports and Dashboard Queries Manager.

Created in Global Settings, these variables are assigned a value is inserted into the query at execution.

Global Variables are referenced in queries using the following syntax: **@variable@**.

Field Descriptions

Variable Name

Value - Default value for the variable. Note, value should be formatted according to the field type (e.g int =
plain text (5), varchar = single-quote text ('LJC01'), etc.)
Variable - Automatically builds the the variable, with added syntax (e.g. @variable@)

More on using InFocus Variables

4.12.4.22UDF Tab

Overview 

The UDF Tab controls the label that is viewed on the Tab in the different applets.

Field Descriptions 

Employee UDF Tab

Text Box - Text that should appear in the Employee Setup form for the User Defined Fields tab.

Vendor UDF Tab

Text Box- Text that should appear in the Vendor Setup form for the User Defined Fields tab.

Client UDF Tab

Text Box- Text that should appear in the Client Setup form for the User Defined Fields tab.
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Project UDF Tab

Text Box - Text that should appear in the Project Setup form for the User Defined Fields tab.

4.12.4.23Miscellaneous Tab

Overview 

This tab contains Miscellaneous settings that do not fall under any of  the other tabs. 

Field Descriptions 

G/L and Invoice Period Code Display

Text Box - Allows you to display G/L periods in other formats.  This is useful for people whose accounting

periods are not the same as the calendar year. Formats are in the tab to aid you in setup.

4.12.4.24Purchasing Tab

Overview

The Purchasing tab governs global setup and configuration for the Purchasing Module. Applets affected by
these settings include:

Purchasing applets

HR>Employees

AP>Vendors

PA>Projects

Field Descriptions

Use Purchase Orders - Enables the use of the Purchasing Module and related applets and fields

Enable Receipt of Goods - Enables the Receipt of Goods feature with the ability to mark ordered items as
received.
Enable Vendor Shipping Address - Enables the use of Vendor Allowable Ship To rules for defining
Shipping addresses available to Purchase Orders. Defined via AP>Vendors>Purchasing tab.
Enable Employee Shipping Address - Enables the use of Employee Allowable Ship To rules for defining
Shipping addresses available to Purchase Orders. Defined via HR>Employees>Purchasing tab.
Custom Comment Box 1 Label - Defines the InFocus label text for the top custom comment box in the
PO>Purchase Order applet
Custom Comment Box 2 Label - Defines the InFocus label text for the bottom custom comment box in the
PO>Purchase Order applet
Use Purchase Order Approval - Enables approvals for Purchase Order items. Left unchecked, all
Purchase Orders are auto-approved.
o Employee PO Approver - Approvals are made by an employee-assigned approver. Defined via
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HR>Employees>Purchasing.
o Employee Timesheet Approver - Approvals are made by an employee-assigned Timesheet

Approver(s). Defined via HR>Employees>Accounting/Rates.
o Project Responsible - Approvals are made by the project-assigned Project Leader (e.g. Project

Manager, Project Accountant, Principle-in-charge). Defined via PA>Projects>Members.
Allow Purchase orders to be included in Sales - Enables the ability to pre-bill Purchase Orders
o ICC - Allow for ICC expense. Default Bill Status is also defined.
o OCC - Allow for OCC expense. Default Bill Status is also defined.
o ODC - Allow for ODC expense. Default Bill Status is also defined.
o PO AP Account - Default AP Account to use in the Purchase Journal entry
o PO Liability Account - Default PO Liab. Account to use in the Purchase Journal entry

Default Bill To - Bill To address to include on Purchase Orders
o Overridable on Purchase Order - When checked, Default Bill To can be overridden on the Purchase

Order
Default Allow Shipping To - Defines where a Purchase Order item can be shipped to. Alternatively, a
Specific Address can also be listed. This can be further defined per Employee and/or Vendor.
o Overridable on Purchase Order - When checked, Default Bill To can be overridden on the Purchase

Order
Global Approval Rules - Defines a set of criteria for determining if a Purchase Order item requires
approval. Rules can be further defined per Employee and/or Purchase Item.
o Approval Require All - When checked, all criteria must be met to require approvals

4.12.5 InFocus Jobs

Overview

 Advanced Users Only 

InFocus Jobs applet allows you to enter scripts to be run on a schedule from the SQL Server.

Available from Administration>InFocus Jobs, SQL Queries or Powershell scripts are entered as steps that
define the order in which they are run. Once entered, a schedule is defined for the job which governs when,
how and by whom the queries are executed (details below). A running History can be reviewed for each job.

Technical Note

Self-Hosted Clients

InFocus Jobs are processed using a single stored procedure, InFocusJobs_Process_Sav, on the SQL
Server. To enable this feature, you’ll need to complete InFocus Jobs Server Setup.

If you’re on InFocus Cloud, you’re all set- we manage this for you.

Key Concepts

Permissions

Access Permissions to InFocus Jobs applet are established to this new applet via
Administration>Permissions.

https://support.clearviewsoftware.net/articles/6046
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Steps

As stated above, scripts are entered as steps and listed in the order of execution. 
InFocusJobs_Process_Sav iterates through each script in the steps and reports back successes or failures
for the job through the History Tab.

Executing InFocus Jobs

InFocus Jobs can be run on demand, according to a schedule or triggered via webhook.

On Demand

Jobs can be run on demand by selecting the Job and clicking Execute Job from the toolbar.

Scheduled Jobs

Jobs can be run on a schedule as often as every 5 minutes. Jobs can also be run as a designated employee-
if your script uses employee variables (e.g. @MYID@).

Missed Runs

In that InFocus Jobs are processed on an automated schedule, a plan must be in place for scenarios where
the job cannot be executed (e.g. power outage, etc.).

InFocus Jobs run on a counter system, where each run increments the Next Run Date based on a defined
recurrence (e.g. Recurring every 1 Day(s)). When a run is missed (e.g. the stored procedure is not
executed), the Next Run Date is not incremented until the next time the job is run. At that time the Next Run
Date will be incremented according to one of two settings: Skipped Missed Runs or Process Missed Runs.

Skipped Missed Runs - Default setting. Increments the Next Start Date from the current date of the run
based on the defined recurrence
Process Missed Runs - Increments the Next Start Date from the previously successful run's Next Start
Date based on the defined recurrence

Webhook

Jobs can be triggered via incoming webhook. To configure, each job will need to be configured with the
following

Webhook Code - Each job must be assigned a unique code to be contained in the webhook URL.
Webhook codes can be generated or entered manually- however if entering manually they should be
secure. 
Expiration Date - Expiration date for the webhook

Webhook URL - The URL used to execute the job. The request should use the POST HTTP Method. It
can also include a JSON Body that the job can access through the $infocus.input parameter.

Tutorials

Creating an InFocus Job
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1. Browse to AD>InFocus Jobs
2. Click New from the toolbar
3. Name and Describe the Job
4. From the Steps tab, add SQL Scripts to be processed by the job. As needed, this can be spread across

multiple steps.
a. Click the (+) button
b. Name the Script
c. Note, jobs default to a type of SQL. If using Powershell, designate this using the Powershell radio

button
d. Enter the SQL/Powershell Script
e. Additional Steps can be added
f. Steps can be ordered/reordered using the up and down arrows (^, v) located at the bottom of the

Steps tab.
5. Click Save

Manually Running a Job

Once entered and saved, an InFocus Job can be kicked off manually from the InFocus Jobs applet by
clicking Execute Job from the toolbar.

Field Descriptions

Menu

File/Help - Lists standard InFocus File and Help options

Toolbar Buttons

New - Creates a new InFocus Job

Save - Saves the InFocus Job

Copy - Copies the InFocus Job

Delete - Deletes the InFocus Job

Refresh - Refreshes the applet

Execute Job - Executes the currently loaded job

InFocus Jobs Grid

InFocus Jobs Grid - Lists all InFocus Jobs and the next scheduled run date

Jobs Header

Active - Defaults to checked. Check if the job is active

SQL - Defaults to checked. Check if using SQL Scripts

Powershell - Check if using Powershell Scripts

Clear History - Clears history displayed in the History tab for the loaded job

Job Name - Name of the job

Descriptions - Job description

Steps Tab
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Steps Grid - Lists the SQL Scripts to be run in the order of execution (e.g. Step 1, Step 2, Step 3, etc.)

Add Button (+) - Adds a new step

Delete Button (x) - Deletes the currently loaded step

Up/Down Arrows (^, v) - Used to reorder the currently loaded step

Step Name - Name of the step

Stored Procedure - Check if the script is a call to a stored procedure

Replace System Variables - Check to indicate that the script uses InFocus Variables which should be
inserted at run-time.
Script Editor - Used for entering and editing SQL queries

Schedule Tab

Next Run Date / Time - Check to enable. Enter the next date/time the job should be run

Recurring Every - Defines how often the job should be run. Supports as often as every 5 minutes.

Employee Context - Employee to insert if the job utilizes employee variables

Skip Missed Runs - Default setting. Increments the Next Start Date from the current date of the run
based on the defined recurrence
Processed Missed Runs - Increments the Next Start Date from the previously successful run's Next
Start Date based on the defined recurrence

No End Date (Job Duration) - The job will be processed indefinitely

End Date (Job Duration) - Sets an end date for job processing

Webhook Tab

Webhook Code - Unique code to be used in the webhook URL. Webhook codes can be generated or
entered manually- however if entering manually they should be secure.
o generate (link) - Generates a unique 32bit code

Expiration Date - Expiration date for the webhook. Once passed, the listed webhook will no longer trigger
the job.
Process Webhook as GET - When checked, the loaded InFocus Job will be triggered by HTTP GET
requests to the listed webhook URL. By default the InFocus Job can only be triggered by POST requests
made to the webhook URL.
Webhook URL - The URL used to execute the job. The request should use the POST HTTP Method. It
can also include a JSON Body that the job can access through the $infocus.input parameter.
View linked Events - Click to view Event Manager events calling the listed webhook.

History Tab

Job Log ID - Internal log ID

Start Date - Job Start Date

End Date - Job End Date

Completed - When the job was completed

Completed (Checkbox) - Job Completion status (True/False)

Error (Checkbox) - Job Error status (True/False)

Message - Job results message (e.g. Compete, Error message, etc.)

4.12.6 List Management

Overview 
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List Management is where lists within InFocus reside and are managed.  Nearly every drop-down box in

InFocus (or wherever there are more than two selections) contains a list. 

Key Concepts

Lists can be of two types - System and User.

System lists cannot be added to, edited, or deleted. They are viewable for reference purposes only.

User lists are completely controlled by the user. They can be added to, edited, deleted, and reordered.

Field Descriptions 

System Lists Management Window

Drop-down - The drop-down allows you to filter the list of Lists. Options are System, User and Both.

Window - Displays the List Names

System Lists Management Grid

ID - Unique Identifier generated by InFocus after saving. 

Display Text - Text the user will see when they click on the list.

Code (not on all items) - Code of item. Must be unique.

Unique (not on all items) - Flags the item in the list as unique.

4.12.6.1 List Management User Lists

Overview 

There are different lists that are used throughout InFocus. There are 2 types of Lists; System and User. 

User Lists can be changed at any time.  Below you will see a description of each User list with sample detail

Items.

Note - If the "Quickstart" scripts were run on your system, you may have the items below.

Key Concepts

Most User Lists are referenced lists. That means, if the text of a list item is changed after other records in

the system have been assigned to the changed list item, those records will pick up the new text. The Non-

Referenced lists are Name Suffixes, Name Prefixes, and Postal States. 
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A list is Non-Referenced if it is possible to type in a value in the associated drop-down that is not in the

list. 

User lists are completely controlled by the user. They can be added to, edited, deleted, and reordered.

Field Descriptions 

Activity Types

Description - The Activity Types list is used in both Activities and Notes throughout the system. You can

supply an Activity Type when creating a follow-up activity. To find the Activity Types list go to 

Marketing>Activities>Activity (double-click on Calendar Time slot) OR got to the Notes Tab in the Clients,

Vendors or Projects applets.

Detail Item 1: Phone Calls

Detail Item 2: Email

Detail Item 3: Appointment

Detail Item 4: Service Issue

Billing Groups

Description - The Billing Group list is typically used to group projects together by Billing Type. This list can be

used as a grouping tool when invoicing. Projects that have been assigned the same Billing Group can be

invoiced at the same time. To find the Billing Groups list go to Project Administration>Projects>Billing

Tab>Billing Group Section.

Detail Item 1: 1st Week

Detail Item 2: 2nd Week

Detail Item 3: 3rd Week

Detail Item 4: 4th Week

Billing Term

Description - The Billing Terms list used in both the Client and Project applets. This is a list of terms of

payment. The list is for display purposes only, and can be configured to display on an invoice. To find the

Billing Groups list go to Project Administration>Projects>Billing Tab>Billing Terms Section OR go to Accounts

Receivable>Clients>Billing Tab>Payment Terms Section.

Detail Item 1: Net 30

Detail Item 2: C.O.D.

Client Specialties
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Description - The Client Specialties list used in the Clients applet. This is a list of specialty areas of your

clients. The list is for display purposes only, and can be configured to display on an invoice. To find the Client

Specialties list go to Accounts Receivable>Clients>General Tab>Client Type / Specialty Section.

Detail Item 1: Transportation

Detail Item 2: Graphic Design

Detail Item 3: Graphic Design

Detail Item 4: Architecture

Detail Item 5: Engineering

Detail Item 6: Geotechnical Engineers

Detail Item 7: Environmental Engineers

Detail Item 8: Electrical Engineers

Client Types

Description - The Client Types list used in the Clients applet. This is a list of the types of clients that you may

work with. The list is for display purposes only, and can be configured to display on an invoice. The list is for

display purposes only. To find the Client Types list go to Accounts Receivable>Clients>General Tab>Client

Type / Specialty Section.

Detail Item 1: Federal Government

Detail Item 2: State Government

Detail Item 3: Local Government

Detail Item 4: Non-Profit

Detail Item 5: Health Care

Detail Item 6: Education

Detail Item 7: Commercial

Detail Item 8: Residential

Contact Employee Type

Description - The list of Contact Employee Types is typically used to classify the Relationship Type the

contact represents at their Firm. To find the Contact Employee Type list go to Marketing>Contacts>Contact

Detail (double-click on the contact)>Employee Associations Tab>Relationship Column.

Detail Item 1: Billing

Detail Item 2: Human Resources

Detail Item 3: Marketing
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Contract Type

Description - The list of Contract Types used to classify the Billing Type of your project. It is typically used for

internal classification and does not control the actuall Billing Terms of a project. The list is for display

purposes only. To find the Contract Type list go to Project Administration>Projects>General Tab>Project

Types Section.

Detail Item 1: Time and Materials

Detail Item 2: Time and Materials to Max

Detail Item 3: Cost Plus

Detail Item 4: Cost Plus to Max

Detail Item 5: Fixed Fee

Detail Item 6: Phased Fixed Fee

Detail Item 7: Percent of Construction

Employee Contact Type

Description - The list of Employee Contact Type is used to classify the relationship between the Employee

and the Contact. It is typically used for internal classification and is assigned when you add a Contact

through the Employees applet. To find the Employee Contact Type list go to Human

Resources>Employees>Contacts Tab>Contact Detail (double-click on the contact)>General Tab>Firm/

Associations Section>Relationship Type.

Detail Item 1: Friend

Detail Item 2: Associate

Detail Item 3: Former Co-worker

Detail Item 4: Relative

Detail Item 5: Business Associate

Detail Item 6: Fellow Board Member

Event Types

Description - The Event Types list is used to specify an Event Type when creating a Contact. To find the

Event Types list go to Marketing>Contacts>Contact Detail(double-click on the contact)>Marketing

Tab>Interests Section.

Detail Item 1: Conference

Detail Item 2: Seminar

Detail Item 3: Meeting

Detail Item 4: Trade Show
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Firm Contact Type

Description - The list of Firm Contact Type is used to classify the relationship between the Firm and the

Contact. It is typically used for internal classification and is assigned when you add a Contact through the

Firms applet. To find the Firm Contact Type list go to Marketing>Firms>Contact Detail (double-click on firm)

>General Tab>Relationship Type.

Detail Item 1: Project Manager

Detail Item 2: Lead Engineer

Detail Item 3: Principal

Detail Item 4: Accounting

FOB Terms

Description - Used by Purchase Orders to define terms of responsibility for the safety and quality for Freight

On Board (FOB).

FS Groups

FS Groups gives the user the ability to group G/L Accounts for use in designing Financial Statements. Each

FS Group (e.g. FS Group 1, 2, 3, 4) can have an unlimited number of designations. FS Groups defined here

are assigned to G/L Accounts via the FS Groups tab (GA>Chart of Accounts) and leveraged when designing

Financial Statements that use a Filter Range.

Gift Types

Description - The Gift Types list is used to specify a Gift Type when creating a Contact. To find the Gift Types

list go to Marketing>Contacts>Marketing Tab.

Detail Item 1: Memorial

Detail Item 2: Honorary

Detail Item 3: Retirement

Detail Item 4: Maternity

Lead Sources

Description - The Lead Sources list is used to classify the source of a Lead when creating a Contact or

Opportunity. To find the Lead Sources list go to Marketing>Contacts>Marketing Tab OR go to
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Marketing>Opportunities>General Tab>Opportunity Info Section.

Detail Item 1: Mailing

Detail Item 2: Advertising

Detail Item 3: Trade Show

Detail Item 4: Personal Contact

Detail Item 5: Client Referral

Detail Item 6: Associations

Lead Stages

Description - The Lead Stages list is typically used to designate the stage of a Lead when creating a Contact.

To find the Lead Stages list go to Marketing>Opportunities>General Tab>Opportunity Info Section.

Detail Item 1: Lead

Detail Item 2: Proposal

Detail Item 3: Pending

Detail Item 4: Short Listed

Detail Item 5: Won

Detail Item 6: Lost

Market Sectors

Description - The Market Sectors list is typically used to designate the percentage of a Market Sector that a

Project or Opportunity represents. To find the Market Sectors list go to Marketing>Opportunities>General

Tab>Markets Sectors Section OR Project Administration>Projects>Market Sectors.

Detail Item 1: Federal Government

Detail Item 2: State Government

Detail Item 3: Local Government

Detail Item 4: Non-Profit

Detail Item 5: Health Care

Detail Item 6: Education

Detail Item 7: Commercial

Detail Item 8: Residential

MessageTypes

Message Types are used by UT>Messages Manager to categorize messages.
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Messages Types - Categorizes types of messages

Name Prefixes

Description - The Prefixes that are used when creating Names throughout InFocus.

Detail Item 1: Mr.

Detail Item 2: Ms.

Detail Item 3: Mrs.

Detail Item 4: Miss

Detail Item 5: Dr.

Detail Item 6: Col.

Detail Item 7: Gen.

Name Suffixes

Description - The Suffixes that are used when creating Names throughout InFocus.

Detail Item 1: Jr.

Detail Item 2: Sr.

Detail Item 3: III

Detail Item 4: AIA

Detail Item 5: PE

Detail Item 6: CPA

Detail Item 7: CFA

Detail Item 8: PhD

Note Types

Description - The Note Types list is used when creating Notes throughout the system. You can supply a Note

Type when creating a Note. To find the Note Types list go to the Notes Tab in the Clients, Vendors or

Projects applets.

Detail Item 1: Phone Calls

Detail Item 2: Meeting

Detail Item 3: e-mail

Detail Item 4: Appointment

Detail Item 5: Lunch

Detail Item 6: Dinner
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Payment Terms

Description - The Payment Terms for vendors as they are set up. To find the Payment Terms list go to

Accounts Payable>Vendors>General Tab>Payment Terms Section.

Detail Item 1: 15 Days

Detail Item 2: 30 Days

Detail Item 3: 45 Days

Detail Item 4: 60 Days

Detail Item 5: Next

Detail Item 6: Hold

Detail Item 7: PWP

Payroll Groups

Description - The Payroll Groups are used to group together employees when running the Payroll export.

Payroll Groups are a user-defined list that allows for multiple runs of the Labor Distribution posting

procedure. More on Labor Distribution To find the Payroll Groups list go to Human

Resources>Employees>Employee Information Tab>Company Information Section.

 If you were navigating from the setup page, click here to return to Labor Distribution Setup

Detail Item 1: Weekly

Detail Item 2: Bi-Weekly

Detail Item 3: Semi-Monthly

Detail Item 4: Monthly

PO Item Receipt Status

Description - Used by the Purchasing module to define available statuses for receiving goods and services

related to a Purchase Order.

Postal States

Description - The Postal States are used when creating Addresses. The Postal States lists are used in

Addresses throughout InFocus.

Detail Items: The 50 US States

Project Contact Types
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Description - The list of Project Contact Types is used to classify the relationship between the Project and the

Contact. It is typically used for internal classification and is assigned when you add a Contact through the

Projects applet. To find the Project Contact Types list go to Project Administration>Projects>Contacts

Tab>Contact Detail (double-click on Contact)>Relationship Column.

Detail Item 1: Project Manager

Detail Item 2: Lead Engineer

Detail Item 3: Principal

Detail Item 4: Accounting

Project Report Types

Description - The Project Report Types list is typically used to group projects together by a user defined

Report Type. To find the Project Report Types list go to Project Administration>Projects>General Tab>Project

Types Section.

Detail Item 1: Commercial

Detail Item 2: Residential

Detail Item 3: Environmental

Detail Item 4: Medical

Detail Item 5: Office Building

Detail Item 6: Sports and Recreation

Detail Item 7: Transportation

Detail Item 8: Government

Project Roles

Description - The Project Roles list is typically used to grant Project Manager access using the Project Roles

Applet. To find the Project Roles list go to Administration>Project Roles.

Detail Item 1: Alternate Project Manager

Detail Item 2: Project Team Lead

Detail Item 3: Junior Project Manager

Shipping Terms

Description - Used by Purchase Orders to define terms for shipping goods

Social Types
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Description - The Social Types list is used to specify a Social Event Type when creating a Contact. To find

the Social Types list go to Marketing>Contacts>Contact Detail(double-click on the contact)>Marketing

Tab>Interests Section.

Detail Item 1: Dancing

Detail Item 2: Wine Tasting

Detail Item 3: Bridge

Sport Types

Description - The Sport Types list is used to specify a Sport Type when creating a Contact. To find the Sport

Types list go to Marketing>Contacts>Contact Detail(double-click on the contact)>Marketing Tab>Interests

Section.

Detail Item 1: Baseball

Detail Item 2: Basketball

Detail Item 3: Soccer

Detail Item 4: Football

Detail Item 5: Tennis

Detail Item 6: Golf

Unit Types

Description - Unit of measurement an Item represents (e.g. Each, Dozen, Box, Day, etc.). Note, this is not

used in calculating extended cost on the Purchase Order.

Vendor 1099 Types

Description - The Vendor 1099 Types list is used to specify a specific group of Vendors as a 1099 Type. This

allows you to load the specific group when running 1099-MISC forms through InFocus. To find the Vendor

1099 Types list go to Accounts Payable>Vendors>Settings Tab>Vendor Types Section>1099 drop-down. 

Detail Item 1: Rent

Detail Item 2: Non-Employee

Detail Item 3: Compensation

Vendor Types 

Description - The Vendor Types list is used to specify a specific group of Vendors as a user defined Vendor

Type. To find the Vendor Types list go to Accounts Payable>Vendors>Settings Tab>Vendor Types
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Section>Standard drop-down. 

Detail Item 1: Trade

Detail Item 2: Non-Trade

Detail Item 3: Subcontractor

4.12.7 Permissions

Overview 

Permissions are used to control access for both Users and Groups in InFocus 

Key Concepts

Permissions can be assigned to one of two entities - users or groups. 

Permissions are additive, meaning a user has permissions assigned directly to him, as well as rights

assigned to groups of which the user is a member.

Groups usually are established based on common departmental requirements. For instance, the user may

establish an Accounts Receivable group and assign all personnel who perform client billing to that group.

When doing so, assign least common denominator rights to that group, since one member of the group is

likely a manager and will receive more rights. For that manager, either set up a second group, or give him

more rights. 

A user can belong to as many groups as necessary.

User Permissions are assigned per applet. Applets are the subcategories shown by clicking on the

sidebar. For example, clicking Personal, the following applets appear--Expense Sheets, My Work Orders,

and Timesheets. Each applet has four basic rights.

o View - Gives users permission to view records.

o Edit - Gives users permission to modify records.

o Add - Gives users permission to add records.

o Delete - Gives users permission to delete records.

If no right is selected, the applet does not appear on the Main Menu for that user. If no applets are
viewable within a given module. Likewise, if no applets are viewable within a given module, that module
will not appear in the Main Menu for that user. Some applets have special rights in addition to the
standard four. The right, or permission name, should be indicative of what it controls (see Special Rights
for more information).
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4.12.7.1 Users Tab

Overview 

The Users Tab displays the list of users that have been created. Here you can create users and manage both

password settings and Domain Accounts.

Key Concepts

When an employee is added to the system in Employee Setup, assuming he was given a login name at

that time, he will be added automatically as a user.

You can add a user by entering a new login here, then associate an employee to that login and click

Save.

Field Descriptions 

Include Inactive - When selected, the list includes Users that have been flagged as Inactive.  This is done

through the Employees applet or the InFocus Permissions Editor. More on Employees

Lock icon - When clicked, the InFocus Permissions Editor is opened. More on the InFocus Permissions

Editor

Login - This is the login name that the user will access InFocus with.

Employee Code - Employee Code of the employee associated with the Login. 

Employee Name - Employee Name of the employee associated with the Login.

Require Reset - When checked, the employee is required to reset their password once the number of

days specified in Global Settings have passed in comparison to the Last Password Change date.  More

on Passwords

Last Password Change - Date used to determine when an employee is required to change their

password.

Windows Domain Account - Required when Windows Mode or Both is selected as the Login Type in 

Global Settings>General Tab.

Enter New Line - Type in a User Name here, fill out the additional info and click Save I to add a new User.
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4.12.7.2 Groups Tab

Overview 

The Groups Tab displays the list of Groups that have been created. Group Permissions are created to restrict

access throughout InFocus to a Group of users. 

Key Concepts

Permissions are additive, meaning a user has permissions assigned directly to them, as well as rights

assigned to groups of which the user is a member.  

Groups usually are established based on common departmental requirements. For instance, the user may

establish an Accounts Receivable group and assign all personnel who perform client billing to that group. 

In a typical setup, you want to use Group Permissions only.  Group Permissions are easier to manage

than individual user permissions.

Field Descriptions 

Lock icon - When clicked, the InFocus Permissions Editor is opened. More on the InFocus Permissions

Editor

Group Name - Name of the Permission Group.

Enter New Line - Type in a Group Name here and click Save I to add a new Group.

4.12.7.3 Permission Editor (Pop-up)

Overview
When you click on the Lock icon next to either the Login or the Group Name, you will bring up the InFocus
Permissions Editor.  Here you can manage your Permissions.

4.12.7.3.1  General Tab

Overview 

The General Tab displays when the User/Group was created.  In User mode, the General Tab allows you to

manage User Status and Passwords. In Group Mode, you are able to edit the Group Name.
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Field Descriptions

User Mode (When you click the lock icon on the User Tab)

Created - Date and time user account was created. Informational only and cannot be modified.

Employee Code - Employee code assigned to this user account. Informational only and cannot be

modified here. More on Employees

Password Reset - This is where a user can change their passord.

o New Password - New user account password

o Confirm Password - Confirmation of new user account password

o Change Password - Commits the password change

Note - Click Save to save any changes made on this tab.

Group Mode (When you click the lock icon on the Group Tab)

Name - Contains the name of the group. (It can be changed here).

Created - Date and time that the group was created. Informational only and cannot be modified.

Note - Click Save to save any changes made on this tab.

4.12.7.3.2  Members (of) Tab

Overview 

The Members (of) Tab displays what members are in a User/Group.  In User mode, the Member of Tab

displays the Groups that the user is a member of. In Group Mode, the Members Tab displays the Users that

are included in the Group. 

Field Descriptions

User Mode (When you click the lock icon on the User Tab)

Member - When checked, the User is a member of the selected Group.

Group - The name of the group. (It can be selected here).

Note - Click Save to save any changes made on this tab.
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Group Mode (When you click the lock icon on the Group Tab)

Is Member - When checked, the User is a member of the selected Group.

Username - The Username of the Employee. More on Employees

Employee Code - The Code of the Employee. 

Employee Name - The Proper Name of the Employee. 

Note - Click Save to save any changes made on this tab.

Overview
The Members Tab.  This tab contains a list of all users setup in the system. Information cannot be modified
on this box.

Location - How to assign Members to a Group:

Step 1 - Go to the Permissions Applet located in the Administration Module. Click on the Groups Tab.

Step 2 - Click on the Lock   located next to the "Admin" group. 

Step 3 -  A "Permissions for Administrators" box will pop up. Click on the Members Tab.

Step 4 - Check the Is Member box next to the desired users to be included in the group, and click Save.

Is Member - When checked, this user is a member of this group.
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Overview 

Members Of Tab.

Location - Use the path given in the Users’ Overview section of the manual. First, click on the lock. Next, a
pop-up box (illustrated below) called InFocus Permissions for "User Name" will appear (descriptions below).

  

Description - This tab will contain a list of all users setup in the system. Information cannot be modified
on this box.

Is Member - When checked, this member is a part of this group.

Click Save to save any changes.

4.12.7.3.3  User/Group Permissions Tab

Overview 

 The User Permissions Tab contains permissions for every applet organized by module. 

Key Concept

Depending on whether you access this tab through Users or Groups, it will be named accordingly; User

Permissions from the Users Tab and Group Permissions from the Groups Tab.

Field Descriptions

Columns

View -  When checked, a User can View the item.

Edit -  When checked, a User can Edit an existing item.

Add -  When checked, a User can Add a new item.

Delete -  When checked, a User can Delete an existing item.

Special Rights - Within some applets special rights may exist. To view "Special Rights" go to the Special

Rights section of this manual. 

Set... For... To...

Description - Permissions can be set quickly for a module or all applets in the system from the General tab in

the user and group pop-ups. The mass setting fields are as follows:

Set - This drop-down gives the user a choice of which standard right to set, as well as an All option.



InFocus User Manual - Current (v2020)644

© 2020 Clearview Software, Inc.

For - This drop-down gives the user a choice of which module to set, as well as an All option.

To - When checked, the rights are enabled, based on the Set and For options. Otherwise, the rights are

revoked.

Note - Click Save to save any changes made on this tab.

4.12.7.3.4  Impersonate Tab

Overview

The Impersonate tab provides the ability to support scenarios where one user needs to log into InFocus as
another.

Administrators can generate unique impersonation tokens which can then be used in the place of user
credentials at login.

Each generated token has a specified expiration.

Getting Started

To enable, an administer can click the lock box next to the user to be impersonated, and establish
impersonation settings for distribution.

At login, users with the Impersonation Token will find an option for Token Login exposed by clicking
advanced database options from the InFocus login screen.

Users will be prompted to provide the token. Once provided the user will re-click advanced database
options and click Login. 

That user will inherit all rights of the impersonated user for the duration of the current session and/or any
subsequent sessions logged in prior to expiration .

Field Descriptions

Expire Minutes - Sets the expiration of the generated token

Generate New Impersonation Token - Generates a new token

Impersonation Token - Generated token to be used at login

Copy (link) - Copies the token to your clipboard

Expiration - Timestamp set for the expiration of the generated token. Note, time refers to the internal clock
of the InFocus server, typically UTC.
Clear Token - Clears and the generated token and deactivates impersonation for the selected user
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4.12.7.3.5  Special Rights

Overview 

Special Permissions. To assign Special Permissions to both Users and Groups, follow the following steps:

User's Special Rights Location - Use the path given in the Users Overview section of the manual. Next,
click on the Lock icon. An InFocus permissions for Username box will pop up. Click the User Permissions
tab. The following graphic shows the Users’ Permissions pop-up.

Groups Special Rights Location - Next, click on the Lock icon. A Permissions for Administrators box will
pop up. Click the Group Permissions tab. The following graphic shows the User’s Permissions pop-up, which
looks similar to the Group Permissions Box. It is, however, labeled as Permissions for Administrators.

 Certain applets have special rights. 

 Special rights are specific permissions that cannot be properly ascertained with the standard Add, Edit,
View, and Delete rights.

 Special rights are additive in that they give the user or group more rights.

4.12.7.3.5.1  Activities

Overview

The following Special Rights can be applied.

Field Descriptions

Can Assign Other Employees - When checked, the user can assign Activities to other employees.
Without this right, employees can only create personal Activities.

4.12.7.3.5.2  A/R Collections

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can Override Project Leader - When checked, the user can limit project leaders to projects they are
assigned to.

4.12.7.3.5.3  Approver

Overview 
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Here are Special Rights that can be granted.

Field Descriptions

Can Force Approve - When selected, the user with this permission can Force Approve a Time Sheet
without completing the Line Item process. Note that this approves all line items on the time sheet.
Can Force Reject - When selected, the user with this permission can Force Reject a Time Sheet without
completing the Line Item process. Note that this rejects all line items on the time sheet.
Can Force Submit - When selected, the user with this permission can Force Submit a Time Sheet without
completing the Line Item process. Note that this submits all line items on the time sheet.

4.12.7.3.5.4  Automated Invoicing

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can Clear Invoice Sessions - Invoice sessions are run per user. If a user is running an invoice for a

project, he can tie up other users wanting to run the same invoice. When this box is checked, the user

can clear invoice sessions that other users are running within the system.

4.12.7.3.5.5  Bank Reconciliation

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can Modify Reconciled Statements - Gives the user the ability to reconcile statements.

4.12.7.3.5.6  Chart Of Accounts

Overview 

Here are Special Rights that can be granted.



InFocus Modules and Applets 647

© 2020 Clearview Software, Inc.

Field Descriptions

Execute Cash Conversion - When checked, the user can run Convert-to-Cash procedure.

4.12.7.3.5.7  Clients

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Edit UDFs - When checked, the user can define user-defined fields.

View Recent - When checked, the user can view recent client transactions.

4.12.7.3.5.8  Client Queries

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can View Private Queries - When checked, the user can view queries marked private.

Is Administrator - When checked, the user can create public and private queries.

  

4.12.7.3.5.9  Contacts

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Edit UDFs - When checked, the user can define user-defined fields.

  

4.12.7.3.5.10  Dashboard Groups

Overview 
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Here are Special Rights that can be granted.

Field Descriptions

Can set Default Layout - Allows the user to configure a default layout for a Dashboard Group

4.12.7.3.5.11  Disbursements Journal

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Allow Post Closing Adjustments - When checked, users can make adjustments to transactions in closed

periods that have been marked to Allow Adjustments in the Accounting Periods applet (GA>Accounting

Periods).

Can Override Expense Markups - Exposes markup fields so they can be overwritten

Can Override Linked Invoice - Exposes link to sales journal so it can be removed

Can Override X-rates - Exposes exchange rate (multi-currency) so it can be overwritten

Change Key Fields - Allows key fields (payee and check) to be modified

Change Period - When checked, the user can change the period of a transaction without leaving and an

trail

Change Period All Versions - When checked, the user can change the G/L Period for any version of the

journal entry

Edit Grid - When checked, the user can edit information in the grid if he does not already have the

Standard Edit right checked for the Disbursement journal. Not checking the Standard Edit, but instead

checking the Edit Grid right, allows Accounts Receivable personnel to modify transaction line items

without affecting the overall balance or header information of the transaction. When the Standard Edit is

already checked, the Edit Grid right is of no consequence.

Show/Post Unposted Transactions - When checked, the user can see and post all unposted transactions

regardless of user who entered transaction.

4.12.7.3.5.12  Employees

Overview 

Here are Special Rights that can be granted.
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Field Descriptions

Edit UDFs - When checked, the user can define user-defined fields.

Is Human Resources - When checked, all of the information in the Personal section of the Company tab

is visible. 

View Pay Rates - Allows the user to view pay rates.

4.12.7.3.5.13  Employee Reimbursables

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Allow Post Closing Adjustments - When checked, users can make adjustments to transactions in closed

periods that have been marked to Allow Adjustments in the Accounting Periods applet (GA>Accounting

Periods)

Can Delete Cash Posting Linked Items - When Credit Card Cash Posting is processed the system makes

a General Journal entry that is linked to individual E/R line items. When checked, this special right allows

the user to delete an E/R Line item associated with the General Journal cash entry

Can Override Expense Markups - Exposes markup fields so they can be overwritten

Can Override Linked Invoice - Exposes link to sales journal so it can be removed

Change Key Fields - Allows key fields (payee and check) to be modified

Change Period - When checked, the user can change the period of a transaction without leaving an audit

trail

Change Period All Versions - When checked, the user can change the G/L Period for any version of the

journal entry

Clear All Pending Expense Sheet Transactions - When checked, the user can delete any transactions

that have been flagged but not yet posted in the Generate Transactions process

Create Recurring Entries - When checked, the user can create an entry that is recurring for a given

number of cycles

Edit Grid - When checked, the user can edit information in the grid if he does not already have the

Standard Edit right checked for the Employee Reimbursable journal. Not checking the Standard Edit, but

instead checking the Edit Grid right, allows Accounts Receivable personnel to modify transaction line

items without affecting the overall balance or header information of the transaction. When the Standard
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Edit is already checked, the Edit Grid right is of no consequence.

Generate Expense Sheet Transactions - When checked, the user can create Employee Reimbursable

transactions from expense sheet transactions

4.12.7.3.5.14  Employee Queries

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can View Private Queries - When checked, the user can view queries marked private.

Is Administrator - When checked, the user can create public and private queries.

4.12.7.3.5.15  Expense Sheets

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Expense Sheet Administrator -  Gives the user Expense Sheet administrator rights. Expense Sheet
administrators can enter expense for other employees. They can create and modify Expense Sheet coverage
periods. They can also submit, approve, and reject any expense. In addition, they can navigate to expense
sheets from other employees.

4.12.7.3.5.16  General Journal

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Allow Post Closing Adjustments - When checked, users can make adjustments to transactions in closed

periods that have been marked to Allow Adjustments in the Accounting Periods applet (GA>Accounting

Periods)

Can Override X-rates - Exposes exchange rate (multi-currency) so it can be overwritten
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Change Period - When checked, the user can change the period of a transaction without leaving an audit

trail

Change Period All Versions - When checked, the user can change the G/L Period for any version of the

journal entry

Create Recurring Entries - When checked, the user is allowed to create an entry that is recurring

Show/Post Unposted Transactions - When checked, the user can see and post all unposted transactions

regardless of user who entered transaction

  

4.12.7.3.5.17  My Work Orders

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can Print Other Employee Work Orders - Allows the user to print other employee work orders.

4.12.7.3.5.18  Organizational Units

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Modify Org. Labels - When checked, the user can change the labels for organizational levels.

4.12.7.3.5.19  PA Bill Review

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Override Project Accountant Restriction - When checked, the Employee type of Project Accountant is not
required.
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4.12.7.3.5.20  PM Bill Review

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can Override Project Leader -  When checked, this gives the user the ability to override the project
leader.

4.12.7.3.5.21  PM Reports

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can Override PM leader restriction - When checked, the user can designate (or change) the PM Leader

field on any reports where Limit to PM Leader has been set. This right applies only to principals, project

managers, and project accountants.

Can View Sensitive Data - When checked, the user can view reports that are marked as containing

sensitive data.

4.12.7.3.5.22  Projects

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can Use Project Members Wizard - Gives the User/Group the ability to use the Project Members Wizard

located at Project Administration> Projects> Tools (Toolbar)> Project Members Wizard.

Deny Allowable Date Ranges - This Special permission denies access to the Allowable Date Ranges

option when Right-Clicking on the Project (PA> Projects>Project Explorer). 

Deny Charge Levels - This Special permission denies access to the Charge Levels option when Right-

Clicking on the Project (PA> Projects>Project Explorer).
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Deny Contract Levels and Caps - This Special permission denies access to the Contract Levels and

Caps option when Right-Clicking on the Project (PA> Projects>Project Explorer).

Deny Default Bill Status - This Special permission denies access to the Default Bill Status option when

Right-Clicking on the Project (PA> Projects>Project Explorer).

Deny Expense Markups/Codes - This Special permission denies access to the Expense Markups/Codes

option when Right-Clicking on the Project (PA> Projects>Project Explorer).

Deny Invoice Descriptions - This Special permission denies access to the Invoice Descriptions option

when Right-Clicking on the Project (PA> Projects>Project Explorer).

Deny Invoice Filters - This Special permission denies access to the Invoice Filters option when Right-

Clicking on the Project (PA> Projects>Project Explorer).

Deny Invoice Posting Groups - This Special permission denies access to the Invoice Posting Groups

option when Right-Clicking on the Project (PA> Projects>Project Explorer).

Deny Labor Code Groups - This Special permission denies access to the Labor Code Groups option

when Right-Clicking on the Project (PA> Projects>Project Explorer).

Deny Rate Schedules - This Special permission denies access to the Rate Schedules option when Right-

Clicking on the Project (PA> Projects>Project Explorer).

Deny Revenue Recognition/Profit Centers - This Special permission denies access to the Revenue

Recognition/Profit Centers option when Right-Clicking on the Project (PA> Projects>Project Explorer).

Deny Time Sheet Comment Templates - This Special permission denies access to the Time Sheet

Comment Templates option when Right-Clicking on the Project (PA> Projects>Project Explorer).

Edit UDFs - When checked, the user can define user-defined fields.

Modify Project Level Labels - When checked, the user can change the labels for project levels.

4.12.7.3.5.23  Project Central

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Addresses - Can Modify - Allows the user to modify the Address Tab

Bill Review - Can Change Bill Status - Allows user to change the bill status on transactions listed on the

Bill Review Tab

Bill Review - Can Move Transactions - Allows user to move transactions listed on the Bill Review Tab

Budget - Save as Baseline - Allows the user to save Budgets to baseline budget on the Budgets Tab

Can Manage Fields and Formulas - Allows the user to manage Fields and Formulas on the Overview Tab
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Can Use System Chart-Packs - Allows the user to work with system Chart-Packs in Project Central

Contacts - Can Modify - Allows the user to make modifications on the Contact Tab 

Contract - Can set amount - Allows the user to set contract amounts on the Contract Tab

Contract - Can Set Contract=Budget - Allows the user to set contracts equal to budgets from the Contract

Tab

Contract - Can Set Level - Allows the user to set contract levels on the Contract Tab

Contract - Can Set Percent Complete - Allows the user to set percent complete amounts on the Contract

Tab

Team Members - Can Modify - Allows the user to modify team members

4.12.7.3.5.24  Project Planning

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Approve Change Orders - When checked, the user can approve change orders.

Can Edit Project Details when NOT Plan - When checked the user can edit the details of a Project with a

charge type not equal to Plan. Access to edit details extends to the following:

o Project Planning Edit (pencil) icon

o Project Central Settings button located on the toolbar

Can Edit Project Details when Plan - When checked the user can edit the details of a Project with a

charge type equal to Plan. Access to edit details extends to the following:

o Project Planning Edit (pencil) icon

o Project Central Settings button located on the toolbar

Edit Budgets on All Projects - When checked, the user can modify budgets on direct and indirect projects

without issuing a change order.

Save Baseline - When checked, the user has permission to save a plan as a baseline.

4.12.7.3.5.25  Project Queries

Overview 

Here are Special Rights that can be granted.
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Field Descriptions

Can View Private Queries - When checked, the user can view queries marked private.

Is Administrator - When checked, the user can create public and private queries.

4.12.7.3.5.26  Purchasing Special Rights

Field Descriptions

Below is a list of special rights for applets found in the Purchasing module.

Can create Purchase Journal - Enables Convert to Purchase Journal toolbar button

Can issue Purchase Order - Enables the Issue toolbar button

Can set Not Received - Allows the user to edit line-item receipt status

Can set Received - Enables the Received toolbar button

Can cancel a Purchase Order - Enables the Cancel toolbar button, allowing the user to cancel an Issued

Purchase Order.

Can edit after Issued - Allows a user to edit the Purchase Journal after it has been issued for fulfillment

Can Override X-rates - Allows a user to manually override exchange rates for multi-currency environments

Change Key Fields - Allows a user to change required fields on a Purchase Order after it has been Issued

Edit Grid - When checked, the user can edit information in the grid if he does not already have the

Standard Edit right checked for the applet. Not checking the Standard Edit, but instead checking the Edit

Grid right, allows personnel to modify transaction line items without affecting the overall balance or header

information of the transaction. When the Standard Edit is already checked, the Edit Grid right is of no

consequence.

4.12.7.3.5.27  Purchase Journal

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Allow Post Closing Adjustments - When checked, users can make adjustments to transactions in closed

periods that have been marked to Allow Adjustments in the Accounting Periods applet (GA>Accounting

Periods)

Can Override Expense Markups - Exposes markup fields so they can be overwritten

Can Override Linked Invoice - Exposes link to sales journal so it can be removed
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Can Override X-rates - Exposes exchange rate (multi-currency) so it can be overwritten

Change Key Fields - Allows key fields (payee and check) to be modified

Change Key field - When checked, the user can change the transaction key fields, as well as the vender

and invoice number

Change Period - When checked, the user can change the period of a transaction without leaving an audit

trail

Change Period All Versions - When checked, the user can change the G/L Period for any version of the

journal entry

Create Recurring Entries - When checked, the user can create an entry that is recurring for a given

number of cycles

Edit Grid - When checked, the user can edit information in the grid if he does not already have the

Standard Edit right checked for the applet. Not checking the Standard Edit, but instead checking the Edit

Grid right, allows personnel to modify transaction line items without affecting the overall balance or header

information of the transaction. When the Standard Edit is already checked, the Edit Grid right is of no

consequence.

Show/Post Unposted Transactions - When checked, the user can see and post all unposted transactions

regardless of user who entered transaction

4.12.7.3.5.28  Rate Tester

Overview 

Here are Special Rights that can be granted.

Field Descriptions

View Pay Rates - Allows the user to view pay rates when using the Rate Tester.

4.12.7.3.5.29  Receipts Journal

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Allow Post Closing Adjustments - When checked, users can make adjustments to transactions in closed

periods that have been marked to Allow Adjustments in the Accounting Periods applet (GA>Accounting
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Periods)

Can Override X-rates - Exposes exchange rate (multi-currency) so it can be overwritten

Change Key Fields - Allows key fields (payee and check) to be modified

Change Period - When checked, the user can change the period of a transaction without leaving and

audit trail

Change Period All Versions - When checked, the user can change the G/L Period for any version of the

journal entry

Show/Post Unposted Transactions - When checked, the user can see and post all unposted transactions

regardless of user who entered transaction

  

4.12.7.3.5.30  Report Management

Overview 

The special rights listed here give design rights to the various reports in the system. These reports do not
include reports designed under the specialty designers: invoices, project management reports, and financial
statements. When checked, the Users and Groups are given design permissions to the following reports:

Field Descriptions

A/P Check

A/P Check Labels

A/P Long Stubs

Accounts Payable Reports

Accounts Receivable Reports

Data Dictionary

Disbursement Journal Reports

E/R Check

E/R Check Labels

E/R Long Stubs

Employee Reimbursable Journal Reports

Expense Sheet

Form 1099

Form 1099 Labels

General Journal Reports

General Ledger Reports
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Invoice Labels

Manual Check

Pay When Paid Reports

Purchase Journal Reports

Receipt Journal Reports

Sales Journal Reports

Time sheet

Time Utilization Reports

Trial Balance

4.12.7.3.5.31  Sales Journal

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Allow Post Closing Adjustments - When checked, users can make adjustments to transactions in closed

periods that have been marked to Allow Adjustments in the Accounting Periods applet (GA>Accounting

Periods)

Can Add Linked Transactions - Allows the ability to link transactions to a Sales Journal entry

Can Delete Linked Transactions - Allows the ability to remove a linked transaction from the Sales Journal

Can Override X-rates - Exposes exchange rate (multi-currency) so it can be overwritten

Change Key Fields - Allows key fields (payee and check) to be modified

Change Key field - When checked, the user can change the transaction key fields, as well as the client

and invoice number

Change Period - When checked, the user can change the period of a transaction without leaving an audit

trail

Change Period All Versions - When checked, the user can change the G/L Period for any version of the

journal entry

Create Recurring Entries - When checked, the user can create an entry that is recurring for a given

number of cycles

Show/Post Unposted Transactions - When checked, the user can see and post all unposted transactions

regardless of user who entered transaction
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4.12.7.3.5.32  Time Sheets

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Timesheet Administrator -  When checked, Time Sheet administrators can enter time sheets for other

employees. They can create and modify time sheet coverage period. They can also submit, approve, and

reject any time sheet. In addition, they can navigate to time sheets from the Employee Setup Recent tab.

 

4.12.7.3.5.33  Timesheet Adjustments

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can Access Overrides - When checked, the user can override system-calculated information such as

rates.

Can Modify Original Totals -  When checked, the user can modify the timesheet in such a way that the

worked hours and pay amount is different than the original version.

Can See Pay Rates - When checked, the user can see pay rates.

Delete version 1 Timesheets -  When checked, the user can delete the original version of the timesheet

leaving no record of the timesheet.

4.12.7.3.5.34  Vendors

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Edit UDFs - When checked, the user can define user-defined fields.
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View Recent - When checked, the user can view recent vendor transactions.

4.12.7.3.5.35  Vendor Queries

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can View Private Queries - When checked, the user can view queries marked private.

Is Administrator - When checked, the user can create public and private queries.

4.12.7.3.5.36  Work Orders

Overview 

Here are Special Rights that can be granted.

Field Descriptions

Can Print Other Employee Work Orders - Allows the user to print other employee work orders.

4.12.8 Project Roles

Overview 

The Project Roles applet allows you give other members of the same project access similar to the standard

Project Roles (Project Manager, Principal-in-Charge, and Project Accountant).

Key Concepts

The Project Roles applet allows you give other members of the same project access similar to the

standard Project Roles (Project Manager, Principal-in-Charge, and Project Accountant). For Example, you

may want to have two members of a project have Project Manager Rights.  You can do this by going to

Project > Members > Team Members.  

When you assign members, you can assign a “Role” to a member that has the same access as a Project

Leader.  

Project Roles are first created under Administration>List Management and are managed in the Project
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Roles applet.

Field Descriptions 

Role Window

Role - Displays all Project roles that have been created in List Management. More on List Management

Applets Tab

Description - This Tab allows you to grant PM access to the different applets throughout the system.

Act as PM - When checked, anyone assigned to this Role will have Project Manager access to this item.

Name - Name of the Applet that PM access is granted to.

PM Reports Tab

Description - This Tab allows you to grant PM access to the different PM Reports throughout the system.

Act as PM - When checked, anyone assigned to this Role will have Project Manager access to this item.

Name - Name of the PM Reports that PM access is granted to.

Custom Reports Tab

Description - This Tab allows you to grant PM access to the different Custom Reports throughout the

system.  

Note - Custom reports MUST have the "Use in Project Roles" check-box checked in order for them to appear

in this list.

Act as PM - When checked, anyone assigned to this Role will have Project Manager access to this item.

Name - Name of the Custom Reports that PM access is granted to.

Alerts Tab

Description - This Tab allows you to grant PM access to the different Alerts throughout the system.

Act as PM - When checked, anyone assigned to this Role will have Project Manager access to this item.

Name - Name of the Alerts that PM access is granted to.

Queries Tab

Description - This Tab allows you to grant PM access to the different Queries throughout the system.

Act as PM - When checked, anyone assigned to this Role will have Project Manager access to this item.

Name - Name of the Queries that PM access is granted to.

Widgets Tab

Description - This Tab allows you to grant PM access to the different Widgets throughout the system.
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Act as PM - When checked, anyone assigned to this Role will have Project Manager access to this item.

Name - Name of the Widgets that PM access is granted to.

Processes Tab

Time Sheet Line-Item Approval - Designates the role can approve/reject Time Sheets governed by Project

Leader approvals

Expense Sheet Line-Item Approval - Designates the role can approve/reject Expense Sheets governed

by Project Leader approvals

4.12.9 UDF Designer

Overview  

User-definable fields (UDFs) can be created for Clients, Employees, Vendors, Projects, Project Level2 and
Contacts.  UDFs are used to create important information that you would like to collect and associate with
one of the previously listed applets.  

A UDFs Designer allows you to create UDFs that will be used in the Clients, Employees, Vendors, Projects,
Project Level2 and Contacts applets.  You can access the UDFs Designer in 2 places:

1) A dedicated applet located at Administration>UDFs Designer.

2) On the toolbar in the Clients, Employees, Vendors, Projects and Contacts applets, there is a toolbar
button labeled UDFs Designer.  When you click on the UDFs Designer in the specific applet, the focus of
the designer will be on the UDF for that specific location.

To see a list of the UDFs that have been created, go to the respective applets and click on the "Custom
Fields" Tab.  The label of the "Custom Fields" Tab can be changed at Administration>Global Settings>UDF
Tabs. UDFs can also be used in conjunction with the Layout Manager to incorporated them into the main
tabs of the applets.

Note:  Project Level2 UDFs are accessed by right-clicking on the WBS node of the project and selecting
"Sub Level UDFs". There you can Create, Edit and Enter data into them.   Project Level2 UDFs are not
available on the Custom Tabs nor are they available in the Layout Manager.

Field Descriptions

The following fields are located on the UDFs pop-up.

Label - This is the field label that will appear on the form next to the field.

Name -  This is the name of the field as it will appear in the associated UDF table in the database. Names
cannot include punctuation marks (including spaces).

Data Type -  Type of data that is expected:  Character, Integer, Numeric, Boolean (True/False), Date,
Date Time (includes both date and time), Long Text, Bill Status, Client, Employee, Expense Code, G/L
Base Code, Labor Code, Org Unit, Project and Vendor.
o Note: Bill Status, Client, Employee, Expense Code, G/L Base Code, Labor Code, Org Unit, Project
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and Vendors all give you selections from the respective areas when selected. For example, if you use
a Data Type of Employee, the UDF will be a look-up containing the list of Employees.

Default - Default value for new records (optional).

Min - Minimum allowed value (optional).

Max - Maximum allowed value (optional).

List - UDF List to use for quick entry. UDF Lists must be created before you create a UDF. To see UDF
lists, look at the top of the UDF pop-up. You will see a tab labeled UDF Lists.

Validation Script - A field has been added to the UDFs called Validation Script. The purpose of this field is
to validate the value entered into the UDF field via SQL script. The script can use two variables:

^udfvalue^ (the value being validated) and ^keyid^ (the primary key of the record holding the udf)
o The SQL script must return at least three values:

reterr (>=0 equals no error, <0 equals error)
retmsg (the error message if reterr <0)
retvalue (this can either be the same as the value passed in or it can be a new value. In either
case, whatever is returned will be the value in the UDF field.

Display Format - Display Format controls the output format of the UDF. Here is a list of a few built in
formats that can format data. Just put the number and the brackets (ex. {1} ) in the column and hit save. 
The result will show the ID.
o {1} - ID 
o {2} - Code 
o {3} - Name Path 
o {4} - LongName
o Date, Currency and Numeric formats are supported.

4.12.9.1 UDF Lists Tab

Overview 

UDF Lists provide drop down lists for UDF fields. Lists are not restrictive in that a user can still enter a value
that is not contained in the list. Lists for UDFs are managed here.

Key Concepts

UDF Lists need to be created before any UDF that will be using a List.

Field Descriptions 

System Lists Management Window
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Lists Text Box - The Lists Text Box is used to create a list. Enter a list name in the Lists box, and click

Add. That will create the Named List. You will still need to go to the "Static List" or "SQL List" on the right

to populate the list.

Static List - The Static List allows you to enter the options that you would like to see in the drop-down.

For example, If the UDF was named State, your Static List could be ME, NC, VA, etc.

SQL List - The SQL List allows you to enter a query that will return the selections in the UDF List. For

example, If you wanted a list of States from the List Management list, you could use the following SQL

Query:

Select 
DisplayText=StateName,
DisplayValue=StateCode

From 
PostalStates

Note - You must alias the fields that you want to use with DisplayText (What you see in the drop-down) and
DisplayValue as you see above.

Preview - Allows you to see what the returned fields will look like in the query.

4.12.9.2 UDF Fields Tab

Overview 

The UDF is where all UDFs are managed.

Field Descriptions 

Label - This is the field label that will appear on the form next to the field.

Name -  This is the name of the field as it will appear in the associated UDF table in the database. Names

cannot include punctuation marks (including spaces).

Data Type -  Type of data that is expected. Choices include Character (text), Integer, Numeric, Boolean

(true/false), Date, and Date Time (includes both date and time).

Default - Default value for new records (optional).

Min - Minimum allowed value (optional).

Max - Maximum allowed value (optional).

List - UDF List to use for quick entry. More on UDF Lists

Validation Script - A field has been added to the UDFs called Validation Script. The purpose of this field is

to validate the value entered into the UDF field via SQL script. 

o The script can use two variables:

^udfvalue^ (the value being validated) 
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 ^keyid^ (the primary key of the record holding the udf)

o The SQL script must return at least three values:

reterr (>=0 equals no error, <0 equals error)

retmsg (the error message if reterr <0)

retvalue (this can either be the same as the value passed in or it can be a new value. In either

case, whatever is returned will be the value in the UDF field.

Display Format - Display Format controls the output format of the UDF. Here is a list of a few built in
formats that can format data. Just put the number and the brackets (ex. {1} ) in the column and hit save. 
The result will show the ID.
o {1} - ID 
o {2} - Code 
o {3} - Name Path 
o {4} - LongName
o Date, Currency and Numeric formats are supported.

4.12.10 UDF Table Designer

Overview  

User-definable (UDFs) Tables can be created for Clients, Employees, Vendors, Projects, Project Level2 and
Contacts.  UDF Tables are used to create tables to hold important information that you would like to collect
and associate with one of the previously listed applets.  

The UDF Table Designer helps you create a UDF Table that can then be used in the standard UDF as an
interface   to hold data and A UDFs Designer allows you to create UDFs that will be used in the Clients,
Employees, Vendors, Projects, Project Level2 and Contacts applets. 

Field Descriptions

Toolbar
The following fields are located on the UDF Tables Toolbar

Import Table - The Import Table button allows you to import an already existing z_ table into the UDF
Table Manager. Note: All custom tables must have a pre-fix of z_ so that they do not get deleted during a
version upgrade. 
New - Creates a New UDF Table

Save - Saves the current progress of the UDF Table you are working on.

Delete - Deletes the Currently selected UDF Table. Note: This action cannot be undone!

Workspace
The following fields are the fields available in the UDF Table Workspace.

Tables - List of the UDF Tables that have been created and/or imported.

Display Name - The Name that will appear when selecting the UDF Table in the UDF Designer and the
Layout Manager.
Database Name - The Name of the Table as seen from the Database (ie. The name you would use when
writing a query for this table).

Columns Tab
Name - This is the name of the field as it will appear in the associated UDF table in the database. Names
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cannot include punctuation marks (including spaces).
Caption -  This is the field label that will appear on the form next to the field.

Data Type -  Type of data that is expected:  Character, Integer, Numeric, Boolean (True/False), Date,
Date Time (includes both date and time), Long Text, Bill Status, Client, Employee, Expense Code, G/L
Base Code, Labor Code, Org Unit, Project and Vendor.
o Note: Bill Status, Client, Employee, Expense Code, G/L Base Code, Labor Code, Org Unit, Project

and Vendors all give you selections from the respective areas when selected. For example, if you use
a Data Type of Employee, the UDF will be a look-up containing the list of Employees.

Size - Size of the Datatype (optional). Used to limit the size of the data that can be entered. 

Identity - ID Field. This is used to create a unique key value for this table.

Hidden - When checked, the column will be hidden when used.  Typically this is checked with an Identity
column.
Allow Null - Allows a blank value to be stored in the field.

Cascade Action - When the value is linked to another objetc (for example, Project, Employee, etc.) The
behavior of what you want the cell to store.
Applet Key Field - When checked, the grid will filter by the pulled up record in the location that the UDF
Table is used.  For Example, If this is used to record certifications per employee, you will check this box
so that you will only see the records for the Employee that you are looking at.
Default Value - Default value for new records (optional).

Read Only - When checked, this value cannot be edited.

Required - When checked, the field will require a value when saving.

Auto Sum - When selected, a sum will be displayed for this column.  

Multi Line - Allows the cell to have multiple text line in the Layout Manager.

Data Tab
The Data Tab is where you establish the "Edit-ability" you want users to have with the Table, Additionally,
you can view the data that currently exists in the table.

Allow Insert - Allows users to insert a new data row into the table.

Allow Update - Allows users to update current data that exists in the table.

Allow Delete - Allows users to delete data rows from the table.

Fit Column - Stretches the table to fill up all of the remaining space in its current location.

Load Data - Loads the current contents of the grid.

Update Gridget - After creating the Columns and setting the Edit-ability, click "Update Gridget" to build the
Gridget with the correct columns and settings.

Steps to Creating & Using UDF Tables
1. Create a UDF Table - Using the UDF Table Designer, create the UDF Table to the specifications of what

you need.
2. Create a UDF - Create a UDF Field in the area that you want to use it. The UDF has to have a Data Type

of Gridget and you must select the Table you just created in the "Gridget" column.
3. Use the Layout Manager to insert the UDF Table into the location that you would like to use it.

4.12.11 User Sessions

Overview

User Sessions allow InFocus administrators to view login history and associated activity for users in InFocus.

While, this feature is most useful for determining who's logged in at a given time, the applet can be

configured to allow further insight to a user's session history and per-session events.  More on User Sessions

https://support.clearviewsoftware.net/articles/5419
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Setup

Description - By default, permissions to this applet are not allowed. Please ensure the following

configurations to deploy this applet.

Permissions

Description - Check the appropriate permissions via Administration>Permissions. As a best practice, these

administrative features should only be allowed to those in an administrator group.

Global Settings

Description - Once permissions have been granted, please review and configure the following Global Settings

as appropriate via Administration>Global Settings>General Tab.

Field Definitions

Enable Sessions - Enables the Session History pane which reflects a login history for a selected user

Enable Session Detail - Enables the Session Events pane which reflects the events of a selected session

Cycle - Sets the Auto-Refresh cycle time frame in seconds (e.g. 60 = Applet refreshes each minute).

Tutorial

Description - Administrators with appropriate configuration, can view an event-level history of an InFocus

User.

Browse to Administration>User Sessions. At a minimum, the Users pane will display each users login

status and last check-in.

To view the Session History for the listed User: Select a User from the list by clicking the row. The

selected user's Session History will be displayed.

To view the events of a given session: Select the Session in the Session History Tab. The events of that

session will display in the Session Events tab.

User Session Field Definitions

User Sessions Toolbar
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Refresh - Clicking this refreshes the applet

Purge Inactive Session History - Click to remove the history of inactive users listed in the Users Pane.

Purged History cannot be rebuilt.

Session Tracking Enabled label - Reflects Global Settings configuration Enable Sessions (described

above)

Session Events Enabled label - Reflects Global Settings configuration Enable Session Detail (described

above)

Users Pane

Grid Fields

Description - Below is a list of required fields in alphabetical order. Additional fields can be added/removed

from the detail using the column chooser (gear icon) in the upper left of the detail grid. All fields can be

reordered in the grid.

Logged In - Reflects the user's logged in status

User Name - User Name

Standard Column Fields

Description - Fields can be selected using the column chooser (gear icon) in the upper left of the detail grid.

Active Sessions - Number of active sessions for the user. While typically this will be 1, users can be

logged into multiple InFocus sessions at once.

Code - InFocus Employee Code associated with the user

IPAddr - IP Address associated with the user session

Last Check In - Last reported check for all user sessions

Last Seen - Difference between the last reported check in and the current date/time

Machine Name - Computer name associated with the user session

Name - InFocus Employee Name associated with the user

OSVer - Version of operating system for the computer associated with the user session

Session Last Report - Date of last session report

Session Start - Date the session started

Session History Pane

Description - Below is a list of required fields in alphabetical order. Additional fields can be added/removed

from the detail using the column chooser (gear icon) in the upper left of the detail grid. All fields can be

reordered in the grid.

Grid Fields

Active - Reflects if the selected user's session is active
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Session ID - Internal ID counter of the user's session history

Start (UTC) - Start time of the session

Standard Column Fields

Description - Fields can be selected using the column chooser (gear icon) in the upper left of the detail grid.

Computer - Computer name associated with the session

IP - IP Address associated with the session

Is Active - Reflects if the selected user's session is active

Last Report (UTC) - Last reported check in for the individual session

OS Version - Version of operating system for the computer associated with the session

Session Code - Unique code for the session

Session Events Pane

Description - Below is a list of required fields in alphabetical order. All fields can be reordered in the grid.

Grid Fields

Applet - InFocus applet associated with the event

Event type - Event reported

o Load - Applet load

o Open - InFocus Opened

o Close - InFocus Closed

Date - Date stamp of the event
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5 InFocus System Reports

Overview

InFocus comes with many reports embedded in the application.  The following chapters show you how to find

those reports and gives a brief explanation of the reports. Don't see what you want, visit the Clearview

Marketplace.

Custom Reports

This designer allows the end user to construct their custom reports that will be housed in the application

and will appear on InFocus menus. Knowledge of SQL is required. 

Note - For more information about Custom Reports, see the Custom Reports section of this manual.

Project Management Reports

Project management reports are project-based. Only data related to projects are available. 

Note - For more information about PM Reports, see the PM Report Designer section of this manual.

Report Management Reports

All reports not covered under one of the three specific report designers are called standard reports.

Examples of standard reports are journal reports, general ledger reports, utilization reports, checks, etc.

All standard reports can be copied and modified using the Report Management applet. You cannot modify

the original report, but you can mark it inactive.

Note - For more information about Standard Reports, see the Report Management section of this manual.

Financial Statements

Financial statement designer provide for very flexible statement generation. Balance sheets, profit & loss

(consolidated and by profit center), and other statements can be created here. The basic premise is that

and group of G/L accounts can be combined to appear on a financial statement design. 

Note - For more information about Financial Statements, see the Financial Statement Designer section of

this manual.

https://support.clearviewsoftware.net/articles/5412
https://support.clearviewsoftware.net/articles/5412
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5.1 Custom Reports

Overview 

Custom Reports are miscellaneous reports that can be used throughout the system. Custom Reports reside

in InFocus at Utilities>Custom Reports.

Key Concepts

Here is a video that takes a deeper look into running InFocus reports: More on Running InFocus Reports.

 If you do not see what you want you can search the InFocus Marketplace or Submit a Custom Work

Request through the Request Custom Work button at the Clearview Support Website.

5.1.1 Custom Report Descriptions (System)

Overview  

Here are the system Custom Reports with a brief description. 

Report Descriptions

Account Inquiry by Date - The Account Inquiry By Date Report allows you to look at all transactions that

go against the Sales Journal, Purchase Journal, Employee Reimbursables Journal, Receipt Journal (cash

and accrual), Disbursement Journal(cash and accrual), General Journal for a particular Date Range.

Account Project Inquiry by Date - The Account Project Inquiry By Date Report allows you to search

against all transactions that go against the Sales Journal, Purchase Journal, Employee Reimbursables

Journal, Receipt Journal, Disbursement Journal, General Journal for a particular Date Range, Grouped by

Project.  The second level of detail groups on the Client, Employee or Vendor.  

Accounting Timesheet – The Accounting Timesheet Report report reflects the most current version of the

time sheet, reflecting any changes made in Timesheet Adjustments. The layout is similar to what you see

in the Time Sheets applet for a specific Time Sheet Period End date.

Accounts Payable By Project - The Accounts Payable by Project Report gives you a list of unpaid vendor

invoices grouped by Project. Additionally, you are given the ability to see all AP by selecting the "Include

Closed Invoices" option.  In that case it displays both paid and unpaid invoices (i.e. the entire history).

https://support.clearviewsoftware.net/articles/5379
https://support.clearviewsoftware.net/marketplace
https://support.clearviewsoftware.net/client
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This report uses the G/L period as the cutoff period so it is basically inception to date. 

Accounts Payable Check Batch Report - The Accounts Payable Check Batch report allows you to print

the details of a check batch from AP Check Writing after the batch has been saved using the "Save to

Batch" option located on the toolbar.

Aged WIP - The Aged WIP Report gives you an Aging list of transactions with a Bill Status of R (Ready to

Bill) and H (Hold) that go against Billable (and optionally Opportunities) projects.  This report displays five

aging periods that are fixed. Additionally, you have the ability to "Drill-through" to the individual

transactions.

Balance Sheet (Rolling 12 Month) - The Balance Sheet (Rolling 12 Month) Report is a statement of the

companies financial position, which states the Assets, Liabilities and Owner's Equity (Capital) for a 12

month period (G/L Period). When you select a G/L Period, that period, and the prior 11 periods, are

displayed on the report.  Additionally, you are given the ability to see all "drill-down" into each account on

the report.  The blue hyperlink indicates where you can do this. 

Balance Sheet with Drill down – The Balance Sheet with drill-down Report is a statement of the

companies financial position, which states the Assets, Liabilities and Owner's Equity (Capital) at a

particular point in time (G/L Period). Additionally, you are given the ability to see all "drill-down" into each

account on the report.  The blue hyperlink indicates where you can do this. 

Bank Register By Date Report - The Bank Register by Date Report is a data sensitive report providing a

running balance of a single bank account.  There are four different report styles to choose from that sort

and group by By Date, By Journal/Date, By Journal/Control Number, By Journal/Control Number/Date. 

You can optionally select which journals to include.  

Benefit Accrual Status Report - The Benefit Accrual Status Report gives you the benefit amounts for the

selected Benefit Project in the current Beneft Year.

Bill Review - The report must be enabled in Global Settings in the A/R tab to enable this feature. This

report provides the necessary information for project managers to determine billing.

Bill Review Batch - The Bill Review Report provides the necessary information for project managers to

determine billing.This report is the same as the Bill Review Report, but can be run in batches.

Billing Status - The Billing Status report allows you to search through all transactions that can have a

billing status (Time Sheets, Purchase Journal, Employee Reimbursable Journal and the Disbursement

Journal) for a specified date range.  You are given the option to filter by Project, Journal and Billing

Status.

Billings - The Billings Report gives you Hourly, Fixed Fee, ODC, OCC, ICC, Retainer, Retainage and
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Other revenue numbers for a specified Period Range.

Billings by State -The Billings by State report receipts broken down by Sales Revenue, grouped by State

for a selected Period Range. 

Budget Backlog Report - The Budget Backlog is a report that compares Budget Amounts

(Labor,ODC,OCC & ICC) to Billed and Unbilled WIP (billing status of R or H).

Cash Requirements Report – This report allows you to run an outstanding Payables report, filtering by a

Due Date range.

Change Orders - The Change Orders Report shows all Change Orders (approved/unapproved) that have

been submitted against all projects (active/inactive) for a given date range. Note: Change Orders are

Requested in Project Planning> Projects window.

Change Transaction Period Utility - The Change Transaction Period Utility is used to move a specific

Journal Transaction from one G/L Period to another.  You can optionally select a single version or move

all versions to the new G/L Period.

Charge Organization Analysis – This report allows you to do an analysis of the charge org recorded in

time sheets versus what the system currently would assign based on project setup rules.  This report has

an option so you can retroactively update time sheets.   This report is useful if you set up the project rules

after time sheets have already been entered.

Clients - The Firms report gives you a list of Firms with additional contact information.

Client Inquiry - This report displays both A/R and non-A/R transactions per Client.  Options are available

to display varying levels of detail such as project, WBS, invoice number and transaction detail.  You can

also run the report for open invoices only.  If you do not supply a Client code it runs for all Clients.

Client Pay Performance – This report shows that average number of days it takes for a client to pay an

invoice.  You can set a minimum number of invoices required before a client appears on the report.

Consultant Tracking by Project then Sales Invoice - Unlike the Pay When Paid report only consultant

charges that have been linked to a Sales Journal entry are included. Also, only A/R invoices with links to

consultant purchases are included. 

Consultant Tracking by Project then Vendor - Unlike the Pay When Paid report only consultant charges

that have been linked to a Sales Journal entry are included. Also, only A/R invoices with links to

consultant purchases are included. 

Consultant Tracking by Vendor then Project - Unlike the Pay When Paid report only consultant charges

that have been linked to a Sales Journal entry are included. Also, only A/R invoices with links to
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consultant purchases are included. 

Contacts - The Contacts report gives you a list of Contacts with additional contact information.

Contract Backlog - The Contract Backlog is a report that compares Fixed Fee and Contract Amounts

(Labor,ODC,OCC & ICC) to Billed and Unbilled WIP (billing status of R or H). It automatically filters based

on project leader designation. Employees with the designation of Project Accountant can see all projects.

Currency Exchange Rates - The Currency Exchange Rates Report is used when using InFocus Muli-

Currency.The report gives you the Currencies currently configured in your system as well as the

"Currency Pairs" that are configured in your system This information comes from General Accounting>

Multi-Currency. More on Multi-Currency

Disbursement Journal Single Transaction Report - The Disbursement Journal Single Transaction Report

gives you the ability to sprint out a specific Disbursement Journal Entry for a specific Version.  When in

the Disbursement Journal applet, you can launch this report by simply clicking "Print" on the toolbar.  The

version showing is the one that will be displayed.  Additionally, if "Show Audit Trail" is checked, you will

see an audit trail of the changes made on that entry.

Disbursements by Date - The Disbursements By Date Report allows you to look at all transactions that

go against the Disbursement Journal(cash and accrual) for a particular Date Range.

Employee Benefit Report - The Employee Benefit Report give an employee a detailed summary of their

Benefit balances.  You must be using the Benefit Accrual feature for this to populate with data.

Employee Inquiry - This report is sorted by employee and allows for inquiry of time and expense for a

given date range. You can also set filters for an employee, project or labor code.

Employee Job Titles – The Employee Job Titles Report shows you the allowable Job Titles for your

employees, including the Default Job Title. This report can be run for all active employees or one

employee. Additionally, it points out Inactive Job Titles that are assigned to Employees. Group / Sort

options include by Employee Name or Job Title Name.  When run for a single project the report uses the

project member tab overrides otherwise it uses employee setup information.

Employee Reimbursable Journal Single Transaction Report - The Employee Reimbursable Journal Single
Transaction Report gives you the ability to sprint out a specific Employee Reimbursable Journal Entry for
a specific Version.  When in the Employee Reimbursable Journal applet, you can launch this report by
simply clicking "Print" on the toolbar.  The version showing is the one that will be displayed.  Additionally,
if "Show Audit Trail" is checked, you will see an audit trail of the changes made on that entry.

Employee Reimbursables by Date - The Employee Reimbursables By Date Report allows you to look at

all transactions that go against the Employee Reimbursables (E/R) Journal for a particular Date Range.

Expense Check Stub - This report is designed to be run by the employee who receives a check.  It will

detail what expense sheet items are being paid on a given check.  To make this available to all employees
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first give permissions to a group that includes all employees and then assign the report to appear in the

Personal module.

Expense Code Listing – This report lists all the Expense Codes set up in the system. You are able to filter

by Type, Status and by those only viewable in Expense Sheets. 

Expense Group Assignment – This report lists the Expense Groups with all Projects that are using that

Expense Group listed below.

Expense Group Detail – This report lists the expense group setup including expense codes and markups.

Expense Sheet Status Report - This report is designed to be run by the individual employee.  It will give a

status report on expense sheets for a given date range.  Possible statuses are paid, processed (imported

and approved by accounting but not yet paid), declined (rejected by accounting), mgr approved (approved

by manager), submitted (by employee), and unsubmitted. To make this available to all employees first

give permissions to a group that includes all employees and assign the report to appear in the Personal

module.

Financial Statement Analysis Report - This report is used to Analyze the structure of Financial

Statements built using the Financial Statement Designer. It displays three tables of information.  The first

table shows what accounts per statement line will be used.   The second table shows what accounts are

not referenced in the design.  The third table shows what lines reference an account more than once. 

Form 1099 Detail Backup - This custom report’s print options are identical to Form 1099’s load options. 

The report provides a detailed and summarized backup of the 1099’s.

General Journal by Date - The General Journal By Date Report allows you to look at all transactions that

go against the General Journal (cash and accrual) for a particular Date Range.

General Journal Single Transaction Report - The General Journal Single Transaction Report gives you the

ability to sprint out a specific General Journal Entry for a specific Version.  When in the General Journal

applet, you can launch this report by simply clicking "Print" on the toolbar.  The version showing is the

one that will be displayed.  Additionally, if "Show Audit Trail" is checked, you will see an audit trail of the

changes made on that entry.

General Ledger by Date - The General Ledger Report shows you the details of every transaction going in

and out of your accounts using a Date Range as a filter. This report can help ensure that all your

Accounts balance. 

Home Organization Analysis – This report allows you to an analysis of the home org recorded in time

sheets versus what the system currently would assign based on employee setup .  This report has an

option so you can retroactively update time sheets.  This report is useful if you set up the employee org
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after time sheets have already been entered.

Income Statement with Budgets - The Income Statement is also called a Profit and Loss Statement (P&L).

The purpose of the Income Statement is to show managers and investors whether the company made or

lost money during the reported period. Income Statements represent a period of time, whereas the

Balance Sheet represents a single moment in time.

Income Statement with Drill-Down – The Income Statement is also called a Profit and Loss Statement

(P&L). The purpose of the Income Statement is to show managers and investors whether the company

made or lost money during the reported period. Income Statements represent a period of time, whereas

the Balance Sheet represents a single moment in time. Additionally, you are given the ability to see all

"drill-down" into each account on the report.  The blue hyperlink indicates where you can do this. 

Inter company Transfers By Date - The Inter-company Transfers By Date report returns all Revenue from

the Sales & General Journals posted against G/L Accounts with a Metric Type of either Inter-company

Revenue or Inter-company Expense for a given date range.

Invoice For Retainage (Style 1) - The Invoice for Retainage is a way to invoice a client for retainage at the

end of the project. You have the option create a posting entry against the Retainage account in the Sales

Journal. Style 1 looks similar to the standard invoice designs that come "out of the box" with InFocus.

Invoice For Retainage (Style 2) - The Invoice for Retainage is a way to invoice a client for retainage at the

end of the project. By running the report, a posting entry is created against the Retainage account in the

Sales Journal. Style 2 looks similar to the Sales Journal Single Transaction report that come "out of the

box" with InFocus.

Job Titles – The Job Title list report give you a list of Job Titles that live in the Job Titles Applet The report

can be filtered by status and sorted by Job Code or Title. More on Job Titles

Labor By Location – The Labor by Location Report report reflects data the most current version of

submitted Time Sheets. The primary purpose of this report is to Filter/ Group by Locations that can

optionally be used. Locations are assigned to the Employee and are typically used to identify where the

actual work was done, for insurance reasons. More on Locations

Labor Code Listing – This report lists the labor codes set up in the system.

Labor Distribution Detail - This report shows the breakdown for labor distribution entries for a given G/L

period range. You are able to specify up to five (5) sorting/grouping levels.

Labor Estimates - This report requires that you have Require Estimates-to-Complete turned on in Projects

> General Tab. The report gives you the ETC hours the employee entered upon submitting their time

sheet.
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MC Consolidated Balance Sheet (FASB) - The MC Balance Sheet Report is a statement of the

companies financial position, which states the Assets, Liabilities and Owner's Equity (Capital) for a 

specific period (G/L Period). 

MC Revaluations Report - Journal report for MC Revaluations journal used when running Multi-Currency.

My Hours – This report is meant for access to be given all employees in the company.  It allows the

employee to list all their hours for any project date range they wish.

No Project Reference - Reports transactions with no project reference for a specified Time Frame, Journal

Type(s), Metric(s). Additional filters include G/L Account, Org Unit and G/L Financial Type (Income and

Expense or All). This report is useful when trying to tie out Project Profit to the Income Statement.

Transactions that do not reference a project can cause variance.

Note Search - This report searches the text of marketing notes.

Opportunities - The Opportunities Report gives you a list of Projects that have a Charge Type of

"Opportunity".

Pay History – This report shows employee pay history which can be useful when performing employee

reviews.

Pay When Paid By Project – This report is similar to consultant tracking with a few notable exceptions

besides format.  Purchases not linked on a sales journal will appear on the report.  There is an okay to

pay columns.  The okay to pay only applies to linked purchases and is based on monies received.  In the

case of partial payments, the receipts are prorated accordingly.  This report also considers the new

revenue type in cash receipts when computing consultant dollars received.

Pay When Paid By Vendor – Same as Pay When Paid By Project except sorted by vendor.

Pay When Paid By Receipt – This report operates off of a deposit date range. It requires that purchases

be linked to Sales Journal and requires that breakdown receipt by revenue type is used. A unique feature

of this report is it can create an A/P check batch based on the report's results.

Print a Check - The Print a Check Report allows you to Print a New Check or enter the previous check

number and re-print a check.

Project Earnings by Org. Unit – The Project Earnings by Org. Unit report gives Current, Year To Date and

Project To Date figures including Billed Revenue, Total Revenue, Spent, Profit, Profit Pct, Fee, Received,

A/R, Un-billed and Effective Multiplier. The project summary report can be grouped by organizational unit.

It also can filter based on a common org code at a given level.

Project Figures - Shows As of the Moment project metrics for a given project to all its WBS levels. It
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automatically filters based on project leader designation. Employees with a designation of Project

Accountant can see all projects. By default, this report shows labor cost as zero. To show labor cost,

make a copy of the report, then click Manage Parameters. Note the parameters and their details. Next,

click on the wand (  ). When prompted that previous parameters will be cleared out, click Yes. All exposed

parameters will be visible. Restore the details of the Project Path and My id parameters. Click Apply after

each. Change the prompt type of the Show labor cost report (at either Pay Rate or Job Cost Rate,

depending on the setting of the Calculate Labor Cost option (in the General Tab of Global Settings). 

Project Metrics for Project Managers - This is a summary level (project level) report that will display most

project metrics.  It is using a new SQL view called ev_projectmetrics_nolaborcost to make querying

simpler for summary type reports.  This view contains no labor cost.

Project Overhead Allocation Report - This report will show current period and year to date overhead

allocations by project and org unit.

Project Revenue by Type Report - The Project Revenue by Type report sorts and groups revenue by

Project Report Type or Market Sector.  Many clients use either the report type or the market sector to

identify the professional liability classification of a project.  In this scenario you can run the report YTD to

provide the necessary revenue breakdown.  When you run the report you can either view billed or

received.  If you run the report using received the system uses the cash basis conversion to break down

the receipts into its types of revenue (labor, ODC, OCC and ICC).  When you run the report by market

sector all metrics are factored by the market sector percentage entered on the project setup.

Project Scorecard - The Project Scorecard report gives you a comprehensive view of your project

performance. It has drill-downs and charts to help dig into your data.

Purchases by Date - The Purchases By Date Report allows you to look at all transactions that go against

the Purchase Journal for a particular Date Range.

Purchase Journal Single Transaction Report - The Purchase Journal Single Transaction Report gives you

the ability to sprint out a specific Purchase Journal Entry for a specific Version.  When in the Purchase

Journal applet, you can launch this report by simply clicking "Print" on the toolbar.  The version showing is

the one that will be displayed.  Additionally, if "Show Audit Trail" is checked, you will see an audit trail of

the changes made on that entry.

Rate Schedule Assignment – The Rate Schedule Assignments report lists what rate schedules are

assigned to what projects.

Rate Schedule Detail – The Rate Schedule Detail report lists the rate schedule setup including

employees and job titles assigned and rates.

Receipts by Date - The Receipts By Date Report allows you to look at all transactions that go against the
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Receipt Journal (cash and accrual) for a particular Date Range.

Receipts by State - This report will show receipts for a given period of time by State as listed on the

Project Address.

Receipt Journal Single Transaction Report - The Receipt Journal Single Transaction Report gives you the

ability to sprint out a specific Receipt Journal Entry for a specific Version.  When in the Receipt Journal

applet, you can launch this report by simply clicking "Print" on the toolbar.  The version showing is the

one that will be displayed.  Additionally, if "Show Audit Trail" is checked, you will see an audit trail of the

changes made on that entry.

Revenue Analysis - The Revenue Analysis report returns revenue transaction in detail and summarized at

the WBS level. It automatically filters based on project leader designation. Employees with the

designation of Project Accountant can see all projects.

Sales by Date - The Sales By Date Report allows you to look at all transactions that go against the Sales

Journal for a particular Date Range.

Sales Journal Single Transaction Report - The Sales Journal Single Transaction Report gives you the

ability to sprint out a specific Sales Journal Entry for a specific Version.  When in the Sales Journal

applet, you can launch this report by simply clicking "Print" on the toolbar.  The version showing is the

one that will be displayed.  Additionally, if "Show Audit Trail" is checked, you will see an audit trail of the

changes made on that entry.

Sales Links - The Sales Links returns a list of all transactions that are linked to the Sales Journal entry.

Single Transaction Reports - All Journals have a Print option on the toolbar that prints the current

transaction. These reports can print out any version of that transaction and can be printed in Audit Trail

mode.

Standard Hours – This report lists employee hours and variance for a date range versus an inputted

standard hours.  This can be useful in determining who should get overtime.

Stored Procedure Code – This report shows the code that is contained in a stored procedure.  Most

reports and queries that ship with InFocus use stored procedures.  This can be useful if you want to

construct your own SQL queries that are based off an existing InFocus report or query.

Timesheet - This can linked to the Personal Time sheet applet and will render a physical time sheet that

visually is comparable to the entry screen.  This can be enabled by selecting the Custom Time sheet

Report option in Global Settings in the Time & Expense tab.

Time Sheet Batch – Time Sheet Batch report is a copy of the Time sheet custom report that prints in

personal time sheet.  It has been modified to accept a date range and an employee and/or project filter.  
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Time Sheet with Overtime Types - The Time Sheet with Overtime Types report can be linked to the

Personal Time sheet applet and will render a physical time sheet that visually is comparable to the entry

screen.  This can be enabled by selecting the Custom Time sheet Report option in Global Settings in the

Time & Expense tab. This report supports using multiple Overtime Types created in Administration>

Global Settings> Labels and assigned in Employees> Pay History Tab.

Time Sheet with Overtime Types Batch  - The Time Sheet with Overtime Types report can be linked to the

Personal Time sheet applet and will render a physical time sheet that visually is comparable to the entry

screen.  The report can accept a date range and an employee and/or project filter.    This can be enabled

by selecting the Custom Time sheet Report option in Global Settings in the Time & Expense tab. This

report supports using multiple Overtime Types created in Administration> Global Settings> Labels and

assigned in Employees> Pay History Tab.

Trial Balance with Drill Down - Displays account balances based on user driven criteria. Includes click in

details for debits and credits. This report also includes End of Year Closing click in details.

Unapproved Expense Sheets -  This report lists expense sheets that have not been approved.

Unapproved Time Sheets – This report lists time sheets that have not been approved.

Unbilled Summary by Org Unit - This report is useful for companies that want to make general ledger

entries to capture WIP.  The report has an option to post WIP to the general journal.  You must have the

PM Bill Review special permission Can Override Project leader to post to the general ledger.   In order to

perform the post you will also need to set up the posting accounts in the Revenue Recognition tab in

Global Settings.  When you choose to post a messages section will appear at the end of the report.  The

messages will display the journal entry number if successful otherwise it will display error messages.  The

auto-reverse feature in the general journal can be used to reset the values to zero in the next period. The

report has standard PM Leader restrictions so can be safely used by project managers.

User Security Settings - User Security Settings allows you the see the User/Group security setup of

individuals and/or Groups.

Vendor Inquiry Report - This report displays both A/P and non-A/P transactions per vendor.  Options are

available to display varying levels of detail such as project, WBS, invoice number and transaction detail. 

You can also run the report for open invoices only.  If you do not supply a vendor code it runs for all

vendors.

Unprocessed Expense Sheets – This report lists expense sheets line items that have not been either

imported into the employee reimbursable journal or have not been declined. 

WBS listing – This report lists the WBS structure for projects.
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WBS Node Inquiry - This report returns work hours, cost, effort and revenue for a specified node of a

project structure. For example, you can select Phase 001 and the report will return the data for all Phase

001's on all projects. It can be run for a date range or a G/L Period range.

5.1.1.1 Account Inquiry By Date

Description
The Account Inquiry By Date Report allows you to look at all transactions that go against the Sales Journal,
Purchase Journal, Employee Reimbursables Journal, Receipt Journal (cash and accrual), Disbursement
Journal(cash and accrual), General Journal for a particular Date Range.

Data: Sales Journal, Purchase Journal, Employee Reimbursables Journal, Receipt Journal (cash and
accrual), Disbursement Journal(cash and accrual), General Journal

Note: This report is run for a date range.  You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Prompt

Date Ranges
Start & End Date - Filters the data by the Date Type supplied in the next selection. 

Date Type (Required) - Options are:
o Transaction Date - The transaction date of the journal entry (ie. invoice date, check date or trans date)
o Create Date - Create Date of the transaction
o Modify Date - Modify Date of the transaction

General
Base Code (Required) - Filters to a specific GL Base Code of the Transactions

Org Unit - Filters to a specific the Organizational Unit related to the GL Base Code of the Transaction.

Include Org. Children - Includes the Organization Units Children  when filtering to a specific the
Organizational Unit.
Show Comments - When checked, the report will show the GL Comments from the line-items of the
Journals.
Is Accrual - When checked, the report looks at the Accrual Journals (Receipts & Disbursements) instead
of the Cash Basis Journals (CBReceipts & CB Disbursements). Note: The Cash Basis Journals are
populated by running the Cash Basis Conversion Utility.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
The Sorts section Groups & Sorts the report by Transaction Date, Create Date, Modify Date, Payee/Payer,
Deposit No and Journal.

Sort 1 - Top Level Sort

Sort 2 - Second Level Sort. 

Sort 3 - Third Level Sort

Report
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Report Columns
Transaction ID - ID of the Journal

Journal - Name of the Journal

Org. Unit - Organizational Unit of GL Base Code related to the line item in the Transaction

Control Number - Invoice Number (Sales, Purchase), Check Number (Receipt, Disbursement), erid
(Employee Reimbursables) or glid (General Journal) depending on the Journal being reported on.
TransDate - Invoice Date (Sales, Purchase,Employee Reimbursable), Check Date (Receipt,
Disbursement), or TransDate (General Journal) depending on the Journal being reported on. 
Amount - The Journal Amount for the General, Sales and Receipts Journals. The Cost Amount for the
Purchases, Employee Reimbursables and Disbursement Journals.

Sample(s)

5.1.1.2 Account Project Inquiry By Date

Description
The Account Project Inquiry By Date Report allows you to search against all transactions that go against the
Sales Journal, Purchase Journal, Employee Reimbursables Journal, Receipt Journal, Disbursement Journal,
General Journal for a particular Date Range, Grouped by Project.  The second level of detail groups on the
Client, Employee or Vendor.  

Data: Sales Journal, Purchase Journal, Employee Reimbursables Journal, Receipt Journal, Disbursement
Journal, General Journal
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Note 1: This report is run for a date range.  You may not see the same figures if you are trying to compare
this to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Note 2: This report only looks at the Accrual Journals and does not report on a Cash Basis.

Prompt

Date Ranges
Start & End Date - Filters the data by the transaction date on the Journal entry.

General
G/L Base Code (Required) - Filters to a specific GL Base Code of the Transactions

Org Unit (blank=all) - Filters to a specific the Organizational Unit related to the GL Base Code of the
Transaction.
Include Projects with No Balance - When selected, projects that do not have outstanding balances will be
included in the results.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
JN - Abbreviation of the Journal that the data is coming from. (SJ-Sales Journal, PJ-Purchase Journal,
ER-Employee Reimbursables Journal, CD-Disbursements Journal, CR-Receipt Journal, GJ-General
Journal)
JNID -  ID of the Journal referenced in the JN column.

TransDate - Invoice Date (Sales, Purchase,Employee Reimbursable), Check Date (Receipt,
Disbursement), or TransDate (General Journal) depending on the Journal being reported on. 
Invoice No - Invoice Number from the respective Journals.

Check No - Check Number from the respective Journals.

G/L Amount - The Journal Amount for the General, Sales and Receipts Journals. The Cost Amount for the
Purchases, Employee Reimbursables and Disbursement Journals.
Effort - This number is the Non-Labor Cost at the Marked-up Rate that comes from the Purchase,
Employee Reimbursables and Disbursment Journals. 
PM Comments (only visible when present) - The PM Comment from the respective Journals.

Sample(s)
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5.1.1.3 Accounting Timesheet

Description
The Accounting Timesheet Report report reflects the most current version of the time sheet, reflecting any
changes made in Timesheet Adjustments. The layout is similar to what you see in the Time Sheets applet for
a specific Time Sheet Period End date.

Data: The data is collected from the Time Sheets table.

Prompt

General
Employee (Required) - Selected Employee of the time sheet that is being reported on. 

Period End Date (Required) - Period End date of the Time Sheet that is being reported n.
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Report

Report Columns
Header

From - Period Start Date of the Time Sheet

To - Period End Date of the Time Sheet

Employee Name

Employee Code (beneath Employee Name)

Detail

Project - Project Path of line item on the time sheet.

JC - Job Title Code of line item on the time sheet.

LC - Labor Code of line item on the time sheet.

Date Columns - Hours entered on a Time sheet per day. includes both Regular and Overtime hours.

Reg - Total of Regular hours for the day.

*OT - Total of Overtime hours for the day.

Total -  Total hours for the day (Reg+OT).

Comments - The Project information of the comment and the PM Comment that was entered for the
workdate.

Sample(s)

5.1.1.4 Accounts Payable By Project

Description
The Accounts Payable by Project Report gives you a list of unpaid vendor invoices grouped by Project.
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Additionally, you are given the ability to see all AP by selecting the "Include Closed Invoices" option.  In that
case it displays both paid and unpaid invoices (i.e. the entire history). This report uses the G/L period as the
cutoff period so it is basically inception to date. 

Data: That data is collected from the Purchase, Disbursement and Receipt Journals.  

Prompt

Date Ranges
G/L Period (Required) - The GL Period is the Cut-off date for this report. 

Aging Date - The Aging Date is used to drive the "Days Old" on the report. 

Age By Invoice Date - When selected, the Invoice Date is used as the Age Date instead of the Due Date
of the transaction.

General
Project - Allows you to filter to a specific Project. When blank, All Projects are returned.

Vendor - Allows you to filter to a specific Vendor. When blank, All Vendors are returned.

Vendor Type - Allows you to filter the Report by the User Defined list of Vendor Types. More on Vendor
Types
A/P Account - Allows you to filter to a specific Accounts Payable GL Account. When blank, All AP
Accounts are returned.
Include Closed Invoices - When selected, the report displays both paid and unpaid invoices (i.e. the
entire history).
Print Invoices - When selected, the Invoices are displayed on the report.

Print Comments - When selected, the A/P Comment from the Purchase Journal is displayed.

Print Detail - When selected, the Invoice & Payment detail is displayed.

Print Adjustments - When selected, this will give an additional layer of detail including check & invoice
numbers.
Sort Vendor By - Options are Code & Name.

Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Invoice No - Invoice Number from the Purchase Journal.

Invoice Date - Invoice Date of the Purchase Journal.

Due Date - Due Date of the Purchase Journal.

Amount Due - The "Amount" (cost amount) column from the detail of the Purchase Journal.

Discount Amount - Discount amount that is applied from the "Results" tab of A/P Check Writing.

Amount to Pay - Amount Due column minus the Discount column.

Sample(s)



InFocus System Reports 687

© 2020 Clearview Software, Inc.

5.1.1.5 Accounts Payable Check Batch Report

Description
The Accounts Payable Check Batch report allows you to print the details of a check batch from AP Check
Writing after the batch has been saved using the "Save to Batch" option located on the toolbar.

Prompt

General
Employee - Selected Employee that created the A/P Check Batch.

Batch Date (Required) - The date of the A/P Check Batch.

Vendors Selected for Payment - When selected, only Vendors that have "Pay" selected on the "Results"
tab are returned. 
Print Detail - When selected, the Vendor Invoice detail is displayed on the report.

5.1.1.6 Aged Wip

Description
The Aged WIP Report gives you an Aging list of transactions with a Bill Status of R (Ready to Bill) and H
(Hold) that go against Billable (and optionally Opportunities) projects.  This report displays five aging periods
that are fixed. Additionally, you have the ability to "Drill-through" to the individual transactions.

Data: That data is collected from Time Sheets, Purchase Journals, Employee Reimbursables and
Disbursement Journals. 

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

Date Ranges
As of Date - The As of Date is the Cut-off date for this report (Unless the Use G/L Period for... Options are

https://support.clearviewsoftware.net/articles/7614
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selected). 
Aging Date - The Aging Date is used to drive the aging "buckets" on the report. 

Use G/L Period for Non-Labor - When selected, all non-labor transactions (Purchase, Employee
Reimbursables and Disbursement Journals) use the G/L Period as a time cut-off instead of the As-of
Date.
Use G/L Period for Labor - When selected, all labor transactions (Time Sheets) use the G/L Period as a
time cut-off instead of the As-of Date. Note - You must be running Labor Distribution for this to work
properly.

General
Org. Unit - Filters the report by the selected Organizational Unit.

Org. Type - Options are Charge & Project. This works in conjunction with the Org. Unit filter.  When
Project is selected, the report is filtered by the Org. Unit associated with the Project that is being charged
against. When Charge is selected, the report is filtered by the Org. Unit associated with the Transaction
in relation to how Profit Sharing was set up on the project. 
Project - Allows you to filter to a specific Project. When blank, All Projects are returned.

Project Leader - Allows you to filter to a specific Project Leader (Project Manager, Principle in Charge,
Project Accountant) that is assigned on the Members Tab on the project.
Show WBS - When selected, the entire WBS (Work Breakdown Structure) is returned on the project.

Include Opportunities - When selected, Projects with a Charge Type of Opportunity are returned with the
results.
Include ICC - When selected, Transactions that go against a G/L Code that have a Metric Type of Cost
and a PM Type of ICC (In Contract Consultant) are included in the results.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
Sort 1 - Top Level Sort. Options are Charge Company, Charge Org  Unit, Project Company, Project Org
Unit, Project Manager, Principal-In-Charge, Client Code, Client Name
1st Sort Subtotal - When selected, the subtotal of Labor, ODC, OCC and ICC are broken out at the Sort
level.
Sort 2 - Second Level Sort. Options are Charge Company, Charge Org  Unit, Project Company, Project
Org Unit, Project Manager, Principal-In-Charge, Client Code, Client Name
2nd Sort Subtotal - When selected, the subtotal of Labor, ODC, OCC and ICC are broken out at the Sort
level.

Report

Report Columns
Type - The PM Type of the WIP that is being reported on the row.  Types include Labor, ODC (Other
Direct Charges), OCC (Out-of-Contract Consultants) and ICC  (In Contract Consultants) 
Aging Bucket (amounts) - This report displays five aging periods that are fixed. The amounts reflected on
this report are effort numbers. Meaning that Labor is reported at the Billing rate and Non-Labor is reported
at the "marked-up" rate.
Total - Total of all aging buckets.

Drill-through Report
Name - Depending on the Journal being reported (Employee Name,Firm Name or Payee Name)

Journal - Journal that the reported data is coming from.
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TransID - ID number of the transaction.

TransDate - Invoice Date (Purchase,Employee Reimbursable), Check Date (Disbursement), or WorkDate
(Time Sheets) depending on the Journal being reported on. 
Units - Hours for labor and units for non-labor.

Amount - The amounts reflected on this report are effort numbers. Meaning that Labor is reported at the
Billing rate and Non-Labor is reported at the "marked-up" rate.

Sample(s)
Main Report

Drill Through

5.1.1.7 Balance Sheet (Rolling 12 Month)

Description
The Balance Sheet (Rolling 12 Month) Report is a statement of the companies financial position, which states
the Assets, Liabilities and Owner's Equity (Capital) for a 12 month period (G/L Period). When you select a G/
L Period, that period, and the prior 11 periods, are displayed on the report.  Additionally, you are given the
ability to see all "drill-down" into each account on the report.  The blue hyperlink indicates where you can do
this. 

Data: That data is collected from the Sales, Receipt (Cash and Accrual), General, Purchase, Disbursement
(Cash and Accrual), Employee Reimbursable and MC Revaluations (Multi-Currency only) Journals. 

Prompt

Date Ranges
G/L period - The cut-off G/L Period for the report.  All returned data falls on or before the selected G/L
Period.

General
Org Unit - When selected, the data is filtered to display only the specified Organizational Unit, and its
children Orgs. 
Cash Basis - When checked, the report reports on a Cash Basis. What that means is that the report
looks at the the Cash Basis Journals (CBReceipts & CBDisbursements) instead of the Accrual Basis
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Journals (Receipts & Disbursements). Note: The Cash Basis Journals are populated by running the Cash
Basis Conversion Utility.
Consolidate - When selected, All of the Organizational Units are consolidated into one line instead of
being broken out into their respective Org. Units.
Show Base Code - When selected, the Base Code of the G/L Account is displayed in addition to the Full
GL Account Name.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency
Include Realized Gains Losses - When selected, Realized Gains Losses are includes in the returned data
(Multi-Currency only). More on MC Revaluations
Include Unrealized Gains Losses - When selected, Unrealized Gains Losses are includes in the returned
data (Multi-Currency only). More on MC Revaluations

Report

Report Columns
Base Code - Only displays when "Show Base Code" is checked. This is the G/L Code of the Account.

Account Name - The full Account Name of the G/L Account.

Amount (per period)  - The amounts reflected on this report are cost amounts. 

Drill-through Report
Balance Forward - The balance of the account coming into this G/L Period.

TransID - ID number of the transaction.

TransDate - Invoice Date (Purchase,Employee Reimbursable), Check Date (Disbursement), or WorkDate
(Time Sheets) depending on the Journal being reported on. 
Invoice/Check - Depending on the Journal, this column will display either the Invoice or Check Number.
Invoice Number (Sales, Purchase), Check Number (Receipt, Disbursement).
Description - Firm Name, Employee Name or Payee Name depending on the Journal.

Amount - The amounts reflected on this report are cost numbers. 

Ending Balance - The balance of the account going out of this G/L Period.

5.1.1.8 Balance Sheet with drill-down

Description
The Balance Sheet with drill-down Report is a statement of the companies financial position, which states the
Assets, Liabilities and Owner's Equity (Capital) at a particular point in time (G/L Period). Additionally, you are
given the ability to see all "drill-down" into each account on the report.  The blue hyperlink indicates where
you can do this. 

Data: That data is collected from the Sales, Receipt (Cash and Accrual), General, Purchase, Disbursement
(Cash and Accrual), Employee Reimbursable and MC Revaluations (Multi-Currency only) Journals. 

Prompt

Date Ranges
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G/L period - The cut-off G/L Period for the report.  All returned data falls on or before the selected G/L
Period.

General
Org Unit - When selected, the data is filtered to display only the specified Organizational Unit, and its
children Orgs. 
Cash Basis - When checked, the report reports on a Cash Basis. What that means is that the report
looks at the the Cash Basis Journals (CBReceipts & CBDisbursements) instead of the Accrual Basis
Journals (Receipts & Disbursements). Note: The Cash Basis Journals are populated by running the Cash
Basis Conversion Utility.
Consolidate - When selected, All of the Organizational Units are consolidated into one line instead of
being broken out into their respective Org. Units.
Show Base Code - When selected, the Base Code of the G/L Account is displayed in addition to the Full
GL Account Name.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency
Include Realized Gains Losses - When selected, Realized Gains Losses are includes in the returned data
(Multi-Currency only). More on MC Revaluations
Include Unrealized Gains Losses - When selected, Unrealized Gains Losses are includes in the returned
data (Multi-Currency only). More on MC Revaluations

Report

Report Columns
Base Code - Only displays when "Show Base Code" is checked. This is the G/L Code of the Account.

Account Name - The full Account Name of the G/L Account.

Amount  - The amounts reflected on this report are cost amounts. 

Drill-through Report
TransID - ID number of the transaction.

TransDate - Invoice Date (Purchase,Employee Reimbursable), Check Date (Disbursement), or WorkDate
(Time Sheets) depending on the Journal being reported on. 
Invoice/Check - Depending on the Journal, this column will display either the Invoice or Check Number.
Invoice Number (Sales, Purchase), Check Number (Receipt, Disbursement).
Description - Firm Name, Employee Name or Payee Name depending on the Journal.

Amount - The amounts reflected on this report are cost numbers. 

Sample(s)
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5.1.1.9 Bank Register By Date

Description
The Bank Register by Date Report is a data sensitive report providing a running balance of a single bank
account.  There are four different report styles to choose from that sort and group by By Date, By Journal/
Date, By Journal/Control Number, By Journal/Control Number/Date.  You can optionally select which journals
to include.  

Data: That data is collected from the Disbursement, Receipts and General Journals. 

Note 1: This report is run for a date range.  You may not see the same figures if you are trying to compare
this to an Income Statement or a Balance Sheet that uses a G/L Period as a Date Filter.

Note2: If you do not select all journals the ending balance will reflect the journals that are included. 

Prompt

Date Ranges
Start Date - Beginning Date used to filter the transactions that are brought into this report.

End Date - Ending Date used to filter the transactions that are brought into this report.

General
Bank G/L Code (Required) - Bank G/L Account to be reported on.

Org Unit - Organizational Unit associated with the Bank G/L Account.

Report Style - There are four different report styles to choose from that sort and group by By Date, By
Journal/Date, By Journal/Control Number, By Journal/Control Number/Date.  You can optionally select
which journals to include.  
Print Comments - When selected, the G/L Comments from the transactions will display on the report.

Include Receipts - When selected, the data returned will include transactions from the Receipt Journal.

Include Disbursements - When selected, the data returned will include transactions from the
Disbursement Journal.
Include General Journal - When selected, the data returned will include transactions from the General
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Journal.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.

Other
Use All Version for Balance Forward - When selected, the report will bring back all versions of the
transactions. Meaning that you will see all of the changes that took place on a transaction that resulted in
a version change.

Report

Report Columns
Opening Balance for [Selected G/L Code] - All outstanding balances from the Journals mentioned above
as of the Start Date that the report was run.
Transaction Date - The Transaction Date comes from the Journal where the transaction comes from:
Receipt Journal (Deposit Date), Disbursement Journal (Check Date),  General Journal (Trans Date)
Control Num - Deposit Number (Receipts), Check Number (Disbursements) and GLID (General Journal)

Type - Deposit (Receipts), Check (Disbursements) and Adj. (General Journal)

Description - Firm Name, Employee Name , Payer Name or G/L Comments, depending on the Journal.

Debit - Debit Amount of the Transaction

Credit - Credit Amount of the Transaction

Balance - A running total of the Opening Balance minus the Debits and Credits.

Ending Balance - Ending Balance of the report. The Grand Total of the Opening Balance minus the Debits
and Credits on the entire report.

Sample(s)

5.1.1.10 Benefit Accrual Status

Description
The Benefit Accrual Status Report gives you the benefit amounts for the selected Benefit Project in the
current Beneft Year.

Note: You must be using the Benefit Accrual functionality within InFocus for this report to return data.

Prompt



InFocus User Manual - Current (v2020)694

© 2020 Clearview Software, Inc.

General
Benefit Project (Required) - The Benefit Accrual Project that the report is to be run for. 

Report

Report Columns
Accrue Type - The Accrual Type from the Benefit Accrual Setup (Benefit Accrual> Edit (toolbar)> Accrual
Type section). Options are Calendar (Anniversary, Calendar & Fiscal) and Hours Worked (allows project
exclusions)
Defaults - The Defaults are from the Benefit Accrual Setup (Benefit Accrual> Edit (toolbar)> Benefit Year
section). 
Maximums - The Maximums are from the Benefit Accrual Setup (Benefit Accrual> Edit (toolbar)>
Maximums section). 
Accrual Schedule - The Accrual Schedules are from the Benefit Accrual Setup (Benefit Accrual> Edit
(toolbar)> Accrual Schedule(optional) section). More on Accrual Schedules
Employee - Employees that are a part of the Accrual.

Current Year - The most recent Benefit Year that has been calculated on a specific Employee.

Accrued YTD - The amount of benefit hours that have been accrued to date.  Note: You must manually
"Run Accruals" for these numbers to update.
Hours Taken - Number of hours used by the Employee.  This is calculated by time sheet hours entered
against the Benefit Project.
 Balance - Accrued YTD minus Hours Taken

5.1.1.11 Bill Review

Description

The Bill Review Report returns the pertinent information to assist Project Managers and Billers in reviewing

their projects for billing purposed.  The report must be enabled in Global Settings (A/R tab) to enable this

feature. 

Data:  Transactional Data (Time Sheets, Purchase Journal, Employee Reimbursables Journal, Disbursement
Journal), (A/R Data) Sales Journal,  Receipt Journal, General Journal), Project Data (Projects/Project
Planning)

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Global Settings: There are number of Global Settings that have an effect on this report. Here is a list of
those settings and the effect that they can have.

G/L Period End Date (Invoicing Tab) - When selected, all reimbursable (non-labor) transactions are
"cut-off" through the Invoice G/L Period.  When Transaction Date is used, those transactions are "cut-
off" using the "As-of Date" when running the report.

Include: Never Bill (A/R Tab) - When selected, a section displaying Never Bill (N) charges will
appear on the Bill Review report.

Include: Write Off  (A/R Tab) - When selected, a section displaying Write Off (W) charges will
appear on the Bill Review report.

Include: In-Contract Consultants (ICC)  (A/R Tab) - When selected, a section displaying In-

https://support.clearviewsoftware.net/articles/7614
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Contract Consultants (ICC) charges will appear on the Bill Review report.

Prompt

General
As of Date - The As-of Date is the date used to cut-off the transactions being returned to the report. 

Project (Required) - The Project that the data is being returned for.

Report

Report Columns
Header

Project - Project Code and Name.

Client (info) - When "Use Client's Bill-To" is selected on the Projects> Billing Tab, the bill to address will
come from Clients> General Tab> Bill To section. Otherwise, the  address will come from Projects> Billing
Tab> Custom Bill To Address
Billing Description - The Invoice Comments that come from either the Invoice Comments window in PA Bill
Review or the Invoice Comments box from  Projects> Billing Tab> Invoice Comments section.
P.O.# - The PO Number that comes from Projects> Billing Tab> Invoicing section.

Prin. -  The Principal In Charge of the Project that comes Projects> Members Tab> Project Leaders
section.
P.M. - The Project Manager of the Project that comes Projects> Members Tab> Project Leaders section.

Rate Schedule - The main Rate Schedule associated with the project. Note: This is the Top-Level only. If
you have Rate Schdules assigned to lower nodes of the project, they will not show.
Retainer Balance

Unbilled Detail section
Job Title / Exp. Code - The Job Title Name associated with the time sheet and Expense Code associated
with non-labor transactions that have a Bill Status of Ready to Bill (R) and Hold (H).
Date - The Work Date associated with the time sheet and Transaction Date associated with non-labor
transactions that have a Bill Status of Ready to Bill (R) and Hold (H).
Hrs./ Units -  The Work Hours associated with the time sheet and Quantity (Units) associated with non-
labor transactions that have a Bill Status of Ready to Bill (R) and Hold (H).
Rate -  The Bill Rate associated with the time sheet and Unit Rate associated with non-labor transactions
that have a Bill Status of Ready to Bill (R) and Hold (H).
Markup - The Markup associated with non-labor transactions that have a Bill Status of Ready to Bill (R)
and Hold (H).
Hold - The Amount associated with the transactions with a status of Hold (H).

Ready - The Amount associated with the transactions with a status of Ready to Bill (R).

Never Bill / Write Off section
Job Title / Exp. Code - The Job Title Name associated with the time sheet and Expense Code associated
with non-labor transactions that have a Bill Status of Never Bill (N) or Write off (W).
Date - The Work Date associated with the time sheet and Transaction Date associated with non-labor
transactions that have a Bill Status of Never Bill (N) or Write off (W).
Hrs./ Units -  The Work Hours associated with the time sheet and Quantity (Units) associated with non-
labor transactions that have a Bill Status of Never Bill (N) or Write off (W).
Rate -  The Bill Rate associated with the time sheet and Unit Rate associated with non-labor transactions
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that have a Bill Status of Never Bill (N) or Write off (W).
Markup - The Markup associated with non-labor transactions that have a Bill Status of Never Bill (N) or
Write off (W).
Hold - The Amount associated with the transactions with a status of Never Bill (N) or Write off (W).

Unbilled Summary
Labor - The summary of Unbilled Labor Bill Amounts (Bill Status of R and H) at the specific levels of the
WBS (Work Breakdown Structure).
ODC - The summary of Unbilled Other Direct Charges (ODC) Bill Amounts (Bill Status of R and H) at the
specific levels of the WBS (Work Breakdown Structure).
OCC - The summary of Unbilled Out-of-Contract Consulting Charges (OCC) Bill Amounts (Bill Status of R
and H) at the specific levels of the WBS (Work Breakdown Structure).
ICC - The summary of Unbilled In-Contract Consulting Charges (OCC) Bill Amounts (Bill Status of R and
H) at the specific levels of the WBS (Work Breakdown Structure).

Project-to-Date Labor Metrics
% Comp. - Fixed Fee Percent Complete. Only when there are Fixed Fee contract amounts.

Contract - Fixed Fee or Labor Contract amounts.

Budget - Labor Budget Amounts. These come from Project Planning.

Effort - Labor Cost at the Billing Rate.

Billed - Billed Amount. This is the amount posted to the Sales Journal, so this may not match the Effort
column in the case of Fixed Fee or Labor Contract situations.

Project-to-Date Other Direct Charges (ODC) Metrics
Contract - Other Direct Charge (ODC) Contract amounts.

Budget - Other Direct Charge (ODC) Budget Amounts. These come from Project Planning.

Effort - Other Direct Charge (ODC) Cost at the Marked-up Rate.

Billed - Billed Amount. This is the amount posted to the Sales Journal, so this may not match the Effort
column in the case of Other Direct Charge (ODC) Contract situations.

Project-to-Date Out-of-Contract Consultants (OCC) Metrics
Contract - Out-of Contract Consultant (OCC) Contract amounts.

Budget - Out-of Contract Consultant (OCC) Budget Amounts. These come from Project Planning.

Effort - Out-of Contract Consultant (OCC) Cost at the Marked-up Rate.

Billed - Billed Amount. This is the amount posted to the Sales Journal, so this may not match the Effort
column in the case of Out-of Contract Consultant (OCC) Contract situations.

Project-to-Date In-Contract Consultants (ICC) Metrics
Contract - In Contract Consultant (ICC) Contract amounts.

Budget - In Contract Consultant (ICC) Budget Amounts. These come from Project Planning.

Effort - In Contract Consultant (ICC) Cost at the Marked-up Rate.

Billed - Billed Amount. This is the amount posted to the Sales Journal, so this may not match the Effort
column in the case of In Contract Consultant (ICC) Contract situations.

Invoices
Invoice No - Invoice Number from the Invoice (Sales Journal)

Date - Invoice Date associated with the Invoice (Sales Journal)

Billed - Amount Billed on the Invoice (Sales Journal)

Received - Amount Received against the Invoice  (Sales Journal)

Balance - Outstanding amount left for the client to pay on the Invoice (Sales Journal)

Days Old - The age of the outstanding Invoice (Sales Journal)
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Sample(s)

5.1.1.12 Bill Review Batch

Description

The Bill Review Report returns the pertinent information to assist Project Managers and Billers in reviewing

their projects for billing purposed.  This report is the same as the Bill Review Report, but can be run in

batches.  The report must be enabled in Global Settings (A/R tab) to enable this feature. 

Data:  Transactional Data (Time Sheets, Purchase Journal, Employee Reimbursables Journal, Disbursement
Journal), (A/R Data) Sales Journal,  Receipt Journal, General Journal), Project Data (Projects/Project
Planning)

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Global Settings: There are number of Global Settings that have an effect on this report. Here is a list of
those settings and the effect that they can have.

G/L Period End Date (Invoicing Tab) - When selected, all reimbursable (non-labor) transactions are
"cut-off" through the Invoice G/L Period.  When Transaction Date is used, those transactions are "cut-
off" using the "As-of Date" when running the report.

Include: Never Bill (A/R Tab) - When selected, a section displaying Never Bill (N) charges will
appear on the Bill Review report.

Include: Write Off  (A/R Tab) - When selected, a section displaying Write Off (W) charges will
appear on the Bill Review report.

Include: In-Contract Consultants (ICC)  (A/R Tab) - When selected, a section displaying In-
Contract Consultants (ICC) charges will appear on the Bill Review report.

Prompt

General
As of Date - The As-of Date is the date used to cut-off the transactions being returned to the report. 

Project (Required) - The Project that the data is being returned for.

Report

Report Columns
Header

Project - Project Code and Name.

Client (info) - When "Use Client's Bill-To" is selected on the Projects> Billing Tab, the bill to address will
come from Clients> General Tab> Bill To section. Otherwise, the  address will come from Projects> Billing
Tab> Custom Bill To Address
Billing Description - The Invoice Comments that come from either the Invoice Comments window in PA Bill
Review or the Invoice Comments box from  Projects> Billing Tab> Invoice Comments section.

https://support.clearviewsoftware.net/articles/7614
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P.O.# - The PO Number that comes from Projects> Billing Tab> Invoicing section.

Prin. -  The Principal In Charge of the Project that comes Projects> Members Tab> Project Leaders
section.
P.M. - The Project Manager of the Project that comes Projects> Members Tab> Project Leaders section.

Rate Schedule - The main Rate Schedule associated with the project. Note: This is the Top-Level only. If
you have Rate Schdules assigned to lower nodes of the project, they will not show.
Retainer Balance

Unbilled Detail section
Job Title / Exp. Code - The Job Title Name associated with the time sheet and Expense Code associated
with non-labor transactions that have a Bill Status of Ready to Bill (R) and Hold (H).
Date - The Work Date associated with the time sheet and Transaction Date associated with non-labor
transactions that have a Bill Status of Ready to Bill (R) and Hold (H).
Hrs./ Units -  The Work Hours associated with the time sheet and Quantity (Units) associated with non-
labor transactions that have a Bill Status of Ready to Bill (R) and Hold (H).
Rate -  The Bill Rate associated with the time sheet and Unit Rate associated with non-labor transactions
that have a Bill Status of Ready to Bill (R) and Hold (H).
Markup - The Markup associated with non-labor transactions that have a Bill Status of Ready to Bill (R)
and Hold (H).
Hold - The Amount associated with the transactions with a status of Hold (H).

Ready - The Amount associated with the transactions with a status of Ready to Bill (R).

Never Bill / Write Off section
Job Title / Exp. Code - The Job Title Name associated with the time sheet and Expense Code associated
with non-labor transactions that have a Bill Status of Never Bill (N) or Write off (W).
Date - The Work Date associated with the time sheet and Transaction Date associated with non-labor
transactions that have a Bill Status of Never Bill (N) or Write off (W).
Hrs./ Units -  The Work Hours associated with the time sheet and Quantity (Units) associated with non-
labor transactions that have a Bill Status of Never Bill (N) or Write off (W).
Rate -  The Bill Rate associated with the time sheet and Unit Rate associated with non-labor transactions
that have a Bill Status of Never Bill (N) or Write off (W).
Markup - The Markup associated with non-labor transactions that have a Bill Status of Never Bill (N) or
Write off (W).
Hold - The Amount associated with the transactions with a status of Never Bill (N) or Write off (W).

Unbilled Summary
Labor - The summary of Unbilled Labor Bill Amounts (Bill Status of R and H) at the specific levels of the
WBS (Work Breakdown Structure).
ODC - The summary of Unbilled Other Direct Charges (ODC) Bill Amounts (Bill Status of R and H) at the
specific levels of the WBS (Work Breakdown Structure).
OCC - The summary of Unbilled Out-of-Contract Consulting Charges (OCC) Bill Amounts (Bill Status of R
and H) at the specific levels of the WBS (Work Breakdown Structure).
ICC - The summary of Unbilled In-Contract Consulting Charges (OCC) Bill Amounts (Bill Status of R and
H) at the specific levels of the WBS (Work Breakdown Structure).

Project-to-Date Labor Metrics
% Comp. - Fixed Fee Percent Complete. Only when there are Fixed Fee contract amounts.

Contract - Fixed Fee or Labor Contract amounts.

Budget - Labor Budget Amounts. These come from Project Planning.

Effort - Labor Cost at the Billing Rate.

Billed - Billed Amount. This is the amount posted to the Sales Journal, so this may not match the Effort
column in the case of Fixed Fee or Labor Contract situations.
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Project-to-Date Other Direct Charges (ODC) Metrics
Contract - Other Direct Charge (ODC) Contract amounts.

Budget - Other Direct Charge (ODC) Budget Amounts. These come from Project Planning.

Effort - Other Direct Charge (ODC) Cost at the Marked-up Rate.

Billed - Billed Amount. This is the amount posted to the Sales Journal, so this may not match the Effort
column in the case of Other Direct Charge (ODC) Contract situations.

Project-to-Date Out-of-Contract Consultants (OCC) Metrics
Contract - Out-of Contract Consultant (OCC) Contract amounts.

Budget - Out-of Contract Consultant (OCC) Budget Amounts. These come from Project Planning.

Effort - Out-of Contract Consultant (OCC) Cost at the Marked-up Rate.

Billed - Billed Amount. This is the amount posted to the Sales Journal, so this may not match the Effort
column in the case of Out-of Contract Consultant (OCC) Contract situations.

Project-to-Date In-Contract Consultants (ICC) Metrics
Contract - In Contract Consultant (ICC) Contract amounts.

Budget - In Contract Consultant (ICC) Budget Amounts. These come from Project Planning.

Effort - In Contract Consultant (ICC) Cost at the Marked-up Rate.

Billed - Billed Amount. This is the amount posted to the Sales Journal, so this may not match the Effort
column in the case of In Contract Consultant (ICC) Contract situations.

Invoices
Invoice No - Invoice Number from the Invoice (Sales Journal)

Date - Invoice Date associated with the Invoice (Sales Journal)

Billed - Amount Billed on the Invoice (Sales Journal)

Received - Amount Received against the Invoice  (Sales Journal)

Balance - Outstanding amount left for the client to pay on the Invoice (Sales Journal)

Days Old - The age of the outstanding Invoice (Sales Journal)

Sample(s)

5.1.1.13 Billing Status

Description
The Billing Status report allows you to search through all transactions that can have a billing status (Time
Sheets, Purchase Journal, Employee Reimbursable Journal and the Disbursement Journal) for a specified
date range.  You are given the option to filter by Project, Journal and Billing Status.

Data: That data is collected from the Time Sheets, Purchase Journal, Employee Reimbursable Journal and
the Disbursement Journal

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

https://support.clearviewsoftware.net/articles/7614
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Date Ranges
Start Date - Beginning Date used to filter the transactions that are brought into this report.

End Date - Ending Date used to filter the transactions that are brought into this report.

General
Project - When selected, the data is filtered for the specified Project. If left blank, all project data is
returned.
Include Inactive - When selected, Inactive projects are returned in the report data.

Include Billed - When selected, transaction with a Bill Status of B (Billed), from the selected Journals, are
returned in the report data.
Include Ready to Bill - When selected, transaction with a Bill Status of R (Ready to Bill), from the
selected Journals, are returned in the report data.
Include Hold - When selected, transaction with a Bill Status of H (Hold), from the selected Journals, are
returned in the report data.
Include Never Bill - When selected, transaction with a Bill Status of N (Never Bill), from the selected
Journals, are returned in the report data.
Include Write Off - When selected, transaction with a Bill Status of W (Write-off), from the selected
Journals, are returned in the report data.
Include Indirect - When selected, Projects with a Charge Type of "Indirect" are returned in the report data.

Include Time Sheets - When selected, Time Sheet transactions are included in the report data.

Include Purchases - When selected, Purchase Journal transactions are included in the report data.

Include Emp. Reimbursables - When selected, Employee Reimbursable Journal transactions are included
in the report data.
Include Disbursements - When selected, Disbursement Journal transactions are included in the report
data.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Bill Status (Group Header) - The Billing Status of the transactions that are grouped below.

Trans Type - The location of the transaction (Time Sheet or Journal)

Trans ID - The ID number of the Time Sheet / Journal Entry. This can be used to look up the transaction
in its respective location.
Code - Depending on the Source, the Code can mean different things. (Time Sheets=Labor Code,
Purchase, Employee Reimbursables and Disbursement Journals=Expense Code)
Date - Depending on the Source, the date is the following (Time Sheets=Work Date, Purchase
Journals=Invoice Date, Employee Reimbursables Journal =Trans Date, Disbursement Journal=Check
Date )
Units/Hrs - Depending on the Source, the Units/Hrs are the following (Time Sheets=Bill Hours, Purchase,
Employee Reimbursables and Disbursement Journals=Qty)
Effort - Effort amounts reflected on this report display labor at the Billing rate and Non-Labor at the
"marked-up" rate.

Sample(s)
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5.1.1.14 Billings

Description
The Billings Report gives you Hourly, Fixed Fee, ODC, OCC, ICC, Retainer, Retainage and Other revenue
numbers for a specified Period Range.

Data: That data in this report is collected from the Sales Journal against Billable Projects Only.

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

Date Ranges
Starting Period - Beginning G/L Period used to filter the Sales Journal transactions that are brought into
this report.
Ending Period - Ending G/L Period used to filter the Sales Journal transactions that are brought into this
report.

General
Client - When selected, the data is filtered for the specified Client. If left blank, all Client data is returned.

Show Clients - When selected, The associated client is displayed on this report.

Show Projects - When selected, The associated Project is displayed on this report.

Show G/L Period - When selected, the G/L Period associated with the Sales Journal Transaction is
displayed.
Show Invoices - When selected, the Invoice Number associated with the Sales Journal Transaction is
displayed.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Hourly - Hourly Revenue Amount. Revenue that goes against a G/L Account with a Metric Type of "Billed
Revenue" and a PM Type of "Labor" (except for Fixed Fee)
Fixed Fee - Fixed Fee Revenue Amount. Revenue that goes against a G/L Account with a Metric Type of
"Billed Revenue" and a PM Type of "Labor" and a Revenue Type of "Fixed Fee".

https://support.clearviewsoftware.net/articles/7614
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ODC - Other Direct Charges Revenue. Revenue that goes against a G/L Account with a Metric Type of
"Billed Revenue" and a PM Type of "Other Direct Charges".
OCC - Out-of-Contract Consultants. Revenue that goes against a G/L Account with a Metric Type of
"Billed Revenue" and a PM Type of "Out-of-Contract Consultants".
ICC - In-Contract Consultants. Revenue that goes against a G/L Account with a Metric Type of "Billed
Revenue" and a PM Type of "In Contract Consultants"
Retainer - Revenue that goes against a G/L Account with a Metric Type of "Retainer".

Retainage - Revenue that goes against a G/L Account with a Metric Type of "Retainage".

Other - Revenue that goes against a G/L Account with the Metrics Type of "Other Revenue", "Late Fee"
and "Bad Debt".
Total - All of the above Revenue amounts combined.

Sample(s)

5.1.1.15 Billings By State

Description
The Billings by State report receipts broken down by Sales Revenue, grouped by State for a selected Period
Range.  

The Report gives you 2 State options to choose from when running it:  

1. Project State (PA> Projects> Billing Tab> Bill To Address) - For this method, check "Use Bill To Address"
and leave the "Project Address" look-up blank on the Prompt. Note:  If "Use Client's Bill-To" is selected
on the Project OR the Project State is blank, the Client State will be used.

2. Specified Project State (PA> Projects> Addresses Tab) - For this method, A specific Address is selected
using the Project Address Look-up. The report will look for the Address with the specified name and group
by the state associated with it. The result will give you a grouping of all Projects that have a Project
Address with the selected name.  All projects with a different name will be un-grouped.

Data: Sales Journal

Prompt

General
Starting G/L Period (Required) - The beginning G/L Period for the report.  All returned data falls in or after
the selected G/L Period.
Ending G/L Period (Required) - The ending G/L Period for the report.  All returned data falls in or before
the selected G/L Period.
Use Billing Address - When checked, the report looks at the state associated with the project (PA>
Projects> Billing Tab> Bill To Address) - If "Use Client's Bill-To" is selected on the Project OR the "Use
Custom Bill-to" State field is blank, the Client State will be used. Note: you would not use this check-box
when using the Project Address filter below.
Project Address - When using the look-up,  you will select a specific Address Name to group.  . The
report will look for the Address with the specified name and group by the state associated with it. The
result will give you a grouping of all Projects that have a Project Address with the selected name.  All
projects with a different name will be un-grouped. Note: If you want to use this to work for all projects, you
will need to have a "named" address that has the same name. The addresses, however, do not have to
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fall in the same state. 
Show Projects - When selected, the Project Code and Name are broken out on the report.

Show Invoices - When selected, the Invoice Number associated with the Receipt entry is displayed.

Show G/L Accounts - When selected, the G/L Base Code, and Org. Unit (if used), are displayed on the
report.
G/L Account - When a G/L Account is selected, the transactions detail is filtered to just the selected
account. When blank, all accounts are selected.

Report

Report Columns
State - Depending on the selection option (above) used, the State will come from either the Project (Billing
Tab), Client (General Tab) or Project (Address Tab)
Invoice No. - Invoice Number associated with the Payment received in the Receipt Journal.

G/L Account - G/L Account associated with the Payment received in the Receipt Journal.

Amount - Total Amount of Received Revenue.

Sample(s)

5.1.1.16 Budget Backlog

Description

The Budget Backlog is a report that compares Budget Amounts (Labor,ODC,OCC & ICC) to Billed and

Unbilled WIP (billing status of R or H).

Data: Figures come from the following:
Budget - Labor/ODC/ODD/ICC Budget Amounts entered through Project Planning.  

Unbilled - Transactions come from the Time Sheets, Purchase Journal, Employee Reimbursables
Journal, Disbursement Journal applets. Unbilled only includes transactions with a Bill Status of R
(Ready to Bill) and H (Hold).
Billed - Billed numbers come from the Sales Journal, Receipt Journal, General Journal applets. 

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

Date Ranges
As of Date - The As of Date is the transaction cut-off date for this report. This number effects only the
Billed and Unbilled number since Budgets are not date sensitive.

General
Project - Allows you to filter to a specific Project. When blank, All Projects are returned.

Include Inactive Projects - When selected, Projects that are Inactive are returned in the report.

Only Projects with Budgets - When selected, only projects that have Budget Numbers from Project
Planning populate the report.
Project Currency - The Currency Code to be used when running the report. Options are set in the Multi-

https://support.clearviewsoftware.net/articles/7614
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Currency applet.  More on Multi-Currency

Report

Report Columns
Budget Amount - Budget Amounts from Project Planning. Includes Labor, ODC (Other Direct Charges),
OCC (Out-of-Contract Consultants) and ICC (In-Contract Consultants)
Billed (Budget) - Billed Revenue numbers from the Sales, Receipt and General Journals that go against
project nodes that have a budget.  
Unbilled (Budget) -The Effort amount of transactions that have a Bill Status of R (Ready to Bill) and H
(Hold) that go against project nodes that have a budget.
Billed (Non-Budget) - Billed Revenue numbers from the Sales, Receipt and General Journals that go
against project nodes that do not have a budget.  
Unbilled (Budget) -The Effort amount of transactions that have a Bill Status of R (Ready to Bill) and H
(Hold) that go against project nodes that do not have a budget.

Sample(s)

5.1.1.17 Cash Requirements

Description
This report allows you to run an outstanding payables report, filtering by a Due Date range.

Note: This report filters by the Due Date on the Transactions. So when you select a Start Due Date and an
End Due Date, those will be compared to the Due Date on the transaction to filter the data.

Data: Figures come from the following:
Invoiced  - Purchase Journal

Paid - looks at both the Disbursement and Receipt Journals

Prompt

Date Ranges
Start & End Due Dates - Start Due Date and an End Due Date are compared to the Due Date on the
transaction to filter the data.

General
A/P Base Account - Allows you to filter the transactions in the report by the AP G/L Account.

A/P Org. Unit -  Allows you to filter the transactions by the Organizational Unit associated with the AP G/L
Account.
Include Consultants - When selected, Vendors with the "Consultant" check-box checked in the Vendor
File will be included in the results of the report.
Group by Due Date - When selected, the report is grouped by the Due Date on the transactions.

Show Invoices - When selected, the report will display the Invoice Detail on the report.

Transaction Currency - The Currency Code to be used when running the report. Options are set in the
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Multi-Currency applet.  More on Multi-Currency

Report

Report Columns
Invoice Number - The Invoice Number from the Purchase Journal.

TransID - The Purchase Journal ID number. This can be used when searching for the Journal.

Due Date - The Due Date of the Invoice (Purchase Journal).  This is the date that is being used to filter
when selecting the Start & End Due Dates.
Invoice Date - The Invoice Date of the Purchase Journal.

Invoiced - The Cost amount that was invoiced by the Vendor.

Paid - The amount paid to the vendor (Disbursement Journal).

Balance - Invoiced minus Paid.

Sample(s)

5.1.1.18 Change Orders

Description

The Change Orders Report shows all Change Orders (approved/unapproved) that have been submitted

against all projects (active/inactive) for a given date range. Note: Change Orders are Requested in Project

Planning> Projects window.  More on Change Orders

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

Date Ranges
Change Order Start Date - Beginning Date used to filter the work orders that are brought into this report.

Change Order End Date - Ending Date used to filter the work orders that are brought into this report.

General
Project - Allows you to filter to a specific Project. When blank, All Projects are returned.

Change Order # - The Change Order Number can be entered to select a specific Change Order. When
blank, or 0, all Change Orders are returned.
Active Projects Only - When selected, only Active projects are returned in the report.

Project Currency - The Project Currency to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns

https://support.clearviewsoftware.net/articles/7614
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Project - Project Code and Name

Status - Status of the Work Order

C.O.# - The Change Order Number

Date - The Date of the Change Order

Detail - Description of the Work Order

Labor - Labor Budget Amount Requested with the Change Order.

ODC - ODC (Other Direct Charges) Budget Amount Requested with the Change Order.

OCC - OCC (Out of Contract Consultants) Budget Amount Requested with the Change Order.

ICC - ICC (In Contract Consultants) Budget Amount Requested with the Change Order.

Total - The total of the above Budget Amounts Requested with the Change Order.

Sample(s)

5.1.1.19 Change Transaction Period Utility

Description
The Change Transaction Period Utility is used to move a specific Transaction from one G/L Period to another.
 You can optionally select a single version or move all versions to the new G/L Period.

Prompt

General
New G/L Period - The G/L Period that you will be changing the selected Transaction to.

Journal - The Journal where the transaction resides. Options are Adjustments (General, Disbursements,
Employee Reimbursables, Purchase, Receipt and Sales Journals
Transaction ID - The ID number of the Transaction to be modified.

First Version - The starting version to be modified.  When "All Version" selected, this is ignored.

Last Version - The ending version to be modified.  When "All Version" selected, this is ignored.

All Version - When selected, all versions of the transaction will be changed to the "New G/L Period.

Only Open Periods - When selected, only open accounting periods will be modified.

Update Transaction -  When selected, the selected transaction is modified. If you would like to see a
"Draft" for what the change will look like, un-check the box and run the report.

Report

Report Columns
Messages - If an error message is returned, it will show up in this box.

Firm/Employee/Other - Depending on the selected journal, this will display the Firm, Employee or other
name associated with the transaction.
Reference # - This is different depending on the Journal. Invoice Number (Purchase Journal), Invoice
Number (Sales Journal), ERID (Employee Reimbursables Journal), Check Number (Disbursements
Journal), Check Number (Receipt Journal), GJID (General Journal)
Transaction ID - The Transaction ID of the Journal Transaction to be modified.

Transaction Date - This is different depending on the Journal. Invoice Date (Purchase Journal), Invoice
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Date (Sales Journal), Invoice Date (Employee Reimbursables Journal), Check Date (Disbursements
Journal), Check Date (Receipt Journal), Transaction Date (General Journal)
Revision - Revision(s) effected by the change.

G/L Account - G/L Account Associated with the modified transaction.

Amount - Amount associated with the modified transaction.

Current Period - Period associated with the transaction, before it was modified.

Period Status - Status of the Accounting period.  If closed, it will be filtered out if you select "Only Open
Periods" on the prompt.
New Period - New period that the transaction will be changed to when the utility is run.

Sample(s)

5.1.1.20 Charge Organization Analysis

Description
The Charge Organization Analysis report allows you to do an analysis of the Charge Org. (recorded in Time
Sheets) versus what the system currently would assign based on project setup rules.  This report is useful if
you set up the project rules after time sheets have already been entered. This report has an option so you
can retroactively update time sheets.   

Prompt

Date Ranges
Start Date - Beginning Date used to filter the transactions that are brought into this report.

End Date - Ending Date used to filter the transactions that are brought into this report.

General
Project - Allows you to filter to a specific Project. When blank, All Projects are returned.

Update Timesheets - When selected, Time Sheets are updated, retroactively.  The "Time Sheet Org." will
be changed to the "Calculated Org."

Report

Report Columns
Time ID - The Time Sheet ID of the time sheet that has a mis-match of the Time Sheet Org. and the
Calculated Org.
Project - The Project associated with the time sheet that has a mis-match of the Time Sheet Org. and the
Calculated Org.
Work Date - The Work Date of the Time Sheet.

Time Sheet Org. - The Org. Unit that was assigned at the point of time entry with the project setup rules
at that time.
Calculated Org. - The Org. Unit that would be assigned with the project setup rules at the current time.

Employee - Employee Code and Name

PE Date - The Period End Date of the Time Sheet
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Sample(s)

5.1.1.21 Clients

Description
The Clients report gives you a list of Clients with additional contact information.

Prompt

General
Client Type - Type of Firm. Options are Client, Prospect and Both.

Group / Sort By - Allows you to Group and Sort the Report by Client Code and Client Name.

Active Firms - When selected, Active Clients are returned in the report.

Inactive Firms - When selected, Inactive Clients are returned in the report.

Report

Report Columns
Client Code

Client Name

Address Information

Sample(s)

5.1.1.22 Client Inquiry

Description
The Client Inquiry report allows you to search for invoices, amounts billed, and other cost amounts paid to
vendors 

Note: This report is run for a date range.  You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Data: That data is collected from the Disbursements, Receipts, and the Sales Journals

Prompt

Date Ranges
Start & End Date - Filters the data by the transaction date on the Journal entry.

General
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Client Code - Allows you to filter to a specific Client. When blank, All Clients are returned.

G/L Account - Specifies the account to limit the report. When blank, all accounts are returned

Transaction Type - Allows you to filter report by Invoice or Payment types or to include both.

Show Invoice - If checked, will display invoiced amount in report.

Show Project - If checked, will display associated project with invoice.

Show WBS - If checked, will display the Work Breakdown Structure of the project.

Show Transaction Detail - If checked, will display invoice/check item detail 

Only Active Clients - If checked, filters the report only for vendors marked "active" in the Vendors applet.

Open Invoices Only - If checked, only returns unpaid invoices

Show Client Type - When selected, the report will display Client Type in the results. Client Type is
managed in Administration> List Managemment
Sort by Client Type - When selected, the report will sort/group by Client Type.

Invoice Currency - The Invoice Currency to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Trans Number - Invoice # (Disbursement & Sales Journal) or Check # (Receipt)

Transaction Type - Invoice (Sales Journal) or Check (Disbursement & Receipt Journal).

Project Amount - The Cost Amount from the Disbursement Journals. The Amount from the Sales and
Receipt Journals. 
Invoice Amount - The detailed Cost Amount from the Disbursement Journals.

Paid Amount - The Cost Amount from the Disbursement Journals and the Amount from the Receipts
Journals. 
Other Amount - The Cost Amount from the Receipts Journals. 

Sample(s)

5.1.1.23 Client Pay Performance

Description
The Client Pay Performance report gives you the average number of days it takes for a client to pay an
invoice.  A minimum number of invoices can be set before a client appears on the report.

Data: That data is collected from the Disbursements, Receipts, and the Sales Journals

Prompt

General
Sort By - Sorting Options (Firm Name, Fastest, Slowest)

Client - Allows you to filter to a specific Client. When blank, All Clients are returned.

Include Inactive Clients - When selected, Inactive clients are returned in the report.

Minimum # of Invoices - The minimum number of invoices to be sent to the client before showing up on
the report. 
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Report

Report Columns
Client Code

Client Name

Number of Invoices - Number of invoices that make up the Average Days number.

Average Days - The number of days between the Invoice Date (Sales Journal) and the Deposit Date
(Receipt Journal) 

Sample(s)

5.1.1.24 Consultant Tracking By Project then Sales Invoice

Description
The purpose of the Consultant Tracking By Project then Sales Invoice report is for consulting pay when paid
purposes.  The display of this report is grouped by Project first, then by Sales Invoice number (SJID).

Data: That Transactional data is collected from the Purchase, Disbursements, Receipts, and the Sales
Journals.  The Budget information (optional) comes from Project Planning> Scheduling.  The Schedule data,
for consultants, is entered in the OCC and/or ICC modes when in Project Planning. Be sure to roll-up the
Schedules to Allocations and Allocations to Budgets once you have established the correct amounts.

Note1:  This report has been deprecated and was replaced by the Pay When Paid by Project, Vendor and
Receipts Reports.

Note2: Only consultant charges in the Purchase Journal (Vendor Invoice), that have been linked to a Sales
Journal entry, are included in this report. Also, only A/R invoices with links to consultant purchases are
included. 

Note3: Vendors must be flagged as a "Consultant" in their Vendor File (AP> Vendors) to be pulled into this
report.

Prompt

Date Ranges
Aging Date - Used to calculate the "Days Old" column on the report. 

Age by Invoice Date - Determine which date is used when calculating the "Days Old" column on the
report.  If "Age by Invoice Date" is selected, the days between the Age Date and the Invoice Date, of the
Purchase Journal (Vendor Invoice), make up the Days Old. Otherwise, the Due Date of the Purchase
Journal (Vendor Invoice) is used.

General
Vendor - Allows you to filter to a specific Vendor. When blank, All Vendor are returned.

Project - Allows you to filter to a specific Project. When blank, All Project are returned.

Open Vendor Invoices Only - When selected, only Vendor Invoices that have an outstanding balance to
be paid will show up on the report.
Only Sales With Receipts - When selected, only Sales Invoices that have received a payment (Receipt
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Journal) will show up on the report.
Invoice Currency - The Invoice Currency to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Project

Project Budget - The Total OCC and ICC Budget going against the project.  This is applied in Project
Planning, Project Window. 
Sales Invoice No. - Invoice Number of the Sales Journal that was billed to the Client.

Total Billed - Total Bill Amount that was billed to the Client.

Consultant Billed - Total Consultant (OCC or ICC) Billed portion of the Sales Invoice. Note: Must be
posted to a Billed Revenue Account with a PM Type of either Out-of-Contract Consultants (OCC) or In-
Contract-Consultants (ICC).
Received - Total Amount Received against the specified Sales Invoice.

Balance - Total Billed minus Received

Vendor - The Vendor associated with the Vendor Invoice (Purchase Journal) that was billed on the Client
invoice(Sales Journal) for work done on the project. 
Vendor Budget - Scheduled Amount against the specific Vendor. This is applied in Project Planning,
Schedule Window.
Vendor Invoice - Invoice number of the Purchase Journal that was received from the Vendor.

Days Old -  If "Age by Invoice Date" is selected, the days between the Age Date and the Invoice Date, of
the Purchase Journal (Vendor Invoice), make up the Days Old. Otherwise, the Due Date of the Purchase
Journal (Vendor Invoice) is used.
Invoice Amount - Cost Amount of the Purchase Journal that was received from the Vendor.

Total Payments - Total of all payments (Disbursement Journal) made to the vendor in regard to the
Vendor Invoice that was received.
Cons. Cost - The Cost amount of the Vendor Invoice.

Cons. Effort - The Effort (marked-up) amount of the Vendor Invoice.

Sample(s)

5.1.1.25 Consultant Tracking By Project then Vendor

Description
The purpose of the Consultant Tracking By Project then Vendor Invoice report is for consulting pay when paid
purposes.  The display of this report is grouped by Project first, then by Vendor.

Data: That Transactional data is collected from the Purchase, Disbursements, Receipts, and the Sales
Journals.  The Budget information (optional) comes from Project Planning> Scheduling.  The Schedule data,
for consultants, is entered in the OCC and/or ICC modes when in Project Planning. Be sure to roll-up the
Schedules to Allocations and Allocations to Budgets once you have established the correct amounts.

Note1:  This report has been deprecated and was replaced by the Pay When Paid by Project, Vendor and
Receipts Reports.

Note2: Only consultant charges in the Purchase Journal (Vendor Invoice), that have been linked to a Sales



InFocus User Manual - Current (v2020)712

© 2020 Clearview Software, Inc.

Journal entry, are included in this report. Also, only A/R invoices with links to consultant purchases are
included. 

Note3: Vendors must be flagged as a "Consultant" in their Vendor File (AP> Vendors) to be pulled into this
report.

Prompt

Date Ranges
Aging Date - Used to calculate the "Days Old" column on the report. 

Age by Invoice Date - Determine which date is used when calculating the "Days Old" column on the
report.  If "Age by Invoice Date" is selected, the days between the Age Date and the Invoice Date, of the
Purchase Journal (Vendor Invoice), make up the Days Old. Otherwise, the Due Date of the Purchase
Journal (Vendor Invoice) is used.

General
Vendor - Allows you to filter to a specific Vendor. When blank, All Vendor are returned.

Project - Allows you to filter to a specific Project. When blank, All Project are returned.

Open Vendor Invoices Only - When selected, only Vendor Invoices that have an outstanding balance to
be paid will show up on the report.
Only Sales With Receipts - When selected, only Sales Invoices that have received a payment (Receipt
Journal) will show up on the report.
Invoice Currency - The Invoice Currency to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Project

Project Budget - The Total OCC and ICC Budget going against the project.  This is applied in Project
Planning, Project Window. 
Vendor - The Vendor associated with the Vendor Invoice (Purchase Journal) that was billed on the Client
invoice(Sales Journal) for work done on the project. 
Vendor Budget - Scheduled Amount against the specific Vendor. This is applied in Project Planning,
Schedule Window.
Invoice (Vendor Invoice) - Invoice number of the Purchase Journal that was received from the Vendor.

Days Old -  If "Age by Invoice Date" is selected, the days between the Age Date and the Invoice Date, of
the Purchase Journal (Vendor Invoice), make up the Days Old. Otherwise, the Due Date of the Purchase
Journal (Vendor Invoice) is used.
Invoice Amount -  Total Invoice (Cost) Amount of the Purchase Journal that was received from the
Vendor.
Total Payments - Total of all payments (Disbursement Journal) made to the vendor in regard to the
Vendor Invoice that was received.
Cons. Cost - The Cost amount of the Vendor Invoice.

Cons. Effort - The Effort (marked-up) amount of the Vendor Invoice.

SJ (Sales Journal) Invoice No. - Invoice Number of the Sales Journal that was billed to the Client.

Total Billed - Total Bill Amount that was billed to the Client.

Cons. Billed - Total Consultant (OCC or ICC) Billed portion of the Sales Invoice. Note: Must be posted to
a Billed Revenue Account with a PM Type of either Out-of-Contract Consultants (OCC) or In-Contract-
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Consultants (ICC).
Received - Total Amount Received against the specified Sales Invoice.

Sample(s)

5.1.1.26 Consultant Tracking By Vendor then Project

Description
The purpose of the Consultant Tracking By Vendor then Project Invoice report is for consulting pay when paid
purposes.  The display of this report is grouped by Vendor first, then by Project.

Data: That Transactional data is collected from the Purchase, Disbursements, Receipts, and the Sales
Journals.  The Budget information (optional) comes from Project Planning> Scheduling.  The Schedule data,
for consultants, is entered in the OCC and/or ICC modes when in Project Planning. Be sure to roll-up the
Schedules to Allocations and Allocations to Budgets once you have established the correct amounts.

Note1:  This report has been deprecated and was replaced by the Pay When Paid by Project, Vendor and
Receipts Reports.

Note2: Only consultant charges in the Purchase Journal (Vendor Invoice), that have been linked to a Sales
Journal entry, are included in this report. Also, only A/R invoices with links to consultant purchases are
included. 

Note3: Vendors must be flagged as a "Consultant" in their Vendor File (AP> Vendors) to be pulled into this
report.

Prompt

Date Ranges
Aging Date - Used to calculate the "Days Old" column on the report. 

Age by Invoice Date - Determine which date is used when calculating the "Days Old" column on the
report.  If "Age by Invoice Date" is selected, the days between the Age Date and the Invoice Date, of the
Purchase Journal (Vendor Invoice), make up the Days Old. Otherwise, the Due Date of the Purchase
Journal (Vendor Invoice) is used.

General
Vendor - Allows you to filter to a specific Vendor. When blank, All Vendor are returned.

Project - Allows you to filter to a specific Project. When blank, All Project are returned.

Open Vendor Invoices Only - When selected, only Vendor Invoices that have an outstanding balance to
be paid will show up on the report.
Only Sales With Receipts - When selected, only Sales Invoices that have received a payment (Receipt
Journal) will show up on the report.
Invoice Currency - The Invoice Currency to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
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Vendor - The Vendor associated with the Vendor Invoice (Purchase Journal) that was billed on the Client
invoice(Sales Journal) for work done on the project. 
Project

Project Budget - The Total OCC and ICC Budget going against the project.  This is applied in Project
Planning, Project Window. 
Vendor Budget - Scheduled Amount against the specific Vendor. This is applied in Project Planning,
Schedule Window.
Invoice (Vendor Invoice) - Invoice number of the Purchase Journal that was received from the Vendor.

Days Old -  If "Age by Invoice Date" is selected, the days between the Age Date and the Invoice Date, of
the Purchase Journal (Vendor Invoice), make up the Days Old. Otherwise, the Due Date of the Purchase
Journal (Vendor Invoice) is used.
Invoice Amount -  Total Invoice (Cost) Amount of the Purchase Journal that was received from the
Vendor.
Total Payments - Total of all payments (Disbursement Journal) made to the vendor in regard to the
Vendor Invoice that was received.
Cons. Cost - The Cost amount of the Vendor Invoice.

Cons. Effort - The Effort (marked-up) amount of the Vendor Invoice.

SJ (Sales Journal) Invoice No. - Invoice Number of the Sales Journal that was billed to the Client.

Total Billed - Total Bill Amount that was billed to the Client.

Cons. Billed - Total Consultant (OCC or ICC) Billed portion of the Sales Invoice. Note: Must be posted to
a Billed Revenue Account with a PM Type of either Out-of-Contract Consultants (OCC) or In-Contract-
Consultants (ICC).
Received - Total Amount Received against the specified Sales Invoice.

Sample(s)

5.1.1.27 Contacts

Description
The Contacts report gives you a list of Contacts with additional contact information.

Data: Contacts (Firms table)

Prompt

General
Last Name - Allows you to filter the report by the first letter of the Last Name of the Contacts list.

Firm - Allows you to filter the Contact list to a specific Firm. If left blank, all contacts are returned.

Print Detail - When selected, the contacts contact information is shown on the report (ie. Phone, Email &
Address)

Report

Sample(s)
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5.1.1.28 Contract Backlog

Description

The Contract Backlog is a report that compares Fixed Fee and Contract Amounts (Labor,ODC,OCC & ICC)

to Billed and Unbilled WIP (billing status of R or H).

Data: Figures come from the following:
Contract - Fixed Fee and Labor/ODC/ODD/ICC Contract Amounts.  

Unbilled - Transactions come from the Time Sheets, Purchase Journal, Employee Reimbursables
Journal, Disbursement Journal applets. Unbilled only includes transactions with a Bill Status of R
(Ready to Bill) and H (Hold).
Billed - Billed numbers come from the Sales Journal, Receipt Journal, General Journal applets. 

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

Date Ranges
As of Date - The As of Date is the transaction cut-off date for this report. This number effects only the
Billed and Unbilled number since Budgets are not date sensitive.

General
Project - Allows you to filter to a specific Project. When blank, All Projects are returned.

Include Inactive Projects - When selected, Projects that are Inactive are returned in the report.

Only Projects with Contracts - When selected, only projects that have Fixed Fee and Contract Amounts
populate the report.
Project Currency - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Contract Amount - Fixed Fee and Labor, ODC (Other Direct Charges), OCC (Out-of-Contract
Consultants) and ICC (In-Contract Consultants) Contract Amounts.
Billed (Budget) - Billed Revenue numbers from the Sales, Receipt and General Journals that go against
project nodes that have a Contract Amount.  
Unbilled (Budget) -The Effort amount of transactions that have a Bill Status of R (Ready to Bill) and H
(Hold) that go against project nodes that have a Contract Amount.
Billed (Non-Budget) - Billed Revenue numbers from the Sales, Receipt and General Journals that go
against project nodes that do not have a Contract Amount.  
Unbilled (Budget) -The Effort amount of transactions that have a Bill Status of R (Ready to Bill) and H
(Hold) that go against project nodes that do not have a Contract Amount.

Sample(s)

https://support.clearviewsoftware.net/articles/7614
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5.1.1.29 Currency Exchange Rates

Description
The Currency Exchange Rates Report is used when using InFocus Muli-Currency.The report gives you the
Currencies currently configured in your system as well as the "Currency Pairs" that are configured in your
system This information comes from General Accounting> Multi-Currency. More on Multi-Currency

Prompt

General
Exchanges Rate From This Date Forward - This date is used as a "Since" date and brings in all Currency
Pairs since the date selected.
Include Inactive Currencies - When selected, Currencies that have been marked as Inactive will be
brought into the report.

Report

Report Columns
Name - Required Field containing the selected culture's currency name.

Code -  International three character monetary code. This important setting drives the import of system
exchange rates.
Symbol - Represents the system wide currency symbol.

Culture - Configures the base culture the business is operating in and drives system report formats.

Units - Represents the smallest unit in the selected currency. Example: For U.S. Dollars, 1 represents the
Penny (the system will round to the nearest penny).
Precision - Defines columns to the right of the decimal place and drives system rounding. Example:
Precision 2 rounds to the nearest hundredth (5.248 = 5.25).
Major Denomination - Defines the singular and plural cases for check printing. For example, USD major
labels are "dollar" and "dollars".
Minor Denomination - Defines the singular and plural cases for check printing. For example, USD minor
labels are "cent" and "cents".

Detail
From Currency - The originating currency in the exchange.

ToCurrency - The destination currency in the exchange.

Triangulating Currency - The interim currency in the exchange if required. A triangulation is used when no
direct exchange rate exists between currencies. For instance, if an exchange from Yens to Euros did not
exist but Yen to USD and USD to Euro exchanges did exist, the currency pair for Yens to Euros could be
defined, triangulated via USD. Please note to utilize a triangulating currency, there must be accompanying
currency pairs to define the exchange relationship between the From and Triangulating currency and the
Triangulating and To currencies.
Use Reciprocal - Indicates the defined exchanges relationship can be utilized inversely.

Date - Date the Exchange Rate was at that rate.

Exchange Rate - The Exchange Rate from the From Currency to the To Currency.

Sample(s)
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5.1.1.30 Disbursement Journal Single Transaction

Description
The Disbursement Journal Single Transaction Report gives you the ability to sprint out a specific
Disbursement Journal Entry for a specific Version.  When in the Disbursement Journal applet, you can launch
this report by simply clicking "Print" on the toolbar.  The version showing is the one that will be displayed. 
Additionally, if "Show Audit Trail" is checked, you will see an audit trail of the changes made on that entry.

Prompt

General
Disbursement Journal ID Number - ID number of the Journal entry. This can be entered in the look-up to
pull the transaction up.
Revision Number - The Version of the number that you want to view.

Show Audit Trail - When selected, you will see the Create By, Create Date, Modify By, Modify Date  and
the changes that happened between versions of the transaction.

Report

Report Columns
Bank - The Bank G/L Account used on the transaction.

Payee Type - The type of the recipient of the disbursement.  Options are Vendor, Employee Client and
Other
 Pay To - Recipient of the Disbursement.

Check Number

Check Date

Current Period

Revision - The version of the transaction

Project

Invoice Number - Invoice Number that the Disbursement is linked to.

Expense Code

G/L Account

G/L Account Name

G/L Period

Status - Options are Ready to Bill (R), Hold (H), Billed (B), Write Off (W) and Never Bill (N)

Amount

Comments

Check Memo

Sample(s)
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5.1.1.31 Disbursements By Date

Description
The Disbursements By Date Report allows you to look at all transactions that go against the Disbursement
Journal(cash and accrual) for a particular Date Range.

Data: Disbursement Journal (cash and accrual)

Note: This report is run for a date range. You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Prompt

Date Ranges
Start & End Date - Filters the data by the Date Type supplied in the next selection. 

Date Type (Required) - Options are:
o Check Date - The Check date of the journal entry.
o Create Date - Create Date of the transaction
o Modify Date - Modify Date of the transaction

General
Bank Base Code - Filters to a specific GL Base Code of the Transactions.

Use Bank Org. Filter - When selected, the Bank Org. Unit selected is used to filter the report.

Bank Org Unit - Filters to a specific the Organizational Unit related to the GL Base Code of the
Transaction.
Include Org. Children - Includes the Organization Units Children  when filtering to a specific the
Organizational Unit.
Is Accrual - When checked, the report looks at the Accrual Journals (Receipts & Disbursements) instead
of the Cash Basis Journals (CBReceipts & CB Disbursements). Note: The Cash Basis Journals are
populated by running the Cash Basis Conversion Utility.
Hide Detail - When selected, the detail of the Disbursement Journal is hidden.

Show Comments - When checked, the report will show the GL Comments from the line-items of the
Journals.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
The Sorts section Groups & Sorts the report by Check Date, Check No (Number), Create Date, Modify Date,
Payee and Bank (Account).

Sort 1 - Top Level Sort

Sort 2 - Second Level Sort. 

Sort 3 - Third Level Sort

Report

Report Columns
Bank Account - Bank G/L Account associated with the transaction.

Check Number - Check number associated with the transaction.
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Payee Name - Name of the Check Recipient.

Check Date - The Check Date Associated with the transaction.

Amount - Amount of the Disbursement Transaction.

Account - G/L Account associated with the detail of the Disbursement Transaction.

Project - The Project associated with the detail of the Disbursement Transaction.

Invoice Number - The Purchase Journal Invoice Number associated with the detail of the Disbursement
Transaction.
Amount - The amount of the line item in the detail of the Disbursement Transaction. 

Sample(s)

5.1.1.32 Employee Benefit Report

Description
The Employee Benefit Report give an employee a detailed summary of their Benefit balances.  You must be
using the Benefit Accrual feature for this to populate with data.

Prompt

Benefit Project - The Benefit to report on.  You must be using the Benefit Accrual feature and be a
member of the Accrual Project for this drop-down to populate with data.

Report

Report Columns
Project - Benefit Project. If using an overriding name, it will show, otherwise the standard project name is
displayed.
Current Benefit Year - Displays the date range of the most recently run Benefit year.

Accrual Transactions
Transaction Date - Date of the transaction.

Amount - Hours of the transaction

Type - Type of Transaction. Options are Standard, Used, Adjustment and Carry-Over

Comment - Description of the transaction.

Summarized By Type
Transaction Date

Drill-through Report
Transaction Type - Type of Transaction. Options are Standard, Used, Adjustment and Carry-Over

Amount - Summarized hours by Transaction Type

Sample(s)
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5.1.1.33 Employee Inquiry

Description
The Employee Inquiry Report reports on Employee Time and Expense for a given date range. 

Data: Time Sheets and the Employee Reimbursables Journal

Prompt

Date Ranges
Start & End Date - Filters the data by the transaction date on the Time Sheet and Journal entries. 

General
Employee - Allows you to filter to a specific Employee. When blank, All Employees are returned.

Project -  Allows you to filter to a specific Project. When blank, All Projects are returned.

Labor Code - Allows you to filter to a specific Labor Code used in an Employee Time Sheet. When blank,
All Labor Codes are returned.
Expense Code - Allows you to filter to a specific Expense Code used in an Employee Expense Sheet.
When blank, All Expense Codes are returned.
Include Labor - When selected, Time Sheet transactions will be included in the returned data.

Include Expense - When selected, Employee Reimbursable transactions will be included in the returned
data.
Show Detail - When selected, the detail lines of the report are displayed (ie. Date, Charge Org, Labor/
Expense Code, Units, OT Type Cost and Effort)
Show Comments - When selected, PM Comments are displayed on the report.

Report

Report Columns
Date - WorkDate (Time Sheets) and TransDate (Employee Reimbursables Journal)

Charge Org - Organization that gets to recognize the Cost of Labor (Typically used in Labor Distribution).
 
Labor/Expense Code - Labor Code (Time Sheet) / Expense Code (Employee Reimbursable Journal)

Hrs/Units - Work Hours (Time Sheet) / Units (Employee Reimbursable Journal)

OT Type - Overtime Type. This is used when multiple Overtime Types are being used. More on Overtime
Types
Cost - Labor Cost at the Pay Rate (Employee must have "Can view Pay Rate" selected for this to
populate)
Effort - Labor Cost at the Billing Rate.

Sample(s)

5.1.1.34 Employee Job Titles

Description



InFocus System Reports 721

© 2020 Clearview Software, Inc.

Prompt
 The Employee Job Titles Report shows you the allowable Job Titles for your employees, including the
Default Job Title. This report can be run for all active employees or one employee. Additionally, it points out
InActive Job Titles that are assigned to Employees. Group / Sort options include by Employee Name or Job
Title Name.  When run for a single project the report uses the project member tab overrides otherwise it uses
employee setup information.

General
Employee - Select a single Employee or leave blank to see all employees.

Project - Select a single Project or leave blank to see all projects. Note: That when run for a single project
the report uses the project member tab overrides instead of looking at the employee setup information.
Job Title - Select a single Job Title or leave blank to see all Job Titles.

Group / Sort By - Sort and Group the report by either Employee Name or Job Title Name.

Report

Report Columns
Employee

Job Title

Work Pct. - Work % assigned to the Job Title on the Employees> Job Titles Tab.

Default - Either the Job Title with the highest Work % on the Employees> Job Titles Tab OR the Default
Job Title assigned on the Project> Members Tab. In the event of even percentages, the one that comes
first, alphabetically, is the default.

Sample(s)

5.1.1.35 Employee Reimbursable Single Transaction

Description
The Employee Reimbursable Journal Single Transaction Report gives you the ability to sprint out a specific
Employee Reimbursable Journal Entry for a specific Version.  When in the Employee Reimbursable Journal
applet, you can launch this report by simply clicking "Print" on the toolbar.  The version showing is the one
that will be displayed.  Additionally, if "Show Audit Trail" is checked, you will see an audit trail of the changes
made on that entry.

Prompt

General
Employee Journal ID Number - ID number of the Journal entry. This can be entered in the look-up to pull
the transaction up.
Revision Number - The Version of the number that you want to view.

Show Audit Trail - When selected, you will see the Create By, Create Date, Modify By, Modify Date  and
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the changes that happened between versions of the transaction.

Report

Report Columns
E/R Account - The Employee Reimbursable G/L Account used on the transaction.

Employee

Invoice Date

Current Period

Revision - The version of the transaction

Project

Expense Code

G/L Account

G/L Account Name

G/L Period

Status - Options are Ready to Bill (R), Hold (H), Billed (B), Write Off (W) and Never Bill (N)

Amount

G/L Comments

E/R Comments

Sample(s)

5.1.1.36 Employee Reimbursables By Date

Description
The Employee Reimbursables By Date Report allows you to look at all transactions that go against the
Employee Reimbursables (E/R) Journal for a particular Date Range.

Data: Employee Reimbursables Journal

Note: This report is run for a date range. You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Prompt

Date Ranges
Start & End Date - Filters the data by the Date Type supplied in the next selection. 

Date Type (Required) - Options are:
o Invoice Date - The Invoice date of the journal entry.
o Create Date - Create Date of the transaction
o Modify Date - Modify Date of the transaction

General
E/R Base Code - Filters to a specific GL Base Code of the Transactions.

Use Org. Filter - When selected, the Bank Org. Unit selected is used to filter the report.

E/R Org. Unit - Filters to a specific the Organizational Unit related to the GL Base Code of the
Transaction.
Include Org. Children - Includes the Organization Units Children  when filtering to a specific the
Organizational Unit.
Hide Detail - When selected, the detail of the Disbursement Journal is hidden.

Show Comments - When checked, the report will show the GL Comments from the line-items of the
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Journals.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
The Sorts section Groups & Sorts the report by Invoice Date, Create Date, Employee, E/R Account and
Transaction No.

Sort 1 - Top Level Sort

Sort 2 - Second Level Sort. 

Sort 3 - Third Level Sort

Report

Report Columns
E/R Account - Employee Reimbursable G/L Account associated with the transaction.

Employee Name - Employee associated with the transaction.

Invoice Date - The Invoice Date Associated with the transaction.

Amount - Amount of the Transaction.

Account - G/L Account associated with the detail of the E/R Transaction.

Project - The Project associated with the detail of the E/R Transaction.

Expense Code - The Expense Code associated with the detail of the E/R Transaction.

Amount - The amount of the line item in the detail of the E/R Transaction. 

Sample(s)

5.1.1.37 Expense  Check Stub

Description
The Expense Check Stub report is designed to be run by the employee who receives a check.  It will detail
what expense sheet items are being paid on a given check.  To make this available to all employees first give
permissions to a group that includes all employees and then assign the report to appear in the Personal
module.

Data: Disbursement Journal, Employee Reimbursable's Journal and Expense Sheets

Note: Only checks run by the Logged in user are returned when the report is run.

Prompt

Check No (required) - The check number, from the Disbursement, that the employee wants to see the
detail for.

Report

Report Columns
Check No. - Check Number (Disbursement) of the check that was posted to pay the reimbursable
amount.
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Invoice No. - The Employee Reimbursable ID Number that was created after importing Expense Sheets.

Expense Sheet - The Date and Expense Sheet Name of the Expense Sheet that was used to create the
Employee Reimbursable Journal Entry.
Date - Transaction Date from the Expense Sheet.

Project Path -  Project Path from the Expense Sheet.

Project Name -  Project Name from the Expense Sheet.

Exp. Code - Expense Code from the Expense Sheet.

Amount - Reimbursable Amount from the Expense Sheet.

Sample(s)

5.1.1.38 Expense Code Listing

Description
This report lists all the Expense Codes set up in the system. You are able to filter by Type, Status and by
those only viewable in Expense Sheets. 

Prompt

General
Type - The type of Expense Code. This refers to the "Exp. Code Type" column in the Expense Code
applet.  Options are Other Direct Charge (ODC), Consultant, In-Contract Consultant (ICC), Out of
Contract Consultant (OCC) and Any Type.
Status - Active Status of the Expense Codes. Options are Active, Inactive and All.

Only Codes Viewable In Expense Sheets - When selected, only expense codes that can be viewed in
Expense Sheets are returned.  This refers to the "Show in Expense Sheet" checkbox.
Sort By - Sorts the returned results. Options are Code and Name.

Report

Report Columns
Expense Code

Expense Name

Type - The type of Expense Code. This refers to the "Exp. Code Type" column in the Expense Code
applet.  Options are Other Direct Charge (ODC), Consultant, In-Contract Consultant (ICC) and Out of
Contract Consultant (OCC).
Status -  Active Status of the Expense Code. Options are Active, Inactive and All.

Currency (optional) - The Currency associated with the Expense Code.

Sample(s)
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5.1.1.39 Expense Group Assignments

Description
This report lists the Expense Groups with all Projects that are using that Expense Group listed below.

Prompt

General
Expense Group Active Date - Since Expense Groups are date sensitive, the Active Date is used to filter
out Expense Groups that have period dates that include the Active Date.
Project Status - Filters out returned projects by that have the selected Status. Options include Active,
Inactive and Both.

Report

Report Columns
Rate Schedule Name

Project Path

Project Name

Sample(s)

5.1.1.40 Expense Group Detail

Description
The Expense Group Detail report lists the expense group detail and setup including expense codes and
markups.

Prompt

General
Expense Group Name (required) - Name of the Expense Group 

Expense Group Active Date -  Since Expense Groups are date sensitive, the Active Date is used to filter
out Expense Groups that have period dates that include the Active Date.

Report

Report Columns
Code - Expense Code

Name - Expense Name

Type - The type of Expense Code. This refers to the "Exp. Code Type" column in the Expense Code
applet.  Options are Other Direct Charge (ODC), Consultant, In-Contract Consultant (ICC) and Out of
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Contract Consultant (OCC).
MU Type - Markup Type.  The type of markup that calculates the Bill Rate for the expense. More on 
Expense Codes
Markup - Depending on the Markup Type, this is the number that is used to calculate the Bill Rate of the
Expense.
Unit Rate - The Cost Rate of the expense. Depending on the Markup Type, this is the number that is as
the "base" in the calculation of the Bill Rate of the Expense.
Currency (optional) - The Currency associated with the Expense Code.

Sample(s)

5.1.1.41 Expense Sheet Status

Description
 This report is designed to be run by the individual employee.  It will give a status report on expense sheets
for a given date range.  Possible statuses are paid, processed (imported and approved by accounting but not
yet paid), declined (rejected by accounting), mgr approved (approved by manager), submitted (by employee),
and unsubmitted. To make this available to all employees first give permissions to a group that includes all
employees and assign the report to appear in the Personal module.

Prompt

General
Range Start Date - The Start Date used to filter out expense sheets by their Create Date.

Range End Date - The End Date used to filter out expense sheets by their Create Date.

Report

Report Columns
Date - Transaction Date of the line item in the Expense Sheet.

Project - Project Path

Exp. Code - Expense Code 

Reim. Amount- Amount to be Reimbursed to the employee.

Invoice No. - Employee Reimbursable ID number

Check No. - The Check Number associated with the check (disbursement) that was paid against the
Employee Reimbursement.
Status - Status of the Expense. Statuses are Paid, Processed (imported and approved by accounting but
not yet paid), Declined (rejected by accounting), Mgr. Approved (approved by manager), Submitted (by
employee), and Unsubmitted.

Sample(s)
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5.1.1.42 Financial Statement Analyzer

Description
This report is used to Analyze the structure of Financial Statements built using the Financial Statement
Designer. It displays three tables of information.  The first table shows what accounts per statement line will
be used.   The second table shows what accounts are not referenced in the design.  The third table shows
what lines reference an account more than once. 

Prompt

General
Statement Name - Name of the Financial Statement to be Analyzed.

Show Org. Units - When selected, Org. Units (Org Path) are displayed in a separate column on the
report.
Show Design - When selected, the details of the FS Design are displayed.

Show Unreferenced Accounts - When selected, a "G/L Accounts Not Referenced" section will display at
the bottom of the report showing what accounts are not referenced in the design.
Show Duplicate References -  When selected, a "Duplicate References" section will display at the bottom
of the report showing what lines reference an account more than once in the design.

Report

Report Columns
Line # - Line Order associated with the Financial Statement Designer

Label - Line Label associated with the Financial Statement Designer

Line Type - Command Type associated with the Financial Statement Designer

Math - Calculation used with the associated account.

Base Account - G/L Account 

Org Path - Org. Unit Path associated with the G/L Account.

Sample(s)

5.1.1.43 Form 1099 Detail Backup

Description
This custom report’s print options are identical to Form 1099’s load options.  The report provides a detailed
and summarized backup of the 1099’s.

Prompt

General
1099 Year - Calendar year that should be analyzed.
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1099 Minimum - Minimum amount paid out before a 1099 should be generated for a given vendor or
employee.
1099 Style - Options are Detailed, Summary and Both. Detailed gives a detailed breakdown of the 1099
items. Summary gives a Summarized line of the 1099 items.
All Vendors - When checked, all vendors are selected.

Vendor -  If All Vendors is not checked, you can select individual vendor here.

All Employees - When checked, all employees are selected.

Employee -  If All Employees is not checked, you can select individual employees here.

Org. Unit - You can select a specific Org. Unit to print the report on.

Run Cash Basis Conversion - When checked, the cash based conversion utility will be run prior to
generating 1099's. Cash journals are used in 1099 calculations.
Use All Accounts - When checked, all G.L accounts are considered for 1099 pay amount; otherwise, only
accounts that are flagged in the chart of accounts as 1099 accounts will be used.

Report

Report Columns
Trans ID - ID Number of the Transaction

JN - Abbreviation of the Journal that the transaction originates.

Check Date - Date of the Disbursement (Check)

Check Number

G/L Account - G/L Account associated with the transaction.

Amount - Amount of the transaction.

Sample(s)

5.1.1.44 General Journal By Date

Description
The General Journal By Date Report allows you to look at all transactions that go against the General Journal
(cash and accrual) for a particular Date Range.

Data: General (Adjustments) Journal (cash and accrual)

Note: This report is run for a date range. You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Prompt

Date Ranges
Start & End Date - Filters the data by the Date Type supplied in the next selection. 

Date Type (Required) - Options are:
o Transaction Date - The Transaction date of the journal entry.
o Create Date - Create Date of the transaction
o Modify Date - Modify Date of the transaction

General
Org Unit - Filters to a specific the Organizational Unit related to the GL Base Code of the Transaction.
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Include Org. Children - Includes the Organization Units Children  when filtering to a specific the
Organizational Unit.
Is Accrual - When checked, the report looks at the Accrual Journals (Receipts & Disbursements) instead
of the Cash Basis Journals (CBReceipts & CB Disbursements). Note: The Cash Basis Journals are
populated by running the Cash Basis Conversion Utility.
Hide Detail - When selected, the detail of the Disbursement Journal is hidden.

Show Comments - When checked, the report will show the GL Comments from the line-items of the
Journals.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
The Sorts section Groups & Sorts the report by Transaction Date, Create Date, Modify Date, Transaction No.

Sort 1 - Top Level Sort

Sort 2 - Second Level Sort. 

Sort 3 - Third Level Sort

Report

Report Columns
Trans ID - Identification number of the General Journal Entry

Trans Date - The Transaction Date Associated with the transaction.

Comment - G/L Comment associated with the transaction.

Account - G/L Account associated with the detail of the General Journal Transaction.

Project - The Project associated with the detail of the General Journal Transaction.

Expense Code - The Expense Code associated with the detail of the General Journal Transaction.

Amount - The amount of the line item in the detail of the General Journal Transaction. 

Sample(s)

5.1.1.45 General Journal Single Transaction

Description
The General Journal Single Transaction Report gives you the ability to sprint out a specific General Journal
Entry for a specific Version.  When in the General Journal applet, you can launch this report by simply
clicking "Print" on the toolbar.  The version showing is the one that will be displayed. You also have the ability
to separate the Debits and Credits into two separate columns on this report.  Additionally, if "Show Audit
Trail" is checked, you will see an audit trail of the changes made on that entry.

Prompt

General
Disbursement Journal ID Number - ID number of the Journal entry. This can be entered in the look-up to
pull the transaction up.
Revision Number - The Version of the number that you want to view.
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Show Audit Trail - When selected, you will see the Create By, Create Date, Modify By, Modify Date  and
the changes that happened between versions of the transaction.
Separate Debits and Credits - When selected, the Debits and Credits will be split into two separate
columns on this report.

Report

Report Columns
Transaction Type

Transaction Date

Cash/Accrual Type

Closing Entry - Denotes whether or not the transaction is an End of Year Closing Entry.

Ignore in Rev. Rec. - When selected, the entry is ignored when Revenue Recognition processes are run.

Labor Dist. Entry - Denotes whether or not the transaction is a Labor Distribution Entry.

Current Period

Revision - The version of the transaction

Project

Expense Code

G/L Account

G/L Account Name

Amount

G/L Comments

Sample(s)

5.1.1.46 General Ledger By Date

Description
The General Ledger Report shows you the details of every transaction going in and out of your accounts
using a Date Range as a filter. This report can help ensure that all your Accounts balance. 

Data: Sales Journal, Purchase Journal, Employee Reimbursables Journal, Receipt Journal (cash and
accrual), Disbursement Journal(cash and accrual), General Journal

Note: This report is run for a date range.  You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that use a GL Period as a Date Filter.

Prompt

Date Ranges
Start & End Date - Filters the data by the Date Type supplied in the next selection. 

Date Type (Required) - Options are:
o Transaction Date - The transaction date of the journal entry (ie. invoice date, check date or trans date)
o Create Date - Create Date of the transaction
o Modify Date - Modify Date of the transaction

General
GL Account (comma delimited) - Filters to specific GL Accounts associated with the Transactions.  A
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comma delimited list of accounts can be entered here to bring in multiple accounts (for example:
10001,1000E, 10002)
Org Unit - Filters to a specific the Organizational Unit related to the GL Base Code of the Transaction.

Include Org. Children - Includes the Organization Units Children  when filtering to a specific the
Organizational Unit.
Consolidate - When selected, the Accounts will beconsolidated into a single line item per account.
Otherwise, the accounts will be broken out by Org Unit (if applicable).
Is Accrual - When checked, the report looks at the Accrual Journals (Receipts & Disbursements) instead
of the Cash Basis Journals (CBReceipts & CB Disbursements). Note: The Cash Basis Journals are
populated by running the Cash Basis Conversion Utility.
Print Comments - When checked, the report will show the GL Comments from the line-items of the
Journals.
Print Control Number - When selected, the control number (ie. invoice date, check date or trans date) of
the transaction will display on the report.
Print Detail - When selected, the details of the transactions will be displayed on the report.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
Sort by Journal - When selected, the report will Group/Sort by the journal that the transaction originates
in. 

Report

Report Columns
Journal - Journal that the account originates from.

Transaction ID - ID of the Journal

Date - Invoice Date (Sales, Purchase,Employee Reimbursable), Check Date (Receipt, Disbursement), or
TransDate (General Journal) depending on the Journal being reported on. 
Description - Depending on the Journal, this can be the Employee Name, Firm Name or Employee Name.
 
Beginning Balance - Balance of the account "As of" the Start Date of the Report.

Ending Balance - Balance after all debits and credits are factored in.

Sample(s)

5.1.1.47 Home Organization Analysis

Description
This report allows you to an analysis of the Home Org. recorded in time sheets versus what the system
currently would assign based on employee setup. The Home Org Analysis report compares the Org. Unit set
in the Employee File (Employee Information Tab> Company Information section) vs the Home Org. that is
was calculated and stored in the time sheet at the point of entry. The report only displays time sheets that
have a mismatch. This report has an option so you can retroactively update time sheets.  

Note: This report is useful if you set up an Employee Org. after the time sheets have already been entered.

Data: The data is collected from the Time Sheets and Employee tables.
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Prompt

General
Start Date - Beginning Date used to filter the transactions that are brought into this report.

End Date - Ending Date used to filter the transactions that are brought into this report.

Update Time Sheets - When selected, the time sheets that have a mismatch will be updated to reflect the
Org. that the system currently would assign based on employee setup.

Report

Report Columns
Time ID - The ID number of the Time Sheet 

Project - The Project that the Time Sheet is entered against.

Work Date - The Time Sheet Work Date.

Time Sheet Org. - The Org. Unit that the Time Sheet is currently holding.

Calculated Org. The Org. Unit that the system currently would assign based on employee setup.

Sample(s)

5.1.1.48 Income Statement with Budgets

Description

The Income Statement is also called a Profit and Loss Statement (P&L). The purpose of the Income

Statement is to show managers and investors whether the company made or lost money during the reported

period. Income Statements represent a period of time, whereas the Balance Sheet represents a single

moment in time. 

The Income Statement with Budgets report includes budgets that are entered through the G/L Budgets applet
under General Accounting. More on G/L Budgets

Prompt

General
G/L period (required) - The selected G/L Period for the report.  All returned data falls within the selected
G/L Period.
Org Unit - When selected, the data is filtered to display only the specified Organizational Unit, and its
children Orgs. 
Cash Basis - When checked, the report reports on a Cash Basis. What that means is that the report
looks at the the Cash Basis Journals (CBReceipts & CBDisbursements) instead of the Accrual Basis
Journals (Receipts & Disbursements). Note: The Cash Basis Journals are populated by running the Cash
Basis Conversion Utility.
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Consolidate - When selected, All of the Organizational Units are consolidated into one line instead of
being broken out into their respective Org. Units.
Show Base Code - When selected, the Base Code of the G/L Account is displayed in addition to the Full
GL Account Name.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency
Include Realized Gains Losses - When selected, Realized Gains Losses are includes in the returned data
(Multi-Currency only). More on MC Revaluations
Include Unrealized Gains Losses - When selected, Unrealized Gains Losses are includes in the returned
data (Multi-Currency only). More on MC Revaluations

Report

Report Columns
Code - G/L Account Code

Name - G/L Account Name

Current - Current amount for the selected period. 

Current Budget - G/L Budget for the selected period.

Year to Date - Amount for the year of the selected G/L Period, up to the selected period.

YTD Budget - Budget for the year of the selected G/L Period, up to the selected period.

Sample(s)

5.1.1.49 Income Statement with drill-down

Description

The Income Statement is also called a Profit and Loss Statement (P&L). The purpose of the Income

Statement is to show managers and investors whether the company made or lost money during the reported

period. Income Statements represent a period of time, whereas the Balance Sheet represents a single

moment in time. Additionally, you are given the ability to see all "drill-down" into each account on the report. 

The blue hyperlink indicates where you can do this. 

Prompt

G/L period (required) - The selected G/L Period for the report.  All returned data falls within the selected
G/L Period.
Org Unit - When selected, the data is filtered to display only the specified Organizational Unit, and its
children Orgs. 
Cash Basis - When checked, the report reports on a Cash Basis. What that means is that the report
looks at the the Cash Basis Journals (CBReceipts & CBDisbursements) instead of the Accrual Basis
Journals (Receipts & Disbursements). Note: The Cash Basis Journals are populated by running the Cash
Basis Conversion Utility.
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Consolidate - When selected, All of the Organizational Units are consolidated into one line instead of
being broken out into their respective Org. Units.
Show Base Code - When selected, the Base Code of the G/L Account is displayed in addition to the Full
GL Account Name.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency
Include Realized Gains Losses - When selected, Realized Gains Losses are includes in the returned data
(Multi-Currency only). More on MC Revaluations
Include Unrealized Gains Losses - When selected, Unrealized Gains Losses are includes in the returned
data (Multi-Currency only). More on MC Revaluations

Report

Report Columns
Code - G/L Account Code

Name - G/L Account Name

Current - Current amount for the selected period. 

Year to Date - Amount for the year of the selected G/L Period, up to the selected period.

Sample(s)

5.1.1.50 Intercompany Transfers By Date

Description
The Inter-company Transfers By Date report returns all Revenue from the Sales & General Journals posted
against G/L Accounts with a Metric Type of either Inter-company Revenue or Inter-company Expense for a
given date range.

Prompt

General
Project -  Allows you to filter to a specific Project. When blank, All Projects are returned. 

Start Date - Beginning Date used to filter the transactions that are brought into this report.

End Date - Ending Date used to filter the transactions that are brought into this report.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
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Project - The Project that the Transaction is going against.

Company - The Org. Unit associated with the G/L Account used in the transaction.

Transaction Number - The Invoice Number of the Transaction (Sales Journal). If the transaction id from
the General Journal, it is the GJID.
Labor - Labor Billed Revenue amount that goes against a G/L Accounts with a Metric Type of either Inter-
company Revenue or Inter-company Expense
ODC - Other Direct Charges (ODC) Billed Revenue amount that goes against a G/L Accounts with a
Metric Type of either Inter-company Revenue or Inter-company Expense
OCC - Out of Contract Consulting (OCC) Billed Revenue amount that goes against a G/L Accounts with a
Metric Type of either Inter-company Revenue or Inter-company Expense
ICC - In Contract Consulting (ICC) Billed Revenue amount that goes against a G/L Accounts with a
Metric Type of either Inter-company Revenue or Inter-company Expense

Sample(s)

5.1.1.51 Intercompany Transfers By Period

Description
The Inter-company Transfers By Date report returns all Revenue from the Sales & General Journals posted
against G/L Accounts with a Metric Type of either Inter-company Revenue or Inter-company Expense for a
given Period range.

Prompt

General
Project -  Allows you to filter to a specific Project. When blank, All Projects are returned. 

Starting Period - Beginning Period used to filter the transactions that are brought into this report.

Ending Period - Ending Period used to filter the transactions that are brought into this report.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Project - The Project that the Transaction is going against.

Company - The Org. Unit associated with the G/L Account used in the transaction.

Transaction Number - The Invoice Number of the Transaction (Sales Journal). If the transaction id from
the General Journal, it is the GJID.
Labor - Labor Billed Revenue amount that goes against a G/L Accounts with a Metric Type of either Inter-
company Revenue or Inter-company Expense
ODC - Other Direct Charges (ODC) Billed Revenue amount that goes against a G/L Accounts with a
Metric Type of either Inter-company Revenue or Inter-company Expense
OCC - Out of Contract Consulting (OCC) Billed Revenue amount that goes against a G/L Accounts with a
Metric Type of either Inter-company Revenue or Inter-company Expense
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ICC - In Contract Consulting (ICC) Billed Revenue amount that goes against a G/L Accounts with a
Metric Type of either Inter-company Revenue or Inter-company Expense

Sample(s)

5.1.1.52 Invoice For Retainage (Style 1)

Description
The Invoice for Retainage is a way to invoice a client for retainage at the end of the project. You have the
option create a posting entry against the Retainage account in the Sales Journal. Style 1 looks similar to the
standard invoice designs that come "out of the box" with InFocus.

Prompt

Accounts
A/R (required) - Accounts Receivable G/L Account to be used when creating the Retainage entry.

Retainage (required) -  Retainage G/L Account to be used when creating the Retainage entry.

Project Info
Project (required) - Project that the Retainage Invoice is going against.

Sales Info
Invoice No (required) - Invoice Number to be used on the Invoice.

Amount (required) - Amount to be used on the Invoice. Note: This field auto-populates with the Total
Amount going against the Retainage G/L Account on the selected project. This amount can be
overridden.
Invoice Date (required) - Invoice Date to be used on the Invoice.

G/L Period (required) - G/L Period for the entry to fall within.

Retainer Verbiage - Test that will show up as a note on the invoice.

Post Entry - When checked, a Sales Journal entry will be created to reflect the invoice.

Report

Sample(s)

5.1.1.53 Invoice For Retainage (Style 2)

Description
The Invoice for Retainage is a way to invoice a client for retainage at the end of the project. By running the
report, a posting entry is created against the Retainage account in the Sales Journal. Style 2 looks similar to
the Sales Journal Single Transaction report that come "out of the box" with InFocus.
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Note: A Sales Journal entry will be created to reflect the invoice when you click "Post".

Prompt

Enter Project and A/R Account
Project (required) - Project that the Retainage Invoice is going against.

A/R (required) - Accounts Receivable G/L Account to be used when creating the Retainage entry.

Enter Invoice Info
Invoice No (required) - Invoice Number to be used on the Invoice.

Retainage Account (required) -  Retainage G/L Account to be used when creating the Retainage entry.

Amount (required) - Amount to be used on the Invoice. Note: This field auto-populates with the Total
Amount going against the Retainage G/L Account on the selected project. This amount can be
overridden.
Invoice Date (required) - Invoice Date to be used on the Invoice.

G/L Period (required) - G/L Period for the entry to fall within.

Report

Sample(s)

5.1.1.54 Job Titles

Description
The Job Title list report give you a list of Job Titles that live in the Job Titles Applet The report can be filtered
by status and sorted by Job Code or Title. More on Job Titles

Prompt

General
Active Status - The status of the Job Titles to be returned. Options are Active, Inactive and Both.

Sort By - The way in which you want the Job Titles to be sorted on the report. Options are Code & Name.

Report

Report Columns
Job Code - Job Title Code

Job Title - Job Title Name

Status - Status of the Job Title

Report
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Sample(s)

5.1.1.55 Labor By Location

Description
The Labor by Location Report report reflects data the most current version of submitted Time Sheets. The
primary purpose of this report is to Filter/ Group by Locations that can optionally be used. Locations are
assigned to the Employee and are typically used to identify where the actual work was done, for insurance
reasons. More on Locations

Data: The data is collected from the Time Sheets table.

Note 1: Since this report displays Pay Cost and Job Cost, only employees that have the "Can View Pay
Rates" and/or "Can View Job Cost Rates" special rights will be able see cost figures on this report.  More on
"Can View..." Special Rights.

Prompt

Date Ranges
Start & End Date - Filters the data by the transaction date on the Time Sheet. 

General
Location - Filters by the Location Code associated with the Tim Sheet.

Print Detail - When selected, The TimeID, Work Date, Hours, Amount Detail will be displayed on the
report. 
Print Comments - When selected, the time sheet comments will be displayed on the report.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sort
Sort By - Sort/Grouping options include, Employee / Project

Report

Report Columns
Location -  Location that associated with the Employee at the Time of Time sheet Entry. This can be
overridden on the actual Time Sheet.
TimeID - Time Sheet ID code

Date - Work Date of the Time Sheet.

Hours - Work Hours associated with the Time Sheet.

Pay - Pay Cost associated with the Time Sheet.

Job Cost - Job Cost associated with the Time Sheet.

Effort - Effort (Bill Amount) associated with the Time Sheet.
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Sample(s)

5.1.1.56 Labor Code Listing

Description
The Labor Code Listing Report returns a list of Labor Codes that are in your system. Labor Codes are used
to designate the "work" that an employee is doing. Labor codes can be subtotals in Project Management
reports. They are not exposed in billing, nor do they have budgets. An employee is able to enter a Labor
Code on the time Sheet.  Examples of Labor Codes include site time, meetings, phone calls, etc. Click Here
for more information about Labor Codes.

Prompt

General
Org. Unit - Allows you to filter by the Org. Unit associated with the Labor Code.

Status - The status of the Labor Code to be returned. Options are Active, Inactive and Both.

Type - Allows you to filter by Labor Code Type.

Sort By - The way in which you want the Labor Codes to be sorted on the report. Options are Code &
Name.

Report

Report Columns

Labor Code

Labor Name

Type - Designates what type of project the labor code can be used with. Choices are Direct, Indirect, or
Both. Note that Indirect refers to all non-direct project types.
Status -  Status of the Labor Code.

5.1.1.57 Labor Distribution Detail Report

Description
The Labor Distribution Detail Report displays the breakdown for labor distribution entries for a given G/L
period range. You are able to specify up to five (5) sorting/grouping levels.

Data: That data is collected from the Adjustment Journal, including only entries that have been flagged as a
Labor Distribution Entry.

Note: For data to populate this report, you must be using the Labor Distribution functionality of InFocus.
More on Labor Distribution.  

https://support.clearviewsoftware.net/articles/5613
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Prompt

Date Ranges
Starting Period - Beginning Period used to filter the transactions that are brought into this report.

Ending Period - Ending Period used to filter the transactions that are brought into this report.

General
Org. Unit - When selected, the report will return Labor Distributions that go against the specified Org.
Unit.
Consolidate G/L Accounts - When selected, the GL Code will be consolidated to just the Base Code of
the GL Account. 
Transaction Currency - The Transaction Currency to be used when running the report. Options are Base,
Company, Project and Transaction.
Show Recap - When selected, A GL Code summary will display at the bottom of the report.

Sorts
1st Sort - When selected, the data will be grouped by the following options: Project, Employee,
Transaction, G/L Period, G/L Account and <None>
2nd Sort - Same as above

3rd Sort - Same as above

4th Sort - Same as above

5th Sort - Same as above

Report

Report Columns
Sort Name - Option selected from the prompt.

Sort Code - Code of item selected from prompt.

Sort Name - Name of item selected from prompt.

Amount - Amount associated with the item selected from prompt.

Sample(s)

5.1.1.58 Labor Estimates

Description
This Labor Estimates report requires that you have Require Estimates-to-Complete turned on in Projects >
General Tab. The report gives you the ETC hours the employee entered upon submitting their time sheet.

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

General
Project - When selected, The report only returns the specified project. When left blank, all projects are
returned.

https://support.clearviewsoftware.net/articles/7614
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Employee - When selected, The report only returns the specified Employee. When left blank, all
Employees with Labor Estimates are returned.
Sort By - Allows you to sort/Group the report by the selected item. Options are Employee or Project. 

Show WBS - When selected, the lower levels of the Project WBS are displayed on the report.

Show Job Title - When selected, the Job Title associated with the Labor Estimate is displayed on the
report.

Report

Report Columns
Depending on "Sort By" selection, the first column is Employee Code when Employee and Project Path
when Project.
Depending on "Sort By" selection, the first column is Employee Name when Employee and Project Name
when Project.
ETC - Hours - Estimate to Complete (ETC) hourse entered by the employee on the time sheet before
saving.
Last Reported - Last date that an Estimate to Complete was entered.

Sample(s)

5.1.1.59 MC Consolidated Balance Sheet (FASB)

Description

The MC Balance Sheet Report is a statement of the companies financial position, which states the Assets,

Liabilities and Owner's Equity (Capital) for a  specific period (G/L Period). 

Prompt

General
G/L Period (Required) - Selected Period that the report is run for.

Calculate Weight Average on YTD Basis 

Show Base Code - When selected, the Account Code of the GL Account is displayed on the Statement.

Report

Sample(s)

5.1.1.60 MC Revaluation Journal

Description
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 Journal report for MC Revaluations journal used when running Multi-Currency.

Prompt

General
Starting Period -  The selected Starting G/L Period for the report.  All returned data falls within the
selected G/L Period.
Ending Period -  The selected Ending G/L Period for the report.  All returned data falls within the selected
G/L Period.
Include Realized Gains and Losses -  When selected, Realized Gains Losses are includes in the returned
data (Multi-Currency only). More on MC Revaluations
Include Unrealized Gains and Losses - When selected, Unrealized Gains Losses are includes in the
returned data (Multi-Currency only). More on MC Revaluations
Include Manual Entries - When selected, transactions flagged as "Manual" in the MC Revaluations
Journal will be included in the report.
Include Automated Entries - When selected, transactions NOT flagged as "Manual" in the MC
Revaluations Journal will be included in the report.
Balance Sheet Account - A Balance Sheet Account can be selected to filter the report.

Company Currency Code -  The Company Currency Code to be used when running the report. Options
are set in the Multi-Currency applet.  More on Multi-Currency

Report

Report Columns
MC Trans ID - ID Number of the MC Revaluation Journal Transaction.

Project

JN - Journal that the transaction is going against. Options are PJ (Purchase Journal), ER (Employee
Reimbursables) and SJ (Sales Journal)
Base Realized - Base Currency Amount that has been Realized.

Base Unrealized - Base Currency Amount that is Unrealized.

Company Realized - Company Currency Amount that has been Realized.

Company Unrealized - Company Currency Amount that is Unrealized.

Sample(s)

5.1.1.61 My Hours

Description
The My Hours report is meant for access to be given all employees in the company.  It allows the employee
to list all their hours for any project date range they wish.

Data: That data is collected from Time sheets.

Note: This report is designed to run for the logged in user.
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Prompt

Date Ranges
Start Date - Beginning Date used to filter the transactions that are brought into this report.

End Date - Ending Date used to filter the transactions that are brought into this report.

General
Project - When selected, The report only returns the specified project. When left blank, all projects are
returned.
Show Projects - When selected, the report displays the Top Level of the Project that the time was entered
against.
Show WBS - When selected, the report displays the Lower Levels of the Project that the time was
entered against.
Show Detail - When selected, the report displays the lowest level detail of the time sheet including the
Work Date and the PM Comments.

Sort
Sort By - Sorts the report by either Date (Work Date) or Project.

Report

Report Columns
Work Date - Date the Time Sheet was entered against

Project - Project Code & Name

Hours - Work Hours of the time sheets.

Comments - PM Comments entered on the time sheet.

Sample(s)

5.1.1.62 No Project Reference

Description
The No Project Reference Report returns transactions with no project reference for a specified Time Frame,
Journal Type(s), Metric(s). Additional filters include G/L Account, Org Unit and G/L Financial Type (Income
and Expense or All). 

Note: This report is useful when trying to tie out Project Profit to the Income Statement. Transactions that do
not reference a project can cause variance.

Prompt

General
Starting Period (required) -  The selected Starting G/L Period for the report.  All returned data falls within
the selected G/L Period.
Ending Period (required) -  The selected Ending G/L Period for the report.  All returned data falls within the
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selected G/L Period.
Journal (required) - Journal to be reported on. Options are the General, Sales, Receipt, Purchase, ER and
Disbursement Journals.
Metric (required) - The Metric Type of the G/L Account to be reported on.

G/L Account -  When selected, The report only returns the specified G/L Account Transactions. When left
blank, all are returned.
Organization Unit - When selected, The report only returns the specified Org. Unit. When left blank, all
are returned.
Just Income and Expense Accounts - When selected, only Accounts that have a Financial Type of
Income or Expense (P&L Accounts) are included.

Report

Report Columns
Journal - Journal that the Transactions originates.

Trans ID - ID number of the Journal entry.

Trans Date - Date of the Transaction.

Account Code - G/l Account Code

Master Name - Firm Name, Payee Name or Employee Name depending on the Journal.

Amount - Cost Amount

Sample(s)

5.1.1.63 Note Search

Description
 The Note Search report searches the text of marketing notes entered throughout InFocus Master Files.

Prompt

General
Start Date - Beginning Date used to filter the transactions that are brought into this report.

End Date - Ending Date used to filter the transactions that are brought into this report.

Project - When selected, The report only returns the specified project. When left blank, all are returned.

Employee - When selected, The report only returns the specified Employee. When left blank, all are
returned.
Firm - When selected, The report only returns the specified Firm. When left blank, all are returned.

Contact Name - When selected, The report only returns the specified Employee. When left blank, all are
returned.
Text to Search For - When text is entered here, the report looks for that specific line of text in the note
comments.
1st Sort - When selected, the report will sort by the following Project, Client, Contact Name, Create Date,
Owner
2nd Sort - Same as above
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3rd Sort - Same as above

Report

Report Columns
Date - Date of Note

Contact - Contact Associated with Note

Owner - Creator of the Note

Project - Project Associated with the Note

Client - Client Associated with the Note

Note

Sample(s)

5.1.1.64 Opportunities

Description
The Opportunities Report gives you a list of Projects that have a Charge Type of "Opportunity".

Prompt

General
Project Manager - When selected, The report only returns the specified Project Manager. When left
blank, all are returned.
Principal-in-Charge - When selected, The report only returns the specified Principal In Charge. When left
blank, all are returned.
Marketing Contact - When selected, The report only returns the specified Contact. When left blank, all
are returned.
Other Contact - When selected, The report only returns the specified Contact. When left blank, all are
returned.
Active Status - Filters by Project Status. Options are Active, Inactive and Both.

Invoice Currency - The Type of Currency to be used when running the report.

Report

Report Columns
Name - Opportunity Name

Code - Opportunity Code

Expected Close - The Expected Close Date of the project. Located at Opportunitites> General Tab>
Opportunity Dates section.
Expected Revenue - The Expected Revenue entered on the project. (Opportunitites> General Tab>
Opportunity Info section)
Win Probability - The Win Probability assigned to the Opportunity. (Opportunitites> General Tab>
Opportunity Info section)
Projected Revenue - Expected Revenue X Win Probability
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Sample(s)

5.1.1.65 Pay History

Description
The Pay History report shows employee pay history which can be useful when performing employee reviews.

Data: The information of this report comes from the Pay History tab located in tHR> Employees.

Prompt

General
Employee - When selected, The report only returns the specified Employee. When left blank, all are
returned.
Org. Unit - When selected, The report only returns the specified Org. Unit associated with the Employees.
When left blank, all are returned.
Approver - When selected, The report only returns the specified Employees where the selected Approver
is the Approver of that employee. When left blank, all are returned.
Active Employees Only - When selected, only Active Employees are returned.

Include Subcontractors - When selected, Employees flagged as "Subcontractors" (HR> Employees>
Employee Info Tab> Company Info Section) are included on the report.
Latest Pay Rate Only - When selected, only the most recent pay rate is returned in the report.

Report

Report Columns
Employee - Proper Name of the Employee

Approver - The Default Approver of the Employee.

Hired - Hire Date

Org. - Org Unit assigned to the Employee.

Terminated - Termination Date

Target % - Target % Assigned to the Employee.

Pay History

Start Date - Start Date of the Pay Rate.

End Date - End Date of the Pay Rate.

Salary Per Period - The Salary Amount Paid per pay period.

Regular Rate - The Regular Pay Rate of an hourly employee.

Overtime Rate - The Overtime Pay Rate of an hourly employee.

Pct Increase - The Percent of Pay Increase since the last pay history range.

Exempt - When an employee is flagged as hourly, exempt equals no.

Sample(s)
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5.1.1.66 Pay When Paid By Project

Description
The Pay When Paid By Project report can be used for consulting pay when paid purposes.  The report layout
of this report groups by Project.

Note1: Purchases not linked on a sales journal will appear on the report as long as the Vendor is flagged as
a "Consultant".  

Note2: "Okay to Pay" Column - There is an okay to pay columns.  The okay to pay only applies to linked
purchases and is based on monies received (Receipt Journal).  In the case of partial payments, the receipts
are prorated accordingly.  This report also considers the Revenue Type in cash receipts when computing
consultant dollars received. The Revenue Type option is turned on in Global Settings> A/R Tab> Receipt
Wizard Breakdowns.

Note3: Vendors must be flagged as a "Consultant" in their Vendor File (AP> Vendors) to be pulled into this
report.

Data: That Transactional data is collected from the Purchase, Disbursements, Receipts, and the Sales
Journals.  The Budget information (optional) comes from Project Planning> Scheduling.  The Schedule data,
for consultants, is entered in the OCC and/or ICC modes when in Project Planning. Be sure to roll-up the
Schedules to Allocations and Allocations to Budgets once you have established the correct amounts.

For detailed steps on paying your vendors through InFocus, walk through this Help Center Course: Paying
Your Vendors

Prompt

Date Ranges
As of Date - Used as the Cut-off date for all transactions, unless "No Cut-Off Date" is selected.

No Cut-Off Date - When selected, the "As of Date" is ignored and the report is run for all time.

General
Vendor - Allows you to filter to a specific Vendor. When blank, All Vendor are returned.

Project - Allows you to filter to a specific Project. When blank, All Projects are returned. 

PM Leader - Allows you to filter to a specific Project Leader. A Project Leader is either the Project
Manager, Principal In Charge or Project Accountant assigned to a specific project on the Members Tab.
Project Status - Allows you to filter the returned projects by status.  Status includes Active, Inactive and
Both.
Include Sales With No Consultant Revenue - When selected, Sales Journals (Client Invoices) will be
included, even if none of the Billed Revenue is going against accounts with a PM Type of Out of Contract
Consultants (OCC) or In Contract Consultants (ICC).
Include Distributed Sales - When selected, Sales Journals that have already paid any associated
Vendors, will be included in the report.
Include Paid Vendor Invoices - When selected, Vendor Invoices (Purchase Journals) that have been paid
(Disbursement Journal) will be included in the report.

Display
Sort By - Gives you the ability to Sort/Group the report by Project, Client, Project Manager, Principal and

https://support.clearviewsoftware.net/articles/5716?groupId=33
https://support.clearviewsoftware.net/articles/5716?groupId=33
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Org. Unit.
Show Receipts - When selected, Receipt Journal Entries that go against the Sales Journal (Client
Invoice) will be displayed on the report.
Show Payments - When selected, Disbursement Journal Entries that go against the Purchase Journal
(Vendor Invoice) will be displayed on the report. 
Show Vendor Budgets -  When selected, Budgets entered in Project Planning against the specific Vendor,
will display on the report.
Invoice Currency - The Invoice Currency to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Ref # - Invoice Number (Purchase and Sales Journals), Check Number (Disbursements and Receipt
Journals)
JN - PJ (Purchase Journal), SJ (Sales Journal), CD (Disbursements Journal) and CR (Receipts Journal)

Date - Invoice Date (Purchase and Sales Journals), Check Date (Disbursements and Receipt Journals)

CNS (Billed) - Portion of the Client Invoice (Sales Journal) that is classified as Consulting Revenue.  That
means that it goes against a Billed Revenue G/L Account that has a PM Type of  Out of Contract
Consultants (OCC) or In Contract Consultants (ICC).
Total (Billed) - Total Amount of the Client Invoice (Sales Journal).

CNS (Charged) - Portion of the Vendor Invoice (Purchase Journal) that is classified as Consulting Cost. 
That means that it goes against a Cost G/L Account that has a PM Type of  Out of Contract Consultants
(OCC) or In Contract Consultants (ICC).
Total (Charged) -  Total Amount of the Vendor Invoice (Purchase Journal).

CNS (Received) - Portion of the Receipt that is classified as  Out of Contract Consultants or In Contract
Consultants.  
Total (Received) - Total amount of the Receipt entry.

Balance (Received) -

CNS (Paid) - Consultant portion that has been Paid (Disbursement Journal) in regard to the Vendor
Invoice (Purchase Journal) .
Total (Paid) - Total Invoice Amount that has been Paid (Disbursement Journal) in regard to the Vendor
Invoice (Purchase Journal) .
Balance (Paid) -  Charged Total minus Paid Total

Ok To Pay - The "Okay to Pay" Column indicates the amount that you are able to pay your Vendor and
only applies to linked purchases and is based on monies received (Receipt Journal).  In the case of
partial payments, the receipts are prorated accordingly.  This report can also use the Revenue Type in
cash receipts when computing consultant dollars received. The Revenue Type option is turned on in 
Global Settings> A/R Tab> Receipt Wizard Breakdowns.

Sample(s)

5.1.1.67 Pay When Paid By Receipt

Description
The Pay When Paid By Project report can be used for consulting pay when paid purposes.  This report
operates off of a deposit date range. It requires that purchases be linked to Sales Journal and requires that
breakdown receipt by revenue type is used. A unique feature of this report is it can create an A/P check
batch based on the report's results.
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Data: That Transactional data is collected from the Purchase, Disbursements, Receipts, and the Sales
Journals.  The Budget information (optional) comes from Project Planning> Scheduling.  The Schedule data,
for consultants, is entered in the OCC and/or ICC modes when in Project Planning. Be sure to roll-up the
Schedules to Allocations and Allocations to Budgets once you have established the correct amounts.

Note1: Only consultant charges in the Purchase Journal (Vendor Invoice), that have been linked to a Sales
Journal entry, are included in this report. Also, only A/R invoices with links to consultant purchases are
included. 

Note2: Vendors must be flagged as a "Consultant" in their Vendor File (AP> Vendors) to be pulled into this
report.

Note 3: The PWP By Receipt uses a different algorithm than the other two PWP reports. In the PWP By
Receipt a vendor invoice will not go into the Okay to Pay columns if it is connected to more than one sales
entry. Basically, if your consultant vendors invoice for more than one project on an invoice the pay when pay
by receipt will not show Okay to pay. It does not try to prorate the receipt in cases where the vendor invoice
cites multiple SJ entries.

Prompt

General
Starting Deposit Date - Uses the Start Date to filter Receipt Journal entries by the Deposit Date.

Ending Deposit Date - Uses the End Date to filter Receipt Journal entries by the Deposit Date.

Combine OCC and ICC Amounts - When selected, both OCC and ICC Amounts are combined in the
report.
WBS Level - When selected, the Code of the WBS level is displayed on the report.

Create A/P Check Batch - When selected, an A/P Check Batch is created to pay all of the "Okay to Pay"
amounts in AP Check writing. Simply go to Accounts Payable> A/P Check Writing> Load from Batch
(toolbar) to pull up the Batch.

Report

Top Grid
JN - PJ (Purchase Journal), SJ (Sales Journal), CD (Disbursements Journal) and CR (Receipts Journal)

Trans. ID - The ID number of the transaction

Trans. Date - Invoice Date (Purchase and Sales Journals), Deposit Date (Disbursements and Receipt
Journals)
Invoice - Invoice Number (Purchase and Sales Journals)

Project

WBS - The Code of the Work Breakdown Structure at the level selected in the reporting prompt.

OCC (Received) - Portion of the Receipt that is classified as  Out of Contract Consultants.  

ICC (Received) - Portion of the Receipt that is classified as  In Contract Consultants.

OCC (Charged) - Portion of the Vendor Invoice (Purchase Journal) that is classified as Out of Contract
Consulting Cost.  That means that it goes against a Cost G/L Account that has a PM Type of  Out of
Contract Consultants (OCC).
ICC (Charged) - Portion of the Vendor Invoice (Purchase Journal) that is classified as In Contract
Consulting Cost.  That means that it goes against a Cost G/L Account that has a PM Type of In Contract
Consultants (ICC).
PJ Many Links - If the Purchase Journal has multiple links, you will see a "Y" in this column.
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SJ Many Cons - If the Purchase Journal has multiple Consultants, you will see a "Y" in this column.

CR Covers All - If the Received amount classified as ICC or OCC exceeds the Vendor Invoice, you will
see a "Y" in this column.
Ok To Pay - The "Okay to Pay" Column indicates the amount that you are able to pay your Vendor and
only applies to linked purchases and is based on monies received (Receipt Journal).  In the case of
partial payments, the receipts are prorated accordingly.  This report can also use the Revenue Type in
cash receipts when computing consultant dollars received. The Revenue Type option is turned on in 
Global Settings> A/R Tab> Receipt Wizard Breakdowns.

Vendor Summary
Vendor - Vendor Code and Name

Invoice - Invoice Number from the Purchase Journal.

Invoice Date - Invoice Date from the Purchase Journal.

Invoiced - Total Amount of the Vendor Invoice (Purchase Journal).

OCC + ICC -  Portion of the Vendor Invoice (Purchase Journal) that is classified as Consulting Cost.  That
means that it goes against a Cost G/L Account that has a PM Type of  Out of Contract Consultants
(OCC) or In Contract Consultants (ICC).
Other Cost -  Portion of the Vendor Invoice (Purchase Journal) that is NOT classified as Consulting Cost.
 
Paid - Portion of the Vendor Invoice that has been paid (Disbursement Journal)

Balance - Invoiced minus Paid.

Ok To Pay - The "Okay to Pay" Column indicates the amount that you are able to pay your Vendor and
only applies to linked purchases and is based on monies received (Receipt Journal).  In the case of
partial payments, the receipts are prorated accordingly.  This report can also use the Revenue Type in
cash receipts when computing consultant dollars received. The Revenue Type option is turned on in 
Global Settings> A/R Tab> Receipt Wizard Breakdowns.

Sample(s)

5.1.1.68 Pay When Paid By Vendor

Description
The Pay When Paid By Project report can be used for consulting pay when paid purposes.  The report layout
of this report groups by Vendor.

Note1: Purchases not linked on a sales journal will appear on the report as long as the Vendor is flagged as
a "Consultant".  

Note2: "Okay to Pay" Column - There is an okay to pay columns.  The okay to pay only applies to linked
purchases and is based on monies received (Receipt Journal).  In the case of partial payments, the receipts
are prorated accordingly.  This report also considers the Revenue Type in cash receipts when computing
consultant dollars received. The Revenue Type option is turned on in Global Settings> A/R Tab> Receipt
Wizard Breakdowns.

Note3: Vendors must be flagged as a "Consultant" in their Vendor File (AP> Vendors) to be pulled into this
report.

Data: That Transactional data is collected from the Purchase, Disbursements, Receipts, and the Sales
Journals.  The Budget information (optional) comes from Project Planning> Scheduling.  The Schedule data,
for consultants, is entered in the OCC and/or ICC modes when in Project Planning. Be sure to roll-up the
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Schedules to Allocations and Allocations to Budgets once you have established the correct amounts.

For detailed steps on paying your vendors through InFocus, walk through this Help Center Course: Paying
Your Vendors

Prompt

Date Ranges
As of Date - Used as the Cut-off date for all transactions, unless "No Cut-Off Date" is selected.

No Cut-Off Date - When selected, the "As of Date" is ignored and the report is run for all time.

General
Vendor - Allows you to filter to a specific Vendor. When blank, All Vendor are returned.

Project - Allows you to filter to a specific Project. When blank, All Projects are returned. 

Project Status - Allows you to filter the returned projects by status.  Status includes Active, Inactive and
Both.
Include Sales With No Consultant Revenue - When selected, Sales Journals (Client Invoices) will be
included, even if none of the Billed Revenue is going against accounts with a PM Type of Out of Contract
Consultants (OCC) or In Contract Consultants (ICC).
Include Distributed Sales - When selected, Sales Journals that have already paid any associated
Vendors, will be included in the report.
Include Paid Vendor Invoices - When selected, Vendor Invoices (Purchase Journals) that have been paid
(Disbursement Journal) will be included in the report.

Display
Sort By - Gives you the ability to Sort/Group the report by Project, Client, Project Manager, Principal and
Org. Unit.
Show Receipts - When selected, Receipt Journal Entries that go against the Sales Journal (Client
Invoice) will be displayed on the report.
Show Payments - When selected, Disbursement Journal Entries that go against the Purchase Journal
(Vendor Invoice) will be displayed on the report. 
Show Vendor Budgets -  When selected, Budgets entered in Project Planning against the specific Vendor,
will display on the report.
Invoice Currency - The Invoice Currency to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Ref # - Invoice Number (Purchase and Sales Journals), Check Number (Disbursements and Receipt
Journals)
JN - PJ (Purchase Journal), SJ (Sales Journal), CD (Disbursements Journal) and CR (Receipts Journal)

Date - Invoice Date (Purchase and Sales Journals), Check Date (Disbursements and Receipt Journals)

CNS (Billed) - Portion of the Client Invoice (Sales Journal) that is classified as Consulting Revenue.  That
means that it goes against a Billed Revenue G/L Account that has a PM Type of  Out of Contract
Consultants (OCC) or In Contract Consultants (ICC).
Total (Billed) - Total Amount of the Client Invoice (Sales Journal).

CNS (Charged) - Portion of the Vendor Invoice (Purchase Journal) that is classified as Consulting Cost. 
That means that it goes against a Cost G/L Account that has a PM Type of  Out of Contract Consultants
(OCC) or In Contract Consultants (ICC).
Total (Charged) -  Total Amount of the Vendor Invoice (Purchase Journal).

https://support.clearviewsoftware.net/articles/5716?groupId=33
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CNS (Received) - Portion of the Receipt that is classified as  Out of Contract Consultants or In Contract
Consultants.  
Total (Received) - Total amount of the Receipt entry.

Balance (Received) -

CNS (Paid) - Consultant portion that has been Paid (Disbursement Journal) in regard to the Vendor
Invoice (Purchase Journal) .
Total (Paid) - Total Invoice Amount that has been Paid (Disbursement Journal) in regard to the Vendor
Invoice (Purchase Journal) .
Balance (Paid) -  Charged Total minus Paid Total

Ok To Pay - The "Okay to Pay" Column indicates the amount that you are able to pay your Vendor and
only applies to linked purchases and is based on monies received (Receipt Journal).  In the case of
partial payments, the receipts are prorated accordingly.  This report can also use the Revenue Type in
cash receipts when computing consultant dollars received. The Revenue Type option is turned on in 
Global Settings> A/R Tab> Receipt Wizard Breakdowns.

Sample(s)

5.1.1.69 Print A Check

Description
The Print a Check Report allows you to Print a New Check or enter the previous check number and re-print a
check.

Prompt

New or Existing Check
Is this a new check? - When selected, a new check will be created and Posted to the Disbursement when
the report is run.

Bank
Bank Account - The G/L Account, with a Subledger Type of Bank, that is to be used when creating the
Disbursement.

Check Number
Check Number - When creating a new check, the check number to be used. When retrieving an old
check, the check number that will be re-printed.

Type of Payee
Payee Type - Payee Type to write the check to. Options are Vendor, Employee, Client and Other.

Payee (editable based on Payee Type)
Payee Name - Text box where a payee can be entered 

Client

Employee 

Vendor
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G/L Accounts
G/L Account to Charge (required) - G/L Account to Charge the check to.

Check Info
Check Amount - Amount of check to be written.

Check Date - Check Date of check to be written.

Check Memo - Check Memo to be added to the check.

G/L Period - G/L Period the check is to be posted in.

Project - Project that the check goes against.

Print Check Number on Face of Check - When selected, the check number will be printed on the check.

Street 1 - Street information to be printed on the check.

Street 2 - Street information to be printed on the check. 

Street 3 - Street information to be printed on the check. 

Street 4 - Street information to be printed on the check. 

City - City information to be printed on the check. 

State - State information to be printed on the check.

Zip - Zip Code information to be printed on the check.

Country - Country information to be printed on the check.

Attention - Attention to be printed on the check.

Report

Sample(s)

5.1.1.70 Project Earnings By Org Unit

Description
The Project Earnings by Org. Unit report gives Current, Year To Date and Project To Date figures including
Billed Revenue, Total Revenue, Spent, Profit, Profit Pct, Fee, Received, A/R, Un-billed and Effective
Multiplier. The project summary report can be grouped by organizational unit. It also can filter based on a
common org code at a given level.

Prompt

Date Ranges
As of Date - The Cut-Off Date for the information being returned to the report.

General
Org. Code - Filters the information being returned to the report to a specific Org Unit.

Organization Level - Filters the returned data to a specific Org. Unit Level.

Combine Org. Unites with Like Codes - When selected, the Org Units. are combined by Code on the
report rather than Path.
Use G/L Period for Non-Time sheet Transactions - When selected, G/L Period is used to filter the non-
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labor transactions rather than transaction date.
Use G/L Period for Timesheet Transaction -  When selected, G/L Period is used to filter the labor
transactions rather than transaction date. (You must be using Labor Distribution for this to return data)
More on Labor Distribution
Overhead Method - The method that Overhead is calculated on this report. Options are Job Cost Rates
and Overhead Allocation.  
Earned Revenue Method - Method of calculating the unbilled revenue.  Options are General Ledger
(Entries in the General Journal posted to an Unbilled Revenue account) and Unbilled Transactions
(Transactions with a Bill Status of R or H).
Project Status - Status of Projects to be reported on. Options are Active, Inactive and Both

Use Calendar Year for YTD - When selected, The YTD Columns populated with data from January 1st of
the selected year.  Otherwise, the Start Date of the 01 GL Period of the selected year (ie. Fiscal Year)
Include Transaction with No Org. Unit - When selected, Transactions not associated with Org. Units are
included in the data.
Include Unsubmitted Time - When selected, Time Sheets that have not been submitted are returned in
the results.
Include Unapproved Time - When selected, Time Sheets that have not been approved are returned in the
results.
Include Proposals - When selected, Opportunity projects are included in the returned data.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
1st Sort - When selected, the report will Sort/Group by the selection.  Options are Org. Unit, Client
Project, Manager and Principal
2nd Sort - When selected, the report will Sort/Group by the selection.  Options are Org. Unit, Client
Project, Manager and Principal

UDFs
Project UDF Field - User Defined Field that the results are to be filtered by

UDF Operator - The Operator that the User Defined Field is using to compare the UDF Value

UDF Value - The Value to be used as a filter in the results of the report

Report

Report Columns
Fee Billed - Labor Billed Revenue against the project. This is a combination of Direct and Fixed Fee. 
Figures come from the Sales Journal and the Adjustments Journal.
Consult Billed - OCC & ICC Billed Revenue against the project. Figures come from the Sales Journal and
the Adjustments Journal.
ODC Billed - ODC Billed Revenue against the project. Figures come from the Sales Journal and the
Adjustments Journal.
Total Billed - Total of all of the above Billed Revenue Items.

Revenue - Combination of the above billed items. Additionally includes Bad Debt, Other Revenue and
subtracts Retainage and Unearned.
Spent - Burdened amount. (Cost + Overhead)

Profit - (Revenue - Spent)  

Profit PCT - (Revenue - Spent)  / Revenue

Fee - Fixed Fee + Labor Cap + ODC Cap + OCC Cap

CurRcv - Current Received Amount

https://support.clearviewsoftware.net/articles/5613
https://support.clearviewsoftware.net/articles/4094
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A/R - Outstanding A/R (Billed - Received)

Unbilled -Depending on the selected Earned Revenue Method. General Ledger (Entries in the General
Journal posted to an Unbilled Revenue account) and Unbilled Transactions (Transactions with a Bill
Status of R or H).
Eff Mult -  [(Effective Multiplier) - (Labor Billed Revenue + Unbilled Labor)] / Labor Cost

Sample(s)

5.1.1.71 Project Figures

Description

The Project Figures Report returns "As of the Moment" project metrics for a given project to all its WBS

levels. It automatically filters based on project leader designation. Employees with a designation of Project

Accountant can see all projects. By default, this report shows labor cost as zero. To show labor cost, make a

copy of the report, then click Manage Parameters. Note the parameters and their details. Next, click on the

wand (  ). When prompted that previous parameters will be cleared out, click Yes. All exposed parameters will

be visible. Restore the details of the Project Path and My id parameters. Click Apply after each. Change the

prompt type of the Show labor cost report (at either Pay Rate or Job Cost Rate, depending on the setting of

the Calculate Labor Cost option (in the General Tab of Global Settings). 

On this report, any figure, that is cased in blue and has an underline, will render a new detail report.  When

the Project Figures Report is selected, a blue back-arrow will appear in the Report Viewer tool bar when a

drill thru report has been entered.  Clicking on the back arrow will navigate back to the master report. The

Project Figures report is accessible on the tool bar (View) in the Project Administration module (Projects

applet) and the Project Management module (Project Planning applet). A permission under Project

Management called View Labor Cost in Project Figures, determines whether a person can see labor costs on

this report.

Note1: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Note2: The Project Figures report is "All Time", so be aware of that when comparing data to reports that use
a Dare Range or As-of-Date.

Prompt

General
Project (required) - Project to be analyzed on the report.

Report

Report Columns

https://support.clearviewsoftware.net/articles/7614
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Contract - Fixed Fee and Contract (Labor, ODC, OCC, ICC) Caps assigned to the Project.

Billed - Billed Revenue posted to the Sales Journal or General Journal (Labor, ODC, OCC, ICC).

Received - Money Received through the Receipt Journal

Effort - Labor Cost at the Billing Rate OR Non-Labor transactions at the Marked-up Rate.

Cost - Labor Cost at the Pay (or JC) Rate, depending on Global Setting> General Tab>Calculate Labor
Cost Using, OR Non-Labor transactions at the Cost Rate.
Unbilled - Unbilled Transaction (Transactions with a Bill Status of Ready to Bill (R) or Hold (H))

Budget - Budget amounts (Labor, ODC, OCC, ICC)  from Project Planning.

Non Reim/Write Off - Transactions with a Bill Status of Never Bill (N) or Write-off (W))

Other Revenue - Journal transactions that go against a G/L Account with a Metric Type of Other
Revenue.
Late Charges - Journal transactions that go against a G/L Account with a Metric Type of Late Fee.

Retainage - Journal transactions that go against a G/L Account with a Metric Type of Retainage.

Bad Debt - Journal transactions that go against a G/L Account with a Metric Type of Bad Debt.

Unapplied Advances - Journal transactions that go against a G/L Account with a Metric Type of Other
Retainer.
Labor % Complete - Fixed Fee % Complete

Hours - Work Hours from Time Sheets

Sample(s)

5.1.1.72 Project Metrics For Project Managers

Description
The Project Metrics for Project Managers report is a summary level (project level) report that will display most
project metrics.  It is using a SQL view called ev_projectmetrics_nolaborcost to make querying simpler for
summary type reports.  This view contains no labor cost.

Prompt

General
Project - Allows you to filter to a specific Project. When blank, All Projects are returned.

Charge Type - Allows you to filter projects by Charge Type. Options are Billable and Opportunity

Is Active - When selected, Active projects are returned. When unchecked, inactive projects are returned.

Report

Report Columns
Budget - Budget amounts (Labor, ODC, OCC, ICC)  from Project Planning.

Estimated % Comp - Budget % Complete from Project Planning

Estimated Expended Budget X Estimated % Comp

Actual Expended -  Labor Cost at the Billing Rate OR Non-Labor transactions at the Marked-up Rate.

Unbilled Effort - Unbilled Transaction (Transactions with a Bill Status of Ready to Bill (R) or Hold (H))

Written Off Effort -  Labor Cost at the Billing Rate OR Non-Labor transactions at the Marked-up Rate with
a bill status of Write Off (W)
Contract Amount -  Fixed Fee and Contract (Labor, ODC, OCC, ICC) Caps assigned to the Project.
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Billed - Billed Revenue against the project (Labor, ODC, OCC, ICC). Figures come from the Sales Journal
and the Adjustments Journal.
Bill Adjustments -  Additional Revenue items that include Bad Debt, Other Revenue, Retainage and Late
Fee.
Received -  Money Received through the Receipt Journal

Net Contract Amount - Contract - Billed

Sample(s)

5.1.1.73 Project Overhead Allocation Report

Description
The Project Overhead Allocation report will show current period and year to date overhead allocations by
project and org unit.

Prompt

General
Current G/L Period (required) - The G/L Period that you would like to view data for. 

Sort By - Sort/Group By option for the report.  Options are Project and Org. Unit

Report

Report Columns
Project Path

Project Name

Org Path

Org Name

Current Amount - Current amount of the Overhead Allocation.

Year-To-Date - Year to date amount of the Overhead Allocation.

Sample(s)

5.1.1.74 Project Revenue By Type

Description
The Project Revenue by Type report sorts and groups revenue by Project Report Type or Market Sector. 
Many clients use either the report type or the market sector to identify the professional liability classification
of a project.  In this scenario you can run the report YTD to provide the necessary revenue breakdown. 
When you run the report you can either view billed or received.  If you run the report using received the
system uses the cash basis conversion to break down the receipts into its types of revenue (labor, ODC,
OCC and ICC).  When you run the report by market sector all metrics are factored by the market sector
percentage entered on the project setup.
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Note1: Can be used for Professional liability Insurance renewal.

Note2: The Project Revenue By Type report when run for received runs on the cash basis. When it is run for
billed it runs on the accrual basis. It does this because the report shows revenue by type (labor, ODC, OCC
and ICC). So if you want to view received first run Convert To Cash.

Note3: Works if either the Report Type or Market Sectors. Basically if gives you preceding years revenue on
a cash or accrual basis group by either market sector or report type which should represent your type of
work.

Note4: The report uses data ranges not G/L periods. You need to compare with G/L by date report. Most
likely this is where your difference lies.

Prompt

General
Start Date - Beginning Date used to filter the transactions that are brought into this report.

End Date - Ending Date used to filter the transactions that are brought into this report.

Sort By - Allows you to Sort/Group the report by Report Type or Market Sector

Show - Billed returned Revenue figures, Received Returns Received figures (Note, the received figures
come from the Cash Basis Journals, so you have to run Convert to Cash before running the report).
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
JN - Journal that the transaction comes from

JN ID - ID number of the transaction

Date - Date of the transaction

Invoice - Invoice Number

Check Number - Check number of the transaction.

Labor - Portion of the transaction that has a PM type of Labor

ODC - Portion of the transaction that has a PM type of ODC (Other Direct Charges)

OCC - Portion of the transaction that has a PM type of OCC (Out of Contract Consultants)

ICC - Portion of the transaction that has a PM type of ICC (In Contract Consultants)

Misc - Portion of the transactions that are classified as Other Revenue, Late Fee, Bad Deb, Retainage or
Retainer.
Total - Total of all the above items.

Sample(s)
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5.1.1.75 Project Scorecard

Description
The Project Scorecard report gives you a comprehensive view of your project performance. It has drill-downs
and charts to help dig into your data.

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

General
Project Manager - Allows you to filter the report to a specific Project Manager, or leave blank for all.

Principal In Charge - Allows you to filter the report to a specific Principal In Charge, or leave blank for all.

Project Accountant - Allows you to filter the report to a specific Project Accountant, or leave blank for all.

Project - Allows you to filter the report to a specific Project, or leave blank for all.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Project

Client

Principal

Project Mgr.

Active Status

G/L Period - Current Invoicing Period

Organization - Org. Unit assigned to the project

Accountant - Project Accountant

Hours - Work Hours (Time Sheets)

Budget - Labor Budget + ODC Budget + OCC Budget + ICC Budget

Contract - Fixed Fee + Labor Contract + ODC Contract + OCC Contract + ICC Contract

Unbilled - Transactions with a bill status of Ready To Bill (R) and Hold (H).

Received - Money received 

Other Billed - Portion of the transactions that are classified as Other Revenue (Metric Type).

Late Fee - Portion of the transactions that are classified as Other Revenue (Metric Type)

Net Billed - Billed Revenue + Other Revenue + Late Fee + Bad Debt + Retainage

Earned - Portion of the transactions that are classified as Unbilled or Billed Revenue (Metric Type)

Write Offs - Transactions with a bill status of Write-off (W).

Cost - Labor Cost at the Pay Rate and Non-Labor at the Cost Rate.

Labor Sched. - Labor Scheduled Amount (Project Planning)

Team Members - Count of the number of employees assigned to the Team Members Tab of a project.
Drill through to see a list.
Bill Info. - Information that is pertinent to billing setup.

Change Orders - Change Order Amount (Project Planning)

Effort - Labor Cost at the Bill Rate and Non-Labor at the Marked-Up Rate

Billed - Portion of the transactions that are classified as Billed Revenue (Metric Type)

Accounts Receivable - Outstanding A/R

https://support.clearviewsoftware.net/articles/7614
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Consultant Effort - OCC Transactions at the Marked up Rate.

Bad Debt - Portion of the transactions that are classified as Bad Debt (Metric Type).

Retainage - Portion of the transactions that are classified as Retainage (Metric Type).

Retainer - Portion of the transactions that are classified asRetainer (Metric Type).

Overhead - Labor at the Job Cost Rate MINUS Labor at the Pay Cost Rate

Profit - (Earned + Other Billed + Late Fee) - Bad Debt - Cost - OH

Work Orders - Count of Work Orders. Drill through to see a list.

Effective Multiplier - Labor Effort / Labor Cost

Contacts / Addresses -  Count of the number of contacts / addresses assigned to the project. Drill
through to see a list.
Tax / Surcharge Setup - Information that is pertinent to tax setup for billing.

Sample(s)

5.1.1.76 Purchase Journal Single Transaction

Description
The Purchase Journal Single Transaction Report gives you the ability to sprint out a specific Purchase
Journal Entry for a specific Version.  When in the Purchase Journal applet, you can launch this report by
simply clicking "Print" on the toolbar.  The version showing is the one that will be displayed.  Additionally, if
"Show Audit Trail" is checked, you will see an audit trail of the changes made on that entry.

Prompt

General
Disbursement Journal ID Number - ID number of the Journal entry. This can be entered in the look-up to
pull the transaction up.
Revision Number - The Version of the number that you want to view.

Show Audit Trail - When selected, you will see the Create By, Create Date, Modify By, Modify Date  and
the changes that happened between versions of the transaction.

Report

Report Columns
A/P Account - The Accounts Payable G/L Account used on the transaction.

Vendor

Invoice Number

Invoice Date

Due Date

Current Period

Revision - The version of the transaction

Project

Expense Code

G/L Account

G/L Account Name
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G/L Period

Status - Options are Ready to Bill (R), Hold (H), Billed (B), Write Off (W) and Never Bill (N)

Amount

G/L Comments

A/P Comments

Sample(s)

5.1.1.77 Purchases By Date

Description
The Purchases By Date Report allows you to look at all transactions that go against the Purchase Journal for
a particular Date Range.

Data: Purchase Journal

Note: This report is run for a date range. You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Prompt

Date Ranges
Start & End Date - Filters the data by the Date Type supplied in the next selection. 

Date Type (Required) - Options are:
o Check Date - The Check date of the journal entry.
o Create Date - Create Date of the transaction
o Modify Date - Modify Date of the transaction

General
Vendor - Allows you to filter the report to a single vendor. If left blank, all vendors will be returned.

A/P Base Code - Filters transactions to a specific Accounts Payable G/L Base Code.

Use Org. Filter - When selected, the A/P Org. Unit selected is used to filter the report.

A/P Org Unit - Filters to a specific the Organizational Unit related to the G/L Base Code of the
Transaction.
Include Org. Children - Includes the Organization Units Children  when filtering to a specific the
Organizational Unit.
Show Comments - When checked, the report will show the G/L Comments from the line-items of the
Journals.
Hide Detail - When selected, the detail of the Purchase Journal is hidden.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
The Sorts section Groups & Sorts the report by Invoice Date, Invoice No (Number), Create Date, Modify
Date, Vendor and A/P Account.

Sort 1 - Top Level Sort
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Sort 2 - Second Level Sort. 

Sort 3 - Third Level Sort

Report

Report Columns
A/P Account - Accounts Payable G/L Account associated with the transaction.

Firm Name - Name of the Vendor associated with the transaction.

Invoice Number - Invoice number associated with the transaction.

Due Date - Due Date assigned to the Purchase Journal entry.  

Invoice Date - The Invoice Date Associated with the transaction.

Amount - Amount of the Purchase Journal Transaction.

Account - G/L Account associated with the detail of the Purchase Journal Transaction.

Project - The Project associated with the detail of the Purchase Journal Transaction.

Expense Code - The Expense Code associated with the detail of the Purchase Journal Transaction.

Amount - The amount of the line item in the detail of the Purchase Journal Transaction. 

Sample(s)

5.1.1.78 Rate Schedule Assignments

Description
The Rate Schedule Assignments report lists what rate schedules are assigned to what projects

Prompt

General
Active Date - Rate Schedules have a date associated with them. Select an Active Date to return Active
Rate Schedules during that date.
Schedule Type - Rate Schedule Type. Options are Bill, Job Cost and Rate. More on Rate Schedules

Project Status - Status of Projects assigned to specific Rate Schedule. Options are Active, Inactive and
Both.

Report

Report Columns
Rate Name (Bold) - Name of the Rate Schedule.

Project Path

Project Name

Project Status

Sample(s)
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5.1.1.79 Rate Schedule Detail

Description
The Rate Schedule Detail report lists the rate schedule setup including employees and job titles assigned
and rates. A Rate Schedule can have multiple dates assigned to it, so the Active Date will return the Rate
Schedule detail for the date range that the Active Date falls in.

Prompt

General
Active Date - A Rate Schedule can have multiple dates assigned to it, so the Active Date will return the
Rate Schedule detail for the date range that the Active Date falls in.
Schedule Name - Rate Schedule to be reported on.

Report

Report Columns
Job Title - Job Title to be analyzed from the Time Sheet to get the rate.  Leave Blank for all Job Titles.

Employee - Employee to be analyzed from the Time Sheet to get the rate.  Leave Blank for all
Employees. 
Reg Base Rate - Overriding Regular Pay Rate (Rate Editor> Base Rates Section> Pay Rate) to be
calculated against the DPE, Overhead and Profit Multipliers.
OT Base Rate - Overriding Overtime Pay Rate  (Rate Editor> Base Rates Section> Premium Rate) to be
calculated against the DPE, Overhead and Profit Multipliers. Note: Must have "Apply Multipliers on
Premium Portion" checked in Rate Editor for this to calculate.
Flat Reg Rate - Overriding Regular Pay Rate (Rate Editor> Use Flat Rates Section> Regular)

Flat OT Rate - Overriding Overtime Pay Rate (Rate Editor> Use Flat Rates Section> Premium)

Use Flat - When selected, Flat Rates are used instead of Base Rates (Use Flat Rates is checked).

Use MU on OT - When selected, the Premium Rate will be calculated against the DPE, Overhead and
Profit Multipliers. Note: Must have "Apply Multipliers on Premium Portion" checked in Rate Editor for this
to calculate.
Use OT - When "Override Premium Multipliers" is selected, the Premium Multiplier will be used to
calculate overtime against the Pay Rate.
DPE Mult - Direct Personal Expense (DPE) multiplier against the line item.

OH Mult - Overhead (OH) multiplier against the line item.

PR Mult - Profit (PR) multiplier against the line item.

Currency - Represents the transactional currency in which the rate is utilized. For example, if entering a
Time Sheet (U.S. Dollars) only Rates of similar currency would be used in bill, cost or pay rate evaluation.

Sample(s)

5.1.1.80 Receipt Journal Single Transaction

Description
The Receipt Journal Single Transaction Report gives you the ability to sprint out a specific Receipt Journal
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Entry for a specific Version.  When in the Receipt Journal applet, you can launch this report by simply
clicking "Print" on the toolbar.  The version showing is the one that will be displayed.  Additionally, if "Show
Audit Trail" is checked, you will see an audit trail of the changes made on that entry.

Prompt

General
Disbursement Journal ID Number - ID number of the Journal entry. This can be entered in the look-up to
pull the transaction up.
Revision Number - The Version of the number that you want to view.

Show Audit Trail - When selected, you will see the Create By, Create Date, Modify By, Modify Date  and
the changes that happened between versions of the transaction.

Report

Report Columns
Bank - The Bank G/L Account used on the transaction.

Payee Type - The type of the recipient of the disbursement.  Options are Vendor, Employee Client and
Other
 Payer - Recipient of the Disbursement.

Check Number

Check Date

Current Period

Revision - The version of the transaction

Project

Invoice No. - Invoice Number that the Disbursement is linked to.

G/L Account

G/L Account Name

G/L Period

Revenue Type 

Amount

Comments

Sample(s)
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5.1.1.81 Receipts By Date

Description
The Receipts By Date Report allows you to look at all transactions that go against the Receipt Journal (cash
and accrual) for a particular Date Range.

Data: Receipt Journal (cash and accrual)

Note: This report is run for a date range. You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Prompt

Date Ranges
Start & End Date - Filters the data by the Date Type supplied in the next selection. 

Date Type (Required) - Options are:
o Deposit Date - The Deposit date of the journal entry
o Check Date - The Check date of the journal entry.
o Create Date - Create Date of the transaction
o Modify Date - Modify Date of the transaction

General
Bank Base Code - Filters to a specific GL Base Code of the Transactions.

Use Bank Org. Filter - When selected, the Bank Org. Unit selected is used to filter the report.

Bank Org Unit - Filters to a specific the Organizational Unit related to the GL Base Code of the
Transaction.
Include Org. Children - Includes the Organization Units Children  when filtering to a specific the
Organizational Unit.
Is Accrual - When checked, the report looks at the Accrual Journals (Receipts & Disbursements) instead
of the Cash Basis Journals (CBReceipts & CB Disbursements). Note: The Cash Basis Journals are
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populated by running the Cash Basis Conversion Utility.
Hide Detail - When selected, the detail of the Disbursement Journal is hidden.

Show Comments - When checked, the report will show the GL Comments from the line-items of the
Journals.
Only Clients - When selected, only Firms that are "Clients" will be returned in the report.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
The Sorts section Groups & Sorts the report by Check Date, Check No (Number), Create Date, Modify Date,
Payee and Bank (Account).

Sort 1 - Top Level Sort

Sort 2 - Second Level Sort. 

Sort 3 - Third Level Sort

Report

Report Columns
Bank Account - Bank G/L Account associated with the transaction.

Check Number - Check number associated with the transaction.

Payer Name - Name of the Check Payer.

Check Date - The Check Date Associated with the transaction.

Amount - Amount of the Receipt Journal Transaction.

Account - G/L Account associated with the detail of the Receipt Journal Transaction.

Project - The Project associated with the detail of the Receipt Journal Transaction.

Invoice Number - The Purchase Journal Invoice Number associated with the detail of the Receipt Journal
Transaction.
Amount - The amount of the line item in the detail of the Receipt Journal Transaction. 

Sample(s)

5.1.1.82 Receipts By State

Description
The Receipts by State report receipts broken down by revenue, grouped by State for a selected Period
Range. This is typically for sales tax and "use tax" purposes to calculate Sales Taxed owed the different
States in which the work has been performed.  The Report gives you 2 State options to choose from when
running it:  

1. Project State (PA> Projects> Billing Tab> Bill To Address) - For this method, check "Use Bill To Address"
and leave the "Project Address" look-up blank on the Prompt. Note:  If "Use Client's Bill-To" is selected
on the Project OR the Project State is blank, the Client State will be used.

2. Specified Project State (PA> Projects> Addresses Tab) - For this method, A specific Address is selected
using the Project Address Look-up. The report will look for the Address with the specified name and group
by the state associated with it. The result will give you a grouping of all Projects that have a Project
Address with the selected name.  All projects with a different name will be un-grouped.
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Data: Cash Basis Receipt Journal

Note: In order for this report to be accurate, the Cash Basis Conversion must be run before running the
report. More on the  Cash Basis Conversion Utility.

Prompt

General
Starting G/L Period - The beginning G/L Period for the report.  All returned data falls in or after the
selected G/L Period.
Ending G/L Period - The ending G/L Period for the report.  All returned data falls in or before the selected
G/L Period.
Use Billing Address - When checked, the report looks at the state associated with the project (PA>
Projects> Billing Tab> Bill To Address) - If "Use Client's Bill-To" is selected on the Project OR the "Use
Custom Bill-to" State field is blank, the Client State will be used. Note: you would not use this check-box
when using the Project Address filter below.
Project Address - When using the look-up,  you will select a specific Address Name to group.  . The
report will look for the Address with the specified name and group by the state associated with it. The
result will give you a grouping of all Projects that have a Project Address with the selected name.  All
projects with a different name will be un-grouped. Note: If you want to use this to work for all projects, you
will need to have a "named" address that has the same name. The addresses, however, do not have to
fall in the same state. 
Show Projects - When selected, the Project Code and Name are broken out on the report.

Show Invoices - When selected, the Invoice Number associated with the Receipt entry is displayed.

Show G/L Accounts - When selected, the G/L Base Code, and Org. Unit (if used), are displayed on the
report.
G/L Account - When a G/L Account is selected, the transactions detail is filtered to just the selected
account. When blank, all accounts are selected.

Report

Report Columns
State - Depending on the selection option (above) used, the State will come from either the Project (Billing
Tab), Client (General Tab) or Project (Address Tab)
Invoice No. - Invoice Number associated with the Payment received in the Receipt Journal.

G/L Account - G/L Account associated with the Payment received in the Receipt Journal.

Amount - Total Amount of Received Revenue.

Sample(s)

5.1.1.83 Revenue Analysis

Description

The Revenue Analysis report returns revenue transaction in detail and summarized at the WBS level. It
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automatically filters based on project leader designation. Employees with the designation of Project

Accountant can see all projects.

Data: Sales Journal, Receipt Journal and General Journal

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

General
Project - Allows you to filter to a specific Project. When blank, All Projects are returned.

Include Inactive - When selected, Inactive projects will be returned in the report results.

Show WBS - When selected, Lower nodes of the WBS will be returned in the project Work Breakdown
Structure (WBS).
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
WBS - Project Path and Project Name

Hourly - Journal transactions that go against a G/L Account with a Metric Type of Billed Revenue a PM
Type of Labor and a Revenue Type of Direct, DPE, OH or Profit.
Fixed Fee - Journal transactions that go against a G/L Account with a Metric Type of Billed Revenue a
PM Type of Labor and a Revenue Type of Fixed Fee.
ODC - Journal transactions that go against a G/L Account with a Metric Type of Billed Revenue and a PM
Type of Other Direct Charges (ODC).
OCC - Journal transactions that go against a G/L Account with a Metric Type of Billed Revenue and a PM
Type of Out of Contract Consultants (OCC).
ICC - Journal transactions that go against a G/L Account with a Metric Type of Billed Revenue and a PM
Type of In Contract Consultants (ICC).
Other - Journal transactions that go against a G/L Account with a Metric Type of Other Revenue.

Bad Debt - Journal transactions that go against a G/L Account with a Metric Type of Bad Debt.

Retainage - Journal transactions that go against a G/L Account with a Metric Type of Retainage.

Retainer - Journal transactions that go against a G/L Account with a Metric Type of Retainer.

Received - Received monies against the project. PM Type is determined by Revenue Type assigned in
the receipt journal.

Revenue Detail
The revenue detail displaye the transactions that make up the revenue numbers.

Sample(s)

https://support.clearviewsoftware.net/articles/7614
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5.1.1.84 Sales By Date

Description
The Sales By Date Report allows you to look at all transactions that go against the Sales Journal for a
particular Date Range.

Data: Sales Journal

Note: This report is run for a date range. You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Prompt

Date Ranges
Start & End Date - Filters the data by the Date Type supplied in the next selection. 

Date Type (Required) - Options are:
o Invoice Date - The Invoice date of the journal entry.
o Create Date - Create Date of the transaction
o Modify Date - Modify Date of the transaction

General
A/R Base Code - Filters transactions to a specific Accounts Receivable G/L Base Code.

Use Org. Filter - When selected, the A/R Org. Unit selected is used to filter the report.

A/R Org Unit - Filters to a specific the Organizational Unit related to the G/L Base Code of the
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Transaction.
Include Org. Children - Includes the Organization Units Children  when filtering to a specific the
Organizational Unit.
Show Comments - When checked, the report will show the G/L Comments from the line-items of the
Journals.
Hide Detail - When selected, the detail of the Sales Journal is hidden.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Sorts
The Sorts section Groups & Sorts the report by Invoice Date, Invoice No (Number), Create Date, Modify
Date, Client and A/R Account.

Sort 1 - Top Level Sort

Sort 2 - Second Level Sort. 

Sort 3 - Third Level Sort

Report

Report Columns
A/P Account - Accounts Payable G/L Account associated with the transaction.

Firm Name - Name of the Vendor associated with the transaction.

Invoice Number - Invoice number associated with the transaction.

Due Date - Due Date assigned to the Purchase Journal entry.  

Invoice Date - The Invoice Date Associated with the transaction.

Amount - Amount of the Purchase Journal Transaction.

Account - G/L Account associated with the detail of the Purchase Journal Transaction.

Project - The Project associated with the detail of the Purchase Journal Transaction.

Expense Code - The Expense Code associated with the detail of the Purchase Journal Transaction.

Amount - The amount of the line item in the detail of the Purchase Journal Transaction. 

Sample(s)

5.1.1.85 Sales Journal Single Transaction

Description
The Sales Journal Single Transaction Report gives you the ability to sprint out a specific Sales Journal Entry
for a specific Version.  When in the Sales Journal applet, you can launch this report by simply clicking "Print"
on the toolbar.  The version showing is the one that will be displayed.  Additionally, if "Show Audit Trail" is
checked, you will see an audit trail of the changes made on that entry.

Prompt

General
Disbursement Journal ID Number - ID number of the Journal entry. This can be entered in the look-up to
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pull the transaction up.
Revision Number - The Version of the number that you want to view.

Show Audit Trail - When selected, you will see the Create By, Create Date, Modify By, Modify Date  and
the changes that happened between versions of the transaction.

Report

Report Columns
A/R Account - The Accounts Receivable G/L Account used on the transaction.

Bill To - Client Info

Invoice Date

Invoice Number

Due Date

As of Date

Current Period

Revision - The version of the transaction

Project

Expense Code

G/L Account

G/L Account Name

G/L Period

Amount

G/L Comments

Sample(s)

5.1.1.86 Sales Links

Description
 The Sales Links returns a list of all transactions that are linked to the Sales Journal entry.

Prompt

General
Invoice Start Date - Beginning Date used to filter the transactions that are brought into this report.

Invoice End Date - Ending Date used to filter the transactions that are brought into this report.

Project - Allows you to filter to a specific Project. When blank, All Projects are returned. 

Client - Allows you to filter to a specific Client. When blank, All Clients are returned. 

Show Comments - When selected, PM Comments on the transactions are displayed.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency
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Report

Report Columns
Client - Client Code & Name

Invoice No - Invoice Number of the Sales Journal

Date: Invoice Date of the Sales Journal

Trans ID - SJID of the Sales Journal

Project - Project Path & Code of the project associated with the transaction.

Trans Date - Date of the of the line item in the transaction.

Trans Number - Journal ID Number of the transaction of the line item in the transaction.

WBS - The node level of the project where the transaction was entered.

Employee/Payee - Employee or Payee Name

Labr/Exp. Code - Labor or Expense Code that was entered on the transaction.

Hrs/Units - The amount of hours or units entered on the transaction.

Effort - Labor Cost at the Bill Rate or Non-Labor cost at the Marked up rate.

Sample(s)

5.1.1.87 Standard Hours

Description
 The Standard Hours report lists employee hours and variance for a date range versus an input standard
hours.  This can be useful in determining who should get overtime.

Prompt

Date Ranges
Start Date - Beginning Date used to filter the time sheets that are brought into this report.

End Date - Ending Date used to filter the time sheets that are brought into this report.

General
Org. Unit - Filter by the Org. Unit assigned to the Employee

Pay Type - The Pay Type of the employee. This comes from the Employees> Pay History Tab> Hourly
check box. Options are Hourly, Salary and Both.
Standard Hours - Number subtracted from the total hours returned to determine Variance.  Total Hours
are determined by Start & End Date.
Include Subcontractors - When selected, Employees with the "Subcontractor" check box checked will be
included.
Use Original Time sheet - When selected, the original Time Sheet will be used to return hours. Otherwise,
adjusted time sheets will be used.
Group by Approver - When Selected, the report will group by Time/Expense Approver. Note:  This does
NOT group by Alternate and Additional Approvers.
Only Show Employees with Variance - When selected, the report will only return Employees that have a
variance other than 0
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Report

Report Columns
Employee Code

Employee Name

Pay Type -  The Pay Type of the employee. This comes from the Employees> Pay History Tab> Hourly
check box. Options are Hourly, Salary and Both.
Hours - Number of Work Hours returned for the given data range.

Variance - Hours minus Standard Hours (prompt)

Sample(s)

5.1.1.88 Stored Procedure Code

Description
 This report shows the code that is contained in a stored procedure.  Most reports and queries that ship with
InFocus use stored procedures.  This can be useful if you want to construct your own SQL queries that are
based off an existing InFocus report or query.

Prompt

General
Stored Procedure Name - Name of the Stored Procedure to be returned.

Report

Report Columns
Stored Procedure

Sample(s)

5.1.1.89 Timesheet

Description

The Time Sheet Report can linked to the Personal> Time sheet applet and will render a physical time sheet

that visually is comparable to the entry screen.  This can be enabled by selecting the Custom Time sheet

Report option in Global Settings> Time & Expense tab.
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Prompt

General
Time sheet ID - The Time Sheet ID number

Report

Report Columns
From - Period Start Date for Time Sheet

To - Period End Date for Time Sheet

Project

JC - Job Title Code

LC - Labor Code

S - Bill Status

Sample(s)

5.1.1.90 Timesheet Batch

Description
 Time Sheet Batch report is a copy of the Time sheet custom report that prints in personal time sheet.  It has
been modified to accept a date range and an employee and/or project filter.  

Prompt
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General
Start Date - Beginning Date used to filter the time sheets that are brought into this report.

End Date - Ending Date used to filter the time sheets that are brought into this report

Project - Allows you to filter to a specific Project. When blank, All Projects are returned. 

Employee - Allows you to filter to a specific Employee. When blank, All Employees are returned. 

Report

Report Columns
From - Period Start Date for Time Sheet

To - Period End Date for Time Sheet

Project

Sample(s)

5.1.1.91 Timesheet with Overtime Types

Description

Time Sheet with Overtime Types can be linked to the Personal Time sheet applet and will render a physical

time sheet that visually is comparable to the entry screen.  This can be enabled by selecting the Custom

Time sheet Report option in Global Settings in the Time & Expense tab. This report supports using multiple

Overtime Types created in Administration> Global Settings> Labels and assigned in Employees> Pay History

Tab.

Prompt

General
Time sheet ID - The Time Sheet ID number

Report

Report Columns
From - Period Start Date for Time Sheet

To - Period End Date for Time Sheet

Project

JC - Job Title Code

LC - Labor Code

S - Bill Status

Sample(s)
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5.1.1.92 Timesheet with Overtime Types Batch

Description

The Time Sheet with Overtime Types report can be linked to the Personal Time sheet applet and will render a

physical time sheet that visually is comparable to the entry screen.  The report can accept a date range and

an employee and/or project filter.    This can be enabled by selecting the Custom Time sheet Report option in

Global Settings in the Time & Expense tab. This report supports using multiple Overtime Types created in

Administration> Global Settings> Labels and assigned in Employees> Pay History Tab.

Prompt

General
Start Date - Beginning Date used to filter the time sheets that are brought into this report.

End Date - Ending Date used to filter the time sheets that are brought into this report

Project - Allows you to filter to a specific Project. When blank, All Projects are returned. 

Employee - Allows you to filter to a specific Employee. When blank, All Employees are returned. 

Report

Report Columns
From - Period Start Date for Time Sheet

To - Period End Date for Time Sheet

Project

Sample(s)

5.1.1.93 Transactions Transcending Companies

Description

Prompt

General
Starting G/L Period - 

Ending G/L Period - 

Current Version Only - 

Include Sales - 

Include Receipts - 

Include Adjustments - 
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Include Purchases - 

Include Disbursements - 

Include Employee Reimbursables - 

Group by G/L Period - 

Report

Report Columns

Drill-through Report

Sample(s)
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5.1.1.94 Trial Balance with drill-down

Description
The Trial Balance with Drill-down report displays account balances based on user driven criteria. Includes
click in details for debits and credits. This report also includes End of Year Closing click in details.

Prompt

General
Starting Period - Beginning Period used to filter the transactions that are brought into this report.

Ending Period - Ending Period used to filter the transactions that are brought into this report.

Org. Unit - When selected, the data is filtered to display only the specified Organizational Unit.

Include Org. Children - When selected, the Child Org. are included in the returned results.



InFocus System Reports 779

© 2020 Clearview Software, Inc.

Consolidate - When selected, All of the Organizational Units are consolidated into one line instead of
being broken out into their respective Org. Units.
Accrual - When checked, the report reports on an Accrual Basis.

Include Accounts with No Activity - When selected, Accounts that have no activity will be returned in the
results.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency
Include Realized Gains Losses - When selected, Realized Gains Losses are includes in the returned data
(Multi-Currency only). More on MC Revaluations
Include Unrealized Gains Losses - When selected, Unrealized Gains Losses are includes in the returned
data (Multi-Currency only). More on MC Revaluations
Include End of Year Closing Entries - When selected, EOY Closing entries are included in the returned
results.

Report

Report Columns
Account - Account Code & Name

Beginning Balance - Starting Balance for the specified Account.

Current Debits - Debits against the specific Account. 

Current Credits - Credits against the specific Account. 

Ending Balance - Ending Balance for the specified Account minus the Debits and Credits.

Drill-through Report
TransID - Transaction ID Number of the transaction.

Trans Date - Transaction Date of the transaction.

Invoice / Check Number

Description - Client / Payee Name

Amount

Sample(s)
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5.1.1.95 Unapproved Expense Sheets

Description
 The Unapproved Expense Sheets report lists expense sheets that have not been approved.

Prompt
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General
Org. Unit - Filters by Org. Unit assigned to the Employee.

Group by Approver - When selected, the report will group by the primary approver.

Report

Report Columns
ESID - Expense Sheet ID Number

Expense Sheet - Expense Sheet Name

Status - Status of the Expense Sheet

Reimburse - Amount to be reimbursed to the employee.

Sample(s)

5.1.1.96 Unapproved Timesheets

Description
 The Unapproved Expense Sheets report lists expense sheets that have not been approved.

Prompt

General
Org. Unit - Filters by Org. Unit assigned to the Employee.

This P/E Date - The PE (Period End) Date to filter the report by.

 All P/E Dates - When selected, All PE dates are returned in the report.

Group by Approver - When selected, the report will group by the primary approver.

Report

Report Columns
Employee Code

Employee Name

Period End Date

Hours

Status - Status of Time Sheet

Sample(s)

5.1.1.97 Unbilled Summary By Org Unit

Description
 The Unbilled Summary by Org Unit report is useful for companies that want to make general ledger entries to
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capture WIP. The report has an option to post WIP to the General Journal. 

Note1: You must have the PM Bill Review special permission "Can Override Project leader" to post to the
general ledger.   

Note2: In order to perform the post you will also need to set up the posting accounts in the Revenue
Recognition tab in Global Settings.  

Note3: When you choose to post a messages section will appear at the end of the report.  The messages
will display the journal entry number if successful otherwise it will display error messages.  The auto-reverse
feature in the general journal can be used to reset the values to zero in the next period. 

Note4: The report has standard PM Leader restrictions so can be safely used by project managers.

Prompt

Date Ranges
As of Date - Cut-off Date for transactions to be returned/posted.

General
Project - When a project is selected, the report will be run for that individual project.  Otherwise all
projects will be included.
Include Labor - When selected, Labor WIP will be included (Time Sheets).

Include ODC - When selected, ODC WIP will be included (Purchase, ER, and Disbursement Journals)

Include OCC - When selected, OCC WIP will be included (Purchase, ER, and Disbursement Journals)

Include ICC - When selected, ICC WIP will be included (Purchase, ER, and Disbursement Journals)

Post WIP to General Ledger - When selected, WIP (Transactions with a Bill Status of R or H) will be
posted to the general journal.  You must have the PM Bill Review special permission Can Override Project
leader to post to the general ledger.  
Post to Level - Level for the WIP to be posted to when the entry is created.

Report

Report Columns
Project Code & Name

No Org Unit - Distribution amount going against No Organizational Unit.

Org Unit -  Distribution amount going against an Organizational Unit.

Labor - Distribution amount going against Labor.

ODC - Distribution amount going against ODC (Other Direct Charges).

OCC - Distribution amount going against OCC (Out of Contract Consulting Charges).

ICC - Distribution amount going against ICC (In Contract Consulting Charges).

Total - Total Distribution of WIP.

Sample(s)
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5.1.1.98 Unprocessed Expense Sheets

Description
The Unprocessed Expense Sheets report lists expense sheets line items that have not been either imported
into the employee reimbursable journal or have not been declined. 

Prompt

General
Org. Unit - Filters by Org. Unit assigned to the Employee.

Group by Approver - When selected, the report will group by the primary approver.

Show Detail - When selected, the Transaction Detail is displayed on the report.

Report

Report Columns
Approver - When selected to display.

Employee Code

Employee Name

ESID - Expense Sheet ID Number

Project Code and Name

Date - Date of the Expense Sheet

Expense Sheet - Expense Sheet Name

Comment - Expense Sheet Comment

Charged - Expense Amount

Reimburse - Expense Amount to be reimbursed to the employee.

Sample(s)

5.1.1.99 User Security Settings

Description

The User Security Settings report gives you the ability to see the Permission setup of both Users and
Groups.

Prompt (Wizard Style)

General
User or Group Permissions (Required) - Select whether you would like to see the Permission Setup of the
Users or Groups
Show Applets - When selected, Applet Permissions are brought into the report.

Show Reports - When selected, Report Permissions are brought into the report.

Show Documents Folders - When selected, Document Folder Permissions (Document Management) are
brought into the report.
Group Name (Must select one) - When you are filtering by Group, this box will be enabled, allowing you to
filter by a single Permission Group.
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Employees (Leave blank for all) - When you are filtering by User, this box will be enabled, allowing you to
filter by a single/multiple Users.

Report

Report Columns

Applets Section
Can View - When "Yes", the User/Group has access AND the ability to View data in this applet.

Can Edit - When "Yes", the User/Group has access AND the ability to Edit/Modify data in this applet.

Can Add Can Delete - When "Yes", the User/Group has access AND the ability to Delete data in this
applet.
Special Right - Displays Special Rights that have been granted in the specified location.

Reports Section
Report Name - Name of the Report that the User/Group has access to.

Is Custom - When "Yes", the report is not a system report that ships "out-of-the-box" with InFocus. 

Document Folder Section
Document Folder - The Name of the Document Folder that the Permissions are referencing.

Can Modify - When "Yes", the User/Group are able to Modify the Documents in the Document Folder.

Is Custom - When "Yes", the Document Folder is not a system Document Folder that ships "out-of-the-
box" with InFocus.

Sample(s)
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5.1.1.100Vendor Inquiry

Description
The Vendor Inquiry report allows you to search for invoices, amounts billed, and other cost amounts paid to
vendors 

Note: This report is run for a date range.  You may not see the same figures if you are trying to compare this
to an Income Statement or a Balance Sheet that uses a GL Period as a Date Filter.

Data: That data is collected from the Disbursements, Receipts, and Purchase Journals

Prompt

Date Ranges
Start & End Date - Filters the data by the transaction date on the Journal entry.

General
Vendor Code - Allows you to filter to a specific Vendor. When blank, All Vendors are returned.

G/L Account - Specifies the account to limit the report. When blank, all accounts are returned

Transaction Type - Allows you to filter report by Invoice or Payment types or to include both.

Show Invoice - If checked, will display invoiced amount in report.

Show Project - If checked, will display associated project with invoice.
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Show WBS - If checked, will display the Work Breakdown Structure of the project.

Show Transaction Detail - If checked, will display invoice/check item detail 

Only Active Vendors - If checked, filters the report only for vendors marked "active" in the Vendors applet.

Open Invoices Only - If checked, only returns unpaid invoices

Include Consultants -  If checked, the report will display vendors marked "consultants" in the Vendors
applet.
Include Non-Consultants - If checked, the report will display vendors not marked "consultants" in the
Vendors applet.
Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Trans Number - Invoice # (Purchase Journal) or Check # (Disbursement,Receipt)

Transaction Type - Invoice (Purchase Journal) or Check (Disbursement,Receipt). In Space after - Invoice
# (Purchase Journal) or Check Date (Disbursement,Receipt)
Project Amount - The Cost Amount for the Purchase & Disbursement Journals. The Amount of the
Receipts Journals. 
Invoice Amount - The detailed Cost Amount for the Purchase & Disbursement Journals.

Paid Amount - The Amount for the Receipts Journals. 

Other Amount - The Cost Amount for the Disbursement and Receipts Journals. 

Sample(s)

5.1.1.101WBS Listing

Description
WBS Listing details information regarding projects and displaying a breakout of each WBS node within the
project.

Prompt

General
Project - Returns only the selected project. All projects are returned if left blank.

Client - Returns only the projects for selected client. 

Principal In Charge - Returns all projects where the selected employee is assigned as the Principal In
Charge on the Project (Members Tab).
Project Manager - Returns all projects where the selected employee is assigned as the Project Manager
on the Project (Members Tab).
Project Accountant - Returns all projects where the selected employee is assigned as the Project
Accountant on the Project (Members Tab).
Org. Unit - Returns all projects where the selected Organizational Unit is assigned to the Project
(Members Tab).
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Active Status - Returns all projects that have the selected status. Options are Active, Inactive and Both.

Charge Type - Returns all projects that have the selected Charge Type. Optiona are Billable, Indirect,
Opportunity, Projection and All.

Report

Report Columns
Project - Path and Name of the Project

Client - Client associated with the Project.

PIC - Principal In Charge assigned to the Project (Members Tab)

Org. Unit - Project's Organizational Unit

Status - Project Status

Prj Mgr - Project Manager assigned to the Project (Members Tab)

Prj Acct - Project Accountant assigned to the Project (Members Tab)

Charge Type - Project's Charge Type

Expense Group - Expense Group Assigned to the Project.

Invoice Design - Invoice Design Assigned to the Project.

Detail
Project Code and Name

Project Start Date - Start Date of Project (General Tab) 

Project End Date - End Date of Project (General Tab) 

Time Start Date - Beginning Date for the Allowable Date Range for time entry. (Optional)

Time End Date - Ending Date for the Allowable Date Range for time entry. (Optional)

Exp. Start Date - Beginning Date for the Allowable Date Range for expense entry. (Optional)

Exp. End Date - Ending Date for the Allowable Date Range for expense entry. (Optional)

Sample(s)

5.1.1.102WBS Node Inquiry

Description
WBS Node Inquiry report allows you to view hours, cost, effort, billed and unbilled figures that go against a
specific Level & Node (Code) of the Project WBS.

Example: An example usage of this report in the Casco and Wilson database would be to return transaction
information related to "003 - Design Development" phases across all projects. 

Note: This report honors Project Roles Filtering. Form more details read this article CLICK HERE.

Data: That data is collected from Time Sheets and the Purchase Journal, Employee Reimbursables,
Disbursements, Sales, Receipts and General Journals

Prompt

Date Ranges
Start & End Date - Filters the data by the transaction date on the Time Sheet/Journal entry.

https://support.clearviewsoftware.net/articles/7614
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Use G/L Period for Labor - If checked, uses G/L period instead of date range to filter the time sheet
Transactions. Note: This will only function correctly if you are using the Labor Distribution feature in
InFocus.
Use G/L for Non-Labor - When selected, the G/L Periods from the prompt will be used to filter all of the
Journals listed above.
Start G/L Period - Beginning period for range of transactions (if "Use G/L Period for Time Transactions"
option is checked)
End G/L Period - Last period of range for transactions (if "Use G/L Period for Time Transactions" option is
checked)

General
WBS Level (Required) - The level of the Project that you want the report to look at.

WBS Codes - Specific codes to return in the report. If you want to see more than one code, enter each of
them in this box separated by a comma. For example, 001, 002, 005
Project Status - The Status of the projects that you want included in the returned data. Options are Active,
Inactive or Both 
Show Detail - displays transaction details if checked. If unchecked, shows aggregated information

Show Transaction ID - When selected, the Transaction ID of the transactions are displayed on the report.

Show Comments - When selected, the PM Comments from the transactions are displayed on the report.

Include Unapproved Time - When selected, Unapproved Time Sheets will be included in the data returned
to the report. 
Include Time - When selected, transactions from Time Sheets will be included in the report.

Include Purchases - When selected, transactions from Purchase Journal will be included in the report.

Include Employee Reimbursables - When selected, transactions from Employee Reimbursables Journal
will be included in the report.
Include Disbursements - When selected, transactions from Disbursement Journal will be included in the
report.
Include Sales - When selected, transactions from Sales Journal will be included in the report.

Include Receipts - When selected, transactions from Receipts Journal will be included in the report.

Include Adjustments - When selected, transactions from General Journal will be included in the report.

Currency Type - The Type of Currency to be used when running the report. Options are Base, Company,
Project and Transaction.
Currency Code - The Currency Code to be used when running the report. Options are set in the Multi-
Currency applet.  More on Multi-Currency

Report

Report Columns
Transaction ID - ID that corresponds to the appropriate Journal or Time Sheet entry.

Transaction Date - Work Date (Time Sheets), Invoice Date (Sales, Purchase,Employee Reimbursable),
Check Date (Receipt, Disbursement), or TransDate (General Journal) depending on the Journal being
reported on. 
Hours - The Hours entered through a Time Sheet.  When "Include Unapproved Time" is selected, this will
include unapproved time.
Cost - For Labor, the cost figure represents Labor Cost at the Pay Rate.  For Non-Labor, the cost figure
represents the Cost rate. The Cost Numbers come from the Time Sheets, Purchase Journal,Employee
Reimbursable Journal, Disbursement and General Journals. Note: To see labor Cost, the employee must
have the "Can View Pay Rate" box checked in their Employee File (Accounting Rates Tab)
Effort - For Labor, the efort figure represents Labor Cost at the Bill Rate.  For Non-Labor, the effort figure
represents the Marked-up rate. The Effort Numbers come from the Time Sheets, Purchase
Journal,Employee Reimbursable Journal, Disbursement and General Journals. 
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Billed - The Billed numbers represent amounts coming from the Sales, Receipts and General Journals
that go against G/L Accounts with a Metric Type of Billed Revenue, Other Revenue, Late Fee and Bad
Debt. Additionally, any Account with a Sub-ledger type os Accounts Receivable is brought into this figure.
Unbilled - This figure represents Unbilled WIP (Work In Process). WIP are all Transactions that have a
Bill Status of R (Ready to Bill) or H (Hold). For Labor, the Unbilled Effort figure represents Labor Cost at
the Bill Rate.  For Non-Labor, the cost figure represents the Marked-up rate. The Effort Numbers come
from the Time Sheets, Purchase Journal,Employee Reimbursable Journal, Disbursement and General
Journals. 

Sample(s)

5.1.2 Action Descriptions (System)

Overview  

Here are the system Actions
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Report Descriptions

Add a Vendor: Action dialogue to add a new Vendor available from Purchase Journal and Vendor applet

toolbars.

Add G/L Accounts to New Org Unit: Inserts G/L Accounts for specified Organizational Unit to defined

account types.

Auto-create Expense Sheet from Time (Project Level): Creates Expense Sheet from Time Sheet at the

Project level

Auto-create Expense Sheet from Time (WBS Level): Creates Expense Sheet from Time Sheet at a

specified Project level

Bank Transfer Using Disbursement and Receipt: Completes a bank transfer using the Disbursements/

Receipts Journals

Bank Transfer Using General Journal: Completes a bank transfer using two General Journal transactions.

Change G/L Period (Any Period): Changes G/L Period for a specified Journal Transaction.

Change G/L Period (Open Periods Only): Changes G/L Period for a specified Journal Transaction (only

allows open G/L Periods)

Change Mileage Rate: Versions all expense groups with a supplied effective date and updates the unit

rate for the supplied expense code.

Close Multiple Accounting Years: Closes accounting years by specified date range and accounting

method

Compress Time Sheet and Combine Comments: Creates summarized Time Sheet for specified TimeID

Convert Project Fee Type: Converts fee type from Fixed Fee to Hourly or vice verse for specified Project

Copy Projects From Timesheet (Project Level): Creates an expense sheet line item(s) for a specified

Expense Sheet for the Projects (Bill Terms Level), Bill Statuses, Work Dates of a specified Time Sheet.

Copy Projects From Timesheet (WBS Level): Creates an expense sheet line item(s) for a specified

Expense Sheet for the Projects, Bill Statuses, Work Dates of a specified Time Sheet.

Create a Simple PM Report: Action dialogue to create a PM Report.

Deactivate Employee: Deactivates, resets password, ends pay history, removes from project teams,

deletes group memberships and clears special rights for specified employee and termination date.

Enter a Vendor Invoice: Action dialogue to create a Vendor Invoice

Modify Previous Billed On A Project without Affecting the General Ledger: Creates General Journal entry

to Project with offsetting entry to G/L Account

Open an Historical Year: Creates G/L Period for specified historical Fiscal Year

Open New G/L Period: As titled with relevant parameters.

Override Employee Job Title on a Project: Adds job title override for specified employee/project. Will also

update Time Sheets, Bill Rates if specified.
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Prevent expense sheet from being saved if amount to be reimbursed is different than charge amount: As

titled.

Prevent Overtime with less than 40 or 80 hours: Raises system error during time entry to govern the point

at which overtime can be charged.

Quick Employee Add: Action dialogue to add an employee

Quick G/L Account Add: Action dialogue to add a G/L account

Quick Project Add: Action dialogue to add a Project

Quick Project Add from Template: Action dialogue to add a Project from a WBS Template.

Quick Vendor Add: Action dialogue to add a Vendor

Refund Retainer: Action dialogue to refund an existing retainer.

Reopen Expense Sheet: Reopens an unapproved expense sheet.

Reopen Time Sheet: Reopens an unapproved time sheet.

Set Start and End Dates for a Level 2 Node: Establishes expense start and end dates for a specified

Project Level two. Also updates the parent project expense start and end dates.

Test Employee for Allowable Time Entry: Reports whether or not an employee can charge time to a

specified Project node. Also reports charge organization information.

Void a Check: Action dialogue to void a check.

5.1.2.1 Add a Vendor

Description

This action provides an easy way to add new vendors to your system. The prompt will ask for vendor code,
name, and other pertinent information.

After running this action, a new vendor is created with the information provided. The new vendor can be found
and edited within "Accounts Payable" -> "Vendors

Suggested Setup/Usage
This action can be added to the sidebar under various modules within InFocus (i.e., Accounts Payable). For
more on adding this action to the sidebar, click here. Corresponding permissions must be added to the action
to be visible to users.
.

Prompt

Enter Vendor Code and Name
Vendor Code and Name - Intended code and name vendor. The next step will validate to make sure code
is not already being used. Both items are required

Code Validation
Vendor Code - Checks to see if code is already being used by a firm. 



InFocus User Manual - Current (v2020)792

© 2020 Clearview Software, Inc.

Main Address
Address Information - Provides the main address information for vendor. Supports both Canadian and US
postal codes. All fields are optional.

Pay To Address
Pay to Address information - Can reuse same information from main address or enter new information. All
fields are optional.

1099 Info
Vendor 1099 Information - Includes Federal ID and name needed for 1099 form

Defaults
GL Account Codes - Used for direct and indirect account codes related to vendor. Leaving blank will use
default values per system configuration
Expense Codes - Determines default expense code related to vendor. Leaving blank will use default
values per system configuration
Net Days - Net days to add to vendor invoice to calculate due date.

Is Unit Biller - When checked, a units (quantity) field will automatically show in the Purchase Journal for
the selected vendor.

EFT Info
Uses EFT - Checking allows for the vendor EFT information provided to be used

Company Info - Typically the Federal EIN number

Company Name - "Doing Business As" name

Is account a Savings Account? - When checked, flags account as an Savings account.  Otherwise
considered an Checking account.

Check Writing Info
Check Memo - memo for check for vendor when printed from AP Check Writing applet

Discount Days - Number of days past invoice date when a discount can be realized.

Discount Percentage - Percentage to apply against invoice amount to calculate discount. Entered as a
percentage (2.00 = 2%)

Miscellaneous
Is consultant- When checked, the vendor is flagged as a consultant. It is necessary when using pay when
paid reports and it can also be used to filter results in other reports like the Vendor Inquiry. This has no
effect on the Labor Distribution process.
Vendor Type - Pulls from Vendor Types list found in "Administration" -> "List Management"

5.1.2.2 Add G/L Accounts to New Org Unit

Description
After running the action, G/L accounts that have not already been added will be added to new org units. Will
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throw an error message if unsuccessful. 

Suggested Setup/Usage
This action can be added to the sidebar under various modules within InFocus (i.e., General Accounting). For
more on adding this action to the sidebar, click here. Corresponding permissions must be added to the action
to be visible to users.

Prompt

Add G/L Accounts
Org Unit  - The Org Unit with which new G/L Accounts will be added

Include Income Accounts - Checking this includes all accounts marked as "Income". This can be found in
"General Accounting" -> "Chart of Accounts" under "Financial Type"
Include Expense Accounts - Checking this includes all accounts marked as "Income". This can be found
in "General Accounting" -> "Chart of Accounts" under "Financial Type"
Only with a Project Metric - If checked, only includes accounts that have a Metric Type assigned. This
can be found in "General Accounting" -> "Chart of Accounts" under "Account Type" -> "Other/Metric
Type"

5.1.2.3 Auto-create Expense Sheet from Time (Project Level)

Description
After running this action, a new unapproved, unsubmitted expense sheet will be created for the same time
period as the time sheet. The new expense sheet will be created at the Project level, not to any underlying
WBS levels. The items in the expense code will only generate to projects level that have hours associated in
the Time Sheet.

Suggested setup for this action is to modify the action under "Utilities" -> "Custom Reports" -> "Modules /
Applets". Checking the Time Sheets Applet and setting the Type to "On Create". No other item within
"Custom Reports" can be set to "Time Sheets" -> "On Save" for this to work correctly.

Suggested Setup/Usage
This action can be launched after creating a time sheet. For more on adding this action to the sidebar, click 
here. Permissions must be added for the action to launch.

Prompt
[No prompts]
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5.1.2.4 Auto-create Expense Sheet from Time (WBS Level)

Description
After running this action, a new unapproved, unsubmitted expense sheet will be created for the same time
period as the time sheet. The new expense sheet will be created at the corresponding WBS level as the time
sheet line. The items in the expense code will only generate to WBS levels that have hours associated in the
Time Sheet.

Suggested setup for this action is to modify the action under "Utilities" -> "Custom Reports" -> "Modules /
Applets". Checking the Time Sheets Applet and setting the Type to "On Create". No other item within
"Custom Reports" can be set to "Time Sheets" -> "On Save" for this to work correctly.

Suggested Setup/Usage
This action can be launched after creating a time sheet. For more on adding this action to the sidebar, click 
here. Permissions must be added for the action to launch.

Prompt
[No prompts]

5.1.2.5 Bank Transfer Using Disbursement and Receipt

Description
Running this action will transfer bank funds within InFocus from one account to another using the
Disbursements/Receipt Journals. 

Suggested Setup/Usage
This action can be added to the sidebar under various modules within InFocus (i.e., General Accounting). For
more on adding this action to the sidebar, click here. Corresponding permissions must be added to the action
to be visible to users.

Prompt

Accounts
From Bank Account (required) - The bank account from which the amount will be moved

To Bank Account (required) - The bank account to which the amount will be moved

Suspense Account (required) - 

Transaction
Transaction Date (required) - The date which will be logged as the date the transfer occurred

G/L Period (required) - The period for which the transfer will be logged against

Transfer Amount (required) - Amount to be transferred. 
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5.1.2.6 Bank Transfer Using General Journal

Description
Running this action will transfer bank funds within InFocus from one account to another using two General
Journal transactions. 

Suggested Setup/Usage
This action can be added to the sidebar under various modules within InFocus (i.e., General Accounting). For
more on adding this action to the sidebar, click here. Corresponding permissions must be added to the action
to be visible to users.

Prompt

Accounts
From Bank Account (required) - The bank account from which the amount will be moved

To Bank Account (required) - The bank account to which the amount will be moved

Suspense Account (required) - 

Transaction
Transaction Date (required) - The date which will be logged as the date the transfer occurred

G/L Period (required) - The period for which the transfer will be logged against

Transfer Amount (required) - Amount to be transferred. 

5.1.2.7 Change G/L Period (Any Period)

Description
After running this action, the indicated Journal transaction will be updated to the provided G/L Period. The
action allows for any period to be selected.

Suggested Setup/Usage
This action can be added to the sidebar under various modules within InFocus (i.e., General Accounting). For
more on adding this action to the sidebar, click here. Corresponding permissions must be added to the action
to be visible to users.

Prompt
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Journal (required) - The corresponding journal to the ID provided. Options: Disbursement Journal,
Employee Reimbursables, General Journal, Receipt Journal, Purchase Journal, Sales Journal
Transaction ID (required) - The Transaction ID corresponding to the journal provided. The ID can be
found within each journal in the header
G/L Period (required) - The period to which the transaction will be moved

5.1.2.8 Change G/L Period (Open Periods Only)

Description
After running this action, the indicated Journal transaction will be updated to the provided G/L Period. The
action allows for only open periods to be selected.

Suggested Setup/Usage
This action can be added to the sidebar under various modules within InFocus (i.e., General Accounting). For
more on adding this action to the sidebar, click here. Corresponding permissions must be added to the action
to be visible to users.

Prompt
Journal (required) - The corresponding journal to the ID provided. Options: Disbursement Journal,
Employee Reimbursables, General Journal, Receipt Journal, Purchase Journal, Sales Journal
Transaction ID (required) - The Transaction ID corresponding to the journal provided. The ID can be
found within each journal in the header
G/L Period (required) - The period to which the transaction will be moved

5.1.2.9 Change Mileage Rate

Description

This action updates the mileage rate from the provided expense code. 
From Doc: Versions all expense groups with a supplied effective date and updates the unit rate for the
supplied expense code.

Prompt

Enter Information

New Rate (required) - New rate for the mileage

Effective Date (required) - The date the new mileage rate is implemented. Note: this is not intended for a
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date range and will be calculated for all dates going forward until the rate is changed again.
Mileage Code (required) - The corresponding expense code for mileage

Set Markup to New Rate - Checking this option will set both the new mileage rate and the markup to the
new rate indicated above

5.1.2.10 Close Multiple Accounting Years

Description

From Doc: Closes accounting years by specified date range and accounting method
Running this action will close multiple accounting years that are specified by accounting method.

Prompt

Accounts
Retained Earnings - In multi-company mode, this account will automatically switch for each company
using the base account of the G/L account designated here

Enter closing selections
First Year (required)- The first inclusive year to close out

Last Year (required) - The last inclusive year to close out

Accounting Method (required) - Cash, Accrual, or Both

5.1.2.11 Compress Time Sheet and Combine Comments

Description

This action consolidates a timesheet by grouping rows by project path. For instance, if multiple lines have the
same project path but hours on different rows, this action will bring those rows together, adding the hours
together for each day. If a cell contains a comment for hours worked, it will leave those hours excluded from
the remaining, uncommented hours.

Prompt
[no prompts]



InFocus User Manual - Current (v2020)798

© 2020 Clearview Software, Inc.

5.1.2.12 Convert Project Fee Type

Description

This action changes the project fee type from Fixed Fee to Hourly or vice versa. This is accomplished by
updating the Sales Journal, Receipts Journal, and the General Journal with the G/L account of the converted
project fee type.

Note: If running multi-company, the new G/L account must be within the same company.

Prompt

Project Info
Project - Fixed fee or hourly project to be converted

Change - Choose from "From Hourly To Fixed Fee" or "From Fixed Fee to Hourly"

Existing G/L Account - The corresponding Hourly/Fixed Fee G/L account that the project currently uses

New G/L Account - The corresponding Hourly/Fixed Fee G/L account that the project should point to after
conversion

5.1.2.13 Copy Projects From Timesheet (Project Level)

Description

This action is launched from "Personal" -> "Expense Sheets" and copies projects (at bill term level) from a
time sheet to an expense sheet for the selected period. To add this action to expense sheets, click on the
"Modules/Applets" tab in "Utilities" -> "Custom Reports" and select "Expense Sheets" and change the "Type"
drop down to "Toolbar".

NOTE: The time sheet must be in a state of "Saved" or "Submitted" for the projects to be copied to the
Expense Sheet.

Prompt

General
Period End Date (required) - The last day of the time sheet period for which the new expense sheet will be
copied
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5.1.2.14 Copy Projects From Timesheet (WBS Level)

Description

This action is launched from "Personal" -> "Expense Sheets" and copies projects at the corresponding WBS
level from a time sheet to an expense sheet for the selected period. To add this action to expense sheets,
click on the "Modules/Applets" tab in "Utilities" -> "Custom Reports" and select "Expense Sheets" and
change the "Type" drop down to "Toolbar".

NOTE: The time sheet must be in a state of "Saved" or "Submitted" for the projects to be copied to the
Expense Sheet.

Prompt

General
Period End Date (required) - The last day of the time sheet period for which the new expense sheet will be
copied

5.1.2.15 Create a Simple PM Report

Description

This action creates a simple PM Report based on parameters provided through the prompt. After completing,
permissions may still need to be adjusted in "Utilities" -> "PM Report Designer" on the "Permissions" tab.

Note: This action honors Project Roles Filtering. Form more details read this article CLICK HERE.

Prompt

General
Title of the report (required) - the new name given to the report

Orientation (required) - the direction in which the new report will print. Portrait or Landscape mode is
supported
Print Project Name on Line above Column Metrics (required)

Only Print WBS (do not show transaction) - the level of detail the report displays

Periods or Time Frames - Number of periods displayed in the report

Date Range - Choose between a date range or as-of date

Other Parameters
Column Headings 

Column Metrics 

Column Periods

https://support.clearviewsoftware.net/articles/7614
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5.1.2.16 Deactivate Employee

Description

Deactivates, resets password, ends pay history, removes from project teams, deletes group memberships
and clears special rights for specified employee and termination date.

Prompt

General
Employee (required) - The employee to be deactivated

Termination Date - termination date marked in "Human Resources" -> "Employees" and last date of in
"Pay History"

5.1.2.17 Enter a Vendor Invoice

Description

This action creates a vendor invoice from the prompt. The invoice will appear as an entry in the purchase
journal after completed

Prompt

General Info
Vendor - 

Invoice Number - 

Invoice Date - 

Comments to appear in A/P Reports and/or check stubs - 

Project Info
Project - 

Comments to appear in project reports and/or invoices - 

Amounts
Units - 

Unit Rate - 

Distribution
General Ledger Account to Charge - 
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5.1.2.18 Modify Previous Billed On A Project WIthout Affecting the General Ledger

Description

Creates General Journal entry to Project with offsetting entry to G/L Account

Prompt

General
Project - Project in which the previously billed needs to be adjusted

Revenue Type - The revenue type that the previously billed needs to be adjusted. Can choose from
Labor, Other Direct Charges, Out of Contract Consultants, or In-Contract Consultants
Labor Revenue Type - Only applicable when "Labor" is selected for "Revenue Type". Choose from Fixed
Fee or Hourly revenue type
WBS Node (if any) - choose which node of the WBS to create the General Journal entry against

Amount to Record as Previously Billed - Amount to adjust the previously billed by. A negative number will
decrease the previously billed while a positive amount will increase it
G/L Account - account to which the previously billed will be recorded

5.1.2.19 Open an Historical Year

Description

From Doc: Creates G/L Period for specified historical Fiscal Year

Prompt

General

Sample(s)

Outcome

5.1.2.20 Open New G/L Period

Description
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From Doc: As titled with relevant parameters.

Prompt

General

Sample(s)

Outcome

5.1.2.21 Override Employee Job Title on a Project

Description

From Doc: Adds job title override for specified employee/project. Will also update Time Sheets, Bill
Rates if specified.

Prompt

General

Sample(s)

Outcome

5.1.2.22 Prevent expense sheet from being saved if amount to be reimbursed is different than charge
amount

Description

From Doc: As titled.
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Prompt

General

Sample(s)

Outcome

5.1.2.23 Prevent Overtime with less than 40 or 80 hours

Description

From Doc: Raises system error during time entry to govern the point at which overtime can be
charged.

Prompt

General

Sample(s)

Outcome

5.1.2.24 Project - Edit

Description

Data: ... Journal

Prompt
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General

Sample(s)

Outcome

5.1.2.25 Quick Employee Add

Description

From Doc: Action dialogue to add an employee

Prompt

General

Sample(s)

Outcome

5.1.2.26 Quick G/L Account Add

Description

From Doc: Action dialogue to add a G/L account

Prompt

General
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Sample(s)

Outcome

5.1.2.27 Quick Project Add

Description

From Doc: Action dialogue to add a Project

Prompt

General

Sample(s)

Outcome

5.1.2.28 Quick Project Add From Template

Description

From Doc: Action dialogue to add a Project from a WBS Template.

Prompt

General

Sample(s)

Outcome
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5.1.2.29 Quick Vendor Add

Description

From Doc: Action dialogue to add a Vendor

Prompt

General

Sample(s)

Outcome

5.1.2.30 Refund Retainer

Description

From Doc: Action dialogue to refund an existing retainer.

Prompt

General

Sample(s)

Outcome
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5.1.2.31 Reopen Expense Sheet

Description

From Doc: Reopens an unapproved expense sheet.

Prompt

General

Sample(s)

Outcome

5.1.2.32 Reopen Time Sheet

Description

From Doc: Reopens an unapproved time sheet.

Prompt

General

Sample(s)

Outcome

5.1.2.33 Set Start and End Dates for a Level 2 Node

Description
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From Doc: Establishes expense start and end dates for a specified Project Level two. Also updates
the parent project expense start and end dates.

Prompt

General

Sample(s)

Outcome

5.1.2.34 Test Employee for allowable time entry

Description

From Doc: Reports whether or not an employee can charge time to a specified Project node. Also
reports charge organization information.

Prompt

General

Sample(s)

Outcome

5.1.2.35 Time Sheet Work-dates All Allowable

Description
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Prompt

General

Sample(s)

Outcome

5.1.2.36 Void a Check

Description

From Doc: Action dialogue to void a check.

Prompt

General

Sample(s)

Outcome

5.1.3 Data Grids (System)

Overview  

Here is a list of the "Out of the box" system Data Grids. A Data Grid is a "grid" pop-up that displays raw data.

 Data Grids are located at Utilities> Custom Reports> System (System Drop-down)> Data Grids (Type Drop-

down).  



InFocus User Manual - Current (v2020)810

© 2020 Clearview Software, Inc.

To activate follow these steps:

1. Double-click on the Data Grid that you want to activate and make sure that the "Active" flag is selected.

2. Click on the Permissions Tab and select the User/Groups that you want to activate the Data Grid for.

3. Click on the Modules/Applet Tab and select the Module that you want the Data Grid to be activated for.

4. Click "Save" and the Data Grid is activated. 

5. Finally, Log out and back into InFocus.  Go to the location and you will see the Data Grid there ready to

launch like a Custom Report.

Data Grid Descriptions

Employee Reimbursable Payment - Meant to be Assigned to the Employee Reimbursable Applet, The

Employee Reimbursable Payment Data Grid returns Disbursements and Receipt amounts that have been

applied to the selected Employee Reimbursable Journal. It shows payment info for accrual entry

associated with the loaded transaction. This is located in the tool bar under Reports.

Fiscal Years Not Closed - Displays unclosed Fiscal Years for specified Cash/Accrual type and Company.

The underlying code looks at the General, Sales, Purchase, ER, Disbursement and Receipt Journals to

make the determination.

Purchase Payment - Meant to be Assigned to the Purchase Journal Applet, this data grid shows payment

info for accrual entry associated with the loaded transaction. This is located in the tool bar under

Reports. 

Sale Payment - Meant to be Assigned to the Sales Journal Applet, this data grid shows payment info for

accrual entry associated with the loaded transaction. This is located in the tool bar under Reports.

Transaction Audit Trail - Can be assigned to the Sales, Receipt, General, Purchase, Disbursement, ER

Journals or the Time Sheet Adjustments Applet.  It shows a grid style audit trail report for the specified

transaction

Trial Balance Data Grid - The Trial Balance Data Grid displays account balances based on user driven

criteria. This data grid can optionally includes End of Year Closing entries.

Utilization Detail By Org (Data Grid) - An Employee Utilization Data Grid that returns standard utilization

data. 

Utilization Summary By Org (Data Grid) - An Org Unit Utilization Data Grid that returns standard utilization

data.  
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5.1.4 Warnings (System)

Overview  

Here is a list of the "Out of the box" system Warnings. A Warning is a "dismiss-able" pop-up that Warns a

user before they perform a particular action.  Warnings are located at Utilities> Custom Reports> System

(System Drop-down)> Warnings (Type Drop-down).  

To activate follow these steps:

1. Double-click on the warning that you want to activate and make sure that the "Active" flag is selected.

2. Click on the Permissions Tab and select the User/Groups that you want to activate the Warning for.

3. Click on the Modules/Applet Tab and select the Applet and Type that you want the Warning to be

activated for.

4. Click "Save" and the Warning is activated. 

5. Finally, Log out and back into InFocus.  Go to the location and test the scenario to confirm that it is

configured correctly.

Warning Descriptions

Warn on deletion of employee reimbursable that has a payment - Warns user when deleting a Employee

Reimbursable entry with an existing payment against it. This Warning is designed to be assigned to the

Employee Reimbursables Applet with Type of "On Delete".

Warn on deletion of purchase that has a payment -  Warns user when deleting a Purchase entry with an

existing payment against it. This Warning is designed to be assigned to the Purchase Journal Applet with

Type of "On Delete".

Warn on deletion of sales that has a receipt - Warns user when deleting a Sales entry with an existing

payment against it. This Warning is designed to be assigned to the Sales Journal Applet with Type of "On

Delete".

Warn on modification of employee reimbursable that has a payment - Warns user when editing a

Employee Reimbursable entry with an existing payment against it. This Warning is designed to be

assigned to the Employee Reimbursables Applet with Type of "On Save".

Warn on modification of purchase that has a payment: Warns user when editing a Purchase entry with an

existing payment against it. This Warning is designed to be assigned to the Purchase Journal Applet with

Type of "On Save".
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Warn on modification of sales that has a receipt applied: Warns user when editing a Sales entry with an

existing payment against it. This Warning is designed to be assigned to the Sales Journal Applet with

Type of "On Save".

Warn on Prepayments: Warns user if payment is being entered for a period prior to the invoiced period.

Warn When Project has no Bill Rate Schedule: Warns user if a Bill Rate has not been assigned on the

project in use.

5.2 Project Management Reports

Overview 

Project Management Reports are project-based reports. PM Reports reside in InFocus at Utilities>PM Report

Designer.

Key Concepts

Here is a video that takes a deeper look into running InFocus reports: More on Running InFocus Reports.

 If you do not see what you want you can search the InFocus Marketplace or Submit a Custom Work

Request through the Request Custom Work button at the Clearview Support Website.

5.2.1 PM Reports

Overview 

The PM Reports allow you to look at Project Management information. These reports are run (consumed) at

Project Management>PM Reports.  By clicking on PM Reports, you will be redirected to the PM Reports

drop-down where you can select the report to run.

Key Concepts

PM Reports are classified as Project Management Management reports, therefore reside at Utilities>PM

Report Designer.

Access to these reports are granted through the Permissions Tab in the PM Report Designer, they are

granted on the Permissions Tab. More on the Permissions Tab

You are unable to modify the Original version of a report, however, you are able to copy a report and

https://support.clearviewsoftware.net/articles/5379
https://support.clearviewsoftware.net/marketplace
https://support.clearviewsoftware.net/client
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modify it.  More on Customizing a Project Management Report

There is a Help Center article that talks about these reports. To view that, follow this link: More on PM

Reports

Report Descriptions

Accounting Summary - Summarized project metrics by General Ledger account.

Accounting Transactions - Itemizes project transactions grouped by General Ledger account.

Expense Transactions - Shows detailed non-labor expense transactions.

Labor Transactions - Shows detailed timesheet transactions.

Market Analysis - Summarized project metrics by market sector. When sorted by market sectors, this

report will apply the market sector factor as established in the project setup to all metrics.

Project Backlog - This project calculates backlog (contract, less billed, less WIP).  Used only when using

revenue recognition to create General Ledger entries for WIP per project. For all other cases, use

Custom Report Contract Backlog.

Project Budget Analysis (Bill Amount) - Compares Project Budget Amounts to Project Actuals at the

billable rate (effort).

Project Budget Analysis (Cost Amount) - Compares Project Budget Amounts to Project Actuals at the

cost rate. For labor transactions, cost is either pay rate, or job cost rate depending on the configuration in

Global Settings.

Project Cost Detail (Single Period) - Cost transactions for a single period of time.

Project Cost Detail (Two Periods) - Cost transactions for two periods of time.

Project History - Five-section report that includes labor transactions for two periods of time, an ODC

section for two periods of time, consultant transactions for two periods of time, budget amounts, and

billing amounts (current and inception to date). Cost transactions are at pay rate.

Project History (Job Cost) - Same as Project History except cost transactions are shown at the job cost

rate.

Project Invoices - Invoices broken down by metric type.

Project Plan - Budgetary information summarized at the allocation level (Job Title for Labor; Expense

Code for Non-Labor) derived from Project Planning.

Project Profit - Summarized project metrics show project profitability. WIP on this report is calculated

using general ledger entries against a WIP account.

Project Profit (Non G/L) - Summarized project metrics show project profitability. WIP on this report is

calculated using transactions with a billing status of R or H.

Resource Schedule - This report shows scheduled work for a period of time. Its intent is to show

https://support.clearviewsoftware.net/articles/5413
https://support.clearviewsoftware.net/articles/5413
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upcoming work.

Schedule Analysis (Bill Rate) - This report compared scheduled Work-to-Date versus Payroll Labor Cost-

to-Date. Non-labor items use cost amount.

Schedule Analysis (Job Cost Rate) - This report compares scheduled Work-to-Date versus Job Cost

Labor-to-Date.

Schedule Analysis (Pay Rate) - This report compared scheduled Work-to-Date versus Job Cost Labor-to-

Date. Non-labor items use marked up amount.

Unbilled Charges - Project cost transactions with a billing status of R or H summarized at the payee level

(employee/vendor).

Unbilled Charges (Detail) - Project cost transactions with a billing status of R or H summarized to the

transaction date level.

5.3 Report Management Reports

Overview 

All reports not covered under one of the three specific report designers are called standard reports. Report

Management reside in InFocus at Utilities>Report Management.

Key Concepts

Here is a video that takes a deeper look into running InFocus reports: More on Running InFocus Reports.

 If you do not see what you want you can search the InFocus Marketplace or Submit a Custom Work

Request through the Request Custom Work button at the Clearview Support Website.

5.3.1 A/P Reports

5.3.1.1 AP Reports

Overview 

The A/P Reports allow you to look at Accounts Payable information. These reports are ran (consumed) at

Accounts Payable>Reports.  By clicking on A/P Reports, you will be redirected to the A/P Reports drop-down

where you can select the report to run.

Key Concepts

https://support.clearviewsoftware.net/articles/5379
https://support.clearviewsoftware.net/marketplace
https://support.clearviewsoftware.net/client
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A/P Reports are classified as Report Management reports, therefore reside at Utilities>Report

Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

There is a Help Center article that talks about these reports. To view that, follow this link: More on A/P

Reports

Report Descriptions

A/P Aged - The A/P Aged report shows all of the aged balances for any Vendor and A/P Account. Age is

shown by using user-defined aging periods that can be adjusted in Global Settings on the A/P Tab. 

A/P Balances - The A/P Balances report shows you all of the balances for any Vendor and A/P Account.

Similar to the A/P Aged, however, no age periods are shown and payments are shown.

A/P Register - This report is a cross between the A/P Balance and A/P Aged reports.

5.3.1.2 Disbursement Journal Report

Overview 

The Disbursement Journal Report allows you to run different reports against the Disbursement Journal using

the criteria below. This reports is ran (consumed) at Accounts Payable>Reports.  By clicking on

Disbursement Journal Reports, you will be redirected to the Disbursement Journal Reports drop-down where

you can select the report to run.

Key Concepts

The Disbursement Journal Report is classified as an Report Management report, therefore reside at 

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

https://support.clearviewsoftware.net/articles/5369
https://support.clearviewsoftware.net/articles/5369
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There is a Help Center article that talks about this report. To view that, follow this link: More on the

Disbursement Journal Report

Filter Criteria

Starting Period - Starting G/L accounting period

Ending Period - Ending G/L accounting period

All Bank Accounts - When checked, all bank accounts are included.

Single Bank Account - When entered, only specified bank account is included.

Accounts from this Org. - When entered, only the specified bank account associated with the specified

org. unit is included.

Include Org. Children - When checked, the org. children from the specified org. unit are included.

Print Projects - When checked, projects will print

Print Periods - When checked, the G/L accounting period will print for each transaction. When a

transaction spans more than one period, the transactions lines are grouped within the appropriate period.

Print G/L Comments - When checked, G/L comments will print.

Print PM Comments - When checked, project management comments will print.

Print Recap - When checked, a summary section showing totals by G/L account will print.

5.3.1.3 ER Reports

Overview 

The E/R Reports allow you to look at Employee Reimbursable information. These reports are ran (consumed)

at Accounts Payable>Reports.  By clicking on E/R Reports, you will be redirected to the E/R Reports drop-

down where you can select the report to run.

Key Concepts

E/R Reports are classified as Report Management reports, therefore reside at Utilities>Report

Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

https://support.clearviewsoftware.net/articles/5283
https://support.clearviewsoftware.net/articles/5283
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There is a Help Center article that talks about these reports. To view that, follow this link: More on E/R

Reports

Report Descriptions

E/R Aged - The E/R Aged report shows you all of the aged balances for any Employee and E/R Account.
Age is shown by using user defined aging periods that can be adjusted in Global Settings on the A/P
Tab. 

E/R Balances - The E/R Balances report shows you all of the balances for any Employee and E/R
Account. Similar to the E/R Aged, however, no age periods are shown and payments are shown.

E/R Register - This report is a cross between the E/R Balance and E/R Aged reports.

5.3.1.4 Employee Reimbursables Report

Overview 

The Employee Reimbursable Report (Emp. Reimb. Report) allows you to run different reports against the

Employee Reimbursable Journal (Emp. Reimb. Journal) using the criteria below. This reports is ran

(consumed) at Accounts Payable>Reports.  By clicking on Employee Reimbursable Journal Reports, you will

be redirected to the Employee Reimbursable Journal Reports drop-down where you can select the report to

run.

Key Concepts

The Employee Reimbursable Report is classified as an Report Management report, therefore reside at

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

There is a Help Center article that talks about this reports. To view that, follow this link: More on the

Employee Reimbursable Journal Report

Filter Criteria

Starting Period - Starting G/L accounting period

https://support.clearviewsoftware.net/articles/5373
https://support.clearviewsoftware.net/articles/5373
https://support.clearviewsoftware.net/articles/5299
https://support.clearviewsoftware.net/articles/5299
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Ending Period - Ending G/L accounting period

All E/R Accounts - When checked, all Employee Reimbursable accounts are included.

Single E/R Account - When entered, only specified E/R account is included.

Accounts from this Org. - When entered, only specified E/R account associated with the specified Org.

Unit is included.

Include Org. Children - When checked, the Org. Children from the specified Org. Unit are included.

Print Projects - When checked, projects will print.

Print Periods - When checked, the G/L accounting period will print for each transaction. When a

transaction spans more than one period, the transaction lines are grouped within the appropriate period.

Print G/L Comments - When checked, G/L comments will print.

Print PM Comments - When checked, project management comments will print.

Print Recap - When checked, a summary section showing totals by G/L account will print.

5.3.1.5 Purchase Journal Report

Overview 

The Purchase Journal Report allows you to run different reports against the Purchase Journal using the

criteria below. This reports is ran (consumed) at Accounts Payable>Reports.  By clicking on Purchase

Journal Reports, you will be redirected to the Purchase Journal Reports drop-down where you can select the

report to run. 

Key Concepts

The Purchase Journal Report is classified as an Report Management report, therefore reside at 

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

There is a Help Center article that talks about this report. To view that, follow this link: More on the

Purchase Journal Report

Filter Criteria

https://support.clearviewsoftware.net/articles/5318
https://support.clearviewsoftware.net/articles/5318
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Starting Period - Starting G/L accounting period

Ending Period - Ending G/L accounting period

All A/P Accounts - When checked, all accounts payable accounts are included.

Single A/P Account - When entered, only specified payable account is included.

Print Projects - When checked, projects will print.

Print Periods - When checked, the G/L accounting period will print for each transaction. When a

transaction spans more than one period, the transactions lines are grouped within the appropriate period.

Print G/L Comments - When checked, G/L comments will print.

Print PM Comments - When checked, project management comments will print.

Print Recap - When checked, a summary section showing totals by G/L account will print.

5.3.2 A/R Reports

5.3.2.1 A/R Reports

Overview 

The A/R Reports allow you to look at Accounts Receivable Information. 

Key Concepts

A/R Reports are classified as Report Management reports, therefore reside at Utilities>Report

Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

When running an A/R report across multiple A/R accounts, zero balance entries would appear if the Sales

Journal used a different A/R account than the receipt.

Report Descriptions

A/R Aged - The A/R Aged Report shows you all of the aged balances for any Client and A/R Account.
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Age is shown by using user-defined aging periods that can be adjusted in Global Settings on the A/R tab. 

A/R Aged By Project - Similar to the standard A/R aged but the report does not show or group by client.

A/R Balances - The A/R Balances Report shows you all the balances for any Client and A/R Account. It is

similar to the A/R Aged; however, no age periods are shown, but payments are shown.

A/R Balances By Project - Similar to the standard A/R Balances Report but the report does not show or

group by client.

A/R By Revenue Type - The A/R  by R evenue Type R eport shows all balances for any Client and A/R

Account. This report separates by Labor, OD C , OC C , IC C , R etainage, and O ther.

A/R By Revenue Type Project - This report is similar to the standard A/R by Revenue Type, but it does

not show or group by client.

A/R Register - This report is a cross between the A/R Balance and A/R Aged reports.

A/R Register by Project - This report is the same as the A/R Register report, but sorted by Project.

Statement of Accounts - Statement that shows the client a detailed summary of what they owe.

Statement of Accounts Labels - This report produces mailing labels for statements. 

5.3.2.2 Receipt Journal Report

Overview 

The Receipt Journal Report allows you to run different reports against the Receipt Journal using the following
criteria. This reports is ran (consumed) at Accounts Receivable>Reports.  By clicking on Receipt Journal
Reports, you will be redirected to the Receipt Journal Reports drop-down where you can select the report to
run.

Key Concepts

The Receipt Journal Report is classified as an Report Management report, therefore reside at 

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

Filter Criteria

Starting Period - Starting G/L accounting period.

Ending Period - Ending G/L accounting period.
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All Bank Accounts - When checked, all bank accounts are included.

Single Bank Account - When entered, only specified bank account is included.

Accounts from this Org. - When entered, only specified bank account associated with the specified Org.

Unit is included.

Include Org. Children - When checked, the Org. Children from the specified Org. Unit are included.

Print Projects - When checked, projects will print.

Print Periods - When checked, the G/L accounting period will print for each transaction. When a

transaction spans more than one period, the transactions lines are grouped within the appropriate period.

Print G/L Comments - When checked, G/L comments will print.

Print PM Comments - When checked, project management comments will print.

Print Recap - When checked, a summary section showing totals by G/L account will print.

Basis

Accrual - When selected, receipts are recorded in the report as they occur, regardless of whether or not

cash has actually changed hands.

Cash -  When selected, receipts are recorded in the report when actual cash is received. Expenses are

reported when they are actually paid.

5.3.2.3 Sales Journal Report

Overview 

The Sales Journal Report allows you to run different reports against the Sales Journal using the following
criteria. This reports is ran (consumed) at Accounts Receivable>Reports.  By clicking on Sales Journal
Reports, you will be redirected to the Sales Journal Reports drop-down where you can select the report to
run.

Key Concepts

The Sales Journal Report is classified as an Report Management report, therefore reside at 

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report
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Filter Criteria

Starting Period - Starting G/L accounting period

Ending Period - Ending G/L accounting period

All A/R Accounts - When checked, all Accounts R eceivable accounts are included.

Single A/R Account - When entered, only specified Accounts R eceivable accounts are included.

Accounts from this Org. - When entered, only specified accounts associated with the specified Org. Unit
is included.

Include Org. Children - When checked, the Org. Children from the specified Org. Unit are included.

Print Projects - When checked, projects will print.

Print Periods - When checked, the G/L accounting period will print for each transaction. When a
transaction spans more than one period, the transactions lines are grouped within the appropriate period.

Print G/L Comments - When checked, G/L comments will print.

Print PM Comments - When checked, project management comments will print.

Print Recap - When checked, a summary section showing totals by G/L account will print.

5.3.2.4 Linked Transactions

Overview 

Linked Transactions is a report of all the linked items in a Sales Journal entry. 

Key Concepts

This reports is run (consumed) at Accounts Receivable>Sales Journal>Tools (toolbar)>Linked

Transactions.  On the pop-up, you will see a Printer icon in the bottom left. This will run the report.  You

must first have a Sales Journal transaction pulled up.

The Linked Transactions Report is classified as an Report Management report, therefore reside at

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

5.3.2.5 Pre-Bill Report

Overview 
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This standard report will print the billing instructions entered by the project manager. 

Key Concepts

This reports is run (consumed) at Accounts Receivable>PA Bill Review>Prebill (toolbar).  

When the Reviewed button is checked in PA or PM Bill review, the report column labeled Reviewed By

will change to Marked Reviewed, signifying the PM has signed off on the changes. The intent of the report

is to save hard copies of the PM change requests. This report is accurate only if it is printed prior to the

changes being made.

The Pre-Bill Report is classified as an Report Management report, therefore reside at Utilities>Report

Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

5.3.3 Human Resources Reports

5.3.3.1 Cross Charge Reports

Overview 

The Cross Charge report allows you to run a report to view cross charging for a Home Org. Cross charging in

InFocus means that the organizations that charge to a project, that are not the owning organization and are

not an established sharing organization, will have the cost of the charges transferred to the owning

organization. Likewise, the owning organization receives all earned revenue for those charges.  

Key Concepts

The Cross Charge Report is classified as Report Management report, therefore reside at Utilities>Report

Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and
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modify it.  More on Customizing a Report Management Report

5.3.3.2 Time Transactions (Dollars)

Overview 

The Time Transactions (Dollars) Report allows a user to run a report, to see the pay amount for an employee
on different projects within a specified date range.

Key Concepts

The Time Transactions (Dollars) Report is classified as Report Management report, therefore reside at

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

5.3.3.3 Time Transactions (Hours)

Overview 

The Time Transactions (Hours) Report allows a user to run a report (using the criteria shown in Fig.1), to see
the work hours for an employee on different projects within a specified date range.

Key Concepts

The Time Transactions (Hours) Report is classified as Report Management report, therefore reside at

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

5.3.3.4 Utilization Reports (Dollars)

Overview 
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Time Utilization (Dollars) Report is used to analyze how profitable employees are. There are two categories

for utilization reports: Hours and Dollars. This is done to allow permissions to be set separately for the type of

information contained in the report. 

Key Concepts

There are two types of utilization report: Hours and Dollars. This is done to allow permissions to be set

separately for the type of information contained in the report.

Time Utilization (Dollars) Report is classified as Report Management report, therefore reside at

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

5.3.3.5 Utilization Reports (Hours)

Overview 

Time Utilization (Hours) Report is used to analyze how employees spend their time. There are two categories

for utilization reports: Hours and Dollars. This is done to allow permissions to be set separately for the type of

information contained in the report. 

Key Concepts

There are two types of utilization report: Hours and Dollars. This is done to allow permissions to be set

separately for the type of information contained in the report.

Time Utilization (Hours) Report is classified as Report Management report, therefore reside at

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions
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You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

5.3.4 General Accounting Reports

Enter topic text here.

5.3.4.1 Balance Sheets

Overview 

The Balance Sheet is the summary of a company’s financial condition at a specific point in time. A balance

sheet, or statement of financial position, is a summary of a person’s or organization’s balances. Assets,

liabilities, and ownership equity appear as of a specific date, such as the end of its financial year. A balance

sheet is often described as a snapshot of a company’s financial condition. Of the four basic financial

statements, the balance sheet is the only statement that applies to a single point in time.

Key Concepts

This is uses a pre-designed standard chart of accounts. InFocus summarizes all income and expense

accounts into a single line called Current Year Profit (Loss). 

This report is not designed via the Financial Statement Designer. More on the Financial Statement

Designer

The Balance Sheet Report is classified as Report Management report, therefore reside at Utilities>Report

Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

There is a Help Center article that discusses a scenario when there is a "Variance in totals between the

Balance Sheet and the Income Statement". To view that article, follow this link: More on Variance

Between Balance Sheet and Income Statement

5.3.4.2 General Journal Report

Overview 

https://support.clearviewsoftware.net/articles/4070
https://support.clearviewsoftware.net/articles/4070
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The General Journal Report allows you to run different reports against the General Journal using the following

criteria.

Key Concepts

The General Journal Report is classified as an Report Management report, therefore reside at 

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

Filter Criteria

Starting Period - Starting G/L accounting period.

Ending Period - Ending G/L accounting period.

Limit Accounts by this Org. - When entered, only the specified bank account associated with the specified

Org. Unit is included.

Include Org. Children - When checked, the Org. Children from the specified Org. Unit are included.

Print Projects - When checked, projects will print.

Print Periods - When checked, the G/L accounting period will print for each transaction. When a

transaction spans more than one period the transactions lines are grouped within the appropriate period.

Print G/L Comments - When checked, G/L comments will print.

Print PM Comments - When checked, project management comments will print.

Print Recap - When checked, a summary section showing totals by G/L account will print.

Accrual Basis - When checked, only transactions flagged accrual or both will be included.

Cash Basis - When checked, only transactions flagged cash or both will be included.  

5.3.4.3 General Ledger Reports

Overview 

The General Ledger report lists all the sub-ledger transactions for the selected criteria.
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Key Concepts

The General Ledger Report is classified as an Report Management report, therefore reside at 

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

5.3.4.4 Income Statements

Overview 

The Income Statement is also called a Profit and Loss Statement (P&L). The purpose of the Income

Statement is to show managers and investors whether the company made or lost money during the reported

period. Income Statements represent a period of time, whereas the Balance Sheet represents a single

moment in time.

Key Concepts

This report is not designed via the Financial Statement Designer. More on the Financial Statement

Designer

This report is not designed via the Financial Statement Designer. More on the Financial Statement

Designer

The Income Statement Report is classified as Report Management report, therefore reside at

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

There is a Help Center article that discusses a scenario when there is a "Variance in totals between the

Balance Sheet and the Income Statement". To view that article, follow this link: More on Variance

https://support.clearviewsoftware.net/articles/4070
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Between Balance Sheet and Income Statement

5.3.4.5 Trial Balance Reports

Overview 

In accounting, the Trial Balance is a worksheet listing the balances of each ledger account in two columns,

namely Debit and Credit, at a certain date. Under the double-entry system, the total of any debits in any

transaction must equal the total of any credits. Therefore, the total of the debit side in a Trial Balance should

always be equal to the total of the credit side. The Trial Balance thus serves as a tool to detect errors that

can result in the totals not being equal. Credits are often represented as a negative, in which case the total of

the Trial Balance should be zero.

Key Concepts

The Trial Balance Report is classified as an Report Management report, therefore reside at 

Utilities>Report Management.

This report is not designed via the Financial Statement Designer. More on the Financial Statement

Designer

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

5.3.5 Utilities Reports

5.3.5.1 Data Dictionary

Overview 

The Data Dictionary report displays descriptions of every table, and column, that comprises the InFocus

application. The names of the tables and columns in most cases should be self-evident. Running the report

requires no parameters.

https://support.clearviewsoftware.net/articles/4070
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Key Concepts

The Data Dictionary Report is classified as Report Management reports, therefore reside at

Utilities>Report Management.

Access to these reports are granted through Permission, they are granted on the User/Group Permissions

Tab. More on Permissions

You are unable to modify the Original version of a report, however, you are able to copy a report and

modify it.  More on Customizing a Report Management Report

5.3.6 Miscellaneous Report Management Reports

Overview 

The Miscellaneous Report Management Reports section contains a description of all Miscellaneous Report

Management reports not mentioned in the previous sections.

Report Descriptions

A/P Check

Description - The following can be selected as the Check Report on the Selections Tab in A/P Check

Writing. More on A/P Check Writing 

A/P Check - System A/P Check Stock. 

A/P Check Notes - System A/P Check Stock including the A/P Comments from the Purchase Journal. 

More on the Purchase Journal

A/P DLM-102 - System A/P Check Stock. The default check layouts in InFocus are designed to work with

check style DLM102 from a national stationery company called NEBS. You can purchase them online

direct from NEBS.   

A/P DLM-102 Notes - System A/P Check Stock including the A/P Comments from the Purchase Journal.

The default check layouts in InFocus are designed to work with check style DLM102 from a national

stationery company called NEBS. You can purchase them online direct from NEBS.  

https://www.nebs.com/nebsEcat/index.jsp
https://www.nebs.com/nebsEcat/index.jsp
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 A/P Check Labels

Description - The following can be selected as the Label Report on the Selections Tab in A/P Check Writing.

More on A/P Check Writing 

A/P Check Labels - Labels that can be printed on Address Labels to affix to an envelope for mailing.

A/P EFT

Description - The following can be selected as the EFT Report on the Selections Tab in A/P Check Writing.

More on A/P Check Writing 

A/P EFT - EFT Transaction report

A/P Long Stub

Description - When the check count exceeds the "Max. Number of Invs." on the Selections Tab, the Long

Stub can be printed on the Post Tab to accompany the check with detail. The following can be selected as

the Long Stub Report on the Selections Tab in A/P Check Writing. More on A/P Check Writing 

A/P Long Stub - Check Long Stub.

A/P Long Stub Notes - Check Long Stub containing the A/P Comments from the Purchase Journal.

Bank Reconciliation

Bank Reconciliation - The Bank Rec Report can be launched from the toolbar of Bank Reconciliation

applet.  It displays information on Selected Bank Account Reconciliation sessions. More on the Bank

Reconciliation Toolbar

Chart of Accounts List

Chart of Accounts List - The Chart of Accounts List Report can be launched from the toolbar of the Chart

of Accounts applet.  It gives you the option to print a list of Active, Inactive or Both types of Chart of
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Accounts. More on the Chart of Accounts Toolbar

Client List

Client List - The Client List Report can be launched from the toolbar of the Clients applet.  It gives you the

option to print a list of Active, Inactive or Both types of Clients. More on the Clients Toolbar

Credit Card Reconciliation

Credit Card Reconciliation - The Credit Card Reconciliation Report can be launched from the toolbar of

Credit Card Reconciliation applet.  It displays Credit Card Reconciliation information from selected filter

criteria. More on the Credit Card Reconciliation Toolbar

CCRec

E/R Check

Description - The following can be selected as the Check Report on the Selections Tab in E/R Check

Writing. More on E/R Check Writing 

E/R Check - System E/R Check Stock. 

E/R Check Notes - System E/R Check Stock including the E/R Comments from the Purchase Journal. 

More on the Employee Reimbursable Journal

E/R DLM-102 - System E/R Check Stock. The default check layouts in InFocus are designed to work with

check style DLM102 from a national stationery company called NEBS. You can purchase them online

direct from NEBS.   

E/R DLM-102 Notes - System E/R Check Stock including the E/R Comments from the Purchase Journal.

The default check layouts in InFocus are designed to work with check style DLM102 from a national

stationery company called NEBS. You can purchase them online direct from NEBS.  

E/R Check Labels

https://www.nebs.com/nebsEcat/index.jsp
https://www.nebs.com/nebsEcat/index.jsp
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Description - The following can be selected as the Label Report on the Selections Tab in E/R Check Writing.

More on E/R Check Writing 

E/R Check Labels - Labels that can be printed on Address Labels to affix to an envelope for mailing.

E/R EFT

Description - The following can be selected as the EFT Report on the Selections Tab in E/R Check

Writing. More on E/R Check Writing 

E/R EFT - EFT Transaction report

E/R Long Stub

Description - When the check count exceeds the "Max. Number of Invs." on the Selections Tab, the Long

Stub can be printed on the Post Tab to accompany the check with detail. The following can be selected as

the Long Stub Report on the Selections Tab in E/R Check Writing. More on E/R Check Writing 

E/R Long Stub - Check Long Stub.

E/R Long Stub Notes - Check Long Stub containing the E/R Comments from the Purchase Journal.

Employee List

Employee List - The Employee List Report can be launched from the toolbar of the Employees applet.  It

gives you the option to print a list of Active, Inactive or Both types of Employee. More on the Employees

Toolbar

Expense Sheet

Expense Sheet - The Expense Sheet Report can be launched from the toolbar of the Expense Sheet

applet.  It gives you a print out of the current Expense Sheet More on the Expense Sheet Toolbar
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Form 1099

Form 1099 - The Form 1099 Report can be launched from the toolbar of the Form 1099 applet.  It gives

you a print out of the current 1099 session. More on the Form 1099 Toolbar

Form 1099 Labels

Form 1099 Labels - The Form 1099 Labels Report can be launched from the toolbar of the Form 1099

applet.  It gives you Labels that can be printed on Address Labels to affix to an envelope for mailing. More

on the Form 1099 Toolbar

Invoice Labels

Invoice Labels - Labels that can be printed on Address Labels to affix to an envelope for mailing.  To show

up on the Labels report, the invoices must be Posted.

Labor Postings

Labor Distribution - If you call up a labor distribution transact in the General Journal it will be available

under the View menu option on the toolbar. More on The General Journal Toolbar

Linked Transactions

Linked Transactions - The Linked Transaction Report displays all transactions that are linked to the Sales

Journal.The Linked Transactions Report can be launched from the Linked Transactions pop-up that is run

from the toolbar of the Sales Journal applet. More on the Linked Transaction Menu Option

Manual Check
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Description - The following can be selected as the Check Report on the Disbursement Journal>Toolbar. More

on the Disbursement Journal

Manual Check - Manual Check Stock.

Manual DLM-102 - System Manual Check Stock. The default check layouts in InFocus are designed to

work with check style DLM102 from a national stationery company called NEBS. You can purchase them

online direct from NEBS.   

OH Script Results

OH Script Results - The OH Script Results Report can be launched from the toolbar of the OH Allocation

Scripts applet.  It gives you the results of the scripts run through Overhead Allocation. More on Overhead

Allocation Scripts.

 

Project List

Project List - The Project List Report can be launched from the toolbar of the Project applet.  It gives you

the option to print a list of Active, Inactive or Both types of Projects. More on the Projects Toolbar

Project Planning

Project Planning -  The Project Planning Report can be launched from the toolbar of the Project Planning

applet.  It gives you a print out of the current Project.  You can optionall adjust the Date Ranges and view

Baseline numbers on this report. More on the Project Planning Toolbar

Time Sheet

Time Sheet - The Time Sheet Report can be launched from the toolbar of the Time Sheet applet.  It gives

you a print out of the current Time Sheet. More on the Time Sheet Toolbar

https://www.nebs.com/nebsEcat/index.jsp
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Vendor List

Vendor List - The Vendor List Report can be launched from the toolbar of the Vendor applet.  It gives you

the option to print a list of Active, Inactive or Both types of Vendors. More on the Vendors Toolbar

Work Order Reports

Work Order Detail - The Work Order Detail Report can be launched from the toolbar of the Work Orders

or My Work Orders applets.  It gives you the option to print Your Personal Work Orders or Work Orders

for an individual. You can also filter by open and or closed Work Orders. More on the Work Orders

Toolbar (Project Management>Work Orders)   More on the Work Orders Toolbar (Personal>My Work

Orders)

Work Order List -  The Work Order Report can be launched from the toolbar of the Work Orders or My

Work Orders applets.  It gives you the option to print Your Personal Work Orders or Work Orders for an

individual. You can also filter by open and or closed Work Orders. More on the Work Orders Toolbar

(Project Management>Work Orders)   More on the Work Orders Toolbar (Personal>My Work Orders)

5.4 Financial Statements

Overview 

InFocus comes out of the box with a set of sample Financial Statements. These designs are based on the
Chart of Accounts established by QuickStart. Even if QuickStart was not run, the samples may be installed
by following the steps below.

Most Financial Statement requirements can be met using the sample statements, Financial Statements found
in the InFocus Marketplace, or statements written using the Financial Statement Designer. 

For further customizations, or for assistance with the designer, please contact Clearview Support.

Installing Sample Financial Statements

1. Browse to UT>SQL Query. More on the SQL Query applet
2. In the query box, enter: fssample_sav. 
3. Click Run Query from the toolbar. 

Once the query has completed, Query Execution Complete will appear in the upper right corner of the SQL
Query screen. The installed Financial Statements will be available to Financial Statement Designer.

https://support.clearviewsoftware.net/marketplace
http://suppprt.clearviewsoftware.net
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Report Descriptions

Classified Income & Expense - The Income Statement is also called a Profit and Loss Statement (P&L).
The purpose of the Classified Income & Expense Statement is to show managers and investors whether
the company made or lost money during the reported period in a summarized format.
Itemized Income & Expense - The Income Statement is also called a Profit and Loss Statement (P&L).
The purpose of the Classified Income & Expense Statement is to show managers and investors whether
the company made or lost money during the reported period in an itemized format.
Classified Balance Sheet - The Balance Sheet is the summary of a company’s financial condition at a
specific point in time. A balance sheet, or statement of financial position, is a summary of a person’s or
organization’s balances. Assets, liabilities, and ownership equity appear as of a specific date, such as the
end of its financial year. A balance sheet is often described as a snapshot of a company’s financial
condition.
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7 InFocus Advanced

7.1 Actions

Overview

Actions take the power of custom reports and unlocks it to do just about anything. You can use actions to

interact with third-party systems or automate complex workflows. There are also hooks throughout the

system that allow you to trigger an action when almost anything–clients, vendors, projects–is created or

updated.

Key Concepts

Note - Because Actions are so powerful it’s easier explained through examples. Here are a few of the endless

ways you could use Actions:

Interact with a third-party system. For example, trigger an export to a project information management

system whenever a project is created, or pull in information from a web-based time-tracking app.

Simplify multi-step processes. For example, InFocus 2 comes with a “Refund Retainer” action. Run it,

specify who and how much and you’re done. Use one of the many built-in Actions or create your own and

then put it on your Dashboard for quick access.

Add warning prompts for specific business rules. For example, “this time sheet isn’t over 40 hours,

are you sure you want to submit it with overtime?”

Actions are SQL-based, so there is an immense amount of flexibility and power. Take them and run with

them, or book someone on our team to write one for your firm.

For more on Custom Report Actions please refer to the Custom Reports section of this manual.

7.1.1 Actions - Overview

Overview

Actions are a platform for automating workflows and extending the functionality of InFocus.
Actions can be launched explicitly by the user or called by an in-applet event type or other process (e.g.
another Action, InFocus Job, etc.). When run, Actions can include wizard-driven user prompts for input or
simply run in the background.

Below are some examples of how you could utilize Actions.

Interact with a third-party system. For example, trigger an export to a project information management



InFocus Advanced 839

© 2020 Clearview Software, Inc.

system whenever a project is created, or pull in information from a web-based time-tracking app.
Simplify multi-step processes. For example, InFocus comes with a “Refund Retainer” action. Run it,
specify who and how much and you’re done. Use one of the many built-in Actions or create your own and
then put it on your Dashboard for quick access.
Add warning prompts for specific business rules. For example, “this time sheet isn’t over 40 hours,
are you sure you want to submit it with overtime?”

Setup

Actions are managed via Custom Report (UT>Custom Reports) where you can create, copy, edit and deploy
as appropriate.

TIP Clearview makes several custom Actions available to you though the InFocus Marketplace .

Permissions

To begin, you’ll need the following permissions to manage Actions. Permissions are configured through
AD>Permissions.

Module Applet View Edit Add Delete

Utilities Custom Reports x x x x

Managing Actions

As stated above, Actions are managed through the Custom Reports applet (UT>Custom Reports). Similar to
Reports, Actions can be of type System or Custom.

System - Actions created by Clearview and shipped with InFocus

Custom - Actions created/installed by your firm

Whether system or custom, all Actions are managed by determining who has permission to use them and
how the Action should be deployed.

Note! As mentioned earlier, Actions (or other processes) can call other Actions. In this case, the called
Action does not require permissions or deployment configuration.

Permission to Use

Access permissions govern which users have the right to run an Action and are granted from the Permissions
tab in Custom Reports (UT>Custom Reports>Permissions tab). Whether launched by the user or run in the
background, the logged in user must have permission to the Action in order for it to fire.

Permissions to an Action can be granted using the steps below:

1. Browse to UT>Custom Reports
2. Double-click the Action you wish to manage
3. Select the Permissions tab
4. Grant permissions to the appropriate users/groups
5. Click Save

https://support.clearviewsoftware.net/marketplace/actions
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Note! While User Permissions govern who can run the Action, Actions can contain scripting that executes at
a level outside access permissions and therefore may not necessarily inherit those access restraints (e.g. the
Action may perform commands your user could not otherwise perform). Deploy wisely

Deploying Actions

Actions can be placed throughout InFocus in any of the following locations:

Module - Listed in the main menu under a specified Module

Applet - Listed in-applet from the toolbar or called by an event type from the Applet
o Toolbar - Listed in-applet on the toolbar
o Event Type - Automated using an in-applet event (e.g. Action launches when a new Project is created)

To deploy an Action,

1. Browse to UT>Custom Reports
2. Double-click the Action you wish to manage
3. Select the Modules/Applets tab
4. Deploy the Action as appropriate

o Module (only) - Check to list in the main menu under the selected Module
o Applet - Check to list on the toolbar or to call the Action from the selected Applet using an event

type. More on Action Types.
5. Check Reload if the applet should reload after running the Action
6. Optionally re-title the Action for deployment
7. Click Save

Using Actions

Once Actions have been setup, users will simply work with them like any other applet or report in InFocus, in
that they will be accessible to launch from their deployed location and/or run when called by the defined event
type (etc.).

If the Action includes user prompts, they will display when launched in a wizard interface. If the Action
includes an output message, the user will see those messages once the Action has completed.

Next up: Actions- Developing Actions

7.1.2 Actions - Developing Actions

Overview

 Advanced 

For developers, Actions are a platform to build customized solutions for InFocus and support both SQL and
Powershell. Below are a few examples of the kinds of solutions you could build using Actions.

Interact with a third-party system. For example, trigger an export to a project information management
system whenever a project is created, or pull in information from a web-based time-tracking app.

http://manual.clearviewsoftware.net/cur/custom_reports_modules_applets_tab.htm
https://support.clearviewsoftware.net/articles/6023
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Simplify multi-step processes. For example, InFocus comes with a “Refund Retainer” action. Run it,
specify who and how much and you’re done. Use one of the many built-in Actions or create your own and
then put it on your Dashboard for quick access.
Add warning prompts for specific business rules. For example, “this time sheet isn’t over 40 hours,
are you sure you want to submit it with overtime?”

Heads up! Developing Actions requires knowledge of SQL and/or Powershell

Framework

Actions operate on a three-part framework that includes: Parameters, a Script and Return Types.

Parameters

Each Action collects a set of parameters which are then passed to the underlying Script. Parameters can be
fed in programmatically (e.g. from InFocus) or sourced from end-user prompts.

Programmatic Parameters

Automated Actions pass two primary parameters: AppletName and KeyID.

AppletName (nvarchar) - Name of the InFocus Applet initiating the Action

KeyID (int) - The ID of the record loaded in the respective Applet

For example, if running an action to suppress zero-hour timesheet rows when the timesheet it saved, InFocus
will programmatically pass the following

appletname='timesheetitems', keyid=[record id]

Prompts

Prompts can be used to collect parameter inputs from the end-user. Displayed in a modal window, prompts
are configured with the following properties:

Prompt Style (Settings tab) - Sets the style of prompt (e.g. Single, Tabbed or Wizard)

Prompt Type (Settings tab) - Sets how information should be organized within the prompt (e.g. Stacked,
Horizontal)
Sections/Steps (tab) - Defines the sections of the wizard and can optionally validate input

Manage Parameters (button) - Parameters are configured and assigned to each section/step as
applicable. Actions support an unlimited number of parameters.

Once a prompt has been completed by the end-user, the Action will pass the entered parameters to the
Script for processing.

Passing Parameters

Regardless of how parameters are collected, they are passed to the script at execution. As such, the script
will need to include syntax for receiving the parameters passed. For example,

DECLARE @appletname nvarchar(250), @keyid int
-- Get the Applet and Record ID
-- Parameter syntax = '^parameter^'
SELECT @appletname='^appletname^'
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SELECT @keyid='^keyid^'

Scripts

Scripts process the actual tasks of the Action. Supported query types include SQL and Powershell and are
entered in the Query window via Custom Reports (UT>Custom Reports). While not required, as a best
practice, Scripts should include a Return Type.

Return Types

When processed, Actions trigger system responses to a defined list of Return Types. An Action can return
zero or more return type result sets. If more than one return type is returned, the system will respond to each
item in the order returned.

Below is a listing of each Return Type, the response it triggers and allowable fields (data types, and field
descriptions) to call.
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Return
Type

Description Fields Data Types Field
Description

Additional
Information

Message Displays a
message box
on the screen

reterr numeric Greater than
0=Success,
Less than
0=Error

retmsg nvarchar The message to
display on
screen

Applet Opens an
InFocus Applet

appletname nvarchar The name of the
applet to open

Chart of
Accounts,
Clients,
Disbursement
Journal,
Employee
Reimbursables,
Employees,
General
Journal,
Projects,
Project
Planning,
Purchase
Journal,
Receipt
Journal, Sales
Journal, Time
Sheet, Vendors,
Expense
Sheets,
Timesheet
Adjustments

keyid int The ID of the
record to load in
the respective
applet

DocID Downloads a
document from
Document
Manager

docid int The ID of the
document record
to download

Please note,
this return type
bypasses
defined
permissions set
on the
document(s).

Web Call Makes a call to
the web

BrowserWidth int If opening a
browser, this
sets the width

BrowserHeight int If opening a
browser, this
sets the width

Content nvarchar The override
data to post to
the weburl

ContentType nvarchar The content type
header (default
is application/x-
www-form-
urlencoded)

Debug bit When true, the
response will be
added to the
InFocus SQL
Watcher

FilePath nvarchar For uploading
files. If set, this
will automatically
set the method
to post and the
contenttype to
multipart/form-
data

Format nvarchar Format to utilize
in the web call

Allowed formats
are: FORM,
JSON, or XML
(default is
FORM)

IncludeParams bit When true, the
parameters from
the Action will be
posted in the
format specified

IsDocManagem
ent

bit When true, and
a file is being
uploaded, it will
also post the
necessary fields
for the listening
Document
Management
service

Method nvarchar Method to utilize
in the web call

For example:
GET, POST,
PUT,HEAD, etc.
The default is
GET

OpenURL nvarchar Opens a browser
to the specified
URL

ParamQuerystri
ng

bit If true, the
included
parameters will
be appended to
the URL as a
query string

Password nvarchar The password
for basic
authentication

ResponseProce
dure

nvarchar If specified, the
web response is
passed to the
procedure
specified in a
variable called
@response
nvarchar(max)

ShowResponse bit If true, the
response will be
shown in a
browser window

URL nvarchar The URL to be
called

UseBasicAuth bit If true, the basic
authentication
header will be
added.

Username and
Password must
be present

Username nvarchar The username
for basic
authentication

Delay int number in
milliseconds to
wait after
processing
(good for
pausing if
making a lot of
calls to the same
URL)

Action CVSReportID int Launches the
system "action" /
"report"

CUSReportID int Launches the
custom "action" /
"report"

ShowDialog bit If true, and
DefaultParams
are passed in, it
will still show the
dialog.

ToFile bit If true, the output
will be saved to
file

Filename nvarchar The full path to
the file to save

ToDocMgt bit if true, the file
will be saved to
document mgt

DocAppId int The Document
Applet Type ID
(from table
DocAppletTypes
)

doc_KeyId int The relative doc
type

doc_<AppletNa
me>

int Additional
columns in the
format
doc_appletName
(from the table
DocAppletTypes
without the
space) where
the value is the
key.  For
example,
doc_salesjournal
with value 1
would associate
the document to
the Sales
Journal SJID 1

ToEmail bit if true, the same
fields for email
can be supplied.
Filename can be
comma
separated 

param_name string param_
precedes the
name of the
parameter to
pass into the
action being run.
 for example
param_projectpa
th would pass
the value in that
column into the
^projectpath^
parameter in the
action being run.

CVSDocTypeId int the primary
system
document type
(folder)

CUSDocTypeId int the primary
custom
document type
(folder)

Email

RecipEmail string the comma
separated list of
"To's"

CC, BCC,
Subject, Body

string normal email
fields

FromAddress,
FromName

string the from info

SmtpServer string Optional
(defaults to
Global
Settings>Docum
ent
Management>E
mail Relay
Settings)

SmtpUser string Optional
(defaults to
Global
Settings>Docum
ent
Management>E
mail Relay
Settings)

SmtpPass string Optional
(defaults to
Global
Settings>Docum
ent
Management>E
mail Relay
Settings)

SmtpPort int Optional
(defaults to
Global
Settings>Docum
ent
Management>E
mail Relay
Settings)

UseSSL bit Optional
(defaults to
Global
Settings>Docum
ent
Management>E
mail Relay
Settings)

DocId int If supplied,
emails the
document

Filename string comma
separated list of
file path's to
attach

Power shell Runs
powershell
script. Note!
Powershell
must be
installed on
both developer
and end-user
machines for
Powershell
Actions to run.

$infocus object The powershell
parameter that
gets passed in
from InFocus

.RetErr int Return Number,
negative is an
error

.RetMsg string Return Message

.Db SqlConnection SqlConnection
(unopened)
pointing to
InFocus
Database

.Tx SqlTransaction SqlTransaction if
in a transaction
pipeline

.Error Exception Internal
Exception

.Username string
(readonly)

The current
InFocus
Username

.UserId int (readonly) The current
InFocus User Id

.EmpId int (readonly) The current
InFocus
Employee Id

.EmpCode string
(readonly)

The current
InFocus
Employee Code

.EmpName string
(readonly)

The Current
InFocus
Employee Name

.KeyId int The primary key
of the current
record (if
applicable)

.AppletName string The name of the
executing applet
(if applicable)

.Dataset Dataset Optional dataset
property that will
allow reports to
be run
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Additional Considerations

Using SQL RAISEERROR

When processing Actions, it’s worth noting that while Return Types define the output of an Action, they don’t
necessarily reflect the output of the event that fired the action.

So, if an On Save action errors out, the On Save event that fired it still occurs. For example: If you created
an action to email Time Approvers after a submitted timesheet is saved (On Save) and the action errors out,
the Timesheet is still saved. If you want to make your event contingent on the success of the Action, the
Action must include an explicit SQL RAISEERROR (severity 11) which would then rollback the event.

Next up: Actions - Hello World Tutorial

7.2 API Management

Read more about API Management here.

7.3 Data Views

Overview

Every SQL table in the InFocus database is also represented by a SQL view. A SQL view is a stored query

that appears in other applications as a table. This can simplify user queries since many of the standard

joining between tables as already been completed.

Key Concepts

InFocus provides two classes of SQL views for end users to use for queries—standard views and

extended views. 

o Standard view names are the same as the table name, but with a prefix of SV. Standard views contain

all the columns of their table counterpart, as well as all code and title fields from related tables. For

instance, querying timesheet items (holds timesheet line items), columns such as projected, jtid, etc.

would appear. These are key fields relating to the projects and job titles tables. In standard view, code

and title fields from the related table would be joined. The standard view also contains projectcode,

projectname, projectpath, projectlongname, jtcode, and jtname.

o Extended Views have a name beginning with EV_. Extended views are useful views created by

InFocus.

EV_ProjectTransactions - Gathers project related transactions. Field compliment is same as

aggregate and non-aggregate in project management report designer.

https://support.clearviewsoftware.net/articles/6024


InFocus Advanced 845

© 2020 Clearview Software, Inc.

EV_Marketing - Marketing contact information

EV_Wip - Work-in-progress data.

7.4 InFocus Variables

Overview

InFocus gives the user the ability to leverage common variables when building queries, reports, etc.

Leverage a list of System Variables or create custom Global Variables.

You can view a full list of available InFocus Variables when using query applets by clicking, for instance, 
View Variables link from Custom Reports or View Variables List from the toolbar of Dashboard Queries
Manager.

Variables are referenced in queries using the following syntax: @variable@. For example: select periodcode,
startdate, enddate from glperiods where periodcode='@CURRENTPERIODCODE@'

Next: System Variables

7.4.1 System Variables

Below is a list of System Scripting Variables

Accounting

@CURRENTPERIODCODE@ - Current Period Code, e.g. 2016–11

@CURRENTPERIODEND@ - Current Period End Date, e.g. 2016/11/30

@CURRENTPERIODMONTH@ - Current Period Month, e.g. 4

@CURRENTPERIODSTART@ - Current Period Start Date, e.g. 2016/11/01

@CURRENTPERIODYEAR@ - Current Period Year, e.g. 2016

@INVOICEPERIODCODE@ - Invoicing Period Code, e.g. 2014–11

@INVOICEPERIODEND@ - Invoicing Period End Date, e.g. 2016/11/30

@INVOICEPERIODMONTH@ - Invoicing Period Month, e.g. 4

@INVOICEPERIODSTART@ - Invoicing Period Start Date, e.g. 2016/11/01

@INVOICEPERIODYEAR@ - Invoicing Period Year, e.g. 2016

Company

@COMPANYNAME@ - Company Name, e.g. Casco and Wilson, Inc.

Date/Time

@AMPM@ - AM or PM, e.g. PM

@DAY@ - Current Day of the Month, e.g. 3

@DAY2@ - Current Day of the Month (Padded), e.g. 03

@HOUR@ - Current Hour, e.g. 2

@HOUR2@ - Current Hour (Two Digits), e.g. 02

@LASTMONTHEND@ - End of the Month, e.g. 2016/10/31

@LASTMONTHSTART@ - Start of the Month, e.g. 2016/10/01
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@MINUTE@ - Current Minute, e.g. 25

@MINUTE2@ - Current Minute (Two Digits), e.g. 25

@MONTH@ - Current Month Number, e.g.11

@MONTH2@ - Current Month Number (Padded), e.g. 11

@MONTHEND@ - End of the Month, e.g. 2016/11/30

@MONTHSTART@ - Start of the Month, e.g. 2016/11/1

@NOW@ - Current Date and Time on the Server, e.g. Nov 3 2016  2:25PM

@SECOND@ - Current Second, e.g. 43

@SECOND2@ - Current Second (Two Digits), e.g. 43

@TIME@ - Current Time, e.g. 2:25 PM

@YEAR@ - Current Year, e.g. 2016

@YEAR2@ - Current Year (Two Digits), e.g. 16

@YEAREND@ - End of the Year, e.g. 2016/12/31

@YEARSTART@ - First of the Year, e.g. 2016/1/1

User

@MYCODE@ - Logged in user's Employee Code, e.g. LJC01

@MYEMPID@ - Logged in user's Employee ID, e.g. 1

@MYID@ - Logged in user's Employee ID, e.g. 1

@MYUSERID@ - Logged in user's User ID, e.g. 1

@MYUSERNAME@ - Logged in user's Username, e.g. demo

Next: Global Variables

7.4.2 Global Variables

Overview

In addition to system scripting variables, InFocus supports custom variables for use in advanced query
applets like SQL Query, Custom Reports and Dashboard Queries Manager.

Created in Global Settings, these variables are assigned a value is inserted into the query at execution.

Global Variables are referenced in queries using the following syntax: @variable@.

Tutorial

In the following example, we’ll variablize a specific project’s internal ProjectID by creating the variable and
utilizing it in the SQL Query applet.

Creating the Variable

1. Browse to AD>Global Settings
2. Select the Global Variables tab
3. Enter the Variable Name: project. The Variable calculated column will automatically build the variable
@project@, which is the syntax for using the variable later.
4. Enter a Value of 5
5. Click Save
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Using the Variable in SQL Query

1. Browse to UT>SQL Query
2. Enter the following: select projectid, projectpath from projects where projectid=@project@
3. Check Replace Variables Before Execution to enable the use of the variable
4. Click Run Query from the toolbar

7.5 Labor Distribution

Overview   

The purpose of Labor Distribution is to post labor expense to the General Journal to mirror payroll. This is
done for firms that need to see a detailed breakdown of their labor expense accounts on their General Ledger
and Income Statement.

To learn more about Labor Distribution and understanding if it is right for your company, Click Here

Key Concepts

When labor distribution is run, the Owning Org. (Profit Center) will receive the labor cost transferred to it.

If Labor Distribution is run at a rate other than pay rate, the difference between that rate and pay rate will

be debited against the Owning Org. of the project and credited against the Home Org. of the employee for

employees outside of the Owning Org Unit.

Labor Distribution posts labor expense figures to the General Ledger based on time sheet entries. The

process scans time sheets that have been approved, but not yet processed by this utility. In general,

labor is divided between direct and indirect labor cost accounts. 

Some initial configuration of Labor Distribution is required in Global Settings>Labor Distribution Tab

When run, this utility makes a single entry for the pay period in the General Journal and marks it as a

Labor Distribution entry. It then flags all time sheet entries that were a part of the run with the General

Journal transaction ID. Deleting the General Journal transaction will erase the link to time sheets, allowing

them to be reprocessed in a future run.

By running Labor Distribution, you are associating the included time transactions with a G/L Period.  If

you are attempting to run Project Management Reports by G/L Period, you must be running this utility.

Every time Labor Distribution is run, any time sheet items that exist prior to the start date (of the pay

period) are processed and booked to the General Journal as a separate journal entry. This means that

Labor Distribution could generate two entries. Salary variance is not calculated for prior pay period

entries.

Note: The purpose of Prior Pay Period Booking is to capture any G/L changes between direct and indirect

account that occur when timesheets are moved between projects after the pay period has been processed.

https://support.clearviewsoftware.net/articles/5613
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These adjustments usually balance to zero (no change in hours or dollars) but if they do not, the variances

will be placed in the payroll and subcontractor clearing accounts accordingly.

Setup Basics

Description - Below is a list of the areas within InFocus that need to be configured in order for the Labor
Distribution utility to function correctly.  It is highly recommended that you schedule a consulting
session with a consulting expert before you begin to use Labor Distribution.

1. The Labor Distribution Tab within Global Settings must be 100% configured, with all necessary accounts

first created in the chart of accounts.

2. Salary amounts must exist in the employee record in the Pay History tab with an amount that represents

the time frame that is to be used for labor distribution e.g. a semi-monthly amount if the utility is to be run

for a semi-monthly period.

3. Employees must be assigned to a specific Pay Group (Employees>Employee Information Tab) when

running the Labor Distribution Utility. Payroll Groups are managed through Administration>List

Management>Payroll Groups

4. If the user wants to charge specific indirect accounts such as Vacation, PTO, etc., these must be first

configured within Projects>Expense & G/L Tab.

5. The Labor Distribution utility (applet) is used to run this process and is located in the Human Resources

module.

7.5.1 Using Compensation Time

Overview   

Optionally, Labor Distribution can record compensation time to a compensatory project.

Key Concepts

The compensatory project is specified in Global Settings>Labor Distribution Tab . 

Compensatory time pertains only to exempt employees. When this option is used, the utility will make

timesheet entries for exempt employees to bring their hours to a standard day. For instance, if a standard

day is eight hours, and an employee works six hours, then an entry for two hours is made against the

compensatory project. If the employee works ten hours one day, a negative two hours is made against

the compensatory project. 

A project management report can be designed to view the totals on this project. 
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Negative balances mean the employee is in the hole.

The variance between Standard Day and Worked Hours is used only on work week days. Weekend

hours are booked as negative hours against the compensatory project.

Note - When using Compensatory Time Recording, the salary variance account should ideally go to zero.

Return to Labor Distribution Setup

7.5.2 Clearing and Variance Accounts

Overview   

The offset of the direct and indirect postings are divided amount clearing and variance accounts

Key Concepts

There are two clearing accounts: Payroll and Sub-contractor. (Fig.1)

o Payroll is the offset for employee time. The payroll clearing account represent the gross payroll

burden. 

o Sub-contractor is the offset for sub-contractor time. Subcontractors are offset to their own clearing

account since they are not part of payroll.

These accounts are called clearing account because they are assumed to be zeroed-out by another entry

(i.e. moving money out of the bank and against the clearing account and various payroll deduction

accounts.

The Salary Variance (seen in Fig.1) account deals with the variance between a salaried persons average

pay rate and what that person actually gets paid. There are two methods for determining variance.  These

methods are located in the employee pay history table: 

o The Standard Day Method - The standard day method allows for change of pay type (hourly or

salaried)  or salary amount within a pay period. The standard day is based on the average pay rate so

the clearing account may not zero out due to rounding. The standard day method can also be used to

split time between G/L periods when a payroll transcends two periods. This of course only makes

sense in weekly and biweekly payroll and requires running the utility twice.

o The Salary Amounts Method - The salary amount method uses the salary amount and pay type at the

start of the pay period only.
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Note 1 - When running a semi-monthly or monthly posting, use the Salary Amount Method. When running

weekly or biweekly, use either the Salary Amount Method or Standard Day Method.

  

Note 2 - The standard day method works as follows. The difference between non-premium time and the

standard day is applied to the variance at the average pay rate for week days. The formula is (standard

hours-hours worked) x pay rate. For weekends all non-premium time reduces the variance by using the

formula (0-hours worked) x pay rate. All days with no time entries use the formula standard hours X pay rate.

An employee must have at least one time sheet line item within the work date range to be processed. 

Return to Labor Distribution Setup

7.5.3 Use G/L Account derivation

Overview   

This section describes how Labor Distribution derives a G/L Account.

Key Concepts

There are two steps to obtaining G/L Accounts in Labor Distribution: 1) obtaining the Base Code, and

then 2) obtaining the Organizational Unit.

o For Base Codes
Direct Projects - The base code defaults to the supplied base codes when running the utility, but
can be overridden by setting base accounts at the job title. Direct labor is further split between
exempt and non-exempt employees and subcontractors.
Indirect Projects---the base code defaults to the supplied base codes when running the utility, but
can be overridden by settings at the job title. In turn, accounts can be set up at the project level to
override the previous two locations. This allows for separation of indirect cost to various types,
such as admin, vacation, or R&D. Like direct labor, indirect labor can be further split between
exempt and non-exempt employees and subcontractors.

o For Org. Units
The organization unit is the charge organization from the time sheets. 
This is usually the same as the employee home organization, but can be another organization in
the case of cross-charging. The one exception is the markup credit account. This uses the home

organization of the time sheets.  

Next: Back to the Global Settings>Labor Distribution Tab
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7.6 Messages Manager

Read more about Messages Manager here.

7.7 Multi-Company Tab

Overview 

Multi-Company (Inter Company Transfers aka. ICT) is used for advanced multi-company support. 

Note - Additional setup and training is required to use this feature as well as an associated cost.  If you are

interested in using ICT, please contact support. 

Key Concepts

Multi-Company is Enabled in Global Settings>Multi-Company Tab.  

Multi-company transfers can be achieved through Automated Invoicing.  

When using Multi-Company, top level org units are considered companies. 

A link in the Help About screen allows you to change the active company name.  When you change the

company name you will see the new name you entered in the screen title bar and all reports will now use

that name.  This setting is relative to the logged in user and does not persist after you log out of InFocus.

 This means two different users can simultaneously be operating under different company names.

A "Use Org Unit for Non-control accounts" has been added to all custom journal by date reports.  This

allows proper filtering in a multi-company scenario.

Automatic Inter-company Transfers have been added to the Purchase, Disbursement, Employee

Reimbursable and Receipt Journals, as well as A/P and E/R Check Writing, Labor Distribution, and the

Import Expense Sheets utility.

The automatic ICT’s (inter-company transfers) are balance sheet line items using the appropriate due-to

and due-from accounts as specified in Global Settings on the Multi-Company Tab.

In Global Settings, four check boxes have been added to the Multi-Company tab to enable automatic

ICT in the four aforementioned journals.

In each journal, an option to Enable ICT has been added to allow user enable/disable automatic ICT.

In the four processes (the two check writers, import expense sheets and labor distribution) a Post ICT

check box has been added.

In all cases the “Use Multi-Company” option must be enabled in Global Settings.
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When the “Enable ICT” is active in a journal, the automated lined entries made by the system are not

editable.  

The use of G/L accounts with no assigned organization is not supported in automatic ICT.  This means all

of your G/L accounts involved in a transaction must have an associated org unit.

When more than two companies exist, each company must have separate due-to and due-from accounts

established in the Global Settings inter-company account settings (matrix).  This means that one account

appears more than once in the matrix.

Additional setup and training is required to use this feature as well as an associated cost.  If you are

interested in using ICT, please contact support. 

7.8 Multi-Currency

Overview

InFocus 2.0 and greater is currency aware and supports a multiple currency environment whereby a
company can operate across multiple currencies. InFocus Multi-Currency (IMC) is configured in four primary
modules: Administration, General Accounting, Human Resources and Project Administration. The
sections that follow contain an in depth discussion of IMC configuration and utilization. Please note, for
current clients wishing to convert to IMC please contact Clearview Support as there are initial procedures
that must be followed for accurate setup.

7.8.1 Getting Started

Terms

The following terms are used throughout the manual and are foundational to understanding InFocus Multi-
Currency.

http://support.clearviewsoftware.net
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InFocus Multi-Currency (IMC) – Refers to the multi-currency feature available in InFocus. This feature

allows a system to operate across multiple currencies. Throughout the manual this is referred to as IMC.

Currency Code – International three character monetary code. For example, USD for U.S. Dollars.

Base Currency – All systems will have one base currency which is considered the base system operating
currency. Systems not operating in IMC will default to a base currency of USD (U.S. Dollars). Exchange rates
for cost and effort is based on system tables and is the rate of exchange from the transactional currency
(defined below). The base currency is the currency used for purposes of consolidation. Accounting
transaction debits and credits must equal for this currency. Exchange rates for cost and effort is based on
system tables and is the rate of exchange from the transactional currency (defined below).

Company Currency – This is utilized when multiple companies or legal entities reside within a single
database and those companies operate under differing currencies. This is designated at the first level of
organizational units and defines the operating currency of that org. Accounting transaction debits and credits
must equal for this currency. Exchange rates for cost and effort is based on system tables and is the rate of
exchange from the transactional currency (defined below).

Transactional Currency – This is the real world currency of a given transaction. It is from this currency that
monies are translated based on system configured rates of exchange. Transactional currency is derived from
the sub-ledger account used on the transaction. For instance, if entering a Purchase Journal, using an AP
account assigned a currency of USD, the transactional currency (or currency environment) for the transaction
would be USD. As such, transactional currency is set at the sub-ledger account level. Accounting transaction
debits and credits must equal for this currency. The existing monetary fields (prior to version 2.0) represent
the transactional currency.

Project Currency – The currency used in project administration and project planning and is defined on the
project. Project management reports can also optionally print using this currency. Accounting transaction
debits and credits do not need to equal for this currency. Exchange rates for cost and effort can be
overridden at the project level. Please note that project budget amounts are always entered in the Project
Currency.

Invoicing Currency – The real world (or transactional) currency for the sales journal and is defined on the
project. While multiple currencies can be represented on a single invoice, the Invoicing Currency is the real
world currency for a given client invoice transaction. Time and expense journals will hold an invoicing
currency at the transactional level. This value can be either the transactional currency (defined by the time
sheet employee or sub-ledger respectively) or the project invoice currency. An exchange rate of exactly 1.0
dictates that the invoice currency designation on the transaction is set to the project invoicing currency.

Evaluation Date – The date used in the evaluation of exchange rates for a given transaction. This is
represented in each InFocus journal by a date field titled "MC Effective Date".

Precision – Defines columns to the right of the decimal place for a given currency.

Units – This is the smallest unit in a given hard currency. For example, one (for one cent) would be the
setting for USD. Units are assigned singular and plural labels for major and minor units. For example, "dollar"
and "dollars" (or "cent" and "cents") would be the singular and plural labels respectively for the major and
minor units in USD.

Triangulation – For purposes of currency conversion, triangulation is the means by which a currency can be
converted to another currency in the absence of globally defined exchange rate. A triangulating currency acts
as an interim currency between the two, otherwise relationally undefined, currencies.
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Reciprocal – This method, often referred to as the inverse method, is used to define the inverse rate of
exchange between two currencies.

Key Concepts

Supported Currencies 

InFocus aligns with Microsoft's supported currencies. A full list can be found here.

Currency Pairs 

Currency Pairs establishes the exchange relationship between two given currencies. This relationship is
defined by an exchange rate as of a given start date and is configured in General Accounting>Multi-
Currency. Additionally, the currency pair can act as an inverse partner (optional). For example, if a USD to
Euro pair was setup with an inverse relationship, a pair defining Euro to USD would not be needed (and in
fact would be not allowed). Inverse pairs use the reciprocal of the stated multiplier when converting in the
reverse direction. A pair can also cite a triangulation currency. A triangulation is used when no direct
exchange rate between currencies exist. For instance, if an exchange rate from Yen to Euro did not exist but
exchanges between Yen and USD and USD to Euro did exist then a Yen to Euro pair could be entered that
triangulated via USD.

Exchange Rates

Exchange rates are the vehicle by which monies in one currency are converted to another. InFocus supports
Currency based and project-specific Project and/or Invoice exchange rate configuration where the Currency
rate acts as a general system rate and the Project and/or Invoice rate acts as a project-specific rate override.
Currency exchange rates, configured in General Accounting>Multi-Currency, can be set manually or
imported from a system defined third party source. Both triangulation and inverse methods are supported.
Project and/or Invoice exchange rates, configured in Project Administration>Projects, only affect the
designated project and invoicing currencies. Configured exchange rates can be refreshed as needed.

Exchange Dates and Multipliers 

Defined currency pairs include an effective start date for each exchange rate. This start date is utilized by the
system to establish the proper exchange multiplier (rate) based on the evaluation date recorded on the
transaction. InFocus compares the evaluation date to the currency pair that represents the transactional
currency of a given transaction and returns the multiplier of the most recently precedent start date. In the
event no exchange rate is found the system uses a multiplier of one (1.0) and colors the transaction 
currency-related columns red. 

Evaluation Date Methods

In IMC, each journal includes a date field titled "MC Effective Date" which represents the evaluation date
used to derive the transaction exchange rate, as described above. InFocus supports four methods for
determining the default evaluation date:

1. Current Accounting Period start date
2. Current Accounting Period end date
3. Transaction Date
4. Today's date (system date) 

http://msdn.microsoft.com/en-us/library/ee825488(v=cs.20).aspx
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The default method is set per journal in Administration>Global Settings>Currency Tab.

Multi-Company

In a Multi-Company environment, all companies within a single database must consolidate to one currency-
the Base Currency (defined above). Though each company may operate from a different company currency,
only one currency can be defined when running a consolidated financial statement encompassing both
companies. Accounting debits must equal credits for each company currency represented.

MC Revaluations

A new journal has been added to host multi-currency revaluations. Transactions in this journal are marked as
realized or unrealized gains and losses. Any revaluation transaction has only two G/L accounts: the sub-
ledger account that is being revalued; and the offsetting gains and losses account. Transactional lines
include the gain or loss, and can optionally identify the project. A positive value represents a gain while a
negative value a loss. This journal does not utilize a debits verses credits approach as a recorded positive
value will act as a debit against the sub-ledger (Balance Sheet) account while simultaneously acting as a
credit to the gains and losses (P&L) account. While this journal is used by automated system utilities with
pre-posting reports to generate realized and unrealized gains and losses, manual entry in this journal is also
supported.

Reporting and Automation

Accounting Reports

The following reports have been up-sized to support printing in Base, Company and Transactional
currencies. 

General Ledger (optionally include realized and/or gains and losses)

Trial Balance

Financial Statements

Journal Reports

Project Management Reports 

Reports designed in the PM Report Designer support Base, Project, and Invoicing currencies. The user can
now filter PM reports by designated currency. For example, a report could be filtered to show results only for
projects where the Project currency is set to U.S. Dollars (see below). Please note, the underlying report
compiler has been modified to support multi-currency. This new compiler can be utilized by checking "Use 2.0
+ Data Format" in Utilities>PM Report Designer under Show Advanced Options.
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Custom Reports

The following report has been added to the InFocus system Custom Reports list to support FASB reporting
requirements for consolidated balance sheets converting multiple currencies.

MC Consolidated Balance Sheet (FASB)

Automated Accounting Processes

The following processes have been updated to support InFocus Multi-Currency.

Labor Distribution

A/P Check Writing

A/R Check Writing

Import of Expense Sheets

Convert To Cash

Automated Invoicing  
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7.8.2 Administration

Global Settings

The root setup of IMC is completed in Administration>Global Settings>Currency Tab. Therein Base
System Currency and Multi-Currency functionality is defined.

Base System Currency

This defines the base currency InFocus operates from. All systems will have one base currency. This is the

currency that all companies within a single database will consolidate to. Although this setting defaults to the

U.S. Dollar (USD), it can be customized to reflect any given company's base operating currency.

Culture - Configures the base culture the business is operating in and drives system report formats.

Symbol - Represents the system wide currency symbol.

Code - International three character monetary code. This important setting drives the import of system
exchange rates.
Name - Required Field containing the selected culture's currency name.

Precision - Defines columns to the right of the decimal place and drives system rounding. Example:
Precision 2 rounds to the nearest hundredth (5.248 = 5.25).
Unit - Represents the smallest unit in the selected currency. Example: For U.S. Dollars, 1 represents the
Penny (the system will round to the nearest penny).
Major Denomination - Defines the singular and plural cases for check printing. For example, USD major
labels are "dollar" and "dollars".
Minor Denomination - Defines the singular and plural cases for check printing. For example, USD minor
labels are "cent" and "cents".

Multi-Currency

This section is only defined when the system should operate across multiple currencies. The configurations
herein define the dates that drive configured exchange rates for sub ledger journals.

Use Multi-Currency - Sets the system to operate across multiple currencies.

Default Evaluation Date Settings

o Transaction Date - Journal based MC Effective date
o Period End Date - End date of the G/L Period of the transaction
o Period Start Date - Start date of the G/L Period of the transaction
o Today's Date - The system date of the transaction

7.8.3 General Accounting

Multi-Currency

If operating across multiple currencies, each currency must be configured in General Accounting>Multi-
Currency. This configuration is completed on the Currencies and Currency Pairs tabs.

Currencies

The grid below holds the following general information for each currency defined. Double click the line to
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launch the Currency utility as described below.

Active - Indicates that the currency is active

Base - Indicates the system base currency

Currency Symbol - Assigns the associated currency symbol

Currency Code - Currency code used to drive the currency exchange rate

Currency Name - Indicates the associated currency name

Currency Utility

This utility is used to define or edit detailed system settings for new or existing currencies respectively.

Base Currency - Checked if designated as the Base System Currency in Administration>Global
Settings>Currency Tab.

Active - Indicates system status of the selected currency

Culture - Configures the base culture the business is operating in and drives system report formats.

Symbol - Represents the system wide currency symbol.

Code - International three character monetary code. This important setting drives the import of system
exchange rates.
Name - Required Field containing the selected culture's currency name.

Precision - Defines columns to the right of the decimal place and drives system rounding. Example:
Precision 2 rounds to the nearest hundredth (5.248 = 5.25).
Unit - Represents the smallest unit in the selected currency. Example: For USD, 1 represents the Penny
(the system will round to the nearest penny).
Major Denomination - Defines the singular and plural cases for check printing. For example, USD major
labels are "dollar" and "dollars".
Minor Denomination - Defines the singular and plural cases for check printing. For example, USD minor
labels are "cent" and "cents".

Currency Pairs

This tab defines the exchange relationship between currencies and contains the Currency Rates set up tool.
Exchange rates can be altered on a daily basis. Both triangulation and inverse (reciprocal) exchanges are
supported.

From - The originating currency in the exchange.

To - The destination currency in the exchange.

Triangulating Currency - The interim currency in the exchange if required. A triangulation is used when no
direct exchange rate exists between currencies. For instance, if an exchange from Yens to Euros did not
exist but Yen to USD and USD to Euro exchanges did exist, the currency pair for Yens to Euros could be
defined, triangulated via USD. Please note to utilize a triangulating currency, there must be accompanying
currency pairs to define the exchange relationship between the From and Triangulating currency and the
Triangulating and To currencies.
Use Reciprocal - Indicates the defined exchanges relationship can be utilized inversely.

Rates - Launches the Currency Rates set up tool (defined below).

Currency Rates Utility

This utility defines the rate to use for the selected currency pair- notice the selected pair is displayed at the
top of the utility. Current and Historical rates can be set manually or imported directly from
openexchangerates.org and can then be tested for a given Amount/As of Date. An exchange rate must be
defined for each exchange relationship in the Currency Pairs grid.
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Amount - Originating currency amount to test. Test functionality only.

As of Date - Date by which to test the rate exchange. Test functionality only.

Start Date - Effective date of defined exchange rate

Rate - Exchange rate to be applied to the exchange relationship

Current Rate - When selected, imported rates will be based on currently designated rates

Historic Rate - When selected, imported rates will be based on the selected Historic Rate Date.

Organizational Units

Company currency can be defined on a level one organizational unit in General Accounting>Organizational
Units. This configuration is only necessary when operating in a multi-company environment where an
individual company currency differs from the Base System Currency.

Chart of Accounts

In IMC, each sub-ledger type account must be assigned an operating currency in General
Accounting>Chart of Accounts> Account Associations Tab. The designated currency defines
transactional currency where the account is used.

MC Revaluations

A new journal has been added to host multi-currency revaluations. Transactions in this journal are marked as
realized or unrealized gains and losses. Any revaluation transaction has only two G/L accounts: the sub-
ledger account that is being revalued; and the offsetting gains and losses account. Transactional lines
include the gain or loss, and can optionally identify the project. A positive value represents a gain while a
negative value a loss. This journal does not utilize a debits verses credits approach as a recorded positive
value will act as a debit against the sub-ledger (Balance Sheet) account while simultaneously acting as a
credit to the gains and losses (P&L) account. While this journal is used by automated system utilities with
pre-posting reports to generate realized and unrealized gains and losses, manual entry in this journal is also
supported.

Manual - Marked if entering the transaction manually

Balance Sheet Account - Sub-ledger account being revalued

Profit / Loss Account - Offsetting Gains and Losses account

GL Period - G/L posting period for the revaluation

Evaluation Date - Date used in evaluating the exchange rate

Realized - Indicates a realized or unrealized (unchecked) gain and loss.

GL Comments (header) - General notes for the revaluation.

Base Amount - Amount in Base System Currency

Company Amount - Amount in Company Currency

Project - Specifies the project (optional)

GL Comments (detail) - General notes for the line item
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Recalculate Exchange Rates

This utility is an extremely powerful, but important tool that allows the user to recalculate exchange rates
historically. Typically this is used to recast rates of exchange for previously undefined exchange rates.

Projects - Defines the projects to include in the range of recalculation

Journals - Defines the journals to include in the range of recalculation

Time Sheet Dates - Defines the optional date range to utilize for Time Sheet recalculation.

Statuses to Include - Defines the bill statuses to include in the range of recalculation

Currency Options - Defines the currency amounts to include in the recalculation

G/L Period - Defines the G/L Period to recalculate. Please note only single periods are supported.

7.8.4 Project Administration

Projects

In IMC, projects must be assigned designations for both Project and Invoicing Currency and can optionally
include Project specific currency and exchange rate overrides. This configuration is completed at Project
Administration>Projects>Multi-Currency Tab. These settings impact how the project and invoicing amount
currencies are determined on a given transaction. For instance, when a Purchase Journal (USD) is entered
against a project and a Currency override exists on the project for the specified Purchase Journal evaluation
date and transactional currency, the defined rate override(s) will be used for the project and/or invoice
currency amounts respectively. If this match is not found, these amounts will be determined using the
currency exchange relationship defined between the transactional currency (Purchase Journal) and main
project currency.
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Settings

This section holds the Project and Invoicing currency designations. Note the designated currencies must be
configured in General Accounting>Multi Currency.

Project Currency - The currency used in project administration and project planning for the selected
project. Project Management reports can optionally print using this currency for the selected project. 
Invoice Currency - The transactional, real world currency used in invoicing (Sales Journal) for the selected
project- used for project contracts and invoicing.
Project Equals Invoice Currency - Indicates that the Project currency will always equal the Invoice
currency and disables the ability to set Project currency and exchange rate overrides.
Separate Exchange Rates - Allows currency and exchange rate overrides for both Labor and Non-Labor

Currencies

This section defines the project specific currency and exchange rate overrides for the previously designated
Project and Invoicing currencies. The available overrides are derived from the defined exchange relationships
(General Accounting>Multi-Currency) and only affect project and invoicing currencies for the selected project.

Use - Indicates the ability to utilize the specified currency

% Button - Sets the exchange rate override. 

Rate Tester

This utility provides an evaluation of the rate exchange between the specified originating currency and the
destination Invoice and Project currencies accounting for configured overrides.

Currency - Originating currency to test.

Amount - Originating currency amount to test.

As of Date - Date by which to test the rate exchange.

Invoice Labor - Converted destination Invoice currency amount for Labor.

Invoice Non-Labor - Converted destination Invoice currency amount for Non-Labor.

Project Labor - Converted destination Project currency amount for Labor.

Project Non-Labor - Converted destination Project currency amount for Non-Labor.

Expense Codes

If utilizing IMC, a currency must be designated on each Expense Code in Project Administration>Expense
Codes. This assignment governs the currency environment the code can be utilized in. Though the currency
defaults to the Base System Currency, an expense code can be assigned any system-defined currency.
Please note, each expense code's currency can also be overridden when adding the expense code to an
Expense Group in Project Administration>Expense Groups. For instance, if there is an expense code
TRAV for travel, an expense group could hold multiple TRAV expense codes with different currencies.

Currency - Represents the transactional currency in which the expense code is utilized. For example, if
entering a Purchase Journal using an AP Account (USD) only Expense Codes of similar currency would
be available to the transaction.
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Rate Schedules

If utilizing IMC, a currency must be designated for each Rate in a Rate Schedule. This assignment governs
the transactional currency the rate can be utilized in. Though the currency defaults to the Base System
Currency, a Rate can be assigned any system-defined currency. This set up is completed from the Rate
Editor in Project Administration>Rate Schedules.

Rate Editor

Currency - Represents the transactional currency in which the rate is utilized. For example, if entering a
Time Sheet (U.S. Dollars) only Rates of similar currency would be used in bill, cost or pay rate evaluation.

7.8.5 Human Resources

Employees

All employees must be assigned a currency (or currencies) in Human Resources>Employees>Pay History
Tab. This configuration defines the transactional currency for employee time sheets.

Pay History

Each pay history period must have a designated currency. This designation drives the transactional currency

of the employee's time sheets within the defined date range of the pay history period. Employees may

optionally be assigned multiple pay histories to support additional currencies, however, time frames cannot

overlap.

Currency - Designated currency utilized by the selected employee pay history. This designation
determines the transactional currency of the employee's time sheets and (therefore) the evaluation of
available Rate Schedule rates for time entered.

7.9 Organizational Units

Overview 

InFocus uses a Parent/Child system to represent the levels of hierarchy within an organization. They are

referred to as Organizational Units (aka Profit Centers).  Org Units are classified by Org Labels and can

represent entities such as: Office, Department, Division, etc. 

Key Concepts

The Organization Units applet is where Org. Units (Profit Centers) are managed and ran. More on the

Organizational Units applet

Org. Units are used to define the management hierarchy of a company. Examples can be offices,

disciplines, business markets, multiple companies.
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InFocus supports unlimited levels of org units.

In a Multi-Company scenario, the top level must act as a company. More on Multi-Company

Employees are assigned to the lowest level.

Project ownership and sharing can be assigned at any level, but that level must be established database-

wide.

Revenue and Expense can be marked to follow the owner of the project, the employees assigned cost

center, or a mixture of the two

Org. units are integrated with the Chart of Accounts for Cost/Profit Center reporting.

Org units are exposed in project management reporting to group project metrics (e.g. cost and revenue)

by organizational unit within a project.

Additional Information

Employees, G/L base accounts, and projects can be attached to org. units. Employees are assigned only

to the lowest level of the org. structure to ensure proper Revenue Recognition calculations. More on

Revenue Recognition

Projects can be shared among org. units at the specified level established in Global Settings>Project

Admin Tab>Profit Centers. They can be owned at any level equal to or above the share level. In the case

of project charging, allowable org. units include not only the established owner or sharing org. unit, but all

of its children as well.

Example - If a project was assigned to office NY (New York), an employee assigned to NY-AR (office NY-

Department Architecture) could charge to it.

Organization Units are established in a tree structure, and each level of the tree is assigned a name.

Each element on the tree (called a Node) is given a code. The code must be unique with respect to its

parent. Since top nodes do not have a node parent, they must be unique with respect to all other top level

nodes. The codes are separated by a single character (a delimiter) as specified in Global Settings.

Note: While not required, it is best to use the same code for the same thing. For instance, if the structure is

office/department, it is best to give similar departments the same code across offices. By doing this they can

be rolled together in project management reporting and financial statements.
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Example - LA-AR and NY-AR would represent architectural departments in New York and Los Angeles. (Fig.

1)

In general, organization units allow for both profit center reporting and the segmentation of accounting.

  

7.10 Overhead Allocation

Overview 

The Overhead Allocation applet manages how overhead is viewed. This is an Advanced feature offered by

InFocus. It is recommended that you contact support to schedule a consultation before you implement this

feature.

Key Concepts

The Overhead Allocation applet is where the Allocation scripts are managed and ran. More on the

Overhead Allocation applet

There are two ways to view overhead on project management reports. 

o Use the Job Cost Rate to include any overhead burden. This allows the user to view figures down to

the transaction level (i.e., employee and work date). If the Job Cost Rate is used for other purposes,

or if the Rate Calculations do not field the desired effect, use the Overhead Allocation Journal for this

purpose.

o Overhead Allocation can be made only to the bottom nodes of the WBS and to an accounting period.

It cannot be applied to an employee or work date. Using this method allows the user to use the

specific overhead variables in Project Management Report Design. These are not used in the default

shipped reports.

The overhead journal allows for two types of transactions: DPE (direct personnel expense) and OH

(overhead). 

Overhead (or DPE) for a given period is calculated by multiplying the pay rate by an overhead factor and

then adding that to all billable projects worked on in the period. This can be done automatically by using

the Automate Allocation option in the toolbar. Selecting this option will produce a warning that it will delete

all overhead transactions for the given period.
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7.11 Profit Sharing

Overview  
Profit Sharing or Profit Center Sharing is accomplished by assigning Organizational Units (aka Profit Centers)
to share in a project’s revenue and expense. The level of the organization that can be assigned as Sharing
Profit Centers is established in Global Settings>Project Admin Tab>Profit Centers Section . When
Organizational Units are assigned to a WBS, all employees of that organization (or their Children Org Units)
can charge time to that portion of the WBS. More on Organizational Units (aka Org Units)

Profit Center Sharing Levels are established for the four PM types (Labor, OD C , OC C , and IC C). These
levels not only dictate the part of the WBS to which org members can charge, but also represent where
organizations can establish intra-profit center caps and rules for Revenue Recognition.

More specific cross-sharing can be established in Profit Center (Org. Unit) reporting where the department to
receive cross-charges can be varied between nodes at the sharing level. 

Revenue Recognition rules and upset amounts can be established for the owning Profit Center and Sharing
Profit Centers. The level where these rules and caps exist must be established for both the owner and the
Sharing Profit Centers. It is then calculated for the Owning Profit Center that receives any under-runs or
absorbs any over-runs. The owner level cannot exist below the sharing level. More on Revenue Recognition

Key Concepts

The Profit Sharing applet is where the Profit Sharing is managed. More on the Profit Sharing applet

This utility credits the effort amount (labor at a billing rate and expense at the marked up value) based on

the charging profit center. It then debits the owning profit center of the project for the reverse amount. 

o Time and material projects this will yield a profit-sharing based on each center’s effort amount. 

o Fixed Fee and Not-To-Exceed type projects all over-run and under-run will be attributed to the owning

profit center. 

The second function of revenue recognition is profit sharing within projects. Multiple profit centers can

earn revenue on a single project by establishing sharing profit centers on a project. This is done by

opening a project and right-clicking on the project name. More on Project Setup

o The sharing profit centers live at a specified level of the WBS on any given project. 

o This can be varied on a project-by-project basis.  

o Each node at the sharing level can have profit centers assigned for sharing. One of the sharing

centers can be designated as the prime sharer.

o  In addition to sharing profit centers, one profit center can be designated as the project owner. This is

set at the Bill Terms Node (Project). There are three types of profit centers: owners, primary sharers,
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and other sharers. More on Profit Centers (aka Org Units)

All profit centers established at each node can have revenue methods set for the four PM types. In Global

Settings>Project Admin Tab>Profit Centers, the level in the organization structure (OBS) project at which

sharers live. The owners must then reside at the same level or above. For instance consider the following

OBS.

Org Level 1 - Office                   Org Level 2

New York (NY)                          Architecture (AR)
                                                Engineering (EN)

Los Angeles (LA)                       Architecture (AR)
                                                Engineering (EN)                       

In this scenario, if sharers were designated to live at the 2nd level, shares could be one of four org units: NY-
AR, NY-EN, LA-AR and LA-EN. Owners could not only be one of those four, but, in addition, the two offices
NY and LA.

When revenue is calculated, it is done in three steps. First, the regular sharers are calculated, then the
primary shares, and, finally, the owners. This allows primary sharers and owners can bear the brunt of
overruns, or, in the case of owners, gain the benefit of under-runs. For instance, sharers can be set to earned
revenue at billable values with no cap while the owner is set with a cap. If the overall project cap is exceeded
only the owner would get penalized in this manner.

When the sharer's revenue is calculated, only transactions charged to that profit center are considered. Note
that the primary will also be calculated.

The primary sharer for a project node is used only when an overall cap for the node has been established.
Revenue calculated for the entire node and its children (after sharing has been calculated) is compared with
the overall node cap. If the revenue exceeds the overall node cap then the primary will absorb the over-run.

After revenue has been calculated for sharer’s, primary and other, revenue is again recalculated for the entire
project using all transactions. Any variance between what has been calculated by the sharers and what is
now calculated by the owner is applied to the owner.

7.12 Revenue Recognition

Overview 

Revenue Recognition is used to recognize Unbilled Revenue and WIP on the General Ledger. This utility
serves two purposes: 1) it posts Earned Revenue and 2) it performs Profit Sharing within projects.

Key Concepts

There is Post Earned Revenue Utility that is used to do this. More on the Posting Earned Revenue Utility

Revenue recognition is to used to meet the GAAP principle of recognizing revenue in the same
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accounting period that the expense was incurred.  

When the utility is run, labor and expense transactions are calculated based on user-set rules to obtain

an earned revenue value on a project-by-project basis. The system then calculates the previous earned

revenue. The difference is posted to unbilled revenue and offset to WIP. When automated invoicing is

used, whatever gets posted to billed revenue is relieved from WIP and offset against unbilled revenue.

Rules can be established for each PM type (labor, ODC, OCC, and ICC). Rules can analyze expense

transactions at cost or marked up (billable value), and analyze labor at any of the three rates (pay, job

cost, or bill). Values can then be compared to maximums of upsets to prevent over-valuing. The rules can

also earn revenue based on user-entered percent completion.

All billing statuses (except for Never Bill) are included. Never Bill is determined in Global

Settings>Revenue Recognition Tab.

When upsets occur, the overage is posted against an upset G/L account set on the Global

Settings>Revenue Recognition Tab. This allows for a separation from the standard unbilled revenue

account. You can make this the same as the standard. In other words, you could use one unbilled labor

revenue account for both the labor revenue and the upset labor revenue. This technique is also useful

regarding expenses.

Expense revenue will post by expense code if available. 

In the case of a cap, you can post the overage to a separate account without randomly penalizing any

expense code.
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9 InFocus Web

9.1 Overview

InFocus Web is a browser based web application used for running InFocus. With cross-platform browser
support, you can access InFocus Web on any device - PC, Mac or mobile device.

9.2 Getting Started with InFocus Web

9.2.1 Relationship to InFocus

InFocus Web is an accompaniment to InFocus Desktop (the InFocus application that installs and runs on
your local PC). From a technical perspective, both applications run on the same database. Records entered
or altered in InFocus Web reflect in InFocus Desktop and vise versa.

They are two applications that work in tandem.

For purposes of the documentation that follows, we'll generally refer to InFocus Web by the full product
name, "InFocus Web" and InFocus Desktop as simply, InFocus.

9.2.2 Permissions for InFocus Web

User access and Permissions to InFocus Web are governed by standard user permissions configured in
InFocus.

InFocus Users are created for each employee in your organization. Once created, users are then granted
access to the various applets and reports found throughout InFocus. Permissions granted to a a user in
InFocus are extended to that user in InFocus Web.

For instance, if you have permissions to PR>Timesheets in InFocus, you'll have access to Time Sheets in

https://support.clearviewsoftware.net/articles/6171
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InFocus Web. Similarly, if you have permission to a suite of analytic dashboards via UT>Dashboard Groups,
you'll see those analytic dashboards in InFocus Web.

9.2.3 Responsive Design

InFocus Web is a responsive application which means it will respond to size of the screen you are viewing it
in. Whether presenting analytics on a large screen or entering time on your mobile device, it's wired to give
you the best viewing experience possible.

To accomplish this, InFocus Web uses intuitive designs geared for the following views.

Mobile View - Default view for accessing from a mobile device

Full App View - Default view for accessing from a larger device such as PC, Mac, etc. Note, Full View
responds further to the size of your viewing space and will scale accordingly. If a smaller viewing space is
detected (e.g. resizing your browser) you'll be prompted to refresh in Mobile View. The first time you login
in Full View, take a moment to resize your browser (up and down) to get the feel for this.

9.2.4 Session Activity & Security

InFocus Web is responsive to session activity. This means that if your session becomes idle, InFocus Web
will automatically log you out.

9.2.5 Projects Near Me

Overview

InFocus Web (2020.1) features an all new search that, in addition to traditional search options, allows a user
to quickly get a list of projects within 10 miles of their location, easing the burden of time and expense entry.
Note Projects Near Me assumes you have assigned a geocoded project address in PR>Projects. If you have
not geocoded addresses historically, we can do this for you! Enable Address Geocoding via Clearview
Support>Billing, Licensing & Settings (InFocus Cloud only) or use the Geocode All Addresses action
available in InFocus Marketplace.

Instructions

To search with Projects Near Me, complete the following

1 Click the Add Project link or button (+) from Time Sheets or Expenses in InFocus Web
2 When prompted, Allow your browser to use your location as appropriate.
3 Click Near Me
4 InFocus Web will search projects within a 10 mile radius of your location

9.2.6 Reports and Actions

Overview

In addition to running key Reports, you can use Flows (built with Actions) to run easy to use, wizard style
workflows. By using Actions, you can include forking and looping logic in the way it gathers data from your
employees.

When logged into InFocus Web, your available Reports and Actions will be displayed in the right hand pane
of Time Sheets and Expenses in full app view or from the bottom menu bar in mobile view.

Note access to reports and actions is defined in InFocus via UT>Custom Reports.

https://support.clearviewsoftware.net/articles/5427
https://support.clearviewsoftware.net/marketplace/search?query=geocode
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How to Deploy a Report or Action to InFocus Web
 
Reports and Actions are managed through UT>Custom Reports where you’ll grant permissions and deploy
them to the application. 

To deploy a Report or Action to InFocus Web, grant permissions as appropriate using the Permissions tab
and then deploy to InFocus Web using the Modules / Applets tab to check the Time Sheets or Expense
Sheets applets as appropriate. Available Reports and Actions can be grouped under a single drop down in
InFocus Web using a similar Title (Optional). In the absence of a title, items will be grouped under Reports or
Actions respectively.

1. Browse to UT>Custom Reports
2. Select the Report or Action to deploy
3. Select the Permissions tab and assign permissions as appropriate
4. Select the Module / Applets tab

a. Check Time Sheets and/or Expense Sheets as appropriate
b. Set the Type = Toolbar
c. Optionally provide a Title to display

5. Click Save

How to run a Report or Action in InFocus Web
 
Once deployed, a Report or Action can be run via InFocus Web as follows.

1. Log into InFocus Web
2. Browse to Time Sheets or Expenses 
3. Click the dropdown(s) (full app view) or lightning icon (mobile view)
4. Select the Report or Action to run

9.3 Logging into InFocus Web

InFocus Web is accessed using your standard InFocus Launch URL.

When browsing to the launch url mobile devices will be seamlessly routed to the InFocus Web login page
and, if accessing from a local PC or Mac, you'll be given an additional link for logging into InFocus Web.

When prompted, enter the same username and password used for logging into InFocus. Note,
usernames and passwords are governed in InFocus via AD>Permissions.

Username - InFocus username

Password - InFocus password

9.4 InFocus Web Home

Overview

The first thing you see when logging in is your home page where you'll find key information like how many
hours you've entered and the current status of your time sheet. 

From there you can drill-through to enter time or browse other applets from the Main Menu (upper left).

Note When logging into InFocus Web, you'll be presented with a view that is responsive to the size of your
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screen. 

Navigating InFocus Web

Navigate InFocus Web using the navigation bar at the top of the screen. 

From the upper left, the main menu (hamburger icon) is used to browse your available applets, and arrows to
navigate from an applet back to the home screen.

From the upper right, you can access your profile information, a direct link to Clearview Support link and Log
out.

Field Descriptions

Main Menu

The Main Menu lists the following applets, based on your InFocus permissions.

Dashboards - Click to view your Analytic Dashboards. Permissions to Dashboards are governed by 
Dashboard Groups.
Time Sheets - Click to browse to the Time Sheets applet

Expense - Click to browse to the Expense applet

Approver - Click to browse to the Approver applet

InFocus Desktop - Launches InFocus Desktop. Note, this only launches when using a supported
browser.
InFocus Mobile - Launches InFocus Mobile.

Profile Menu

User Name - Displays the name of the logged in user

Clearview Support - Click to access Clearview Support

Log Out - Logs the current user out of InFocus Web

9.5 Dashboards

Overview

Analytic Dashboards use rich data visualizations allowing you to perform business analysis and gain powerful
insights into your data.

InFocus Web gives you real-time access to your analytics wherever your work takes you.

How to view an Analytic Dashboard

The Dashboards applet is accessed through the main menu (hamburger icon) in the upper left hand corner of
the screen. Once loaded you'll select a specific analytic dashboard to view from the applet submenu (vertical
ellipsis).

Note Your available dashboards are governed by your administrator in InFocus via UT>Dashboard Groups.

https://support.clearviewsoftware.net/articles/4077
https://support.clearviewsoftware.net/articles/4077
https://support.clearviewsoftware.net/articles/5409
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1. Browse to Dashboards
2. Select an Analytic Dashboard from the submenu (vertical ellipsis)

Your dashboard will load into view.

Interacting with your Dashboard

When viewing Analytic Dashboards - whether from a mobile device or local PC or Mac - you'll benefit from the
following options.

Expand - Expand any item (Chart, Grid, etc.) for a more isolated view. Simply tap the item on your mobile
device or, hover over the item when viewing from your local PC/Mac and you'll be presented with the
option to expand. 
Export - Analytic Dashboards can be exported in whole or in part by clicking/tapping the export icon (up
arrow out of box icon). When available, the export icon is displayed in the upper right hand corner of the
dashboard, expanded dashboard item or when hovering over a dashboard item. Supported exports
include .PDF, Image and Excel.
Filter - Filters and ranges can be applied to various items on an Analytic Dashboard. For dashboards 
viewed on a mobile device, tap the filter icon (funnel) in the upper right hand corner to get a full status of
all filters in use. From the filter view, tap the listed filters to adjust/apply as appropriate.
Orientation (mobile view only) - InFocus Web will rotate the dashboard to accommodate the orientation of
your device
Gestures (mobile view only) - Use common gestures (e.g. double tab, unpinch, etc.) for viewing your
Analytic Dashboards

Field Descriptions

Dashboard Header

Note Items listed here are presented in both mobile and full app view unless indicated.

SubMenu (vertical eclipses) - Used to select dashboards to load

Expand (expand icon) - Used to enter full screen mode. Only available from the header when working in
full app view.
Dashboard Title - Title of the loaded dashboard

Export (export icon) - Used to export the full dashboard

Additional Options

Filter (funnel icon) - Used to filter results

Clear Filter (funnel with red x icon) - Used to clear filters for a specified item

Date Range (two flags icon) - Used to adjust a date range filter

9.6 Time Sheets

Overview

Time entry is a core process in InFocus. Entered by each employee and/or consultant, timesheets have a
direct impact on billing, project reporting and utilization. The Time Sheets applet gives you the tools you need
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to record time quickly and accurately.

Time Sheets in InFocus Web, gives you on-the-go access to submit hours timely and with ease.

Note Time Sheets available in InFocus Web are created by your administrator.

How to Enter/Submit Time

Time is entered by selecting a time sheet from the time sheet menu (described below) and using the project
cards to enter hours and related comments.

Time Sheet rows are visualized as cards which provide you with basic project information and a clear space
for entering time. Projects can be added, copied, edited or deleted from the list of available cards. Optionally,
cards can be collapsed or expanded to optimize your viewing space.

1. Select a time sheet period
2. Add Projects to your time sheet
3. Enter hours and related comments for each day in the time sheet period as appropriate
4. Click Save
5. Once all time is entered and accurate, click Submit

Your time sheet has been submitted.

Field Descriptions

Time Sheet Header

Note Items listed here are presented as icons when viewing from a mobile device. Mobile view icons are
listed below in parenthesis. Certain options will be accessed from the menu to the right of the time cards
when working in full app view.

Time Sheet Menu (hamburger icon) - Selects a time sheet to load for time entry. For full app view, this is
accessed from the drop down arrow at the top of the header.
Time Sheet Summary - Contains summary information for the loaded time sheet.

Show Overtime (red split icon) - Click to enable Overtime entry as appropriate.

Collapse (arrows icon) - Collapses the project cards

Add Project (plus icon) - Adds a project to the time sheet. Projects are added by searching existing Work
Orders or Projects. Projects can be searched by name or by project code. Options also exist to search
Recent, Scheduled or Projects Near Me.
Group/Sort By (up and down arrows icon) - Gives the ability to adjust the grouping and sorting of the
project cards on the time sheet. 
o Group by Client, Labor Code or Project
o Sort by Project Path, Job Title, Labor Code or Location

Search/Filter (magnifying glass) - Filters the time sheet cards as specified.

Time Card Options

Check Box (upper left) - Selects the specified card for performing row actions such as Copy or Delete.

Time Entry Boxes - Used for entering hours

Comments - Used for entering comments for the associated hours. Optionally, comments can be applied
to all weekdays in the week.
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Card Menu (upper right of card)
o Collapse - Collapses the individual card
o Edit - Edits the Card information (e.g. Work Order, Project, Job Title, Labor Core, Location).
o Copy - Copies the card
o Delete - Deletes the card

Time Sheet Footer

Note Items listed here are presented as icons when viewing from a mobile device. Certain options will be
accessed from the menu to the right of the time cards when working in full app view.

Refresh - Refreshes the applet

Reports & Actions (lightening icon) - Used to access a list of your available reports and actions. Note,
available reports and actions are governed by permissions in InFocus Desktop.
Save/Submit - Click to save and/or submit your time sheet. Note, these buttons are presented separately
when viewing the full app.

Additional Options for Full App View

When working in full app view, the following options are broken out as menu items to the left/right of the time
cards.

Time Sheets (left)

Documents - Click to view attachments

Information (left)

Documents - Click to view attachments

Benefit Balances - Click to view benefit project balances such as Vacation

Billable Percentage - Click to view utilization breakdown

Row Actions

Row Actions are listed to the right of the time cards when in full app view. These are accessed in mobile view
by selecting a time card(s).

Copy - Copies the selected card(s) and adds copies to the bottom of the card view.

Delete - Deletes the selected card(s)

Grouping & Sorting

Gives the ability to adjust the grouping and sorting of the cards on the time sheet.

Group by - Client, Labor Code or Project

Sort by - Project Path, Job Title, Labor Code or Location

Reports & Actions

Used to access a dynamic list of available reports and actions. Note, available reports and actions are
governed by permissions in InFocus via UT>Custom Reports.
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9.7 Expense Sheets

Overview

Expense entry is a core process in InFocus and the Expense Sheets applet gives you the tools you need to
record expenses quickly and accurately.

Similar to Time Sheets, Expense Sheets in InFocus Web, gives you on-the-go access to submit expenses
wherever your work takes you.

How to Enter/Submit Expense

Expenses are entered selecting an existing expense sheet from the expense sheet menu or by clicking
Create New Expense Sheet from the right-hand toolbar. Once created, expenses can be added by clicking
the Add Item (+) at the top of the expense sheet.
 
Expense Sheet rows are visualized as cards which provide you with basic project and expense item
information along with a clear space for entering the expense. Expenses can be added, copied, edited or
deleted from the list of available cards. Optionally, cards can be viewed as rows to optimize your viewing
space.
 
1. Select an Expense Sheet
2. Add Items to your Expense Sheet
3. Enter expenses and related comments for each item as appropriate
4. Attach Documents such as receipts as appropriate
4. Click Save
5. Once all expense is entered and accurate, click Submit

Your Expense Sheet has been submitted.

Field Descriptions

Expense Sheet Header

Note Items listed here are presented as icons when viewing from a mobile device. Mobile view icons are
listed below in parenthesis. Certain options will be accessed from the right/left of the expense cards when
working in full app view.

Expense Sheet Menu (hamburger icon) - Selects an expense sheet to load for entry. For full app view,
this is accessed from the drop down arrow at the top of the header.
New Expense Sheet (plus icon left) - Creates a new expense sheet

Edit Sheet Header (pencil icon left) - Edits the expense sheet name

Delete (trash can icon) - Deletes the loaded expense sheet

Add Project (plus icon right) - Adds a project to the expense sheet. Projects can be searched by project
name/code or by location using Projects Near Me.
Sort By (up and down arrows icon right) - Gives the ability to adjust the sorting of the project cards on the
expense sheet. 
o Sort by Project Path, Expense Code, Date and Amount

Search/Filter (magnifying glass right) - Filters the expense sheet cards as specified.
o Filter buttons exist for Documents and Expense Code when in full app view.
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Expense Card Options

Check Box (upper left) - Selects the specified card for performing row actions such as Copy or Delete.

Expense Code tag - Indicates expense code assigned to the expense item

Document icon - Indicates an attached and linked document. Click to link existing attachments.

Credit Card icon - Indicates if the expense was made on a company credit card (green = yes).

Card Menu (upper right of card)
o Edit - Edits the card information
o Copy - Copies the card
o Delete - Deletes the card

Expense Sheet Footer

Note Items listed here are presented as icons when viewing from a mobile device. Certain options will be
accessed from the menu to the right of the time cards when working in full app view.

Refresh - Refreshes the applet

Reports & Actions (lightening icon) - Used to access a list of your available reports and actions. Note,
available reports and actions are governed by permissions in InFocus Desktop.
Save/Submit - Click to save and/or submit your time sheet. Note, these buttons are presented separately
when viewing the full app.

Additional Options for Full App View

When working in full app view, the following options are broken out as menu items to the left/right of the
expense cards.

Filters (left)

Line Doc Filter - Filters the expense cards by whether or not documents are attached

Expense Codes - Filters by the selected expense code

Row Actions

Row Actions are listed to the right of the time cards when in full app view. These are accessed in mobile view
by selecting a time card(s).

Copy - Copies the selected card(s) and adds copies to the bottom of the card view.

Delete - Deletes the selected card(s)

Sorting

Gives the ability to adjust the sorting of the cards on the time sheet.

Sort by - Project Path, Expense Code, Date and Amount

Create / Edit Sheet

New Expense Sheet - Creates a new expense sheet

Edit Sheet Header - Edits expense sheet name

Delete Sheet - Deletes the expense sheet
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Documents - Click to attach documents/receipts

Reports & Actions

Used to access a dynamic list of available reports and actions. Note, available reports and actions are
governed by permissions in InFocus via UT>Custom Reports.

9.8 Approver

Overview

Each employee is assigned a Time/Expense Approver and Alternate Time/Expense Approver (as appropriate)
via HR>Employees>Accounting/Rates tab. As an approver you have the ability to review and subsequently
approve or reject an assigned employee’s expense sheet.

Understanding Filters

When browsing to the Approvers applet, you’ll be able to filter your list of items using the following filters

Time/Expense Sheet Status - Submitted, Unsubmitted or Both Submitted and Unsubmitted

Time/Expense Sheet - Time, Expense or Both Time and Expense

Understanding Card/Grid Icons

Approver applet uses icons to designate key information and present calls to action for the items displayed.

Submitted Status- X = Unsubmitted, Check = Submitted

Type - $ = Expense Sheet, Clock = Time Sheet

Mail Icon - Click to email a reminder to submit a timesheet. Note, this will appear if tracking the
employee’s Work Email via HR>Employees.
Arrow Box - Click to review details of the Time/Expense Sheet 

How to Approve Time and Expense with InFocus Web
 
Time and Expense Sheets can be reviewed for approval in InFocus Web by completing the following steps.
 
1. Browse to Approver using the hamburger menu (upper left)
2. Filter the results as appropriate using filters and search
3. Review items listed for each employee
4. Select the item(s) you wish to Approve/Reject
5. Click Approve or Reject as appropriate
6. Click Confirm to confirm the approval/rejection.

Note When approving/rejecting you’ll be presented with a reminder that On Approve or On Reject Actions
(configured via UT>Custom Reports) will not be processed but that On Approve or On Reject Events
(configured via AD>Event Manager) will be processed. This is noted for firms leveraging those technologies.

Field Descriptions
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Note Items listed here are presented as icons when viewing from a mobile device. Mobile view icons are
listed below in parenthesis. Certain options will be accessed from the side bar when working in full app view.

Filters

Time/Expense Sheet Status (gauge icon left) - Options include Submitted, Unsubmitted or Both Submitted
and Unsubmitted
Time / Expense Sheet (gauge/time/expense icon right) - Options include Time, Expense or Both Time and
Expense
Employee Search - Filter results by employee

Buttons

Approve - Approve selected Time/Expense Sheets

Reject - Reject selected Time/Expense Sheets

Refresh (mobile view only) - Refreshes the applet

Approver Cards / Grid (full app view)

Submitted Status - Indicates Time/Expense Sheet status

Type - Indicates Time or Expense Sheet

Mail Icon - Listed for Unsubmitted Time Sheets.Click to email a reminder to submit a time sheet. Note,
this will appear if tracking the employee’s Work Email via HR>Employees.
Name / Period - Name of Expense Sheet or Time Sheet Period. Click to review details of the Time/
Expense Sheet (mobile view)
Arrow Box (full app view only) - Click to review details of the Time/Expense Sheet

Amount / Hours - Total Amount of the Expense Sheet / Hours on the Time Sheet

Check Box - Use to select one or many Time / Expense Sheets to approve or reject
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